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HDR Light Studio

Contents

· Release Notes

· Installing HDR Light Studio

· Installing Preset Lights

· Licensing

· Quick Start Video

· User Guide

See Connections (Plug-ins) for documentation on installing and using HDR Light Studio connected

to 3D software.
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HDR Light Studio - User Guide
This User Guide covers the main areas of the application in detail.

It is not designed to be read from start to finish. Just dip into a section when you'd like to find out

more about that feature.

Quick Start Tutorial Video

Menus and Toolbars | Light List | Canvas | Render Views and Settings | Light Preview | Light

Properties  | Preset Library  | Light Looks

  Composite Lights | Filters
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Release Notes

This section contains release notes and known issues for the HDR Light Studio main application.

Release Notes:

· HDR Light Studio (8 Drop 1.1) - Build 2023.0515

· HDR Light Studio (8 Drop 1) - Build 2023.0425

· HDR Light Studio (Xenon Drop 4.2) - Build 2022.0426

· HDR Light Studio - Xenon (Drop 4.2) - Build 2022.0405

· HDR Light Studio - Xenon (Drop 4.1) - Build 2021.1208

· HDR Light Studio - Xenon (Drop 4) - Build 2021.1103

· HDR Light Studio - Xenon (Drop 3) - Build 2021.0514

· HDR Light Studio - Xenon (Drop 2) - Build 2021.0112

· HDR Light Studio - Xenon (Drop 1) - Build 2020.0828

· HDR Light Studio - Tungsten (Drop 4) - Build 2020.0326

· HDR Light Studio - Tungsten (Drop 3) - Build 2019.1205

· HDR Light Studio - Tungsten (Drop 2) - Build 2019.0719

· HDR Light Studio - Tungsten (Drop 1) - Build 2019.0426

· HDR Light Studio - Carbon (Drop 5) - Build 2018.1210

· HDR Light Studio - Carbon (Drop 4) - Build 2018.1023

· HDR Light Studio - Carbon (Drop 3) - Build 2018.0725

· HDR Light Studio - Carbon (Drop 2) - Build 2018.0504

· HDR Light Studio - Carbon (Drop 1) - Build 2018.0213

· HDR Light Studio 5.4.2 - Build 2017.0313

· HDR Light Studio 5.4.1 - Build 2017.0131

· HDR Light Studio 5.4 - Build 2016.1212

· HDR Light Studio 5.3.5 - Build 2016.0810

· HDR Light Studio 5.3.4 - Build 2016.0627

· HDR Light Studio 5.3.3 - Build 2016.0512

· HDR Light Studio 5.3.2 - Build 2016.0323

· HDR Light Studio 5.3.1 - Build 2016.0314

· HDR Light Studio 5.3 - Build 2016.0301

· HDR Light Studio 5.2.1 (Patch 2015.11.02)

· HDR Light Studio 5.2.1 - Build 2015.0820
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· HDR Light Studio 5.2 - Build 2015.0716

· HDR Light Studio 5.1 - Build 2015.0527

· HDR Light Studio 5.0 - Build 2015.0424
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HDR Light Studio 8.2.0

Version: 8.2.0

Build Date: 2024.0301

Released: 5 March 2024

Requirements:

Windows: 10, 11

Mac OS: 11.4 (Big Sur) or later

Linux: Centos 7.9 and compatible distributions

Plug-in Connection Requirements:

3ds Max - 2022, 2023, 2024 - Plug-in build 2024.0208 (updated) Release Notes

Blender - 2.83 and higher (inc Apple Silicon support) - Plug-in build 2024.0301 (updated) Release

Notes

Cinema 4D - 26, 2023, 2024 (inc Apple Silicon support) - Plug-in build 2024.0222 (updated) Release

Notes

DeltaGen - 2019x and higher, Stage 2019x and higher - Plug-in build 2023.0327 Release Notes

Houdini - 19.0, 19.5, 20 (with Python 2.7, 3.7 & 3.9) (inc Apple Silicon support 19.5+) - Plug-in build

2023.1115  (updated) Release Notes

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2022.0513

Maya - 2022, 2023, 2024 - Plug-in build 2023.1115 (updated) Release Notes

MODO - 14, 15, 16 (Windows and OSX) - Plug-in build 2024.0222 (updated) Release Notes

Octane Standalone: 2021.1, 2022.1, 2022.1.1, 2023.1 (Windows only) , Plug-in build 2023.1115

(updated) Release Notes

Omniverse - Create 2021.3.2 and higher (now called USD Composer) (Windows only) - Plug-in build

2023.1115 (updated) Release Notes

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6,7 (Windows only) - Plug-in build 2023.1218 (updated) Release Notes

Unreal Engine - 5.2 & 5.3 - Plug-in build 2023.1115 (updated) Release Notes

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

Patchwork 3D 2023 - Windows - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and higher (Windows) - No additional plug-in installation required

VRED - 2020.1 and higher (Windows only) - No additional plug-in installation required
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What's New in HDR Light Studio 8 - Drop 2?

LightPaint®: Shadow & Shade

New ways to position your lights in HDR Light Studio 8.2 provide even more creative control over

your lights. 'Shadow' mode lets users click to position the shadow cast by a light. 'Shade' mode

positions the light to place the clicked surface in the shade of the light. Read more about LightPaint

methods.

Reflection Filter

The Reflection filter is used to mirror the image within a 'composite' across a vertical or horizontal

axis. It offer different methods and settings that can produce a wide range of useful effects.

For example, you can now produce symmetrical lighting designs, adding lights to only one half of the

HDRI map only, and letting the reflection filter automatically create the other lights.

Read more.

Presets Improvements

Presets Library

The Presets panel is now called 'Presets Library'. There have been many improvements to Presets to

make them even more useful and easier to apply in more ways to your lighting design. There have

been so many changes, its worth reviewing all of the Preset documentation, but here are some

highlights...

Preset Tabs

The new Tabs, at the top of the panel, filter the Presets into useful categories based on the

properties of the preset. This makes it much easier to find the Presets you are looking for. For

example all Environment Presets are shown on their own tab. Read more.

Preset Auditioning

This is a major new innovation for Presets. The new Audition feature lets you instantly, and

temporarily, change the appearance of the selected light by hovering over Preset thumbnails in the

Preset panel. As you move the cursor around the panel, the appearance of the selected light changes

using the Preset. Use Audition mode to explore lots of different HDR Environments or Light

appearances really fast. In Audition mode, once you find a Preset you want to use, double click on

the Preset to apply it permanently to the selected light. Read more.

Apply a Light Preset to an existing light

This is a much requested feature. You can now right click on a Light Preset to apply it's appearance to
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the selected light. Or you can drag and drop a Light Preset on top of a light in the light list to apply

the appearance. The appearance is all settings for main, value blend and alpha multiply tabs for the

saved preset light.

Read more about applying Light presets.

Content and Element Presets

We have enhanced how Content and Element Presets can be used to both make new lights and be

applied to existing lights. The new M,V,A buttons let you select where the Preset will be applied when

both making a new light or apply the preset to an existing light. This includes using the Audition

feature. M,V,A represent the Main, Value Blend and Alpha Multiply tabs on the Appearance settings.

Element Presets for Color, Color Ramps and Images have been enhanced to be more useful. You can

now audition and apply a color or a color ramp to an existing light if those settings are applicable, if

not the light will be adjusted to apply the preset. This is a huge time saver for exploring color in HDR

Light Studio. Read more to see what you can do now with Content Presets and Element Presets

Change the size of Preset Thumbnails

Choose from Standard (the size they were before), Large, and Extra Large. Read more.

Hide Presets

Use the right-click menu to hide Presets you do not want to see using Add to Hidden. Use the new

button to reveal the hidden Presets.

New Presets: HDRI from hdrmaps.com and more

HDR Light Studio 8.2 adds 405 new HDRI Maps from hdrmaps.com. These are provided at 2048x1024

pixels. This resolution is suitable for many lighting tasks. But if you need a higher resolution version,

you can get them from hdrmaps.com.

In addition to the new HDRI maps, we have added a lot of useful new presets to the library,

including:

· Rigs: 25 Studio Lighting Rigs, Rigs showing Composites, and the new Reflection Filter.

· Lights: Colored Lights, Composite Light Examples, Infinite Scrim Light Examples, Additional Window

Gobos.

· Content: Polygon Content.

· Element: Color Ramps - A range of color ramps with combinations of hues at each end of the ramp.

· Element: Colors - Color Palettes, including color temperature and Kelvin.

· Effects: New Effects Lights showcasing Blend modes in action.

https://hdrmaps.com/
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Infinite Plane

Infinite Plane option has been added for 3D mapped lights.

This is designed to be used with a Scrim Light. It treats the 3D light surface as extending infinitely, so

that the lighting effect from the light behind the scrim can fall off unrestricted by the actual size of

the light. This allows a lighting design to be created without any worries of creating hard edges when

the light reaches the edge of the panel. Just turn on this setting and scrim lights will extend beyond

the light edges. Read more.

Light Handle

The position of the light handle can now be adjusted using a new LightPaint mode called Handle.

You can drag in the Render Views or Canvas, and this slides the position of the handle around the

light.

Double Click Gradient label text

Double-clicking the Gradient label text will reset the gradient to its default settings.

OCIO LUT Changes

In order to clean up the interface, the LUT drop-down has been removed from Presets, Canvas and

Light Preview panels. The LUT applied to these views is the 'OCIO Default View' LUT set in the

application Preferences panel.

When using HDR Light Studio with 3D software that supports streaming its render into the HDR Light

Studio render view, the render view should know if a LUT has already been applied to the incoming

image. This new Auto LUT setting means when using HDR Light Studio with Unreal, Rhino,

Omniverse, and Octane Standalone, you will not need to set the OCIO to None to prevent the double

application of LUTs on the render. Read more.

Open ColorIO, OpenImageIO, and Open EXR

We have updated to newer versions of:

Open ColorIO - From 2.0.2 to 2.3.0

OpenImageIO - From 2.2.19 to 2.4.15.0

Open EXR - From 3.1.3 to 3.2.0

Light Looks

A convenient right-click menu can be used in the Light Looks panel, providing the Light Look button

features on hand.

Start-up time

A convenient right-click menu can be used in the Light Looks panel, providing the Light Look button

features on hand.



25

25HDR Light Studio - User Guide

Plug-in Connection Updates

Most plug-ins have been updated to be compatible with changes made in HDR Light Studio 8.2.

Please update your plug-in to the latest version to use with 8.2.

Cinema 4D

Updated plug-in to support Cinema 4D 2024.3 (that had a breaking change).

Native Cinema 4D renderer support reinstated and now supported again.

Crash bug fixed when LightPainting on subdivision objects in C4D render in HDRLS interface.

Redshift cameras are now being listed in HDR Light Studio's render view.

HDR Light Studio - Bug Fixes

· Cinema 4D / Arnold - Area Light visibility now working correctly

· Cinema 4D / Maxwell - Removed Maxwell render support

· MODO - Fixed an error when making Area Lights in MODO 16.1 and above

· 3ds Max / Octane & Corona - Area lights were broken with Octane/Corona due to returning false for

area light spread call

· 3ds Max / Maxwell & Art - Maxwell & Art renderer support removed from 3ds Max

· Fixed a crash bug when changing between planar and spherical motion blur settings

· Spherical mapped images are now optimized and is quicker at handling large HDRI maps

· Light Preview - the whole panel area is not longer taking mouse clicks, prior to this it was easy to

accidentally move the light handle by accident

· Rim LightPaint method with area lights now works correctly

· Fix production render hang when using multiple area lights in the project

· Correctly initialize area lights with solo and on/off states created from rig presets.

· Fixed a bug where red preset thumbnails were being generated.

· Composite light is now honoring Display Ratio correctly.
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HDR Light Studio 8.1.1

Version: 8.1.1

Build Date: 2023.0515

Released: 17th May 2023

This is a minor update with no new features, but fixes an important issue that can lock HDR

Light Studio start up.

If a referenced texture file in a Preset was missing, this would lock up HDR Light Studio 8.1.0 at start

up during the creation of preset thumbnail cache files.

HDR Light Studio 8.1.1 now handles this gracefully and will generate a red thumbnail image

indicating the referenced texture was missing, and then carries on to successfully start up HDR Light

Studio.

This is the only change in this new build.

For more information on HDR Light Studio 8 and new features please see - HDR Light Studio 8.1.0

What's New?

7th December 2023 - new plug-in released

Houdini

Support added for Houdini 20. See release notes.

This build removes support for 18.5, for 18.5 please use Build 2023.0706

5th December 2023 - new plug-in released

New Unreal Engine Plug-in Connection Released

We are proud to release this new plug-in connection to Unreal Engine 5.  Simply add the provided

plug-in to Unreal Engine in order to connect HDR Light Studio to your Unreal Engine session.

Works with official major & minor releases of Unreal Engine 5.2.1 & 5.3.x (Windows only) - Plug-in

build 2023.0921

Documentation for this new plug-in connection can be found here.
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30th November 2023 - new plug-in released

Blender

Updated to support Blender 4+

2nd October 2023 - new plug-in released

Cinema 4D

Support added for Cinema 4D 2024.

8th August 2023 - new plug-ins released

Houdini

The Houdini connection now uses our new API for a far more responsive lighting experience. 

The Houdini connection is now only compatible with Python 3 builds of Houdini.

Support added for Houdini 19.5 running on Apple Silicon.

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on

Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.

Updated HDR Light Studio Connection UI.

Compatibility added for Area Light Spread (Redshift, V-Ray, Arnold, and RenderMan).

The path to the rendered HDRI lighting textures now uses $HIP file structure.

Bug fix: The HDR Light Studio connection now prevents users from creating more than one HDR Light

Studio Connection Controller.

Omniverse

Support added for Support for USD Composer 2023.1+

'Refresh' button has been added to the HDR Light Studio Connection panel. The button re-scans the

Omniverse stage and re-populates available dome lights in the Dome Lights list.

The name structure of the area lights created by HDR Light Studio now adheres to the latest naming

conventions for paths. The name of any area light created by HDR Light Studio will now begin with

'hdrls_'. 
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HDR Light Studio 8.1.0

Version: 8.1.0

Build Date: 2023.0425

Released: 3rd May 2023

Requirements:

Windows: 10, 11

Mac OS: 11.4 (Big Sur) or later

Linux: Centos 7.9 and compatible distributions

Plug-in Connection Requirements:

3ds Max - 2021, 2022, 2023 - Plug-in build 2023.0208 (updated) Release Notes

3ds Max - 2024 - Plug-in build 2023.0504 Release Notes

Blender - 2.83 and higher - Plug-in build 2023.0329 (updated) Release Notes

Cinema 4D - 25, 26, 2023, - Plug-in build 2023.0329  (updated) Release Notes

DeltaGen - 2019x and higher, Stage 2019x and higher - Plug-in build 2023.0327 (updated) Release

Notes

Houdini - 18.5, 19.0, 19.5 (with Python 2.7, 3.7 & 3.9) (Apple Silicon on MacOS not supported) - Plug-in

build 2023.0330  (updated - single installer) Release Notes

Maya - 2022, 2023, 2024 - Plug-in build 2023.0329 (updated - single installer) Release Notes

MODO - 14, 15, 16 (Windows and OSX) - Plug-in build 2023.0330 (updated) Release Notes

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2022.0513

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2023.0417 (updated) Release Notes

Octane Standalone: 2021.1  (Windows only) , Plug-in build 2023.0203 (updated) Release Notes

Octane Standalone: 2022.1, 2022.1.1 (Windows only) , Plug-in build 2023.0505 (updated) Release

Notes

NVIDIA Omniverse™ - Create 2021.3.2 (now called USD Composer) and higher (Windows only) - Plug-

in build 2023.0217 (updated) Release Notes

VRED - 2020.1 and higher (Windows only) - No additional plug-in installation required

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and higher (Windows) - No additional plug-in installation required

Patchwork 3D 2023 - Windows - No additional plug-in installation required

See more details about compatibility and plug-in features here in the Compatibility Chart

What's New in HDR Light Studio 8 - Drop 1?

Product naming

We are now naming HDR Light Studio by the release numbers again - not nick names like Carbon,

https://lightmap.s3.eu-west-1.amazonaws.com/docs/HDRLightStudio-8-1-Connection-Features-and-Compatability.pdf
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Tungsten, and Xenon. The product name was getting too long and a bit confusing for new customers.

This is HDR Light Studio version 8, drop 1 - so it's called 8.1.0

User Interface Enhancements

LightPaint Expanded

More lighting control directly inside the Render Views and Canvas

The user interface in the Render Views and Canvas have been improved to allow mouse input to

control key lighting settings like - scale, rotation, brightness, and more. Keyboard shortcuts keys can

be used to switch the mode. This means you can do more directly inside the views without needing

to use sliders in the Light Properties panel. This provides a far faster workflow.

Read more.

Watch the training video

Light Properties split into 2 tabs - Settings & Appearance

There are a lot of settings in the Light Properties panel. Users were spending too much time scrolling

up and down a long list of settings. We fixed this by splitting the properties into 2 tabbed sections.

Read more

New Light Content Types

Scrim Light

The Scrim Light mimics how a photographer would light in the studio (see image below) when

shining a light source at the back of a sheet of material. The Scrim Light in HDR Light Studio produces

a very realistic light that is easy to adjust in a physical way. Most of the settings for this light can be

controlled by dragging in 2D views of the light setup. This is far faster and more intuitive than using

lots of sliders. The Scrim Light is the most advanced and controllable procedural light available in

HDR Light Studio - and can produces a huge range of realistic lighting effects.

Read more

Watch the training video

https://www.lightmap.co.uk/learning/ui-enhancements-8/
https://www.lightmap.co.uk/learning/scrim-light-tutorial/
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This perfectly shows the concept behind the Indirect Light. See the spot light placed behind the sheet

of material (outlined red)

Polygon Content

The Polygon content is very useful for controlling the shape of lights when used on Alpha Multiply to

control the Alpha of the light.

Read more.

Watch the training video

Additional New Features

Copy and Paste Lights

You can now copy and paste selected lights, within in the same Look, into other Looks and between

https://www.lightmap.co.uk/learning/polygon-tutorial/
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Projects. Pasted lights are added to the top of the current Light List.

Read more.

Reverse Ramp button

A new button has been added to the ramp editing panel that will horizontally flip the ramp.

Read more.

CTRL + Drag/Drop Presets, forces Area Light creation

When making a new light from a Preset with 3D mapping - holding the CTRL key will force the

creation of an Area Light.

Improved handling of Preset texture files

When opening a HDR Light Studio project file created on a different computer, HDR Light Studio will

now automatically try to locate preset textures files in your own Presets installation. This will avoid

the user needing to manually fix missing file links when moving HDR Light Studio projects between

computers.

Plug-in Updates

Most plug-ins have been updated with performance enhancements and API changes. So please

update to the latest plug-in for your 3D software.

Maya

Support has been added for Maya 2024

Support has been added for Area Light spread control from HDR Light Studio for: Arnold, Redshift,

RenderMan, V-Ray

DeltaGen

Support has been added for DeltaGen 2023 (and the x-builds).

Patchwork 3D

Patchwork 3D 2023 has been updated to stream it's render into the HDR Light Studio 8 interface for

LightPainting.

For further information please refer to the release notes for your connection here:

3ds Max, Blender, Cinema 4D, DeltaGen, Houdini, Maya, MODO, Octane Render Standalone,

Omniverse, Rhino 3D
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HDR Light Studio - Bug Fixes

· Motion blur got broken a few releases ago by a code change in another area of HDR Light Studio.

Motion blur now works correctly.

· We now support on/off/solo/pickable from edit menu in the undo stack.

· Canvas would not update when nudging lights via keyboard shortcuts - this is fixed.

· HDR Light Studio should now start up faster. It has been optimized.

· Additive Blend on Value channel was incorrectly setting the alpha on production renders - this is

fixed.

· Correct OCIO handling when OCIO env var/application settings are used. Fallback to default also

works correctly now too.
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HDR Light Studio (Xenon Drop 4.2) (2022.0426)

Version: Xenon (Drop 4.2)

Build Date: 2022.0426

Released: 19 May 2022

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2021, 2022, 2023 - Plug-in build 2022.0722 (updated)

Blender - 2.83+, 2.93+, 3.0+, 3.1+ - Plug-in build 2022.0913 (updated)

Cinema 4D - 26/25/24 - Plug-in build 2022.0525  (updated)

Cinema 4D - 2023 - Plug-in build 2022.0916  (updated)

DeltaGen - 2017, 2018, 2019x, 2020x, 2021x, 2022x - Plug-in build 2021.1110

Houdini - 18, 18.5, 19 (18.5/19 with Python 2 and 3) - Plug-in build 2021.1208

Houdini - 19.5 (with Python 3.7 & 3.9) - Plug-in build 2022.0624  (new)

Maya - 2019, 2020, 2022 - Plug-in build 2021.1115

Maya - 2023 - Plug-in build 2022.0404

MODO - 12, 13, 14, 15 (Windows and OSX) - Plug-in build 2021.0504

MODO - 16 - Plug-in build 2022.0420

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2022.0513  (updated)

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2019.0624
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Octane Standalone: 2020, 2020.2, 2021.1 (Windows only) , Plug-in build 2021.0512

NVIDIA Omniverse™ - Extension the 'Create' app 2021.3.2 versions and higher (Windows only) - Plug-

in build 2022.0920 (updated)

VRED - 2020.1, 2021, 2022 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

What's New?

30th September 2022 - new plug-ins released

Blender - Support added for 3.3

Cinema 4D - Support added for Cinema 4D 2023

Omniverse - Compatibility updated for breaking changes in newer Omniverse Create builds

4th August 2022 - new plug-in released

Please note: New build for Blender Plug-in was released to fix the following issues.

Blender - Fix for Octane area lights not working in the latest stable build of Blender for Octane

2021.1.5_26_3. For users working with Blender for Octane, the new build of the Blender Plug-in now

requires 'at least' Blender For Octane 2021.1.5_26_3 (Windows only) or Blender for Octane

2022.1.BX2_27_1 (Windows & Mac OS X).

29th July 2022 - new plug-ins released

3ds Max - Support added for V-Ray 6

Houdini - Support added for Houdini 19.5

13th June 2022 - new plug-ins released

Please note: New build for Omniverse Create Plug-in was released to fix the following issues.

Omniverse Create - In Omniverse Create 2022.1.3, the DX12 implementation corrupts the Beauty

Pass of the interactive rendering inside HDR Light Studio. As a result, the interactive rendering inside

HDR Light Studio interface will appear black. NVIDIA is aware of this issue and will fix it in the next

release of Create.

At the moment, there are 2 options to use HDR Light Studio with Omniverse Create:

1) Use HDR Light Studio with Omniverse Create 2022.1.2

2) Use the new Omniverse Create Connection build 2022.0610 and run Vulkan rather than default

DX12 rendering engine:
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From your create root folder, example: C:\Users\user\AppData\Local\ov\pkg\create-2022.1.3

You can run .\kit\kit.exe .\apps\omni.create.kit --vulkan

This will use the Vulkan engine rather than DX12. It may take some time to start the first time as it

will be compiling the shaders. Users can then use HDR Light Studio and Omniverse Create 2022.1.3.

19th May 2022 - new plug-ins released

Please note: New builds for Cinema 4D and Blender Plug-ins were released to fix the following issues.

Cinema 4D - If for some reason the environment variable had not been set for the location of main

HDR Light Studio app, the fall back location was not being used, and HDR Light Studio wasn;t found

by the connection. This is fixed now.

Blender - Fix for blender API breaking change of cycles area light visibility after v3.x

Cinema 4D 26 support released, including Apple Silicon support

HDR Light Studio is now compatible with Cinema 4D 26. In addition, the Cinema 4D 26 plug-in is

compatible with Cinema 4D running on Apple Silicon. This new plug-in requires the latest build of

HDR Light Studio (2022.0426).

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on

Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.

Blender Add-on updated to support Apple Silicon

The HDR Light Studio add-on for Blender has been updated to support Blender running on Apple

Silicon. This new plug-in requires the latest build of HDR Light Studio (2022.0426).

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on

Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.

LightWave

New build fixes bad memory access in LW2020 that causes a crash
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HDR Light Studio (Xenon Drop 4.2) (2022.0405)

Version: Xenon (Drop 4.2)

Build Date: 2022.0405

Released: 8th April 2022

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2020, 2021, 2022 - Plug-in build 2021.0914

3ds Max - 2023 - Plug-in build 2022.0420 (updated)

Blender - 2.83+, 2.93+, 3.0+, 3.1+  - Plug-in build 2022.0324 (updated)

Cinema 4D - 21.115 or higher, 22, 23, 24, 25 - Plug-in build 2021.0519

DeltaGen - 2017, 2018, 2019x, 2020x, 2021x, 2022x - Plug-in build 2021.1110 (updated)

Houdini - 18, 18.5, 19 (18.5/19 with Python 2 and 3) - Plug-in build 2021.1208

Maya - 2019, 2020, 2022 - Plug-in build 2021.1115

Maya - 2023 - Plug-in build 2022.0404 (updated)

MODO - 12, 13, 14, 15 (Windows and OSX) - Plug-in build 2021.0504

MODO - 16 - Plug-in build 2022.0420 (updated)

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2021.0520

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020, 2020.2, 2021.1 (Windows only) , Plug-in build 2021.0512



37

37HDR Light Studio - User Guide

NVIDIA Omniverse™ - Extension the 'Create' app 2021.3.2 versions and higher (Windows only) - Plug-

in build 2022.0414 (updated)

VRED - 2020.1, 2021, 2022 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

What's New?

5th May 2022 - new plug-ins released (shown in red above)

3ds Max 2023, Maya 2023, MODO 16 connections added

Omniverse Connection update: we now auto enable 'sampled direct lighting' so that area lights can

be seen in reflections using the RTX Real-time renderer.

8th April 2022 - Original Xenon Drop 4.2 Release

NVIDIA Omniverse™ Connection

HDR Light Studio Indie and Pro licenses will now support the NVIDIA Omniverse™ Connection

in this HDR Light Studio build.

Previously the NVIDIA Omniverse™ Connection was only available for Automotive licenses.

Existing customers with active licenses of Indie and Pro will be able to start using the NVIDIA

Omniverse™ Connection right away with their existing licenses.

Simply update to the HDR Light Studio 'Xenon Drop 4.2'.

The Omniverse Connection has been updated to support the latest build of Omniverse, where

Omniverse changes had broken our previous build.

Fixed bug that caused LightPaint to not work with RTX Real-Time. Now, for LightPaint to work with

RTX Real-Time, DLSS needs to be disabled in RTX Real-Time Render Settings > Anti-Aliasing.

Blender Connection

Support added for Blender 3.1+

A change of python version in Blender 3.1 broke our connection. Our connection has now been

updated to add compatibility.

3ds Max Connection

Now compatible with FStorm Renderer

Tested with FStorm Version 15.0H.
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Live HDRI Map and HDR Area Lights is supported.

Sharing of the interactive render from FStorm in the HDR Light Studio interface is not supported.

DeltaGen Connection

Support added for DeltaGen 2022

Compatible with the new Ambience nodes

General Bug Fixes

· Fixed bug that would cause HDR Light Studio to crash when certain presets lights would be

dragged from the presets panel onto the canvas.

· Fixed bug that would cause HDR Light Studio to crash when adjusting a ramp.

· Fixed bug that would cause HDR Light Studio to crash when duplicating lights.
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HDR Light Studio (Xenon Drop 4.1)

Version: Xenon (Drop 4.1)

Build Date: 2021.1208

Released: 15th December 2021

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2020, 2021, 2022 - Plug-in build 2021.0914

Blender - 2.83+, 2.93+, 3.0+  - Plug-in build 2021.0914

Cinema 4D - 21.115 or higher, 22, 23, 24, 25 - Plug-in build 2021.0519

DeltaGen - 2017, 2018, 2019x, 2020x, 2021x - Plug-in build 2021.0319

Houdini - 18, 18.5, 19 (18.5/19 with Python 2 and 3) - Plug-in build 2021.1208 (updated)

Maya - 2019, 2020, 2022 - Plug-in build 2021.1115 (updated)

MODO - 12, 13, 14, 15 (Windows and OSX) - Plug-in build 2021.0504

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2021.0520

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020, 2020.2, 2021.1 (Windows only) , Plug-in build 2021.0512

NVIDIA Omniverse™ - Extension the 'Create' app 2021.3.2 versions and higher (Windows only) - Plug-

in build 2021.0914

VRED - 2020.1, 2021, 2022 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

HDR Light Studio Xenon Drop 4.1 is a minor update to enable compatibility and fix

some bugs
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What's New?

Houdini Connection

Support added for Houdini 19

Support added for RenderMan 24.2

Octane 2021.1.0.4  or newer is required for compatibility with Octane.

Dropped support for Houdini 17.5

Maya Connection

Support added for RenderMan 24.2

Dropped support for Maya 2018

Octane Standalone (14 Jan 2022)

Connection Released for Octane Standalone 2021.1

General Bug Fixes

· Fixed bug that would cause HDR Light Studio to crash when the OCIO environment variable is set

but it points to a config.ocio file that doesn't exist. Further validation checks have been

implemented and if the validation fails, the user will be prompted with an error message and made

aware that HDR Light Studio is falling back to a different OCIO configuration.

· Fixed bug where OCIO "Default" button did not remove HDRLS OCIO prefs, instead it would set the

HDRLS prefs to the default prefs OCIO file location.
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HDR Light Studio (Xenon Drop 4)

Version: Xenon (Drop 4)

Build Date: 2021.1103

Released: 9th November 2021

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2020, 2021, 2022 - Plug-in build 2021.0914 (updated)

Blender - 2.83 (LTS) and higher - Plug-in build 2021.0914 (updated)

Cinema 4D - 21.115 or higher, 22, 23, 24, 25 - Plug-in build 2021.0519

DeltaGen - 2017, 2018, 2019x, 2020x, 2021x - Plug-in build 2020.0319

Houdini - 17.5, 18, 18.5 (18.5 with Python 2 and 3) - Plug-in build 2021.0504

Maya - 2018, 2019, 2020,2022 - Plug-in build 2021.0504

MODO - 12, 13, 14, 15 (Windows and OSX) - Plug-in build 2021.0504

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2021.0520

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020, 2020.2 (Windows only) , Plug-in build 2021.0512

New NVIDIA Omniverse™ - Extension the 'Create' app 2021.3.2 versions and higher (Windows only) -

Plug-in build 2021.0914

VRED - 2017, 2018, 2019, 2020 and 2020.1, 2021, 2022 (Windows only) - No additional plug-in

installation required.

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

What's New?
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HDRI Map kindly provided by https://ctccreativestudio.com/

Motion Blur (Advanced) filter

Here are the additional features that the Motion Blur (Advanced) filter provides, above the standard

Motion Blur filter:

· Curve and Tilt: The motion path can be curved in any direction. Use case: Replicating motion blur

travelling around a corner in a car.

· Noise Profile: Noise can be added to the path. Use cases: Replicating the effect of road noise in the

blur or to generate a creative lighting trail effect.

· Depth Image: Motion blur amount can be scaled per pixel by values from a loaded image. Use case:

Paint an image to control where the map is blurred and by how much.

Documentation for this new feature can be found here.

NVIDIA Omniverse Connection Released

We are proud to release this new connection to NVIDIA Omniverse.  Simply add the provided

extension plug-in to the Create App in order to connect HDR Light Studio to your Create session.

Documentation for this new connection can be found here.

Blender Connection

Added support for Octane Render and RenderMan

Fixed scene export failure with versions Blender 2.93.2 and higher

Single installer file for all versions.

Documentation for this connection can be found here.

3ds Max Connection

Updated to use new faster API for the 2022 plug-in only
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Fixed a conflict with Ornatrix and scene export into HDR Light Studio

Fixed renderer not being detected after closing and reopening connection panel

Fixed crash bug when selecting a new scene and saving the scene

Dropped support for 3ds Max 2019

Documentation for this connection can be found here.

Cinema 4D

R25 Connection Added

SOLIDWORKS Visualize

Fixed LightPaint bug positioning lights in the wrong place

General Bug Fixes

Fixed bug where LightPainting from hosts was placing lights incorrectly inside Composite lights with

non default transform settings

Fixed problem loading older HDR Light Studio project files

Fixed graduation handed issue opening older project files
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HDR Light Studio (Xenon Drop 3)

Version: Xenon (Drop 3)

Build Date: 2021.0520

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2019, 2020, 2021, 2022 - Plug-in build 2020.0814

Blender - 2.83 (LTS) and higher - Plug-in build 2021.0504 (updated)

Cinema 4D - 21.115 or higher, 22, 23, 24 - Plug-in build 2021.0519 (updated)

DeltaGen - 2017, 2018, 2019x, 2020x, 2021x - Plug-in build 2020.0319

Houdini - 17.5, 18, 18.5 (18.5 with Python 2 and 3) - Plug-in build 2021.0504 (updated)

Maya - 2018, 2019, 2020,2022 - Plug-in build 2021.0504 (updated)

MODO - 12, 13, 14, 15 (Windows and OSX) - Plug-in build 2021.0504 (updated)

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2021.0520  (updated)

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 and 7 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020, 2020.2 (Windows only) , Plug-in build 2021.0512 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1, 2021, 2022 (Windows only) - No additional plug-in

installation required.

Maxwell Studio - 5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

WHAT'S NEW?

Motion Blur Filter
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The Motion Blur filter is used to provide a linear motion blur effect. The example image above shows

an HDRI map used for lighting and for the background image that was motion blurred using this new

filter.

Find out more here.

A new faster, re-engineered, Cinema 4D Connection

The Cinema 4D connection now uses our new API for a far more responsive lighting experience. We

also took the opportunity to rework the behavior of this connection, here are the key changes:

· Support added for Cinema 4D 24

· Moving lights is more interactive

· Simplified the Connection panel terminology to be easier to understand for new users

· You can switch Cinema 4D projects without HDR Light Studio closing and your lighting project will

auto sync

· You can create multiple HDR Light Studio lighting projects in a single C4D project and correctly

swap between them. This is also compatible with the Cinema 4D 'Takes' system

· Added support for V-Ray 5 (removed support for older V-Ray versions)

· Added support for real-time Area Light Spread control for: Arnold, V-Ray, Redshift and Octane

· Hiding the HDR Light Studio Connection panel on the UI does no longer stops the lighting updates.

You can now tab the connection panel and have it behind another tab when using HDR Light

Studio

· Logging has moved into the native Cinema 4D logging system

· On macOS, if the environment variable is not working to tell Cinema 4D the location of the HDR

Light Studio application, the Connection will then look in the default install location. This fixes an

issue where macOS users report Cinema 4D not able to start HDR Light Studio from Cinema 4D on

macOS.



46

46HDR Light Studio - User Guide

Connection Compatibility (9th June 2021)

Support for 3ds Max 2022 added

Support for Maya 2022 added

LightWave - plug-in updated. On macOS, if the environment variable is not working to tell LightWave

the location of the HDR Light Studio application, the Connection will then look in the default install

location. This fixes an issue where macOS users report LightWave not able to start HDR Light Studio

from Cinema 4D on macOS.

User Interface Improvements

Real-time Light moves on Canvas 

When moving lights on canvas the HDR Light Studio Render View now updates in real-time.

Area Light Controls moved on the UI

The Area Light specific controls in the Light Properties panel have been moved and grouped next to

the Area Light check box. The text labels match the yellow color used for area lights in the Light List.

Many users overlook the area light feature. So now it's easier to find and to use. In addition the

Falloff drop down has been removed and all lights will be created with physically correct quadratic

falloff.
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Area Light Spread

A new property called Spread has been added to the Area Lights. This controls the spread/directional

setting on an area light. This has only been implemented in this release for Cinema 4D with Arnold,

V-Ray, Redshift and Octane.

This setting is ignored by non supported connections and renderers.

Expansion of the LightPaint System

To allow positioning the Motion Blur direction on the Canvas or Render Views, a new drop down has

been added for selecting the behavior of the LightPaint tool. At the moment this drop down by

default is set to Move, i.e. the light is being moved in the view, which is the same behavior as before.

But when a spherical motion blurred light is selected, the drop down adds Motion Blur to the drop

down. This new drop down will be expanded in the future with additional tools.

Render View - Max Samples

The Max Samples setting is now a slider from 0 to 160 - making it easier to use and set the max value.
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Additional Improvements

Box Gradient Light

New Light type on Tool Bar. Box Gradient Light. Box Gradient Light is ideal for creating a white light

with highly controllable soft edges and more.

Help

The help links have been improved in HDR Light Studio, with the main Help linking to our online

docs.

Retired Features!

These features have been retired to simplify the experience of using HDR Light Studio.

Light Property: Cookie

This was a legacy feature that caused issues when changing the content on a light and realizing it

had a Round or Hex cookie, cropping the light content. The shape of the light should be controlled by

its content or alpha. All lights behave like they have the Rect cookie now, even when opening old

projects.

Uber Light

This is a legacy feature from when lights created using the tool bar had simplified controls.
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Hex Light

This light was defined by the Hex Cookie which has been retired. To give your lights shape, please

use an Alpha image.

Bug Fixes

· Fix a major bug where older HDR Light Studio projects (pre Tungsten Drop 1) were not

opening in Xenon Drop 2!

· On macOS, if HDR Light Studio environment variable is not found/work/set then default install

location used to find HDR Light Studio main app from Cinema 4D, MODO, Maya, Blender,

LightWave and Houdini connections.

· Deleting a light in a comp was not updating the Canvas and Render View.

· Comp lights not updating properly on canvas when deleted.

· MODO 15 fixes a problem where MODO was preventing floating licenses of HDR Light Studio

working.

· Better handling if the user set proxy directory is missing.

· Area Lights opening in 'off' state when opening older scenes.

· Fixed issues with Octane Standalone and area lights not showing and hiding correctly.

· Cinema 4D / Arnold: Mapping of HDRI map was incorrect as Arnold has changed orientation of

image based lighting
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HDR Light Studio (Xenon Drop 2)

Version: Xenon (Drop 2)

Build Date: 2021.0121

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra) or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2019, 2020, 2021 - Plug-in build 2020.0814

Blender - 2.83 (LTS) and higher - Plug-in build 2020.0928 (updated)

Cinema 4D - 19, 20, 21.115 or higher, 22, 23 - Plug-in build 2019.1212

DeltaGen - 2017, 2018, 2019 (and the x-builds), 2020 (and the x-builds) - Plug-in build 2020.0319

Houdini - 17.5, 18, 18.5 - Plug-in build 2020.1207 (updated)

Maya - 2018, 2019, 2020 - Plug-in build 2020.1203 (updated)

MODO - 11, 12, 13, 14 (Windows and OSX) - Plug-in build 2019.0710

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2019.1212

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020. 2020.2 (Windows only) , Plug-in build 2020.1208 new

VRED - 2017, 2018, 2019, 2020 and 2020.1, 2021 (Windows only) - No additional plug-in installation

required.

Maxwell Studio - 4/5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

WHAT'S NEW?

Filters
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The first filter added to HDR Light Studio is Diffusion - a blur effect that mimics the diffusion of light

through a material like tracing paper or cloth. Spreading and softening the light.

Diffusion updates in real-time and is energy conserving. Preserving the amount of light in your shot.

We can't wait to see what you will do with it.

Find out more here.

Light Looks

A single HDR Light Studio project file can now contain multiple lighting designs organized in a tree

hierarchy.

These are controlled from the new Light Looks panel.

Find out more here.

Additional Changes
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'Toggle Area Light' available from right-click in the Light List

You can select multiple lights in the list and toggle their area light state.

Demo Presets

Demo Presets now ship in the main HDR Light Studio installer - simplifying the demo installation

process.

If you do not have any Presets installed. HDR Light Studio will automatically load the low-resolution

demo Presets.

Changes:

Help > License Management panel column has changed name from Version to Maintenance,

making it clearer that the date represents the maintenance date for the user.

Bug fixes:

You can now drag and drop multiple lights into a Composite Light and it works as expected.

Invalid OCIO path could cause a HDR Light Studio crash. We now handle this and warn the user

when OCIO configuration files are not found.

If a user has a non-ASCII operating system user name - we now check on startup and provide an

appropriate warning message that ithere is a problem.

Fixed an issue with Blender connection when logging the path was invalid.

Maya/RenderMan: Fixed a bug with RenderMan IPR
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HDR Light Studio (Xenon Drop 1)

Version: Xenon (Drop 1)

Build Date: 2020.0828

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.13.0 (High Sierra)  or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2019, 2020, 2021 - Plug-in build 2020.0814  (updated)

Blender - 2.83 (LTS) and higher - Plug-in build 2020.0828 New 

Cinema 4D - 19, 20, 21.115 or higher, 22 - Plug-in build 2019.1212

DeltaGen - 2017, 2018, 2019 (and the x-builds), 2020 (and the x-builds)  - Plug-in build 2020.0319

Houdini - 17, 17.5, 18 - Plug-in build 2020.0218

Maya - 2018, 2019, 2020 - Plug-in build 2020.0302

MODO - 11, 12, 13, 14 (Windows and OSX) - Plug-in build 2019.0710

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2019.1212

Rhino 5 (Windows only) - Plug-in build 2018.0206 

Rhino 6 (Windows only) - Plug-in build 2019.0624

Octane Standalone: 2020 (Windows only) , Plug-in build 2020.0805 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1, 2021 (Windows only) - No additional plug-in installation

required.

Maxwell Studio - 4/5 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

WHAT'S NEW?

This new HDR Light Studio release includes new features for Blender, Octane Render Standalone and 3ds

Max/V-Ray 5 users. However, the work done for this release has laid the foundations for improving the

performance of all our connections in the future, with the development of a new faster TCP/IP based API.
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New Blender Connection

We are proud to release our new Blender Connection. This brand new connection is the big new

feature in our Xenon Drop 1 release. This Blender Add-on is a free addition for existing Indie, Pro and

Automotive customers with active Subscriptions or Maintenance. Visit our Blender Connection web

page for more details. Documentation for the new Blender Connection can be found here.

New API

We have developed a new TCP/IP based API (Application Programming Interface) for HDR Light

Studio. This new API is significantly faster, providing a far more responsive lighting experience for the

3D artist. The first connections to use the new API are the new Blender Connection and the Octane

Render Standalone Connection. We are aiming to port other connections to use the new API, where

applicable, in future connection updates.

Octance Standalone Connection

This connection has been updated to use the new TCP/IP based API in HDR Light Studio.

3ds Max Connection 

Support for V-Ray 5 added.

Fix added to deal with username paths with non ASCII characters. See here for details on how to

implement this.

Notable Bug Fixes

Mouse Up event were not being passed to host 3D app when using LightPaint.



55

55HDR Light Studio - User Guide

HDR Light Studio (Tungsten Drop 4)

Version: Tungsten (Drop 4)

Build Date: 2020.0326

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.12.0 (Sierra)  or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2018, 2019, 2020, 2021 - Plug-in build 2020.0305  (updated)

Cinema 4D - 19, 20, 21, (Requires R21.1 (build 21.115) and higher), 22 - Plug-in build 2019.1212

(updated)

DeltaGen - 2017, 2018, 2019 (and the x-builds), 2020 (and the x-builds)  - Plug-in build 2019.0115

Houdini - 17, 17.5, 18 - Plug-in build 2020.0218 (updated)

Maya - 2018, 2019, 2020 - Plug-in build 2020.0302 (updated)

MODO - 11, 12, 13, 14 (Windows and OSX) - Plug-in build 2019.0710

LightWave 3D - 2018, 2019, 2020 - Plug-in build 2019.0123

Rhino 5 - Plug-in build 2018.0206 

Rhino 6 - Plug-in build 2019.0624

Octane Standalone: 2018, 2019, 2020 (Windows only) , Plug-in build 2019.1211 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

Update 14th May

Support added for Cinema 4D 22 and LightWave 2020

Updated build for release version of Octane Standalone 2020

Update 16th April

Support added for 3ds Max 2021 and DeltaGen 2020x
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WHAT'S NEW?

PRESET SYSTEM ENHANCEMENTS

Manage User Presets

HDR Light Studio users have been able to save their own 'User Presets' since the Carbon Drop 3

release. However there has been no method for managing these until now.

Tungsten Drop 4 introduces a new User Preset Management panel that is opened using Edit >

Manage User Presets.

In this panel the user can Edit the Description and Tags for a user Preset, and also Delete user

presets. Find out more details here

Favorite Presets

A user can right click on a Preset and select 'Add to Favorites' or 'Remove From Favorites'. You can

then filter to view only your favorite presets using the heart button. This saves a lot of time hunting

through lists of lights when you know the ones you like to use often. Find out more details here

Replace all lights with a Rig Preset

Right click on a rig preset and select - Replace Lights with Rig, to delete all current lights and add

the rig lights. A much faster way to audition different lighting rigs.

Find out more about Preset Rigs here

Hover on a Preset for a larger Preview

You can now hover over a Preset Thumbnail and a larger preview will appear that includes additional

useful information about the preset. For example, pixel resolution on images, mapping used on

lights etc.

Images are also shown at the correct aspect ratio also on Preset thumbnails.

Improved workflows with Content and Element Presets

You can now create new 3D or Background Lights directly from all 'Content' and some 'Element'

presets.

For example - drag and drop lots of HDRI maps onto the Presets panel to batch create Element:

Image presets.

You can then drag and drop those HDRI maps onto the Render View directly to make a new

Background Light.

Previously you would need to make the background light first, then drag and drop the image onto the light

properties panel. The new method is much faster.

Alternatively, drag and drop lots of light source images onto the Presets panel to batch create

Element: Image presets.

Now you can drag and drop those light images onto the Render and a 3D light will be created where
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you dropped it using LightPaint.

Previously you would need to make the 3D light first and position it on your model, then drag and drop the

light image onto the light properties panel. The new method is much faster.

See the updated documentation for Presets here

Area Light Toggle

New Keyboard Shortcut to toggle Area Light checkbox on 3D lights. CTRL + SPACE BAR (Fn + CMD +

SPACE BAR on MacOS)

A big time saver!

Compatibility:

Support added for Maya 2020, supporting: Redshift, V-Ray, Octane, RenderMan and Arnold

Tested against: Redshift 2.6.51, V-Ray 4.30.001, Octane 2019.1.5 - 15.14, RenderMan 23.1, Arnold 4.0.1

Support added for MODO 14 (there is an area light bug, see release notes)

Support added for Redshift 3 in Cinema 4D

HDR Light Studio Changes:

Reflection Fresnel settings have been simplified for HDR Light Studio's Render View. Fresnel setting is

now set using only an IOR setting. Removing the none physical approaches of 'None' and 'Custom'.

Image Saturation and Gamma 'up and down' arrow button increments were too big and have been

reduced to steps of 0.1. (Customer request)

Render Progress Bar now orange - easier to notice when a render has completed. (Customer request)

Render View and Canvas tool settings are no longer stored within project files. This caused confusion

when a scene loaded and the tools changed.

Color Profile (LUT) dropdowns can now accommodate wider LUT names. These were truncated and

with ACES LUTS this made them hard to correctly identify and select.

Enhancements:

Save Render View Images - This Project menu item has been updated to save out all Render Views as

EXR files, both the internal and external rendered image when available.

Saving Render View Images during Production Render - Has been updated to save out all Render

Views as PNG files with LUT baked into image.

HDR Light Studio 'Project files' are about 8 times smaller in file size in this release than previous

versions. We now only save the active settings on each light in the project. Performance may be

improved when used via a connection as a result.

The updated about box contains more information and a 'Copy Details to Clipboard' feature, which

can provide our support team with useful information about your installation for trouble shooting.

Bug Fixes:

784: HDRLS: Fixed visible join seam over horizontal image boundary on flat mapped HDRI map.

713,800,801: 3ds Max: Crash bug when starting HDR Light Studio with 3ds Max, due to certain

interface layouts.
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709: Cinema 4D: Remove the AVX compiler flags from libs and plug-in.

645: HDRLS: Light Control rotation button is now correctly disabled when Advanced Rotations are

being used.

627: 3ds Max / Octane: Alpha not showing properly on Area Lights with Octane 2019.

697: HDRLS: Crash bug fixed when right clicking on a Content Preset, choosing 'Apply Content to

Selected Light' when no Light is selected.

704: Maya / Octane: Area Light Alpha not appearing correctly.

714: HDRLS: Crash Bug, Duplicate Presets would cause a crash at start-up - this is now handled.

583: HDRLS: Crash Bug, A Production Render with saving the Render View option enabled. This is

fixed and also an enhancement added to save all render views as PNG files with LUT applied.

723: HDRLS: Preset Thumbnails were not updating with LUT changes for that panel.

763: HDRLS: Composite Presets Broke Between T2 and T3 with black thumbnail.

HDR Light Studio (Tungsten Drop 3)

Version: Tungsten (Drop 3)

Build Date: 2019.1205

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.12.0 (Sierra)  or later

Linux: Certified against: Scientific Linux 7.2

Compatible with: Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE

13.2+

Connection Requirements:

3ds Max - 2018, 2019, 2020 - Plug-in build 2019.0531

Cinema 4D - 19, 20, 21 (Requires R21.1 (build 21.115) and higher) - Plug-in build 2019.1113

(updated)

DeltaGen - 2017, 2018 (and the x-builds), 2019 (and the x-builds) - Plug-in build 2019.0115

Houdini - 17, 17.5, 18 - Plug-in build 2019.1203 (updated)

Maya - 2017, 2018, 2019 - Plug-in build 2019.0531

MODO - 11, 12, 13 (Windows and OSX) - Plug-in build 2019.0710

LightWave 3D - 2018, 2019 - Plug-in build 2019.0123

Rhino 5 - Plug-in build 2018.0206 

Rhino 6 - Plug-in build 2019.0624

Octane Standalone: 4, 2018, 2019, 2020 (Windows only) , Plug-in build 2019.1203 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.
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WHAT'S NEW?

Houdini Connection

Support for V-Ray, Octane and RenderMan has been added to the Houdini Connection. This adds

to existing support for: Redshift, Arnold and Mantra renderers.

Support added for Houdini 18

Updated documentation here.

HDRI Haven Presets

We have selected a range of useful interior and exterior HDRI maps from the HDRI Haven web site.

These HDRI maps are available to anyone for free due to their generous CC0 license. For your

convenience we have created a Preset Pack adding these HDRI maps to HDR Light Studio. These are

provided at a resolution of 2,048 pixels wide. You can download higher resolutions if required from

HDRI Haven. This Preset Pack can be downloaded by customers from your account at

www.lightmap.co.uk.

Faster Applications Startup

The first time HDR Light Studio Tungsten Drop 3 runs, it will build a cache of thumbnail images on

disc for the installed Presets. Thereafter, HDR Light Studio Presets are available to see immediately

after application start up.

Float HDR Light Studio UI Panels

Use the new 'undock icon' whilst pressing the Control Key (Command on MacOS) to undock and float

a user interface panel in HDR Light Studio. You can then move this UI panel over the top of the HDR

Light Studio interface without it snapping back into the interface. Double click the top bar of the

floating UI panel to return it to dock in the interface.

Cinema 4D Connection

Support has been added for R21 - Updated documentation here.

Octane Standalone Connection

Connections added for Octane Standalone 2019 and 2020

LibPNG 15.0

LibPNG 15.0 now shipped with the Linux Distro if required

Bug Fixes:

HDR Light Studio internal Render View: Fixed a bug where we did not handle Alembic hierarchies

correctly, resulting in partially loaded scenes.

C4D: Redshift - Area Light width and height controls incorrectly swapped over.

https://hdrihaven.com/
https://hdrihaven.com/
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C4D: Redshift - Production Rendering was turning off shadows from the environment lighting.
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HDR Light Studio (Tungsten Drop 2)

Version: Tungsten (Drop 2)

Build Date: 2019.0719

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.12.0 (Sierra)  or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE 13.2+

Connection Requirements:

3ds Max - 2018, 2019, 2020 - Plug-in build 2019.0531 (updated)

Cinema 4D - 18,19, 20 - Plug-in build 2019.0712 (updated)

DeltaGen - 2017, 2018 (and the x-builds), 2019 (and the x-builds) - Plug-in build 2019.0115

Houdini - 16.5, 17, 17.5 - Plug-in build 2019.0314

Maya - 2017, 2018, 2019 - Plug-in build 2019.0531 (updated)

MODO - 11, 12, 13 (Windows and OSX) - Plug-in build 2019.0710 (updated)

LightWave 3D - 2018, 2019 - Plug-in build 2019.0123

Rhino 5 - Plug-in build 2018.0206 

Rhino 6 - Plug-in build 2019.0624

Octane Standalone: 4 and 2018 (Windows only) , Plug-in build 2019.0716 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1 (Windows only) - No additional plug-in installation required.

(updated)

Maxwell Studio - 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017 and above (Windows) - No additional plug-in installation required.

WHAT'S NEW?

Render View [HDR Light Studio] improvements

Fast Area Lights - Enable this check box and a single average color/brightness is used for the

illumination contribution of the area lights. This means a less noisy render result is achieved far
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faster.

Upgraded Render View to use Embree 3.4.0 tracing engine - faster performance on many scenes - up

to 40% faster.

Cinema 4D Connection

See your Cinema 4D Interactive Render inside the HDR Light Studio interface - Supported in

Cinema 4D R20 only, with Arnold, Octane, Redshift, Thea.

Added support for Corona render - R18,19,20.

See new workflow here

MODO Connection

See your MODO Interactive Render inside the HDR Light Studio interface - Supported in MODO

11,12,13, with MODO Renderer and Octane Render.

See new workflow here for MODO Renderer

See new workflow here for Octane Renderer

Octane Connection

2018 standalone now supported

Other

New Environment Variable That Overrides System TMPDIR For Holding Our Mutexes Under Posix

Systems

Removed support for Mental Images files in HDR Light Studio Render View.

Bug Fixes:

3ds Max Connection - Bug where hidden HDRLS could not be stopped.

3ds Max Connection - HDRLS standin textures to avoid missing files not being used by Arnold.

Maya Connection - LightPaint inaccurate in V-Ray Render View inside HDRLS

Cinema 4D Connection - Duplicating object in C4D incorrectly closes HDR Light Studio.

Cinema 4D Connection / Arnold - Crash/hang bug with area lights and IPR running.

Cinema 4D Connection / Redshift - Camera visibility setting on area lights not working.

Cinema 4D Connection / Arnold - Updated to use TX file for proxy updates and missing textures. 

MODO Connection - Export Selected Via File with Collada not working.

Rhino Connection - Octane Framebuffer in Rhino now supported in Octane 4 and Octane 2018

Demo/Studio/Enterprise

Octane Standalone Connection: Lightpaint sometimes inaccurate.

Octane Standalone Connection: Area lights not correctly synced back up causing scene geometry to

be hidden when area lights toggled on/off 

Octane Standalone Connection: Renaming area lights correctly handled 
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HDR Light Studio (Tungsten Drop 1)

Version: Tungsten (Drop 1)

Build Date: 2019.0426

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.12.0 (Sierra) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE 13.2+

Connection Requirements:

3ds Max - 2017, 2018, 2019, 2020 - Plug-in build 2019.0426 (updated)

Cinema 4D - 18,19, 20 - Plug-in build 2018.1115

DeltaGen - 2017, 2018 (and the x-builds), 2019 (and the x-builds) - Plug-in build 2019.0115 (updated)

Houdini - 16.5, 17, 17.5 - Plug-in build 2019.0314 (updated)

Maya - 2016.5, 2017, 2018, 2019 - Plug-in build 2019.0403 (updated)

MODO - 10, 11, 12, 13 (Windows and OSX) - Plug-in build 2019.0403 (updated)

LightWave 3D - 2015, 2018, 2019 - Plug-in build 2019.0123 (updated)

Rhino 5 - Plug-in build 2018.0206 

Rhino 6 - Plug-in build 2018.1130

Octane Standalone: Windows only, 3.08.1+, 4. Plug-in build 2019.0304 (updated)

VRED - 2017, 2018, 2019, 2020 and 2020.1 (Windows only) - No additional plug-in installation required.

(updated)

Maxwell Studio - 3.2 and 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

WHAT'S NEW - POST TUNGSTEN DROP 1 RELEASE

VRED 2020.1 (Released 26 June 2019)
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Since we released Tungsten Drop 1 - Autodesk released VRED 2020.1, which has added support for

HDR Light Studio ' Area Lights'

See our updated VRED documentation here.

WHAT'S NEW?

New Product Range

You can see the new product range on the buy page at our web site here: www.lightmap.co.uk

Existing licenses continue to work with the new version of HDR Light Studio.

License administrators may wish to look at these notes on how the new software licenses work:

License Changes in Tungsten

Composites are a powerful new addition to HDR Light Studio

You can use Composites to:

· Group Lights

· Control a group of lights (brightness, position, color etc)

· Store Multiple Lighting Designs in one HDR Light Studio project

· Isolate and Edit Individual Lights

· Mask Lights

· Clone and move areas of the HDRI map

· Combine different regions of multiple HDRI maps

· Dissect and take controls of light regions in existing HDRI maps

Read more here and see examples of how to use it: Working with Composites

Select multiple Lights in the Light List

Multiple light selections can be: Deleted, Merged into a Composite, Released from a Composite

Blend Channel

A new drop down called Blend Channel currently allows you to choose if Add blend mode affects the

Color or only Values.

This option works well with the Composite feature - allowing the user to take control over light

sources in an existing HDRI map - see the example here.

http://www.lightmap.co.uk
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Blend Modes

Streamlined

When using blend modes, we have made a few changes making them easier to use. Improved default

settings and removed redundant options from interface.

Low Pass takes into account Alpha

Low Pass blend mode now takes into account the alpha of the light, so that a Low Pass blend can

have a soft edge to its clamping effect.

Mask Setting on Multiply

Mask setting added to Multiply blend mode. Very useful to use in conjunction with Composites. Read

more here

Flat Background Light

A Flat Background light has been added to the tool bar. This is a very useful light setting and having it

available on the tool bar is a time saver.

HDRLS_SCALE_GUI environment variable

Add support to force scale of GUI through HDRLS_SCALE_GUI environment variable. The value

represents the scale size you want. 

Updated Compatibility:

Maya 2019 support added

3ds Max 2020 support added

MODO 13 support added

Houdini 17.5 support added

LightWave 3D 2019 support added

DeltaGen 2019 (and the x-builds) support added

Bug Fixes:

MODO Connection: Fixed Deletes environment textures on load complete notification (no env

texture on re-starting session)

Octane Standalone Connection: Fixed issue with area lights not turning off/on

Octane Standalone: Fixed memory leak

Maya Connection: Fixed issues with VRay VFB not hiding/reloading/restarting properly.

Maya Connection: Fixed issues with ReSync'ing the Arnold FrameBuffer.

Maya Connection: Fixed issue with Maya not refreshing its environment hooks before Starting the

Connection.

Maya Connection: Fixed issues with not handling switching of the Maya scene when HDRLS is

running. 
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Maya Connection: Fix for RenderMan 22.3 support 

3dsMax Connection: Fixed bug from Maxwell new release where environment not being correctly

detected.

Houdini Connection: Send empty string in place of camera name if no camera in use/selected but

there are cameras in the scene. 

Houdini Connection: Updated Arnold to use .tx files for its missing textures. 
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HDR Light Studio (Carbon Drop 5)

Version: Carbon (Drop 5)

Build Date: 2018.1210

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.11 (El Capitan) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE 13.2+

Connection Requirements:

3ds Max - 2017, 2018, 2019 - Plug-in build 2018.1015

Cinema 4D - 17,18,19, 20 - Plug-in build 2018.1115

DeltaGen - 13.1, 2017, 2018 (and the x-builds) - Plug-in build 2018.0118

Houdini - 15.5, 16, 16.5, 17 - Plug-in build 2018.1015

Maya - 2016.5, 2017, 2018 - Plug-in build 2018.1206 (updated)

MODO - 10, 11, 12 (Windows and OSX) - Plug-in build 2018.1204 (updated)

LightWave 3D - 2015, 2018 - Plug-in build 2018.0207

Rhino 5 - Plug-in build 2018.0206 

Rhino 6 - Plug-in build 2018.1130 (New Beta Available)

Octane Standalone: Windows only, 3.08.1+, 4. Plug-in build 2018.1127 (updated)

VRED - 2017, 2018, 2019 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 3.2 and 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

WHAT'S NEW?

HDR Light Studio

Resync button has been added to the Render View (HDR Light Studio).

When using HDR Light Studio standalone - the resync button will reload the current scene back into

the Render View.
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When using HDR Light Studio connected to a 3D app - the resync button will open the 'Import Scene

Geometry' panel - so you can re-import the scene from your host 3D software.

This is useful if you have made changes to the scene in your 3D software.

Rhino 6 Connection - (BETA Version)

Rhino 6 support is now released with a new updated Connection workflow. Rhino's rendered

viewport is now displayed inside the HDR Light Studio interface where users can paint the shot with

lighting.

Compatible with Cycles, Octane, V-Ray, and other renderers using the Rhino Environments for

lighting. Read more

Octane Standalone Connection

Octane Standalone version 4 is now supported

Octane Render version 4

Octane 4 has now been tested, and we can confirm is compatible with our 3ds Max, Maya, Cinema

4D, MODO and Rhino 6 Connection.

Bug Fixes

MODO Connection - Fixed bug where initial state of lighting shared with Modo was black until one

lighting change was made.

Maya Connection - Fixed a bug resulting in duplicated area lights caused by a change in Arnold 3.1.1



69

69HDR Light Studio - User Guide

HDR Light Studio (Carbon Drop 4)

Version: Carbon (Drop 4)

Build Date: 2018.1023

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.11 (El Capitan) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7, Fedora 19+ (not 27 though), Ubuntu 13.10+, Mint 16+, Debian 8+, OpenSUSE 13.2+

Connection Requirements:

Octane Standalone: Windows only, 3.08.1 or higher. Plug-in build 2018.0717

Cinema 4D - 17,18,19, 20 - Plug-in build 2018.1115 released 19th Nov 2018 (updated, fixes issue

with 2018.1108 build)

LightWave 3D - 2015, 2018 - Plug-in build 2018.0207

Maya - 2016.5, 2017, 2018 - Plug-in build 2018.1023 (updated)

MODO - 902, 10, 11, 12 (Windows and OSX) - Plug-in build 2018.0424

3ds Max - 2017, 2018, 2019 - Plug-in build 2018.1015 (updated)

Houdini - 15.5, 16, 16.5, 17 - Plug-in build 2018.1015 (updated)

DeltaGen - 13.1, 2017, 2018 (and the x-builds) - Plug-in build 2018.0118

Rhino - 5 - Plug-in build 2018.0206

VRED - 2017, 2018, 2019 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 3.2 and 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

New Features:

Light Content Properties have been tabbed to save space and reduce the need for scrolling -

See here

Gamma control has been added to images - See here
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Content Presets (Content:Images, Content:Bulbs, Content: Gradients etc.) are even easier and

faster to use:

· Drag and drop onto any of the new content tabs (Master, Value Blend, Alpha Multiply)

· Right Click on Content Preset thumbnail and choose 'Apply to Current Light' to apply (Master

Content).

· Drag and Drop Content Presets onto lights in the Light List to apply them (Master Content).

See here

Resolution of loaded image content is now displayed in the Light Properties panel.

Middle mouse wheel scrolling does not scroll through the contents of a drop down list when the

cursor is over the drop down. This change in behavior prevents accidental changing of light

properties when scrolling up and down the light properties panel.

Batch Import of images as Element:Images

Easily add a batch of images to your User Presets, as Element: Images, by dragging and dropping the

images onto the Presets panel in HDR Light Studio. See here

Resolution of loaded image is now shown on light properties panel

Houdini Connection

Updated to support Houdini 17

Maya Connection 

Updated to support RenderMan 22.

Fixing issues with latest Octane Render (API was overhauled and broke HDR Light Studio

compatibility).

Maya/Octane: Later release of Octane broke HDR Light Studio compatibility. This has now been fixed.

Maya/Octane: Fixed a potential crash issue when starting the Octane IPR in Maya via HDR Light

Studio.

3ds Max Connection

3ds Max/VRay Next: Fix issue with toggling area lights on and off.

3ds Max / Redshift: Updated to use the new Redshift Render View, this will only work with Redshift

2.6.24+

Bugs Fixed

Production Render crash fix when lights are placed with a latitude of 90 (at the bottom of the map).
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Cinema 4D Connection - 2018.1115 released 19th Nov 2018 (updated, fixes issue with 2018.1108

build)

Fixed bug where existing embedded HDR Light Studio projects were not loading using the C4D

Connection 2018.1108 build

Added support for Cinema 4D r20

Fixed: Area light textures not working correctly with Redshift

Fixed: HDRLS connection panel was not showing current renderer

Fixed: Thea area lights having texture facing wrong direction
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HDR Light Studio (Carbon Drop 3)

Version: Carbon (Drop 3)

Build Date: 2018.0725

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.11 (El Capitan) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7

Fedora 19+ (not 27 though)

Ubuntu 13.10+

Mint 16+

Debian 8+

OpenSUSE 13.2+

Connection Requirements:

Octane Standalone: Windows only, 3.08.1 or higher. Plug-in build 2018.0717 (new)

Cinema 4D - 17,18,19 - Plug-in build 2018.0723  (updated)

LightWave 3D - 2015, 2018 - Plug-in build 2018.0207

Maya - 2016.5, 2017, 2018 - Plug-in build 2018.0725  (updated)

MODO - 902, 10, 11, 12 (Windows and OSX) - Plug-in build 2018.0424

3ds Max - 2016, 2017, 2018, 2019 - Plug-in build 2018.0724 (updated)

Houdini - 15.5, 16, 16.5 - Plug-in build 2018.0615 (updated)

DeltaGen - 13.1, 2017, 2018 (and the x-builds) - Plug-in build 2018.0118

Rhino - 5 - Plug-in build 2018.0206

VRED - 2017, 2018, 2019 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 3.2 and 4 (Windows only) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

New Features:

Presets get a major expansion!
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Rigs, Content and Elements have been added to the Presets types. You now save your own Presets

too. Find out more here.

Octane Standalone Connection

New Connection released for Octane Standalone. Find out more here.

Houdini Connection

Houdini Connection has been updated to support Area Light creation and control. Plus Redshift

suppoort added. Find out more here.

3ds Max Connection

V-Ray Next is now supported (with some issues)

Bugs Fixed

Spherical mapping longitude slider not mapping correctly

Rotations on spherical mapped lights were not being applied when changed from the GUI 
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HDR Light Studio (Carbon Drop 2)

Version: Carbon (Drop 2)

Build Date: 2018.05.04

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.11 (El Capitan) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7

Fedora 19+ (not 27 though)

Ubuntu 13.10+

Mint 16+

Debian 8+

OpenSUSE 13.2+

Connection Requirements:

Cinema 4D - 17,18,19 - Plug-in build 2018.0418 (updated)

LightWave 3D - 2015, 2018 - Plug-in build 2018.0207

Maya - 2016.5, 2017, 2018 - Plug-in build 2018.0426  (updated)

MODO - 902, 10, 11, 12 (Windows and OSX) - Plug-in build 2018.0424  (updated)

3ds Max - 2016, 2017, 2018, 2019 - Plug-in build 2018.0418 (updated)

Houdini - 15, 16 (and their .5's) - Plug-in build 2018.0131

DeltaGen - 13.1, 2017, 2018 (and the x-builds) - Plug-in build 2018.0118

Rhino - 5 - Plug-in build 2018.0206

VRED - 2017, 2018 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 3.2 and 4 (Windows and OSX) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

Main New Features:

Value Blend

Box Gradient
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Connection Updates:

New Maya Connection Interface – Shelf Buttons replace the Connection Panel

3ds Max 2019 Connection release

MODO 12 Connection release

DeltaGen 2018x and DeltaGen Stage 2018x Connection release

Enhancements:

Production Render Speed Improvements

Big performance boost with production renders containing lights using gradient ramps (which is

many light types), especially large lights. Additionally lighting designs containing many small lights

will see significant render speed improvements too, with smarter use of render threads.

Brightness Slider Enhancements

New buttons have been added to each end of the brightness slider. They provide a more

photographic approach to adjusting the light brightness. They work by adjusting the brightness

relative it's current value. So you can double, halve, increase by 1/3 or decrease by 1/3. This is a really

useful addition when an art director wants a light brightening by 1 stop for example. (Double the

brightness).

All Lights are now Uber Lights

When we released HDR Light Studio 5 we wanted to make sure it was easy to use, so the toolbar

created simple lights with fewer settings. But many users don’t take advantage of converting them to

Uber Lights that provide all possible settings. So in this release all lights are now created as Uber

Lights, which include the Alpha Multiply and Value Blend options.

Light List Button Behavior

Using the buttons on a light in the Light List (on/off, solo, etc) no longer selects the light. It was

common for a user to turn off a light and not expect it to be selected, and move a newly hidden light

by accident for example. The new behaviour avoids this problem.

Region Zoom on the Render View

A tool has been added to the tool bar on the Render View (HDR Light Studio) for region zoom. This

was available previously only as a keyboard shortcut.

Color Coded Light Properties

With the addition of the new Value Blend on the Light Properties panel, it was easy to confuse which

properties you were editing. We have color coded each section making it easier to navigate the

properties.

LUT control for Preset Panel

The Presets panel now has a LUT drop down to view the presets with correct color space.
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Bug Fixes:

Bug 2147: 3ds Max crash bug with area lights related to a dome light that no longer exists.

Bug 2148: 3ds Max crash if you reload a scene file in the same session that has a valid HDRLS env

hook.

Bug 2150: 3ds Max. If you create a new hook via the New Hook button, the Environment Hook status

indicator doesn't update to indicate that a valid hook is now selected.

Bug 1732: Maya/Arnold - area lights are not hidden when solo'd or turned off in HDRLS
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HDR Light Studio (Carbon Drop 1)

Version: Carbon

Build Date: 2018.0213

Requirements:

Windows: 7, 8, 8.1, 10

Mac OS: 10.11 (El Capitan) or later

Linux:

Certified against: Scientific Linux 7.2

Compatible with: 

Centos 7

Fedora 19+ (not 27 though)

Ubuntu 13.10+

Mint 16+

Debian 8+

OpenSUSE 13.2+

Connection Requirements:

Cinema 4D - 17,18,19 - Plug-in build 2018.0208

LightWave 3D - 2015, 2018 - Plug-in build 2018.0207

Maya - 2016.5, 2017, 2018 - Plug-in build 2018.0202

MODO - 902, 10, 11 (Windows and OSX) - Plug-in build 2018.0129

3ds Max - 2016, 2017, 2018 - Plug-in build 2018.0201

Houdini - 15, 16 (and their .5's) - Plug-in build 2018.0131

DeltaGen - 13.1, 2017, 2018 (and the x-builds) - Plug-in build 2018.0118

Rhino - 5 - Plug-in build 2018.0206

VRED - 2017, 2018 (Windows only) - No additional plug-in installation required.

Maxwell Studio - 3.2 and 4 (Windows and OSX) - No additional plug-in installation required

SOLIDWORKS Visualize - 2017, 2018 (Windows) - No additional plug-in installation required.

New Features:

HDR Light Studio has been updated to support HI-DPI display

A new Render View panel can display the interactive render image from host 3D software/renderer

(Currently supports 3ds Max and Maya) - See here for details

Much faster performance when using Area Lights in HDR Light Studio's Render View, even with huge

models.

HDR Light Studio Render View now supports diffuse color selection

3ds Max connection has been updated with a easier workflow, including automated IBL hook

creation.

Maya connection has been updated with a easier workflow, including automated IBL hook creation.

New panel for easy floating license setup on client machines.

HDR Light Studio interface layout is stored on a per connection basis. Ensuring you can have a
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preferred interface layout when using with each connection.

Added new keyboard shortcuts for Save Project (CTRL + S) and Save Project As (CTRL + ALT + S). 

Cinema 4D - Redshift support added. V-RayforC4D 3 fully supported.

LightWave 2018 support added

Improvements:

Faster HDR Light Studio start up

The HDR Light Studio render view does not load a file or start rendering until play button is pressed

Much faster rendering of the procedural sky

The interface has been adjusted to be more compact, with tools on the Render Views and Canvas

now down the left of the view, allowing for more compact layouts.

New 'hdrlightstudio' OCIO settings ensure the default display LUT is set to sRGB when starting HDR

Light Studio.

Dump License Info setting in preferences - Enables licensing diagnostics in logging when logging is

enabled. By being turned off this speeds up HDR Light Studio when logging in on.

3ds Max / V-Ray - added support for VRay RT in Production mode, switching between V-Ray RT and V-

Ray Adv maintains lighting design correctly.

Updated to use OpenImageIO 1.7.10

Changes:

Releases are getting 'nick names' instead of release numbers - this is the Carbon release.

Removed support for OBJ files in HDR Light Studio's Render View

Camera move tools removed - users should load 3D scene with camera included

Removed roughness setting from Render View shader.

Removed support for Mental Ray and iRay renderer in our connections.

Maya - Removed mental images export format and reliance on mental images code

When in unlicensed mode, water marks appear on the live output content only, not in the lighting

used by the internal Render View.

Maya - Removed old RenderMan version support. Now only version 21 is supported.

HSV(A) is now the Default Channel View for Canvas, Render View (HDRLS) and Light Preview. 

Key Bugs Fixed:

BZ# 1979 Area lights were not being set to use a texture correctly under C4DtoA 

Cinema 4D - Copy Paste bug

Improvements to always on top behavior with HDR Light Studio

Crash fix when removing the last peg on a gradient.

BZ# 848: Now using regular combo boxes means click/drag/release now works as expected. 

BZ# 1703 Warnings on AreaLight deletion and re-syncing (Modo 11) 

UV Projection type moved from connector to texture (caused errors when creating area lights) 

BZ# 20 Preventing Production Render Over Used Asset 
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Known Issues:

Drop down menus can appear on wrong display with MacOS running more than one display.
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HDR Light Studio 5.4.2

Version: 5.4.2

Build Date: 2017.0313

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 16,17,18,19 - Plug-in build 2017.1123

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2015, 2016, 2016.5, 2017 - Plug-in build 2016.1122

Maya - Version 2018 - Plug-in build 2017.1116

MODO - Versions 801, 901, 902, 10, 11 - Plug-in build 2016.1102

3ds Max - Versions 2014, 2015, 2016, 2017 - Plug-in build 2017.0118

Houdini - Versions 13,14,15 - Plug-in build 2016.1102

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1, 2017, 2018 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016, 2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 (Windows and OSX) - No additional plug-in installation required - Please

note Maxwell Studio 4 is not yet supported

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

New Features:

Re-instated 3ds Max 2014 Connection due to popular demand

Houdini 16 Connection added

Maya Connection for Linux, has additional build against Python 2.7

Bugs Fixed:

Critical Bug Fix: Issue fixed where rotations are broken when importing pre v5.3 project files. 
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HDR Light Studio 5.4.1

Version: 5.4.1

Build Date: 2017.0131

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 16,17,18 - Plug-in build 2016.1124

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2015, 2016, 2016.5, 2017 - Plug-in build 2016.1122

MODO - Versions 801, 901, 902, 10 - Plug-in build 2016.1102

3ds Max - Versions 2015, 2016, 2017 - Plug-in build 2017.0118

Houdini - Versions 13,14,15 - Plug-in build 2016.1102

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1, 2017 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016, 2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 (Windows and OSX) - No additional plug-in installation required - Please

note Maxwell Studio 4 is not yet supported

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

New Features:

Added support for Redshift renderer in 3ds Max. 

Render View now supports transparency for Area Lights.

Rear of area lights have a light icon image mapped to them, to identify the back of light.

Bugs Fixed:

Critical Bug Fix: Issue Fixed with light brightness slider and value displaying incorrect brightness in

the interface for brightnesses over 2000 after switching lights.
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Critical Bug Fix: When loading projects from eariler versions of HDR Light Studio, version 5.4 would

disregard the lights rotation setting, giving all lights a rotation of 0.

Critical Bug Fix: Fixed the crash bug with SolidWorks Visualize

Fixed bug with Maya/Arnold - HDR Light Studio production render content coming through in the

wrong file format.

Increased sky shader sampling for more accurate colour - this is significantly slower to render as a

result.
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HDR Light Studio 5.4

Version: 5.4

Build Date: 2016.1212

Release Date: 16 Dec 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 15,16,17,18 - Plug-in build 2016.1124

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016, 2016.5, 2017 - Plug-in build 2016.1122

MODO - Versions 701, 801, 901, 902, 10 - Plug-in build 2016.1102

3ds Max - Versions 2014, 2015, 2016, 2017 - Plug-in build 2016.1208

Houdini - Versions 13,14,15 - Plug-in build 2016.1102

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1, 2017 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016, 2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 (Windows and OSX) - No additional plug-in installation required - Please

note Maxwell Studio 4 is not yet supported

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

What's New:

Re-positionable light handle - Click here for more details

Advanced Rotation Settings for 3d Mapped and Area Lights: X,Y,Z rotations + Rotation Modes: Free, V-

Lock, H-Lock, Fixed - Click here for more details

Relink Presets - restore file links to preset light textures from projects made on another computer -

Click here for more details

Render View and Canvas - Cursor now changes when in those views depending on tool selection.
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Double click slider labels to reset the slider to it's default value.

32 new studio light sources

Cursor changes to indicate 'click and drag' buttons - i.e. Light Controls, Exposure, X,Y,Z rotations.

Added support for Cinema 4D R18

Improved aspect ratio button for image content

3ds Max, Maya, Cinema 4D and MODO connections updated to work with new advanced rotations

for area lights.

Bugs Fixed:

HDR Light Studio

Problems fixed with canvas/HDR content not being correctly updated when un-soloing lights and

resizing the canvas.

Bug 1376: Keyboard light nudge controls horizontally reversed now canvas flipped and viewed from

"inside". 
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HDR Light Studio 5.3.5

Version: 5.3.5

Build Date: 2016.0810

Release Date: 11 August 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 15,16,17 - Plug-in build 2016.0511

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016, 2016.5, 2017 - Plug-in build 2016.0804

MODO - Versions 701, 801, 901, 902, 10 - Plug-in build 2016.0621

3ds Max - Versions 2014, 2015, 2016, 2017 - Plug-in build 2016.0809

Houdini - Versions 13,14,15 - Plug-in build 2016.0809

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1, 2017 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016, 2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

Changes:

Added support for DeltaGen 2017

Added support for 3ds Max 2017

3ds Max / Corona - Environment now uses Corona Bitmap

3ds Max - added beta support for Arnold in 3ds Max 2017

3ds Max - added beta support for ART Renderer in 3ds Max 2017

Added support for Maya 2017

Added support for Maya/RenderMan 21

Fixed broken Alpha on Maya V-Ray area lights

V-Ray area lights are now correctly scaled using U and V size parameters in Maya and 3ds Max
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HDR Light Studio 5.3.4

Version: 5.3.4

Build Date: 2016.0627

Release Date: 1 July 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 15,16,17 - Plug-in build 2016.0511

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016, 2016.5 - Plug-in build 2016.0512

MODO - Versions 701, 801, 901, 902, 10 - Plug-in build 2016.0621

3ds Max - Versions 2014, 2015, 2016 - Plug-in build 2016.0623

Houdini - Versions 13,14,15 - Plug-in build 2016.0425

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016, 2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

Changes:

Area Light Camera Visibility is now on by default on Area Light creation.

New Smart Dolly Scalar setting in Preferences Panel.

Fixed mapping issue with SolidWorks Vizualise.

Updated Render View Tessellation Code - Now more robust and can handle more edge cases with

geometry.

Fixed a crash bug when HDR Light Studio restores host HDRLS projects that reference an Alembic file

on disc.

Fixed an issue with incorrect illumination from Area Lights in the Render View for very small models.

Fixes for a range of version 4 project import issues regarding light visibility.



87

87HDR Light Studio - User Guide

HDR Light Studio 5.3.3

Version: 5.3.3

Build Date: 2016.05.12

Release Date: 12 May 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 15,16,17 - Plug-in build 2016.0511

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016, 2016.5 - Plug-in build 2016.0512

MODO - Versions 701, 801, 901, 902 - Plug-in build XXXXXX

3ds Max - Versions 2014, 2015, 2016 - Plug-in build 2016.0505

Houdini - Versions 13,14,15 - Plug-in build 2016.0425

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016,2017 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

New Features:

Support for HDR Light Studio Area Lights has been added to Cinema 4D and 3ds Max.
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HDR Light Studio 5.3.2

Version: 5.3.2

Build Date: 2016.0323

Release Date: 23 March 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 14,15,16,17 - Plug-in build 2015.1102

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016 - Plug-in build 2016.0323

MODO - Versions 701, 801, 901, 902 - Plug-in build 2016.0225

3ds Max - Versions 2013, 2014, 2015, 2016 - Plug-in build 2016.0104

Houdini - Versions 12,13,14,15 - Plug-in build 2016.0219

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

Improvements:

Renderman is now supported on all Platforms in the Maya Connection

Known Issues:

When using HDR Light Studio on OSX with 2 displays, if they are different resolutions, then drop

down menus in HDR Light Studio can be drawn in the wrong location on the screen. The software

remains usable. We are working on a fix for this.
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HDR Light Studio 5.3.1

Version: 5.3.1

Build Date: 2016.0314

Release Date: 15 March 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 14,15,16,17 - Plug-in build 2015.1102

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016 - Plug-in build 2016.0225

MODO - Versions 701, 801, 901, 902 - Plug-in build 2016.0225

3ds Max - Versions 2013, 2014, 2015, 2016 - Plug-in build 2016.0104

Houdini - Versions 12,13,14,15 - Plug-in build 2016.0219

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

Fixed Bugs:

Fixes a major bug with the mapping of planar and spherical content - which was being placed with

incorrect orientations.

Fixes a memory leak with the Render View render engine.
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HDR Light Studio 5.3

Version: 5.3

Build Date: 2016.0301

Release Date: 1 March 2016

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Connection Requirements:

Cinema 4D - Versions 14,15,16,17 - Plug-in build 2015.1102

LightWave 3D - Versions 11, 2015 - Plug-in build 2016.0106

Maya - Versions 2014, 2015, 2016 - Plug-in build 2016.0225

MODO - Versions 701, 801, 901, 902 - Plug-in build 2016.0225

3ds Max - Versions 2013, 2014, 2015, 2016 - Plug-in build 2016.0104

Houdini - Versions 12,13,14,15 - Plug-in build 2016.0219

DeltaGen - Versions 12.1, 12.2, 13.0, 13.1 - Plug-in build 2016.0218

Rhino - Version 5 - Plug-in build 2015.1123

VRED - Version 2014, 2015, 2016 (Windows only) - No additional plug-in installation required.

Maxwell Studio - Version 3.2 and above (Windows and OSX) - No additional plug-in installation

required.

SOLIDWORKS Visualize - Version 2016 (Windows) - No additional plug-in installation required.

New Features:

Area Lights

Lights in HDR Light Studio with 3D mapping can now be promoted to become Area Lights in 3D

space. The first Connection to support this new feature is the Maya Connection. The updated Maya

Connection supports live HDRI map and Area Light creation with renderers: Mental Ray, Arnold, V-

Ray, Maxwell, Redshift, Octane, Renderman (RIS) and iRay for Maya. (Renderman (RIS) is currently

supported on Windows and Linux only.)

Convert to Uber Light

There is a new menu command that can be used to convert any selected light into an Uber Light. For

example, the user may place a Picture Light from the tool bar, and decide they want to add an alpha

to the image. This is only possible when using the Uber Light, therefore using ‘Edit > Convert to

UberLight’ allows the light to preserve all of the light’s settings, and gain the flexibility of being an
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Uber Light with more properties available to change.

Render View – Continuous Updates

Users can drag lights using LightPaint on the Render View, and experience continuous updates to the

Canvas and Render View.

New Area Lights can also be moved, scaled and rotated with continuous updates in the Render View.

Aspect Ratio on Images

New button in image content,  to adjust the height of the light to match the image's aspect ratio.

License Management Panel

Users can now easily see what licenses they have installed and when they will expire. The new

License Management panel displays both main app and connection licenses, their type, expiry date

(days left), plus the last build date that the licenses will run.

New Compatibility:

Maya / iRay for Maya

Modo 902

SOLIDWORKS Visualize 2016

Improvements:

Canvas: Canvas view has been flipped horizontally, so the user is now looking at the HDRI map from

world origin. Therefore when area lights are added, the Canvas is an accurate view of the lighting

scene from the world origin viewpoint.

User Interface: Keyboard shortcuts are now displayed in menu commands where possible. Example:

Edit > Undo   Ctrl + Z

Render View: Support for specifying the fresnel as an IOR.

Render View: Display LUT is active during camera moves.

Render Settings: 3d scene file slot, and the background image file slot both support dragging and

dropping files from the OS.

Render View: Performance has been improved when moving the camera.

Render View: New Fit Scene to View button for Freecam mode.

Render View / Render Settings: The time in the Render View is now specified as a frame number,

which is more useful for a 3D artist than the seconds that are embedded in an Alembic file. Therefore

we have now added a FPS setting in the Render View, so the user can input the frame rate for the

shot.

Render View: Added Tilt Camera Tool for Freecam mode.
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Render Settings: New roughness setting for the reflection roughness/glossiness value

Render Settings: Added checkbox for toggling floor plane on and off.

HDR Light Studio license type is displayed in the top bar of the application.

User Interface: Small change to color scheme tone, input boxes are now darker in color and stand

out more on the interface.

Host Presets: Cinema 4D/Corona has been added for production render orientation settings

Production Render: New optional settings for the additional output of Thumbnail PNGs for lights,

Render View PNG, and a Saved HDR Light Studio Project File.

All HDR Light Studio application settings can now be removed via a command line option.

Light Controls / Exposure Control: New keyboard controls to change the sensitivity when dragging.

Light Controls: New Smart Dolly button, click and drag and Smart Dolly selected area light.

Fixed Bugs:

Bug 1154 - Dragging Lat / Long Sliders when used with Connections causes slow performance in host.

Bug 825 - Crash bug: Fixed crashing issue with spherical mapping and gradient content.

Bug 1265 - Bulb offsets from v4 projects inverted on loading to match v4 output.

Bug 1232 - All connections: When starting HDR Light Studio with an embedded project, the initial

lighting didn't match until a change was made.

Bug 1262 - Version 5 was not honoring on/off light state when loading V4 projects.

Bug 1128 - Alembic importer now handles polygon mesh nodes that do not contain any geometry

Bug 1212 - Over Blend mode bug affecting brightness of other lights on the canvas

Bug 1214 - Fixed issues with the License Activation dialog appearing behind the main window when

Always on Top is turned on. 

Bug 929 - Fixed Undo bug where Light Preview and Light List thumbnails were not updating after

Undo.

Bug 974: Drag and drop disabled on Render View whilst a load is in progress, to prevent crash.

Bug 1005 - Fixed crash on HDRLS exit when referencing Alembic file

Known Issues:

Area Lights are not visible through the HDR Light Studio shadow catcher floor plane. Workaround:

Turn off 'Show Floor Plane' option in the Render Settings.

Area Lights alpha channel is not supported in the HDR Light Studio Render View, which uses a pre-

multiplied RGB version of the content.
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Moving Area Lights with Cam Visibility 'On' slows down the Render View performance due to

invalidating the cached image based lighting. 
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HDR Light Studio 5.2.1 (2015.1102)

Version: 5.2.1

Build Date: 2015.1102

Release Date: 3rd November 2015

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Cinema 4D 14,15,16,17 connection, build 2015.1028

LightWave 3D connection, build 2015.0707

Maya connection, build 2015.0814

MODO connection, build 2015.0625

3ds Max 2013, 2014, 2015, 2016 connection, build 2015.1021

Houdini 12,13,14,15 connection, build 2015.1023

DeltaGen 12.1, 12.2, 13.0 connection, build 2015.0522

Rhino 5 connection, build 2015.1103

VRED 2014, 2015, 2016 (Windows only) - no plug-in connection required.

Maxwell Studio 3.2 (Windows and OSX) - no plug-in connection required.

New Features

New support for:

Houdini 15 Connection

Cinema 4D R17 Connection

Rhino Connection

Maxwell Studio Connection

3ds Max Connection updated to support Octane version 2.23.2-2.8 and above 
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HDR Light Studio 5.2.1

Version: 5.2.1

Build Date: 2015.0820

Release Date: 21 August 2015

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Cinema 4D connection, build 2015.0626

LightWave 3D connection, build 2015.0707

Maya connection, build 2015.0814

MODO connection, build 2015.0625

3ds Max 2013, 2014, 2015, 2016 connection, build 2015.0625

Houdini 12,13,14 connection, build 2015.0814

DeltaGen 12.1, 12.2, 13.0 connection, build 2015.0522

VRED 2014, 2015, 2016 (Windows only) - no plug-in connection required.

Improvements

A critical stability issue relating to communications between HDR Light Studio and host connections

has been fixed in this release that was causing occasional crashes for some customers.

Fixed Bugs

BUG 961 - Critical stability fix relating to communications between HDR Light Studio and host

connections.
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HDR Light Studio 5.2

Version: 5.2

Build Date: 2015.0716

Release Date: 23 July 2015

Requirements

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Cinema 4D connection, build 2015.0626

LightWave 3D connection, build 2015.0707

Maya connection, build 2015.0630

MODO connection, build 2015.0625

3ds Max 2014, 2015, 2016 connection, build 2015.0625

Houdini 12,13,14 connection, build 2015.0706

VRED 2014, 2015, 2016 (Windows only) - no plug-in connection required.

New Features

A Houdini connection has been released with this version of HDR Light Studio. This connection

supports Houdini 12, 13 and 14 on Windows, Mac OS X and Linux.

The 3ds Max plug-in connection now supports the Corona renderer.

The Cinema 4D plug-in now supports the Arnold renderer and the Thea renderer.

The Maya plug-in connection now supports the  Renderman 20 environment node (new named node

- PxrStdEndMapLight)

Alembic scene export has been added to the MODO connection to support animated content. Artists

can choose to transfer the proxy environment map from HDR Light Studio to MODO as an EXR file (as

an alternative to the HDR format currently supported). EXR proxy files support transparency via the

alpha channel.

Saving Layouts - users can now save up to 4 of their favourite window/panel layouts.

The Render View image can be saved as an image file on the file system.

Improvements

Render View
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The resolution of the render view image is set in the Render Settings rather than from the size of the

user interface panel. Changes to the position and size of the panels no longer triggers a re-render of

the model and makes layout changes much more responsive.

Added Ctrl left click and drag to zoom into an area of the render view.

The layout of the Render Settings panel has been improved. There are two sections, one for

parameters that do not trigger a re-render and the other for settings that do.

Keyboard shortcuts to switch LightPaint modes have been added.

Ctrl-1 switches to Reflection.

Ctrl-2 switches to Illumination.

Ctrl-3 switches to Rim.

The default display LUT (None, sRGB, rec709) for HDR Light Studio can be globally set in the

Preferences panel, rather than individually set in each panel.

Picture Lights - Image files can be dragged from the file system directly onto the image path in the

Light Properties panel, rather than browsing for the image.

Up and down arrow keys on the keyboard can now be used to nudge numeric values in edit boxes.

Sky Background

Added a vertical alpha ramp to control the softness of the horizon.

Added sun disc softness.

Energy conservation - changing the size of the sun varies the brightness to preserve the same

illumination of the model.

When duplicating a light a dialog allows the user to enter a name for the copied light.

Duplicated lights appears directly above the source light rather than at the top of the list.

On deleting a light, the light below is automatically selected allowing users to rapidly delete lights

down the light list.

Added "Arrange" and "Rename" options to the right click context menu on the light list.

The user interface of all plug-in connections have been tweaked to improve consistency of

terminology and function, making it easiest to switch between them.

Fixed Bugs

Pausing the rendering in the Render View panel would not actually stop the rendering. This has been

fixed. Pausing now stops the collection of samples but allows users to update the lighting. When the

Render View panel is hidden no rendering occurs.

The LightCam mode in the Render View did not show the correct 3D camera controls. This has been

fixed.

When using the 3ds Max or MODO plug-in connections, the scene data would be lost when hiding or

pausing HDR Light Studio. This has been fixed.
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BUG 340 - if HDRLS_LOG_FILE was set to a path that did not exist, HDR Light Studio would crash. This

has been fixed.

BUG 465 - if HDRLS_LOG_FILE was set to a directory, HDR Light Studio would crash. This has been

fixed.

BUG 823 - it was not possible to change the OCIO settings from Nuke Default in the Preferences

panel. This has been fixed.

BUG 894 - if you loaded a project containing lights and then deleted a light, that delete operation was

not undoable. This has been fixed.

BUG 966 - when running HDR Light Studio 5.0 with VRED, some customers would occasionally get an

error saying "Listening Error: Failed to send over header and raw data for

[HDRLS_NOTIF_LIVEUPDATE_RAW] notification". This has been fixed.

BUG 845 - when using KeyShot or VRED with HDR Light Studio 5.1, if you launch the Production

Render dialog, select Destination=Live and render, HDR Light Studio will crash. This has been fixed.

Known Bugs & Workarounds

BUG 961 - on Mac OS X and Linux there is a bug that can result in connection errors when using plug-

in connections. It has been observed on MODO, Houdini and Cinema 4D but may affect other plug-

ins too. The workaround is to force quit HDR Light Studio, save your scene and quit your 3D

application. Then start it up again.
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HDR Light Studio 5.1

Version: 5.1

Build Date: 2015.0527

Release Date: 1 June 2015

Requirements

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Cinema 4D connection, build 2015.0324

LightWave 3D connection, build 2015.0408

Maya connection, build 2015.0527

MODO connection, build 2015.0527

3ds Max 2013, 2014, 2015 connection, build 2015.0422

3ds Max 2016 connection, build 2015.0520

Improvements

We have further optimised the shared memory in this build. In the previous build using the Maya or

MODO plug-in connections (particularly on Mac OS X and Linux), there was a delay of a few seconds

before a re-render was triggered in the 3D app after a lighting change in HDR Light Studio. To take

advantage of this change, you will need to install the Maya/MODO plug-in connections build

2015.0527 as well as HDR Light Studio 5.1. Bug 829.

Fixed Bugs

BUG 632 - HDR Light Studio 5.0 would crash on Mac OS X if you were using it with a Wacom

pen/tablet. This bug has been fixed.

Known Bugs & Workarounds

BUG 845 - when using KeyShot or VRED with HDR Light Studio 5.1, if you launch the Production

Render dialog, select Destination=Live and render, HDR Light Studio will crash. As a workaround,

select EXR or HDR and render the file to disk.
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HDR Light Studio 5.0

Version: 5.0

Build Date: 2015.0424

Release Date: 12 May 2015

Requirements:

Windows 7, 8, 8.1, 10

Mac OS X 10.7 or later

Linux Fedora 13 and above

Cinema 4D connection, build 2015.0324

LightWave 3D connection, build 2015.0408

Maya connection, build 2015.0422

MODO connection, build 2015.0423

3ds Max 2013, 2014, 2015 connection, build 2015.0422

3ds Max 2016 connection, build 2015.0520

Headline New Features

New full screen interface with panels that can be moved, resized, tabbed and docked.

Preset lights can be dragged from a library and dropped onto the canvas, model or light list.

You can load your own LDR and HDR images as picture lights to illuminate your model. LUT, flip

image, desaturate, invert alpha and unpremultiply options included.

There is a new light type - Uber Light. This allows you to dynamically switch between light shapes and

mappings rather than deleting the light and picking another light type.

Different color channels can be shown on the Canvas - HSV, Alpha, Red, etc. Transparency is shown

using a checkerboard pattern.

The canvas and render view can now be viewed through a LUT.

A pixel probe has been added to the Canvas, so you can view HSVA and RGB values under the cursor.

Click and Drag buttons to scale, rotate and change light brightness. Enables the uniform scaling of

lights with one control.

Render Settings have parameters for fresnel, samples and ray depth.

Light List - new preview thumbnail of the light is shown in the list.

Light List - right mouse click on a light in the list to duplicate, deselect or delete.

Light List - lights can be locked so their properties cannot be changed.
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Light List - lights can be set as non-pickable on the canvas. This is handy for background lights that

cover the whole canvas.

Light List - new solo functionality for one or more lights.

A background image generator that renders realistic skies is included.

A new Gradient light type has been added with linear and radial gradients.

New mapping types have been added - planar and spherical.

New secondary alpha multiply option available.

New content type - flat color provided.

Support for OpenColorIO has been added.

Load Alembic models with parameter to set the time in seconds.

Load FBX models (windows only).

New blend modes have been added - multiply, high-pass (using low pass with invert), hue.

The size of a light can be scaled in width and height keeping their proportions by using the Light

Controls panel.

Headline Improvements

LiveLight is no longer a separate executable. It has been incorporated into HDR Light Studio.

LiveLight has been replaced by a new renderer, powered by Embree 2, that can give instant feedback

when changing the following parameters: HDR lighting, view exposure, diffuse, reflection, shadow or

background image adjustments.

Image import using mip-mapped images is much faster than in HDR Light Studio 4.

The way HDR Light Studio 5 is licensed has been greatly simplifed. Activation codes are bought and

then converted to rlm license keys on starting the app. Customers no longer need to upload User

Keys and wait for a key to be generated by hand.

The resolution of the proxy HDR images sent to your 3D app through a connection is no longer fixed

at 646x323.

The directory for picture lights (presets) is no longer fixed. Customers can move these to a shared

directory.

Color and value ramps are now part of the main user interface and no longer popup dialogs.

The fixed canvas resolution of HDR Light Studio 4 has been replaced with a resizable canvas.

The Canvas and Render View panels have a toolbar for common functions - move light, pan, zoom,

etc.

Preset lights can be filtered using tags in the .xml file.

FreeCam mode is now a user configured camera position that retains its state. In HDR Light Studio 4,

the freecam position was lost each time another camera was selected.
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The following image tpes are supported: BMP, Cineon, DDS, HDR, IFF, Jpeg, OpenEXR, PNG, PSD,

Targa, TIFF.

Invoking the Production Render using the last settings has been added to a button - rather than only

being available on a keyboard modifier.

Faster multi-threaded final rendering of HDR maps.

In HDR Light Studio 4 the position of lights were set by longitude/latitude values. Only whole

numbers of degrees were allowed. Now lights can be positioned with an accuracy of 2 decimal places.

Gradient backgrounds now have an alpha ramp.

In HDR Light Studio 4 models were loaded from the render settings dialog. In HDR Light Studio 5

models can be loaded from the Project menu.

The Light Preview thumbnail is no longer a fixed size. Exposure control, LUT and channel selection

also provided.
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Current Plug-ins Features and Compatability

Current Plug-ins Features and Compatability PDF

See which versions of your 3D software are supported by the current HDR Light Studio plug-ins and

the features available.

https://lightmap.s3.eu-west-1.amazonaws.com/docs/HDRLightStudio_Connection_Features_and_Compatability.pdf
https://lightmap.s3.eu-west-1.amazonaws.com/docs/HDRLightStudio_Connection_Features_and_Compatability.pdf
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Historic HDR Light Studio and Plug-in Pairings

Historic HDR Light Studio main app and Plug-in pairings Compatibility Chart PDF

This PDF document shows the current and historic compatibility/pairings of HDR Light Studio

versions and Connection builds with their build dates.

Expired Maintenance Customers

This PDF is useful for customers using permanent licenses with expired maintenance. You can see

which plug-ins builds you can use with older versions of HDR Light Studio.

Using Older 3D Software

If you are using an older 3D application, this PDF chart will also help you see what version of HDR

Light Studio and plug-in build can be used with your 3D software.

Subscription Licenses

Customers with subscription licenses can always use the latest builds of both HDR Light Studio and

the plug-ins. This PDF is of no use to you.

https://s3-eu-west-1.amazonaws.com/lightmap/docs/CompatibilityChart.pdf
https://s3-eu-west-1.amazonaws.com/lightmap/docs/CompatibilityChart.pdf
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Installing HDR Light Studio

This chapter will take you through the steps required to install HDR Light Studio on your computer.

· HDR Light Studio Installation - Windows

· HDR Light Studio Installation - MacOS

· HDR Light Studio Installation - Linux

To learn how to install  hi-resolution 'presets' light content - see here

To learn how to install 'Connection Plug-ins - see plug-in documentation
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HDR Light Studio Installation - Windows

Step 1: Install HDR Light Studio application

Follow these instructions to install HDR Light Studio on a computer running Windows.

1. Download the .exe file from our web site.

2. Double click on the .exe file to launch the installer.

3. Follow the on screen instructions in the installer.

By default, the application is installed to C:\Program Files\Lightmap\HDR Light Studio

Note for Demo Users

Now you can start HDR Light Studio and press the 'Run Unlicensed in Demo Mode' button.

The restrictions in this unlicensed mode are:

· Project saving and embedding is disabled

· Rendering out HDRI content is disabled

· HDRI content shared via a Connection will have a red water mark light

· Live resolution of the HDRI map is limited to 646 pixels wide, and area lights is limited to

64 pixels

· Saving of User Presets is disabled

Step 2: Activation (Node Locked Licenses)
If you have bought a floating license, please read Installing a Floating License.

Start HDR Light Studio.

The software is not yet licensed - therefore a Licensing dialog appears after the splash screen.

If you have purchased a node locked license, you will have been provided with an Activation Code.

Activation codes have 24 characters and are presented in 6 blocks of 4 characters.
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Press the Enter an activation code button.

Copy and paste (or manually type) the Activation Code provided into the text field.
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Press the Verify button.

The status of the activation code is now checked on our servers and a summary of the licenses that

will be generated is given.
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Press Yes to continue. Your licenses will be retrieved and installed on your computer.
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Press Start HDR Light Studio and the software will open fully licensed.

What's Next: If you have purchased HDR Light Studio, install the high-resolution Presets
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HDR Light Studio Installation - MacOS

Step 1: Installing the main HDR Light Studio application

Follow these instructions to install HDR Light Studio on a computer running Mac OS X.

1. Download the .dmg file from our web site.

2. Double click on the .dmg file.

3. Read the End User License Agreement and Agree to proceed.

4. Double click on the InstallHDRLightStudio.pkg file to run the installer and follow the prompts.

The application, HDRLightStudio.app, is installed to the directory /Applications

Note for Demo Users

Now you can start HDR Light Studio and press the 'Run Unlicensed in Demo Mode' button.

The restrictions in this unlicensed mode are:

· Project saving and embedding is disabled

· Rendering out HDRI content is disabled

· HDRI content shared via a Connection will have a red water mark light

· Live resolution of the HDRI map is limited to 646 pixels wide, and area lights is limited to

64 pixels

· Saving of User Presets is disabled

Step 2: Activation (Node Locked Licenses)
If you have bought a floating license, please read Installing a Floating License.

Start HDR Light Studio.

The software is not yet licensed - therefore a Licensing dialog appears after the splash screen.

If you have purchased a node locked license, you will have been provided with an Activation Code.

Activation codes have 24 characters and are presented in 6 blocks of 4 characters.
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Press the Enter an activation code button.
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Copy and paste (or manually type) the Activation Code provided into the text field.
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Press the Verify button.

The status of the activation code is now checked on our servers and a summary of the licenses that

will be generated is given.
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Press Yes to continue. Your licenses will be retrieved and installed on your computer.
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Press Start HDR Light Studio and the software will open fully licensed.

What's Next: If you have purchased HDR Light Studio, install the high-resolution Presets
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HDR Light Studio Installation - Linux

Step 1: Installing the main HDR Light Studio application

Follow these instructions to install HDR Light Studio on a computer running Linux.

1. Download the .ta.gz file from our web site.

2. Decide where you want to put it.

cd /usr/bin

mkdir hdrlightstudio

cd hdrlightstudio

3. Copy the download archive file to this directory.

cp hdrlightstudio5-lin-2015.0420.tar.gz /usr/bin/hdrlightstudio

4. Un-compress the file and extract to the current directory.

gunzip hdrlightstudio5-lin-2015.0420.tar.gz

tar xvf hdrlightstudio5-lin-2015.0420.tar

5. If you intend to use HDR Light Studio with a plug-in connection to a 3D App (Maya, etc) you must

set the environment variable HDRLS_HOME_V5 to point to the directory containing the extracted

files. For example:

export HDRLS_HOME_V5=/usr/bin/hdrlightstudio

Note for Demo Users

Now you can start HDR Light Studio and press the 'Run Unlicensed in Demo Mode' button.

The restrictions in this unlicensed mode are:

· Project saving and embedding is disabled

· Rendering out HDRI content is disabled

· HDRI content shared via a Connection will have a red water mark light

· Live resolution of the HDRI map is limited to 646 pixels wide, and area lights is limited to

64 pixels

· Saving of User Presets is disabled
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Step 2: Activation (Node Locked Licenses)
If you have bought a floating license, please read Installing a Floating License.

1. Start HDR Light Studio.

The software is not yet licensed - therefore a Licensing dialog appears after the splash screen.

If you have purchased a node locked license, you will have been provided with an Activation Code.

Activation codes have 24 characters and are presented in 6 blocks of 4 characters.

2. Press the Enter an activation code button.

3. Copy and paste (or manually type) the Activation Code provided into the text field.

4. Press the Verify button.

The status of the activation code is now checked on our servers and a summary of the licenses that

will be generated is given.

5. Press Yes to continue. Your licenses will be retrieved and installed on your computer.

6. Press Start HDR Light Studio and the software will open fully licensed.

What's Next: If you have purchased HDR Light Studio, install the high-resolution Presets
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Installing Presets

The HDR Light Studio installation now includes low resolution demo Preset files that do not need to

be separately installed.

If no other Presets are found by HDR Light Studio at startup, these demo presets will be loaded. Ideal

for new users trying a demo of HDR Light Studio.

However, for customers that have purchased a HDR Light Studio license, you are entitled to

download and install the high-resolution Preset files using the following instructions.

· Presets Installation - Windows

· Presets Installation - MacOS

· Presets Installation - Linux
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Presets Installation - Windows

Installing High-Quality Presets

The HDR Light Studio installation now includes low resolution demo Preset files that do not need to

be separately installed.

If no other Presets are found by HDR Light Studio at startup, these demo presets will be loaded.

However, for customers that have purchased a HDR Light Studio license, you are entitled to

download and install the high-resolution Preset files.

1. Downloading Presets

Login to your account at www.lightmap.co.uk and download the Preset zip files from the Download

web page on your account.

There are currently 2 zip files to download and you need both. There is just over 8GB of lighting

content here in total.

Once downloaded, unzip these files, they contain .xml and .tx files. The xml files describe each

preset, and the tx files are image files referenced by the presets.

2. Installing Preset Files on your local computer

Please Note: If you have multiple users of HDR Light Studio, the presets files can be installed on a

network drive accessible by all HDR Light Studio users. If you would like to do this, please follow

these instructions.

Start HDR Light Studio. At the bottom of the Presets panel there is a warning triangle and message:

Demo Presets Loaded. Presets Folder Empty

http://www.lightmap.co.uk
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Click on the 'Presets Folder' text link. This opens the directory on your computer where HDR Light

Studio looks for the Preset files.

By default this is: C:\Users\<username>\AppData\Local\lightmap\presets

Move all of the .xml and .tx files you downloaded into this directory.
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Close the directory and re-start HDR Light Studio.

Your Presets panel should now look like this. The demo lights warning text has gone from the bottom

of the Presets panel.
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The Presets are now installed and ready to use.

What's Next: Install your plug-in connections. Find your Connection here and follow the provided

instructions.
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Presets Installation - MacOS

Installing High-Quality Presets

The HDR Light Studio installation now includes low resolution demo Preset files that do not need to

be separately installed.

If no other Presets are found by HDR Light Studio at startup, these demo presets will be loaded.

However, for customers that have purchased a HDR Light Studio license, you are entitled to

download and install the high-resolution Preset files.

1. Downloading Presets

Login to your account at www.lightmap.co.uk and download the Preset zip files from the Download

web page on your account.

There are currently 2 zip files to download and you need both. There is just over 8GB of lighting

content here in total.

Once downloaded, unzip these files, they contain .xml and .tx files. The xml files describe each

preset, and the tx files are image files referenced by the presets.

2. Installing Preset Files on your local computer

http://www.lightmap.co.uk
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Please Note: If you have multiple users of HDR Light Studio, the presets files can be installed on a

network drive accessible by all HDR Light Studio users. If you would like to do this, please follow

these instructions.

Start HDR Light Studio. At the bottom of the Presets panel there is a warning triangle and message:

Demo Presets Loaded. Presets Folder Empty

Click on the 'Presets Folder' text link. This opens the directory on your computer where HDR Light

Studio looks for the Preset files.

By default this is: /Users/<username>/Library/Application Support/lightmap/presets

Move all of the .xml and .tx files you downloaded into this directory.
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Close the directory and re-start HDR Light Studio.

Your Presets panel should now look like this. The demo lights warning text has gone from the bottom

of the Presets panel.
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The Presets are now installed and ready to use.

What's Next: Install your plug-in connections. Find your Connection here and follow the provided

instructions.
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Presets Installation - Linux

Installing High-Quality Presets

The HDR Light Studio installation now includes low resolution demo Preset files that do not need to

be separately installed.

If no other Presets are found by HDR Light Studio at startup, these demo presets will be loaded.

However, for customers that have purchased a HDR Light Studio license, you are entitled to

download and install the high-resolution Preset files.

1. Downloading Presets

Login to your account at www.lightmap.co.uk and download the Preset zip files from the Download

web page on your account.

There are currently 2 zip files to download and you need both. There is just over 8GB of lighting

content here in total.

Once downloaded, unzip these files, they contain .xml and .tx files. The xml files describe each

preset, and the tx files are image files referenced by the presets.

2. Installing Preset Files on your local computer

Please Note: If you have multiple users of HDR Light Studio, the presets files can be installed on a

network drive accessible by all HDR Light Studio users. If you would like to do this, please follow

these instructions.

Start HDR Light Studio. At the bottom of the Presets panel there is a warning triangle and message:

Demo Presets Loaded. Presets Folder Empty

http://www.lightmap.co.uk
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Click on the 'Presets Folder' text link. This opens the directory on your computer where HDR Light

Studio looks for the Preset files.

By default this is: /home/<username>/.local/share/lightmap/presets

Move all of the .xml and .tx files you downloaded into this directory.

Close the directory and re-start HDR Light Studio.

Your Presets panel should now look like this. The demo lights warning text has gone from the bottom

of the Presets panel.



130

130HDR Light Studio - User Guide

The Presets are now installed and ready to use.

What's Next: Install your plug-in connections. Find your Connection here and follow the provided

instructions.
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Installing Presets on Network Drive

If you have multiple users of HDR Light Studio, the presets files can be installed on a network drive

accessible by all HDR Light Studio users. The Presets files are currently over 8GB of content. So

installing these on every user's computer will take up a lot of disc space and time to do for multiple

users.

Step 1: Installing the Preset files
Create a folder for the Presets on a network drive that all user computers can access.

Place downloaded the xml and tx files in that folder.

Make a note of the path to this folder, you will need to know this to setup the user machines.

Step 2: HDR Light Studio user computer setup

There are 2 ways to do this:

Method 1: Manually set a preference on the user computer

Method 2: Set an Environment Variable

Method 1: Manually set preference on the user computer

Start HDR Light Studio and open the Preferences panel

On Windows this is in the Edit Menu > Preferences

On MacOS this is in the HDRLightStudio menu > Preferences

Press the Choose... button to the right of the Preset Directory
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In the file browser that pops up, find and select the network drive folder where the preset files are

located and press the Select Folder button.

Press OK in the Preferences panel and the setting will be saved.

You will be warned that you need to restart HDR Light Studio for the changes to take effect.

Restart HDR Light Studio and it will load the Presets from the network drive.

Method 2: Set an Environment Variable

On the user computer, you can set an Environment Variable to set the location where HDR Light

Studio loads its Presets.

This setting will override all other settings.

Here is the environment variable that needs to be set:

HDRLS_PRESETS_DIR

For example:

HDRLS_PRESETS_DIR = \DiskName\HDRLS_Presets\
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Licensing

Nodelocked Licenses

A nodelocked license will allow HDR Light Studio to run on one computer.

Installing a Nodelocked License

Floating Licenses

If you purchase a floating license of HDR Light Studio, it allows any computer on the network to use

that HDR Light Studio license.
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If you purchase 1 x floating license, any 1 computer can use HDR Light Studio at a time.

If you purchase 2 x floating licenses, any 2 computers can use HDR Light Studio at the same time.

It’s called a floating license because it can ‘float’ between users on the same network.

HDR Light Studio uses the Reprise License Management (RLM) licensing software. This is an industry

standard solution. At Lightmap we prefer to code new features in HDR Light Studio than re-invent

the wheel and create our own licensing solution. RLM works very well and is used by many other

leading software companies.

Limitations of a Floating License: The floating license is shared with computers on the same

network only. This is not an online license that can be activated and deactivated on any computer

anywhere that can see the internet.

Installing a Floating License
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Installing a Nodelocked License
When you buy HDR Light Studio nodelocked licenses you are given an Activation Code.

When you use the Activation Code for a nodelocked license inside HDR Light Studio, license files for

your hardware are generated by Lightmap's server and delivered seamlessly onto your computer.

Activation codes can only be used once!

If you need to retrieve and install the license files again, these can be downloaded from the

Activation Codes page under your account at the Lightmap web site.

Using an Activation Code inside HDR Light Studio for a Node-Locked License

Start HDR Light Studio.

The software is not yet licensed - therefore a Licensing dialog appears after the splash screen.

If you have purchased a node locked license you will have been provided with an Activation Code.

Activation codes have 24 characters and are presented in 6 blocks of 4 characters.

If you have bought a floating license, please read Installing a Floating License.
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Press the Enter your activation code button.
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Copy and paste (or manually type) the Activation Code provided into the text field.
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Press the Verify button.

The status of the activation code is now checked on our servers and a summary of the licenses that

will be generated is given.
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Press Yes to continue. Your licenses will be retrieved and installed on your computer.
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Press Start HDR Light Studio and the software will open fully licensed.
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Floating License Installation

HDR Light Studio uses Reprise License Management

At Lightmap we prefer to code new features in HDR Light Studio instead of re-inventing the wheel

and developing our own software licensing solution. Therefore, HDR Light Studio uses Reprise

License Management software - called RLM for short. RLM is an industry standard solution used by

many other leading 3D software companies to license their software.

First let's choose the right process for your floating license installation...

This is a new RLM installation

Start from Step 1: Choose the computer where RLM Server software will be installed

or you can watch a video of the whole process here.

I want to add HDR Light Studio licenses to an an existing RLM License Server

Start from Step 3: Download and install the lightmap.set file

I want to install Maintenance floating licenses

See Updating Maintenance Floating Licenses

I have renewed Subscription and want to install my renewal floating licenses

See Updating Subscription Floating Licenses

Step 1: Choose the computer where RLM Server software will be

installed

The RLM Server software is a small application that you leave running on a computer of your choice,

that then gives out license permissions for computers on the network to run HDR Light Studio.

https://www.lightmap.co.uk/learning/floating-license-installation/
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Important! Choose this computer carefully as the license files generated will be

locked to this machine.

Below is a list of criteria to consider when choosing where to install the RLM server software:

• It can be a dedicated license server or any suitable computer on the network

• It can be installed on Windows, MacOS or Linux operating system

• It’s easiest to install on Windows for less technical users!

• The computer needs to be on at all times when users need to use HDR Light Studio

• Ideally the computer is on all the time

• The computer needs to be accessible by the HDR Light Studio user computers over

the network

• It can be a low specification computer

• Don’t choose a computer you plan to dispose of soon

• HDR Light Studio can also be run on the license server computer if required

Mobile Floating License on a Laptop: If you want to use HDR Light Studio both inside and outside

of the office network - your license server computer can be a laptop. So, when you are in the office

with that laptop turned on, any machine on the work network, or the laptop itself,  can use HDR Light
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Studio. When you go home with that laptop, any machine on the home network, or the laptop itself,

can also use HDR Light Studio.

Step 2: Download and Install RLM Server Software

In this example the RLM Server software will be installed on a Windows computer.

Log into your account at www.lightmap.co.uk/login then click on your username in the top right and

select ‘Downloads’ from the drop-down menu.

At the bottom of the downloads page, there is a section called ‘RLM License Server’ - this is where the

RLM Server software can be downloaded.

Click on the link to download the RLM License Server for your platform, in this example we will

download it for Windows.

https://www.lightmap.co.uk/login/
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You will need to read and agree to the terms of the EULA in order to actually start the download.

Place the zip file containing the RLM License Server software in the location where you want to install

the RLM server software - this can be anywhere. In this example, the RLM License Server software is

going to be installed on the C Drive, inside a folder called ‘RLM License Server’.
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Then, unzip the file. Once the content of the zip file is unzipped, you can delete the zip file. The next

image shows the contents of the RLM folder - there is no installer as such, these files are the RLM

server software.

Step 3: Download and install the lightmap.set file

Next, download the lightmap.set file which is required to install HDR Light Studio floating licenses.

This can is downloaded from the downloads page, there is a link to this file shown below.

Place the lightmap.set file in the RLM folder next to the RLM executable.
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Step 4: Start RLM server software

Start the RLM application by double clicking the rlm.exe file.

When running it for the first time, you will get a Windows Security Alert about the Firewall. It’s

important to give the RLM software access to private networks so that the RLM Server can speak with

other computers on the network.

The RLM application is now running.

Minimize the RLM application using the button highlighted top right - to keep it running but hide it

away whilst completing the next steps.
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Step 5: Start the RLM Server Administration Web Page

Go to a web browser and type in the address 127.0.0.1:5054. If it’s not loading, make sure your RLM

application is still running. You should see the web page shown below being served up from the

running RLM server software – if you do that’s great, it shows that RLM is working fine!

Step 6: Generate Floating License files
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Whilst on the RLM web page on your license server computer, click on ‘System info’ to display

information about your computer system.

You can see that the working directory is set to the RLM License Server folder, that has been created

on the C drive, that’s good.

On the system info page, you can find 2 important pieces of information that you will need for

generating your floating licenses.

1) The Host Name, in this example it’s Workstation01

2) The MAC address or addresses
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Leave the RLM Server Administration web page open, and open a new browser window to go to

www.lightmap.co.uk and click on your username in the top right, then select ‘Activate Floating

License’ from the drop-down menu.

https://www.lightmap.co.uk
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Copy the first MAC address of your computer system from the RLM web page and paste it in the

‘MAC Address’ field on the ‘Activate Floating License’ web page. The license file will be locked to an

RLM server computer with the MAC address you put in on this page.

Please ensure the MAC address you put in is of the hardware that will always be active on your

license sever computer. For example, if you installed on a laptop, this should not be a MAC address

only active when a USB to Ethernet adapter is plugged in.

Now let’s copy and paste the Host Name. We can leave the server port as the default 5053.
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The host name and port can be changed in the future by editing the license file generated. This

doesn’t invalidate the license file. However, it’s critical that the MAC address is correct as this cannot

be edited, so always double check it after pasting it.

All that’s left is the activation code, which you can copy either from the email you have received

or from the ‘My Activation Codes’ page.

Paste the activation code on the ‘Activate Floating License’ web page, ensuring all characters have

been pasted.

Then click on ‘Generate License’ to generate your floating license/s.
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You have now generated your floating licenses. You can see the details for the licenses on the

resulting web page.
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Step 7: Download your floating licenses

You will have been sent an email with the license files attached. Or another way to access your

floating licenses is to go to the ‘My Activation Codes’ page and click on ‘Download’ next to the

activation code you just used.

If you do not see ‘Download’, instead you see ‘Click to activate’, it’s likely that you haven’t refreshed

the ‘My Activation Codes’ page after generating your licenses, so refresh it now. Please note that

licenses downloaded this way are zipped. 

Step 8: Install the Floating Licenses 
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Once you have your floating license files (if your licenses are in a zip file, unzip them before

proceeding), you need to install them by simply placing the .lic files in the same directory as your

RLM application – in this example in C:\RLM License Server 

You now need to tell the already running RLM server software to restart and reread the installed

floating licenses. Open a web browser and go to the address 127.0.0.1:5054 if you’re not already

there, and click on ‘Reread/Restart Servers’. Then, press the ‘REREAD/RESTART’ button. This will

restart the RLM software and it will read the floating licenses you have installed. 

Now if you click on ‘Status’, you will see the status of your HDR Light Studio floating licenses under

the ‘Lightmap’ name.

Please Note: If you are not seeing Lightmap licenses, it could be because you forgot to download and

place the lightmap.set file next to your RLM executable. If this is the case, re-visit Step 3.
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Figure 24: Viewing the status of the floating licenses

The floating licenses are now installed and running.

Step 9: Setup the Client Computers to use the Floating Licenses 

The client computers are each computer where you have installed and want to use HDR Light Studio.

First, make a note of the IP address of your RLM server computer. You can find it by going back to the

RLM web page and then clicking on ‘System info’ in this example it’s 192.168.0.12

Now you’re ready to set up the client machines.
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Go to your chosen client machine now, then proceed further with these instructions on that

machine. 

HDR Light Studio should be already installed on your client machine, if it isn’t see Installing HDR Light

Studio before proceeding further.

Launch HDR Light Studio

Starting HDR Light Studio on a client machine

There is a chance HDR Light Studio will automatically find the RLM licenses over the network. If this is

the case, HDR Light Studio will simply start without a license warning dialog box. That will be it! The

software is ready to use. 

However, most times the licenses are not automatically found. On launch you will see this licensing

panel.

Click on ‘Connect to Floating License Server’ button. 
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Choosing to license HDR Light Studio using a floating license

Now you can enter the IP address of your RLM Server that you have set-up in previous steps, in this

example: 192.168.0.12. Leave the port as default, i.e. 5053, and click on ‘Submit’.
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Figure 28: Connecting to the RLM Server

As long as the client machine can find the RLM Server software running on the license server

computer via local network, a local hdrls_server.lic file will be created, that contains the IP address

and port where the floating licenses can be obtained.

Press Finish and HDR Light Studio will now run licensed!

Figure 29: HDR Light Studio connected to the RLM server

The software is now ready to use.
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Updating Maintenance Floating Licenses

I have purchased maintenance for my HDR Light Studio Floating licenses and

would like to update my license files to have the new maintenance date.

Step 1: Generate Floating License

Login at www.lightmap.co.uk/login then click on your username in the top right, and select ‘Activate

Floating License’ from the drop-down menu.

You will be taken to the ‘Activate Floating License’ web page – this is the page where you will generate

your new Floating licenses with your updated maintenance date.

https://www.lightmap.co.uk/login
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When you purchased maintenance for your permanent licenses, you were supplied with a new

activation code. This new activation code will let you redeem your new license files with an updated

maintenance date. 

Copy your new activation code either from the email you have received or from the ‘My Activation

Codes’ page.

Next, paste the activation code on the ‘Activate Floating License’ web page, ensuring all characters

have been pasted. 
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The activation code is locked to use the MAC address we already have on file for your current

permanent license. In the case of Transferred licenses, this is the MAC address of the machine where

the software was last transferred to. In other words, the activation code is locked to a MAC address of

the license server computer that is currently hosting your HDR Light Studio licenses. Therefore,

renewing maintenance does not give you an additional opportunity to relocate your software. 

You can check what MAC address is locked to your new activation code on the ‘My Activation Codes’

page.

Please note: If the MAC address shown on the ‘My Activation Codes’ page is not what you expect and

is for a different machine, get in touch with us at support@lightmap.co.uk.

Copy the MAC address locked to your activation code from the ‘My Activation Codes’ page and paste

it in the ‘MAC Address’ field on the ‘Activate Floating License’ web page.
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All that’s left is the Host Name. You can copy it from the ‘System Info’ area on the RLM web page,

which you can access by typing the address 127.0.0.1:5054 into your web browser on the RLM License

Server machine where your current licenses are installed.

Paste the host name of your license server computer in the ‘Host Name’ field on the ‘Activate Floating

License’ page. Leave the server port as the default, i.e. 5053, unless your requirement is to use a

different port, then click on ‘Generate License’.
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Figure 8: Generating new floating licenses with updated maintenance date

The host name and port can be changed in the future by editing the license file generated. This

doesn’t invalidate the license file. However, the MAC address cannot be edited. 

You have now generated your new floating licenses with the updated maintenance date. You can see

the details for the licenses on the resulting web page. 

 

You will now be sent an email with your new license files attached. Or another way to access your

new floating licenses is to go to the ‘My Activation Codes’ page and click on ‘Download’. If you do not

see ‘Download’, instead you still see ‘Click to activate’, it’s likely that you haven’t refreshed the ‘My

Activation Codes’ page after generating your licenses, so refresh it now.
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Step 2: Install Floating Licenses

Once you have your new floating license files (if your licenses are in a zip file, unzip them before

proceeding), you need to install them by simply placing the new .lic files in the same directory as

your RLM application – in this example it’s in C:\RLM License Server.

Your new floating licenses have a replace flag set and will override your old floating licenses with

older maintenance dates.

If you want to you can delete your old set of licenses with an expired maintenance date, but you

don’t have to as HDR Light Studio will use your new licenses either way. 

You now need to tell the RLM server software to restart and reread the installed floating licenses.

Open a web browser and go to: 127.0.0.1:5054, then click on ‘Reread/Restart Servers’. Next, press the

‘REREAD/RESTART’ button. This will restart the RLM software and it will read the new floating licenses

you have just installed.
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Step 3: Setup the Client Computers to use the Floating Licenses 

Client computers do not need to be updated. Next time HDR Light Studio is run, it will pick up the

new license from the RLM server.
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Updating Subscription Floating Licenses

If you have 'renewed' your subscription floating licenses, here are instructions

on how to create and install your new licenses.

You should complete this process on the day your previous floating licenses expire.

As the 1 year starts from the activation date of these new licenses.

Stage 1: Generate and Download Floating Licenses

Login at www.lightmap.co.uk/login then click on your username in the top right, and select ‘Activate

Floating License’ from the drop-down menu.

You will be taken to the ‘Activate Floating License’ web page – this is the page where you will generate

your new Floating licenses.

https://www.lightmap.co.uk/login
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When you purchased a new subscription floating license, you were supplied with a new activation

code. This activation code will let you redeem your new license files to use for another year from the

date of the activation. 

You have up to 30 days after the purchase date to activate your software, if you don’t, your 1-year

subscription will start after the 30 days grace period. 

Copy your new activation code either from the email you have received or from the ‘My Activation

Codes’ page.

Paste the activation code on the ‘Activate Floating License’ web page, ensuring all of it has been

pasted.
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Figure 4

Copy the first MAC address of your RLM Server. You can copy it from the ‘System Info’ area on the

RLM web page, which you can access by typing the address 127.0.0.1:5054 into your web browser

whilst on your license server computer.

Paste the MAC address in the ‘MAC Address’ field on the ‘Activate Floating License’ web page
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The host name and port can be changed in the future by editing the license file generated. This

doesn’t invalidate the license file. However, it’s critical that the MAC address is correct as this cannot

be edited, so always double check it after pasting it. 

All that’s left is the Host Name of your RLM server.

Copy the Host Name from the ‘System Info’ area on the RLM web page.

Paste the host name of your RLM server in the ‘Host Name’ field on the ‘Activate Floating License’

page. Leave the server port as the default, i.e. 5053, unless your requirement is to use a different

port, then click on ‘Generate License’

You have now generated your new subscription floating licenses for your RLM server. You can see

the details for the licenses on the resulting web page.
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You will now be sent an email with your new license files attached. Or another way to access your

new floating licenses is to go to the ‘My Activation Codes’ page and click on ‘Download’.  If you do not

see ‘Download’, instead you still see ‘Click to activate’, it’s likely that you haven’t refreshed the ‘My

Activation Codes’ page after generating your licenses, so refresh it now.

Stage 2: Install Floating Licenses

Once you have your new floating license files (if your licenses are in a zip file, unzip them before

proceeding), you need to install them by simply placing the new .lic files in the same directory as

your RLM application on your license server computer – in this example it’s in C:\RLM License

Server.
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HDR Light Studio will disregard your old expired licenses once it finds your new active subscription

floating licenses. If you want to you can delete your old and expired set of subscription floating

licenses – but you don’t have to. 

You now need to tell your RLM server software to restart and reread the installed floating licenses.

Open a web browser and go to the address 127.0.0.1:5054 if you’re not already there, then click on

‘Reread/Restart Servers’. Next, press the ‘REREAD/RESTART’ button. This will restart the RLM software

and it will read the new floating licenses you have just installed.

Stage 3: Setup end user computers to use the Floating Licenses

Client computers do not need to be updated. Next time HDR Light Studio is run, it will pick up the

new license from the RLM server.
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Floating Licenses and Next Limit RLM Licensing

Maxwell Studio and Realflow both use RLM for their licensing system. Here is a guide to installing a

HDR Light Studio license with RLM for Maxwell Studio or Realflow already installed

Using the existing RLM installation

If there is an instance of RLM already set up to administer licenses for Maxwell Studio or Realflow

then it is not necessary to install a new instance of RLM exclusively for HDR Light Studio.

In order to add the HDR Light Studio floating license to an existing Server, download the

lightmap.set ISV file from this page - www.lightmap.co.uk/downloads and add the ISV and the

Floating License File to the directory that RLM is installed to and restart RLM.

To restart RLM after adding the ISV file. Open an internet browser on the Server machine and type in

localhost:5054 into the address bar, this will bring up the RLM webhost.

Use the ReRead/Restart Servers option on the webhost menu to restart RLM with the lightmap.set

ISV file along with the existing licenses for Maxwell or Realflow.

Installing a new instance of RLM for HDR Light Studio

If necessary, a new instance of RLM can be installed to run alongside the existing RLM License Server.

Once RLM has been installed and the HDR Light Studio License File and lightmap.set ISV have been

moved into the RLM directory. If the original instance of RLM is using port 5053 then this second

instance must be configured to use a different port to avoid a conflict. This can be done by editing

the license file.

To edit the license file, open an internet browser on the Server machine and type in localhost:5054

into the address bar, this will bring up the RLM webhost. Use the Edit License Files option in the left

hand menu and edit each License File in turn. The top line of your license file will look something like

this;

HOST licenseServerName 84578h25d361 5053

The rightmost number, 5053 is the default port RLM is set to use, change this number to one that is

not being used by another program. Do not attempt to edit anything else in the license file as this

can break the license file completely. Save the license and then use the ReRead/Restart Servers

option on the menu to restart the lightmap ISV in order to pick up the changes in the license file.

https://www.lightmap.co.uk/downloads
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License Administration

Reprise Software have written an excellent user guide that will tell you everything you need to know

about RLM licensing. It's called RLM License Administration and you can download it from their

web site www.reprisesoftware.com

The rest of this section covers the basics of license administration for HDR Light Studio.

Nodelocked Licenses

Nodelocked licenses are sometimes called uncounted licenses. A single nodelocked license will

enable one of our products to work on one particular computer. It cannot be used on a different

computer. If you need it to work on a different computer you will have to transfer the license key but

there are restrictions. See Transferring Licenses. 

Nodelocked licenses are easy to get working. They simply require a text file containing the license key

to be stored in a particular directory on the computer you are using to run HDR Light Studio. Here’s

an example of a nodelocked license.

LICENSE lightmap hdrlightstudio 2016.0413 13-apr-2016 single hostid="0024d77eb961" share=uh 

start=13-apr-2015 issuer=web-shop customer=U-00000002 contract=commercial

issued=13-apr-2015 options=091314c90980091eb5900b4df005186aae11c3b40974dc2b

092b09726c3909a6_ck=e5d4d19131 sig="302D0215009DC7B225B1008F1D116

F968A34E7E2A07CC8E8C202141B4A0DDD2920F74209FC6843E0CA51E596ED2551"

It should be stored in a plain text file with a .lic file extension. If you have installed your nodelocked

license from an activation code, we will have put the license key in the correct directory for you.

Default License Directory

Your nodelocked license key must be stored in a specific user directory, although this can be moved.

These locations depend on your operating system and are shown below for a user called Fred.

Mac OS X

/Users/Fred/Library/Application Support/lightmap/licenses/hdrlightstudio.1851.2016.0413.lic

Windows

C:\Users\Fred\AppData\Local\lightmap\licenses\hdrlightstudio.1851.2016.0413.lic

Linux

http://www.reprisesoftware.com


174

174HDR Light Studio - User Guide

/home/Fred/.local/share/lightmap/licenses/hdrlightstudio.1851.2016.0413.lic

If you have trouble navigating to these directories from your file browser (these directories are

sometimes hidden), just run HDR Light Studio and launch the Preferences dialog. From here you can

open the license directory.

Alternative License Directory

You don't have to use the default license directory to store your license keys. You can move your keys

to any directory but you need to set the location of this directory in the Preferences dialog.

Another method, though not as easy as the one described above, is to set an environment variable

to point to the new location. You can set the environment variable to point to a directory (containing

one or more license files with .lic file extensions) or to a specific file. The environment variable is:

lightmap_LICENSE

The command syntax to set an environment variable differs between operating systems. For a guide,

see Setting Environment Variables.

Floating Licenses

Floating licenses are sometimes called network licenses or counted licenses. A single floating license

will allow any networked computer to use one copy of HDR Light Studio at any one time. Without a

valid license key installed, a watermark will appear on your canvas and you will not be able to save

your project.

Floating licenses are more complicated to get working than nodelocked licenses. To get floating

licenses to work, you will need:

1. To install the Reprise License Manager on the license server.

2. To put the floating license key on the server.

3. To tell the client computers how to connect to the license server.

The Reprise License Manager (RLM) manages your use of HDR Light Studio through the license key. It

counts how many clients have taken licenses and how many are free. The license key is a human-

readable text file that typically defines the version of HDR Light Studio you can use, the number of

computers you can use for lighting and how long the license is valid. Here is an example:

HOST acme_server b8e856458582 5053

ISV lightmap port=62645

LICENSE lightmap hdrlightstudio 2016.0412 12-apr-2016 5 hostid=ANY share=uh

 start=12-apr-2015 issuer=web-shop customer=U-00000002 issued=12-apr-2015 replace
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 options=4b397bc914c156025f4e5b5960e74441410ba0ea73716f1c4a1e571b73395836

 disable="TerminalServer VM" _ck=202228fefb sig="302D02145AD0D8A948E

 E52F3D762C92A0CE34449878B33BD021500C73A903258B3A1C1F54B2DB3FD5BD317

 7E5B93E6"

Any client computer that has HDR Light Studio installed needs to know which computer is being

used as the license server. This is done through a simple text file or an environment variable that

specifies the hostname (or ip address) of the license server and the port through which

communication should take place.

Auto-starting RLM

To server licenses on the network, the RLM license server needs to be running at all times. We

recommend that you configure the RLM license server to automatically run when your computer

boots up.

Linux

Configuring your linux machine to start rlm each time the machine is rebooted varies depending on

the flavour of Linux running and is beyond the scope of these notes. Please see your Systems

Administrator.

Windows

On Microsoft Windows you will need to install and run the RLM License server as a Windows service

process. A service process will start automatically when the computer boots up and will remain

running as long as the computer is up. Installing RLM as a service is done at the command prompt.

Once installed as a service it remains installed until it is deleted as a service. Deleting the service

removes it from the Windows service database and does not delete the rlm.exe or associated file(s).

· Let's imagine that you have installed the Windows RLM license server to the directory C:\Program

Files\RLM

· Start a command prompt and run it as Administrator.

· Change directory to C:\Program Files\RLM

· Type the following command (all one one line):

rlm.exe -install_service -service_name rlm-lightmap -dlog +"C:\Program Files\RLM\rlm-lightmap.log" 

   -c "C:\Program Files\RLM\hdrlightstudio.lic"

· Go to the Control Panel - Administrative Tools and click on Services. Find rlm-lightmap in the list of

services and start the service.
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Mac OS X

You will need to create a launchd property list file called com.lightmap.rlm.plist and put it in the

correct directory (/Library/LaunchDaemons).

Here is an example file. Using TextEdit (or vi), change the contents to match the location of your rlm

executable.

<?xml version="1.0" encoding="UTF-8"?> <!DOCTYPE plist PUBLIC -//Apple Computer//DTD PLIST
1.0//EN http://www.apple.com/DTDs/PropertyList-1.0.dtd > <plist version="1.0">

<dict>

 <key>Label</key>

 <string>com.lightmap.rlm</string>

 <key>ProgramArguments</key>

 <array>

 <string>/Users/Fred/Lightmap/RLM/rlm</string>

 <string>-c</string>

 <string>/Users/Fred/Lightmap/RLM/HDRLightStudioV4_License.lic</string>

 <string>-dlog</string>

 <string>/Users/Fred/Lightmap/RLM/lightmap.log</string>

 </array>

 <key>RunAtLoad</key>

 <true/>

</dict>

</plist>

Make sure the plist file has the correct name and does not have a .txt file extension (that may have

been added using TextEdit).

Move the plist file to /Library/LaunchDaemons

Change the owner to root using this command in a terminal:

sudo chown root /Library/LaunchDaemons/com.lightmap.rlm.plist

Run this command from the terminal to check it loads the RLM license server daemon correctly.

sudo launchctl load -w /Library/LaunchDaemons/com.lightmap.rlm.plist

Check that a log file has been created. Go to /Users/Fred/Lightmap/RLM and look for a lightmap.log

file. If it is there, everything is working. If not, check the contents of the plist files for any spelling
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errors. As a final check, reboot your computer and then verify the license server is running with the

following command:

./rlmutil rlmstat -a

Stopping RLM

To stop the RLM server, first stop the lightmap (ISV) server then the RLM server. You can use the RLM

Web Server or these shell commands.

./rlmutil rlmdown lightmap

./rlmutil rlmdown RLM

Note that RLM must be in Caps. To check that the server has indeed stopped, use

./rlmutil rlmstat -a

Starting RLM

A quick way to get RLM running is to run it directly from the command line. It will read any file with a

.lic file extension in the same directory. From a terminal, shell or command prompt, change directory

to the RLM Directory and enter the following command to start the Reprise License Manager and

print diagnostic information to the screen.

./rlm

If you prefer to write diagnostic information to a log file, type this instead:

./rlm -dlog lightmap.log

To append log information to an existing log file, try this:

./rlm -dlog +"lightmap.log"

Understanding Ports

If your RLM license server is behind a firewall you may need to unblock some TCP/IP ports to allow

client machines outside the firewall to be able to check out HDR Light Studio licenses.

By default, RLM uses port 5053 for the main RLM service and a dynamically-chosen port for the ISV

(lightmap) service. You can change these default ports by editing your license file and then

restarting both RLM and the ISV license servers.

In the license file shown below RLM uses port 5059, and the ISV lightmap server uses port 62645.
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HOST acme_server b8e856458582 5059

ISV lightmap port=62645

LICENSE lightmap hdrlightstudio 2014.0306 permanent 5 hostid=ANY share=uh

 start=06-mar-2014 customer=A-000000003 issued=14-mar-2014 replace

 options=4b397bc914c156025f4e5b5960e74441410ba0ea73716f1c4a1e571b73395836

 disable="TerminalServer VM" _ck=202228fefb sig="302D02145AD0D8A948E

 E52F3D762C92A0CE34449878B33BD021500C73A903258B3A1C1F54B2DB3FD5BD317

 7E5B93E6"

The HOST line specifies the port used by the main RLM license service. By default (if no port is

specified) this port is 5053, but we have changed it to 5059. If you change the port number on the

server you must mirror this change on the client in the environment variable or license file. For

example, the client license file would say:

HOST acme_server b8e856458582 5059

or if the client connects by an environment variable:

lightmap_LICENSE=5059@hostname

ISV Port

The ISV line does not specify a port by default, so RLM dynamically chooses a port number when you

start the license server. To specify a fixed port (to get through a firewall), add port=<isv-port> to the

ISV line, where <isv-port> is the number of a free TPC/IP port. In the example above, we added

port=62645

After you edit the license file, stop both RLM and the ISV license server, then start RLM. Here is an

example of the output from RLM using the example port numbers above.

# ./rlmutil rlmdown lightmap

# ./rlmutil rlmdown RLM

# ./rlm

03/19 13:42 (rlm) RLM License Server Version 11.0BL2

 

 Copyright (C) 2006-2014, Reprise Software, Inc. All rights reserved.

 

03/19 13:42 (rlm) License server started on acme_server

03/19 13:42 (rlm) Server architecture: x64_m1

03/19 13:42 (rlm) License files:

03/19 13:42 (rlm)     hdrlightstudio.lic

03/19 13:42 (rlm)
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03/19 13:42 (rlm) Web server starting on port 5054

03/19 13:42 (rlm) Using TCP/IP port 5059

03/19 13:42 (rlm) ... adding UDP/IP port 5053

03/19 13:42 (rlm) Starting ISV server lightmap on port 62645

03/19 13:42 (lightmap) RLM License Server Version 11.0BL2 for ISV "lightmap"

03/19 13:42 (lightmap) Settings from RLM Version 9.4BL4 for ISV "lightmap"

03/19 13:42 (lightmap) Server architecture: x64_m1

Web Server Port

By default, the RLM web interface uses port 5054. If you need to use a different port, you can use the

rlm -ws <port> command-line flag when you start the rlm license server.

RLM Web Server

Once RLM is running and serving licenses, it's worth having a look at RLM's web server. This is a

handy tool that let's you see whether your license server is up and running, which products are

licensed, which license files have been read, etc. You can also use it to stop and start the license

server and re-read the license files. You can also write out diagnostic information that may help us

identify problems. By default, the RLM web server uses port 5054 (if you need to change this see Web

Server Port). To start the RLM web server, in a web browser on the license server, go to

http://localhost:5054/

RLM Web Server

http://localhost:5054/
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To access the RLM web server from a client machine, you can use the ip address of the license

server in the browser window. For example:

http://192.8.2.10:5054

Or if you know the hostname of the license server (for example, acme_server) you may find it easier

to type:

http://acme_server:5054

Moving the License Key

RLM will read any file with a .lic file extension that is in the same directory as the RLM executable.

However, you can get RLM look into other directories as well. For example, if you had copied your

license key to your home directory, you can use this command:

./rlm -c $HOME/hdrlightstudio.lic

Adding more License Keys

Adding more license keys to a running license server is easy, just drop the new license file in the

same folder as your Reprise License Manager (the RLM Directory), then Reread/Restart the servers.

Not sure where this folder is? It's the one that usually contains the following files.

rlm

rlmutil

lightmap.set

You can put multiple license files in this directory. RLM will read all files with a .lic file extension in

this directory.

If RLM is already running when you receive a new license key, you'll need to restart the license server

to get the key working. The simplest method is to use the RLM Web Server.

1. Put your new license key in the RLM Directory.

2. In your browser, go to the RLM Web Server at localhost:5054.

3. Under the RLM Administration Commands, click the Reread/Restart Servers button.

4. In the ISV list, select lightmap.

5. Click the REREAD/RESTART button.

That's it. Your new license key should be working.
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Anatomy of a License Key

Here's an example of a floating license key.

HOST acme_server b8e856458582 5053

ISV lightmap port=62645

LICENSE lightmap hdrlightstudio 2016.0412 12-apr-2016 5 hostid=ANY share=uh

 start=12-apr-2015 issuer=web-shop customer=U-00000002 issued=12-apr-2015 replace

 options=4b397bc914c156025f4e5b5960e74441410ba0ea73716f1c4a1e571b73395836

 disable="TerminalServer VM" _ck=202228fefb sig="302D02145AD0D8A948E

 E52F3D762C92A0CE34449878B33BD021500C73A903258B3A1C1F54B2DB3FD5BD317

 7E5B93E6"

The HOST line specifies on which computer the license server will run. There is only one HOST line

per license file.

HOST acme_server b8e856458582 5053

· acme_server the hostname of the license server.

· b8e856458582 the MAC Address of the license server. The license key needs to be on the

computer whose MAC Address matches this number.

· 5053 the port through which communication takes place. 5053 is the default value. If

5053 is being used by another vendor, you should change this port to another

number (like 5058).

The ISV line generally does not need to be changed. By default, the ISV line does not specify a port,

so RLM dynamically chooses a port number when you start the license server.

ISV lightmap port=62645

· lightmap the ISV vendor name

· port=62645 the TCP/IP port through which the ISV communicates. RLM dynamically chooses a

port number when you start the license server. To specify a fixed port (to get

through a firewall), add port=<isv-port> to the ISV line, where <isv-port> is the

number of a free TPC/IP port. In the example above, we added port=62645

The LICENSE lines specifies the product and version being licensed. It shows you when the key will

expire and how many licenses are granted.

LICENSE lightmap hdrlightstudio 2016.0412 12-apr-2016 5 hostid=ANY share=uh

 start=12-apr-2015 issuer=web-shop customer=U-00000002 issued=12-apr-2015

 options=4b397bc914c156025f4e5b5960e74441410ba0ea73716f1c4a1e571b73395836

 disable="TerminalServer VM" _ck=202228fefb sig="302D02145AD0D8A948E
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 E52F3D762C92A0CE34449878B33BD021500C73A903258B3A1C1F54B2DB3FD5BD317

 7E5B93E6"

· lightmap is the name of the ISV granting the license.

· hdrlightstudio is the product being licensed.

· 2016.0412 is the build version of HDR Light Studio that will be licensed. Any version number

less than this number will also be licensed with this key. This version number

(2016.0412) will allow any builds of HDR Light Studio released before 12 April 2016

to be licensed with this key.

· 12-apr-2016 is the date this license key will expire. The license will work on 12 April 2016 but

not the following day. By default RLM uses the current local time zone.

· 5 is the number of floating licenses granted. In this example, up to 5 client

computers can simultaneously connect to the license server and get a license to

run HDR Light Studio.

· start=12-apr-

2015

is the date the license key will start to function.

· customer=U-

00000002

identifies the person for whom this license was created. U- prefixes are web

customers. A- prefixes are for other customers.

· contract=comm

ercial

the options are commercial, edu, beta, nfr. This defines your use of the software

through the terms and conditions of the EULA.

· issued=12-apr-

2015

is the date the license was created.

· options is an internal code to ensure the license is being used correctly.

· disable="Termin

alServer VM"

prevents licenses being used on virtual machines or terminal servers.

· sig="302D0…

B93E6"

is the encryption key.

Useful rlmutil Commands

Reprise Software provide a useful command line tool called rlmutil. You should find this in the same

directory as your RLM license server. Unless otherwise stated, we’re assuming you are on the license

server and that rlm, rlmutil and your license key are all in the same directory.

To display the number of (unused) licenses available for lighting. If you have 5 licenses and 1 is being

used by someone, this command will return 4.

rlmutil rlmstat -avail
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To show comprehensive data including the total number of licenses, how many are used, how many

are available; as well as port numbers, version numbers, log file path and statistics, try this:

rlmutil rlmstat -a

To show your MAC Address, try:

rlmutil rlmhostid ether

or your ip address:

rlmutil rlmhostid ip

or the hostname of the license server:

rlmutil rlmhostid host

To see who is using the licenses, try this:

rlmutil rlmstat -u

Diagnosing Problems

Here's a list of some of the problems you may encounter and how to get round them.

Port 5053 in Use

When you start RLM two processes are spawned: the RLM process and the lightmap process. If you

shutdown the license server by killing just the RLM process, the lightmap process will continue to run

and a subsequent restart of the license server will fail saying:

(rlm) Port 5053 in use, waiting...

It is recommended that you shutdown the lightmap isv process first, followed by the RLM process.

You can use rlmutil to do this:

./rlmutil rlmdown lightmap

./rlmutil rlmdown RLM

If you do find yourself struggling with Port 5053 in use, the simplest solution is to restart your

computer. That will kill this process as well as all other running processes. If shutting down the server

would make you very unpopular in the office, ask your systems administrator to kill the individual

rlm process then start RLM again.
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Problems Setting up Clients

If you have followed the instructions to set up your clients and you're sure the server is up and

running and serving licenses,but you are getting the following errors:

Communications error with license server (-17)

Connection refused at server (-111) HDRLightStudio

Then you should try replacing the hostname of the server with the IP address of the server in the

client license file or environment variable. To display the ip address for the license server, open a

terminal, shell or command prompt on the server, change directory to the RLM Directory and type:

./rlmutil rlmhostid ip

Make a note of the ip address. Find the license key file on the client machine. The easiest method is

to start HDR Light Studio, select Help from the top menu bar and select Open License Directory. Edit

the file and replace the hostname with the ip address. For example:

HOST 192.8.2.10 ANY 5053

Or if you are connecting with an environment variable use

lightmap_LICENSE=5053@192.8.2.10

Firewall Problems

All the ports in use by the RLM server must be opened for the licensing to work. Get your Systems

Administrator to check that the main server port and ISV port are not blocked or used by another

party. You can see conflicts in the rlm server log file as the IN message containing "Client Exit".

Transferring Licenses

If your computer has been stolen or is broken and you are unable to run HDR Light Studio, you are

entitled to transfer your license key to another computer. You are permitted to do this once per year,

and no more. Terms and conditions apply. Please see the Lightmap Support pages on our web site.

Get the hostid from your Operating System

If you haven't downloaded the Reprise License Manager, you can use an operating system command

to get the hostid (MAC Address). This varies for each operating system.

Windows

On Windows, start a command prompt and use ipconfig.

https://www.lightmap.co.uk/support
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ipconfig /all

In the ipconfig output, look for the Physical Address. In the example below, the hostid =

0024E77DB960

Windows IP Configuration

Host Name . . . . . : LIGHTMAP-PC

Primary Dns Suffix . . . :

Node Type . . . . . : Mixed

IP Routing Enabled . . . : No

WINS Proxy Enabled . . . : No

DNS Suffix Search List . . : lan

Wireless LAN adapter WiFi:

Connection-specific DNS Suffix . : lan

Description . . . . : Intel(R) Centrino(R) Ultimate-N

Physical Address . . . : 00-24-E7-7D-B9-60

DHCP Enabled . . . . : Yes

....

Linux

On Linux, open a shell and use ifconfig.

ifconfig -a

In the output, look for the Ethernet HWaddr. In the example below the hostid = 0024E77DB960

# ifconfig -a

eth1 Link encap:Ethernet  HWaddr 00:24:E7:7D:B9:60

....
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Mac OS X

1. Launch System Preferences

2. Click on Network

System Preferences Dialog

3. Click on Advanced...

Network Dialog
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4. Click on Hardware to display the MAC Address (hostid). In the example shown, the hostid =

b8e856438583

Hardware Tab

Setting Environment Variables

Since nothing is ever easy, how you set an environment variable differs for each operating system.

Here's a quick guide if your systems administrator is busy.

Windows

Microsoft keeps messing with this location on each release of Windows, so here are the approximate

steps

1. Start the Control Panel

2. Click on "System and Security" then "System" then "Advanced System Settings". You're trying to

get to the Advanced tab in the System Properties dialog.

3. Click on the "Environment Variables..." button.

4. Under the System Variables panel, click "New..."

5. In the Variable Name text field enter the environment variable, for example, lightmap_LICENSE

6. In the Variable Value text field enter the value you wish to set. For example, C:

\Shared\lightmap\licenses\hdrlightstudio.lic

Mac OS X

On a Mac you can set a temporary environment variable using the Terminal application. This is easy
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to do and is worth doing before going to the trouble of setting one permanently. The process is

further complicated because the syntax you use differs depending on the type of shell (csh, bash,

tcsh).

1. Start a Terminal (Applications - Utilities - Terminal) and enter:

echo $SHELL

2. If you are running a bash or ksh shell, enter:

export lightmap_LICENSE=/Shared/lightmap/licenses/hdrlightstudio.lic

3. If you are running a csh or tcsh shell, enter:

setenv lightmap_LICENSE /Shared/lightmap/licenses/hdrlightstudio.lic

In the above example, the environment variable (lightmap_LICENSE) only exists in this shell. If you

open another terminal, you would need to set the environment variable in that shell too. 

For a more permanent solution, you'll need to add the environment variable to /etc/launchd.conf

and for that you'll need to find your busy systems administrator.

Linux

On Linux you can set a temporary environment variable in a shell. The process differs depending on

the type of shell (csh, bash, tcsh) you are using.

1. Start a shell and enter:

echo $SHELL

2. If you are running a bash or ksh shell, use export to set the environment variable, for example:

export lightmap_LICENSE=/Shared/lightmap/licenses/hdrlightstudio.lic

3. If you are running a csh or tcsh shell, use setenv to set the environment variable, for example:

setenv lightmap_LICENSE /Shared/lightmap/licenses/hdrlightstudio.lic

In the above example, the environment variable (lightmap_LICENSE) only exists in this shell. For a

permanent solution for you as a user, you'll need to add the environment variable to your

.cshrc, .tcshrc, .bashrc, .kshrc file in your home directory. For a permanent, system wide solution,

then get your systems administrator to add it to /etc/profile.

Further Reading

The Reprise Software website is a good place to search for additional help. Here's a link to their

License Administrator and User FAQs.

http://www.reprisesoftware.com/admin/software-licensing-faq.php
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License Changes in Tungsten

Legacy Licenses

Since the release of HDR Light Studio version 5, May 2015, customers would purchase a license for

HDR Light Studio and for each plug-in Connection required.

For example if you wanted to use HDR Light Studio connected with Maya and 3ds Max, you would

purchase HDR Light Studio, a Maya Connection and a 3ds Max Connection.

The customer would then receive 3 license files for these products using their activation code.

To use HDR Light Studio standalone would use only a HDR Light Studio license.

To use HDR Light Studio connected to Maya would use both a HDR Light Studio license and a Maya

Connection license.

To use HDR Light Studio connected to 3ds Max would use both a HDR Light Studio license and a 3ds

Max Connection license.

We will now refer to these license types as legacy. They will continue to be supported in future HDR

Light Studio versions for our customers with permanent licenses and purchasing maintenance for

those licenses.

New Licenses (introduced in Tungsten release May 2019)

For Tungsten and newer software, we have made changes in how HDR Light Studio is sold.

Customers now purchase single products that bundle HDR Light Studio and a selection of

Connections.

These new products are enabled with a single license file.

HDR Light Studio - Indie

In the license file, the product is called: hdrls_tier1

This allows HDR Light Studio to run both standalone and connected to our 'tier 1' connections, these

are (at the time of launch):

3ds Max, Maya, Cinema 4D, MODO, LightWave3D, Houdini, Maxwell Studio, Rhino 3D, Octane

Standalone, SOLIDWORKS Visualize

In the license file, the contract (terms) is: indie

The combination in the license file of hdrls_tier1 and indie means this is a license for our Indie

product.
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HDR Light Studio - Pro

In the license file, the product is called: hdrls_tier1

This allows HDR Light Studio to run both standalone and connected to our 'tier 1' connections, these

are (at the time of launch):

3ds Max, Maya, Cinema 4D, MODO, LightWave3D, Houdini, Maxwell Studio, Rhino 3D, Octane

Standalone, SOLIDWORKS Visualize

In the license file, the contract (terms) is: pro

The combination in the license file of hdrls_tier1 and pro means this is a license for one of our Pro

products.

HDR Light Studio - Automotive

In the license file, the product is called: hdrls_tier2

This allows HDR Light Studio to run both standalone and connected to our 'tier 2' connections, these

are (at the time of launch):

3ds Max, Maya, Cinema 4D, MODO, LightWave3D, Houdini, Maxwell Studio, Rhino 3D, Octane

Standalone, SOLIDWORKS Visualize

Plus VRED, DeltaGen and PatchWork 3D.

In the license file, the contract (terms) is: automotive

The combination in the license file of hdrls_tier2 and automotive means this is a license for one of

our Automotive products.

License Use Logic

Here is the logic for how HDR Light Studio will try to obtain licenses in Tungsten and newer versions.

Standalone

If HDR Light Studio is run standalone it will look for a hdrls_tier1 license first,

if it can't obtain one it will look for a hdrls_tier2 license,

if it can't obtain one it will look for a legacy hdrlightstudio license.

This is why when you start the software unlicensed now you will see these messages
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Connected to Maya

If HDR Light Studio is started from Maya (which can run from a tier 1 license) it will look for a

hdrls_tier1 license first,

if it can't obtain one it will look for a hdrls_tier2 license,

if it can't obtain one it will look for a legacy hdrlightstudio + maya connection license pair.

Connected to VRED

If HDR Light Studio is started from VRED (a tier 2 connection) it will look for a hdrls_tier2 license first,

if it can't obtain one it will look for a legacy hdrlightstudio + vred connection license pair.

Behavior mixing legacy and new licenses

There are certain situations where this license logic may be undesirable. For example when there are

a mix of legacy and new licenses on a single floating license server.
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For example, if you have 5 sets of legacy licenses for HDR Light Studio and Maya on an RLM server.

But you also have a single license for HDR Light Studio - Automotive (hdrls_tier2) on there too, to use

with VRED.

Which ever client in the office starts HDR Light Studio first, be that standalone or with Maya, they will

use the Automotive license first (HDR Light Studio looks for tier1, then tier2, then legacy last). This

will prevent any other user from obtaining this Automotive license which is the only one that can be

used with VRED. In this scenario, it would be best to install the Automotive license on a separate RLM

session on a different port - keeping the legacy and new licenses separate from each other.

If you would like to ask more and have an issue you would like to discuss, please contact:

support@lightmap.co.uk

mailto:support@lightmap.co.uk
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Subscription Renewal

Renewing 1 Year Licenses (Subscriptions)

Renewing your 1 year license of HDR Light Studio is easy. Simply buy another subscription.

Facts:

·  Subscriptions do not auto renew. We do not know or store your card details.

· Just buy another subscription whenever you need to use the software again.

· The new subscription does not need to be on the same user account as the original purchase.

· The new subscription does not need to be continuous from the expiry of the previous license.

· The license start date is the date the Activation code is used, not the date of purchase. You have up

to 30 days to activate your software after purchase until the subscription period starts.
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Maintenance and Maintenance Renewal
1. What is Maintenance?

2. When does the included 1 year Maintenance period begin?

3. How can I check my Maintenance end dates?

4. How can I check the build dates of my installed HDR Light Studio or Connection?

5. When downloading new builds of HDR Light Studio or a Connection, how do I know their

build dates?

6. What happens if I run a version of HDR Light Studio or a Connection that is newer than the

maintenance end dates in my license files?

7. How are my licenses updated when I renew maintenance?

8. How much does Maintenance cost?

9. How do I purchase Maintenance?

10.What is co-terming?

11.Can I renew maintenance via my reseller?

12.I used the license transfer to install node locked HDR Light Studio on 2 machines (work and

home). I am confused about how to renew the maintenance licenses on both machines.

What is Maintenance?

Maintenance = Entitlement to Software Updates and Customer Support

When buying a permanent license of HDR Light Studio or Connections, the price includes 1 year of

maintenance. Maintenance ensures you can run the latest versions of the software. For example

during 2018, we released 4 new drops of HDR Light Studio that included new features, bug fixes and

updated or additional compatibility with partner software.

Maintenance is the only way to keep your permanent software up to date. We do not sell upgrades.

Maintenance also entitles you to customer support – email support questions and license transfers.

Permanent node locked licenses can be relocated once per year using the online license transfer

system at our web site. Outside of this, we will not relocate any permanent licenses for customers

that are outside of maintenance.

When does the included 1 year (365 days) Maintenance period begin?
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The 1 year maintenance period starts from the moment the activation code is used - this both

creates and redeems your permanent license file/s.

For example, if you purchase on the 2nd March 2018, then use the activation code on the 10th March

2018, the maintenance date in the license file will be set to 10th March 2019. Using this license file

you can run any build of HDR Light Studio with a build date up to, and including, 10th March 2019.

Please note: The activation code should be used within 30 days from the purchase date at our web shop.

The maintenance date is limited to be no more than 1 year and 30 days from the purchase date.

How can I check my Maintenance end dates?

You can easily check the maintenance end dates for your installed licenses from within HDR Light

Studio software (even if the software is in an unlicensed state). Go to Help > License Management.

The ‘Version’ column displays the maintenance end dates in the YYYY.MM.DD format. Those license

files will run HDR Light Studio and Connections built on or before that version date.

Prior to installing a new version of HDR Light Studio or a plug-in Connection, you should check these

maintenance end dates to ensure your licenses will run the new software.

 

In the example above, the maintenance date for those licenses is 2019.1211 = 11th December 2019.

Alternatively you can login to your account at lightmap.co.uk and go to the My Maintenance page,

where maintenance expiry dates are also shown for software purchased using that account.
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How can I check the build dates of my installed HDR Light Studio or

Connection?

In HDR Light Studio go to the menu Help > About. The About panel will display the build of HDR

Light Studio – with the build date in YYYY.MMDD format, and the Connection build date too if HDR

Light Studio was started via a connection to your 3D software.

 

In the example above, the build date for HDR Light Studio is 2018.1023 = 23rd October 2018

The build date for the Maya Connection is also 2018.1023 = 23rd October 2018

A build date for a connection is also often displayed within the Connection interface panel in your 3D

software.



197

197HDR Light Studio - User Guide

When downloading new builds of HDR Light Studio or a Connection, how

do I know their build dates?

All installers for HDR Light Studio and Connections include their build date in their file name, using

this format: YYYY.MMDD (i.e. 2018.1023 = 23rd October 2018). These build dates are also shown on

our Downloads pages, prior to downloading those files.

What happens if I run a version of HDR Light Studio or a Connection that

is newer than the maintenance end dates in my license files?
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If you run a build of HDR Light Studio or a Connection that is newer than the maintenance date

within the license file, HDR Light Studio will start unlicensed, and will display this error: Requested

version not supported (-6) HDR Light Studio.

How are my licenses updated when I renew maintenance?

When purchasing maintenance for your permanent licenses, you will be supplied with a new

activation code. The new activation code will redeem a new license file with an updated maintenance

date. This has the replace flag set and will override your existing licenses. It will use the mac address

we already have on file for your permanent license. (In the case of Transferred licenses, this is the

Mac address of the machine where the software was last transferred to). Therefore renewing

maintenance does not provide an additional opportunity to relocate your software.

For node locked licenses, enter the new activation code directly into HDR Light Studio. You can do

this by starting HDR Light Studio and going to Help > Enter Activation Code

For floating licenses, go to the web page:

https://www.lightmap.co.uk/support/licensing/activate-floating-license/

https://www.lightmap.co.uk/support/licensing/activate-floating-license/
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If asked, enter the details where the existing permanent licenses that have been maintained are

installed.

If you don't know what machine that was, the mac address we have for the previous license is

displayed on your activation codes account page on our web site.

How much does Maintenance cost?

The best way to see what you will actually need to pay, is to follow the purchase process below. It

provides an accurate price.

How do I purchase Maintenance?

Login to your account at: www.lightmap.co.uk and go to the ‘My Maintenance’ section.

Here you can see the maintenance status for all licenses and add maintenance purchases to your

cart.

Once you have enabled the ‘Renew or Upgrade’ checkbox, next press the ‘Add Renewals to Basket’

button at the bottom of that page. You will then proceed to your basket and can see the cost for your

maintenance renewal/s. Complete the purchase to be sent new activation codes used to retrieve new

updated licenses with new maintenance dates.

Please Note: If you feel that Maintenance items are missing that you expect to see on your

Maintenance page (https://www.lightmap.co.uk/account/maintenance/) , please check you have

activated the previous license on your Activation Codes page

(https://www.lightmap.co.uk/account/activation-codes/). Maintenance will not appear for licenses

that have not been activated, including previous maintenance purchases.

What is co-terming?

https://www.lightmap.co.uk/account/maintenance/
https://www.lightmap.co.uk/account/activation-codes/
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Floating licenses sharing the same mac address will be grouped and ‘co-termed’ – i.e. if the licenses

have staggered maintenance dates, the new licenses will ensure these all share the same new

maintenance end date.

Can I renew Maintenance via my reseller

If you want your reseller to renew your maintenance – login to your account and go to the ‘My

Maintenance’ section and locate your ‘reseller maintenance authorization code’ at the top of the

page. Supply this code to your reseller and they will be able to renew maintenance for you.

 

I used the license transfer to install HDR Light Studio node locked on 2

machines (work and home). I am confused about how to renew the

maintenance on both machines.

When you purchased HDR Light Studio, it was initially installed on computer A. You then got a new

activation code for the second machine via the license transfer facility on our web site, and then used

the additional activation code to license computer B. Now both computers are A and B licensed.

When purchasing your maintenance renewal. You will need to use the new activation code on

computer B first. Computer B has the last mac address we have on file for that license. If you try to

use the maintenance activation code on any other machine it will not issue a new license. Once you

have used the activation code on computer B, use the license transfer facility again on our web site,

using this new activation code. You will then be issued with an additional activation code that can be
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used on computer A. Now both computer A and B will have new licenses with updated maintenance

end dates.

For any additional help with renewing maintenance please contact: sales@lightmap.co.uk

mailto:sales@lightmap.co.uk
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Quick Start Video
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Menus and Toolbars

A lot of HDR Light Studio functionality is available through the Menus and Toolbars.

· Project Menu

· Edit Menu

· Create Menu

· Canvas Menu

· Window Menu

· Help Menu

· Tool Bars
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Project Menu

HDR Light Studio projects are saved as .HDi files. These project files contain each light and its

settings, and also any references to external content including images and the loaded 3D scene file.

New Project

Open Project

Save Project

Save Project As

Load 3D Scene File

Allows the user to load a new 3D scene file to show in the Render View window. This will not replace

the current lighting, all of the lights will remain in the Light List after this operation.

Load Demo Model

Opens the panel where you can choose to load one of the demo 3D models included with HDR Light

Studio.

Save Render View Images

Saves the current render images from Render Views as EXR files on disc. Upon selection, the file

browser will open, so a file name and location for the EXR file can be set.

File names will have a suffix added to note which view they came from. For example:

the_file_name_(3DSMax_VRay).exr

the_file_name_(HDRLightStudio).exr

Please note: During the Production Render (using HDR button on tool bar) you can also enbale the

Render View check box in the settings to save a PNG for open Render Views, with the view LUT baked
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in. These images form a handy reference to go with the final lighting and optionally the lighting

project.

Render Production HDRI

Opens the Production Render dialog to allow the user to set the properties for the production

rendering of HDR content, and to then render this content. For more information see: Production

Rendering Dialog

Re-Render Production HDRI

Renders the HDR content with the last used settings. eg. same file names and locations, overwriting

the previous content.

Manage File Links

Allows the user to manage the files referenced in the current project. For more information see:

Project Assets Dialog

Exit

Closes HDR Light Studio application.
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Edit Menu

Undo

Undoes last operation.

Redo

Undoes the previous 'undo' operation.
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Duplicate

Duplicates the selected light and prompts the user for a new light name.

Delete

Deletes the selected light.

Delete All

Deletes all lights only. This will not delete the currently loaded 3D scene file or the background

image.

Delete 'Off' Lights

Deletes all the lights that are in the off state in the first column. This a good way to purge your

project of lights that are no longer contributing to your lighting.

New in 8 Drop 1

Copy

Copy selected lights.

Paste

Pastes the copied lights into the active Look in the current Project. Lights are added to the top of the

Light List.

New in Tungsten Drop 1 - Commands for Composite Content

See here for Working with Composites

Merge To Composite

This command creates a new light with Composite content, and moves the selected lights from the

current Light List into the Composite. The new light has planar mapping and fills the canvas,

therefore the lights will maintain their position on the Canvas.

Merge All Lights to Composite

This command creates a new light with Composite content, and all lights in the currently viewed

Light List are moved into its Composite (excluding area lights and lights with composite content).

The new light has planar mapping and fills the canvas, therefore the lights will maintain their

position on the Canvas.
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Merge All To Composite

This command creates a new light with Composite content, and all lights in the currently viewed

Light List are moved into its Composite (excluding area lights). The new light has planar mapping

and fills the canvas, therefore the lights will maintain their position on the Canvas.

Release From Composite

This command removes the selected lights from the Composite, and moves them up one level, to be

in the same Light List as their parent light.

Release All From Composite

This command removes all lights from the currently viewed Composite light list, and moves them up

one level, to be in the same Light List as their parent light.

On/Off

Contains operations for changing the On/Off state of the selected light or all lights.

i.e. Light On, Light Off, All Lights On, All Lights Off

Solo

Contains operations for changing the Solo state of the selected light or all lights.

i.e. Solo, Unsolo, Solo All, Unsolo All

Pickable

Contains operations for changing the Pickable state of the selected light or all lights.

i.e. Set Pickable, Set Not-Pickable, Set All Pickable, Set All Not-Pickable

Arrange

Contains operations for changing the Light List ordering of the selected light.

i.e. Move to Top, Move Up, Move Down, Move to Bottom

Lock

Contains operations for changing the Lock state of the selected light or all lights.

i.e. Lock, Unlock, Lock All, Unlock All

Deselect

Deselects the selected light



209

209HDR Light Studio - User Guide

Rename

Opens a dialog for renaming the selected light.

Manage User Presets New in Tungsten Drop 4

Opens the User Presets Management dialog, that allows the user to rename and update tags for user

presets, and delete them.

Preferences

Opens the Preferences dialog that allows the user to set the preferences for the HDR Light Studio

application.
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Create Menu

Creates a new light based on the selected light type. For more information see: Light Types

Create user presets - Lights and Rigs. See: Presets
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Canvas Menu

Lat-Long Guide

Turn this on to display guide lines on the canvas, they are only an overlay and not included in the

HDRI map design. These guides can be helpful as they show the horizon line and a vertical lines at 0,

90, 180, 270, 360 degrees. They are off by default.

Example of Canvas Guides On

Selected Light

Turn this on to display the orange light handle in the middle of the selected light. This is on by

default. You may want to turn this off if the orange handle is obscuring your view of the pixels in the

center of the light. The selection handle denotes the position by which the light is being placed.

When you move the light, this locator is moved to the new position selected.
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Window Menu

Always on Top

When enabled, the HDR Light Studio interface is displayed on top of any other running applications.

This can be useful when using a 3D application and HDR Light Studio on the same screen.

Please Note: Sometimes if you open a dialog from HDR Light Studio (e.g. the Preferences dialog), this

window will appear underneath the main HDR Light Studio window. You'll have to move HDR Light Studio

main interface out of the way to proceed.

Toolbars

Enables the display of the following Toolbars on the interface:

Project Toolbar, Edit Toolbar, Create Toolbar, Help Toolbar

Interface Panels

Enables the display of the following interface panels on the interface:

Presets, Render Views, Render Settings, Light List, Light Properties, Canvas, Light Controls, Light

Preview

Layout

Contains controls to load and save user interface layouts. For more information see: Layouts
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Help Menu

Online Help

Opens the online version of HDR Light Studio documentation. This is always the most up to date

version and may include new information between software releases.

Enter Activation Code

Provides a method to add additional licenses to your node locked installation using Activation Codes.

For more information see: Enter Activation Code Dialog

Buy HDR Light Studio License

Link to the HDR Light Studio buy page on the Lightmap website.

Connect To Floating License Server

Opens a dialog that allows the user to enter a Host Name or IP address and Port number for the RLM

server running the HDR Light Studio licenses.

License Management

Opens a dialog containing information on the current licenses installed for the HDR Light Studio

installation.

For more information see: License Management Dialog

Open License Directory

Opens the directory in your operating system when the license files for HDR Light Studio are located.

Legal Information

Link to the Legal Information web page related to HDR Light Studio.
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About

Provides useful information about the installation of HDR Light Studio you are using. These details

can be useful when getting technical support.

For more information see: About Dialog
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Tool Bars

Here is an overview of all the buttons on the tool bars.
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Tool Bar Light Types

The tool bar lights provide a quick way to make a new light with specific basic initial settings. The

light will be created at a default size and position - ready to then position and scale.

· Round Light

· Rectangular Light

· Scrim Light (New 8 Drop 1)

· Box Gradient Light

· Gradient Light

· Picture Light

· Dark Light

· Sun Shade

· Gradient Background

· Picture Background

· Sky Background

· Flat Background

· Composite Light

The Presets are a far more convenient way to add lights to your scene. Presets provide a huge variety

of lighting that can be dragged and dropped where needed directly onto the 3D model.
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Round Light

A soft round light.

Here are the key settings for a Round Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add

Content: Bulb
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Rectangular Light

A procedural soft box style light with controllable Bulb content.

Here are the key settings for a Rect Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add

Content: Bulb with 'Outside' option on.
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Scrim Light

A versatile procedural light capable of a huge range of physical light effects.

Here are the key settings for a Scrim Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add

Content: Scrim Light
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Box Grad Light

A procedural light with Box Gradient content (Blended vertical and horizontal ramps). Great for

creating a light with highly controllable soft edges.

Here are the key settings for a Box Grad Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add

Content: Box Gradient
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Gradient Light

Light defined by a linear or radial set of gradients for color, brightness (value), and alpha.

Here are the key settings for a Gradient Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add

Content: Gradient with a default linear gradient
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Picture Light

This light uses any imported image as the source of light. You can use low dynamic range files or high

dynamic range files. Alpha is supported.

Here are the key settings for a Picture Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Over

Content: Image with no image loaded
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Dark Light

A soft round light with blend mode settings Add with Invert that removes brightness from underlying

content. Use it to darken areas of the HDRI map.

Please note... you can often get better more controllable results switching to Amplify blend mode, with

Invert on.

Here are the key settings for a Dark Light:

Mapping: 3D

Width: 20

Height: 20

Blend Mode: Add, with Invert option on

Content: Bulb
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Sun Shade

The Sun Shade is used to clamp the brightness of bright pixels. Its main purpose is to allow you to

reduce the brightness of the sun on HDR environment maps.

Here are the key settings for a Sun Shade Light:

Mapping: Planar

Width: 20

Height: 40

Blend Mode: Low Pass

Content: Flat
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Gradient Background

This add a whole canvas linear gradient from the top to the bottom of the environment map. There

are 3 ramps to control color, brightness (value) and alpha.

Here are the key settings for a Gradient Background:

Mapping: Planar

Width: 100

Height: 100

Blend Mode: Add

Content: Gradient with a default linear gradient
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Picture Background

Fills the canvas with the loaded image. Ideal for loading HDRI maps into HDR Light Studio.

Here are the key settings for a Picture Background:

Mapping: Planar

Width: 100

Height: 100

Blend Mode: Over

Content: Image with no image loaded
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Sky Background

Procedural sky shader, mapped to fill the canvas.

Here are the key settings for a Picture Background:

Mapping: Planar

Width: 100

Height: 100

Blend Mode: Over

Content: Sky
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Flat Background

Creates a new light with planar mapping filling the canvas, its Content Type is set to Flat. The one

above had its color set to blue.

Here are the key settings for a Picture Background:

Mapping: Planar

Width: 100

Height: 100

Blend Mode: Add

Content: Flat
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Composite Light

Creates a new light with planar mapping filling the canvas, its Content Type is set to Composite.

See here for Working with Composites
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Light List Panel

As lights are added to your scene they appear in the Light List. If you cannot see the Light List panel,

go to the top menu bar and click on Window > Light List. The order of the lights in the list determines

the order in which they are rendered on the canvas. Lights at the top of the list are rendered over

lights below them in the list.

Some common functions are available by right-mouse clicking on the light list.
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Selecting Lights

To select a light, click on the light in the Light List. When a light is selected it is highlighted in light

grey and its properties (colour, position, etc) are shown in the Light Properties panel.

Once a light is selected you can move the position of the light on the 3D model by clicking on the

Render View, by moving it on the Canvas, or by adjusting its Latitude and Longitude slider in the

Light Properties panel.

You can also edit other properties for the selected light in the Light Properties panel.

You can use the 'up' and 'down' arrow keys on your keyboard to change which light is selected -

moving up and down the list from the current selection.
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New in Tungsten

You can now select multiple lights in the Light List.

Use the Shift key whilst clicking in the Light List to select a range of lights.

Use the Ctrl key whilst clicking in the Light List to add and remove individual lights from the current

selection.

When multiple lights are selected, they will be highlighted in the Light List.

Multiple light selections can be:

Deleted

Copied

Merged into a Composite

Released from a Composite

For example, when multiple lights are selected they can not be moved and their properties can not

be adjusted.

Please note: To undo commands performed on multiple lights, then multiple undos will be required. For

example if deleting 2 selected lights, this will require 2 undos to get them back.
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Reordering Lights

To change the position of a light within the Light List:

· Click, hold and drag the light in the light list to place it in a new position on the list, or

· Use the main menu and choose Edit > Arrange, which contains a range of commands for

changing the order of lights, or

· Hold the Shift key and use the Up and Down arrow keys on your keyboard, to move the

selected light up and down the list.
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Deleting Lights

 

To Delete a light, select the light and either:

· Go to the menu Edit > Delete or

· Use Ctrl-X on your keyboard (Command-X on a Mac), or

· Press the Delete button on the Toolbar (a cross in a circle), or

· Right click on the light in the light list and select Delete from the pop-up menu.

After a light has been deleted the next light below that in the list is automatically highlighted. This allows

for rapid deletion of adjacent lights.
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Duplicating Lights

To duplicate a light, select the lights in the list and either:

· Go to the menu Edit > Duplicate or

· Use the keyboard shortcut is Ctrl + D on Windows/Linux  and Command-D on Mac, or

· Press the Duplicate button on the toolbar, or

· Right click on the light in the light list and select Duplicate from the pop-up menu.
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Copy and Paste Lights

To Copy lights, select the lights in the light list and either:

· Go to the menu Edit > Copy or

· Use Ctrl + Shift + C on your keyboard (Command + Shift + C on a Mac), or

· Right click on the light in the light list and select Copy from the pop-up menu.

You can paste lights within in the same Look, into other Looks and across Projects. Pasted lights are

always added to the top of the Light List.

To Paste Lights:

· Go to the menu Edit > Paste or

· Use Ctrl + Shift + V on your keyboard (Command + Shift + V on a Mac), or

· Right click on the light in the light list and select Paste from the pop-up menu.
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Renaming Lights

To rename a light by opening the Renaming panel for the light either:

· Go to the menu Edit > Rename or

· Double click on the Light in the Light List or

· Right click on the light in the list and select Rename from the pop-up menu

You can then rename the light using the Renaming panel and press OK
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Alternatively you can also rename the light by typing a new name in the Name field, in the Light

Properties panel.
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Switching Lights On/Off

You can switch on/off any of the lights in the list by clicking on the on/off button for the light in the

list.

When a light is off, it will not be shown in the lighting design, unless the solo state is on for the light.
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Soloing Lights

If you have lots of lights in your scene but just want to see the effect of one light, you can use the

solo button to hide all other lights.

Multiple lights can be set to solo, and only the solo lights will be shown.

Solo Switch

When no solo buttons are used, the state of the lights (either on or off) is taken only from the on/off

switches.

If any light has been soloed, then the on/off column is ignored and the state of the lights is taken

from just from the solo switches.

This is handy because you can use the solo feature to see lights that are turned off in the lighting

design without changing their on/off state.
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Picking Lights

Instead of selecting lights from the light list, you can pick the lights directly from the render view (or

canvas). Simply, select the pick tool in a Render View or Canvas window and click on the light you

want to select. 

Pick Tool

Tip: You can also right click in the canvas and render views to select a light. In the Render Views, the

LightPaint mode is used to select the light.

By default, every light is pickable but you can switch this off. This is worth doing for background

lights that cover the whole scene and are therefore pickable from anywhere on the model or canvas.

 In the example below, the gradient background has been set to be not pickable (as shown in the

third column).

Pick Switch
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Locking Lights

To stop you accidentally moving a light, you can lock it using the padlock icon in the fourth column.

The light can still be switched on/off, soloed and moved up and down the list, but the name of the

light, position on the model, color and other light properties cannot be edited.
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Composites

New in Tungsten

Composite is a new content type in HDR Light Studio.

Instead of a light getting its appearance from a loaded texture or procedural image data  - the

appearance of the light comes from a set of HDR Light Studio lights held within the composite.

See here for Working with Composites

New Arrow Buttons

Lights containing Composite content have an arrow button on the right side of the light list.

Press the arrow button on the right to Edit the Composite and display the composite's lights on the

light list and canvas.

When editing a Composite. The Light List will display the name of the parent light at the top, and will

list the lights in the composite below. It will also show a left arrow button at the top.

Use the left arrow button to return to the Light List containing the parent light - this is like moving up

a level in the lighting design.
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In short, these new arrow buttons on the light list allow users to navigate 'in' and 'out' of Composites.

A composite can contain another light which also has composite content. The arrows get very useful

for navigating these multi-level lighting designs.

Drag and Drop a light into a Composite

You can drag and drop a light into a Composite Light.

See in the image below there is a Composite Light and a Picture Background Light.

The Picture Background light can be dragged and dropped onto the Composite Light, you can see the

Composite Light is highlighted.

See in the image below, the Picture Background light has now been dropped into the Composite

Light. The small preview image in the light list for the Composite Light now shows the Picture

Background.

The light has not disappeared, it is now contained within the Composite light.

Press the right arrow button to edit the Composite and you can see the Picture Background light

again in the light list. It now belongs to the Composite.
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If you wanted to remove the Picture Background light from this Composite, and return it to the base

lighting design - right click on the light in the list and select: Release From Composite
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Right Click Menu

Right clicking on lights in the list displays a pop-up menu. It will also select a light if it is not already

selected.

Toggle Area Light

This setting is enabled for lights with 3D mapping, enabling their Area Light setting to be toggled. You

can now select multiple lights in the Light List and toggle their area light state. You can also use the

keyboard shortcut CTRL + Space Bar, (on MacOS - Fn + Cmd + Space Bar).

Duplicate

Duplicates the selected light.

Deselect

Deselects the selected light/s (works with multiple selections).

Delete

Deletes the selected light/s (works with multiple selections).

Rename

Opens the Renaming panel - so the selected light can be Renamed.

Create Preset

Opens the 'Create Lights Preset' panel, so the selected light can be saved as a User Preset.
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Merge To Composite

Takes the selected light/s and adds them into a new Composite light (works with multiple selections).

Release From Composite

Takes the selected light/s and removes them from their composite, and moves them up to the light

list containing the parent light (works with multiple selections).

Copy

Copy selected lights.

Paste

Pastes the copied lights into the active Look in the current Project. Lights are added to the top of the

Light List.
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Canvas Panel

The canvas is at the heart of HDR Light Studio. The final output of HDR Light Studio is a high

resolution, high dynamic range image of the canvas (and sometimes HDR area lights). Your lighting

design is described by the lights you add to the canvas. The canvas is a rectangular image that is

wrapped around a sphere to light the 3D model in the Render View.

LightPaint on Canvas
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The LightPaint drop down controls what attributes are controlled by clicking/dragging in the Canvas

panel. This defaults to 'Move'. If the cursor is within the Canvas panel, use the keyboard shortcuts to

switch between LightPaint modes for the Canvas only.
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Canvas Tools

The Canvas Tools allow you to move and pick lights; and pan, zoom and reset the canvas. To zoom

the canvas, press the tool and drag the mouse vertically. To use the Rectangular Canvas Zoom, drag

the mouse diagonally. Note that pressing the Right Mouse Button (RMB) on the canvas selects the

lights under the cursor.

When the cursor is within the Canvas window, it will change to represent the active tool.

Exposure

The exposure controls let you view detail in overexposed lights or in the shadows of environment

maps. It does not affect the brightness of any of the lighting itself, it changes the exposure level of

the image being displayed on the screen.

Exposure

Control

Click and drag on the button, right and left to increase or decrease the exposure or type values into

the text field. Double click on the icon to reset the value to 1.

Example of adjusting the Exposure of the Canvas View
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Channels

The Channels drop down lets the user choose which channels are used for the display in the Canvas

view. This does not affect the data being used to light the view in the Render View, or the HDRI map

being shared with a Connection. It simply controls the display as seen in the canvas view.

Here are some example Channel settings:
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Pixel Probe

The Pixel Probe is located at the bottom of the Canvas and displays values for the pixel that is

currently located under the cursor on the Canvas. As you move your cursor around the Canvas you

will see these values and the swatch update.

Additional Settings

There are two additional canvas settings available from the Canvas menu.

Lat-Long Guide - turn this on to display guide lines on the canvas, they are only an overlay and not

included in the HDRI map design. These guides can be helpful as they show the horizon line and a

vertical lines at 0, 90, 180, 270, 360 degrees. They are off by default.

Selected Light - turn this on to display the orange selection handle in the middle of the selected

light. This is on by default. You may want to turn this off if the orange handle is obscuring your view

of the pixels in the center of the light. The selection handle denotes the position by which the light is

being placed. When you move the light, this locator is moved to the new position.
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Render View Panels

HDR Light Studio has an inbuilt interactive renderer that provides a preview of the lighting effect

from the HDRI Map and Area Lights on a loaded 3D scene with a simple single shader for the whole

model. This is view is called Render View (HDR Light Studio).

Some HDR Light Studio plug-in connections support a second render view panel, where the

interactive render from the main 3D software is displayed in the HDR Light Studio interface. This view

is called Render View (Host/Renderer) where the host is the 3D software connected, and the

renderer is the active renderer in the 3D software.

· Render View (HDR Light Studio)

· Render View (Host/Renderer)

· The LightPaint System

· Render View Settings Panel

· Display Controls

· Frame Number

· Proxy Image Resolution

· Render Views Usage Guide

· Matching your 3D Software
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Render View (HDR Light Studio)

This view is displayed by default using HDR Light Studio standalone

This view is displayed by default using Connections allowing 3D scene export into HDR Light Studio

HDR Light Studio includes it's own fast CPU based 3D renderer.  It provides a fast and responsive

interface (even with large models) where lighting can be moved by clicking and dragging directly on

the rendered view. To do this our renderer takes short cuts. For example, there is only one material

applied to the whole model, no light bounces are calculated, it doesn't support fur and only polygon

geometry. But it is smart - a clever caching approach means once samples are collected from the

HDRI map, any changes do not restart the rendering process as with traditional renderers.
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Advantages and Disadvantages of using our in-built Renderer

Advantages

· Fast: Click and drag to position lights with immediate feedback in the view. Render does

not need to recalculate with HDRI map changes. A very fast and responsive interface for

controlling the lights.

· Robust: Created to handle complex scenes with ease - load huge scenes and maintain fast

interactive feedback.

· Export only a part of your scene to get even faster feedback.

· Zoom into a region of the shot to light a detail.

Disadvantages

· Doesn't show the lighting with your final shaders/render engine - this view provides an

impression of the lighting effect using a single simple shader on the entire scene. You

need to render the image in your host/renderer to see the actual lighting effect on the

final shot.

· Requires loading an exported version of your scene into HDR Light Studio. This takes time

to export and uses more resources like RAM on your computer because the scene will be

loaded in both the host and HDR Light Studio at the same time. The model loaded in HDR

Light Studio is at the mercy of the exporters in the host 3D software.

· Does not calculate light bounces. Very poor solution for lighting interiors for example.

· Only previews lighting created with HDR Light Studio. Any other lights in your scene will

not be previewed in this view.
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Loading Models

When starting HDR Light Studio, the Render View (HDR Light Studio) displays a play button.

When running HDR Light Studio standalone, pressing the Play button will open the Load Scene

Geometry panel.

Here you can load the provided Demo model/s or choose an existing 3D scene to load from disc.

HDR Light Studio supports: Alembic, Collada, FBX (FBX Windows only).
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Please note: If the Play button is pressed when HDR Light Studio is connected to your 3D software via a

connection, if supported, you will be prompted to import you 3D scene from your 3D software.

There are 3 additional ways to load a new scene file in HDR Light Studio:

1. In the menu, go to Project > Load 3D Scene File

2. Drag and drop a scene file from your file system browser directly onto the Render View

3. In the Render Settings panel, press the Browse button next to 3D Scene File to locate and choose a

scene

Resync Scene

When using HDR Light Studio standalone - the resync button will reload the current scene back into

the Render View.

When using HDR Light Studio connected to a 3D app - the resync button will open the 'Import Scene

Geometry' panel - so you can re-import the scene from your host 3D software.

This is useful if you have made changes to the scene in your 3D software.

Render View Tools

The render view tools allow you to move/pick lights and pan/zoom the view.
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Find out more about the LightPaint Tool here

When the cursor is within the Render View window, it will change to represent the active tool.

Camera List

When 3D scene files are imported into HDR LIght Studio, the cameras contained within your scene

file are listed in the camera drop down in the Render View.

Use the drop down to select which camera is used for the Render View.

IBL and Area Lights Compositing

In the Render View, the lighting and reflections from the HDRI map (IBL) and Area Lights are

calculated separately and composited together. This is a short cut to improve the performance of the

Render View, to make it faster and more interactive.

This does mean that in some situations the result may be a little confusing.

In this example below, we have the kettle lit with a HDRI map and an Area Light. Even though the

Area Light is not transparent, and will not be transparent with this lighting setup in your actual

render software, in the Render View the sun from the HDRI map can be seen through the Area Light

reflection on the kettle. If this was physically accurate, the area light would obscure the sun, and

would cast a shadow too. This is not the case in the Render View.
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Render View (Host/Renderer)

The view name is derived from the current connection - for example ‘Render View [3dsMax|V-Ray]’

This view is displayed by default using Connections that can support this feature, but it is renderer

specific.

This view is not displayed by default when using HDR Light Studio standalone

This Render View starts/stops and displays the interactive rendering from your host/renderer directly

in HDR Light Studio's interface.

LightPaint Tool

Find out more about the LightPaint Tool here

Select Light Tool

Click on the render image to select a light using the current LightPaint mode selected in this view.
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Play/Pause (Start/Stop Rendering)

Use the play/pause button to start and stop the interactive rendering in your main 3D software. That

render is displayed in this view.

This interactive render may, or may not, be seen running in your 3D software.

When first starting HDR Light Studio (when connected to supported 3D software), the logo for the

renderer and a big play button will appear on the view.

This play button is used to start the rendering, just like the small play button at the bottom.

Resync

Stops and restarts the rendering. If the lighting has got out of sync, this is a good way to reset the

rendering.

Image Requested/Received Lights

The image requested and image received lights provide show the status of the polling for images

from the renderer.

Resize IPR to fit view size button

Press this button to update the render width and height back in your main 3D software to match the

current size of the Render View in HDR Light Studio.
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Please refer to the Render View (HDR Light Studio) docs for the following features in this panel:

Display Settings, LightPaint

Advantages and Disadvantages of showing your IPR in this panel

Advantages

· Use HDR Light Studio on a single display showing everything you need in a single

interface.

· Accurate: Light your shot looking at the final result from your 3D software/renderer. No

guessing - what you see is what you get!

· Click to place lights directly into the final shot.

· No need to export the host 3D scene into HDR Light Studio using this view. Faster

workflow.

· Also shows any lighting not created using HDR Light Studio

Disadvantages

· Can be less responsive/interactive than HDR Light Studio’s own renderer: Due to the time

for communication and data transfer between HDR Light Studio > Host > Renderer > Host

> HDR Light Studio, this view can be slow to update due to this round trip. Render

Settings in your host/renderer may also mean this view refines slowly, meaning a longer

wait to make lighting decisions. Interactive performance depends on scene complexity,

render settings, shaders and hardware.

· LightPaint clicks only to position lights, no dragging lights in this view to discover lighting

sweet spots.

· LightPaint positioning can be less reliable than HDR Light Studio’s render view.
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The LightPaint System

In HDR Light Studio 8 Drop 1 - the LightPaint system has had a major overhaul.

Originally 'LightPaint' controlled only the the light positions when clicking and dragging on the 3D

model.

This page explains the new expanded LightPaint system and keyboard shortcuts.

What is The LightPaint System?

LightPaint is a system that let's you control the properties for a selected light with mouse

interactions in the Render Views and Canvas. The goal of LightPaint is to make it as easy and fast as

possible to adjust and develop the lighting for a shot, without needing to leave the views.

How LightPaint works...
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LightPaint is the default tool in the Render Views and Canvas - and its button icon is a 'brush'.

At the bottom of the view is a drop-down list where you select the LightPaint mode. This mode

controls how the mouse input will change the selected light's properties. The contents of the drop-

down list changes depending on the available settings for the selected light. The default LightPaint

mode is Move. This ensures that by default the views behave like older versions of HDR Light Studio.

LightPaint Tool Modes

Move (on the Render Views)

In order to move the Light, LightPaint uses the active LightPaint method.

New methods added for HDR Light Studio 8 Drop 2: Shade and Shadow
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Moving lights with LightPaint is a key feature in HDR Light Studio. This allows you to precisely

position your lighting effect by clicking (and dragging) on the 3D model in the Render Views.

Let's take a look at the range of LightPaint methods.

LightPaint Move Mode: Illumination
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Illumination positions the light normal to the surface. This faces the light directly to the surface and

illuminates the location where clicked.

Here are some examples showing the cursor in the position where clicked. This position will not align

with the reflection of the light!!!

You can see the light is facing the direction where clicked.

LightPaint Move Mode: Shade
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Shade positions the light normal to the surface, but facing in the opposite direction, and puts the

surface in shade from the light.

Here are some examples showing the cursor in the position where clicked.

You can see the light being positioned on the opposite wide of the object, placing the clicked location

in the shade.

LightPaint Move Mode: Reflection
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Reflection positions the light reflected through the normal to the surface. The light is positioned to

be seen in the reflection of the surface. You can place highlights this way.

Here are some examples showing the cursor in the position where clicked.

You can see the light reflected in the exact locations where clicked.

LightPaint Move Mode: Rim
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Rim positions the inline with the location clicked from the camera point of view. It totally ignores the

scene. If the light is on the HDRI map, you will be positioning it in the background behind the scene.

If the light is an area light, the distance setting will determine how far the light is from the camera.

Here are some examples showing the cursor in the position where clicked (on the HDRI map).

You can see the light in the background matching the cursor location.

LightPaint Move Mode: Shadow
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Shadow pivots the light through it's existing LightPaint position, and directs the light towards the

clicked location. This allows the light to be moved to position its shadow.

We recommend initially placing the light using reflection mode, to set the LightPaint location, and

then adjust the shadow.

Here are some examples showing the cursor in the position where clicked.

See how the shadow moves to the location of the cursor.

Move (on Canvas)

Light moves directly to the position where clicked on the Canvas.
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Move Rel (Relative)

Dragging in the Render Views and Canvas will adjust the position of the light relative to the amount

of mouse movement and direction of dragging. This is ideal for adjusting the light position based on

its current position.

Smart Dolly

This is only shown for area lights. Dragging the cursor to the left and right, decreases and increases

the smart dolly distance.

Rotate

Dragging the cursor to the left and right, decreases and increases the light rotation value.

Please Note: Rotate is not applicable to planar lights, like a background light. Planar lights do not

have a rotate property. To rotate a HDRI background, use Move Relative, and lock to the horizontal

axis holding keyboard qualifier CTRL. This will change the Latitude of the light and provide the effect

of rotating the HDRI map.

Scale

Dragging the mouse to the left and right, proportionally decreases and increases the size of the light.

Free Scale

Dragging the cursor left and right changes the width.

Dragging the cursor up and down changes the height.

You can move the cursor in any direction to change the width and height at the same time.

Brightness

Dragging the cursor to the left and right, decreases and increases the light brightness.

Spread

This is only shown for area lights. Dragging the cursor to the left and right, decreases and increases

the area light spread.

Handle New in HDR Light Studio 8 Drop 2

Drag on the Canvas and Render Views to move the position of the handle on the selected light. This

will result in the the light sliding in relation to the fixed position of the handle. This can be used for

making small adjustments to the position of the light without actually moving the LightPaint position.

This can also be used to place the handle on the edge of the Light, allowing the light to be positioned

using its edge.
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Motion Blur

Shown only for lights with Motion Blur filter.

Render Views: Click to position the Motion Blur direction using the LightPaint method selected in the

drop down on the right.

Canvas: Click to position the Motion Blur direction on the Canvas.

Scrim Light Position

Shown only for lights with Scrim Light as 'main' content.

Render Views: Click to position the Scrim Light effect using the LightPaint method selected in the

drop down to the right.

Canvas: Click to position the Scrim Light effect on the Canvas.

Reflection Axis New in HDR Light Studio 8 Drop 2

Shown only for lights with Reflection filter.

Render Views: Click to position the Reflection Axis using the LightPaint method selected in the drop

down on the right.

Canvas: Click to position the Reflection Axis on the Canvas.

Designed for Keyboard Shortcuts

A faster way to change the LightPaint tool mode, in any UI panel, is to use a keyboard shortcut. These

shortcuts are common across all UI panels in HDR Light Studio. These keyboard shortcuts are also used

on the Scrim Light content.
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To change the mode, move the cursor to the view where you want to change the mode, then press

the keyboard shortcut key/s and the mode will change in that view only. There is no need to hold

down the key/s, the mode changes and stays in the new mode.

Each tool mode can have additional keyboard qualifier keys that you hold down whilst dragging in

the view.

These are:

Horizontal Lock: Shift

Vertical Lock: Ctrl

Fine Adjust (reduces sensitivity of adjustment): Alt

A LightPaint mode per UI panel
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The LightPaint mode settings are not global. Each panel has its own LightPaint mode. This can be

very useful, for example, you could use the Canvas with Scale mode, and a Render View with Move

mode.... between the 2 views you can now move and scale lights - just by using the mouse in those

views.

So, when using keyboard shortcuts for LightPaint modes, ensure the cursor is within the panel

whose mode you want to change.

Cursors and Overlay Text
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Each LightPaint mode has a different cursor, making it easy to know which mode you are in. In

addition there is a text overlay giving you useful information about the mode, such as optional

keyboard qualifiers for that mode.

When you are dragging in the view to adjust a setting, the overlay text will provide useful information

about the adjustment being made. For example, when scaling the light, you see the % change you

have made compared to the original value. So it's easy to double or half the size of a light, even

without seeing the renderer catch up and update the view. This is ideal for render views that are not

updating fast. You can still make the adjustment knowing the amount of change you made.
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Render View Settings Panel

The Render Settings panel allows you to set a wide range of properties relating to the behavior and

appearance of the Render Views.

Use the drop down at the top of the panel to choose which Render View settings you want to adjust.

HDR Light Studio is the native Render View included with HDR Light Studio for fast light positioning

and lighting preview.

If you are using HDR Light Studio connected to a supported Host/Renderer, this will also be listed in

the drop down, in this example 3DSMax/VRay

Render View Settings for HDR Light Studio's Render View
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Scene

3D Scene File

Displays the loaded 3D Scene file path. Use the Browse button to load a new 3D Scene.

Up Direction

Sets whether the scenes Y or Z axis is the "up" axis in the Render View. When the loaded scene file

includes an up direction, this setting is set and locked.

However, if you find your model is rotating around the "wrong" axis or your floor shadow is missing,

toggle this setting as it is most likely to be the cause.
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Scene FPS (Frames Per Second)

When loading an alembic file, the user can choose which frame from the animation to display, via the

Frame Number setting in the Render View. Alembic files store time in seconds, not frames, so this

setting is provided for the user to tell HDR Light Studio the FPS used in their 3D software. This

ensures the frame numbering matches.

Renderer

Max Samples

This is a quality setting for the Render View. Sets the number of rays that are computed to determine

the color of a pixel. High values take longer to calculate but give more accurate, less noisy results. To

reduce the CPU useage of HDR LIght Studio, you can keep this setting low, so it does not compete for

as long a duration when other CPU renderers are also running. This is less of an issue when the other

renderer is GPU, because HDR Light Studio's own Render View is CPU only.

Ray Depth

Sets the ray depth for ray traced reflections. A larger ray depth means more object inter-reflections

are calculated, this will slow down the render process. The default setting of 2 is suitable for nearly all

situations.

Fast Area Lights

Enable this check box, and a single average color/brightness is used for the illumination contribution

of the area light. This means a less noisy render result is achieved far faster.

Display
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Image Width

The horizontal resolution of the rendered image.

Image Height

The vertical resolution of the rendered image.

Render View

Scale to Fit will scale the fixed resolution image to fit the size of the panel.

Actual Size will display the image unscaled introducing scroll bars as required.

Ident Logo

Turns on and off the display of the HDR Light Studio logo in the corner of the view

Appearance

Diffuse Color

Click the swatch to open the color picker to choose a new diffuse color for the shader.

Reflectivity

Controls the reflectivity of the shader used in the Render View. A setting of 0 has no reflection, a

setting of 100 is 100% reflective. Please note the reflectivity is also affected by the fresnel setting.

Show Floor

Enables a shadow catcher plane that is automatically calculated to be positioned at a height touching

the bottom most point of the loaded model on frame 0. This shadow catcher plane does not catch
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shadows from area lights, only from the HDRI map.

Please note, Area Lights are not currently visible through this floor.

Floor Shadow

Controls the intensity of the floor shadow, when the Floor Plane is active.

Background

You can choose what appears in the background of the camera view in the Render View.

HDRI Env

This is the default setting and shows the HDRI map lighting the model in the background.

Solid Color

Allows the user to set a color for the background.

Image File

Allows the user to load an image file that is placed in the background with the width fitting into the

camera view.

The user needs to also set the Color Profile for the loaded image. In the image below a photograph

has been loaded as a background image. But the Color Profile has been left at the default of Linear.

Therefore when the image is displayed in the Render View, which has a display LUT of sRGB, the

image has in effect had an sRGB profile applied twice.
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If we correctly set the Color Profile for the loaded images as sRGB (which most LDR images will be).

Then this would have converted the image into linear color space and would have then correctly

displayed in the Render View with the sRGB LUT applied. See below.

Please note: Whatever zoom level is applied to the camera view, the background image will always fit to the view.

Therefore the background does not behave as expected with panning and zooming your shots.

Any changes to the parameters in this section, Appearance (Re-Calc), will cause the gathered samples

to be discarded and the rendering will restart.

IOR

Fresnel is set by a single IOR (Index of Refraction) parameter.

Render View Settings for Host/Renderer Render View
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Scene FPS, Image Width, Image Height are read only displayed settings.

Render View

Scale to Fit will scale the fixed resolution image to fit the size of the panel.

Actual Size will display the image unscaled introducing scroll bars as required.

Ident Logo

Turns on and off the display of the Renderer's logo in the corner of the view

Refresh Rate

This setting determines how frequently HDR Light Studio requests a new image from the

host/renderer. A setting of 1000 will update the image every second, 500 every half second and so

on.
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Display Controls

LUT Mode (New in HDR Light Studio 8.2)

HDR Light Studio uses OpenColorIO (OCIO) color management.

When the Render View displays an interactive render image coming from your 3D software,

depending on the 3D software and renderer, a display LUT may or may not have already been baked

into the image data. If a LUT has already been applied, you would need to manually change the color

setting in the Render View to None every time you used HDR Light Studio. This prevented the double

application of a display LUT that would display a brighter, washed out, and inaccurate render.

Manually changing this every time was not an ideal workflow.

We have updated plug-ins to tell HDR Light Studio if a display LUT is already applied to the render

image. With thenew default LUT Auto mode, HDR Light Studio will automatically disable a LUT in the

Render View for: Octane Standalone, Rhino, Omniverse and Unreal Engine. This LUT Auto setting

can be overridden, and you can choose LUT On or LUT Off. With LUT Off, whatever the LUT

dropdown on the right of it is set to, this will be ignored.

Please note: This setting is somewhat redundant for the RenderView(HDR Light Studio) and can be

left at the default setting of LUT Auto.

LUT

Use the drop down to select the LUT that should be applied (if the LUT mode on the left of it allows

this).

The OCIO LUTs being used are set in the Preferences panel.
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Display Channels

Allows the user to choose which image channels are displayed in the Render View. The default is HSV.

Display Exposure

The exposure controls let you adjust the brightness of the displayed Render View image. This will

help you match the brightness with that seen in your 3D render software, so that you can roughly

calibrate the Render View to your Renderer.

Exposure

Control

Drag the icon button right and left to increase or decrease the exposure or type values into the text

field. Double click on the icon to reset the value to 1.

Example of adjusting the Exposure of the Render View
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Frame Number

Alembic models loaded into HDR Light Studio support animation. If you load an alembic model you

can set the frame displayed in the Render View using the Frame Number numeric entry.

Please also refer to the Scene FPS setting in the Render View Settings Panel.

Example Alembic scene - viewing different Frame Number
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Proxy Image Resolution

The horizontal resolution of the environment map used to light the model in the Render View, and

shared with Connections, is 646 pixels by default. But this Proxy Map Size can be changed in the

Preferences. Set it to 3000 for a (slower) high quality render with fewer jagged edges on lights. In the

images below, note the resolution difference in the background.

Proxy Map Size 646 - Lower quality, faster
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Proxy Map Size 3000 - Higher quality, slower
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Render Views Usage Guide

The chart below shows an ideal strategy to use when both Render Views are available.

You can see the advantages of the Render View [HDR Light Studio] here

You can see the advantages of the Render View [Host|Renderer] here
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Notes:
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The interactive performance and the choice of which render views to use is dependent on many

factors, including the 3D scene complexity, material/shader/texture complexity, the performance of

your renderer and the performance of your hardware. Using a combination of HDR Light Studio’s

Render Views means you can light any scene interactively.

Host Render interactivity is Fast

Using Render View [Host|Renderer] on its own

If the host scene is rendering nice a fast using interactive rendering, using this view on its own makes

perfect sense. Click on this view to move a light and updates should be nice and fast.

Host Render interactivity is Medium

Using Render View [HDR Light Studio] and Render View [Host|Renderer] together

If the host scene is slow to respond/update when using interactive rendering, use HDR Light Studio's

own renderer to position the lights with instant feedback, and use the host render view to simply

keep an eye on the effect of the lighting on your final shaders. The host rendering will catch up with

the lighting updates and provide a useful and accurate view of the final lighting as you work in HDR

Light Studio, even if it is a little behind.

Host Render interactivity is Slow

Using Render View [HDR Light Studio] with occasional test renders using Render View [Host|

Renderer]

If the host scene is rendering very slow and is not interactive, it makes sense to take advantage of

HDR Light Studios own renderer to get the lighting design created quickly with interactive feedback -

without the overhead of also running the host/renderer at the same time. In this case use the Render

View [Host|Renderer] to make occasional test renders to check on the lighting result and then pause

the view. This will prevent both renderers needing to run at the same time and compete for the

computers resources whilst dealing with a complex scene.
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Matching your 3D Software

When using the Render View [HDR Light Studio] in conjunction with your 3D software and Renderer,

sometimes the renders look very different due to their brightness or the materials used in the scene.

There are simple adjustments you can make to the settings of the Render View [HDR Light Studio] to

provide a closer and more useful match.

Matching View Brightness

The simplest change to make is to the brightness of the view. See below, the Render View [HDR Light

Studio] is very bright compared to the Render from the 3D software.

You should adjust the brightness of the Render View [HDR Light Studio] to provide a better match, so

the views are responding the the lighting in a similar way. In the example below, we changed the

Exposure in the view from 1 to 0.1. The view brightness now matches, and you can make better

lighting decisions for the shot using the Render View [HDR Light Studio].
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Adjusting Appearance Properties

You can change the appearance settings for the Render View [HDR Light Studio] if the model has a

very specific color or level of reflectivity you want to match better. Of course there is only one shader

on the whole model in Render View [HDR Light Studio], but adjusting this appearance can be useful.

In the image below, the appearance settings are their defaults in Render View [HDR Light Studio].

The Diffuse Color is: Mid Grey

The Reflectivity is: 50

The Fresnel is set to the default values for: Custom
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In the image below we changed those settings to:

Diffuse Color: Dark red matching the bulk of the 3D model in the other view

Reflectivity: 100

Fresnel: IOR, value 2.5

Using different settings for appearance, you can mimic other basic materials in HDR Light Studio.

Like a matt material, with a Reflectivity setting of 0.

Or Chrome. With Diffuse Color set to Black, Reflectivity: 100, and Fresnel: IOR, value 10.



299

299HDR Light Studio - User Guide



300

300HDR Light Studio - User Guide

Light Preview Panel

The Light Preview panel shows you an image of the currently selected light without any of the

transformations applied - a front on view. This allows you to see what the light appearance looks like.

Light Handle

The orange dot shown on the image is the light's handle. The light is placed in HDR Light Studio using

this handle position. You can move the handle by clicking/dragging within the preview image. See

Light Handle for more details.
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Light Properties Panel

Layout Change in HDR Light Studio 8 Drop 1

Users were spending too much time scrolling up and down this properties panel during a lighting

session and it took up a lot of UI space. We have now split the properties into 2 tabbed sections,

named Settings and Appearance. However the brightness setting shows at the top of the panel - to

be easily accessed at all times. This interface change may take a little time to adjust to, but it should

save you time and improve the experience of using HDR Light Studio when you do.

Each light is defined by a collection of properties - color, position, size, shape, opacity, etc. These

properties are displayed in the Light Properties panel.

Top Tip: Double clicking on the text label for a slider and ramp will reset the setting to its default

value.
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Just select the light to edit the properties of that light. If the parameters are not visible, the light has

been locked in the Light List and you will need to unlock the light before being able to edit it's

properties. See Locking Lights.

Settings
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Name

The label applied to the light and shown in the Light List. If you have several round lights, giving

them unique names will help you find them. You can type in this field and press return to change the

name of the light.

You can also double click on a light in the Light List to rename it.

Brightness

The brightness value of the light. Higher values can be input into the numeric entry box than can be

shown on the slider. You can also click and drag beyond the end of the slider for higher values, and a

small triangle will appear to indicate this.

In order to adjust the brightness of the light in a more photographic way, buttons allow increasing

and decreasing the light brightness relative to its current value.

The large plus and minus buttons increase and decrease by 1 stop (doubling and halving the

brightness), the small plus and minus buttons increase and decrease y 1/3 of a stop (1.33 or 0.66)

Opacity

The transparency of the light when blended with the Canvas.
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Blend Modes (Including Invert and Preserve Alpha)

Determines how the light content is composited with underlying Canvas content.

For more information see: Blend Modes

Mappings

You can choose between 3 mapping types. The mapping types determine how the Content is

mapped with respect to the HDRI map. There are 3 types of mapping:

3D - Light is positioned normal to the lighting sphere

Planar - content is placed flat onto the HDRI map with no distortion

Spherical - Content is wrapped around the lighting sphere.

For more information see: Mapping.

Area Light

This option is only available when the 3D mapping option is selected. It promotes the light from

being on the HDRI map, to being a full 3D Area Light.

This setting can be toggled using Keyboard shortcut: CTRL + Space Bar (On MacOS, using Fn + CMD + Space

Bar) (New in Tungsten Drop 4)

For more information see: Area Lights
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Blend Modes

The blend modes determine how the current light and the underlying content are mixed together.

Since we're dealing with high dynamic range images the pixels values are not clipped to a range 0 to

1.

· Add

· Multiply

· Over

· Low Pass

· Color

· Saturation

· Hue

· Amplify

· Preserve Alpha

Updates made to Blend Modes in Tungsten

Blend Channel 

By default blend mode Add affects the Color of underlying content. We have added an option via this

drop down for this blend mode to affect only Value.

This makes it useful for removing brightness from underlying content, whilst not affecting its color.

This is used in this example of using the Composite lights.

Currently all other blend modes have fixed channels and the drop down can not be changed.

New Mask Setting on Multiply Blend Mode

See here

Low Pass updated to take into account Alpha

See here
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Options

When using blend modes, we have made a few changes making them easier to use. Improved default

settings and removed redundant options from interface.

When switching between blend modes, we always reset the setting for that mode to its default. So

you will need to manually override those if there is a specific effect you want.

Old projects will honor their original settings.
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Add

This blend mode simply adds the pixel values of the light over underlying lights (composited on the

canvas).

See how the 3 colors mix to create white as the lights are added together.

See how 3 soft round lights are added to this HDRI map using add blend mode.

Add blend mode is ideal for adding lights and is the default blend mode for Round, Rect, Hex,

Gradient Lights, Gradient Background and Picture Background.

Dark light has blend mode add with invert.
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Use Add with the Invert option on to Subtract. This blend modes simply subtracts the pixel values of

the light over underlying lights (composited on the canvas).
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See how 3 soft round lights are subtracted to this HDRI map using add blend mode with invert

option on. They darken the image.
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Multiply

This blend mode simply multiplies together the pixel values of the light over the underlying content.

The source image on the right is added to the canvas with blend mode multiply. White areas show

the underlying image correctly, whilst black areas darken the image to black.

The color of the light is also multiplied with the underlying canvas image.

New in Tungsten

Mask setting added to Multiply blend mode



311

311HDR Light Studio - User Guide

A new setting has been added to the Multiply blend mode called Mask. With this setting off (the

behavior of previous versions of HDR Light Studio), a Multiply blend will only effect the area covered

by the light. So for example on the following screen grab, a round light has been placed on the HDRI

map with multiply blend mode and is darkening the HDRI map as the light gets darker towards its

edge. But this light has no effect on the underlying HDRI map outside of this.

With the Mask option turned on, as seen in the following image, any area outside of the light is now

considered to be black also. Therefore the single light placed with 3D mapping over just a part of this

HDRI map is now acting as a movable mask over the whole canvas using the Multiply blend mode.

This is very useful with used in conjunction with the new Composites.
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Over

This blend mode simply replaces the pixel values of the light over the underlying lights.

It uses the alpha on the light for transparent areas.

It's a great way to add non-transparent (solid) content onto the HDRI map.

Over is the default blend mode for image based Preset lights, Picture Lights and Sky Background.

The people and lights have been added to this HDRI map using Over blend mode.
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Low Pass

This blend mode uses the brightness value of the light to limit the brightness of the underlying

canvas values.

This is the blend mode used for the SunShade light.

See how the square light, set to blend mode Low Pass, is limiting the brightness of the underlying

HDRI map. Blocking the brightness of the sky and sun, but leaving the darker values untouched.

Use the invert option to use the brightness value of the light to limit the darkest value of the

underlying canvas values.

So in this example the square light has a minimum brightness matching the lights brightness. The

darkest areas of the image are matching the brightness of the square light.
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This chart is useful for understanding how the low pass blend mode works. See how the pixels are

clamped on the middle chart, and the lowest values raised to meet the lights value on the right hand

chart.

New in Tungsten

The alpha of the light is now taken into account when using Low Pass blend mode.

The image below shows using a soft round light with Low Pass blend mode. It ignores the alpha and

uses only the value of the light within the blend.

This results in hard edges to the Low Pass effect and you can see the square of the light.
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The image below was created using Tungsten, and the alpha of the round light is now used in the

blend calculation.

This has resulted in alpha being used to control where the Low Pass blend is affecting.
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Color

The Color blend mode mixes the Color (Hue and Saturation) of the light with the color of the

underlying canvas.

The amount of Hue influence depends on the brightness of the light.

Using the invert option colorizes with the inverse color.
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Saturation

The saturation blend mode uses the brightness of the light to increase the saturation of the

underlying canvas content.

See how the soft round light here is used to increase saturation.

Use the invert option to use the brightness of the light to decrease the saturation of the underlying

canvas content.

See how the soft round light here is used to decrease saturation.
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Hue

The hue blend mode mixes the Hue of the light with the Hue of the underlying canvas. (Leaving

Saturation and Value).

The amount of Hue influence depends on the brightness of the light.

See how the square light has changed the hue of the HDRI map.
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Amplify

The amplify blend mode multiplies the values of the light + 1, with the underlying content. i.e. black

areas on the light have no affect on the canvas (black (0) + 1 = x1), brighter areas increase the

brightness. So lights can be used to boost the brightness on the canvas. The color of the light is also

multiplied in.

See below 2 soft round lights with amplify blend mode. The light on the right is white and simply

boost brightness. The light on the left is orange, like shining an orange torch into the HDRI map.
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Use the Invert option (with Preseve Alpha on too) to remove brightness from the canvas, this also has

an inverse color effect, removing orange with the left light, making the image more blue.

Top Tip: Amplify is a great blend mode for boosting the brightness of the sun on a HDRI map using a

small round light. It is also great for adding a hot spot to an existing soft box.
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Preserve Alpha

Using some blend modes, the alpha of the light content is also used in the calculation. This can result

in making areas of the canvas image transparent, especially when using the invert option. Use the

Preserve alpha option to leave the canvas transparency unaltered.

Using the Dark Light to remove light from the centre of the softbox. Without Preserve Alpha the light punches

through to the transparency layer.
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Mapping

This parameter determines how the light is applied to your lighting design.

There are 3 available options:

· 3D Mapping

· Planar Mapping

· Spherical Mapping
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3D Mapping

3D Mapping is for places light sources and effects. Wherever the light is placed on the HDR Canvas,

with 3D mapping, it is correctly distorted to maintain the correct shape and appearance when the

HDR is mapped onto a spherical environment.

3D mapped lights can be enabled as Area Lights in your 3D scene, and will not appear on the HDRI

map lighting the shot. See Area Lights for more details.

New in HDR Light Studio 8.2

Infinite Plane

The Infinite Plane setting has been added to use with Scrim Lights. Read more.

Transform (Core) Settings for a light with 3D mapping

Latitude

The latitude defines the vertical position on the canvas. Values range from -90 (north pole) to 90

(south pole). A value of zero will position the light at the equator.
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Longitude

This determines the horizontal position of the light on the canvas. Values range from 0 to 360

degrees around the virtual sphere.

Width

This is the horizontal dimension of the light. Increase this to make the light wider.

Height

This is the vertical dimension of the light. Increase this to make the light taller.

Rotation

This changes the orientation of the light around an axis at right angles to the canvas plane. It is

calibrated in degrees from 0 to 360.

Transform (Extended) Settings for a light with 3D mapping

Handle U

Sets the horizontal position of the light's Handle. See Light Handle for more information

Handle V

Sets the vertical position of the light's Handle. See Light Handle for more information

Rotations: Enable Advanced Rotations

Activate to allow lights to be oriented in 3 axis with the additional advanced settings.

Rotation Mode and Adjustments

Select the Rotation Mode to determine the orientation behavior of the light. Make adjustments to the

orientation using the controls.

See Advanced Rotations for a full explanation.
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Infinite Plane

The Infinite Plane setting has been added to use with Scrim Lights on the HDRI map.

If this setting is used with other content types you will get strange results in the extended areas of

the light on the HDRI map.

The Infinite Plane setting is available for 3D Mapping only. It extends the area upon which the light

content can be projected, so that the spill of light from a scrim light can keep going until it falls off

into darkness. If the area light setting is turned on, then this setting is ignored and has no effect at

all. It only applies to 3D mapped lights on the HDRI map.

In the image below, there is a Scrim Light each side of the kettle. You can see that the light effect

from the scrim light is limited to the external edges of the lights, based on their size setting - they

have a width and height. So the scrim lighting effect is cropped to the light. You may want this effect,

as the scrims being lit may be quite small.

The image below is the exact same scene, but with the Infinite Plane setting turned on for both

lights. Now you can see the scrim lighting effect is not limited by the edges of the light. This is as if

you are lighting huge planes using the scrim lights behind them. The orientation and scale of the

light effect is controlled by the orientation and scale of the light. There are no hard edges from the

scrim lighting now. The lights can be moved and scaled as usual... but they are not constrained by

the rectangular light edges.
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Another benefit of using the infinite plane setting is that you can light a shot using just scrim lights

and adjust the look and feel of a light only using the scrim light settings. Below is an example. All of

the lights in the shot are scrim lights with infinite plane turned on. You can adjust the scrim light

settings to dramatically change the lighting effect in a physical way. Moving the lights closer or

further away from the scrim. This is much more intuitive than using a bulb content type with a

gradient mimicking this effect.
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Planar Mapping

Planar mapping does not distort the light, it is simply added flat on the Canvas.

The width and height settings in this mode are a percentage of the canvas size. In the example

below, the flat blue light has width =50 and height =50. The result is not square because the size is a

percentage of the canvas which itself is a 2:1 rectangle. Superimposed on the flat blue light is a

square picture of a dog. To get the correct ratio for this square picture, the width is set to half of the

height.

Planar mapping is ideal for placing an HDRI map as a background or creating a full canvas gradient.

It's also good for adding Soft Box lights for pack shots where you always want vertical lights wherever

you position them.

Transform Settings for Planar mapping

Latitude

The latitude defines the vertical position on the canvas. Values range from -90 (north pole) to 90

(south pole). A value of zero will position the light at the equator.
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Longitude

This determines the horizontal position of the light on the canvas. Values range from 0 to 360

degrees around the virtual sphere.

Width

This is the horizontal dimension of the light expressed as a % of the canvas width.

Height

This is the vertical dimension of the light expressed as a % of the canvas height.

Handle U

Sets the horizontal position of the light's Handle.

Handle V

Sets the vertical position of the light's Handle.

See Light Handle for more information
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Spherical Mapping

With Spherical Mapping the light appearance is wrapped around the lighting sphere. In this mode

the width of the light should be set to 100 so that the lighting is wrapped fully around the sphere.

Values less than 100 produce largely undesirable effects. Spherical mapping is best used for full

canvas gradients or full canvas environments. In the example below, varying the longitude and

latitude moves the start point for the content being wrapped around the sphere.

Tilting the Background Image

Another good use of spherical mapping is for tilting HDRI maps. Remember that wherever you click

on the canvas to position this mapping, the north pole of the spherical image is moved to that

location, as shown by the cross in the images below.

Transform Settings for Spherical mapping
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In this mapping mode lights are placed by their top edge. Therefore the Latitude and Longitude

settings relate to this location.

Latitude

The latitude defines the vertical position on the canvas. Values range from -90 (north pole) to 90

(south pole). A value of zero will position the light at the equator.

Longitude

This determines the horizontal position of the light on the canvas. Values range from 0 to 360

degrees around the virtual sphere.

Width

This is the horizontal dimension of the light expressed as a % of the sphere. For this mapping, it is

advised to keep this at 100%

Height

This is the vertical dimension of the light expressed as a % of the sphere. For a full canvas gradient or

image, this should also be 100%.

Rotation

Changing the rotation in this mapping will move the content left to right around the north pole. Here

is an example:
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Area Lights

Area lights are intuitive to use for existing HDR Light Studio users, as minimal new controls have

been added to control them.

When a light uses 3D mapping in HDR Light Studio, the Area Light check box is shown. When the

check box is enabled, the light is removed from the HDRI map being shared with the Render View

and Connection, and an Area Light is created in 3D space in HDR Light Studio with the light content

mapped to it's surface. The properties of the light are updated to include area light controls, and

exclude non applicable settings such as: Mapping and Blend Modes. 

New in Tungsten Drop 4

This Area Light setting can be toggled on/off with the keyboard shortcut:

CTRL + Space Bar

(Fn + CMD + Space Bar for MacOS)
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Cam Visibility

Sets whether the area light can be seen by the camera both in HDR Light Studio and your

host/renderer. (primary visibility is another name for this)

Smart Dolly

Moves the light closer or further away, and multiplies the size of the light depending on the context.
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This is the primary control for setting the distance of the area light.

Smart Dolly in action

Dolly Multiplier

A secondary distance control that will move the light closer or further away without altering the size
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of the light. This is more suitable to be used for fine adjustments of the light distance.

Dolly Multiplier in action
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Spread (New in Xenon Drop 3)

Controls the spread/directionality of the area light illumination. At launch this is supported by

Cinema 4D with Arnold, V-Ray, Redshift and Octane Render. All other connections will ignore this

setting until support has been added.

Options: Maintain Reflection Size

Turn on to ensure the light stays the same size in reflections in flat surfaces, as you move the light

closer and further away with Smart Dolly.

With this setting off, the light will scale to ensure illumination effect of the area light is the same

whatever the distance, effectively filling the same solid angle.
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Maintain Reflection Size in action

LightPaint Pos

This displays the XYZ coordinates of the clicked LightPaint position for the light. When relevant, these

coordinates can be adjusted, again for fine adjustments of the lighting effect. i.e. to nudge the height

location of the light upwards without requiring another LightPaint click.
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Advanced Rotations

HDR Light Studio 5.4 introduces Advanced Rotations. This enables lights to be rotated in all 3 axis.

These rotations are available for 3D mapped lights when on the HDRI map and when enabled as

Area Lights.

The Advanced Rotations controls are found in the Transform (Extended) section of Light Properties.

Use the check box to enable the advanced settings.

About Rotation Modes + Adjustments

Rotation Modes are used to set the default orientation desired for the light. Think of the rotation

modes as setting the 'resting' orientation/behavior of the light. i.e. the orientation the light will face

prior to any adjustments being made to it.

These modes have been created as helpers to create orientation behaviors that are genuinely useful

for lighting.

Once the rotation mode has been chosen, the X,Y and Z adjustments can be made. These X,Y, and Z

adjustments are made to the current orientation of the light.

The adjustments are applied as an offset to the 'resting' orientation for the selected rotation mode.

So if the light is moved with LightPaint, and the light is now pointing at a new LightPaint location, the

same offset rotations will be applied to the light. i.e. the rotation adjustments are always relative to

the Rotation modes default orientation.

This may sound complex. It's easier to use than explain.

Rotation Modes



339

339HDR Light Studio - User Guide

Free

In Free Mode the default orientation behaves exactly the same as when Advanced Rotations is off. So

the light will be normal to the sphere when on the HDRI, and Area Lights will face the LightPaint

location.

Use the X,Y,Z adjustments to offset the orientation of the light from this default. Whenever the light

is moved it will maintain this offset.

Reset the orientation back to the default for this mode using the Reset button.

Here is Free mode in action:

V-Lock

In V-Lock mode the light on the HDRI will be vertical and aligned normal to the sphere. Area Lights

will be vertical and aligned to the LightPaint location.

Use the X,Y,Z adjustments to offset the orientation of the light from this default. Whenever the light
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is moved it will maintain this offset.

Reset the orientation back to the default for this mode using the Reset button.

Here is V-Lock mode in action:

H-Lock

In H-Lock mode the light on the HDRI will be horizontal and aligned normal to the sphere. Area Lights

will be horizontal  and aligned to the LightPaint location.

Use the X,Y,Z adjustments to offset the orientation of the light from this default. Whenever the light

is moved it will maintain this offset.

Reset the orientation back to the default for this mode using the Reset button.
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Here is H-Lock mode in action:

Fixed

In Fixed mode, the light is orientated in world space. Disregarding the LightPaint location altogether.

Wherever the light is moved it faces the same direction in this mode.

Use the X,Y,Z adjustments to offset the orientation of the light from this default. Whenever the light

is moved it will maintain this offset.

Reset the orientation back to the default for this mode using the Reset button.
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Here is Fixed mode in action:

Adjustments

The adjustments allow the light to be rotated in the X,Y and Z axis relative to its current orientation.

Click, hold and drag on the X,Y or Z buttons to make the adjustments.

Here are examples of the effect of the rotations.
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Here are the rotations in actions on the HDRI map:
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Here are the rotations in actions with an Area Light:

Keyboard qualifiers can be used to change the sensitivity of the X,Y,Z buttons whilst dragging.

CTRL + Drag  = slower increment (i.e. smaller adjustment for distance dragged).

SHIFT + Drag = faster increment (i.e. larger adjustment for distance dragged).

Press the Reset button to return the light to its default orientation for the chosen Rotation Mode.

Press the Flip button to rotate the light 180 degrees around its Handle to face the opposite direction.
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Light Handle

3D and Planar mapped lights are positioned in HDR Light Studio by their Handle. By default the

Handle is in the center of the light.

HDR Light Studio 5.4 introduces the ability to reposition this Handle away from the center, using U

and V controls. These can be adjusted using the sliders.

Or the Handle can be moved by dragging its location within the Light Preview image.

The updating of the handle position is dynamic, as seen here on the HDRI map:
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The updating of the handle position is dynamic, as seen here with an Area Light:

Here are some examples of moving the Handle and how this affects the positioning of a 3D light.
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When using LightPaint to position a light - the light can now be positioned by its edge or by a specific

detail within the light because this handle can be moved.

New in HDR Light Studio 8.2

There are new LightPaint modes on the Canvas and Render Views that allow the adjustment of the

light handle position. As you drag in the view, the light will slide relative to the light handle.
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Content Types

These are the different types of lighting content that HDR Light Studio can create. The content is

what the light looks like.

· Bulb

· Image

· Scrim Light (New in 8 Drop 1)

· Polygon (New in 8 Drop 1)

· Gradient

· Flat

· Sky

· Box Gradient

· Composite
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Bulb Content

Bulb is procedural content type that creates a useful lighting effect.

Bulb Width

The dimensions of the bulb filament can be adjusted with the Bulb Width parameter. The values

range from 0 to 100%.

Bulb width: 0, 25, 75

Bulb Position

The vertical position of the bulb filament can be adjusted with the Bulb Position parameter. The
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values range from -50 to +50. This parameter is available on the Round, Rect, Hex and Dark light

types.

Bulb Position: -25, 0, 25

Half

Cuts the light across the middle removing the bottom half.

Outside

The outside parameter changes the falloff of the light. By default, the falloff stops at the inner

bounding box. For some lights, a more desirable softbox look is to extent the falloff into the corners.
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Color Mode

Choose between Flat and Ramp

Alpha Ramp

Controls the transparency of the light from it's center (left) to it's outside (right)
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Image Content

An image is loaded as the content for this type.

Image

To load a new picture or change an existing one, click on the Folder icon button and select an image

file, or drag the file from a file browser and drop it into this field.

The following is a list of supported image file formats: BMP, DDS, DPX, FITS, HDR, ICO, IFF, JPEG,

OpenEXR, PNG, RLA, SGI, TIFF.

If the image being loaded is 1,500 pixels wide or larger,  you will be prompted to convert the image

into a TX file. For more information about Converting to TX files, see Working with Images.

Resolution

Displays the pixel resolution of the loaded image

Aspect Ratio

To adjust the height of the light to match the loaded image's aspect ratio, press the Restore button.

Color Profile

Set this to tell HDR Light Studio what color profile has been embedded into the values in this image.

The selected profile is reverse applied to the image, to return the image to linear color space.

For example, most LDR images will have color a profile sRGB already applied. So select sRGB in this

drop down to make the image linear.

Most HDR images should already be in linear color space, so choosing linear will not apply any

adjustment, as the image is already in linear space.

For more information see: Color Management
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Options: Half

Removes the bottom half of the light.

Options: Flip

Horizontal Flip of the image

Options: Unpremultiply

If the loaded image RGB values have already been multiplied by the alpha, this provides a method to

un-premultiply them, so we get proper results when using the alpha channel in conjunction with this

image. Otherwise we could get white fringing on the image.

Options: Invert Alpha

Inverts the alpha channel in the loaded image.

Color Mode

Choose how to color the image. There are 3 options:

Source - the color of the image comes from the image. A saturation slider allows the

intensity of the colors to be adjusted.

Flat - choose a single color to colorize the whole image.

Ramp - use a linear or radial gradient to colorize the image.

Saturation

Adjusts the saturation of the loaded image

Saturation value examples: 0, 0.5, 1 (matches the source, no change), 1.5

Gamma

Adjusts the gamma of the luminance of the loaded image. (put simply its an image contrast control)

Adjusting the Gamma of the whole HDRI map. Example values: 0.5, 1 (no change), 2.2



354

354HDR Light Studio - User Guide

Adjusting the Gamma of a light source. Example values: 0.5, 1 (no change), 2

See how the gamma adjustment can be used to change the character of the light source. In the

example above, a tracing paper light, the fall-off of the light across the paper has been dramatically

changed by using the gamma control alone. Gamma is very useful for adjusting the character of

image based light sources.
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Scrim Light Content

New in HDR Light Studio - 8 Drop 1

What is an Scrim Light?

Settings Explained

Scrim Light Examples

Using Scrim Light on Value Blend

What is an Scrim Light?

Scrim Light mimics how a photographer would light in the studio (see image below) when shining a

light source at the back of a sheet of material. The Scrim Light in HDR Light Studio produces a very

realistic light that is easy to adjust in a physical way. Most of the settings for this light can be

controlled by dragging in 2D views of the light setup. This is far faster and more intuitive than using

lots of sliders. The Scrim Light is the most advanced and controllable procedural light available in

HDR Light Studio - and can produces a huge range of realistic lighting effects.
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This perfectly shows the concept behind the Scrim Light. See the spot light placed behind the sheet of

material (outlined red)

Settings Explained
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Top View

This view shows the top view of the light in relation to the scrim surface. This view provides a user

interface for controlling the light.

Dragging in this view will change the light's settings using the active Tool Mode. For example, using

'Move' tool mode, dragging in the view will change the height of the light.

Front View

This view shows the lighting effect created by the light source on the scrim. Only the region outlined

in white is used for the appearance of the light. This view also provides a user interface for
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controlling the light. Dragging in this view will change the light's settings using the active Tool Mode.

For example, using 'Move' tool mode, dragging in the view will move the position of the light source.

Tool Mode (for Top and Front views)

Use the drop-down to change how the mouse interactions change the light source settings.

When the cursor is over the Top or Front View - the tool mode can also be changed using keyboard

shortcuts shown in the chart below. (These keyboard shortcuts provide the same functionality in the

Render Views and Canvas, when the cursor is over those panels.) The chart also shows how the

mouse input controls the Scrim Light.
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Tool / Keyboard Shortcut Top View Front View

Move   W Drag to move the light up and

down

Drag to move the position of

the light

Rotate   E Drag to change the tilt of the

light

Drag to rotate the light

Scale   R Drag to proportionally scale

the light

Drag to proportionally scale

the light

Free Scale   Shift + R Drag up and down to change

the depth of the light

Drag left and right to change

the width of the light

Drag up and down to change

the depth of the light

Drag left and right to change

the width of the light

Spread   T Drag to change the spread of

the light

Drag to change the spread of

the light

Handle   Y - Drag to move the position of

the light handle

Settings - Reset Button

Pressing the Reset button will return all values on the Scrim Light to their default values.

Light Type

Left: Quad Light  Right: Spot Light
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There are 2 types of light available to place behind the scrim - Polygon Light and Spot Light

The Polygon light has an adjustable number of sides - from 3 to 25. The default is 4 sides, basically a

quad light. If the number of sides are increased to 25 - this effectively provides a circular light.

The Spot light projects a beam of light adding a falloff ramp in the settings to control the brightness

from the center to the edge of the beam.

Color

Sets the color of the light.

Sides (Polygon light only)

Changes the number of sides for the Polygon light source.

Height

Changes the distance the light source is from the scrim.

Tilt

Changes the angle of the light relative to the scrim.
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Width and Depth (Polygon Light only)

Changes the size of the Polygon light.

Spread

Changes the spread angle of light emitted for both Polygon and Spot lights.

Surface Fade

There is an invisible clipping plane above the scrim surface. This setting changes the height of this

clipping plane, and allows the softening of harsh light edges seen when the light is close or touching

the scrim.

Position X and Position Y

Controls the location of the light in the front view.

Rotation

Rotates the orientation of the light in the front view.
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Zoom

Allows the scaling of the light effect in the front view using a single zoom setting. Ideal if you have the

light look settings you want, but want to simply scale everything.

Handle X and Handle Y

You can use LightPaint in the Render Views and Canvas to control the position of the light relative to

the scrim. The handle (orange dot shown in front view) is the position used by LightPaint to move the

light. We need to be able to move the handle location because the position of the light does not

always coincide with the lighting effect being produced by the light on the scrim.

Falloff (Spot light only)

When the light type is Spot Light - the Falloff ramp is shown and can be used.
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This ramp controls the brightness of the light from it's center (left on the ramp) to the outer edge

(right on the ramp). Lots of lighting effects can be created this way.

Scrim Light Examples

See how realistic these lighting effects are, they have a real photographic feel. It's amazing that all

these effects come from this single light content type.

These Scrim Light designs are available in the Presets supplied with HDR Light Studio, so you can

explore their settings.

These Presets include the Polygon content on the Alpha Multiply - this applies a small radius to the

corners and adds softness to the edges.

Using Scrim Light on Value Blend

Scrim Light content is really useful to use on the Value Blend for a light.
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In this example, we take a soft box light preset, with all of its interesting visual details, and apply the

Scrim Light to the Value Blend choosing Multiply blend mode.

You can now control the character of the light by moving the position of the hot spot and adjusting

the Scrim Light settings.

You can even position this hot spot directly on the 3D model using LightPaint to move the Scrim Light Effect.

Please Note: On Value Blend, there is an additional brightness slider added to the Scrim Light. This

is needed to balance the brightness with the Main content on the light.
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Polygon Content

New in HDR Light Studio - 8 Drop 1

The Polygon content is very useful for controlling the shape of lights when used on Alpha Multiply to

control the Alpha of the light.

Sides

Controls how many sides the polygon shape has.

The minimum value is 3, and maximum value is 12.

Example Settings: 3,4,6, and 12 sides

Softness

Controls the amount of softness on the outer edge of the polygon. 

As the value increases, the polygon shape is scaled down to allow the addition of a soft transition

outwards from the polygon shape.

The minimum value is 0 creating a sharp crisp edge, and maximum value is 1.



367

367HDR Light Studio - User Guide

Example Settings: 0, 0.25, 0.5, and 0.75 softness

Radius

Controls the size of the radius at the corners of the sides of the polygon.

The minimum value is 0, and maximum value is 1.

With a Radius setting of 1 - the shape becomes a perfect circle.

Example Settings: 0, 0.25, 0.5, and 1 radius
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Gradient Content

Gradient is a procedural content type that creates a controllable gradient via 3 ramps for the color,

value (brightness) and alpha.

Type

Choose from either a linear or radial gradient.

Color Ramp

Use this ramp to control the color of the content.
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Value Ramp

Use this ramp to control the brightness of the content.

Alpha Ramp

Use this ramp to control the alpha value of the content.

Rotation, Origin X, Origin Y, Extent

Use these controls to control the start position, extent and rotation of the gradient.

Example Settings

Linear

Radial
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Radial - Origin 0.5, 0.5, Extent 2

Linear - Rotation 90

Value Ramp - controlling brightness
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Alpha Ramp - controlling transparency
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Flat Content

Select a single color for all of the light by clicking on the color swatch.
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Sky Content

Elevation

This sets the vertical position of the sun measured in degrees from 0 to 90 . A value of 0 puts the sun

on the horizon. A value of 90 puts the sun directly overhead.

Turbidity

Is a measure of the number of particles in the sky (dust, moisture, etc). It affects the color and

brightness of the sun and sky. A value of 0 will be a perfectly clear sky. A value of 10 will be hazy.

Albedo

Is the amount of light reflected from the planet's surface back into the atmosphere. A value of 0

represents a pure black ground. A value of 1 would be a white ground (desert). Please note that this

is a very subtle effect.

Disc Size

The size of the sun. Increase this value to make the sun bigger. The brightness of the sun is

automatically reduced to make the illumination from the sun the same when making this artistic

change to the size of the sun.

Disc Visibility

Switch this on to see the sun.
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Disc Falloff

This ramp can be used to soften the edges of the sun disc.

Energy Boost

Increases the brightness of the sun (but not sky).

Sky Visibility

Toggles the sky on and off.

Sky Alpha

A vertical alpha ramp controls the softness of the horizon, allowing artists to control the blend of the

sky over any underlying content.

Sunset (Elevation = 10)

Sunset (Elevation = 5)
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Sunset (Elevation = 2)

Clear Skies with Turbidity = 2

Hazy Skies with Turbidity = 5
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Box Gradient

New in Carbon (Drop 2)

Box Gradient is a really useful new content type in HDR Light Studio. It provides a blended vertical

and horizontal ramp.
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Here are some effects you can create using it:

Bulb content, using Box Gradient on Alpha Multiply to create a light grid

Uses Step interpolation on the ramps

Bulb content, using Box Gradient on Alpha Multiply to create soft light grid

Uses default Cosine interpolation on the ramps



379

379HDR Light Studio - User Guide

Bulb content, using Box Gradient on Alpha Multiply to create more light character
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Bulb content, using Box Gradient on Alpha Multiply to create vertical lines
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Bulb content, using Box Gradient on Alpha Multiply to create graduated soft vertical lines

Soften edges of Bulb content, using Box Gradient content on Alpha Multiply
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Soften edges of Image content, using Box Gradient content on Alpha Multiply (Left: Before,

Right: After)

Soften edges of Image content, using Box Gradient content on Alpha Multiply

In this example part of a HDRI map has been added to another
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Composite

New in Tungsten

Composite content enables an entire HDR Light Studio lighting design (excluding area lights) to be

used as the image texture for a light. This lighting design displays it's own Light List and Canvas when

being edited.

See here for Working with Composites

Edit

Press this button to edit the lighting design held within the Composite. Once this button is pressed,

the Light List will display just the lights within this Composite and the canvas will also display only

those lights. However your 3D scene will be lit by the entire lighting design.

Flip

The Flip option allows the resulting Composite image data be flipped horizontally. This is on by

default for the correct orientation.

Unpremultiply
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This setting prevents soft round lights getting darker and looking smaller when they are placed

within a Composite with no background light. This setting is on by default.

If the setting is off, the alpha is in effect applied twice. Being applied to the composite RGB image

data, and also used in the blend of the Composite light content with the rest of the lights.

One example where you may want to turn this setting off, is if you would like to cut a light within a

composite, using another light, and get the expected results and control.

Display Ratio

Sets the display ratio of the image content on the Canvas when editing the Composite. By default this

is set to 2:1 as for most situations you will be creating lat-long image data. It can be set to 1:1 and will

distort the canvas image to a 1:1 ratio, which is more useful when making content to go on a square

area light for example.

Filter

New in Xenon Drop 2

Filters enable special effects to be applied to the appearance of the Composite content. Use the drop

down to select a Filter, for example Gaussian Blur.

Find out more about Filters here.
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Composite Lights

New in Tungsten

'Composite' is a new Content Type for lights in HDR Light Studio. When using Composite content, the

image texture for the light is the result of a nested set of HDR Light Studio lights with their own Light

List and Canvas.

Watch the video demonstrations here if you want.

The diagram below illustrates this concept.

At its most basic, Composite lights are a way of grouping lights and managing lighting designs - this is

a much requested feature from our users. However, because the Composite results in a texture on

the parent light - the parent light can then be adjusted like any other light in HDR Light Studio. This

includes changing its brightness, mapping, blend mode, size, rotation and position. This allows much

more flexibility than simply grouping lights in the Light List. In addition, as the name suggests, the

texture on the parent light comes from the composite result of blending those lights. This means

effects can be created that were simply not possible before in HDR Light Studio with a single light list.

You can use Composites to:

· Group Lights

· Control a group of lights (brightness, position, color etc)

· Store Multiple Lighting Designs in one HDR Light Studio project

· Isolate and Edit Individual Lights

· Mask Lights
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· Clone and move areas of the HDRI map

· Combine different regions of multiple HDRI maps

· Dissect and take controls of light regions in existing HDRI maps

· Add effect to lighting using Filters

Let's make our first Composite in HDR Light Studio

Here is a lighting design containing 4 lights.

Let's select all 4 lights in the Light List.

Selecting multiple lights is a new feature and has been added to use with Composites.

With the top light in the list already selected, hold the Shift key and click on the bottom light in the

list.

Now all 4 lights have been selected.

(Please note, to add and remove individual lights from the selection, hold the Ctrl key)
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Right click on one of the selected lights in the list and select Merge To Composite from the pop-up

menu.

You will now see a single light on the light list named Composite Light.

(This is the default name when making a light with Composite content, you can rename it.)

The Canvas will look the same, you can still see the 4 original lights on the Canvas even though they

are no longer in this list.
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With the Composite Light selected, it's properties are displayed like any other light.

Key properties to note are:

Mapping: Planar

Width and Height: 100

So this light is filling the whole Canvas with the Composite content.

These are the default settings, for example, when making a Picture Background light and loading a

HDRI map.

In addition the Composite Lights 'Content Type' is set to Composite. So rather than getting it's visual

appearance from a procedural Bulb or Image, this light's appearance (RGBA image data) is coming

from the Composite set of lights.
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We made the Composite Light using the 4 original lights. Now let's take a look at where they have

moved to.

There are 2 ways to edit a Composite.

1. Press the Edit button in the Composite Content section of the Light Properties panel or

2. Press the Right Arrow button on the Light List, this appears on the right of lights with Composite

Content.
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When editing a Composite, the Light List will update to display the lights within this Composite. In

this example, we can see the original 4 lights again.

The Light List for a Composite will also display the name of the parent light at the top of the list. The

Left Arrow button is used to return back to the light list of the parent light.

The Canvas will also update when editing the Composite and now shows only the lights within the

Composite.

However, the entire lighting design will still be lighting your Render View.

Once you are editing a Composite and seeing its lights in the Light List - you work with this Light List

in the normal way in HDR Light Studio.

You can add new lights, select them, delete lights, re-order them, move them, solo, hide etc.

You can even select a light within a Composite and use LightPaint in the Render View to re-

position it on the model!

Another example, if you use the menu command Edit > Delete All, this will delete all lights within the

Composite Light List only.

Let's press the Left Arrow button to return to the Light List where the parent light is, in this case the

base Light List.
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Now it's worth taking the time to understand the benefits of the Composite being a texture on a

standard HDR Light Studio light.

With the Composite Light selected, we can now adjust it's properties like any other light.

In this case below, we have decreased its brightness and adjusted its longitude setting - in effect

rotating the lighting design horizontally.

We have rotated the entire lighting design and adjusted its brightness by adjusting just 2 settings on

the parent light.

We didn't need to adjust each of the 4 lights individually to do this.
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This parent light has planar mapping and fills the canvas. This is the default setting when merging

lights to a Composite Light because the appearance and position of the lights do not change when

they move into the Composite. This makes it ideal for grouping and organizing your lights.

Once lights are within a Composite, it's easy to move them out of the Composite and back to the

main light list.

Edit the Composite and select the light/s in the list you want to remove from the Composite.

Right click on the light/s and select Release from Composite from the pop-up menu

The light will disappear from the Composite list, and from the Canvas for the Composite.

Remember when editing a Composite, the Canvas will only display the lights within this Composite. Even

though the Render View is always lit by all lights in the lighting design.
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Press the Left Arrow button at the top of the Light list to return to the base Light List.

You can now see the light that was removed from the Composite, and it's also visible on the Canvas,

because this is now showing the whole lighting design again.

If you want to move a single light from the Light List and into an existing Composite light, simply drag

and drop the Light onto the Composite light in the list. It will then be moved into the Composite.



395

395HDR Light Studio - User Guide

Showing the light being dropped onto a Composite Light which highlights.

Please Note:

A Composite Light can contain another Composite Light, multiple levels deep if required.

Area Lights can not be placed in a Composite - they are 3D lights and make no sense in this

Composite context.

That concludes the overview of how to use the new Composite content in HDR Light Studio.

Next we need to take things further and show some examples of what is possible using

Composites.

Check out these examples:

Example 1: Studio lighting mixed with a HDRI map

Example 2: Making windows through to a HDRI map

Example 3: Mixing regions of different HDRI maps

Example 4: Enhancing a single light source

Example 5: Moving a region of an existing HDRI map

Example 6: Taking Control of individual lights sources in an existing HDRI Map



396

396HDR Light Studio - User Guide

Composite Example 1

Studio lighting mixed with a HDRI map

In this example we are going to light a car with studio style lighting. Then load a HDRI map and use

the studio lighting like a HDRI mask through to the HDRI map.

This way we get the effect of the shaping of the studio lighting, but with the character showing

through from the HDRI map.

Step 1: Light the shot with a range of studio style white lights. Add a solid black background at the

base of the lighting design.

Step 2: When happy with the basic lighting, merge those lights into a Composite light.
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Step 3: Make a Picture Background light and load a HDRI map. Put this light at the bottom of the light

list, under the Composite light.

Step 4: Change the blend mode for the Composite light to Multiply. The studio lighting will now act

like a mask over the HDRI map.

You can see this when looking at the Canvas.



398

398HDR Light Studio - User Guide

You can change the brightness of the Composite light to increase or decrease the brightness of the

lighting, as this is multiplying with the brightness of the HDRI map.
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Composite Example 2

Making windows through to a HDRI map

In this example we are going to light a still life with a base HDRI map and use a Composite Light to

create some Windows showing through to the HDRI map.

(Thank you to Raphael Rau for the Demo Scene - www.silverwing-vfx.de)

Step 1: Create a Picture Background light and load an exterior HDRI map.

Your scene will now be lit by the loaded HDRI map.

Step 2: In the Preset Lights, use the drop down to select WindowGobo.

http://www.silverwing-vfx.de
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Drag and drop two of these Window lights onto your still life subject, and position/scale them to

create nice looking reflections in your 3D model.

Step 3: Select both Window lights and merge them to a new Composite Light (Right Click in the light

list > Merge To Composite).

Change the blend mode of the new Composite Light to Multiply.

The windows will now be multiplied with the HDRI map. The result means you can see through to the

HDRI map where the Windows are positioned.

These windows could still be moved and adjusted to change the look of the lighting if you wanted.
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This diagram shows what we have just created, and how the lighting project is constructed.

Step 4: To brighten the overall lighting, which just got darker because a lot of the HDRI map is no

longer visible, you can either adjust the brightness of the Picture Background light or the Composite

Light as their values are multiplied together. In this case we adjusted the brightness of the

Composite Light to boost the lighting brightness.
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We now have other options to control the lighting with this kind of setup

Color the Windows

If you wanted to color the light coming through the windows, just like the window glass was colored.

Edit the Composite Light to see the lights within it, and change the color of each Window light.

The result is this color will be multiplied with the colors from the HDRI map coming through the

window. You can use color to dramatically alter the mood of the lighting.
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Change the Base HDRI map

At any time you can change the HDRI map used as the base of this lighting design. This will also

dramatically change the feel of the lighting, as a different location can now be seen through the

windows.

In the example below, we chose a location with lots of trees, see how the trees can be seen through

the window in the reflections.
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Change the Lights

In this example below, we swapped the content on the Window lights to be Bulbs, providing a soft

round lighting effect. When this is blended with the HDRI map, they provide a soft mask onto the

HDRI map, providing a softer lighting effect.
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Composite Example 3

Mixing regions of different HDRI maps

In this example, we are going to show how you can mix areas of different HDRI maps, to create

perfect and unique lighting for your shot - full of character.

We have made a Picture Background light and loaded an interesting airport terminal interior HDRI

map. This creates lots of interesting reflections in the car.

Next we create a Gradient Background light from the toolbar, change its mapping to Spherical, and

blend mode to Multiply.

On the value ramp we make the top of the ramp white, and the bottom black. We also add another

black peg in the middle of the value ramp. This will give us more control over the size of the light.

We now have a really useful light that surrounds the entire canvas, graduating from white through to

black. The multiply blend mode for this light means it darkens the HDRI map under it, as it goes from

white to black. Acting like a mask.

You can see that below.
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Use LightPaint to position the Gradient Background light we adjusted, using Reflection mode.

We can now use this light to control what area of the HDRI map is reflected in the model.

Adjust the brightness of the Picture Background light with the HDRI map loaded if its too dark.

You can see below we have a soft region of the HDRI map now reflecting in the car. This creates a

nice mood in the lighting.

The black peg we added on the Value Ramp for this light can be used to change the size of the

region.
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If we want to add another region of this HDRI map to show through, we can also do this using more a

more standard Round light from the tool bar.

Make a new Round Light, and use LightPaint to position it on the car where you want more lighting

from the HDRI map.
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We now need to use a Composite to get the required effect.

Select both the Round Light and Gradient Background Light, and Merge them to a Composite.

Edit the Composite

Select each light and change their blend modes to Add

Return to the base Light List and select the Composite Light, change its blend mode to Multiply

We now have those 2 lights multiplying their brightness with the underlying HDRI map. The

brightness of those lights determines the brightness of the region of the HDRI map they reveal.

Next we are going to load another HDRI map to create a different lighting feel coming from the left.

Make another Picture Background light and load another HDRI map. We have set the blend mode for

this to Over, so it covers the other lighting.
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We will now follow the same process from earlier, creating a Gradient Background light from the

toolbar, change its mapping to Spherical, and blend mode to Multiply.

On the value ramp we make the top of the ramp white, and the bottom black. We also add another

black peg on the ramp.

We will move this light to reflect in the left side of the car.
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So now we need to organize our lighting, so we can see the lighting we created earlier mixed with this

new lighting.

Select the newer Picture Background and Gradient Background lights and merge them into a

Composite. The Composite Light default blend mode is add, so now the lighting we just created is

added over the top of the earlier lighting.

We can now see both lighting designs are mixed together, with lighting coming from areas of both

HDRI maps.

Now we can see the overall look of the lighting, we can adjust any part of it to create the look we

want.

You may want to move  some of the lights we are using to mask the HDRI maps.

You may want to rotate the HDRI maps on the Picture Background lights using the Longitude Slider.

We have made some adjusts below and switched to viewing the IPR from V-Ray inside HDR Light

Studio, to see the final result.
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This diagram shows what we have just created, and how the lighting project is constructed.
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Composite Example 4

Enhancing a single light source

We are going to create some hot spots on an overhead Softbox without affecting other areas of the

HDRI map.

(Thank you to www.pk3d.com for the Demo Scene)

A softbox light has been placed above the car.

Advanced Rotations has been enabled, and Rotation Mode is set to Fixed, so wherever the light is

placed using LightPaint, the light is horizontal and aligned with the X axis.

We now want to enhance this light and give it more character by adding some Round Lights with

Blend mode Amplify. We will position these lights using LightPaint, to get the effect where we want it.

We can now see the reflection of the Softbox is more dynamic and interesting.

http://www.pk3d.com
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One issue we have is that the new lights are overspilling onto the background HDRI map. We want

them to affect only the softbox light, and leave the background alone.

 

To do this select the 3 lights (Softbox and 2 round lights) and Merge To Composite.

Change the Blend mode of the Composite Light to Over (so that it still appears solid on the canvas).
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The round lights are now only amplifying the brightness of the Softbox and the background is not

touched.

This diagram shows what we have just created, and how the lighting project is constructed.

We added a few more lights to complete the lighting design, and here you can see the final result,

with the softbox provide a lot of character to the reflections with those boosted areas.
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Composite Example 5

Moving a region of an existing HDRI map

We are going to use a Composite to move an area of the HDRI map - in order to create a more

pleasing reflection.

(Thank you to www.pk3d.com for the Demo Scene)

We have made a Picture Background light and loaded a HDRI map.

Here we are looking at the side of the car, with the sunset area of the HDRI map reflecting in the car.

But the position of this reflection does not look good on this car.

Let's move that region of the HDRI map.

Duplicate the existing Picture Background light.

Then create a Round Light and place it over the sunset region of the HDRI map. Adjust its Alpha

ramp by adding a new peg half way, with a value of 1 (white). This will reduce the softness of the

light.

http://www.pk3d.com
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Merge the duplicated background light and the Round light to a Composite.

Edit this Composite.

Change the blend mode for the Round light to Multiply, enable Mask, and turn off Preserve Alpha.

You are now looking at a region of the HDRI map that is masked off using this Round light.

Return to the base Light List and change the blend mode of the Composite light to Over. It will now

be opaque and cover the underlying HDRI map.

Now adjust the Latitude of the Composite light, reducing the Latitude will move the light upwards.

In this example, the reflection of the sunset now looks much better in the reflection. Enhancing the

appearance of the subject.

Even though the HDRI map itslef looks a bit odd with the region moved... the effect of this HDRI map

in the car is much better and still feels very realistic.
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Composite Example 6

Taking Control of individual lights sources in an existing HDRI Map

This is the most complex example, it shows what is possible using Composites.

(Thank you to Raphael Rau for the Demo Scene - www.silverwing-vfx.de)

We have made a Picture Background light and loaded a HDRI map of a room with various

lights/windows. We are going to take control of the brightness of groupings of lights/windows using

Composites.

This will allow us to turn up and down the brightness of those areas of the HDRI map.

Clamping the base HDRI map

First we will clamp the brightness of the base HDRI map using a Low Pass blend mode - in order to

get our ambient lighting.

Here is a good method to choose the correct level to use for this Low Pass light.

Make a new light with Flat Content, Planar mapping and scale it to fill the canvas.

Change its blend mode to Add, enable Invert on the blend, and change the Blend Channel to Value.

This light will now reduce the brightness of the whole HDRI map by the brightness value you have set

on the light.

Adjust the brightness of the light until you can clearly see the distinct areas of light of the HDRI map.

http://www.silverwing-vfx.de
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This will become the threshold for the base HDRI map.

You can see in the image below that distinct areas of lighting in the lights and windows are clearly

visible using a value of 50 for the light.

Change the blend mode of this light to Low Pass. This will now limit the brightest pixels to be 50.

Effectively removing the lights from the HDRI map.

You can see this in the rendered view below, that there are no longer any bright reflections.

You will notice color appear in areas of the HDRI map that have been clamped by Low Pass. This

color was there before, but the brightness of the pixels meant you could not see it.

Rename the Light to 'Low Pass'.



421

421HDR Light Studio - User Guide

Making a Composite Light to Recover the Brightness in a Region

Next we are going to make a Composite Light which will result in a light containing the lights from a

region of the HDRI map. This will then be added back to the clamped base HDRI map, and will mean

you have an adjustable brightness light source.

Duplicate both existing lights, the base Picture Background light and the Low Pass light.

Then select both lights and Merge to Composite.

Edit the Composite.

Rename the Low Pass light to Subtract.

Change its blend mode to Add, enable Invert (making it subtract), change Blend Channel to Value

The canvas now shows the regions of lighting that we can now mask.

Make a new light with planar mapping and flat content.

Rename it to 'Mask'

Move/scale this light to cover a group of lights you want to control together.

You can see below the light is covering a group of lights.



422

422HDR Light Studio - User Guide

Once positioned, change the blend mode of this light to Multiply and enable Mask.

That region is now masked and has isolated those lights.

If we return to the base light list, by pressing the back arrow at the top of the list.

We can then duplicate this composite light, to make 2 more composite lights and then adjust the

mask light within those lights, to define 2 other regions.

This is what we have done below, and we have renamed the Composite Lights so they make sense to

the user.

Once all regions have been added. The resulting HDRI map design will look the same as the original

HDRI map.

But the difference is, we can now adjust the individual brightness of those regions of the HDRI map.

Let's solo each Composite light so you can see the isolated lighting effect on the 3D scene.
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If we turn all the lights on, we can now adjust the brightness of each group of lights to get the

optimum lighting effect in our 3D scene.

This diagram shows what we have just created, and how the lighting project is constructed.
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Composite Video Demonstrations
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Composites Technical Notes

Composite Resolution

With live lighting and updates, the Composite texture resolution matches the proxy HDRI map

resolution.

For production renders, the Composite texture resolution matches the final render output

resolution.
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Filters

Filters enable special effects to be applied to Composite content.

Filters are applied live, even when editing the content of a Composite, like moving, scaling and

changing the brightness of lights.

There are currently 4 filters:

· Diffusion Blur (New in Xenon Drop 2)

· Motion Blur (New in Xenon Drop 3)

· Motion Blur Advanced (New in Xenon Drop 4)

· Reflection (New in 8.2)

How to apply a Filter

Content Light Properties for Composite Light

The way HDR Light Studio software is designed means that Composites are the only place where

image data exists in a format that can be manipulated by Filters. So if you have a HDRI map (a single

light), or a HDRI lighting design (multiple lights), then you must first place the lights into a Composite

to apply a filter.

How to place your lights into a Composite Light
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Select all the lights in the Light List that you want to add the effect to. Then right-click in the light list

and select Merge to Composite.

A new Composite Light is created containing the lights.

The Filters settings are shown at the bottom of the Composite settings on the Light Properties panel.
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Diffusion

New in Xenon Drop 2

Diffusion is a blur effect, similar to Gaussian blur. In the context of lighting, it is most useful for

replicating the effect of seeing lights through a diffusing medium like cloth or tracing paper. This is a

standard technique used in photography and film. Learn about the settings for Diffusion below, or

take a look at these examples of Diffusion in action.

Example 1 - Diffusing the Sun

Example 2 - Diffusing Bright Lights

Example 3 - Lighting through Tracing Paper

Diffusion Filter Settings

Type - Spherical
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With the Spherical setting, Diffusion blurring is correctly applied taking into account the image is a

HDRI map with lat-long mapping. Therefore, the blurring is uniform when the image is mapped onto

an environment light, and it is blurred correctly across the left and right edge of the image. The blur

also conserves light energy - so as the map is blurred more and more, the amount of light energy it

contains remains the same.

Percentage

Controls the amount of Diffusion blur being applied. Higher values mean more blur.
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Accuracy

There are 3 accuracy settings: Low, Medium, and High.

The higher the setting, the smoother the result but it will take a little longer to render.

Type - Planar
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Use this setting to apply Diffusion blurring to flat images. For example the appearance of an Area

Light.

Percentage

Controls the amount of blur applied. Higher values mean more blur.

Scale to Fit

With this setting On, the blurred content will be scaled to fit inside the image dimensions -

maintaining soft edges.

The higher the blur percentage, the more the image is reduced in scale to fit.

With this setting Off, the image will be blurred without scaling. As the blur amount increases, the

blur will spill over the edges of the texture space.

Left: Light without Diffusion   Middle: Light with Diffusion, Scale to Fit: Off, see how the blur spills

over the edges    Right: Light with Diffusion, Scale to Fit: On, see how all of the blurred light is

contained within the texture.
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Accuracy

There are 3 accuracy settings: Low, Medium, and High.

The higher the setting, the smoother the result but it will take a little longer to render.

Next: Let's take a look at Diffusion in action in Example 1
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Example 1 - Diffusing the Sun

When a photographer works on location outdoors, they still need to control the light to produce the

best end result, just like in the studio. One method is to use a diffuser panel to spread the natural

light and produce a more pleasing, softer lighting effect, removing harsh highlights and hard

shadows.

Screengrab from this youtube video: https://youtu.be/qoQ4_W3ogFg by Tony & Chelsea Northrup

Using the Diffusion filter in HDR Light Studio. We can now mimic this effect.

The portrait render, below, on the left has very hard lighting coming from the small and bright sun.

The sun area of the HDRI map has been diffused to light the render on the right. This produces a far

more pleasing softer lighting effect. The brightness of the sun has been spread out over a larger

area, but the amount of light energy has been conserved.

https://youtu.be/qoQ4_W3ogFg
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3D scene kindly provided by: Marlon R. Nunez

Here is the HDR Light Studio project setup to achieve this.

The root Light List is to the left, and the contents of the Composite Lights is expanded towards the right.
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We created Composite Light 1, so that the Rect Light can mask Composite Light 2. We made

Composite Light 2 in order to use the Blur filter on the HDRI map. Filters can only be applied to

composites.

Next: Let's take a look at Diffusion in action in Example 2
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Example 2 - Diffusing Bright Lights

Some renderers can struggle to produce clean renders lit using HDRI maps containing small and

bright light sources.

In this example, we will Diffusion blur all lights over a threshold brightness value on the HDRI map .

The result is a much cleaner render for the same amount of samples.

You can see the side by side comparisons below showing the results.

Here are some close up details of what we did:
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Here is the HDR Light Studio project set up to achieve this.

The root Light List is to the left, and the contents of the Composite Lights is expanded towards the right.
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In order for the edited HDRI map to match the lighting brightness of the original, both Flat

Background lights need to have the same brightness value. The brightness of those lights is setting

the threshold above which the lights are being Diffusion blurred. In this example by only a small

amount, 1%. But as you can see from the renders, it was enough to really clean up the render from

noise with only a minimal effect on the reflections.

This diagram below shows what we did. You can see the original and edited HDRI map look the same

apart from the blurred part of the HDRI map in the brighter areas.

Next: Let's take a look at Diffusion in action in Example 3
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Example 3 - Lighting through Tracing Paper

Some subjects, like jewellery can benefit from a nice diffuse lighting setup. Photographers create this

effect using a medium like tracing paper, placing it between the lights and the subject. It controls the

reflections seen by the subject too.

Example from: www.karltayloreducation.com/jewellery-photography-top-tips-for-how-to-photograph-jewellery

https://www.karltayloreducation.com/jewellery-photography-top-tips-for-how-to-photograph-jewellery/
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Example from: www.photigy.com/school

Using the Diffusion blur filter in HDR Light Studio. We can now mimic this effect using higher blur

values. This gives the appearance the lighting is being viewed through a diffusing medium like

tracing paper.

Here is an example render with the HDRI map used for lighting. Note how diffuse the lights are.

https://www.photigy.com/school/ 
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However, the light sources on this HDRI map are actually hard edged but have all been diffused by

the blur.

The dark circle represents a dark area at the top of the tracing paper cone. This does add a little

contrast to the lighting seen by the ring. This is not blurred.
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Here is the HDR Light Studio project set up to achieve this.

The root Light List is to the left, and the contents of the Composite Lights is expanded towards the right.

You can see how the hard edged lighting within the Composite Light has been blurred and softened.

The great thing about this blur effect is that it is totally dynamic. You can move lights inside the

composite and see their blurred effect live on your 3D scene.
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Motion Blur

New in Xenon Drop 3

The Motion Blur filter is used to provide a linear motion blur effect. The example image above shows

an HDRI map used for lighting and for the background image that was motion blurred using this new

filter.

Things you can do with Motion Blur

Easily add linear motion blur in any direction to your whole HDRI map.

Add motion blur to an edited HDRI map

Add lights and adjustments to an HDRI map and those are included in the motion blur. Move lights
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within the lighting design and they get motion-blurred on the fly.

Design a static lighting design and then add motion blur to the final design.

Add moving objects to a static HDRI map.

In this example, we are showing a moving car and aircraft, each with their own motion blur direction.

Add motion blur to certain areas of the map using masking/alpha.

In this example, we have blurred only the road, which is more correct as the sun and far off parts of

the image would not appear to move.
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Motion Blur Filter Settings

Type - Spherical

With the Spherical setting, Motion Blur is applied taking into account the image is an HDRI map with

lat-long mapping.

U and V Directions

The U and V Directions control the direction of travel for the motion blur within the HDRI map image

space. Example settings and results can be seen in the image below.

Please note: The blue arrows and green dot have been added to help your understanding of the motion

blur direction for the given settings.
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Using the sliders is not the best way to set the direction. There is a far more intuitive way of using the

LightPaint tool on the Canvas and Render Views.

When a light is selected with a Motion Blur (Spherical), the LightPaint Tool drop down on the Canvas

or Render View is updated to include a Motion Blur option. Select this option to position the direction

for the motion blur.
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Now if you click on the Render View, the LightPaint mode of Reflection, Illumination or Rim will be

used to position the direction for the motion blur. This will update the U and V Directions in the

properties panel.

Now if you click on the Canvas, you will directly position the direction for the motion blur on the HDRI

map. This will update the U and V Directions in the properties panel.
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Blur Length

Controls the length of the motion blur. A larger value gives the impression of moving faster. Example

settings and results can be seen in the image below.
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Bias

This setting allows artistic control over the motion blur. The default setting is 1 and is most physically

correct. But using a higher Bias value the non blurred area of the HDRI map in the direction of travel

increases. You may want to adjust this if you have a visible HDRI map in the background of your shot

and you want to control at what point the map starts to become motion blurred.
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Accuracy

There are 3 accuracy settings: Low, Medium, and High.

The higher the setting, the smoother the result but it will take a little longer to render.

Type - Planar
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Use this setting to apply Motion Blur to flat images. For example the appearance of an Area Light.

Blur Angle and Blur Length

These settings control the direction and amount of motion blur.

Scale to Fit

With this setting On, the blurred content will be scaled to fit inside the image dimensions -

maintaining soft edges.

The higher the blur length, the more the image is reduced in scale to fit.

With this setting Off, the image will be blurred without scaling. As the blur length increases, the blur

will spill over the edges of the texture space.
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Accuracy

There are 3 accuracy settings: Low, Medium, and High.

The higher the setting, the smoother the result but it will take a little longer to render.

Motion Blur Tutorials

Now you have learned the basics, why not watch the 3 motion blur tutorials to see motion blur in

action.

Motion Blur - Tutorial 1 - Introduction

Motion Blur - Tutorial 2 - Using gradient to mask motion blur

Motion Blur - Tutorial 3 - Using alpha image to mask motion blur
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Motion Blur - Tutorial 1

Introduction tutorial on how to use the motion blur filter.
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Motion Blur - Tutorial 2

In this tutorial we learn how to use a gradient in HDR Light Studio to blur only the parts of the HDRI

map that are close and would be moving.
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Motion Blur - Tutorial 3

In this tutorial we learn how to use an alpha image to control which parts of the HDRI map are going

to be blurred.
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Motion Blur Advanced

HDRI Map kindly provided by https://ctccreativestudio.com/

New in Xenon Drop 4

The Motion Blur (Advanced) filter is used to create advanced motion blur effects on HDRI maps.

Here are the additional features that the Motion Blur (Advanced) filter provides, above the

standard Motion Blur filter:

· The motion path can be curved in any direction. Use case: Replicating motion blur travelling around a

corner in a car.

· Noise can be added to the path. Use cases: Replicating the effect of road noise in the blur or to

generate a creative lighting trail effect.

· Motion blur amount can be scaled per pixel by values from a loaded image. Use case: Paint an image

to control where the map is blurred and by how much.

This filter is slower to calculate than the standard Motion Blur filter.

Motion Blur (Advanced) Settings
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Motion Blur (Advanced) Settings

U and V Directions

The U and V Directions control the direction of travel for the motion blur within the HDRI map image

space. Example settings and results can be seen in the image below.

Please note: The blue arrows and green dot have been added to help your understanding of the motion

blur direction for the given settings.
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Using the sliders is not the best way to set the direction. There is a far more intuitive way of using the

LightPaint tool on the Canvas and Render Views.

When a light is selected with a Motion Blur (Advanced), the LightPaint Tool drop down on the Canvas

or Render View is updated to include a Motion Blur option. Select this option to position the direction

for the motion blur.
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Now if you click on the Render View, the LightPaint mode of Reflection, Illumination or Rim will be

used to position the direction for the motion blur. This will update the U and V Directions in the

properties panel.

Now if you click on the Canvas, you will directly position the direction for the motion blur on the HDRI

map. This will update the U and V Directions in the properties panel.
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Blur Length

Controls the length of the motion blur. A larger value gives the impression of moving faster.
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Curvature and Tilt

A special feature of this motion blur is the ability to curve the motion path and tilt the orientation.
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The curvature setting changes the amount of curvature on the motion path.

By default the value is 0 and this provides a straight path. As the value of this setting increases, the

path becomes more curved. 

The tilt value controls the orientation of the curved path. See example settings below.

For example, curving to the left has a tilt setting of 0.

In the examples below, the image on the left has a curvature setting of 0. The image on the right has

a curvature setting of 0.5. You can see how the motion blur is curving in the image on the right.
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Noise Profile

A key feature of the advanced motion blur is the ability to put a jitter noise profile onto the motion

path. This is useful for replicating the effect of road noise or to generate a creative lighting trail effect.

Press the Edit button to adjust the noise profile settings.
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At the top of the panel is a preview of the noise. As this UI panel is scaled, this preview area increases

in size, ideal if you want to see the noise path in more detail.

As you adjust the settings, this preview visual will update in real-time. However, to apply the new

settings to the HDRI map in HDR Light Studio, you will need to either press the Apply or OK button.

The OK button will apply the settings and close the panel. Press cancel to revert any changes made in

the current editing session and close the panel.

Spread

Scales the noise over the length. Smaller values produce a smoother result.

Seed

Explore the seed values to vary the noise effect. This seed value ensures the noise result is the same

next time the project is opened.

Amplitude

Scales the height of the noise. A value of 0 will remove all noise.

Ground Clamp

With this setting turned on, the values are clamped to positive values only.

Here are some example motion blurs results with different noise settings.
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Depth Image

A loaded image scales the amount of motion blur that each pixel will receive. You can use this feature

to paint a depth image in photo editing software, with values from black to white, in order to decide

which parts of the map get blurred and by how much. Black pixels are not blurred, white pixels are

fully blurred.

Here are 2 examples using the Depth Image.

In example 1: We have painted a depth image - so that the sky, sun and horizon remain still, but the

closer elements are blurred. You can see the railings are blurred, but the sea between the rails is not.
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In example 2: You can see we have used the depth image more like a mask. Selecting only 3 lights

from the HDRI map to get blurred. The 3 lights make stunning light trails over the rest of the map.
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Advanced Motion Blur Tutorial

Now you have learned the basics, watch this video tutorial to see the Advanced Motion Blur filter in

action: Advanced Motion Blur Tutorial
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Advanced Motion Blur Tutorial

In this tutorial we learn how to use the Advanced Motion Blur filter.



474

474HDR Light Studio - User Guide

Reflection

New in HDR Light Studio - 8 Drop 2

The Reflection filter is used to mirror the image within a composite across a vertical or horizontal

axis.

Type

Wrap 

This mode allows mirroring a HDRI map across an axis, taking into account the continuity of the

image over the seam, between the left and right edges.

Original HDRI map with no reflection filter.
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Dotted lines are not part of the interface and are added to help explain the feature.

Reflection is on with type Wrap. The reflection setting is Left to Right, so image content on the left of

the axis set at 0 is reflected to the right of it. Because of the wrap setting, image to the left of the axis

is actually coming from the right of the HDRI map, because the image is treated as one continuous

image wrapping from the left edge over to the right edge. So strangely, in this case, the left side of

the axis is coming from the right side of the HDRI map. Wrap mode is therefore the only mode you

can use for mirroring HDRI maps and whole lighting designs. This is why its the default mode, as we

believe this will be the most common use for reflection.

This has the same settings but we have moved the axis to 0.25 across the image. Here it's a little

clearer what is happening. Source image content from the left of the axis is reflected to the right. This

more clearly shows how the source content to the left actually wraps to the other side of the HDRI

map too.

Mirror

This setting mirrors the content from one side of the axis to the other. This is ideal for using on light

sources to remove unwanted details perhaps. Here are some example settings.
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Here is the original light with no reflection setting.

Dotted lines are not part of the interface and are added to help explain the feature.

Mirror - Left to Right - Axis 0.5
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Mirror - Right to Left - Axis 0.5

Mirror - Top to Bottom - Axis 0.5
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Mirror - Bottom to Top - Axis 0.5

Mirror - Left to Right - Axis 0.25

With axis position lower than 0.5, there will be a blank area where there is no content to mirror.

If you were to add a Blend value to any of the Mirror examples above, the Blend region only appears over

the axis.

Wrap mode is the only reflection type where the Blend would be applied to both the axis and the other side

of the reflected content.

Fit
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Mirrors the content across the axis and scales the reflected content to fit and fill the image space.

Here is the original light with no reflection setting.

Fit - Top to Bottom - Axis 0.4. See how the reflected content at the bottom is stretched to fill the

image space.

Fit - Top to Bottom - Axis 0.5. You actually see the same with these settings as mirror. The image

doesn't need stretching to fit as the axis is exactly half way.
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Fit - Top to Bottom - Axis 0.7. See how the reflected content is squashed to fit in the image space.

If you were to add a Blend value to any of the Mirror examples above, the Blend region only appears

over the axis.

Wrap mode is the only reflection type where the Blend would be applied to both the axis and the

other side of the reflected content.

Direction

Sets the direction of the reflection. See these examples:

Original source image with no reflection. A colorful rabbit designed to make it easy to see how the

image will be reflected.
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Left to Right

Right to Left

Top to Bottom
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Bottom to Top

Axis

Sets the location of the reflection axis in image space, from 0 to 1.

The location of the axis can be set using the numeric input and slider.

However, it can also be set using a LightPaint mode on the Canvas and Render Views. Then you can

click in the view to position the Axis.

 

Here are some example axis settings.
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Vertical axis - Setting 0.2 (20% across the image)

Vertical axis - Setting 0.4 (40% across the image)

Vertical axis - Setting 0.6 (60% across the image)
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Vertical axis - Setting 0.8 (80% across the image)

Brightness

This setting scales the brightness of the reflected image content. Default is 1 = 100%.

This setting is useful when reflecting a studio lighting design. With this single setting you can change

the relative brightness of the reflected half of the lighting design.

Example showing reflected left side with a brightness setting of 0.25. This is 25% of the brightness of

the source image.
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Alpha

To get the alpha effect you expect - you will need to turn off the Unpremultiply setting on the

Composite content.

This setting sets the alpha value of the reflected content. 1 = 100% and solid, 0 = 0% and totally

transparent.

This setting is useful for faking a reflection of the HDRI in a floor.

Reflected from top to bottom. Behind is the original HDRI map, the transparent reflection is over the

top and looks like water.

Blend

The original and reflected image content can be blended over the axis with a soft edge. The width of

this blend region is specified with this setting.

A setting of 0 provides a hard edged reflection and no blend.

Using the Blend setting is useful to soften the transition between both sides of a HDRI map. If the
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brightness has been adjusted for the reflected region, this normally leaves a hard edge unless a

Blend value is used to soften this edge and create a transition.

Blend = 0 - Hard Edge

Blend = 5 - Soft blend

Blend = 20 - Very soft blend
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Loading Images

HDR Light Studio has been designed to quickly and efficiently handle working with many high

resolution images loaded into your lighting project.

The following is a list of supported image file formats: BMP, DDS, DPX, FITS, HDR, ICO, IFF, JPEG, OpenEXR,

PNG, RLA, SGI, TIFF.

HDR Light Studio works best when loading tiled and mip-mapped images. The image cache system

then retrieves only the area of the image (the tiles) and the resolution (the mip-map level) required.

This is all handled automatically for you and saves a huge amount of memory, which speeds things

up considerably.

However, if you load large images that are not tiled and mip-mapped, then HDR Light Studio will load

the full resolution images into memory. The performance will then be much slower!

Image Conversion

HDR Light Studio makes it easy to convert the images you load into tiled and mip-mapped images.

When loading any image into HDR Light Studio that is larger than 1,500 pixels wide, you will be

prompted to convert the image with the Image Conversion dialog.

Press the Convert button. (If you press Open Anyway the performance will be slow, and loading very

large images will take a long time)

HDR Light Studio will then prompt the user to save a new image file that is tiled and mip-mapped

and has the same file name with a .tx added.
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Press Save and the image is then converted and saved onto disc.

The new .tx file is then loaded into HDR Light Studio.

Once images are tiled and mip-mapped like this, you can lots of load massive images into HDR Light

Studio and it will perform quickly. 
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Missing Images

If a HDR Light Studio project is opened and a referenced image cannot be found, the light will be

displayed as solid bright red. To fix missing images please see: Project Assets Dialog
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Value Blend

Value Blend allows blending of the luminosity values using a secondary content. It provides a way to

tweak the character of the light source. For example adding a hot spot into an existing soft box, or

graduating the light brightness across your light.

Content types for Value Blend are: Image, Gradient, Box Gradient, Scrim Light (default), Polygon,

Flat

Blend Modes for Value Blend are: Add, Multiply, Over, Low Pass and Amplify

Here are some effects you can create:

Value Blend Off - showing original content for reference

Value Blend - Gradient used with Multiply blend mode, to darken areas of the light using a

radial gradient, top corner

You can see how the character of the light changes in the reflections on the render view. It's less flat
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and more dynamic.

Value Blend - Gradient used with Multiply blend mode, to darken areas of the light using a

radial gradient, bottom corner
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Value Blend - Gradient used with Multiply blend mode, to darken areas of the light using a

radial gradient, centered

Value Blend - Gradient used with Multiply blend mode, to darken areas of the light using a

linear gradient, top edge
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Value Blend - Image used with Multiply blend mode to change brightness of a soft box

Value Blend - Flat used with Low Pass blend mode, this is clamping the values of the spot light

on the right, the character of the light is maintained, but the hot spot of the light bulb is
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removed
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Alpha Multiply

The alpha multiply provides an optional secondary alpha that is multiplied by the alpha of the main

light content.

Content types for Alpha Multiply are: Image, Gradient, Box Gradient, Scrim Light, Polygon

(default)

Alpha Multiply: Image

If you load an image the value channel of the image is used as a stencil/matte.

Left: Image loaded onto Main Content of Light   Middle: RGB Alpha Image loaded into Alpha Multiply    Right: Result
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Alpha Multiply: Gradient

If you don't have a matte to use in the alpha override, you may find the gradient control sufficient.

Linear or radial ramps can be used to cut or shape synthetic lights. Using a gradient can produce a

highly controllable soft edge or additional fall off to a light. This is very useful for sophisticated car

and product studio lighting. The ramp shape can be controlled and rotated using the sliders.

Left: Bulb Content   Middle: Alpha Multiply Gradient   Right: Result

Alpha Multiply: Box Gradient
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Box Gradient can used to create soft edges, and many more effects (see Box Gradient)

Left: Bulb Content   Middle: Alpha Multiply - Box Gradient   Right: Result
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Value and Alpha Ramps

One some light types, the Brightness Value or Alpha Value can be controlled by a ramp.

The user clicks on the ramp to add new pegs. Use the peg slider to adjust the brightness of the

selected peg. Click on a peg under the ramp to select it.

Click on the graph button at the end of the ramp to access additional settings and a more visual way

of controlling the ramp.

Custom Gradient Dialog

A log button is provided to allow artists to have a very bright light at the center while still having

subtle control over the dark part of the ramp.
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Left - Log: Off    Right - Log: On
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Color Modes

Source

With Color Mode set to Source (available only on image content), the Saturation slider can be used

to boost or subdue the colors.

Color Mode = Source

The Gamma slider can be used to change the gamma (contrast) of the image. Ideal to change the

character of light sources, or to modify HDRI maps to fix incorrect gamma.

Flat

With Color Mode set to Flat, procedural content uses this flat color, or image content is colorized by

this color.
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Color Mode = Flat

Ramp

Select from either a linear or radial gradient of color that is used to color procedural lights, or to

colorize image content.

Color Mode = Ramp
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Light Controls Panel (Legacy)

The Light Control buttons are a depreciated feature since HDR Light Studio (8 Drop 1).

Light Control buttons have been replaced with LightPaint modes that can be used in the

Render Views and Canvas.

We are leaving the information below for users of older versions of HDR Light Studio.

The Light Controls panel contains 'click, hold and drag' buttons to edit the size, rotation and

brightness of a light. This provides an easy to use alternative to using the sliders to control these

properties.

Keyboard qualifiers can be used to change the sensitivity of the Light Control buttons whilst

dragging.

CTRL + Hold Drag  = slower increment (i.e. smaller adjustment for distance dragged).

SHIFT + Hold Drag = faster increment (i.e. larger adjustment for distance dragged).

If you can't see the Light Controls panel, switch it on from the Window menu. See Panels.

These parameters are also available in the Light Properties panel.
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Preset Library Panel

What are Presets?

Presets provide a library of lighting content and settings that you can apply to your lighting designs.

There have been a lot of improvements to Presets in HDR Light Studio 8 Drop 2.

· Preset Types Explained

· Presets Panel Layout

· Preset Tabs (New 8 Drop 2)

· Preset Rigs

· Preset Lights

· Preset Content

· Preset Elements

· Auditioning Presets (New 8 Drop 2)

· Save your own Presets
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· Create Preset Panel

· User Preset Management Panel

· Batch Import of Images to User Presets

· Preset Preferences

· Presets Technical Information

If you have not installed the presets, your Presets panel will show this message - Demo Presets

Loaded. Presets Folder Empty.

If you have purchased HDR Light Studio, please download the presets provided and install the files

into the folder linked from the panel.

See Installing Presets
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Preset Types Explained

Let's illustrate this using the HDR Light Studio interface too.
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Next: Presets Panel Layout
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Presets Panel Layout

Thumbnails

The Presets panel displays lots of Thumbnail images that show the visual effect (where possible) of

each Preset. The size of these thumbnails can now be adjusted in the application Preferences.

Preset Tabs (New in 8 Drop 2)

Tabs have been added to make it easier to navigate the Presets. Tabs act as high-level filters on the
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Presets and help separate Presets into more useful groupings. For example, any preset that fills the

canvas we show in the Env (Environment) tab, so that all of the environments are shown together.

Learn more about Preset Tabs.

Type Drop-down

Use this drop down to select the available Presets Types for the current Tab. On some tabs, only one

type is available, for example Rig and Light tab.

Tag Drop-down

Use this drop down to filter the displayed presets by the selected Tag wording.

Audition Toggle (New in 8 Drop 2)

Turns on and off the Audition mode for Presets. In Audition mode, hovering over a Preset will

instantly and temporarily apply the Preset to the selected light. Double click to apply the Preset in

Audition mode.

Favorite Filter (New in Tungsten Drop 4)

Use this button to show only presets marked as Favorites.

To Favorite a Preset, right click on a preset thumbnail and select 'Add to Favorites' (or 'Remove from

Favorites' to remove it).

Hidden Presets Filter (New in 8 Drop 2)

Use this button to reveal all the hidden Presets.

To Hide a Preset, right click on a preset thumbnail and select 'Add to Hidden' (or 'Remove from Hidden' to

show it again).

Description (Name) Field

This field updates as the cursor moves around the preset panel, showing the description/naming of

the preset under the cursor.

Preset Tags Field

This field updates as the cursor moves around the preset panel, showing all tags assigned to the

preset under the cursor.

Hover for Larger Preview (New in Tungsten Drop 4)

Hover the cursor over a preset - after a short wait,  a larger preview image will be displayed with

useful text details about the preset.
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M, V, A buttons (New in 8 Drop 2)

For Content Presets and most Element Presets, these M,V,A buttons appear on the Presets interface.

These buttons are used to chose where the Preset is going to be applied, to the Main, Value Blend, or

Alpha Multiply of the selected light or new light.

Next: Preset Tabs
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Preset Tabs

New in HDR Light Studio 8 Drop 2

The new tabs filter the Presets into useful categories, based on the properties of the preset. This

makes it easier to find the Presets you are looking for.

When switching between tabs, the Type and Tags selected in the drop-downs will be remembered for

each Tab during that HDR Light Studio session.

Rig Tab

The Rig tab shows all Presets that are Rigs. (This is why the Type drop down only contains Rigs on this

tab)

Rigs Presets can not be used with the new Audition feature. Rig Thumbnails will not display when Audition

mode is on.

To try out Rigs quickly, right click on a Rig thumbnail and select 'Replace Lights with Rig'.
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Env (Environment) Tab

The Env tab shows:

All Light Presets with settings that look like an Environment, filling the HDRI Canvas.

Content: Skies Presets

Content: Images Presets with image ratio 2:1

Element: Images Presets with image ratio 2:1

If a new light is made from any Preset type shown in the Env tab, it will always be created to fill the

canvas. You will not be asked if you want to make a 3D Light or Background Light.
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Light Tab

The Light tab shows Presets that are Lights. This is why the Type drop down only contains Lights on

this tab.

Lights in this tab will exclude Lights appearing in the Env and Effect tabs.

Content Tab

The Content tab shows all Presets that are Content Types.

BoxGrads, Bulbs, Flats, Gradients, Images, Polygon, Scrim Light, Skies, Composite

Presets in this tab will exclude those appearing in the Env tab.
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Element Tab

The Element tab shows all Presets that are Elements.

Color Ramp, Colors, Images, Value Ramp

Presets in this tab will exclude those appearing in the Env tab.

Effect Tab

The Effect Tab shows lights with Blend modes that are 'not' Add or Over. These lights therefore add

'effects' to your HDRI lighting design with Blend modes like Saturation, Color, Low Pass.

The Type drop down will only contain Lights on this tab.

Please see the Description/Name for the Preset when hovering the cursor over the preset in order to

understand it's effect. The thumbnail image will not represent the visual effect that the Preset will

have on the HDRI.

Next: Preset Rigs
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Preset Rigs

Rigs are entire lighting designs containing multiple lights. HDR Light Studio is supplied with a range

of example rigs and you can save your own Rig Presets too.

Rigs provide all the benefits of 'off the shelf' static HDRI maps, but without the limitations. Everything

is editable in HDR Light Studio, the rig is a starting point and the lighting can be easily adjusted to

suit your shot. Rigs are not limited to storing entire lighting setups. You may have a small collection

of light sources that you use on most projects. Store them in a rig, and drag and drop that rig to add

that set of lights in an instant.

1. Drag and Drop onto the Canvas

All of the lights from the preset rig will be added to your current lighting project, at the top of the

light list.

The lights in the rig will always be positioned where they were stored in the preset, therefore

ignoring the location dropped.

2. Drag and Drop onto a Render View

All of the lights from the preset rig will be added to your current lighting project, at the top of the

light list.

The lights in the rig will always be positioned where they were stored in the preset, therefore

ignoring the location dropped.

3. Drag and Drop onto the Light List

All of the lights from the preset rig will be added to your current lighting project, at the top of the
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light list.

The lights in the rig will always be positioned where they were stored in the preset.

4. Double Click on the Preset

All of the lights from the preset rig will be added to your current lighting project, at the top of the

light list.

The lights in the rig will always be positioned where they were stored in the preset.

5. Right Click - Choose 'Replace Lights with Rig' (New in Tungsten Drop 4)

This will delete all lights and replace them with the rig lights. The lights in the rig will always be

positioned where they were stored in the preset.

Rigs can not be Auditioned using the new Audition feature. So this is a really fast way to test different

lighting rigs on your scene. 

Next: Preset Lights



517

517HDR Light Studio - User Guide

Preset Lights

HDR Light Studio includes a large library of preset lights you can use in your lighting projects, and

you can save your own Light Presets also.

1. Drag and Drop onto the Canvas

The new light will be added to your current lighting project, at the top of the light list.

The light will be positioned where it was dropped (mouse button released) on the canvas.

2. Drag and Drop onto a Render View

The new light will be added to your current lighting project, at the top of the light list.

The light will be positioned where it was dropped (mouse button released) on the 3D model using

the active LightPaint mode (Reflection, Illumination, Rim etc).

3. Drag and Drop into an empty area on the Light List

The new light will be added to your current lighting project, at the top of the light list.

The light will be positioned using the location stored in the preset.
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4. Double Click on the Preset

The new light will be added to your current lighting project, at the top of the light list.

The light will be positioned using the location stored in the preset.

5. Drag and Drop onto existing lights in the Light List (New in 8 Drop 2)

The appearance of the preset light is applied to the light where the preset is dropped (mouse button

released). This includes all Main, Value Blend and Alpha Multiply settings.

6. Right Click Menu - Apply to Current Light (New in 8 Drop 2)

The appearance of the preset light is applied to the selected light in the light list. This includes all

Main, Value Blend and Alpha Multiply settings.

Next: Preset Content
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Preset Content

Content are the ingredients that combine to give the light it's Appearance. There are 3 sections on

the light appearance settings where content can be used: Main (M), Value Blend (V) and Alpha

Multiply (A).

Please note the new M,V,A buttons on the Preset panel. They are a key new feature controlling how

Content Presets are applied to lights.

1. New Light - Drag and Drop onto the Canvas (Changed in 8 Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light', once a choice is made, a light is

created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

For a 3D Light, the new light is positioned where the Preset was dropped. For a Background Light, the

new light is always positioned centrally filling the canvas.

The content will be applied to either Main, Value Blend or Alpha Multiply based on the active M,V,A

button active in the Presets panel.

2. New Light - Drag and Drop onto a Render View (Changed in 8 Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

For a 3D Light, the new light is positioned where the Preset was dropped using LightPaint. For a

Background Light, the new light is always positioned centrally filling the canvas.
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The content will be applied to either Main, Value Blend or Alpha Multiply based on the active M,V,A

button active in the Presets panel.

3. New Light - Drag and Drop onto a space in the Light List (Changed in 8 Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

The new light is created centered on the canvas.

The content will be applied to either Main, Value Blend or Alpha Multiply based on the active M,V,A

button active in the Presets panel.

4. New Light - Double Click on the Preset (New in Tungsten Drop 4)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

The light is created centered on the canvas.

The content will be applied to either Main, Value Blend or Alpha Multiply based on the active M,V,A

button active in the Presets panel.

5. Apply to existing light - Drag and Drop onto 'Content Tabs' or a 'Content Type' field name

When dragging a Content Preset - the Tabs and Fields where it can be applied in the Light Properties

panel change to the color Green. You will need to be looking at the Appearance tab to see this.

Drop the Preset onto the location where you want it to apply.

6. Apply to existing light - Drag and Drop onto a light in the Light List

The content will be applied to either the Main, Value Blend or Alpha Multiply based on the active

M,V,A button active in the Presets panel.

Not all Content types can be used on Value Blend and Alpha Multiply - so the M,V,A buttons will show and

hide to shows what is applicable.

M,V,A buttons

7. Apply to existing light - Right Click Menu 'Apply To Current Light'

The content will be applied to either the Main, Value Blend or Alpha Multiply based on the active

M,V,A button active in the Presets panel.
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Not all Content types can be used on Value Blend and Alpha Multiply - so the M,V,A buttons will show and

hide to shows what is applicable.

For reference, the chart below shows where it is possible to apply the different Content Types.

Main Value Blend Alpha Multiply

Content: Bulb Yes

Content: Image Yes Yes Yes

Content: Gradient Yes Yes Yes

Content: Box Gradient Yes Yes Yes

Content: Scrim Light Yes Yes Yes

Content: Polygon Yes Yes Yes

Content: Flat Yes Yes

Content: Sky Yes

Content: Composite Yes

Next: Preset Elements
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Preset Elements

Elements are properties settings used within Content.

HDR Light Studio is supplied with a wide range of Element Presets, and you can save your own

Element Presets too.

You can batch import images as Presets, and ideal way to add lots of HDRI maps or new HDR Lights to your

Presets library - see here

Please note the new M,V,A buttons on the Preset panel. They are a key new feature controlling how

Content Presets are applied to lights.

There are 4 types of Element Presets to choose from:
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It may seen weird at first, but you can use an Element as the basis for making a new light. This is

especially useful when working with Images. If you drag and drop a batch of images into the Presets

panel, they get added as Element: Images Presets. So we have provided these convenient ways to

make new lights directly from Element Presets where possible.

Behavior for creating new lights from Elements:

Element: Color Ramps will create a new light with Gradient Content and apply the preset to the

Color Ramp

Element: Colors will create a new light with Flat Content and apply the preset to the Color

Element: Images will create a new light with Image Content and apply the preset to the Image slot

Element: Value Ramps can not be used to make new lights and can only be applied directly to

existing value/alpha ramps.

1. New Light - Drag and Drop onto the Canvas (Color Ramps, Colors, Images) (Changed in 8 Drop

2)

You are offered a choice of creating a '3D Light' or 'Background Light', once a choice is made, a light is

created using the preset. (unless you are on the Env tab and all lights are created as Background



524

524HDR Light Studio - User Guide

Light)

For a 3D Light, the new light is positioned where the Preset was dropped. For a Background Light, the

new light is always positioned centrally filling the canvas.

The element will create content on either Main, Value Blend or Alpha Multiply based on the active

M,V,A button in the Presets panel.

2. New Light - Drag and Drop onto a Render View. (Color Ramps, Colors, Images) (Changed in 8

Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

A 3D Light will be created in the location where dropped using LightPaint.

A Background Light  is created centered on the canvas.

The element will create content on either Main, Value Blend or Alpha Multiply based on the active

M,V,A button in the Presets panel.

3. New Light - Drag and Drop onto a space in the Light List. (Color Ramps, Colors, Images)

(Changed in 8 Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

The light is created centered on the canvas.

The element will create content on either Main, Value Blend or Alpha Multiply based on the active

M,V,A button in the Presets panel.

4. New Light - Double Click on the Preset. (Color Ramps, Colors, Images) (Changed in 8 Drop 2)

You are offered a choice of creating a '3D Light' or 'Background Light' - once a choice is made, a light

is created using the preset. (unless you are on the Env tab and all lights are created as Background

Light)

The light is created centered on the canvas.

The element will create content on either Main, Value Blend or Alpha Multiply based on the active

M,V,A button in the Presets panel.

5. Apply to existing light - Drag and Drop onto the relevant Element field/property.

When dragging the Element Preset, locations where it can be applied on the Content settings will

have their label text change to green.

6. Apply to existing light - Drag and Drop onto 'Content Tabs' or a 'Content Type' field. (Color

Ramps, Colors, Images) (Changed in 8 Drop 2)

When dragging the Element Preset, Appearance Content Tabs and the Content Type text where it can

be applied will have their text change to green.
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Here is the logic of how the Element will be applied to the Content:

Element: Color Ramps

If the current content type contains a Color Ramp, the Color Ramp will be made active and the Preset

Color Ramp will be applied to it.

If the current content type does not have a Color Ramp, the content type will be changed to

Gradient, and the Preset Color Ramp applied to it's Color Ramp.

Element: Colors

If the current content type shows a Color swatch, the Color Preset will be applied to it.

If the current content type shows a Color Ramp, the Color Preset will be applied to the active Color

Peg.

If there is no location to apply Color on the current content type, the content type will be changed to

Flat and the Preset Color is applied.

Element: Images

If the current content type is Image, the Image Preset is applied to the Image slot.

If the current content type is not image, the content type is changed to image and the Preset Image

is applied to the Image slot.

All of the rules above may seem a bit over complex. But as a user, the logic gives you a lot more

control using Element Presets. For example, you can change the color of any light easily, whether it

has color settings or not. It will adapt to make sure you can apply a color setting from a Element:

Color preset.

7. Apply to existing light - Drag and Drop onto a light in the Light List. (Color Ramps, Colors,

Images) (Changed in 8 Drop 2)

The Element will be applied to either the Main, Value Blend or Alpha Multiply based on the active

M,V,A button in the Presets panel, using the same rules as above.

M,V,A buttons

For reference, the chart below shows where the Element Types can be applied on a Light

Appearance.

Main Value Blend Alpha Multiply
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Element: Color Ramp Yes

Element: Colors Yes

Element: Images Yes Yes Yes

Element: Value Ramp

Next: Auditioning Presets
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Auditioning Presets

New in HDR Light Studio 8 Drop 2

The new Audition feature lets you instantly, and temporarily, change the appearance of the current

light by hovering over Preset thumbnails in the Preset panel. As you move the cursor around the

panel, the appearance of the selected light changes using the Preset.

Use Audition mode to explore lots of different HDR Environments or Light appearances really fast. In

Audition mode, once you find a Preset you want to use, double click on the Preset to apply it to the

selected light.

Entering Audition mode is as easy as turning on the Audition toggle in the top right of the Presets

panel.

With Audition mode on, Presets are filtered in each Tab to show only the types of Presets than can be

Auditioned. For example, with Audition mode on, Rig Presets will not be shown as Rigs can not be

auditioned. But most Presets can be auditioned and they are applied to lights with the same logic as

when not in Audition mode.

When Auditioning Content Presets and Element Presets, the active M,V or A button determines

where the Preset is being Auditioned to - Main, Value Blend, or Alpha Multiply.
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For example, with the A button active, Content: Images can be auditioned to the Alpha Multiply for

the selected light. This lets you try out different images to act as an alpha mask on the light.

The new audition feature will let you explore different lighting options so much faster.

Next: Save your own Presets
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Save your own Presets

Save your own Rig Presets

To save the current lighting design as a Preset. Use the Create menu: Create > Rig Preset

The Create Preset Panel will appear where you will provide a description and tags for the preset.

Save your own Light Preset

With the light selected in the Light List, use the Create menu: Create > Light Preset
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The Create Preset Panel will appear where you will provide a description and tag words for the

preset.

Save your own Content Preset

Press the Save Preset button to the left of the Content Type field label. (highlighted red below)

The Create Preset Panel will appear where you will provide a description and tag words for the

preset.
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Save your own Element Preset

Press the Save Preset button to the left of the property label (highlighted in red below).

The Create Preset Panel will appear where you will provide a description and tag words for the

preset.

Next: Create Preset Panel
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Create Preset Panel

1. Name your Preset 'Description'

Give the preset a name using the Description field.

2. Add Tags to your Preset

Scroll and to find existing tags in the existing Tags panel. Select a tag and press the arrow button to

add the tag to your preset.

Or use the Create New Tag button, to create a new unique tag.

If you make a mistake, you can remove a tag using the Remove Tag button. Tags can not include

spaces, they need to be 'one word'.

3. Create the Preset

Press the OK button to create your new preset.

If you do not want to make the new preset - press the cancel button to abort the process.

Next: User Preset Management Panel
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User Preset Management Panel

(New in Tungsten Drop 4)

The User Preset Management panel is opened by going to the menu Edit > Manage User Presets

This panel is the only way to manage your User Presets.

This panel can take a few seconds to appear as the user presets are loaded into this panel.

Selecting a Preset to Edit

The panel includes a region displaying the installed user presets. These are filtered with the same

controls as used in the main Presets panel in HDR Light Studio.

Find the preset you want to edit and select it by clicking on the thumbnail. The selected preset is

highlighted with an orange outline, and its Description (name) and Tags are then displayed.

Deleting a Preset

With a single User Preset selected, press the Delete Preset button. (Multiple light selections is not

supported at this time)

A warning dialog will appear checking if you really want to permanently delete the user preset.
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Please note: Images referenced in a Preset will not be deleted. These images may be used in previous HDR

Light Studio projects, and deleting them will mean old projects will not load correctly.

Changing the Description

This is effectively the name for the preset as shown in the preset panel. With the preset selected,

type a new name in the Description field, and then press the Apply Updates button to change the

name.

Changing the Tags

With the preset selected you can add tags from the Existing Tags list using the button, or select a

existing tags and remove them with the Remove Tag button. To save the changes to Tags, press the

Apply Updates button.

Once you have finished editing your user presets, press the Close button, to close this panel.

Next: Batch Import of Images to User Presets
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Batch Import of Images to User Presets

If you have a range of images you would like adding to the User presets, you can drag and drop the

images onto the Presets panel, and they will be added as Element: Images.

This is ideal if you have a library of HDRI maps that you would like available inside HDR Light Studio.

Any images that have a ratio of 2:1 will automatically be available from the Env tab in the presets

panel. Making it easy to find your HDRI maps.

Simply drag and drop the selected images from a directory in your OS onto the Presets panel.

It doesn't matter what type of content is active in the drop down menus, the images will always be added as

Element:Images

Once the images have been dropped, you will be asked to confirm you wish to continue with

converting the images to presets.

Choose Yes to continue.
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The Presets name/description will be inherited from their file names. But you should tag them

appropriately. Here we have created a new tag HDRI_Maps

Press OK to continue.
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Now each image will be processed into a .tx file that is added to the User Presets folder, with an

accompanying .xml file describing the preset.

Once all of the images have been processed a confirmation will be displayed.

Press OK to close the panel.
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If you select Element: Images and the tag HDRI_Maps, you will now be able to see the images that

have been added to the User Presets.
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You can rename, tag and delete your added User Presets using the User Preset Management panel.

Next: Preset Preferences
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Preset Preferences

Go to the menu Edit > Preferences. This panel contains some settings for Presets.

Preset Directory and User Preset Directory

Choose or Open the location where the Presets and User Presets are stored on disk.

Preset Thumbnail Size

Choose the size of thumbnail to displayed in the Presets panel. Choose from Standard, Large, and Extra Large
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Standard, Large, & Extra Large Thumnails

Next: Presets Technical Information
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Presets Technical Information

Preset File Locations and Folders

On Windows for example, HDR Light Studio has the following default folder structure for HDR Light

Studio user files, located here:

C:\Users\<username>\AppData\Local\lightmap\

The Presets included for download with HDR Light Studio by default should be placed in the 'presets'

folder.

For example located in Windows OS here: C:\Users\<username>\AppData\Local\lightmap\presets

HDR Light Studio generates preview thumbnail images for all presets in the 'presetCache' folder. The

first time HDR Light Studio runs it will generate these thumbnail images which may take some time.

Thereafter, the presets will load much faster using the presetCache image files.

When a user creates their own User Presets, these are stored in a different location, so they do not

get mixed up with the Lightmap preset content.

User Presets by default are stored in the 'userpresets' folder.

For example located in Windows OS here: C:

\Users\<username>\AppData\Local\lightmap\userpresets

As user presets are created, they are automatically placed in a well organized folder structure within

the userpresets folder. There is a folder for each type of preset and a folder containing textures

referenced by these presets (unless the texture is already present in the presets folder, then it will be

referenced from there).
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Using Edit > Preferences in HDR Light Studio, the location HDR Light Studio uses for the presets and

userpresets can be changed.

Changing the location of the user presets can be very useful, allowing the user to create different

sets of user presets for different projects or clients perhaps.

Changing the location of presets or userpresets requires a restart of HDR Light Studio.

User Presets and Referenced Images

If the image file name being referenced by the preset you are creating is already present in the

'presets' or 'user presets' locations, then the preset will reference that existing image.

If the image being referenced is outside of your existing presets and userpresets location, then the

image will be automatically converted into the .tx file format and saved into the textures folder of

your userpresets.

The images file gets a random string as a filename, an example would be: 3735509F-BEE7-DCDC-

DE0B-4D85F1D25426.tx

In addition, the user stored preset data (xml) file also gets a random string file name.

The advantage of giving the user presets and image files random string names, is that the user does

not need to concern themselves with naming conventions in order to store their presets. What is

important for the user is to provide a good description and tags in order to make it easy to find and

use the preset in HDR Light Studio.
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Light Looks Panel

New in Xenon Drop 2

The lighting process is about creativity and experimentation. There are so many lighting decisions to

make and so many different approaches you can try out. Light Looks allow you to easily store,

compare, duplicate and edit multiple lighting designs in a single HDR Light Studio project -

supporting your creative lighting process.

Light Looks Summary

· Light Looks allow multiple lighting designs (Light Lists) in a single HDR Light Studio

project

· Click on a Look to make it active. The Light List panel lists lights from the active Look

· Only one Look can be active at a time

· Lighting Looks works with all HDR Light Studio light types - both lights on the HDRI map

and Area Lights

· Looks are organized in a tree hierarchy

· The lighting for your shot includes the active Look and all parent lights from further up its

tree hierarchy - highlighted with white text. Inheriting lights from higher up the tree
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allows multiple child looks to have lights that edit/augment the parent look. This enables

more creative ideas to be explored with a common editable base lighting design.

· All Looks are embedded in your host 3D software via the single HDR Light Studio project

file

· Looks can be deleted and duplicated - child looks will be deleted and duplicated too.

· You can create as many Looks as you want

Next: Let's take a look at the uses for Light Looks
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Light Looks Uses

What can you use Looks for?

Try Different Lighting Looks

Kind of goes without saying... but..... you can use Light Looks to create distinctly different lighting

moods or styles for the same shot. These are all stored in the same HDR Light Studio project. So once

you or your client chooses their favorite Look it's easy to select it and produce the final lighting for

your scene or to make further tweaks. Previously you would need to save out multiple HDR Light

Studio projects and load them, which is far slower and also means all those lighting designs are not

stored in the host 3D software's project.

Lighting Styles shown with VRED (Animated GIF)

Saving Lighting Iterations

Save off iterations as the lighting design evolves over time, a history of your lighting project. Then

easily compare earlier versions with the current version to decide if the lighting has moved in a good

direction.

You can easily go back to an earlier version and carry on where you left off.
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Lighting Iterations shown with VRED (Animated GIF)

Lighting for different Cameras

In a single HDR Light Studio project, you can now set up a lighting design for each camera view. So

you no longer need to save multiple scenes file in your host 3D software for each camera.
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Lighting for different cameras shown with VRED (Animated GIF)

Using Child Looks to make adjustments to a common Base Look

Imagine you have a product to light, but it comes in different colors. Set up a base lighting 'Look' as

the foundation for your lighting. Then create Child Looks to augment the lighting for each colorway,

i.e. adding different lights on top of the common base. So you have a family of lighting designs that

have a common theme.
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Edits to base lighting shown with VRED (Animated GIF)

Next: Let's take a look at the Light Looks User Interface
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Light Looks UI

In the Looks panel, you can not reorder Looks by dragging them, the order is fixed. Dragging over the

Looks will change the active Look as you drag.

Double click on a Look to Rename it.

Buttons

Create a New Look

This button creates a new Look at the same hierarchy level as the active Look. This is added at the

bottom of the tree.

Create a Child Look

This button creates a new Look as a child of the active Look. If the Look already has children, it will be

added at the bottom of the list.

Delete

Deletes the active Look, and all child Looks too.
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Duplicate

Duplicates the active Look, and all child Looks too. The duplicate Look will has the same name with

the word 'copy' added.

Right Click menu

Added in HDR Light Studio 8.2

If you right click on an entry in the Light Looks panel, you can access the same features found in the

buttons above.

Next: Let's take a look at how Light Looks Behave
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Light Looks Behavior

When starting a new HDR Light Studio Project, there is always a Default Look. There must always be

at least one Look in your project. You can close the Light Looks panel and not use the new Looks

feature. This will provide the same experience as using previous versions of HDR Light Studio,

working with a single Light List.

Clicking on a Look in the Light Looks panel will make it active and display its lights in the Light List

panel. Any Looks further up an active Look's tree hierarchy will also be highlighted with white text. All

Looks up the tree with white text have their lights included on the Canvas and used to light the shot.

Inheriting lights from the parents in this way is a useful feature - allowing the creation of multiple

lighting designs sharing a common set of parent lighting. Looks can have Children many levels deep.

Below we show how the lights are added together to light your shot using the Looks tree hierarchy.
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Commands in the Edit menu including the wording 'All', like 'Delete All', will only operate on the

active Look. This will not delete all lights in all Looks.

When Soloing a light in the light list, parent lighting will also be hidden, so you only see the solo lights

from the current Look.

When rendering the production HDR content (using the HDR button), the active Look and parent

lighting that you see on the canvas and lighting the shot is rendered.
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Color Picker

Press the color swatch squares in property panels to launch the Color Picker and select a new color.

Color Picker

To pick a new color click on the color spectrum. Each new color you pick changes the bulb color on

the canvas and in the render view to provide instant visual feedback as you make your color

decisions. Having picked a color on the spectrum use the color tuning grid for fine selection. The

magnification buttons select a range of similar colors centered on the selected color. Magnification

x16 gives a wider range of colors. Magnification x2 gives a narrow choice. Use the value control to

change the brightness of the color - although brightness is typically controlled using the Brightness

slider for the bulb.

You can lock the hue and just vary the saturation by pressing the Ctrl key and moving the mouse

vertically on the color spectrum. To keep the same saturation and vary the color, press the shift key

and move the mouse left and right.
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Ctrl - Hue Lock Shift - Saturation Lock

To save a favorite color just drag a color from the tuning area to the user storage area. Colors stored

here are saved in your project file.

Image Color Matching Tool

To help you pick the right color, you can pick colors from an image using the Image Color Matching

Tool.

You will be prompted to select an image to load. Supported formats are HDR, EXR, TIFF, JPEG and

BMP.
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Image Color Matching Tool

There are 3 ways to pick a color from the image.

1. Point - use the cross to select a color from the image.

2. Rect - draw a rectangle over the image to get an average of the colors within that area.

3. Lasso - trace a free form irregular shape over the image to get an average color of the pixels

within your selection.

The image can be displayed in one of 4 color display modes.

1. HSV - this mode shows the complete image in HSV. Use the exposure control to explore the detail

in the shadows and highlights of HDR images. The Color Picker window only shows the colors

used in the image.

2. Color - this mode shows the true color content of the HDR image. All brightness values are

ignored and only the hue and saturation values are displayed.

3. Dominance - this mode displays the color in the very brightest parts of the image. This view helps

you understand the colors that will be predominantly lighting your scene.
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4. Coverage - this mode shows the most used colors if the brightness is ignored.

Numeric Color Input

Another way to pick colors is by entering the color channel values numerically.

Numeric Input Dialog

Values can be entered as RGB, HSV, CIE-XYZ or CIE-LAB formats. If an invalid color entered a warning

dialog is shown and the nearest color selected.

Kelvin Color Matching Tool

Colors can be selected using the color temperature values in the Kevin Color Matching Tool.
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Color Temperature Dialog

Pick colors from the slider or the presets.
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Customizing the Interface

Interface Panels can be scaled by positioning the cursor on the black space between panels.

The space highlights orange and the cursor changes to indicate you can click and drag to scale the

panel.

Interface panels can be closed using the Cross button in the top right corner.

Interface Panels can be opened and closed using the Window menu, which lists all available

interface panels.
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In addition the HDR Light Studio interface can be forced to draw on top of any other applications

using the Always On Top option.

This is useful when using HDR Light Studio connected to your 3D software and you don't want it to

disappear behind the 3D app when it gets focus.

Click and drag on the Panel Name at the top of a panel to undock it from the main interface.

It can be dropped between existing panels, which will separate and create a new space for the

panel.

Dropping an interface panel directly on top of another will cause the panels to be 'tabbed'.

Blue highlights give you an idea of how the interface will adapt when you drop the panel.
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To detach a tabbed panel you must click and drag on the name of the panel at the top of the panel, and

not drag on the tabs!

New in Tungsten Drop 3 - Undock Button

Press the new Undock button to undock the interface panel, so its now floating. But as you move it,

it will want to snap back into the interface.

If you press CTRL key (Command on MacOS) and the Undock button, this will float the panel so it

will not snap back into the user interface when moved over it.

Undock button

To return the floating panel back into the interface, double click the top bar of the floating panel,

and it will return to its last docked position.
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Double click the top bar of the floating panel
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Saving and Loading Interface Layouts

HDR Light Studio stores it's interface layout depending on which connection it is being used with or if

it is being used standalone.

For example, if you use HDR Light Studio standalone your current interface layout will be stored for

standalone use when closing HDR Light Studio.

If you then switch to using HDR Light Studio connected with 3ds Max, the default 3ds Max UI layout

will load in HDR Light Studio. If you change the layout, this will be stored as the UI layout next time

you run HDR Light Studio with 3ds Max.

It works like this because depending on which 3D software is connected with HDR Light Studio, you

may need a different UI layout with each one. One interface layout does not suit all. This is an

improvement made in HDR Light Studio (Carbon Release).

Loading Default Interface Layouts

HDR Light Studio includes default interface layouts depending on which Connection you are using

HDR Light Studio with.

Go to Window > Layout > Load > Default and Choose which you would like.

You can use this to reset the interface layout if you have changed it, and want to return to the default.
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If you have set up an interface layout that you would like to store. HDR Light Studio provides user

assignable layouts.

Simply go to Window > Layout > Save and select one of the 4 slots. You will be prompted to name
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the layout and it will then be stored.

User layouts can be loaded from the User section of the Load menu.

Please bear in mind when storing your layout, it will include which display the panels were located on

also.
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Keyboard Shortcuts

You can download a PDF of these keyboard shortcuts from here.

https://lightmap.s3.eu-west-1.amazonaws.com/docs/HDR_LIGHT_STUDIO_8-2_KEYBOARD_SHORTCUTS.pdf
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Production Rendering Dialog

When using HDR Light Studio, proxy lighting content (HDRI map and Area Light images) is used to

keep the software fast and responsive. But when the lighting process is complete, this low resolution

content needs replacing with higher quality (sub-sampled), high resolution imagery. We call this

stage a 'Production Render'.

Press the 'Render Production HDRI' button on the toolbar (HDR) to open the Production Render

dialog.
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Production Render dialog

Map Settings

Orientation

When using HDR Light Studio in a connection with your 3D software, the Orientation setting will

display the name of your host 3D software and chosen renderer. This is automatically set by the

connection so that the HDRI map is rendered correctly for your 3D software/renderer combination.

We need this setting to overcome that different 3D software and renderers use different default

orientations for their image based lighting sphere/dome, i.e. both sphere horizontal rotation and

horizontal mapping direction of the HDRI map.

These settings apply a rotation and optional image flip to HDRI map output, to ensure the lighting

positions are correct in your 3D software/renderer.
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When using HDR Light Studio standalone, use the two Orietnation drop downs to ensure the image

based lighting in your 3D software/renderer is correct. The default setting is Canvas, this means no

rotation or flip will be applied. If your 3D software/renderer combination is not listed, you can choose

Custom and manually set a rotation value and optional flip.

These are the only settings you would need to test to find a match for your unlisted 3D

software/renderer.

Rotation 0 - Flip Off

Rotation 90 - Flip Off

Rotation 180 - Flip Off

Rotation 270 - Flip Off

Rotation 0 - Flip On

Rotation 90 - Flip On

Rotation 180 - Flip On

Rotation 270 - Flip On

The rotation and flip settings for each combination in the drop down menu is stored in am XML file

called 'HostPresets.xml'. This is located next to the installed HDR Light Studio executable file. This file

can be edited by a more advanced user, to add new host/renderer combinations.

Resolution

Sets the pixel resolution of the output HDRI map image. Includes a list of preset sizes, or a Custom

option, where the user sets the width of the HDRI map.

Format

Determines the file type used to save the HDRI map. In most situations it is best to select the EXR

image format as it is the highest quality format.

Area Light Settings

Resolution

Area light content is always rendered as a square image. Use this setting to set the width and height

pixel dimensions for the output images for area lights.
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Format

Displays the output image formats generated for the area lights. Currently this is set by the host app

that is connected to HDR Light Studio. Area Lights can be represented by one or two output images

depending on the requirements of the renderer. We need two images sometimes to correctly set up

the light to honor an alpha channel.

Options

EXR Options

With EXR set as the output format, these options control additional output settings.

Color Profile

You can set a color profile transform for the output images. This would change the lighting effect of

the content and is not advisable to use, unless for an artistic effect.

Fast Preview

Normally the rendered output content is super sampled. If you want a faster output render, you can

turn on Fast Preview, and the image will get only one sample per pixel, making it much faster but

with more jagged edges to lights.

Thumbnails

Enable this option to save a thumbnail versions of the HDRI map and area lights as PNG files at

render time. Many operating systems do not provide preview images of HDR content, so it can be

handy to have thumbnails to help identify lights. These can also be useful for asset management in

larger pipelines.

RenderView

Enabling this option saves the currently open Render View images as a PNG files with the display LUT

baked into those images. The images will have a suffix to identify which view they came from, for

example:

the_file_name_(3DSMax_VRay).png

the_file_name_(HDRLightStudio).png

Project

Enable this option to save a Project File (HDi) of the current lighting design at production render

time. This provides a handy very snapshot of the lighting design that shares the exact same file name

as the HDRI map produced. This provides an interesting new workflow, where you could decide not

to use the normal Project Save method, and only save projects at render time, the perfect time to

capture the project associated with the output image set.
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Output

Master File

Use the Browse button to choose the location for your rendered content, and to set the Master File

name.

This file name will be used for the HDRI map and as the start of the file names of all the other

content files produced at render time.

For example, if the Master File name is Mobile_Phone_Job_Lighting_01

Here is what a set of content would look like if we enabled options for Save Thumbnails, Save Render

View and Save Project:
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Project Assets Dialog

HDR Light Studio projects contains references to a range of files. These include: Images used on

lights, the Render View background image, and the 3D scene file loaded in the Render View. Using

the Project Menu, you can select 'Manage File Links' to open the Project Assets panel. This displays a

list of all referenced files used in the loaded project.

File paths are stored as absolute and not relative - so for preset images this path includes the user

directory name. If you move a HDR Light Studio project between 2 different computers with 2

different user names, the preset image texture paths stored in the project file are invalid. However,

in HDR Light Studio 8.1 and higher, HDR Light Studio will now automatically find the image textures

in your local presets path and update the file paths stored in the project. This allows HDR Light

Studio projects to be moved between computers without needing to relink missing preset textures.

You can delete an image link to a file by pressing the red cross next to the file path in the Project

Assets.

Missing Images

If referenced images can not be found by HDR Light Studio, then the content is shown as solid red.

You can use the Project Assets dialog to see the actual path and file name that is being referenced by

HDR Light Studio, and therefore identify which file is missing. You can change the file being

referenced by double clicking on the file path in the Project Assets panel, and browsing to an

alternative file.
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Example of missing referenced file. Light is shown solid

red.
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Application Preferences Dialog

The application Preferences can be found under the Edit menu on Windows/Linux (and the HDR

Light Studio menu on Mac).

Preferences Dialog

License Directory

This folder contains the RLM license keys required to run HDR Light Studio. Click Choose... to open a

file browser and select an alternative directory. Click 'Default' to reset the directory to the default

location. Click Open... to launch a file browser showing this directory.

Dump License Info

Enable this check box to include license information in logs. This is off by default. Only turn this on if

asked by Lightmap support to do so during a support case.

Preset Directory

This directory contains the .tx image files and .xml files that define the preset lights supplied by

Lightmap. They take up a lot of space, so you may wish to share these on a central disk drive rather

than duplicated for each user.
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User Preset Directory

This directory contains the .tx image files and .xml files that define the preset lights saved by the

user.

Proxy Directory

This is the root folder for temporary image files (image cache) written by HDR Light Studio. When we

run HDR Light Studio through a connection to a 3D app, we create a sub directory called

HdrlsBuckets in the Proxy Image Directory in which we store temporary environment maps (HDR or

EXR) that are passed from HDR Light Studio to the 3D app like Maya, 3ds Max or Cinema 4D. These

are used to light the scene using the renderer in the 3D app. The HdrlsBuckets directory is deleted

when the application is closed. By default the Proxy Image Directory is on your local machine under

your user directory. This preference allows you to specify a shared network directory for this image

cache. This is useful when using network rendering for your lighting previews.

Proxy Map Size

This defines the horizontal size of the HDRI map used to light the Render View and shared with 3D

apps. In Demo (unlicensed) mode only the smallest proxy size is selectable.

Proxy Area Light Size

This defines the horizontal size of the area light HDR content used in the Render View and shared

with 3D apps. In Demo (unlicensed) mode only the smallest proxy size is selectable.

Smart Dolly Scalar

All Area Light's Smart Dolly distances are multiplied by this value. If a very small model is being lit

with HDR Light Studio (or has been exported using meter units and is therefore small in HDR Light

Studio units), then reduce this value so that Smart Dolly moves Area Lights over smaller distances.

Preset Thumbnail Size

Choose the size for the thumbnails shown in the Preset Library panel.

Image Cache

This defines how much RAM HDR Light Studio uses to store images. If you find your renders are very

slow (due to swapping), increase this value.

OCIO Config

This is the location of your OCIO configuration file. Some example OCIO files are shipped with HDR

Light Studio in the OCIOConfigs subfolder. For example:

Windows - C:\Program Files\Lightmap\HDR Light Studio\OCIOConfigs\

Mac OS X - /Applications/HDRLightStudio.app/Contents/MacOS/OCIOConfigs/
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This is set using the OCIO environment variable.

OCIO Default View

Sets the default LUT to use in the Canvas, Render View and Light Preview panels.

Log Directory

This is the location of the diagnostic information written out by HDR Light Studio. This is set using

the HDRLS_LOG_FILE environment variable.

Log Level

This indicates the verbosity of the diagnostic information. 0 is succinct, 5 is wordy. This is set using

the HDRLS_LOG_LEVEL environment variable.

Display Scale

Shows the interface scale as set by the Environment Variable - HDRLS_SCALE_GUI.
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Resetting Application Preferences

Resetting HDR Light Studio application settings can be useful if you have lost one of the HDR Light

Studio interface panels on a display that is no longer connected, and you are unable to retrieve it.

Resetting all application settings will return the interface, and all other settings to their default

values.

Windows Instructions:

Open a Command Prompt

1. Press the Start button on Windows Desktop

2. Start typing: Command Prompt

3.  Command Prompt will appear in the start list - click on this to open the Command Prompt window

The Command Prompt window is now open

Navigate to where HDR Light Studio is installed

4. For a default installation of HDR Light Studio type: cd C:\Program Files\Lightmap\HDR Light Studio
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5. Press Enter, you are now inside the HDR Light Studio application directory.

6. Clear the settings by typing: HDRLightStudio.exe removesettings

7. Press Enter and HDR Light Studio will briefly start in the background, reset all its settings to

default values, and then exit. The next time you run HDR Light Studio it will run with default

application settings.

Mac OS Instructions:

Open a terminal prompt

1. Press CMD + Space Bar

2. Start to type Terminal
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3. Terminal - Utilities will appear in list - double click on this.

The Terminal Window is now open

Navigate to where HDR Light Studio is installed

4. For a default installation of HDR Light Studio type: cd /Applications/
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5. Press Enter

6. Clear the settings by typing: ./HDRLightStudio.app/Contents/MacOS/HDRLightStudio removesettings

7. Press Enter. HDR Light Studio will briefly start in the background, reset all its settings to default

values, and then exit. The next time you run HDR Light Studio it will run with default application

settings.

Linux Instructions:

1) Open a terminal prompt

2) Navigate to where you have installed HDR Light Studio

3) Clear the settings by typing: ./hdrlightstudio removesettings
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4) Press Enter

HDR Light Studio will briefly start in the background, reset all its settings to default values, and then

exit. The next time you run HDR Light Studio it will run with default application settings.
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Enter Activation Code Dialog

At any time you can activate additional activation codes in HDR Light Studio by using the Help menu

and selecting Enter Activation Code. You may want to do this for example if you purchased the

main HDR Light Studio app and used it standalone. But decided to buy a connection at a later date

and received a new activation code for the connection. This is how you would enter the additional

activation code to retrieve your new license.
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License Management Dialog

The License Management dialog reports what licenses HDR Light Studio can see.

Product - Name of the product the license will run.

Terms - The commercial terms of the license (i.e. Commercial or Educational)

Version - This date (YYYY.MMDD) represents the latest build version this license will run, it is also the

expiry date for your maintenance.

Expiry - If the license is a subscription license (not permanent), this shows the expiry date of the

license. After this date the product will no longer run.

Days Left - How many days until the license expires.

Press the Run Diagnostics button to generate a text file containing RLM License Diagnostics. You

may be asked for this file when working with support on licensing problems.
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About Dialog

The About dialog can be opened from the Help menu. It displays information that can be very useful

when getting help from Lightmap technical support.

Build

Shows the build number of the running HDR Light Studio app, the build date is on the end in format

YYYY.MMDD

License Expires

Shows the license type and expiry date on the license being used, or if it is Permanent.

Render View

Displays the version number of the rendering engine used in HDR Light Studio's own render view.
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Current Plugin Version

Where possible displays the version number of the plug-in that is connected to the current HDR

Light Studio session.

Mac Address

Primary mac address for the machine.

Project

Shows the path and file name for the current project if it has been saved.

API Versions

Shows the API version being used by the connected 3D app.

Copy Details to Clipboard button

This button will copy the details shown on the About Box, plus many other relevant settings, so that

these details can be pasted into an email being sent to support.

These details enable us to get a better understanding of your installation and trouble shoot your

problems.
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OCIO Color Management

HDR Light Studio uses OpenColorIO color management. For further information on OpenColorIO see

http://opencolorio.org/

You may already be using OCIO on your computer and have a path set for your OCIO config file by

using an Environment Variable. If you have, HDR Light Studio will honor the OCIO environment

variable. You can see this by going to Edit > Preferences in HDR Light Studio.

Panel shows that OCIO Config is set with Environment Variable

If no environment variable is set, HDR Light Studio will default to loading the hdrlightstudio OCIO

config installed with HDR Light Studio. A range of OCIO configs are installed in an OCIOConfigs

http://opencolorio.org/
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folder, next to the HDR Light Studio application. For example on Windows this location is: C:\Program

Files\Lightmap\HDR Light Studio\OCIOConfigs

You can place additional OCIO folders containing config files in that location. The name of the folder

will be the name of the listed config. But beware, this folder's contents is replaced when reinstalling

HDR Light Studio.

When HDR Light Studio starts it reads all settings in the OCIOConfigs folders. Go to Edit >

Preferences and use the dropdown to select the OCIO Config you want to use. You will need to

restart HDR Light Studio after this.

On the HDR Light Studio Preferences panel, the OCIO Default View setting will determine which LUT

is applied to the interface: Presets Library thumbnails, Canvas and Light Preview images.

There are 3 areas in HDR Light Studio where OCIO Color Management is used:
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1. User Interface Display

All lighting content inside HDR Light Studio is handled in linear format - i.e. no color transform =

ground truth values. For example, the Render Views, Light Preview and Canvas are all displaying

linear image data. So, in order for them to look correct on your display, a display LUT/Color Profile

needs applying to this data.

As mentioned above, the OCIO Default View setting in the Preferences panel is applied to Presets

Library thumbnails, Canvas and Light Preview images.

The color settings for the Render Views are set via the interface. The color settings for the Render

Views are explained here.

2. Loaded Images

When loading an image into HDR Light Studio, a Color Profile is set for the image. By default this is

Linear, as we expect to mostly be loading HDR lighting content.

If you do choose a LUT, this Color Profile should tell HDR Light Studio the color profile already baked

into the values of the image. HDR Light Studio will then apply a 'reverse' transform to convert the

image into linear.

Below shows a low dynamic range image of a flower that has sRGB baked into its values. On the left,

the image is washed out, becuase the sRGB image is having a display LUT of sRGB applied to it. So

the image looks brighter than expected and the colors washed out. On the right, you can see what
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happens when the color profile sRGB is selected. The flower image looked correct now it has been

converted into linear color space, with a display LUT of sRGB.

3. Production Render (HDR Output files)

When producing production renders of your HDR content. There is an option to set a Color Profile for

the output. It is very rare you would want to use this as it would destroy the integrity and lighting

look you had created in HDR LIght Studio. We suggest always using a setting of linear or raw. But it

does allow a Color Profile to be used perhaps to change the lighting look to a specific feel.
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Setting an OCIO Environment Variable

The OCIO environment variable allows you to specify your OCIO config file. Here's an example

pointing to some Nuke defaults that ship with HDR Light Studio:

OCIO = C:\Program Files\Lightmap\HDR Light Studio\OCIOConfigs\nuke-default\config.ocio

Please note: When specifiying the OCIO path, slashes should be the correct way for the platform you are on,

and not doubled up. 

For example: \\cgi-shotgun\library\OCIO_Configs\aces_1.2_marks\config_marks_01.ocio 

and not \\\\cgi-shotgun\\library\\OCIO_Configs\\aces_1.2_marks\\config_marks_01.ocio



594

594HDR Light Studio - User Guide

Environment Variables

HDR Light Studio has a range of environment variables that can control it.

Instructions on how to add Environment Variables can be found on this page, showing how to set

them up for Logging, but the same process can be used for all the environment variables below.

HDRLS_HOME_V5

If you intend to use HDR Light Studio with a connection to a 3D apps such as Maya, 3ds Max and

Cinema 4D, you will need the environment variable HDRLS_HOME_V5 set on your system pointing to

the directory containing the HDR Light Studio executable. This tells the plug-in connection where to

find the HDR Light Studio application. This environment variable is required for all platforms, it is

setup for you automatically on Windows and MacOS during installation, but for Linux will need

manually configuring as there is no set installation process.

HDRLS_USER_DIR

The HDR Light Studio user directory by default contains folders containing these files that HDR Light

Studio needs: license files, presets, user presets, presets cache and favorites preset settings file.

With a default installation this path will be, for example on Windows: C:

\Users\Username\AppData\Local\lightmap

If you wish to store these files in a different location, you can set the environment variable

HDRLS_USER_DIR.

For example:

HDRLS_USER_DIR = \DiskName\HDRLS_DATA\USER\

HDR Light Studio currently supports ASCII characters only in file paths. Therefore you may want to use this

setting if your OS account username contains none ASCII characters, in order for HDR Light Studio to work

properly. For example when using HDR Light Studio with 3ds Max. (Please note: Other Connections may not

currently function correctly, even after using this override when you have a none ASCII character in your

username).

HDRLS_TEMPRENDER_DIR

When using HDR Light Studio, it create's temporary files shared with your 3D software, and

temporary files during rendering.

With a default installation this path will be, for example on Windows: C:

\Users\Username\AppData\Local\Temp\

Files will be created within subfolders in that location, for example all temp image files are stored in:

HdrlsBuckets_Lightmap Ltd

If you wish to store these files in a different location, you can set the environment variable

HDRLS_TEMPRENDER_DIR.

For example:

HDRLS_TEMPRENDER_DIR = \DiskName\HDRLS_DATA\TEMP\
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HDR Light Studio currently supports ASCII characters only in file paths. Therefore you may want to use this

setting if your OS account username contains none ASCII characters, in order for HDR Light Studio to work

properly. For example when using HDR Light Studio with 3ds Max. (Please note: Other Connections may not

currently function correctly, even after using this override when you have a none ASCII character in your

username).

HDRLS_LOG_FILE

Diagnostic information can be written to a text file while using HDR Light Studio. Just set the

environment variable HDRLS_LOG_FILE to a text file in a directory. The directory path must exist but

the log file will be created on starting HDR Light Studio.

For example, on Windows:

HDRLS_LOG_FILE = C:\Users\Username\Documents\lightmaplogs\hdrls.log

Every time the app is launched the old log file will be renamed and a new log file created. This value

can been seen (if set) in the Preferences dialog.

HDRLS_LOG_LEVEL

The verbosity of the diagnostic information written to the log file can be controlled with the

environment variable HDRLS_LOG_LEVEL. Values range from 0 (a little information) to 5 (full

information).

For example, on Windows:

HDRLS_LOG_LEVEL = 1

This log level value can been seen (if set) in the Preferences dialog.

HDRLS_PRESETS_DIR

Larger studios may wish to set an environment variable (in a login script maybe) to point all their

artists to a central server storing the Preset Lights. These are over 8GB of files at the moment, and it

will save time needing to install these files on each users machine. This setting will override the path

set with HDRLS_USER_DIR environment variable.

For example:

HDRLS_PRESETS_DIR = \DiskName\HDRLS_Presets\

HDRLS_LICENSE_DIR

Large studios may wish to set an environment variable (in a login script) to point all their artists to a

central location for their license keys. This is useful when there is a floating license server. Every user

will have the same client.lic file pointing to the same licenses server. This way if the license server is

updated, changing the single client.lic file in the central location will let all HDR Light Studio seats use

the new floating license server. This setting will override the path set with HDRLS_USER_DIR

environment variable.

For example:

HDRLS_LICENSE_DIR = \DiskName\HDRLS_Licenses\
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OCIO

OpenColorIO (OCIO) is a complete color management solution geared towards motion picture

production with an emphasis on visual effects and computer animation.

Lightmap supports OCIO in HDR Light Studio. By default HDR Light Studio ships with a set of OCIO

config files located here for example on Windows: C:\Program Files\Lightmap\HDR Light

Studio\OCIOConfigs

The OCIO environment variable allows you to specify your OCIO config file.

Here's an example pointing to some Nuke defaults that ship with HDR Light Studio:

OCIO = C:\Program Files\Lightmap\HDR Light Studio\OCIOConfigs\nuke-default\config.ocio

Please note: When specifiying the OCIO path, slashes should be the correct way for the platform you are on,

and not doubled up. 

For example: \\cgi-shotgun\library\OCIO_Configs\aces_1.2_marks\config_marks_01.ocio 

and not \\\\cgi-shotgun\\library\\OCIO_Configs\\aces_1.2_marks\\config_marks_01.ocio

This value can been seen (if set) in the Preferences dialog. For further information see

http://opencolorio.org/

HDRLS_SCALE_GUI

Forces scale of the User Interface through HDRLS_SCALE_GUI environment variable. The value

represents the scale size you want. 1 = 100%, 2 = 200% etc.

For example, to double the scale of the UI:

HDRLS_SCALE_GUI = 2

HDRLS_TMPDIR_OVERRIDE

This environment variable changes the location of our system mutexes from the default posix

TMPDIR location to that specified in the new environment variable. This allows customers that have

non-standard and custom setups to set it to somewhere else so that HDR Light Studio can actually

run. The directory set must have already been created.  We will not create it if it is not found.

Plug-in Connection TCPIP API Communication Ports

Some plug-ins use our new TCPIP based API which is nice and fast. In rare occasions, our default

TCPIP port settings for communications can be in conflict with other software. For example, Teradici

PCoIP remote protocol uses port 5555 and prevents HDR Light Studio from working with default

settings.

Here are the Environment Variables you can set to change the port settings for HDR Light Studio

TCPIP communication.

HDRLS_LOCAL_PORT  The default setting without an environment variable is: 5555

HDRLS_REMOTE_PORT  The default setting without an environment variable is: 5556

http://opencolorio.org/
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HDRLS_HEARTBEAT_SVR_PORT  The default setting without an environment variable is: 5557

HDRLS_HEARTBEAT_CLI_PORT  The default setting without an environment variable is: 5558
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Generating Log Files

Overview

Logging in HDR Light Studio is enabled by setting two Environment Variables within your operating

system. HDR Light Studio looks at these settings at start-up.

The environment variables are:

HDRLS_LOG_FILE

This variable tells HDR Light Studio the file name and path for the log files, there can be more than

one file created, with it's name based off the name you give it.

HDRLS_LOG_LEVEL

This variable tell HDR Light Studio the level of detail to produce in the log files. The range is from 0 to

5.

0 = off

1 = minimum

3 = some detail, not too much noise

5 = maximum

Setting Up Logging on Windows

1. Open Windows Settings by going to your start menu and searching for "Settings"

2. Within the Search Box type "Environment Variables" and select "Edit the System Environment

Variables" this will open the the System Properties window
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3. Click on "Environment Variables" to open the editor 

4. Select "New" under System variables 



600

600HDR Light Studio - User Guide

5. Type in the below variables, pressing OK after each

Make sure you provide a path that has access rights for the user. In this example the main log is

saved on the desktop, and the file is called: HDRLS.log
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In this example we set logging level 3.

6. Those variables should now show in the System Variables list, after which you can press OK to save

and exit this window 

Please note: You can set HDRLS_LOG_LEVEL to 0 to turn logging off, if you want to leave the

environment variables in place to use again in the future.
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Setting Up Logging on MacOS and Linux

The easiest way to set this up is to add an Environment Variable in the Terminal and then use the

Terminal to start your 3D software.

Open a Terminal and type the following to create a log file in your home directory:

export HDRLS_LOG_FILE=~/hdrls.log

export HDRLS_LOG_LEVEL=2

Now you need to run your 3D software (e.g. Cinema 4D) from this Terminal:

cd <Path_to_3D_Software>

When it comes to entering the <Path_to_3D_Software> part, you can type the cd (and space), then

drag and drop the main 3D software onto the terminal window - it will paste the path in for you

Now type:

cd Contents/MacOS/

Then start your 3D software by typing ./Cine then press TAB to autocomplete the path. For example:

For Cinema 4D, you would end up with something like

./Cinema\ 4D

Your 3D software will now start. Now if you look in your home directory, you should see 2 log files:

1) hdrls.log

2) hdrls.log.live.log
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maketx

Lightmap supplies a command line utility called maketx that is used to convert images to a tiled,

MIP-mapped format. Using images that have been converted with maketx will dramatically improve

the import time and performance of these images in HDR Light Studio. Maketx is part of

OpenImageIO (http://www.openimageio.org).

How much faster is it?

Well, that depends on the image size, but for a large image, it is much faster. For example, on an Intel

Core i7 CPU 1.87GHz computer, a tiff file of resolution 20,000x10,000 pixels RGBA 32 bit takes 4

minutes and 45 seconds to load as a picture background light in HDR Light Studio. If that file is first

converted using maketx it takes 2 seconds to load in HDR Light Studio.

Usage

maketx [options] file.exr

You can display a complete list of options using the help flag

maketx --help

Here is an example that converts an exr file to a tiled, MIP-mapped exr file suitable for use in HDR

Light Studio. The  --envlatl flag indicates that we are creating a lat/long environment map. Box

filtering is used if no filter algorithm is specified.

maketx -v --oiio --filter lanczos3 --format exr --envlatl -o outputfile.tx inputfile.exr

When using maketx make sure you add the --oiio flag which will generate tx files optimised for HDR

Light Studio.

Install Directory

Maketx is included with the installation of HDR Light Studio. You can find maketx in the following

directories.

Mac OS X - /Applications/HDRLightStudio.app/Contents/MacOS/maketx

Windows - C:\Program Files\Lightmap\HDR Light Studio\maketx

Linux - <install directory>/maketx

http://www.openimageio.org)
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Converting files in HDR Light Studio

HDR Light Studio will detect and warn you on loading a large image file that has not been tiled and

MIP-mapped.

Warning dialog

You are given the option of canceling the image load, opening the file without converting it, or

converting the file and then opening that tx file. Please note that converting the file can take many

minutes during which time you will be locked out of HDR Light Studio.
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Connections (Plug-Ins)
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Connections (Plug-Ins)

HDR Light Studio - Connections

· Introduction to Connections

· Legacy Keyshot Connection Notes

· Common Connections Issues
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Introduction

Connections create a bridge between HDR Light Studio and your 3D software, so that the lighting can

be synchronized in your 3D software whilst working in HDR Light Studio.

This means you can start an interactive rendering session in your 3D software to see the result of the

lighting from HDR Light Studio. This provides a great lighting workflow.

One Connection at a time.

Only one session of HDR Light Studio can be run at once on your computer. Therefore only one

'connection' to HDR Light Studio can be active at any time.

For example, running 2 sessions of Maya and trying to Start HDR Light Studio with both will cause

problems.

Where it can, an error message will appear when you try to do this with a connection:

Unable to Start.

HDR Light Studio is already using another Connection.
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3ds Max Connection

The 3ds Max Connection is a plug-in that creates a bridge between HDR Light Studio and 3ds Max.

As the HDRI map and Area Lights are created in HDR Light Studio, 3ds Max is kept in sync.

Supported Renderers: V-Ray, Corona, Octane, Arnold, Maxwell, Redshift, Art Render, FStorm

· Installation

· Interface Overview

· Usage - Method 1
These instructions are for those using 3ds Max 2021 / 2022 / 2023 with

V-Ray, Corona, Redshift or Arnold

Workflow

· Usage - Method 2

· These instructions are for those using 3ds Max 2021 / 2022 / 2023 with

Octane, Maxwell, Art Render or FStorm

Workflow

· Managing Performance/Resources

· Renderer Specific Notes

· Release Notes
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Installation

Installing on Windows

Uninstalling
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Installation - Windows

Important Note:

You should install the main HDR Light Studio application first, prior to installing our 3ds Max

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both 3ds Max and HDR Light Studio app are not running prior to installing our 3ds

Max Connection plug-in.

1. Download the 3ds Max Connection plug-in file from our web site.

2. Unzip the file.

3. Run the appropriate installer for your version of 3ds Max. For example

3dsMax2016_Win_2016.0805.exe

4. Make sure the 'Add HDR Light Studio Connection entry to the 3ds Max XXXX Rendering

menu' tick box is enabled when running the installer.
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5. Start 3ds Max. You will now see the HDR Light Studio Connection entry in the Rendering menu.

6. To open the HDR Light Studio connection panel, choose Rendering > HDR Light Studio

Connection from the 3ds Max menu bar. This panel is dockable in the 3ds Max interface.

If you can not see this panel and are using 3ds Max 2018, please follow these steps
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This plug-in connection can run unlicensed (in demo mode) but will be limited in functionality. You

should proceed to Licensing to enjoy full functionality of the plug-in.

Please note: If the  'Add HDR Light Studio Connection entry to the 3ds Max 2016 Rendering

menu' tick box was not enabled, or was not showing on your installer, it can be manually

installed following these instructions.

1. Download the 3ds Max plug-in file from our web site.

2. Unzip the file.
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3. Run the appropriate installer for your version of 3ds Max.

4. Start 3ds Max

5. From the top menu bar click on Customize > Customize User Interface...

6. In the Customize User Interface dialog click on the Menus tab.

7. In the list on the right hand side, expand the Rendering section and find the "Environment Dialog

Toggle"

8. From the Action list on the left hand side, find "HDR Light Studio - Connection" and drag 'n' drop it

just below the "Environment Dialog Toggle" on the right hand list.

9. Press Save and save the settings in MaxStartUI.mnux

10.  Close the Customize User Interface dialog.

Customize User Interface
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That's everything installed. To open the HDR Light Studio connection panel, choose Rendering >

HDR Light Studio Connection from the 3ds Max menu bar. This panel is dockable in the 3ds Max

interface.

Starting HDR Light Studio
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This plug-in connection will need a license key to work. You should now proceed to Licensing. For

information on using the connection see 3ds Max Connection.
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Uninstalling

To remove the HDR Light Studio plug-in connection for 3ds Max, run the uninstaller in the following

directory.

C:\Program Files\Lightmap\HDRLightStudioConnection3dsMax\
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Interface Overview
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Workflow 1

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to 3ds Max provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in 3ds

Max, where you can see the lighting interact with your 3D scene. You can also create and control

Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between 3ds Max and HDR

Light Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial

Requirements: 3ds Max 2021 / 2022 / 2023 with V-Ray, Corona, Redshift or Arnold. Not your renderer?

Click here to see Workflow - Method 2

STEP 1: Start 3ds Max and load the 3ds Max project you want to light (see Figure 1).

Make sure a camera is set up for your scene and that the correct renderer is set. In this example V-

Ray is used.

Figure 1: 3ds Max on startup after loading a project

STEP 2: Open the HDR Light Studio Connection plug-in panel

Go to the menu: Rendering > HDR Light Studio Connection (see Figure 2). Not seeing HDR Light

Studio Connection? See our installation instructions

https://www.lightmap.co.uk/learning/category/get-started/
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Figure 2: Opening 3ds Max connection panel

The HDR Light Studio Connection panel opens (see Figure 3). HDR Light Studio Connection panel did

not open? See our bug fix
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Figure 3: HDR Light Studio Connection panel

If you have a red cross next to 'Current renderer valid', it indicates that you are either using a

renderer that is incompatible with HDR Light Studio connection or it is incorrectly installed. 

STEP 3: On the HDR Light Studio connection panel, click on the 'Start' button (see Figure 4)

In order for HDR Light Studio to be started in a connection with 3ds Max and your renderer, an IBL

Hook is required to connect with.
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An IBL Hook is simply a valid Image Based Lighting setup (Dome Light / Environment Light), whose

HDRI map file can be replaced and updated by HDR Light Studio.

Figure 4: Starting HDR Light Studio Connection

STEP 4:  Create a new IBL Hook by providing a name for the hook in the 'Create New Hook for

VRay-Next' panel and press the OK button (see Figure 5).

During the start process, our plug-in detects if there are valid IBL Hooks, if not then we create one for

you.
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Figure 5: Creating a new hook

HDR Light Studio will now start, controlling the HDRI image file used on the new IBL Hook, unless

there are already valid IBL Hooks in your 3ds Max scene, a dialog will appear where you will be asked

to choose a Hook from the drop down, or there is an option to create a New Hook (see Figure 6).

Figure 6: Selecting an existing hook before HDR Light Studio

connection starts

HDR Light Studio will then start connected to the hook selected or the new one that was created (see

Figure 7).

The HDR Light Studio interface should look like in Figure 7.

If not in HDR Light Studio you can reset it by going to the menu: Window > Layout > Load > Default > 3ds

Max

Figure 7: HDR Light Studio on start up
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If we switch back to the 3ds Max interface, we can see the created environment that HDR Light

Studio has attached to, in this example called VRayLight001 (see Figure 8).

 

Figure 8: VRayLight001 node shown in the

outliner

The current HDRI map design in HDR Light Studio is shared with 3ds Max as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for 3ds Max to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is

updated in 3ds Max to use a new temp with a new file name, to ensure the renderer uses the new

image even when caching images.

The temporary file name and location will look something like in Figure 9. 
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Figure 9: File path points to a HDR Light Studio temp proxy image

STEP 5: In HDR Light Studio, press Play on Render View [3ds Max|VRay] (see Figure 10)

 Please note: If you start interactive rendering inside HDR Light Studio interface and your active

3D view in 3ds Max isn't set to camera view, then the camera list in Render View [3dsMax|V-Ray] will

be empty.
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Figure 10: Starting the Octane Render View within HDR Light Studio

HDR Light Studio now instructs 3ds Max to start an interactive render session with the current

renderer.

The interactive render image is now displayed in this Render View (see Figure 11).

To understand all of the features/controls for this view, see here.

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_host.html
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Figure 11: V-Ray render view working withing HDR Light Studio

 

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the chosen

location on the 3D model when using LightPaint (see Figure 12).
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Learn about LightPaint here.

Figure 12: LightPaint mode set to Reflection

STEP 6: Click on the Presets tab next to the Light List tab, to show the Preset Lights (see Figure 13).

Figure 13: Opening the presets tab to see a list of presets

STEP 7: Drag and drop a Preset Light onto the 3D model in the Render View [3ds Max|VRay] (see

Figure 14).

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 14: Placing a preset light onto the model
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The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

• A new light in the Light List in HDR Light Studio (see Figure 15).

• You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure 15).

• The 3ds Max environment has been updated to use the new live HDRI map from HDR Light Studio,

and the 3ds Max|VRay Preview Render updated using the new lighting (see Figure 15).

Figure 15: HDR Light Studio interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [3ds Max|VRay]

(see Figure 16).

STEP 8: Click on the 3D model to reposition the selected light from the Light List (see Figure 16).

The light is moved on the HDRI map, the new HDRI map is sent to 3ds Max and the Preview Render

updates.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where you

want them.
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Figure 16: Using LightPaint to paint lights on the model

If there is a delay of more than a second, or so, after clicking to move a light and see the updated

rendered result - the process will be slow and tedious.

In this situation we can use HDR Light Studio's built in renderer to speed up the lighting process.

 

STEP 9: Press the play button on Render View [HDR Light Studio] (see Figure 17)
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Figure 17: Starting up HDR Light Studio Render View

The Import Scene Geometry panel will pop up

STEP 10: Press Import (see Figure 18)

Figure 18: Importing the scene from

3ds Max to HDR Light Studio render
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You may need to use the Camera Drop Down in Render View [HDR Light Studio] to match the camera

view you are seeing from 3ds Max (see Figure 19).

Figure 19: 3ds Max|VRay render view (left) and HDR Light Studio render

view (right) side by side

The Render View [HDR Light Studio] renders the loaded scene lit with the current lighting design. A

simple shader is used on the whole scene to preview the light and reflections.

If you needed to open Render View [HDR Light Studio] to get a more interactive lighting

experience. Use this view for LightPaint, where clicking and dragging to position lights is

supported - it's fast and interactive.

The Render View [3ds Max|VRay] rendering will catch up eventually as you work, and will display an

image using the latest lighting.

 

If the Render View [3ds Max|VRay] is still so slow that it is of little benefit during the

interactive lighting process, and maybe it is also slowing down HDR Light Studio a lot, then use

the Pause/Play button to stop and resume rendering in Render View [3ds Max|VRay], in order

to do test renders from time to time (see Figure 20).
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Figure 20: Pause / Play for the render view

We have documented in more detail the process of using 2 render views together in HDR Light Studio here.

 

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area Light in 3D space in 3ds Max, mapped with the HDR content

from HDR Light Studio.

 

STEP 11: Enable the Area Light check box in the Light Properties panel for the selected light (see

Figure 21).

Figure 21: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

http://help.lightmap.co.uk/hdrlightstudio5/render-views-useage.html
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•   The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 22).

•   The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 22).

•   A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio with a

Smart Dolly distance of 1,000 (see Figure 22).

•   A 3D plane with emitter shader is created in 3ds Max, mapped with the HDR light content (RGBA),

this can be seen lighting the shot in Render View [3dsMax|VRay] (see Figure 22).

Figure 22: Light converted into an area light

STEP 12: Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure

23).
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Figure 23: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in 3ds Max. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

If we switch to the 3ds Max user interface, we can see:

•   The Area Light geometry in the viewport (see Figure 24) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here)  

•   An area light node made with HDR Light Studio in the Scene Explorer (see Figure 24)

•   Area Light shader in the Material Editor for the created area lights - mapped with HDR (RGBA)

content (see Figure 24)

Figure 24: 3ds Max interface after creating an area light

http://help.lightmap.co.uk/hdrlightstudio5/reference-area-lights.html
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STEP 13: Use LightPaint in the Render Views to move the Area Lights, just like moving a light on the

HDRI map (see Figure 25).

In fact, area lights are controlled just like any other light in HDR Light Studio, with the addition of

distance settings.

Figure 25: Using LightPaint to position the area light

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in 3ds Max (or any part of their associated shader

network/file nodes) will cause problems!

STEP 14: Enable Fast Area Light setting in the Render View panel  (Figure 26) for fast noise removal

on very big scenes (see Figure 27). 
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Figure 26: Fast Area Light checkbox

Figure 27: Painting area lights with Area Light Setting On (left) and Off (right)

STEP 15: Once you are happy with your lighting, press the 'Production Render' button in HDR Light Studio (see Figure

28).

Figure 28: Production Render buttons
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Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to '3ds Max/VRay', this ensures that the rendered HDRI map is mapped correctly in the

host, i.e. 3ds Max (see Figure 29). For more information see: Production Render Dialog

Figure 29: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update 3ds Max to use these final area lights and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be updated

to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced your

production lighting, by Pressing the Stop button (see Figure 30).

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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Figure 30: Stopping the HDR Light Studio

STEP 16: Save 3ds Max scene.

If you would like the HDR Light Studio project to be saved in your 3ds Max scene, you should save

your 3ds Max scene now. This way the scene state matches the HDRI map and area lights that are

currently in the project.

STEP 17: The below explains how to save and load HDR Light Studio projects.

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as a HDi file (native HDR Light Studio project file), even when using HDR Light Studio

via a connection. If you were to open HDR Light Studio in a connection with 3ds Max, this project can

be loaded into HDR Light Studio using Project > Open Project. The lighting design would load into
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HDR Light Studio replacing its current design, and would then be synced back into 3ds Max. This is

how you can move lighting designs between 3ds Max projects or between other supported 3D

software / renderers.

Workflow 2

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to 3ds Max provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in 3ds

Max, where you can see the lighting interact with your 3D scene. You can also create and control

Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between 3ds Max and HDR

Light Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial

Requirements: 3ds Max 2021 / 2022 / 2023 with Octane, Maxwell, Art Render or FStorm. Not your

renderer? Click here to see Workflow - Method 1

STEP 1: Start 3ds Max and load the 3ds Max project you want to light (see Figure 1).

Make sure a camera is set up for your scene and that the correct renderer is set. In this example

Octane is used.

https://www.lightmap.co.uk/learning/category/get-started/
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Figure 1: 3ds Max on startup after loading a project

STEP 2: Open the HDR Light Studio Connection plugin panel

Go to the menu: Rendering > HDR Light Studio Connection (see Figure 2). Not seeing HDR Light

Studio Connection? See our installation instructions

Figure 2: Opening 3ds Max connection panel

The HDR Light Studio Connection panel opens (see Figure 3). HDR Light Studio Connection panel did

not open? See our bug fix
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Figure 3: HDR Light Studio Connection panel

If you have a red cross next to 'Current renderer valid', it indicates that you are either using a

renderer that is incompatible with HDR Light Studio connection or it is incorrectly installed. 

STEP 3: On the HDR Light Studio connection panel, click on the 'Start' button (see Figure 4)

In order for HDR Light Studio to be started in a connection with 3ds Max and your renderer, an IBL

Hook is required to connect with.
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An IBL Hook is simply a valid Image Based Lighting setup (Dome Light / Environment Light), whose

HDRI map file can be replaced and updated by HDR Light Studio.

Figure 4: Starting HDR Light Studio Connection

STEP 4:  Create a new IBL Hook by providing a name for the hook in the 'Create New Hook for

Octane' panel and press the OK button (see Figure 5).

During the start process, our plug-in detects if there are valid IBL Hooks, if not then we create one for

you.
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Figure 5: Creating a new hook

HDR Light Studio will now start, controlling the HDRI image file used on the new IBL Hook, unless

there are already valid IBL Hooks in your 3ds Max scene, a dialog will appear where you will be asked

to choose a Hook from the drop down, or there is an option to create a New Hook (see Figure 6).

Figure 6: Selecting an existing hook before HDR Light Studio

connection starts

HDR Light Studio will then start connected to the hook selected or the new one that was created (see

Figure 7).

The HDR Light Studio interface should look like in Figure 7.

Using our latest version of HDR Light Studio and the 3ds Max connection - the HDR Light Studio

interface will now show 2 Render Views. On the left is Render View [3ds Max|Octane] (see Figure

7)

Currently this view is not compatible with 3ds Max Octane and can be closed!
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Figure 7: HDR Light Studio on start up

We recommend changing the layout using the top menu: Window > Layout > Load > Default >

Standalone

The HDR Light Studio interface will then contain the features you need to use HDR Light Studio with

3ds Max and Octane (see Figure 8).

Figure 8: HDR Light Studio Standalone interface layout

The current HDRI map design in HDR Light Studio is shared with 3ds Max as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for 3ds Max to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is

updated in 3ds Max to use a new temp with a new file name, to ensure the renderer uses the new

image even when caching images.

The temporary file name and location can be found in the Slate Material Editor and will look

something like in Figure 9. 
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Figure 9: File path points to a HDR Light Studio temp proxy image

STEP 5: Using 2 displays provides the best workflow, with HDR Light Studio on one display, and 3ds

Max on the other (see Figure 10). Press the play button on Render View [HDR Light Studio] (see

Figure 11).

Figure 10: 3ds Max (left) and HDR Light Studio (right) running on 2 displays
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Figure 11: Starting HDR Light Studio Render View

The Import Scene Geometry panel will pop up.

STEP 6: Press Import (see Figure 12)

Figure 12: Importing the scene from

3ds Max to HDR Light Studio render

We will use this Render View in HDR Light Studio as the interface for positioning lights on the model,

with real time feedback (see Figure 13).
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Figure 13: HDR Light Studio render view with imported scene from 3ds Max

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the chosen

location on the 3D model when using LightPaint (see Figure 14).

Learn about LightPaint here.

Figure 14: LightPaint mode set to Reflection

STEP 7: Drag and drop a Preset Light onto the 3D model in the Render View (see Figure 15)

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 15: Placing a preset light onto the model

The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

•   A new light in the Light List in HDR Light Studio (see Figure 16).

•   You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure

16).

•   The Render View has been updated to show the lighting effect on the loaded 3D model (see Figure

16).
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Figure 16: HDR Light Sutido interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [HDR Light Studio]

(see Figure 17).

STEP 8: Click and Drag on the 3D model to reposition the selected light from the Light List.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where you

want them (see Figure 17).

Figure 17: Using LightPaint to paint light on the model

STEP 9: Let's start Octane Live DB from the Octane tab in the 3ds Max's top menu, to see what the

lighting looks like (see Figure 18).
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Figure 18: Starting Octane

interactvie rendering in 3ds

Octane Frame Buffer opens and Octane starts rendering the view (see Figure 19).

Figure 19: Octane Frame Buffer inside 3ds Max (left) running with HDR Light

Studio (right)

We can leave Octane rendering as we work in HDR Light Studio. When lighting changes in HDR Light

Studio, it will update 3ds Max > Octane to use the new lighting.

If the scene is large and rendering in Octane is updating slowly, you can produce test renders from

time to time instead of leaving Octane interactive rendering running. It is up to the user to judge this

performance and decide what to do.

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area Light in 3D space in 3ds Max, mapped with the HDR content

from HDR Light Studio.

STEP 10: Enable the Area Light check box in the Light Properties panel for the selected light (see

Figure 20).
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Figure 20: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

•   The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 20).

•   The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 20).

•   A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio with a

Smart Dolly distance of 1,000 (see Figure 20).

•   A 3D plane with emitter shader is created in 3ds Max, mapped with the HDR light content (RGBA),

this can be seen lighting the shot in Render View [HDR Light Studio] (see Figure 20).
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Figure 20: Light converted into an area light

STEP 11: Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure

21).

Figure 21: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in 3ds Max. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

On the 3ds Max user interface, we can see:

•   The Area Light geometry in the viewport (see Figure 22) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here) 

•   Area lights made with HDR Light Studio are shown in the Scene Explorer (see Figure 22)

•   Shaders setup for the created area lights - mapped with HDR (RGBA) content (see Figure 22)

http://help.lightmap.co.uk/hdrlightstudio5/reference-area-lights.html
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Figure 22: 3ds Max interface after creating an area light

STEP 12: Use LightPaint in the Render View [HDR Ligh Studio] to move the Area Lights, just like

moving a light on the HDRI map (see Figure 23).

In fact, area lights are controlled just like any other light in HDR Light Studio, with the addition of

distance settings.

Figure 23: Using LightPaint to position the area light

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in 3ds Max (or any part of their associated shader

network/file nodes) will cause problems!

Rather than guessing where to put the lights in HDR Light Studio to achieve your desired effect, a

selected light in HDR Light Studio can be moved using the LightPaint tools in the HDR Light Studio

Connection panel. Press one of the LightPaint mode names to enable the tool. Then click on the 3D

model in the 3ds Max viewport to position the light via that LightPaint mode. Press the Off button to

stop the LightPaint tool (see Figure 24).

For more information about the LightPaint modes see: LightPaint

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 23: LightPaint tools in the HDR Light Studio

Connection Panel

STEP 13: Enable Fast Area Light setting in the Render View panel  (Figure 25) for fast noise removal

on very big scenes (see Figure 26). 
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Figure 25: Fast Area Light checkbox

Figure 26: Painting area lights with Area Light Setting On (left) and Off (right)

STEP 14: Once you are happy with your lighting, press the 'Production Render' button in HDR Light

Studio (see Figure 27).

Figure 27: Production Render buttons



658

658Connections (Plug-Ins)

Set your Production Render settings and Press Render in this panel. Notice how the

'Orientation' is already set to '3ds Max/Octane', this ensures that the rendered HDRI map is

mapped correctly in the host, i.e. 3ds Max (see Figure 28). For more information see:

Production Render Dialog

Figure 28: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update 3ds Max to use these final area lights and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be

updated to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced

your production lighting, by Pressing the Stop button (see Figure 29).

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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Figure 29: Stopping the HDR Light Studio connection

STEP 15: Save 3ds Max scene.

If you would like the HDR Light Studio project to be saved in your 3ds Max scene, you should

save your 3ds Max scene now. This way the scene state matches the HDRI map and area lights

that are currently in the project.

STEP 16: The below explains how to save and load HDR Light Studio projects.

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during

the lighting process as a HDi file (native HDR Light Studio project file), even when using HDR
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Light Studio via a connection. If you were to open HDR Light Studio in a connection with 3ds

Max, this project can be loaded into HDR Light Studio using Project > Open Project. The

lighting design would load into HDR Light Studio replacing its current design, and would then

be synced back into 3ds Max. This is how you can move lighting designs between 3ds Max

projects or between other supported 3D software / renderers.

Managing Performance/Resources

HDR Light Studio includes its own CPU powered Render View. Import a 3ds Max scene and quickly

create perfect lighting by clicking and dragging light positions on the 3D model geometry with real

time feedback. Use 3ds Max's own interactive rendering at the same time to see the updated lighting

interacting with the final shaders. In this scenario, 2 renderers are running at the same time and will

be competing for your computer's resources. The competing renderers can slow down each other's

performance and the responsiveness of the computer. Here is some advice on how to better manage

this situation by managing the resources better.
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Recommendations for Managing Performance/Resources:

GPU Rendering in 3ds Max

When using a GPU based renderer in 3ds Max (when HDR Light Studio's renderer is running), it

should not compete with HDR Light Studio. So both renderers should be nice and fast when used at

the same time.

CPU Rendering or CPU/GPU (Combined) Rendering in 3ds Max

If using CPU or CPU/GPU (Combined) rendering in 3ds Max when HDR Light Studio's CPU renderer is

running, please consider making the following adjustments to improve performance:

1. In HDR Light Studio's Render View Settings for HDR Light Studio, reduce the Max Samples to a

low number like 5.

HDR Light Studio's renderer will now stop rendering much sooner after each lighting change, leaving

more resources for 3ds Max's renderer.

HDR Light Studio's Render View really does not need to resolve to a high quality image, just a few

samples is enough to get a good impression of the lighting. See here:
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Please note

One thing to bear in mind is that when using HDR Light Studio using only the HDRI map (i.e. no 3D

area lights). Once HDR Light Studio has collected the render samples, it does not need to re-sample

when the HDRI map changes, i.e. a light is edited on the HDRI map. Therefore, once the progress bar

is fully green, the renderer has essentially stopped 'rendering'. There is a small set of calculations to

update the image when the HDRI map is changed. But these happen fast. So please understand that

you can leave the Max Samples setting at 80 if you are using only HDRI map based lighting and HDR

Light Studio's own Render View has already completed sample collection.

2. If you still feel the renderers are competing and performance is poor, if possible reduce the

number of threads used by your renderer in 3ds Max when rendering. Many renderers default to

using all threads. This can reduce 3ds Max's ability to process messages and images from HDR Light

Studio. For example, if you have a computer with 8 CPU cores, reducing your renderer to use 6 cores

will leave 2 more cores for HDR Light Studio and for handling communications between HDR Light

Studio and 3ds Max. Additionally reducing thread priority to low can also help. Availability of these

settings varies from renderer to renderer, please consult your renderer's documentation to see how

to change these settings.
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Renderer Specific Notes
Here are specific notes relating to using HDR Light Studio in Connection with 3ds Max using the

following renderers:

· V-Ray

· Corona

· Octane

· Arnold

· Maxwell

· Redshift

· Art Renderer (Autodesk)

Support has been removed for Mental Ray and Iray in this release of HDR Light Studio
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V-Ray

KNOWN ISSUES

IBL HOOK SETUP

Advice

To use HDR Light Studio with V-Ray, use ActiveShade with V-Ray RT. This way you can see interactive

updates in V-Ray RT as you light using HDR Light Studio.

Known Issues:

Hidden Area lights are still rendered by default by V-Ray

To fix:

Go to the Production Render Mode settings

Switch to the VRay tab

Expand the Global Switches section

Check the "Hidden Lights" setting
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Issue: If non-physical settings are created by HDR Light Studio, warnings can be shown

To fix:

Go to the ActiveShade Mode settings

Switch to the V-Ray RT tab

Expand the V-Ray RT section

Untick the "Warn for non-physical settings" setting
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IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Create a V-Ray Dome Light, ensuring Spherical (full dome) setting is On.
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Enable Use Texture on the V-Ray Dome Light properties, and then choose a VRayHDRI in the

Material/Map Browser. View the properties of the VRayHDRI in the Material Editor, and ensure

Mapping type is set to Spherical.

HDR Light Studio will now see and connect to this IBL setup.
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Corona

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Unsupported Area Light Features:

Constant Falloff

Notes:

Existing area light geometry will be exported to HDR Light Studio when exporting a full scene.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

In the Render Setup panel for Corona, ensure the Scene Environment is set to Use 3ds Max settings
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Go to menu Rendering > Environment…

Enable Use map check box and click on the Environment Map: None button

Choose a CoronaBitmap and then a HDRI map file to use as a temp stand in for now.

HDR Light Studio will now see and connect to this IBL setup.
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Octane

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Unsupported Area Light Features: 

 Constant Falloff

Notes:

Existing area light geometry will be exported to HDR Light Studio when exporting a full scene.

When no background HDRI map is set or is black, strange lighting can occur due to Octane's

importance sampling.

Temporarily turn off importance sampling on the environment if this becomes an issue for

you.
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IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Go to menu Rendering > Environment…

Enable Use Map check box and click on the Environment Map: None button

In the Octane Render section of Material/Map Browser, select Texture Environment
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In Material Editor, select the Texture Environment you have created

Change the drop down that says Color to Texture

Click on None button next to Texture

In the Octane Render section of Material/Map Browser, pick RGB Image

Change the Gamma of the RGB image from 2.2. to 1

Press the None button next to filename to select a HDRI map to use as a ‘stand in’ for now

HDR Light Studio will now see and connect to this IBL setup.
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Arnold

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Arnold (3ds Max 2017)

Initial Beta Support - HDR Light Studio's area lights feature is unsupported - HDRI map creation only.

When using the Arnold Sky Dome - lighting changes on the HDRI map are not updated in

ActiveShade mode. Requires a restart of ActiveShade to see the up to date lighting.

For this reason we recommend using the 3ds Max Environment method.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Option 1: Using a standard 3ds Max Environment - Preferred Method
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Select Environment... in the Rendering menu

Click on the None button to assign an Environment Map image file
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Choose Bitmap and press OK
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Then select a HDR or EXR stand-in file and press Open

Press OK on the following dialog.

HDR Light Studio will now see and connect to this IBL setup.

Option 2: Arnold Sky Dome - not visible in the background

In ActiveShade Mode, the Render does not update with lighting changes, and ActiveShade needs

restarting to see the up to date lighting from HDR Light Studio.
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Select Arnold light types in the drop down

Press the Arnold Light button

The panel extends to show the Arnold Light properties

Click in the 3ds Max viewport to make an Arnold Light

Now adjust the properties of the Arnold Light

Set Type to Skydome
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Set Format to LatLong
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Click on the None button next to the Texture, and select Bitmap and press the OK button
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Then select a HDR or EXR stand-in file and press Open

Press OK on the following dialog.

HDR Light Studio will now see and connect to this IBL setup.
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Maxwell

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Unsupported Area Light Features: 

Constant Falloff

Cam Visibility (off state)

Notes:

If the 3DS Max Render Settings panel is open when when using HDR Light Studio, this can cause

issues with HDR Light Studio texture updates.

Existing area light geometry will be exported to HDR Light Studio when exporting a full scene.

Creation/deletion and show/hiding of area lights are not correctly honored in the FIRE preview (as of

v3.24 + 3.2.1.1)

After creating or soloing lights from HDR Light Studio, the scene must be "reexport"ed to Fire.

To ensure area lights are correctly updated after their creation ensure "Export Primitive Changes" is

On in the Interactive Preview Options for Fire.

IBL Hook Setup
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These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

In the Render Setup panel, on the Renderer tab, in the Image Based Environment section, Activate

image based lighting with the Activate check box.

Load a stand in HDRI map on the Background.
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Now HDR Light Studio will connect with the image slots for Maxwell image based lighting.
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Redshift

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Unsupported Area Light Features:

- Constant Falloff

- Alpha

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Create a Redshift Dome light
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In the Bitmap section of the Dome Light, click on the None button to choose a stand-in HDRI map
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Find and select a HDRI map file, and Press Open.
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Press OK on the following HDRI Load Settings window

Click somewhere in in a viewport to make the Dome light

HDR Light Studio will now see and connect to this IBL setup.
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Art Renderer

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Initial Beta Support - HDR Light Studio's area lights feature is unsupported - HDRI map creation only.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.
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Select Environment... in the Rendering menu

Click on the None button to assign an Environment Map image file
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Choose Bitmap and press OK
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Then select a HDR or EXR standin file and press Open

Press OK on the following dialog.

HDR Light Studio will now see and connect to this IBL setup.
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Release Notes

Release Notes | Known Issues

Release Notes

Build 2024.0208

Updated to be compatible with HDR Light Studio 8.2

Fixed Area lights that were broken with Octane/Corona due to returning false for area light spread

call

Maxwell & Art renderer support removed

Build 2023.0504

Adds support for 3ds Max 2024

Build 2023.0208

Performance improvements.

HDR Light Studio API updates.

Updated 3ds Max 2021 plug-in to use the new faster API.

Fixed a bug with Corona renderer.

Fixed an issue with Soloing area lights with V-Ray.

Build 2022.0722

Support added for V-Ray 6

5th May 2022

3ds Max 2023 plug-in released - Plug-in build 2022.0420

HDR Light Studio - Xenon (Drop 4.2)

Now compatible with FStorm Renderer

Tested with FStorm Version 15.0H.

Live HDRI Map and HDR Area Lights is supported.

Sharing of the interactive render from FStorm in the HDR Light Studio interface is not supported.

Build 2021.0914

Updated to use new faster API for the 2022 plugin only

Fixed a conflict with Ornatrix for scene export into HDRLS

Fixed renderer not being detected after closing and reopening connection panel
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Fixed crash bug when selecting a new scene and saving the scene

Dropped support for 3ds Max 2019

9th June 2021

Support for 3ds Max 2022 added

Build 2020.0814

Support for V-Ray 5 added.

Fix added to deal with username paths with non ASCII characters. See here for details on how to

implement this.

3ds Max 2021 Connection released 16th April 2020

Build 2020.0305

Bug fix: 3ds Max: Crash bug when starting HDR Light Studio with 3ds Max, due to interface layout.

Bug fix: 3ds Max / Octane: Alpha not showing properly on Area Lights with Octane 2019.

Build 2019.0531

Bug fix: 3ds Max Connection - Bug where hidden HDRLS could not be stopped.

Bug fix: 3ds Max Connection - HDRLS standin textures to avoid missing files not being used by

Arnold.

Build 2019.0426

Support for 3ds Max 2020 added

3dsMax Connection: Fixed bug from Maxwell new release where environment not being correctly

detected.

Build 2018.1015

Updated to use the new Redshift Render View, this will only work with Redshift 2.6.24+

3ds Max/VRay Next: Fix issue with toggling area lights on and off.

Build 2018.0724

Support added for V-Ray Next

Build 2018.0418

Adds 3ds Max 2019 support

Bug Fixes:

Bug 2147: 3ds Max crash bug with area lights related to a dome light that no longer exists.

Bug 2148: 3ds Max crash if you reload a scene file in the same session that has a valid HDRLS env
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hook.

Bug 2150: 3ds Max. If you create a new hook via the New Hook button, the Environment Hook status

indicator doesn't update to indicate that a valid hook is now selected.

Build 2018.0201

Updated workflow - hook creation for renderers, 3ds Max Activeshade image hosted in HDR Light

Studio Render View

BZ# 1990 Added VRay-RT support in production render mode.

Fixed loss of lighting design issues when swtiching between V-Ray RT and V-Ray Production.

Plus minor bug fixes

Bug 1659 - Fixed so that only valid IBL hooks are listed in the HDR Light Studio connection

Build 2017.0118

Support added for Redshift renderer

Build 2016.1208

Support added for new area light advanced rotations and light handle

Bug 1535 - Fixed bug where area lights in a 3ds Max scene could be duplicated when loading HDR

Light Studio.

Bug 1536 - Fixed bug where starting HDRLS then loading a scene with a different renderer causes

saved lights not to load

Bug 1533 - Fixed crash bug when starting a new project in 3ds Max after loading a saved project and

starting the HDRLS connection

Bug 1493 - Fixed LightPaint insid 3ds Max bug with objects with local scale transforms

We now support 3dsMax Environment Texture for the V-Ray renderer, as well as dome lights.

Build 2016.0809

Added support for 3ds Max 2017

Beta support for Arnold in 3ds Max 2017 - without Area Lights creation

Beta support for ART Renderer in 3ds Max 2017 - without Area Lights creation

V-Ray area lights are now correctly scaled using U and V size parameters

Corona - Environment now uses Corona Bitmap

With the latest Corona (1.4), if you use a standard 3ds Max bitmap in the environment, 3ds Max will

crash when you stop the HDR Light Studio connection.

The fix is to use a CoronaBitmap in place of a 3ds Max bitmap. The plug-in has been updated to

support CoronaBitmap in the environment slot. (3ds Max bitmaps are still supported)
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Build 2016.0623

Fixed bug where V-Ray Area Lights were being seen as potential Environment Hooks.

We now ensure VRayHDRI mapping is Spherical in order for the Environment Hook to be valid.

Build 2016.0505

Supports Area Light creation and control

Build 2016.0104

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Bug 1164: Fixed crash when launching HDRLS from 3DS Max when there is no compatible render

assigned,

Fixed bug where HDRLS can not be stopped when it's hidden.

Bug 620 - LightPaint now works in 3ds Max viewports with TurboSmoothed models. 

Bug 1045 - Fixed broken compatibility with later versions of Octane 2.

Bug 1061 - Fixed 3ds Max crash if 3DS Max will crash if HDRLS_HOME_V5 environment variable not

set.

Build 2016.0104

Bug 620: LightPaint in 3ds Max viewports now works with Turbo smoothed models.

Added warning message when trying to run multiple connections to HDR Light Studio.

Build 2015.1021

Bug 1045: Fix to support Octane version 2.23.2-2.8 and above

Build 2015.0625

Support for 3ds Max 2013 has been dropped.

Support for 3ds Max 2016 has been added.

Support for Corona renderer has been added.

Plug-in user interface has been updated to be more consistent with the plug-in connections.

Build 2015.0520

3ds Max 2016 support added.

Physical cameras - if you wish to use physical cameras, you should use the Alembic format to sync

model data between 3ds Max and HDR Light Studio as these cameras are supported in Alembic.

Please note that physical cameras are not supported in the fbx model format. If a model is pushed

into HDR Light Studio using fbx, the model will be imported but the physical cameras will not. Artists
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will have to line up the model using the FreeCam in HDR Light Studio, to match the camera position

in Max.

BUG 373 - on starting 3ds Max, the user interface window containing the HDR Light Studio plug-in

connection may appear very small. As a workaround just drag the window larger to reveal the

buttons.

Build 2015.0422

Supports 3ds Max 2013, 2014, 2015

Support for the Corona renderer is not included in these builds.

Known Issues

F-Storm Area Lights

Alpha is not currently supported on area lights.

3ds Max 2018 Interface Bug

3dsMax 2018 has a bug in it that can sometimes  hide the initial HDR Light Studio connection panel

when first installed.

See here for a workaround to fix the issue.

Lost undocked HDR Light Studio Connection panel in 3ds Max on second display

If the HDR Light Studio Connection panel is undocked and dragged onto another display, this can

result in it just disappearing, this is a 3ds Max bug.

Here is how to retrieve it:

Go to the Rendering Menu and select HDR Light Studio Connection to turn the panel off, and select

again to turn it back on.

Now press 'alt+spacebar'

Then press the down arrow key on the keyboard once

Press enter on the keyboard once

Press the left arrow key on the keyboard once

Now move the mouse around and the panel should appear moving around with your cursor!
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3ds Max 2018 Interface Bug

3dsMax 2018 has a bug in it that can sometimes hide the initial HDR Light Studio connection panel

when first installed.

Please watch the following video to see a workaround to make the interface panel appear. Once this

has been done the connection panel should always appear in the correct location.

None ASCII Username

HDR Light Studio currently supports ASCII characters only in file paths.

If your Windows account username contains none ASCII characters, you will need to set the following

Environment Variables to choose a location without none ASCII characters in the path.

Then HDR Light Studio will function correctly.

Instructions on how to add Environment Variables can be found on this page, showing how to set them up

for Logging, but the same process can be used for all the environment variables below.

HDRLS_USER_DIR

The HDR Light Studio user directory by default contains folders containing these files that HDR Light

Studio needs: license files, presets, user presets, presets cache and favorites preset settings file.
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With a default installation this path will be, for example on Windows: C:

\Users\Username\AppData\Local\lightmap

If you wish to store these files in a different location, you can set the environment variable

HDRLS_USER_DIR.

For example:

HDRLS_USER_DIR = \DiskName\HDRLS_DATA\USER\

HDRLS_TEMPRENDER_DIR

When using HDR Light Studio, it create's temporary files shared with your 3D software, and

temporary files during rendering.

With a default installation this path will be, for example on Windows: C:

\Users\Username\AppData\Local\Temp\

Files will be created within subfolders in that location, for example all temp image files are stored in:

HdrlsBuckets_Lightmap Ltd

If you wish to store these files in a different location, you can set the environment variable

HDRLS_TEMPRENDER_DIR.

For example:

HDRLS_TEMPRENDER_DIR = \DiskName\HDRLS_DATA\TEMP\
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Blender Connection

The Blender Connection is an Add-on that creates a bridge between HDR Light Studio and Blender.

As the HDRI map and Area Lights are created in HDR Light Studio, Blender is kept in sync.

Supported Renderers: Cycles, Eevee, Octane & RenderMan

· Installation

· Interface Overview

· Workflow

· Video Tutorials

Reference

· HDRLS World

· Area Lights in Detail

· Project Data

· Release Notes
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Installing and Uninstalling

• You should install HDR Light Studio Xenon Drop 1 or newer before installing the Blender plug-in

add-on. See installation instructions for HDR Light Studio here.

• If you have an older build of the Blender add-on installed, you should uninstall it first before

installing a newer build - see Uninstalling.

Installing the Blender Add-on - Windows, Mac and Linux

STEP 1: Download the Blender add-on zip file from our website.

STEP 2: Save the zip file downloaded from our website at a location of your choice. Do not unzip this

file as Blender actually requires this zip file for installation. (see Figure 1)

MacOS note: Zip files are unzipped automatically if you have "open 'safe' files after downloading"

checked in the Safari preferences. If you have this set, then you will have to re-compress the

HDRLightStudioConnection folder to make it a zip file that can be used for installation.

Figure 1: Blender add-on file stored on the

desktop

STEP 3: Start up Blender and open Blender Preferences

Go to Edit > Preferences... (see Figure 2)

http://help.lightmap.co.uk/hdrlightstudio5/installation.html
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Figure 2: Opening Blender Preferences

STEP 4: Go to the Add-ons section and then click on Install... (see Figure 3)

Figure 3: Clicking on the 'Install...' button to install a

new add-on

STEP 5:  Go to the directory where you have stored the Blender add-on zip file. Select it and click on

Install Add-on (see Figure 4)

Figure 4: Installing HDR Light Studio add-on for

Blender
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The HDR Light Studio add-on for Blender is now installed.

You no longer need the .zip file used to install the add-on, it can now be deleted (in this example it was

stored on the desktop).

STEP 6: Blender has automatically searched for the installed add-on called 'HDR Light Studio for

Blender'. Now, enable the HDR Light Studio add-on for Blender in order to use it.

Check the checkbox for Lighting: HDR Light Studio for Blender to enable the add-on (see Figure 5)

Figure 5: Enabling the HDR Light Studio add-on for

Blender

You can see the HDR Light Studio add-on is installed because there is a new HDR Light Studio

section in the World Properties in Blender (see Figure 6)

Figure 6: HDR Light Studio add-on for Blender

The installation process is complete and you are now ready to use HDR Light Studio using this

Workflow.
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Uninstalling

STEP 1: Disable the HDR Light Studio Add-on in Blender's Add-ons Preferences (Go to the Blender

menu, Edit > Preferences) 

STEP 2: Close and Restart Blender

STEP 3: Open Blender Preferences and go to the Add-ons

STEP 4: Find the HDR Light Studio Add-on using the search tool in Preferences, and use the Remove

button to complete the uninstall process
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Interface Overview
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Workflow

This workflow tutorial teaches how to use HDR Light Studio with

Blender via the Connection.

Watch the HDR Light Studio - Quick Start video first to learn the key

concepts of using HDR Light Studio.

Ensure you have installed both the HDR Light Studio main application and then the HDR Light Studio

Connection for Blender.

For compatibility, ensure you are running 'at least' these HDR Light Studio and Blender versions...

•   For rendering with Cycles or Eevee: HDR Light Studio Xenon Drop 1 and Blender 2.83

•   For rendering with RenderMan: HDR Light Studio Xenon Drop 4 and Blender 2.83

•   For rendering with Octane: HDR Light Studio Xenon Drop 4.2 (2022.0426) and Blender Octane Edition

2021.1.5_26_3+ (Windows only) or 2022.1.BX2_27_1+ (Windows & Mac OS X)

  If you'd prefer to learn with a video tutorial - you can watch our Blender: Getting Started

video

STEP 1: Start Blender and load your Blender project

Before we start to use HDR Light Studio to light this scene.... let's make sure the scene is ready

to light first.

Camera View

Make sure you have a camera setup with the final composition for the shot that you want to light. If

you move the camera during the lighting process, the reflections of the lights will move and this will

ruin your lighting.

Existing Lights

Ideally, your scene should not contain any lighting before using HDR Light Studio. You may have set

up some environment lighting during the look development for the scene, so now is a good time to

delete or hide this lighting. If you have an LED light that's part of a product for example, then this is a

part of your scene and should be kept. We simply want to avoid confusion by mixing lights created

with HDR Light Studio and those not created with HDR Light Studio. A blank lighting canvas is the

best place to start.

https://www.lightmap.co.uk/learning/blender_getting_started/
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Tip: If you have an HDRI map you want to edit that's already lighting the scene, hide or delete this

light and load the HDRI map into HDR Light Studio once it's open.

In this example, we are using Cycles (see Figure 1).

Figure 1: Blender on startup after loading a project

STEP 2: Go to the HDR Light Studio Connection Add-on panel

Go to 'World Properties' and expand the 'HDR Light Studio' section (see Figure 2).

Not seeing HDR Light Studio Connection? See our installation instructions

Figure 2: HDR Light Studio connection add-on panel
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STEP 3: Start HDR Light Studio from Blender

On the HDR Light Studio connection panel, click the Start button (see Figure 3)

Figure 3: Starting HDR Light Studio Connection

 Important: The HDR Light Studio API used to talk with Blender uses TCP/IP. When first starting

HDR Light Studio you may be asked for permission for it to use TCP/IP. It will require ports

5555,5556,5557 and 5558 to be open. Please allow these TCP/IP communications for the Add-on to

function correctly.

The connection add-on creates a new world called HDRLS World, even if there is already a non

HDRLS World set up. 

 RenderMan Users: Instead of creating a new world, the connection add-on creates a new

RenderMan/Pixar Dome Light called HDRLS Dome Light, and it will be visible in the Blender Outliner.

This is the case even if there is already a non HDRLS Dome Light set up. Once the HDRLS Dome Light

is set up in the project, HDR Light Studio will always use that Dome Light to connect to. A shader

network is created for the HDRLS Dome Light where the environment texture always references an

up-to-date temporary HDRI map file which can be replaced and updated by HDR Light Studio

Once the HDRLS World is set up in the project, HDR Light Studio will always use that World to

connect to. A shader network is created for the HDRLS World where the environment texture uses an

Image data-block called HDRLS World Tex that always references an up-to-date temporary HDRI

map file which can be replaced and updated by HDR Light Studio (see Figure 4).

You can read more about the HDRLS World here. 
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Figure 4: Shader network created for HDRLS World

The HDR Light Studio interface should look like the interface shown in Figure 5. If it doesn't, go to

Window > Layout > Load > Default > Blender.

 If you are using a single display, watch the Getting Started video on this page to see how to

customize the HDR Light Studio interface, so you can see Blender and HDR Light Studio at the same

time.

Figure 5: HDR Light Studio on start up

The current HDRI map design in HDR Light Studio is shared with Blender as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for Blender to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is



713

713Connections (Plug-Ins)

updated in Blender to use a new temp with a new file name, to ensure the renderer uses the new

image even when caching images.

STEP 4: Import your Blender Scene into HDR Light Studio

In this demo we are using 2 displays, with HDR Light Studio on one display and Blender on the other

(see Figure 6).

Press the play button on Render View [HDR Light Studio] (see Figure 7).

Figure 6: Blender (left) and HDR Light Studio (right) running on 2 displays

Figure 7: Starting HDR Light Studio Render View

The Import Scene Geometry panel will pop up.

STEP 5: Choose your import options

Let's use the default settings. Press Import (see Figure 8)
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Figure 8: Importing the scene from Blender to

HDR Light Studio render view

 Using this play button the current frame will be exported, and if a subdivision surface modifier is

applied to meshes, this will be applied to the exported model too. The model is exported into HDR

Light Studio as a temporary Alembic file. You can send your 3D model into HDR Light Studio by using

the Export section in the HDR Light Studio panel in Blender. This provides more control over what is

exported.

 HDR Light Studio will only support perspective projection cameras.

We will use the Render View in HDR Light Studio as the interface for positioning lights on the model.

It will give us real time feedback (see Figure 9).

Figure 9: HDR Light Studio render view with imported scene from Blender
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STEP 6: Let's create our first light in HDR Light Studio

By default, LightPaint is set to Reflection mode in this view. This means lights are positioned to

reflect in the chosen location on the 3D model when using LightPaint (see Figure 10).

Learn about LightPaint here.

Figure 10: LightPaint mode set to Reflection

Drag and drop a Preset Light onto the 3D model in the Render View (see Figure 11)

Figure 11: Placing a preset light onto the model

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

•   A new light in the Light List in HDR Light Studio (see Figure 12).

•   The new light has been added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure

12).

•   The Render View has been updated to show the lighting effect on the loaded 3D model (see

Figure 12).

Figure 12: HDR Light Studio interface after creating a light

STEP 7: Reposition a light using LightPaint



717

717Connections (Plug-Ins)

You can see that the LightPaint tool is active in the toolbar within the Render View [HDR Light Studio]

(see Figure 13).

Click and Drag on the 3D model to reposition the selected light from the Light List.

This is a very interactive way to light your shot, placing lights directly on the 3D model where you

want them (see Figure 13).

Figure 13: Using LightPaint to paint light on the model

STEP 8: Start interactive rendering in Blender

Start interactive rendering by clicking on the 'Viewport Shading: Rendered' icon in the top right of

the viewport, to see what the lighting looks like in your renderer (see Figure 14).

 Cycles and Eevee Users: You can switch between Cycles and Eevee at any time. Our lighting is

compatible with both.
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Figure 14: Starting Blender's Render Preview using Cycles

We can leave Blender rendering as we work in HDR Light Studio. When lighting changes in HDR Light

Studio, it will update Blender to use the new lighting. If the scene is large and the render inside

Blender is updating slowly, you can produce test renders from time to time instead of leaving

Blender's Live Render Preview running. It is up to the user to judge this performance and decide

what to do.

STEP 9: Choosing Area Light Type - Cycles & Eevee only

Cycles and Eevee users have the option to choose between 2 different methods of area light creation:

1. Mesh Emitters

2. Blender Area Lights

The type of area light that should be used for the project depends on the user's workflow and

preference. Read the comparison between Mesh Emitter and Blender Area Lights to find out more

about which type is more suitable for your needs.

Return to Blender's interface and, in the HDR Light Studio connection panel, choose your preferred

Area light type.

In this example, we are using Mesh Emitters (see Figure 15). 

If you are using Octane or RenderMan, you will not see this setting and you may skip to Step 10.
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Figure 15: Mesh Emitter area light type selected

Area Light Type is a global setting and will determine the type of all area lights made by HDR Light

Studio in the scene. It is also dynamic, meaning that the setting can be tweaked at any time to

convert all area lights made by HDR Light Studio from Mesh Emitters to Blender Area Lights and vice

versa.  

STEP 10: Creating Area Lights

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area light in 3D space in Blender. 

Return to HDR Light Studio, and enable the Area Light check box in the Light Properties panel for the

selected light that we have created in Step 6 (see Figure 16).
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Figure 16: Converting a light into an area light of

type 'Mesh Emitter'

As a result of enabling the Area Light setting, these things instantly happen:

•   1. The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 17).

•   2. The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 17).

•   3. Additional Area Light properties have been added to the Light Properties for this light, with a

default Smart Dolly distance of 1,000 units  (see Figure 17).

•   4. An Area light has been created in the Render View [HDR Light Studio], mapped with the HDR

texture to control its appearance (see Figure 17).

•   5. An Area Light has been created in Blender for the selected renderer - mapped with the HDR

texture from HDR Light Studio, and matching the size and position of the area light in HDR Light

Studio  (see Figure 17).

To find out more about the behavior of area lights created by HDR Light Studio for your renderer,

read Area Lights in Detail.

Figure 17: Light converted into an area light of type 'Mesh Emitter'
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STEP 10: Adjust the distance of the Area Light from the 3D model

Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure 18).

Figure 18: Moving the area light closer to the model (LightPaint position)

 HDR Light Studio has a scene scale setting that is useful when working with area lights in Blender.

If the area lights are too close or too far away by default when using the slider, adjust the Smart Dolly

Scalar value in Preferences. This value scales all area lights made with HDR Light Studio. You can

watch a video to learn about this scale setting here.

On the Blender user interface we can see: 

•   1. The Area Light geometry in the viewport (see Figure 19) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here) 

•   2. Area lights made with HDR Light Studio are shown in the Outliner inside HDR Light Studio Lights

(see Figure 19)

•   3. Shaders set up for the created area lights - mapped with HDR content (see Figure 19)

http://help.lightmap.co.uk/hdrlightstudio5/reference_preferences.html
http://help.lightmap.co.uk/hdrlightstudio5/reference_preferences.html
https://www.lightmap.co.uk/learning/arealight_distance_scale/
http://help.lightmap.co.uk/hdrlightstudio5/reference-area-lights.html
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Figure 19: Blender interface after creating an area light

 Please Note: Area Lights created by HDR Light Studio in Blender will not be named to match

those in HDR Light Studio. You can see the HDR Light Studio light name by going to the Object

Properties for the light in Blender, and looking at the Custom Property called strName. This is not

important as there is really no need to adjust the lights created by HDR Light Studio in Blender.

STEP 11: Moving Area Lights

In HDR Light Studio, use LightPaint in the Render View [HDR Light Studio] to move the Area Lights,

just like moving a light on the HDRI map (see Figure 20).

In fact area lights are controlled just like any other light in HDR Light Studio, with the addition of the

distance settings (Smart Dolly and Dolly Multiplier).

Figure 20: Using LightPaint to position the area light

STEP 12: Area Light Spread - Cycles only
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 Important: For compatibility ensure you using 'area light type: Blender Area Light' and are

running 'at least' Blender 2.93 and HDR Light Studio Xenon Drop 4.

You can use the spread setting to change the light emitting from the area light.

This is how the spread setting changes the light emitting from the area light.

Here you can see the effect of changing this setting, see how the light becomes more focused on the

scene with lower settings.

Default Spread = 1
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Spread = 0.50

Spread = 0.08

STEP 13: Finalizing the lighting design

Once you are happy with your lighting, press the Render Production HDRI button in HDR Light

Studio (see Figure 21).

It says HDR on it.

Figure 21: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to 'Blender/Blender', this ensures that the rendered HDRI map is mapped correctly in the

host, i.e. Blender (see Figure 22). For more information see: Production Render Dialog

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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Figure 22: Production Render Panel

The production quality content will be calculated and saved as files on disk. The connection will

automatically update Blender to use these final high-res area lights and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be updated

to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced your

production lighting by Pressing the Stop button (see Figure 23).

Figure 23: Stopping the HDR Light Studio

connection

If you stop the HDR Light Studio connection and have not produced a production render of the

final lighting, the temporary lo-res files will be replaced with blue HDR Light Studio logo images. This

serves 2 purposes: It stops the Blender scene from referencing the temporary HDR files that will
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disappear, causing missing file errors in the future, and it makes it clear to the user that the lighting

has not been produced at a high quality avoiding the low quality temporary files being used by

accident.

STEP 14: Save the Blender scene to store the HDR Light Studio lighting

project

If you would like the HDR Light Studio project to be saved in your Blender scene for next time you

load this Blender scene, you should save your Blender scene now. This way the scene state matches

the HDRI map and area lights that are currently in the HDR Light Studio project.

Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as a HDi file (native HDR Light Studio project file), even when using HDR Light Studio

via a connection. If you were to open HDR Light Studio in a connection with Blender, this project can

be loaded into HDR Light Studio using Project > Open Project. The lighting design would load into

HDR Light Studio replacing its current design, and would then be synced back into Blender. This is

how you can move lighting between Blender projects or between other supported 3D software.

STEP 15: Switching to a different Renderer

If you decide to now light the same scene using a different renderer, we recommend that you Purge

Lights (see Figure 24) before switching to a different renderer and starting HDR Light Studio again -

find out more about the Purge Lights function here.

 Purging Lights can also 'fix' issues related to issues with synchronization and accuracy updates

between HDR Light Studio and Blender - find out more here.

Figure 24: Purge Lights button
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Video Tutorials

Tutorial Video only

Tutorial Video and Document

https://www.lightmap.co.uk/learning/blender_getting_started/
https://www.lightmap.co.uk/learning/blender_tutorial_01/


728

728Connections (Plug-Ins)

Tutorial Video and Document

Tutorial Video and Document

More HDR Light Studio learning content can be found at: www.lightmap.co.uk/learning

https://www.lightmap.co.uk/learning/blender_tutorial_02/
https://www.lightmap.co.uk/learning/blender_tutorial_03/
https://www.lightmap.co.uk/learning/
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Reference

Some specific information about the HDR Light Studio add-on:

· HDRLS World

· Area Lights in Detail

· Purge Lights

· Project Data



730

730Connections (Plug-Ins)

HDRLS World

 You can also watch this video to learn about how HDR Light Studio works with the

Blender World

When HDR Light Studio is first started in a Blender Scene, the add-on will create a new world named

HDRLS World.

We do this because you may already have a World set up with any number of shader nodes and

settings. So we decided not to mess with existing worlds and have our own for HDR Light Studio.

Currently we create a very simple shader setup on the HDRLS World that looks like this (Figure 1):

Figure 1: Shader set-up on HDRLS World

Instead of linking directly to a file on disk we create an image data-block called HDRLS World Tex,

referencing the updating HDR files we share with Blender. This will point at the temporary lo-res files

we share and the final production render from HDR Light Studio too.

We use the image data-block to allow the user to take advantage of using the generated HDRI texture

on another world. You may want to do this to take more control over the HDRI map, using more

shader nodes in Blender. There are many possibilities, for example in the shader network below you

can independently control the diffuse lighting contribution coming from the HDRI map. This can be

useful when using Eevee, which can over-light the render when using HDRI maps with a bright sun

(see Figure Figure 2).

https://www.lightmap.co.uk/learning/blender_hdrlsworld/
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Figure 2: Example of a more complex shader set-up using the HDRLS World Tex

 Please Note: When using the HDRLS World Tex on another world setup, if you add a node to

transform and rotate the environment then it will no longer match the orientation being created by

HDR Light Studio. We advise that you orient your lighting in HDR Light Studio and don't use

transforms on your own world setups.

When making your own World, you can select the HDRLS World Tex as a texture by using the Browse

button on the texture node. If there is a long list of textures already being used in the scene, you can

find it using the search at the bottom of the panel (see Figure 3).

Figure 3: Finding the HDRLS World Tex

More information on how the HDRLS World behaves:
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If you switch away and select a different World to the HDRLS World and then start making changes in

HDR Light Studio, the HDRLS World will be made active again, so you can see the lighting results in

Blender.

If you delete the HDRLS World for some reason, it will be recreated when using HDR Light Studio

again in that scene.

If you alter the shader network on the HDRLS World, it's highly likely the add-on will adjust the node

network when the next change is made to the lighting in HDR Light Studio. So if you need a different

shader setup, please make a new world and reference the HDRLS World Tex.
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Area Lights in Detail

The HDR Light Studio connection creates area lights that are compatible with Cycles, Eevee,

RenderMan and Octane. On this page you will find out how area lights behave across different

renderers and what are their limitations.

HDR Light Studio Area Light Type Setting (Cycles & Eevee only)

We provide 2 types of area light 'construction' that you can choose from when rendering in Cycles

and Eevee. At any time you can switch the type of area lights being created by HDR Light Studio and

they will be rebuilt on the fly - so feel free to experiment and switch them during your lighting

session and see how they look.

You can also switch between Cycles and Eevee at any time as the lighting is compatible with both,

but you will see there are some limitations described below.

Renderer: Cycles

HDR Light Studio - Area Light Type: Mesh Emitter

Below you can see what to expect when using our Mesh Emitter lights with Cycles. There is an RGBA

HDR texture used on a mesh plane that has a shader network emitting from one side. The light is

solid and can be seen by the camera. It is opaque apart from the areas where alpha is used - there it

is totally invisible with full alpha.

The light can be seen in reflections and emits light from the front.

The back side of the light will be seen as a black rectangle.
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Below is the node network HDR Light Studio creates for each HDR Light Studio 'Mesh Emitter'. It's

pretty complex in order to create the physically plausible lighting result you see above.

 Please Note: When making Mesh Emitter lights, Blender will go into edit mode for the light we

create. If you come to work on the scene after lighting in HDR Light Studio, you will need to switch

back to Object mode.

Renderer: Cycles

HDR Light Studio - Area Light Type: Blender Area Light

Figure 4: Area light with type 'Blender Area Light'

and rendered in Cycles
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Below you can see what to expect when using our Blender Area Lights with Cycles. There is an RGB

HDR texture used on a Blender area light. The light can not be seen by the camera. The area light

emits light and the HDR texture can be seen in reflections. The light is translucent and not solid. The

back of the light is invisible.

Below is the node network HDR Light Studio creates for each HDR Light Studio 'Blender Area Light'.

It's quite simple.

Renderer: Eevee

HDR Light Studio - Area Light Type: Mesh Emitter
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The light is set up the same as the Mesh Emitter shown with Cycles above, we don't change the

shader network when changing between Cycles and Eevee.

Below you can see what to expect when using our Mesh Emitters with Eevee. There is an RGBA HDR

texture used on a mesh plane that has a shader network emitting from one side. The light is solid

and can be seen by the camera. It is opaque apart from the areas where alpha is used - where it is

totally invisible.

The light can be seen in reflections by enabling 'Screen Space Reflections' on the Eevee render

settings.

The back side of the light will be seen as a black rectangle.

Importantly, the light does not emit light in Eevee, like a Blender Area Light does. The only way to

get lighting from this type of light setup in Eevee is to bake Indirect Lighting. But this is time

consuming to calculate and really this is meant for indirect light bouncing effects for added realism,

not as a way to get your primary direct lighting.

Please note: Cam Visibility Setting in HDR Light Studio is not supported with Mesh Emitter Area

Lights and Eevee. 

 Please Note: When making Mesh Emitter lights, Blender will go into edit mode for the light we

create. If you come to work on the scene after lighting in HDR Light Studio, you will need to switch

back to Object mode.
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 Screen based reflections in Eevee: If an area light front face is not visible in the view, it will not

show in reflections when using Eevee. This is how Eevee screen based reflections work at the

moment.

Renderer: Eevee

HDR Light Studio - Area Light Type: Blender Area Light

Figure 5: Blender Area Light rendered in Cycles

Below you can see what to expect when using our Blender Area Lights with Eevee.

HDR Light Studio controls this light by sharing Color and Power values to use on the lights settings,

so the shaders and texture is actually ignored by Eevee at the moment.

HDR Light Studio calculates the average color and brightness from our area light HDR texture which

provides a reasonable match for lighting purposes. But you are limited to seeing the shape of the

Blender Area Light in the reflections and not the texture. This light type does emit light and shadows

in Eevee.
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 When using these area lights, when the light is far away, we have seen artifacts with the shadows.

If you increase the Clip Start setting on the area light in Blender this seems to fix problems with the

shadows.

Renderer: RenderMan

Below you can see what to expect when using RenderMan Area Lights (PxrRectLight) with HDR Light

Studio.

•   There is an RGB HDR texture used on a PxrRectLight.

•   The light can be seen by the camera. However, Cam Visibility setting in HDR Light Studio can be

checked to hide it from the camera.

•   The area light emits light from the front and the HDR texture can be seen in reflections.

•   The light is translucent and not solid.

•   The back of the light is invisible.
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Below is the node network HDR Light Studio creates for each RenderMan Area Light (PxrRectLight).

It's quite simple.
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Renderer: Octane

Below you can see what to expect when using Octane Area Lights with HDR Light Studio. There is an

RGBA HDR texture used on an Octane Area Light that has a shader network emitting from one side.

The light is solid and can be seen by the camera. It is opaque and where alpha is used the area

reflects the color of the scene. 

The light can be seen in reflections and emits light from the front.

The back side of the light will be opaque.
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Below is the node network HDR Light Studio creates for each Octane Area Light.
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Purge Lights

What does it do?

Pressing the Purge Lights button in HDR Light Studio connection panel will delete all HDR Light

Studio lights created using Object Data. This does not delete the HDR Light Studio Project Data, so

next time HDR Light Studio is started via the connection panel, all HDR Light Studio created lights will

be re-created.

Renderer Specific Behaviors

Cycles/Eevee/Octane Users

Area Lights are created using Object Data but the Environment Light is created using World data.

Therefore, when the Purge Lights button is clicked, all area lights created by HDR Light Studio will be

deleted but not the environment light. Purging lights only deletes light objects created using Object

data.
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Example light setup created by HDR Light Studio for Cycles renderer, showing area

lights created using Object Data and the environment using World Data.

RenderMan Users

Both the Area Lights and the Environment/Dome Light is created using Object Data. Therefore, when

the Purge Lights button is clicked, all area lights and the environment/dome light created by HDR

Light Studio will be deleted.

Example light setup created by HDR Light Studio for RenderMan renderer, showing

both area lights and the environment/dome light created using Object Data.

When to use it?

A conflict between existing HDR Light Studio lights and newly created HDR Light Studio lights could

potentially occur. Using the Purge Lights button is a good first step in troubleshooting any issues
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related to updates that are being sent from HDR Light Studio to Blender. Perhaps, the lights in

Blender are out of sync with the lights in HDR Light Studio. This can potentially occur when lighting a

scene using one renderer, e.g. Cycles, and then switching to a different renderer, e.g. Octane, to light

the same scene again. This is why we recommend to always purge lights in the scene before

switching to a different renderer and lighting that same scene again.

Project Data

When using the HDR Light Studio Blender Connection, we store the HDR Light Studio project data in

the Blender scene file... but where?

You can find our data by looking at the Data API view. In the Scene > Scene section, towards the

bottom of the list, you will find an entry called HDRLS Project Data.

You don't really need to mess with this. But if for some reason you did want to delete the embedded

lighting project data, you can right click and select 'Reset To Default Value' to clear it.
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Release Notes

Build 2024.0301

Updated to be compatible with HDR Light Studio 8.2

Build 2023.1116

Updated to support Blender 4+

Build 2023.0329

Performance improvements.

HDR Light Studio API updates.

Fix for Mesh Area Emitters - these broke in Blender 3.4

HDR Light Studio has moved to using a new version of QT. Plug-in updates were required as a result

of this.

Build 2022.0913

Updated to support Blender 3.3+

Does not support Octane on Linux

Build 2022.0803

Fix for Octane area lights not working in the latest stable build of Blender for Octane 2021.1.5_26_3.

For users working with Blender for Octane, the new build of the Blender Plug-in now requires 'at

least' Blender For Octane 2021.1.5_26_3 (Windows only) or Blender for Octane 2022.1.BX2_27_1

(Windows & Mac OS X).

Build 2022.0525

Fix for blender API breaking change of cycles area light visibility after v3.x

Build 2022.0426

Blender Add-on updated to support Apple Silicon

The HDR Light Studio add-on for Blender has been updated to support Blender running on Apple

Silicon. This new plug-in requires the latest build of HDR Light Studio (2022.0426).

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on

Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.
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Build 2022.0324

Support added for Blender 3.1+

A change of python version in Blender 3.1 broke our connection. Our connection has now been

updated to add compatibility.

Build 2021.0914

Added support for Octane Render and RenderMan

Fixed scene export failure with versions Blender 2.93.2 and higher

Single installer file for all versions

Build 2021.0504

On macOS, if HDR Light Studio environment variable is not found/work/set then default install

location used to find HDR Light Studio main app. This allows users to use HDR Light Studio with their

connection who were having technical difficulties due to macOS ignoring our environment variable.

Build 2020.0928

Fixed a bug when an invalid log path is set.

Known Issues / Behaviors

Undo in Blender

If you use the Undo in Blender whilst in a lighting session with HDR Light Studio, then this can really

mess things up. So please use the Undo inside HDR Light Studio instead to undo your lighting

changes.

For example: If HDR Light Studio is open, and you use Undo in Blender, and then export the Blender

scene into HDR Light Studio using the re-sync button, it will crash Blender.

Screen based reflections in Eevee

If an area light front face is not visible in the view, it will not show in reflections when using Eevee.

This is how Eevee screen based reflections work at the moment.

Export Limiations of Scenes into HDR Light Studio

We use Blender's Alembic exporter to send scenes into HDR Light Studio's Render View.

Currently we have noticed that these features are not exporting using this exchange format:

1) Instanced Geometry
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2) Solidify Modifiers

3) Particle Systems

Area Light - Cam Visibility setting in HDR Light Studio

This setting in the HDR Light Studio properties panel has no effect in Eevee.

Blender 2.93 & RenderMan XPU:

Blender may crash when changing the Area Light Spread.
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Cinema 4D Connection

The Cinema 4D Connection is a plug-in that creates a bridge between HDR Light Studio and Cinema

4D.

As the HDRI map and Area Lights are created in HDR Light Studio, Cinema 4D is kept in sync.

Supported Renderers: Cinema 4D, V-Ray, Octane, Arnold, Redshift, and Corona

· Installation

· Interface Overview

· Quick Start Video

· Workflow

· Interface Layout Gallery

Make sure you get the right layout and workflow for your project, renderer and computer power.

· Managing Performance/Resources

· Release Notes
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Installation

Installing on Windows

Installing on MacOS

Uninstalling
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Installing on Windows

Important Note:

You should install the main HDR Light Studio application first, prior to installing our Cinema 4D

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both Cinema 4D and HDR Light Studio app are not running prior to installing our

Cinema 4D Connection plug-in.

1. Download the Cinema 4D plug-in file from our web site. Pick the appropriate one for your version

of Cinema 4D.

2. Unzip the file.

3. Move the HDRLightStudio folder into your Cinema 4D 'plugins' folder. If the 'plugins' folder does

not exist, please make one.

Your installation will look something like this:

Make sure the contents of your HDRLightStudio folder look like this (make sure you do not have a

HDRLightStudio folder inside another HDRLightStudio folder).
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4. Run Cinema 4D and check that HDRLightStudioC4D Connection is in the Plugins menu.

This plug-in connection will need a license key to work. You should now proceed to Licensing. For

information on using the connection see Cinema 4D Connection.
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Installing on MacOS

Important Note:

You should install the main HDR Light Studio application first, prior to installing our Cinema 4D

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both Cinema 4D and HDR Light Studio app are not running prior to installing our

Cinema 4D Connection plug-in.

1. Download the Cinema 4D plug-in file from our web site.

2. Unzip the file.

3. Move the HDRLightStudio folder into your Cinema 4D 'plugins' folder. If the 'plugins' folder does

not exist, please make one.

/Applications/MAXON/RXX/plugins

4. Run Cinema 4D and check that HDRLightStudioC4D Connection is in the Plugins menu.

This plug-in connection will need a license key to work. You should now proceed to Licensing. For

information on using the connection see Cinema 4D Connection.
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Uninstalling

To remove the HDR Light Studio plug-in connection for Cinema 4D, just delete the HDRLightStudio

folder in the Cinema 4D plugins folder. For example, on Windows:

C:\Program Files\MAXON\R15\plugins\HDRLightStudio
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Interface Overview
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Quick Start Video

Make sure you have watched the HDR Light Studio - Quick Start video

first to learn the key concepts of using HDR Light Studio.

Cinema 4D Connection - Quick Start Video

Workflow

This workflow tutorial teaches how to use HDR Light Studio with

Cinema 4D via the Connection.

Watch the HDR Light Studio - Quick Start video first to learn the key

concepts of using HDR Light Studio.

Ensure you have installed both the HDR Light Studio main application and the HDR Light Studio

Connection for Cinema 4D.

For compatibility ensure you are running 'at least' these renderer versions:

V-Ray Version: 5, Octane Version: 2018.1.3 (Octane 5) or 4.04-R2 (Octane 4), Arnold Version: 2.5.0, Redshift
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Version: 2.6.40

Big thanks to Szymon Kubicki for the awesome demo scene used on this tutorial.

Start Cinema 4D and Load your Cinema 4D Project

Before we start to use HDR Light Studio to light this scene.... let's make sure the scene is ready

to light first.

Camera View

Make sure you have a camera setup with the final composition for the shot that you want to light. If

you move the camera during the lighting process, the reflections of the lights will move and this will

ruin your lighting.

Existing Lights

Ideally, your scene should not contain any lighting before using HDR Light Studio. You may have set

up some environment lighting during the look development for the scene, so now is a good time to

delete or hide this lighting. If you have an LED light that's part of a product for example, then this is a

part of your scene and should be kept. We simply want to avoid confusion by mixing lights created

with HDR Light Studio and those not created with HDR Light Studio. A blank lighting canvas is the

best place to start.

Tip: If you have an HDRI map you want to edit that's already lighting the scene, hide or delete this

light and load the HDRI map into HDR Light Studio once it's open.

Open the 'HDR Light Studio Connection' panel

Go to the menu: Extensions > HDR Light Studio

(Cinema 4D 20 users, go to the menu: Plugins > HDR Light Studio)

https://www.behance.net/kubicki3d
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The HDR Light Studio Connection panel opens.

Ideally, you should now drag the panel and dock it into the Cinema 4D interface.

The connection will still function even when the tabbed panel is hidden by another tabbed panel.
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 Tip: You can save your Cinema 4D interface layout to include the HDR Light Studio connection

panel. So you don't need to do this every time.

Now we are ready to start working in the HDR Light Studio Connection panel.

Set Renderer

Use the 'Set Renderer' dropdown in the Connection panel to set the Renderer for this Cinema

4D project.

This tells HDR Light Studio which renderer it will create lighting for. In this example, we are choosing

Redshift in the drop down. 



759

759Connections (Plug-Ins)

Create New Lighting Project

Press the 'Create New Project' button.

This will create a new HDR Light Studio lighting project for the chosen renderer.

In the image below, you can see the HDRLightStudio.Redshift project has been created in the

Cinema 4D Objects panel - containing an environment light for Redshift.

This new HDR Light Studio project is also listed as the Active Project in the HDR Light Studio

Connection panel.
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Tip: Working with Multiple HDR light Studio Projects

You can create multiple HDR Light Studio lighting projects in the Cinema 4D scene. Use the Active

Project dropdown to select the active lighting project, this will then be loaded into HDR Light Studio

for editing and the other lights, in the other HDR Light Studio projects, will be hidden.
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Tip: Renaming HDR Light Studio Projects

You can rename the HDR Light Studio project in the Cinema 4D Objects panel and use the Refresh

Project List button in the Connection panel to update the names in the Active Project dropdown

list.
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Start HDR Light Studio

Press 'Start' to start HDR Light Studio in a connection with Cinema 4D.

Please Note: If HDR Light Studio is already open standalone, connected with another 3D app, or

connected to another session of Cinema 4D - the connection will not function correctly. So please

ensure HDR Light Studio is not already open before starting it from Cinema 4D.
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The HDR Light Studio application now opens connected with Cinema 4D. Behind the scenes, the HDR

Light Studio connection has taken control of the environment image in the active HDR Light Studio

lighting project.

The HDRI map from HDR Light Studio is now shared with Cinema 4D as a temporary low-res image (a

proxy). This image is fast to calculate and fast for Cinema 4D to load and use during the interactive

lighting design process.
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When the lighting design changes in HDR Light Studio, the environment in Cinema 4D is updated to

use a new temp file with a new file name with a random number on the end (see image above). This

ensures the renderer uses the new image and not a cached old image.

Default HDR Light Studio Interface Layout with Cinema 4D

By default, the HDR Light Studio interface should look something like this. (below)

If not, you can reset the HDR Light Studio interface layout by going to the menu: Window >

Layout > Load > Default > Cinema 4D
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Additional Render View

This default interface layout is different to using HDR Light Studio standalone. An additional Render

View has been added on the left. In this example, the panel is called Render View [Cinema4D|

Redshift]. This view allows the interactive render from Redshift in this case (supports Arnold and

Octane too) to be displayed inside the HDR Light Studio interface. You can then drag and drop lights

onto this view and use LightPaint to position lights here too.

When would you use this additional render view?

Using this additional render view is ideal when using a computer with one display - as everything you

need to light the shot can be viewed inside HDR Light Studio. However, there is an overhead to using

this view and it's very much optional. For simple scenes that render fast and don't bog down your

computer too much, this view works really well.

Feature Not Supported Message

If you are using V-Ray, Corona or native Cinema 4D renderers, then this additional render view will

contain a message telling you the feature is not supported. This is expected, as those renderers are

unable to stream their render image with HDR Light Studio at the moment.
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Considering this additional render view is very much optional and not

compatible with all renderers in Cinema 4D, for now in this tutorial we will

remove this render view by changing the interface layout. Towards the

end of this tutorial, Octane, Arnold and Redshift users can learn how to

use this additional render view.

Changing the Interface Layout

Using the menu go to: Window > Layout > Load > Default > Standalone

The HDR Light Studio interface will update to the standalone layout you are familiar with from our

Getting Started training.
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Most professional 3D artists have at least 2 displays. Using 2 displays provides the best workflow

because you can place Cinema 4D on one display and HDR Light Studio on the other. If you have

one display, there are alternative interface layouts you can configure, we show a range of interface

layouts here.

Exporting your scene into HDR Light Studio's Internal Renderer

When we used HDR Light Studio standalone, we used the Render View [HDR Light Studio] to position

the lights on an interactive render of the scene. Let's get the Cinema 4D scene into HDR Light

Studio's Render View so we can paint it with light.

The easiest way to do this is by pressing the Play button on Render View [HDR Light Studio]
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Because HDR Light Studio is connected with Cinema 4D, the Import Scene Geometry panel pops up. 

Leave the settings at their default and press the Import button

By default, the whole Cinema 4D scene is exported as an Alembic file (that's automatically deleted

after your lighting session) and loaded into the Render View [HDR Light Studio].

However, selected scene geometry can be exported using the 'Scene Export' tab in the HDR Light

Studio Connection panel in Cinema 4D if required.

Using the Scene Export Panel in the Connection
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The scene export tab provides more control over exporting the Cinema 4D scene into HDR Light

Studio's Render View.

Export format:  Collada or Alembic

Sometimes scenes do not export properly in one of the formats, exporters always have their

issues. So having both export formats is handy if one is not working well for you.

Alembic is the only format supporting animation. With Alembic selected you can set the start

frame, end frame and frame steps.

Export Options

Full Scene or Current Selection Only

If you want only parts of your scene to be exported, use 'Current Selection Only' for the currently

selected objects in Cinema 4D to be exported. Make sure you include the cameras in the selection.

Please Note: Objects hidden in Cinema 4D, or set to non-renderable for example, will often be

included when exporting your scene. Using the 'Current Selection Only' setting is ideal to export

only the parts you need into HDR Light Studio.

Temporary File or User Selected File

If you use 'Temporary File', the exported file is deleted once the lighting session in HDR Light

Studio has finished. However, if you have a very large scene that takes a very long time to export

and you feel you may keep returning to HDR Light Studio to relight the scene, you may want to
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export it as a permanent file by choosing 'User Selected File'. Use the folder button to set a file

name and file location before pressing the Export button.

Once all settings have been chosen

Press the Export Scene into HDR Light Studio button and the file will be exported by Cinema

4D and then automatically loaded into HDR Light Studio's Render View.

We will now use this Render View in HDR Light Studio as the interface for positioning lights on the

model, with real-time rendered feedback.

Let's make our first Light

By default, LightPaint is set to Reflection in this view. So lights are moved to reflect in the clicked or

dragged location on the 3D model.

Learn about LightPaint here.

Drag and drop a Preset Light onto the 3D model in the Render View.
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A new light is added to the lighting design - it's reflecting where the light was dropped on the 3D

model.

As a result, you can now see in HDR Light Studio:

· 1. New light added in the Light List

· 2. New light can be seen on the Canvas

· 3. Render View has updated to show the new light on the model

Just the same as when we used HDR Light Studio standalone, but we have the Cinema 4D scene in

our Render View.
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Move the Light

You can see that the LightPaint tool is active in the toolbar in the Render View [HDR Light Studio].

Click on the 3D model to reposition the selected light, (highlighted on the Light List)

Interactive Rendering in Cinema 4D
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Whilst we have been working in HDR Light Studio, Cinema 4D has been updated with every lighting

change, via the Connection. Let's start interactive rendering in Cinema 4D so we can see the lighting.

Start Redshift interactive rendering in Cinema 4D. 

Redshift starts interactive rendering using the current lighting from HDR Light Studio.

You can see the lighting in HDR Light Studio's render view and in the interactive render in Cinema 4D

are matching.

We can leave Redshift interactive rendering in Cinema 4D as we work on the lighting in HDR Light

Studio.

 Tip: If the scene is large/complex and interactive rendering in your renderer is too slow, then

produce test renders from time to time.

LightPaint in the Cinema 4D Viewport
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An alternative to using the Render View [HDR Light Studio] to position your lights is to LightPaint

directly in the Cinema 4D viewport.

This is enabled with the LightPaint tool buttons on the HDR Light Studio Connection panel in Cinema

4D.

Choose a LightPaint mode, for example, click on the Reflection button.

Now click on the model in the Cinema 4D viewport and the selected light in HDR Light Studio is

moved to reflect in that location.

Some renderers, Redshift, for example, allow viewport rendering in Cinema 4D. This provides a nice

lightweight workflow, without the need to load the model into HDR Light Studio and have 2

renderers running at the same time. In the example screengrab below, we are using HDR Light

Studio on a single display with Cinema 4D. We have rearranged the interface to show Cinema 4D on

the left and have HDR Light Studio on the right. LightPaint Reflection mode has been chosen and

Redshift is rendering in the viewport. We have clicked on the side of the car to position the selected

light in HDR Light Studio.

To learn about rearranging the HDR Light Studio interface, see Customizing the Interface
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 Tip: When using HDR Light Studio on the same display as Cinema 4D, go to Window and activate

the Always On Top Setting. This allows you to click on the Cinema 4D interface to position lights,

without the Cinema 4D interface covering the HDR Light Studio interface.

 Tip: The advantage of LightPaint in Render View [HDR Light Studio] is that it's silky smooth and

fast - allowing you to drag lights in real-time and discover the light position 'sweet spots'. Using

LightPaint in the Cinema 4D viewport, you can only click to position lights. When large models are

loaded the LightPaint calculation in Cinema 4D can be slow also - so there will be a time delay

between clicking and the light moving in HDR Light Studio.

Making Area Lights - A 3D light mapped with an HDR texture

So far the lighting we created is on the HDRI map shared with Cinema 4D. This is about to change!

Please Note: Only Lights with 3D mapping show the option to be converted into area lights, as

these are the only lights that make sense to become area lights.

Enable the Area Light check box in the Light Properties panel for the selected light.
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As a result of enabling this Area Light setting, the lighting looks very similar to before, but lots of

things just happened with that single setting:

· 1. The Light in the Light List gets the suffix [AreaLight] and its text is now yellow.

· 2. The light has been removed from the HDRI map but is still represented on the Canvas as a view

of the light as seen from the center of the world. Don't be confused, it's really no longer on the

HDRI map lighting the shot!

· 3. Additional Area Light properties have been added to the Light Properties for this light, with a

default Smart Dolly distance of 1,000 units.

· 4. An Area light has been created in the Render View [HDR Light Studio], mapped with the HDR

texture to control its appearance.

· 5. An Area Light has been created in Cinema 4D for the selected renderer - mapped with the HDR

texture from HDR Light Studio, and matching the size and position of the area light in HDR Light

Studio.
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Change the Area Light Distance

Initially, the Area Light will be far away from your model providing a similar lighting effect to when it

was on the HDRI environment. We need to move it closer to the model so you can see it in the

Render View and in the Viewport in Cinema 4D.

Reduce the Smart Dolly slider value to move the light closer to the 3D model.

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in Cinema

4D. If the area lights are too close or too far away by default, adjust the Smart Dolly Scalar value in

Preferences. This value scales all area light distances in HDR Light Studio.

Let's take a look at the Cinema 4D interface now. You can see:

· 1. The Area Light that HDR Light Studio created can be seen in the viewport.
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· 2. Area Lights made with HDR Light Studio are shown inside the active HDR Light Studio project. In

this example inside the HDRLightStudio.Corona group.

· 3. The Area Light has been set up for your renderer. You can see the texture from HDR Light Studio

mapped to the light properties. This texture is updated when the light's appearance is changed in

HDR Light Studio.

 Please Note: Renaming/deleting/duplicating HDR Light Studio area lights in Cinema 4D (or any

part of their associated shader network/file nodes) will cause problems!

Moving Area Lights

In HDR Light Studio, use LightPaint in the Render View [HDR Light Studio] to move the Area

Light.

Area lights are controlled just like any other light in HDR Light Studio with the addition of the

distance controls.

Area Light Spread - Arnold, Redshift V-Ray and Octane only
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New in Xenon Drop 3

A new slider has been added in HDR Light Studio to control area light spread/directionality. This is

supported by Arnold, Redshift, V-Ray and Octane. This setting is ignored by other renderers in

Cinema 4D.

This is how the spread setting changes the light emitting from the area light.

Here you can see the effect of changing this setting, see how the light becomes more focused on

the car with lower settings.
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Default Spread = 1

Spread = 0.5

Spread = 0.08

Using the Additional Render View - Arnold, Redshift and Octane

only
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Let's reset the HDR Light Studio interface to its default layout by going to the menu:

Window > Layout > Load > Default > Cinema 4D

This layout shows the additional Render View.

There is an overhead of computer resources to share the interactive render image stream with

HDR Light Studio. Before using the view we need to ensure we set a sensible resolution for the

interactive rendering so that we are not streaming a huge amount of image data that will slow

down the rest of the lighting and rendering processes.

Set the Render Resolution in Cinema 4D to a maximum of 1,000 x 1,000 pixels.
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 Please Note: Ensure no current interactive render sessions are running in Cinema 4D before

pressing the Play button. HDR Light Studio will start an IPR session in Arnold, Octane or Redshift

for you.

Press the Play button on Render View [Cinema 4D|Redshift]

HDR Light Studio tells Cinema 4D to start an interactive render and stream the updating images to

HDR Light Studio.

Arnold - The IPR render session starts without any panel opening in Cinema 4D. This hidden

Arnold render session streams its IPR image directory into the HDR Light Studio interface.

Octane - A new Live Viewer window will open, start rendering, and show the message EXTERNAL

RENDERING on a black view. Octane streams its IPR image into the HDR Light Studio interface.

Redshift - A new Redshift RenderView panel opens and starts rendering. You can see the

interactive render both in the Redshift RenderView and streamed into the HDR Light Studio

interface. If you are working on a single display set-up, the Redshift RenderView panel will open

behind HDR Light Studio interface, regardless of whether HDR Light Studio has the 'Always on top'

setting switched on or off.

With the LightPaint tool active in this Render View. Click on the model to move the selected

light using the LightPaint mode.

You can also drag and drop Preset Lights onto this view too.
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This view functions the same as Render View [HDR Light Studio], but will always be less responsive

due to the communication lag between HDR Light Studio > Cinema 4D > Renderer and back.

You can stop and start the rendering from this view using the Pause/Play button at the bottom of

the panel.

If this Render View is working well for you, why not close HDR Light Studio's other Render View

and reconfigure the HDR Light Studio user interface as required.

See the example layout below. Everything you need to light the shot is available in one user

interface now.
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 Please Note: When using this Render View to display the interactive render from Cinema 4D,

don't go into Cinema 4D and start another interactive rendering session for your renderer. This

will either cause 2 sessions to be running, or stop the render session being shared with HDR Light

Studio. Either way, this causes problems.

 Please Note: The use of this Render View is optional. If you are working with more than one

display, then it makes perfect sense to look at your interactive render in Cinema 4D on a separate

display. The main advantage of using this Render View in HDR Light Studio is for those working on

a computer with one display.

Finalizing the Lighting Design

Rendering the Final HDRI Lighting Textures

So far we have been sharing lo-res temporary textures with Cinema 4D for your lighting - to keep things fast

during the lighting design process.

Now let's complete the lighting process by producing higher resolution and higher quality sub-sampled HDR

textures on disk.
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Press the 'Production Render' button in HDR Light Studio.

The top HDR button on the toolbar

Set your Production Render settings

Notice how the 'Orientation' is already set for Cinema 4D and your set renderer. This ensures that

the rendered HDRI map is orientated correctly when rendered.

For more information on these settings see: Production Render Dialog

Press the Browse button to choose a file location and give the lighting file a name.
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Press the Render button in this panel.

The production quality HDR textures will now be calculated and saved as permanent files on disk.

Once complete, the connection automatically updates Cinema 4D to use these new textures.

Stopping HDR Light Studio

If any further changes are now made to the lighting in HDR Light Studio, all lighting textures will be

updated to use new proxy images, and the link to the rendered files is broken.

Please ensure you 'Stop' the HDR Light Studio connection after you have rendered your final

lighting files.

Press the Stop button.

HDR Light Studio now closes and leaves your Cinema 4D scene with an awesome lighting setup for

your renderer. This scene uses standard lights and can be rendered anywhere, even on computers

without HDR Light Studio licenses.

 Please Note: If you want to edit the lighting design, press the Start button and HDR Light Studio

will open and load the lighting design project data which is embedded in the Cinema 4D scene. You

can now edit the lighting, but make sure to render the final HDR textures at the end of the process.
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Save the Cinema 4D scene.

The current state of the HDR Light Studio project is embedded in the Cinema 4D project. You should

save your Cinema 4D scene now.

 Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as an HDi file (native HDR Light Studio project file), even when using HDR Light

Studio via a connection. If you were to open HDR Light Studio in a connection with Cinema 4D, this

project can be loaded into HDR Light Studio using Project > Open Project. The lighting design would

load into HDR Light Studio replacing its current design, and would then be synced back into Cinema

4D. This is how you can move lighting between Cinema 4D projects or between other supported 3D

software.
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Interface Layout Gallery

HDR Light Studio's interface and features can be configured in many

different ways to work with Cinema 4D.

This gallery provides a wide range of interface layouts that you can use,

with each having their own benefits. It's very important to make sure you

set up HDR Light Studio to create an efficient workflow. Looking at these

example layouts should stimulate you to find your own perfect way to use

HDR Light Studio.

Page Content

Interface Layouts for 2 Displays

Interface Layouts for 1 Display

To learn about rearranging the HDR Light Studio interface, see Customizing the Interface

Interface Layouts for 2 Displays

For users with lower power computers

This layout can be used by those able to do viewport rendering in Cinema 4D - for example

Redshift and the Cinema 4D physical renderer.

In HDR Light Studio, select the default standalone UI layout, then close the Render View panel. Use

the LightPaint buttons in Cinema 4D to move your lights by clicking on the rendered viewport.

This is a very efficient workflow, as the rendered view does not need to be shared with HDR Light

Studio and the model is not loaded and rendered by HDR Light Studio.

With large scenes however, the LightPaint calculation can be slow, causing a delay between clicking

on the model and the light moving.

Left: Cinema 4D   Right: HDR Light Studio
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For users with lower power computers

This layout can be used by those unable to do viewport rendering in Cinema 4D - for example

Octane and V-Ray.

In HDR Light Studio, select the default standalone UI layout, then close the Render View panel. Use

the LightPaint buttons in Cinema 4D to move your lights by clicking on the viewport.

This is a very efficient workflow, as the rendered view does not need to be shared with HDR Light

Studio and the model is not loaded and rendered by HDR Light Studio.

With large scenes however, the LightPaint calculation can be slow, causing a delay between clicking

on the model and the light moving.

Left: Cinema 4D   Right: HDR Light Studio

For all users

In HDR Light Studio, select the default standalone UI layout.

Click and drag on the scene in HDR Light Studio's render view to position the lights. See your final

lighting update the interactive render inside Cinema 4D - either in the viewport or the Render View

for your renderer.

You can zoom and pan around the render view in HDR Light Studio to light details, whilst seeing the

whole render in Cinema 4D.

In this layout, 2 renderers are running at the same time. So ensure your renderer is using the GPU or

not using all CPU threads, leaving some CPU resources for HDR Light Studio and its renderer.

Left: Cinema 4D   Right: HDR Light Studio
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This layout can be used by those using Arnold, Redshift and Octane only.

In HDR Light Studio, select the default standalone UI layout, then swap the Render View to show the

Render View connected to Cinema 4D.

All of your lighting can be done inside the HDR Light Studio interface directly onto the Cinema 4D

Render.

Left: Cinema 4D   Right: HDR Light Studio

For users with powerful computers using Arnold, Redshift and Octane

In HDR Light Studio, select the default standalone UI layout, then show and undock the Render View

that can show the Cinema 4D render and drag it onto the display where Cinema 4D is.

You can paint your lights on either Render View, perhaps using HDR Light Studio's own renderer for

zooming and panning into the shot to place lights on smaller details.

Make sure the resolution of the Render coming from Cinema 4D into HDR Light Studio is not higher

than needed.

In this layout, 2 renderers are running at the same time. So ensure your renderer is using the GPU or

not using all CPU threads, leaving some CPU resources for HDR Light Studio and its renderer.

Left: Cinema 4D with HDR Light Studio Render View on top   Right: HDR Light Studio
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Interface Layouts for 1 Display

For users with lower power computers

This layout can be used by those able to do viewport rendering in Cinema 4D - for example

Redshift and the Cinema 4D physical renderer.

In HDR Light Studio, reorganize your interface layout to look like the layout below. No HDR Light

Studio Render Views are needed.

Turn on the 'Always On Top' setting in the Window menu. Now you can use the LightPaint feature

inside the Cinema 4D rendered viewport if you wanted and HDR Light Studio will not be hidden by

Cinema 4D. The LightPaint buttons from the HDR Light Studio connection are showing beneath the

rendered viewport.

This is a very efficient workflow, as the rendered view does not need to be shared with HDR Light

Studio and the model is not loaded and rendered by HDR Light Studio.

With large scenes however, the LightPaint calculation can be slow, causing a delay between clicking

on the model and the light moving.

HDR Light Studio in front and arranged around the

Cinema 4D viewport

For users with lower power computers

This layout can be used by those unable to do viewport rendering in Cinema 4D - for example

Octane and V-Ray.

In HDR Light Studio, reorganize your interface layout to look like the layout below. No HDR Light

Studio Render Views are needed.

Turn on the 'Always On Top' setting in the Window menu. Now you can use the LightPaint feature

inside the Cinema 4D rendered viewport if you wanted and HDR Light Studio will not be hidden by

Cinema 4D.

This is a very efficient workflow, as the rendered view does not need to be shared with HDR Light

Studio and the model is not loaded and rendered by HDR Light Studio.
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With large scenes however, the LightPaint calculation can be slow, causing a delay between clicking

on the model and the light moving.

HDR Light Studio down the right side, in front of Cinema

4D

For all users

In HDR Light Studio, reorganize your interface layout to look like the layout below. With just the

internal HDR Light Studio render view.

Click and drag on the scene in HDR Light Studio's render view to position the lights. See your final

lighting update the interactive render inside Cinema 4D - either in the viewport or the Render View

for your renderer.

You can zoom and pan around the render view in HDR Light Studio to light details, whilst seeing the

whole render in Cinema 4D behind.

In this layout, 2 renderers are running at the same time. So ensure your renderer is using the GPU or

not using all CPU threads, leaving some CPU resources for HDR Light Studio and its renderer.

HDR Light Studio in front and arranged around the

Cinema 4D viewport

This layout can be used by those using Arnold, Redshift and Octane only.

In HDR Light Studio, select the default standalone UI layout, then swap the Render View to show the

Render View connected to Cinema 4D.

All of your lighting can be done inside the HDR Light Studio interface directly onto the Cinema 4D
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Render.

HDR Light Studio only (Cinema 4D is running and covered

by HDR Light Studio)

For users with powerful computers using Arnold, Redshift and Octane

In HDR Light Studio, select the default Cinema 4D UI layout.

You can paint your lights on either Render View, perhaps using HDR Light Studio's own renderer for

zooming and panning into the shot to place lights on smaller details.

Make sure the resolution of the Render coming from Cinema 4D into HDR Light Studio is not higher

than needed.

In this layout, 2 renderers are running at the same time. So ensure your renderer is using the GPU or

not using all CPU threads, leaving some CPU resources for HDR Light Studio and its renderer.

HDR Light Studio only (Cinema 4D is running and covered

by HDR Light Studio)
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Managing Performance/Resources

HDR Light Studio includes its own CPU powered Render View. Import a Cinema 4D scene and quickly

create perfect lighting by clicking and dragging light positions on the 3D model geometry with

realtime feedback. Use Cinema 4D's own interactive rendering at the same time to see the updated

lighting interacting with the final shaders. In this scenario, 2 renderers are running at the same time

and will be competing for your computer's resources. The competing renderers can slow down each

other's performance and the responsiveness of the computer. Here is some advice on how to better

manage this situation by managing the resources better.

Recommendations for Managing Performance/Resources:

GPU Rendering in Cinema 4D

When using a GPU based renderer in Cinema 4D (when HDR Light Studio's renderer is running), it

should not compete with HDR Light Studio. So both renderers should be nice and fast when used at

the same time.

CPU Rendering or CPU/GPU (Combined) Rendering in Cinema 4D

If using CPU or CPU/GPU (Combined) renderering in Cinema 4D when HDR Light Studio's CPU

renderer is running, please consider making the following adjustments to improve performance:

1. In HDR Light Studio's Render View Settings for HDR Light Studio, reduce the Max Samples to a

low number like 5.
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HDR Light Studio's renderer will now stop renderering much sooner after each lighting change,

leaving more resources for Cinema 4D's renderer.

HDR Light Studio's Render View really does not need to resolve to a high quality image, just a few

samples is enough to get a good impression of the lighting. See here:

Please note

One thing to bear in mind is that when using HDR Light Studio using only the HDRI map (i.e. no 3D

area lights). Once HDR Light Studio has collected the render samples, it does not need to re-sample

when the HDRI map changes, i.e. a light is edited on the HDRI map. Therefore, once the progress bar

is fully green, the renderer has essentially stopped 'rendering'. There is a small set of calculations to
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update the image when the HDRI map is changed. But these happen fast. So please understand that

you can leave the Max Samples setting at 80 if you are using only HDRI map based lighting and HDR

Light Studio's own Render View has already completed sample collection.

2. If you still feel the renderers are competing and performance is poor, if possible reduce the

number of threads used by your renderer in Cinema 4D when rendering. Many renderers default to

using all threads. This can reduce Cinema 4D's ability to process messages and images from HDR

Light Studio. For example, if you have a computer with 8 CPU cores, reducing your renderer to use 6

cores will leave 2 more cores for HDR Light Studio and for handling communications between HDR

Light Studio and Cinema 4D. Additionally reducing thread priority to low can also help. Availability of

these settings varies from renderer to renderer, please consult your renderer's documentation to see

how to change these settings.
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Release Notes

Release Notes | Known Issues

Release Notes

Build 2024.0222

Updated to be compatible with HDR Light Studio 8.2

Cinema 4D - Fix to support Cinema 4D 2024.3 that had a breaking change

Crash bug fixed when LightPainting on subdivision objects in C4D render in HDRLS interface

Redshift cameras are now being listed in HDR Light Studio's render view

Arnold - Area Light visibility now working correctly

Reinstated support for native Standard & Physical renderers

Removed Maxwell render support

Build 2023.1004

New plug-in added for Cinema 4D 2024

Build 2023.0329

Performance improvements.

HDR Light Studio API updates.

HDR Light Studio has moved to using a new version of QT. Plug-in updates were required as a result

of this.

Build 2022.0916

New plug-in added for Cinema 4D 2023

Build 2022.05.25

If for some reason the environment variable had not been set for the location of main HDR Light

Studio app, the fall back location was not being used, and HDR Light Studio wasn;t found by the

connection. This is fixed now.

Build 2022.0414

Cinema 4D 26 support released, including Apple Silicon support

HDR Light Studio is now compatible with Cinema 4D 26. In addition, the Cinema 4D 26 plug-in is

compatible with Cinema 4D running on Apple Silicon. This new plug-in requires the latest build of

HDR Light Studio (2022.0426).

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on
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Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.

9th November 2021

Cinema 4D R25 Connection Added

Build 2021.0519

The Cinema 4D connection now uses our new API for a far more responsive lighting experience. We

also took the opportunity to rework the behavior of this connection, here are the key changes:

· Support added for Cinema 4D 24

· Moving lights is more interactive

· Simplified the Connection panel terminology to be easier to understand for new users

· You can switch Cinema 4D projects without HDR Light Studio closing and your lighting project will

auto sync

· You can create multiple HDR Light Studio lighting projects in a single C4D project and correctly

swap between them. This is also compatible with the Cinema 4D 'Takes' system

· Added support for V-Ray 5 (removed support for older V-Ray versions)

· Added support for real-time Area Light Spread control for: Arnold, V-Ray, Redshift and Octane

· Hiding the HDR Light Studio Connection panel on the UI does no longer stops the lighting updates.

You can now tab the connection panel and have it behind another tab when using HDR Light

Studio

· Logging has moved into the native Cinema 4D logging system

· On macOS, if the environment variable is not working to tell Cinema 4D the location of the HDR

Light Studio application, the Connection will then look in the default install location. This fixes an

issue where macOS users report Cinema 4D not able to start HDR Light Studio from Cinema 4D on

macOS.

· Arnold: Fixed mapping of HDRI as Arnold had changed this orientation.

· Fixed a crash bug when opening pre Xenon Drop 3 'Octane' lighting projects containing HDR Light

Studio area lights.

Please note we have officially stopped supporting Maxwell and Thea in Cinema 4D

September 22nd 2020

Compatibility added for R23 
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Build 2019.1212

Remove the AVX compiler flags from libs and plug-in

Support added for Redshift 3 in Cinema 4D

Build 2019.1113

Support added for Cinema 4D R21 (Requires R21.1 (build 21.115) and higher) 

C4D: Redshift - Area Light width and height controls incorrectly swapped over.

C4D: Redshift - Production Rendering was turning off shadows from the environment lighting.

Build 2019.0712

See your Cinema 4D Interactive Render inside the HDR Light Studio interface

Supported in Cinema 4D R20 only, with Arnold, Octane, Redshift, Thea.

Added support for Corona render - R18,19,20.

Cinema 4D Interactive Render View inside HDR LIght Studio

For compatibility ensure you are running 'at least' these renderer builds:

Octane Version: 2018.1.3 (Octane 5) or 4.04-R2 (Octane 4)

Arnold Version: 2.5.0

Redshift Version: 2.6.40

Thea Version: 2.1.457.1847

Bug Fixes:

Cinema 4D Connection - Duplicating object in C4D incorrectly closes HDR Light Studio.

Cinema 4D Connection / Thea - Camera visibility setting on area lights not working.

Cinema 4D Connection / Arnold - Crash/hang bug with area lights and IPR running.

Cinema 4D Connection / Redshift - Camera visibility setting on area lights not working.

Cinema 4D Connection / Arnold - Updated to use TX file for proxy updates and missing textures. 

Cinema 4D Connection - 2018.1115 released 19th Nov 2018 (updated, fixes issue with 2018.1108

build)

Fixed bug where existing embedded HDR Light Studio projects were not loading using the C4D

Connection 2018.1108 build

Added support for Cinema 4D r20

Fixed: Area light textures not working correctly with Redshift

Fixed: HDRLS connection panel was not showing current renderer

Fixed: Thea area lights having texture facing wrong direction

Build 2018.0723

Updated to fix an Area Light bug when used with the latest version of HDR Light Studio.

Build 2018.0208

Redshift Renderer support added
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Updated to support VRay4C4D version 3 correctly

Press Play button in HDR Light Studio to automatically import the scene from Cinema 4D

BZ# 1784 C4D Copy Paste bug that was selecting HDRLS hook

Plus minor bug fixes

Build 2017.1123

Added support for CINEMA 4D R19

Fixed: C4DtoA hook stopped working after Arnold 2.1.2 update

Fixed: C4DtoA Area light textures are not loading correctly

Fixed: Bug where selecting an object, then copy and paste it (either CTRL+C then CTRL+V, or

CTRL+Drag) the HDR Light Studio Environment was being selected.

Build 2017.0718

Now correctly supports C4DtoA (Arnold) version 2.0.3+

Build 2016.1124

Support added for new area light advanced rotations and light handle

Cinema 4D R18 is now supported

Updated Thea support to use bitmap shader parameters instead of filenames parameters in the

Thea Sky Tag. Minimum supported version of Thea in Cinema4D is v1.5.07.271

Bug 1526 - Fixed C4D Arnold & V-Ray: Z rotation incorrect when converting a light to an Area Light

Build 2016.0511

Supports Area Light creation and control

Build 2015.1102

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Bug 1044 - OBJ export bug with Cinema 4D R17 fixed.

Bug 1002 - Fixed bug where switching between export formats in plugin not changing file extension

of filename.

Fixed bug where HDRLS can not be stopped when it's hidden.

Build 2015.1028

Support added for Cinema 4D R17

Build 2015.0626

Support for Arnold renderer has been added.
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Support for the Thea renderer has been added.

Plug-in user interface has been updated to be more consistent with the plug-in connections.

Known Issues

LightPaint issue in the Cinema 4D Viewport

When using a low polygon model with a Phong Tag - light positions can appear wrong when Light

Painting in the Cinema 4D viewport (or the Cinema 4D render in the HDR Light Studio interface). The

reasoning for this is that the Phong tag interpolates across the polygon edges to "smooth" out the

model, but this smoothing isn't taken into account in any of the maths functions we use to calculate

the LightPaint positions. The workaround is to export the model into HDR Light Studio with the

Phong tag on, and our Renderer will handle the "smoothed" surfaces fine with LightPainting inside

HDR Light Studio.
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DeltaGen Connection

HDR Light Studio is designed to generate a high resolution, high dynamic range image used for

image based lighting. As you shape the lighting, the DeltaGen connection seamlessly pulls HDR Light

Studio's environment map back into DeltaGen without having to import/export via the file system.

· Installation

· Connection Overview

· Connection Workflow

· Release Notes



803

803Connections (Plug-Ins)

Installation

Installing on Windows

Uninstalling

Notes for HDR Light Studio 4 users
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Installing on Windows

Important Note:

You should install the main HDR Light Studio application first, prior to installing our DeltaGen

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure DeltaGen is not running prior to installing our DeltaGen Connection plug-in.

1. Download the DeltaGen plug-in connection for HDR Light Studio from our web site. Pick the

appropriate installer for your version of DeltaGen.

2. Run the installer. 

For DeltaGen 12, this copies the files from the installer to:

C:\Program Files\RTTSoftware\Release12.2\HDRLightStudioConnection

For DeltaGen 13, this copies the files from the installer to:

C:\Program Files\Dassault
Systemes\3DEXCITE\DELTAGEN13.0\plugins\HDRLightStudioConnection3DEXCITEDELTAGEN

3. Run DeltaGen. Go to:

Tools > Modules and Plug-ins > Add Plug-in 

and navigate to the DeltaGen's plug-in folder. Inside the HDRLightStudioConnection folder, select the

file:

HDRLS5Connection Deltagen.xml

An entry for HDR Light Studio will appear in the Plug-ins section of the doalog. Click on the

load/autoload check boxes as required.
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Modules and Plug-ins menu

4. If the installation was successful there will be an HDR Light Studio Connection menu entry under

DeltaGen's main menu, Windows >
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HDR Light Studio menu entry under the Windows

menu

You should now proceed to Licensing. For information on using the connection see DeltaGen

Connection.
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Uninstalling

To remove the HDR Light Studio plug-in connection to DeltaGen, run the uninstaller in the following

directory, if you're on Windows.

C:\Program Files\Lightmap\HDRLightStudioConnection3DEXCITEDELTAGEN\Uninstall HDR Light Studio
Connection For 3DEXCITE DELTAGEN 13.0.exe
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Notes for HDR Light Studio 4 users

If you are currently using DeltaGen with HDR Light Studio 4, you will need to uninstall the DeltaGen

plug-in HDR Light Studio 4 before installing and using HDR Light Studio.

To remove the plug-in for HDR Light Studio 4, start DeltaGen and from the main menu select Tools >

Modules and Plug-ins and click the red cross (x) next to HDR Light Studio 4. This will unload the plug-

in. Quit DeltaGen and navigate to the DeltaGen plug-in folder.

C:\Program Files\RTTSoftware\Release12.2\plugins

Delete the HDRLightStudio4 directory. Now install the DeltaGen plug-in connection for HDR Light

Studio.
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Overview
1. Start DeltaGen.

2. Add a model.

3. Select a local surrounding or an ambience as a basis for the lighting from HDR Light Studio.

4. Start HDR Light Studio.

5. Add lights to the canvas in HDR Light Studio to illuminate the model in DeltaGen.

6. Position the lights by clicking on the model in DeltaGen.

7. When the lighting design is finished, render a high resolution image to disk. DeltaGen then points

at the file on disk rather than the HDR Light Studio output.

8. Save the HDR Light Studio project within the DeltaGen scene file.

9. Quit DeltaGen.
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Workflow

1. Opening HDR Light Studio Connection Panel

Start DeltaGen.

Load a scene or create some geometry.

Before we start to use HDR Light Studio to light the scene.... we need to make sure the scene is ready

to light first. We need to make sure there is a camera setup with the final composition for the shot

that we want to light. If we move the camera during the lighting process, the reflections of the lights

will move and this will ruin the lighting.

When your scene is ready to be lit, Load the HDR Light Studio panel from Windows > HDR Light

Studio Connection. By default the panel will appear in the bottom left hand corner of the screen.

HDR Light Studio Connection Panel

2. Adding a Spherical Environment Map

In the Scene tree, select the local surrounding or the ambience. A new local surrounding or

ambience can also be created by right clicking on the .csb file and selecting Create New > Local

surrounding or Ambience.
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Please note: For lighting with Ambiences, DeltaGen 2022x and HDR Light Studio DeltaGen

Connection build: 2021.1110 or newer is required.

In this example, we'll work with a local surrounding. 

Creating a new local surrounding or ambience

3. Starting HDR Light Studio in Connection with DeltaGen

With the local surrounding or ambience selected, press the Edit button in the HDR Light Studio

Connection panel to start HDR Light Studio in connection with your DeltaGen session.

Edit button in HDR Light

Studio Connection panel



812

812Connections (Plug-Ins)

You will notice that the studio environment lighting has been replaced by the output from HDR Light

Studio. This is a default gradient background. 

Default grey background

4. Lighting DeltaGen scene in HDR Light Studio

Create  a white round light in HDR Light Studio. In DeltaGen select LightPaint, Ref, and click on the

model in DeltaGen. The light moves so that it is reflected in the model where you clicked.

Clicking on the model to position the lights

Add more lights.
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Lighting design after adding more lights

5. Finalizing the Lighting Design

Once you are happy with your lighting, press the Render Production HDRI button in HDR Light

Studio.

It says HDR on it.

Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to 'DeltaGen/DeltaGen', this ensures that the rendered HDRI map is mapped correctly in

the host, i.e. DeltaGen. For more information see: Production Render Dialog
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Production Render Panel

DeltaGen then automatically points at the file saved to disk rather than HDR Light Studio output. You

can see this in DeltaGen's Object Editor panel in the Local Surrounding or ambience tab. HDR Light

Studio's interface will become disabled.

HDR Light Studio in disabled state.

6. Save the DeltaGen scene to store the HDR Light Studio lighting

project
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If you would like the HDR Light Studio project to be saved in your DeltaGen scene for next time you

load this DeltaGen scene, you should save your DeltaGen scene now. This way the scene state

matches the HDRI map that is currently in the HDR Light Studio project.

Quit DeltaGen.
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Release Notes

Release Notes

Build 2023.0327

DeltaGen 2023 (and the x-builds) support added.

Performance improvements for DeltaGen 2023 (and the x-builds)

Bug fix related to editing a HDR and not rendering the edited map. Original HDR is correctly

maintained in this situation.

Build 2021.1110

DeltaGen 2022 (and the x-builds) support added. This connection update is compatible with the new

Ambience nodes

DeltaGen 2021x support added 6th April 2021

DeltaGen 2020x support added 16th April 2020

Build 2019.0115

DeltaGen 2019 (and the x-builds) support added

Build 2018.0118

Added support for DeltaGen Suite 2018x

Support/plug-in added for DeltaGen 2017x (16 December 2016)

Support/plug-in added for DeltaGen 2017 (11 August 2016)

Build 2016.0218

Updated for compatibility with HDR Light Studio 5.3

Bug 1155 '_ll' should now be appended once, if '_ll' is already at the end of the file name it will not be

added again.

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Build 2015.0522

Supports DeltaGen versions 12.1, 12.2, 13, 13.1
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Known Issues

Issues when using HDR Light Studio in unlicensed demo mode

Loading/Creating a new scene in DeltaGen 2017 then adding lights in HDR Light Studio unlicensed

'demo' mode, and then saving the DeltaGen project will cause a couple of issues when loading the

project back into DeltaGen: 

1. The default lighting on the model and background will not load correctly in both the Look and

Stellar renderers: lighting will look wrong in the Look renderer, and will appear chequered in the

Stellar renderer.

2. The lights that were "saved" will appear in the local surrounding image in the connection panel:

these will disappear once HDR Light Studio demo mode is launched again.

To avoid these issues. Try HDR Light Studio for 15 days with a full license.

Please email sales@lightmap.co.uk to arrange your trial.
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Houdini Connection

The Houdini Connection is a plug-in that creates a bridge between HDR Light Studio and Houdini.

As the HDRI map and Area Lights are created in HDR Light Studio, Houdini is kept in sync.

Supported Renderers: Mantra, Arnold, Redshift, V-Ray, RenderMan, Octane

· Installation

· Interface Overview

· Workflow

· Managing Performance/Resources

· Release Notes
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Installation
1. Installing on Windows

2. Installing on MacOS

3. Installing on Linux

4. Uninstalling

Installing on Windows

Please note: 

• You should install HDR Light Studio before installing the Houdini plug-in connection. See

installation instructions for HDR Light Studio here.

• You should uninstall any older versions of the Houdini plug-in (HDR Light Studio Connection) for

your Houdini version - see uninstalling.

STEP 1: Download the HDR Light Studio 'Houdini connection' file from our website. 

STEP 2: Place the .zip file in the location of your choice. This is where the Houdini connection

files will be stored.

In this example, we will store it in C:\Program Files\Lightmap\HDRLightStudioConnectionHoudini\19.5

STEP 3: Unzip / Extract the file.

Figure 5: Extracting the downloaded file

The content of the extracted Houdini connection file will look something similar to the below.
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Figure 5: Content of the downloaded file

We no longer need the Houdini connection .zip file, so let's delete it.

STEP 4: Copy the packages folder and paste it inside your Houdini folder, e.g. Houdini19.5 folder

Important: HDR Light Studio plug-in connection is only supported with Python 3 builds of

Houdini.

By default it is stored in Documents, in this example: C:\Users\myself\Documents\houdini19.5 - You'll

know you're in the right folder because it will contain a houdini.env file inside it.

If you do not see the Houdini folder or the houdini.env file for your version of Houdini, it may be

because that version of Houdini was not started on your machine yet. Simply start-up Houdini, then

close it, and you should now see the Houdini folder and the houdini.env file inside it.



821

821Connections (Plug-Ins)

STEP 5: Go inside the packages folder you have pasted in Step 4, then right click on

hdrlightstudio.json file and open it with Notepad

STEP 6: Copy the file path to your Houdini Connection files (from Step 2) and replace the default

HDRLS_HOME file path with your copied file path

By default HDRLS_HOME variable will be set to C:/Program

Files/Lightmap/HDRLightStudioConnectionHoudini

In Step 2, we have stored the Houdini Connection files at a location of our choice, in this example in

C:\Program Files\Lightmap\HDRLightStudioConnectionHoudini\19.5, so this will be the file path that we

need to use as the HDRLS_HOME variable in hdrlightstudio.json file.

Please note: Be sure the file path you paste is contained within quotation marks, e.g. "C:\Program

Files\Lightmap\HDRLightStudioConnectionHoudini\19.5"
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STEP 7: That's it! You can now launch Houdini and in the Scene Graph panel press the Tab key

and select HDRLSConnectionCtrl

Installing on MacOS

Please note: 

• You should install HDR Light Studio before installing the Houdini plug-in connection. See

installation instructions for HDR Light Studio here.

• You should uninstall any older versions of the Houdini plug-in (HDR Light Studio Connection) for

your Houdini version - see uninstalling.

STEP 1: Download the HDR Light Studio 'Houdini connection' file from our website. 

STEP 2: Place the .zip file in the location of your choice. This is where the Houdini connection

files will be stored.

In this example, we will store it in /Applications/HDRLightStudioConnectionHoudini

It's a good practice to create a folder dedicated to storing Houdini connection files for various

Houdini versions. In this example, we have created a folder called

HDRLightStudioConnectionHoudini.
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STEP 3: Unzip / Extract the file (see Figure 6).

The content of the extracted Houdini plug-in file will look something similar to the below.

Please note: If your extracted content doesn't look similar to the below, you are probably trying

to install a Houdini Connection for an older version of HDR Light Studio. See the User Guide for your

installed version of HDR Light Studio; in HDR Light Studio go to Help > User Guide

We no longer need the Houdini connection .zip file, so let's delete it.

STEP 4: Copy the packages folder and paste it inside your Houdini folder, e.g. Houdini18.5 folder

Important: HDR Light Studio plug-in connection is only supported with Python 3 builds of

Houdini.

By default the Houdini folder is located in ~/Library/Preferences. This is a hidden user library, you can

access it from the Finder by selecting Go to Folder from the Go menu at the top of the screen. Then,

entering ~/Library/Preferences and clicking Go.
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You'll know you're in the right folder because it will contain a houdini.env file inside it. If you do not

see the Houdini folder or the houdini.env file for your version of Houdini, it may be because that

version of Houdini was not started on your machine yet. Simply start-up Houdini, then close it, and

you should now see the Houdini folder and the houdini.env file inside it. 

STEP 5: Go inside the packages folder you have pasted in Step 4, then right click on

hdrlightstudio.json file and open it with TextEdit
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STEP 6: Copy the file path to your Houdini Connection files (from Step 2) and replace the default

HDRLS_HOME file path with your copied file path

By default HDRLS_HOME variable will be set to C:/Program

Files/Lightmap/HDRLightStudioConnectionHoudini.

In Step 2, we have stored the Houdini Connection files at a location of our choice, in this example

in /Applications/HDRLightStudioConnectionHoudini/Houdini, so this will be the file path that we need to

use as the HDRLS_HOME variable in hdrlightstudio.json file.
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When editing the hdrlightstudio.json file, you may be informed that the file is locked. Be sure to

unlock it so you can save your changes.

Please note: Be sure the file path you paste is contained within quotation marks, e.g.

"/Applications/HDRLightStudioConnectionHoudini/Houdini"
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STEP 7: That's it! You can now launch Houdini and in the Scene Graph panel press the Tab key

and select HDRLSConnectionCtrl

Installing on Linux

Please note: 

• You should install HDR Light Studio before installing the Houdini plug-in connection. See

installation instructions for HDR Light Studio here.

• You should uninstall any older versions of the Houdini plug-in (HDR Light Studio Connection) for

your Houdini version - see uninstalling.

STEP 1: Download the HDR Light Studio 'Houdini connection' file from our website. 
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STEP 2: Place the .tar.gz file in the location of your choice. This is where the Houdini connection

files will be stored.

In this example, we will store it in home/myself/hdrls/connections/houdini/

STEP 3: Unzip / Extract the file (see Figure 7).

Example using Linux command line:

Change the directory to the location of the downloaded Houdini plug-in file.

For example: if it's in home/myself/hdrls/connections/houdini/18.5 you'd use cd to go to the home

directory and then use cd ~/hdrls/connections/houdini/18.5 followed by:

tar -xvf houdini_18.5_linux_2021.0504.tar.gz



829

829Connections (Plug-Ins)

The content of the extracted Houdini plug-in file will look something similar to content shown below.

Please note: If your extracted content doesn't look similar to the below, you are probably trying

to install a Houdini Connection for an older version of HDR Light Studio. See the User Guide for your

installed version of HDR Light Studio; in HDR Light Studio go to Help > User Guide.
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We no longer need the Houdini connection .tar.gz file, so let's delete it.

STEP 4:  Copy the packages folder and paste it inside your Houdini folder, e.g. Houdini18.5

folder

Important: HDR Light Studio plug-in connection is only supported with Python 3 builds of

Houdini.

By default it is stored in your Home directory - You'll know you're in the right folder because it will

contain a houdini.env file inside it.

If you do not see the Houdini folder or the houdini.env file for your version of Houdini, it may be

because that version of Houdini was not started on your machine yet. Simply start-up Houdini, then

close it, and you should now see the Houdini folder and the houdini.env file inside it.
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STEP 5: Go inside the packages folder you have pasted in Step 4, then right click on

hdrlightstudio.json file and go to properties. Ensure the access of that file is set to 'Read and

write'
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STEP 6: We now need to edit the hdrlightstudio.json file. So, let's right click on it and open it

with Text Editor
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STEP 7: Replace the default HDRLS_HOME file path with a file patch to your Houdini connection

files (from Step 2)

By default HDRLS_HOME variable will be set to C:/Program

Files/Lightmap/HDRLightStudioConnectionHoudini

In Step 2, we have stored the Houdini Connection files at a location of our choice, in this example in

home/myself/hdrls/connections/houdini, so this will be the file path that we need to use as the

HDRLS_HOME variable in hdrlightstudio.json file.

Please note: Be sure the file path is contained within quotation marks, e.g.

"home/myself/hdrls/connections/houdini"
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STEP 8: That's it! You can now launch Houdini and in the Scene Graph panel press the Tab key

and select HDRLSConnectionCtrl

Uninstalling

To uninstall the Houdini plug-in connection, simply delete the packages folder from your Houdini

folder. By default the Houdini folder will be stored in:

[On Windows] Documents, e.g. for Houdini 18.5 it may be in C:\Users\myself\Documents\houdini18.5

[On MacOS] Preferences, e.g. for Houdini 18.5 it may be in  ~/Library/Preferences/houdini/18.5

[On Linux] Home Directory, e.g. for Houdini 18.5 it may be in home/houdini18.5

Please note: If you do not have the packages folder, you have probably used the old Installation

method. See the User Guide for your installed version of HDR Light Studio; in HDR Light Studio go to

Help > User Guide.

You can now delete the folder containing the Houdini connection files from where they were

installed. In our installation instructions, we have installed them in:

[On Windows] C:\Program Files\Lightmap\HDRLightStudioConnectionHoudini

[On MacOS] /Applications/HDRLightStudioConnectionHoudini/Houdini

[On Linux] home/myself/hdrls/connections/houdini
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Interface Overview
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Workflow

This workflow tutorial teaches how to use HDR Light Studio with

Houdini via the Connection.

Watch the HDR Light Studio - Quick Start video first to learn the key

concepts of using HDR Light Studio.

Ensure you have installed both the HDR Light Studio main application and the HDR Light Studio

Connection for Houdini (Python 3 build).

For compatibility ensure you are running at least HDR Light Studio 8.1.1 (build 2023.0515).

Start Houdini and Load your Houdini Project

Before we start to use HDR Light Studio to light this scene.... let's make sure the scene is ready

to light first.

Camera View

Make sure you have a camera setup with the final composition for the shot that you want to light. If

you move the camera during the lighting process, the reflections of the lights will move and this will

ruin your lighting.

Renderer

Make sure the renderer is set up. In this example, we are using Mantra and have set up the renderer

in the Network View: Outputs by pressing the Tab key and selecting Mantra.

See render specific setup:
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   Redshift

     Arnold

    V-Ray

     Octane
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   RenderMan

Create a HDR Light Studio Connection Controller

Press the Tab key in the Network View: Objects and select Digital Assets > HDRLSConnectionCtrl.

Not seeing HDR Light Studio Connection? See installation instructions
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The HDR Light Studio Connection Controller has been created and the HDR Light Studio connection

panel will open.

Set Renderer

Use the Renderer drop-down in the Connection panel to set the Renderer for this Houdini

project.

This tells HDR Light Studio which renderer it will create lighting for. In this example, we are choosing

Mantra in the drop-down.

Create a new EnvLight Hook
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Use the EnvLight Hook menu in the Connection panel to create a New Hook.

You will be asked to name your EnvLight hook. In this example, we will use the default name:

My_Mantra_Hook.

Please note: If you have given your EnvLight Hook a name and you decide to change it later, do

not rename it until you start HDR Light Studio. EnvLight Hooks should only be renamed while HDR

Light Studio is running.

The EnvLight hook will contain a single HDR Light Studio project (consisting of a single Environment

Light plus any area lights).

We can see the Environment Light has been created for our renderer and it has inherited its name

from the EnvLight hook it is associated with.
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Information for Octane Users

When using Octane Renderer, the hook created by HDR Light Studio will be located in Network

View: Vex Builder

Working with Multiple EnvLight Hooks
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HDR Light Studio connection supports working with multiple EnvLight Hooks in a Houdini scene.

You can create additional EnvLight Hooks from the EnvLight Hook menu or manually create your

own Environment Lights and they will be listed in the EnvLight Hook drop-down.

Use the EnvLight Hook drop-down to select the HDR Light Studio project you want to work on. 

When HDR Light Studio is started from the connection panel in Houdini, the HDR Light Studio

project associated with the selected EnvLight Hook will be loaded into HDR Light Studio for

editing. If there is no project data associated with the selected EnvLight Hook, HDR Light Studio

will create one when you load the EnvLight Hook for the first time in HDR Light Studio. 
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Depending on the Status and whether the Project Data is present or not, you may need to

unlock the lighting design before you can edit the HDR Light Studio project. There is more

information on this later in this workflow tutorial – learn more here.

Houdini layers the results of multiple Environment Lights on top of eachother. So, if you switch

between different EnvLight Hooks and you see stand-in blue HDR Light Studio logo images

lighting your scene, it’s because one or some of your EnvLight Hooks are not using final

production files. There is more information on this later in this workflow tutorial – learn more

here.

Start HDR Light Studio

Press Start to start HDR Light Studio in connection with Houdini.

Please Note: If HDR Light Studio is already open standalone, connected with another 3D app, or

connected to another session of Houdini - the connection will not function correctly. So please

ensure HDR Light Studio is not already open before starting it from Houdini.

The HDR Light Studio application will now open connected with Houdini. Notice how the Project

Data has changed to Present and Status to Live Temp Files - Design Unlocked.
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Behind the scenes, the HDR Light Studio connection has embedded project data in the Houdini

scene and it has taken control of the environment image on the Environment Light called

My_Mantra_Hook. The HDRI map from HDR Light Studio is now shared with Houdini as a temporary

low-res image (a proxy). This image is fast to calculate and fast for Houdini to load and use during the

interactive lighting design process.
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When the lighting design changes in HDR Light Studio, the Environment Light in Houdini is updated

to use a new temp file. The temp file will have a new file name with a random number on the end.

This ensures the renderer uses the new image and not a cached old image.

Tip: Renaming EnvLight Hooks

Ensure HDR Light Studio is running when renaming EnvLight Hooks, or else it will cause project

data to be disassociated.

You can rename the EnvLight Hook by selecting the EnvLight Hook you want to rename from the

EnvLight Hook drop-down and then going to the EnvLight Hook menu and pressing Rename

Hook. 

Default HDR Light Studio Interface Layout with Houdini

By default, the HDR Light Studio interface should look something like the image shown below.

If not, you can reset the HDR Light Studio interface layout by going to the menu: Window >

Layout > Load > Default > Houdini



846

846Connections (Plug-Ins)

Most professional 3D artists have at least 2 displays. Using 2 displays provides the best workflow

because you can place Houdini on one display and HDR Light Studio on the other. If you have one

display.

Exporting your scene into HDR Light Studio's Internal Renderer

When we used HDR Light Studio standalone, we used the Render View [HDR Light Studio] to position

the lights on an interactive render of the scene. Let's get the Houdini scene into HDR Light Studio's

Render View so we can paint it with light.

The easiest way to do this is by pressing the Play button on Render View [HDR Light Studio]
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Figure 7: Starting HDR Light Studio Render View

Because HDR Light Studio is connected with Houdini, the Import Scene Geometry panel pops up.

Leave the settings at their default and press the Import button

By default, the whole Houdini scene is exported as an Alembic file (that's automatically deleted after

your lighting session) and loaded into the Render View [HDR Light Studio].

However, selected scene geometry can be exported using the Scene Export tab in the HDR Light

Studio Connection panel if required.

Using the Scene Export Tab in the Connection

The scene export tab provides more control over exporting the Houdini scene into HDR Light

Studio's Render View.
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Selection Only

If you only want parts of your scene to be exported, check Selection Only, for the currently

selected objects in Houdini to be exported. Make sure you include the cameras in the selection.

Temporary File

If you check Temporary File, the exported file is deleted once the lighting session in HDR Light

Studio has finished.

Permanent File

If you have a very large scene that takes a very long time to export and you feel you may keep

returning to HDR Light Studio to re-light the scene, you may want to export it as a permanent file

instead. To do this, use the folder button to set a file name and file location before pressing the

Export button.

Once all settings have been chosen

Press the Export Scene To HDR Light Studio button and the file will be exported by Houdini and

then automatically loaded into HDR Light Studio's Render View.

We will now use this Render View in HDR Light Studio as the interface for positioning lights on the

model, with real-time rendered feedback.
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Let's make our first Light

By default, LightPaint is set to Reflection in this view. So lights are moved to reflect in the clicked or

dragged location on the 3D model.

Learn about LightPaint here.

Drag and drop a Preset Light onto the 3D model in the Render View.

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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A new light is added to the lighting design - it's reflecting where the light was dropped on the 3D

model.

You will see:

•   1. New light added in the Light List

•   2. New light can be seen on the Canvas

•   3. Render View has been updated to show the new light on the model

Just the same as when we used HDR Light Studio standalone, but we have the Houdini scene in our

Render View.
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Move and Brighten the Light

You can see that the LightPaint tool is active in the toolbar in the Render View [HDR Light Studio].

Click on the 3D model to reposition the selected light (highlighted on the Light List).

Then, increase the brightness of the light in the Light Properties panel. 
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Interactive Rendering in Houdini

Whilst we have been working in HDR Light Studio, Houdini has been updated with every lighting

change, via the Connection. Let's start interactive rendering in Houdini so we can see the lighting.

Start Mantra interactive rendering in Houdini.

Information for Octane Users

When using Octane, interactive rendering cannot be started from the Render View panel in Houdini.

Interactive rendering can be started using the IPR, available from the Octane shelve instead. 

Mantra starts interactive rendering using the current lighting from HDR Light Studio.

You can see the lighting in HDR Light Studio's render view is matching with the interactive render in

Houdini. 

We can leave Mantra interactive rendering in Houdini as we work on the lighting in HDR Light Studio.
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Tip: If the scene is large/complex and interactive rendering in your renderer is too slow, then

produce test renders from time to time.

Making Area Lights - A 3D light mapped with an HDR texture

So far, the lighting we created is on the HDRI map shared with Houdini. This is about to change!

Please Note: Only Lights with 3D mapping show the option to be converted into area lights, as

these are the only lights that make sense to become area lights.

Enable the Area Light check box in the Light Properties panel for the selected light.

Figure 7: Converting a light into an area light

As a result of enabling this Area Light setting, the lighting looks very similar to before, but lots of

things just happened with that single setting:

•   1. The light in the Light List gets the suffix [AreaLight] and its text is now yellow.

•   2. The light has been removed from the HDRI map but is still represented on the Canvas as a view

of the light as seen from the center of the world. Don't be confused, it's really no longer on the HDRI
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map lighting the shot!

•   3. Additional Area Light properties have been added to the Light Properties for this light, with a

default Smart Dolly distance of 1,000 units.

•   4. An area light has been created in the Render View [HDR Light Studio], mapped with the HDR

texture to control its appearance.

•   5. An area light has been created in Houdini for the selected renderer - mapped with the HDR

texture from HDR Light Studio, and matching the size and position of the area light in HDR Light

Studio.

Information for Arnold and Octane Users

When new geometry is added, e.g. area lights, the geometry and their effect on the scene may not be

shown in the render view. The interactive rendering requires to be re-started. 

Information for Octane Users

Currently, area lights will not show correctly due to a bug - we are waiting for OTOY to fix this. HDR

Light Studio plug-in sets the “Use Alpha” check box in the Distribution-IES Texture panel of the

Shader settings in the area light properties, but now when this is set, you will not see the light.

The workaround is to uncheck this tick box. However, that means you will have no alpha on your

area light.



855

855Connections (Plug-Ins)

Change the Area Light Distance

Initially, the Area Light will be far away from your model providing a similar lighting effect to when it

was on the HDRI environment light. We need to move it closer to the model so you can see it in the

Render View and in the Houdini viewport.

Reduce the Smart Dolly slider value to move the light closer to the 3D model.

Tip: HDR Light Studio has a scene scale setting that is useful when working with Area Lights in

Houdini. If the area lights are too close or too far away by default, adjust the  Smart Dolly Scalar value

in Preferences. This value scales all area light distances in HDR Light Studio.

Let's take a look at the Houdini interface now. You can see:

•   1. The Area Light that HDR Light Studio created can be seen in the interactive render.

•   2. Area Lights made with HDR Light Studio are shown inside the HDRLS Area Lights network box

associated with our EnvLight Hook. In this example inside the HDRLS Area Lights

(obj/My_Mantra_Hook) network box.

•   3. The Area Light has been set up for your renderer. You can see the texture from HDR Light Studio

mapped to the light properties. This texture is updated when the light's appearance is changed in

HDR Light Studio.

Please Note: Renaming/deleting/duplicating HDR Light Studio area lights in Houdini (or any part

of their associated shader network/file nodes) will cause problems!

http://help.lightmap.co.uk/hdrlightstudio5/reference_preferences.html
http://help.lightmap.co.uk/hdrlightstudio5/reference_preferences.html
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Moving Area Lights

In HDR Light Studio, use LightPaint in the Render View [HDR Light Studio] to move the Area

Light.

Area lights are controlled just like any other light in HDR Light Studio with the addition of distance

controls.

Information for Arnold Users

Cam Visibility - The ability to set whether the area light can be seen by the camera both in HDR Light

Studio and your host/renderer is not supported by Arnold. 

Information for Redshift Users
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Redshift Area Lights initially do not support an alpha channel. However, if Cam Visibility (in HDR Light

Studio, under Light Properties tab) is unchecked on a Redshift area light, the alpha channel will be

applied to the reflections.

Area Light Spread - Redshift, V-Ray, Arnold, RenderMan

You can use the Spread slider in the Light Properties panel to control area light

spread/directionality. This is supported by Redshift, V-Ray, Arnold and RenderMan. This setting is

ignored by other renderers in Houdini.
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This is how the spread setting changes the light emitting from the area light.

Here you can see the effect of changing this setting, see how the light becomes more focused on

the shaver with lower settings.
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Default Spread = 1

Spread = 0.5

Spread = 0.00

Finalizing the Lighting Design

Rendering the Final HDRI Lighting Textures
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So far we have been sharing lo-res temporary textures with Houdini for your lighting - to keep things

fast during the lighting design process.

Now let's complete the lighting process by producing higher resolution and higher quality sub-

sampled HDR textures on disk.

Press the Production Render button in HDR Light Studio.

The top HDR button on the toolbar

Set your Production Render settings

Notice how the Orientation is already set for Houdini and your set renderer. This ensures that the

rendered HDRI map is orientated correctly when rendered.

For more information on these settings see: Production Render Dialog 

Press the Browse button to choose a file location and give the lighting file a name.

Press the Render button in this panel.

The production quality HDR textures will now be calculated and saved as permanent files on disk.

Once complete, the connection automatically updates Houdini to use these new textures.

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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The HDR Light Studio interface will disable control and the Status inside the connection panel in

Houdini will change to Final Render – Design Locked. This is to stop you from accidentally making

any further changes to the lighting in HDR Light Studio, which would cause all lighting textures to

update to use new temporary images, and the link to the rendered permanent files to be broken.

Stopping HDR Light Studio

Please ensure you Stop the HDR Light Studio connection after you have rendered your final lighting

files.

Press the Stop button.

HDR Light Studio now closes and leaves your Houdini scene with an awesome lighting setup for your

renderer. This scene uses standard lights and can be rendered anywhere, even on computers

without HDR Light Studio licenses.

Please note: Scenes lit with HDR Light Studio can be loaded and rendered without the HDR Light

Studio connection installed. This means you can put the scene through a render farm or share it with

others. However, if HDR Light Studio OTL is left present in the scene and it has been shared with a

computer that does not have HDR Light Studio OTL present (e.g. the HDR Light Studio connection for
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Houdini was never installed on that machine), then the user will see a standard Houdini error

message informing that the OTL is not complete. To avoid this, simply remove the HDR Light Studio

OTL before sharing/submitting the scene. 

What happens when you stop the HDR Light Studio connection without rendering the

final HDRI lighting textures?

If you stop HDR Light Studio and have not done a Production Render of your final HDRI lighting

textures, your Houdini scene would still be using temporary low-res temporary images. When the

HDR Light Studio session is over and the connection is stopped, the temporary low-res proxy

images are deleted. Therefore, the connection detects this and updates Houdini to use the blue

HDR Light Studio logo image on the Environment Light and the Area Lights. This prevents the

scene from referencing missing image textures, and also makes it obvious that the scene is not

using the final high-quality lighting, ensuring the scene is not rendered by mistake using proxy

content.

So, it’s important to always render your final HDRI lighting textures at the end of the lighting

session in HDR Light Studio, to provide the highest quality lighting images for your final renders in

Houdini.

Editing Existing Lighting

If you want to edit existing lighting, choose the lighting design you want to edit from the EnvLight

Hook drop-down and Start HDR Light Studio from the connection panel in Houdini. Depending on

the state of the lighting project, your HDR Light Studio interface may or may not be disabled upon

opening. 
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The state of the lighting project is judged by the Status and whether the Project Data is present - as

seen in the HDR Light Studio connection panel in Houdini. 

Project Data

None

The selected EnvLight Hook was never opened in HDR Light Studio. This is the state of a brand new

EnvLight Hook. 

Present

The selected EnvLight Hook was opened in HDR Light Studio at some point and has Project Data

associated with it which is embedded in the Houdini scene.

Status

Not used by HDR Light Studio

If there’s no Project Data associated with the selected EnvLight Hook then this lighting design was

never opened in HDR Light Studio. 

Live Temp Files - Design Unlocked

The selected EnvLight Hook has Project Data and the HDRI lighting textures from HDR Light Studio

are being shared with Houdini as temporary low-res images (a proxy). The lighting design is unlocked

so the HDR Light Studio interface will not be disabled upon opening. 

Final Render - Design Locked

The HDRI lighting textures from HDR Light Studio are being shared with Houdini as permanent high-

res files on disk. The lighting design is locked so the HDR Light Studio interface will be disabled upon

opening – the user will need to unlock the lighting design if they wish to edit it in HDR Light Studio. 

Final Render - Design Unlocked

The HDRI lighting textures from HDR Light Studio are being shared with Houdini as permanent high-

res files on disk. The lighting design is unlocked so the HDR Light Studio interface will not be disabled

upon opening.
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No matter the state of your lighting project, HDR Light Studio will open and if the project data

already exists, it will load the lighting design that’s embedded in the Houdini scene. You can then

unlock the lighting design (if applicable) and edit the lighting. Just make sure to render the final HDR

textures at the end of the process.

Save the Houdini scene

The current state of the HDR Light Studio project is embedded in the Houdini project. You should

save your Houdini scene now.

Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as an HDi file (native HDR Light Studio project file), even when using HDR Light

Studio via a connection. If you were to open HDR Light Studio in a connection with Houdini, this

project can be loaded into HDR Light Studio using Project > Open Project. The lighting design would

load into HDR Light Studio replacing its current design, and would then be synced back into Houdini.

This is how you can move lighting between Houdini projects or between other supported 3D

software.
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Managing Performance/Resources

HDR Light Studio includes its own CPU powered Render View. Import a Houdini scene and quickly

create perfect lighting by clicking and dragging light positions on the 3D model geometry with

realtime feedback. Use Houdini's own interactive rendering at the same time to see the updated

lighting interacting with the final shaders. In this scenario, 2 renderers are running at the same time

and will be competing for your computer's resources. The competing renderers can slow down each

other's performance and the responsiveness of the computer. Here is some advice on how to better

manage this situation by managing the resources better.

Recommendations for Managing Performance/Resources:

GPU Rendering in Houdini

When using a GPU based renderer in Houdini (when HDR Light Studio's renderer is running), it

should not compete with HDR Light Studio. So both renderers should be nice and fast when used at

the same time.

CPU Rendering or CPU/GPU (Combined) Rendering in Houdini

If using CPU or CPU/GPU (Combined) renderering in Houdini when HDR Light Studio's CPU renderer

is running, please consider making the following adjustments to improve performance:

1. In HDR Light Studio's Render View Settings for HDR Light Studio, reduce the Max Samples to a

low number like 5.
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HDR Light Studio's renderer will now stop renderering much sooner after each lighting change,

leaving more resources for Houdini's renderer.

HDR Light Studio's Render View really does not need to resolve to a high quality image, just a few

samples is enough to get a good impression of the lighting. See here:

Please note

One thing to bear in mind is that when using HDR Light Studio using only the HDRI map (i.e. no 3D

area lights). Once HDR Light Studio has collected the render samples, it does not need to re-sample

when the HDRI map changes, i.e. a light is edited on the HDRI map. Therefore, once the progress bar

is fully green, the renderer has essentially stopped 'rendering'. There is a small set of calculations to
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update the image when the HDRI map is changed. But these happen fast. So please understand that

you can leave the Max Samples setting at 80 if you are using only HDRI map based lighting and HDR

Light Studio's own Render View has already completed sample collection.

2. If you still feel the renderers are competing and performance is poor, if possible reduce the

number of threads used by your renderer in Houdini when rendering. Many renderers default to

using all threads. This can reduce Houdini's ability to process messages and images from HDR Light

Studio. For example, if you have a computer with 8 CPU cores, reducing your renderer to use 6 cores

will leave 2 more cores for HDR Light Studio and for handling communications between HDR Light

Studio and Houdini. Additionally reducing thread priority to low can also help. Availability of these

settings varies from renderer to renderer, please consult your renderer's documentation to see how

to change these settings.
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Release Notes and Known Issues

Release Notes | Known Issues

Release Notes

Build 2023.1115

Updated to be compatible with HDR Light Studio 8.2

Build 2023.0823

Support added for Houdini 20.

This build removes support for 18.5, for 18.5 please use Build 2023.0706

Please note: We have spotted a problem introduced with plug-in Build 2023.0706. If the digital

assets from older projects are embedded in the project and are not referencing our latest plug-in,

you may not experience these problems. In fact, we have not had any customers complain about the

issue we have found here.

There were significant changes to our plug-in in 2023.0706. Lighting stored using build 2023.0706 will

work fine with build 2023.0823 and any newer builds. However, there will be an error when loading

older Houdini scenes using HDR Light Studio plug-in versions 2023.0330 and older. The lighting

stored in those projects is not restoring correctly when opening HDR Light Studio. But there is a

workaround if this is required.

1. Install HDR Light Studio Houdini plug-in Build 2023.0330.

2. Open the old scene and start HDR Light Studio.

3. Save the lighting project as a file on disk from HDR Light Studio using Project > Save Project.

4. Close the scene. Install the latest HDR Light Studio Houdini plug-in.

5. Open the old scene and start HDR Light Studio - a warning/error box will pop up.

6. In HDR Light Studio, open the project saved on disk using Project > Open Project. This will

properly restore the lighting design, and a new set of HDR Light Studio area lights will be created

(if there were any in the design)

7. Delete the old HDR Light Studio area lights that have not been synced up properly. These are

grouped in the area light network box (if there were any)

That's it; everything will now work as expected. You have updated your lighting to the new HDR Light

Studio Houdini plug-in version.

We apologize for any inconvenience caused.
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Please note: OCIO config file versions higher than 2.0.2 are not supported by HDR Light Studio 8.1.1.

Users who are using Houdini versions such as Houdini 20 with OCIO config file version 2.1 will be

unable to load their own OCIO profiles. Instead, they will need to use the default profiles provided by

HDR Light Studio. This will be addressed and fixed in the next release of HDR Light Studio.

Build 2023.0706

The Houdini connection now uses our new API for a far more responsive lighting experience. 

The Houdini connection is now only compatible with Python 3 builds of Houdini.

Support added for Houdini 19.5 running on Apple Silicon.

Please note: The HDR Light Studio main application is still an Intel MacOS app and runs via Rosetta on

Apple Silicon computers. However, this does not stop it from performing very well and communicating with

our new plug-ins compiled for Apple Silicon apps.

Updated HDR Light Studio Connection UI.

Compatibility added for Area Light Spread (Redshift, V-Ray, Arnold, and RenderMan).

The path to the rendered HDRI lighting textures now uses $HIP file structure.

Bug fix: The HDR Light Studio connection now prevents users from creating more than one HDR Light

Studio Connection Controller.

Build 2023.0330

Performance improvements.

HDR Light Studio API updates.

Fix some issues with Area Lights.

HDR Light Studio has moved to using a new version of QT. Plug-in updates were required as a result

of this.

Bug fixes.

Build 2022.0624

Support added for Houdini 19.5

Build 2021.1208

Support added for Houdini 19

Support added for RenderMan 24.2

Octane 2021.1.0.4  or newer is required for compatibility with Octane.

Dropped support for Houdini 17.5

Build 2021.0504

On macOS, if HDR Light Studio environment variable is not found/work/set then default install

location used to find HDR Light Studio main app. This allows users to use HDR Light Studio with their

connection who were having technical difficulties due to macOS ignoring our environment variable.
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Build 2021.0203 - Released 6th April 2021

Support added for Python 3 version of Houdini 18.5. Single plug-in supports both Python 2 and 3.

Build 2020.1207

Small bug fixes

November 23rd 2020

Support added for Houdini 18.5

Build 2020.0218 

Small bug fixes

Build 2019.1203

Supports Houdini 18, 17, 17.5

Installation method has been updated. 

Support for V-Ray, Octane & RenderMan has been added.

Support added for Houdini 18

HDR Light Studio Connection interface has been refreshed.

Build 2019.0314

Updated to support Houdini 17.5

Send empty string in place of camera name if no camera in use/selected but there are cameras in the

scene. 

Updated Arnold to use .tx files for its missing textures. 

Build 2018.1015

Updated to support Houdini 17.

Build 2018.0615

Support added for Redshift render.

Area Light creation and control added for Mantra, Arnold and Redshift.

Updated connection workflow - press the start button and env light is created for you.

Build 2018.0131

Minor bug fixes

Build 2016.1124

Minor bug fixes
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Build 2016.0425

Updated compatibility with HDR Light Studio 5.3.3

Build 2016.0219

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Bug 1163: Fixed bug with Houdini not closing the main app if the main app is hidden. 

Bug 972 - Fixed bug where exporting Alembic file from HDRLS plug-in would fail unless .abc was

typed as the extension. We automatically add missing extension to filename in plugin now.

Bug 988 - Fixed bug where connection could not be resumed with HDRLS after a HDRLS crash.

Build 2015.1023

Support for Houdini 15 has been added. 

Build 2015.0814

The Houdini Connection has been updated to be compatible with HDR Light Studio 5.2.1

HDR Light Studio 5.2.1 contains a critical stability fix relating to communications between HDR Light

Studio and host connections.

Build 2015.0706

Support for Houdini 12, 13, 14 has been added. 

Scenes can be pushed into HDR Light Studio and file format for proxy environment map can be

switched between exr and hdr.

Support for Arnold renderer has been added in the following combinations.

Houdini 14.0.361

Houdini 14.0.335

Houdini 14.0.291

Houdini 13.0.498

HtoA 1.5.4

HDR Light Studio 5.2 Build 2015.0716

Houdini connection Build 2015.0706

Known Issues

HDR Light Studio 8.1.1 does not support OCIO config file versions higher than 2.0.2

Some Houdini versions use OCIO config file versions higher than 2.0.2, for example: Houdini 20 uses

OCIO config file version 2.1. This means the users will not be able to load their own Houdini OCIO
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profiles in HDR Light Studio, instead they will have to use the default HDR Light Studio ones. This

issues will be fixed in the next release of HDR Light Studio. 

Importing Scene Geometry

On rare occasions, when you press the play button in HDR Light Studio on Render View [HDR Light

Studio], the Houdini scene might not sync with HDR Light Studio. To fix this, users can click inside the

HDR Light Studio connection panel in Houdini and the scene will sync. 

Octane

Currently, area lights under Octane do not show correctly due to a bug - we are waiting for OTOY to

fix this. HDR Light Studio plug-in sets the “Use Alpha” check box in the Distribution-IES Texture panel

of the Shader settings in the area light properties, but now when this is set, you will not see the light.

The workaround is to uncheck this tick box. However, that means you will have no alpha on your area

light.

Arnold

When IPR Running, if you make an area light in HDR Light Studio (Arnold mesh light) and put a

texture on it, it's shown as white with no texture.  The IPR needs to be restarted before it’s picked up

by Arnold. This is an Arnold bug.

If the IPR completes - changing the light textures will not invalidate and restart the IPR rendering.
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LightWave 3D Connection

HDR Light Studio is designed to generate a high resolution, high dynamic range image used for

image based lighting. The LightWave 3D connection seamlessly pushes the model to HDR Light

Studio and pulls the environment map back into LightWave 3D without having to manually

import/export via the filesystem. The connection allows you to view each of your lighting changes

both in HDR Light Studio’s optimised renderer and in LightWave 3D.

Supported Renderers: LightWave 3D, Octane

· Installation

· Connection Overview

· Connection Workflow

· Release Notes
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Installation

Installing on Windows

Installing on MacOS

Updating the HDR Light Studio Connection

Uninstalling
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Installing on Windows

Important Note:

You should install the main HDR Light Studio application first, prior to installing our

LightWave3D Connection plug-in. See installation instructions for HDR Light Studio here.

The example instructions given are for installing the HDR Light Studio connection for LightWave 3D

2015.

1. Download the HDR Light Studio Connection for LightWave 3D download from our web site. Pick

the appropriate one for your version of LightWave 3D.

2. Unzip the file.

3. Move the folder HDRLightStudioConnection into your LightWave 3D plugins folder so that it looks

like this:

C:\Program Files\NewTek\LightWave2015\support\plugins\HDRLightStudioConnection

4. Start LightWave 3D.

5. Click on the Utilities tab.

6. Select Add Plugins.

7. Browse to the HDR Light Studio for LightWave plug-in you installed earlier and select it.

C:\Program Files\NewTek\LightWave2015\support\plugins\HDRLightStudioConnection\HDRLS_for_LW.p

Now that the plug-in is installed, you need to add the HDR Light Studio menu item to your LightWave

3D user interface.

8. Open the Configure Menus dialog (<Alt-F10>).

9. Right click on Main Menu and click on the Import Branch button.

10.  Open the hdrls_menu_branch.cfg file from the plug-in folder.
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Adding the HDR Light Studio menu item

11.  You should see an HDR Light Studio tab appear on the interface.

This plug-in connection will need a license key to work. You should now proceed to Licensing. For

information on using the connection see LightWave 3D Connection.
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Installing on MacOS

Important Note:

You should install the main HDR Light Studio application first, prior to installing our

LightWave3D Connection plug-in. See installation instructions for HDR Light Studio here.

The example instructions given are for installing the HDR Light Studio connection for LightWave 3D

2015.

1. Download the HDR Light Studio Connection for LightWave 3D download from our web site. Pick

the appropriate one for your version of LightWave 3D.

2. Unzip the file.

3. Move the folder HDRLightStudioConnection into your LightWave 3D plugins folder so that it looks

like this:

/Applications/NewTek/LightWave2015/support/plugins/HDRLightStudioConnection

4. Start LightWave 3D.

5. Click on the Utilities tab.

6. Select Add Plugins.

7. Browse to the HDR Light Studio for LightWave plug-in you installed earlier and select it.

/Applications/NewTek/LightWave2015/support/plugins/HDRLightStudioConnection/HDRLS.plugin

Now that the plug-in is installed, you need to add the HDR Light Studio menu item to your LightWave

3D user interface.

8. Open the Configure Menus dialog (<Alt-F10>).

9. Right click on Main Menu and click on the Import Branch button.

10.  Open the hdrls_menu_branch.cfg file from the plug-in folder.
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Adding the HDR Light Studio menu item

11.  You should see an HDR Light Studio tab appear on the interface.

This plug-in connection will need a license key to work. You should now proceed to Licensing. For

information on using the connection see LightWave 3D Connection.
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Updating the HDR Light Studio Connection

When installing the new LightWave plugin over a previous build, this does not remove the reference

to 'HDR Light Studio 5' in the plugin tab. 

Please do the following:

- Go to Configure Menus (Alt+F10) then delete 'HDR Light Studio 5' from the Main Menu branch.

- Right click on the Main Menu branch and select Import Branch.

- Locate the HDRLightStudioConnection folder in Lightwave - Support - Plugins, then select and open

the hdrls_menu_branch.cfg file.

This should add the correct version to the LightWave menu, and should no longer reference '5'.
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Uninstalling

To remove the HDR Light Studio plug-in connection to LightWave3D.

1. Delete the HDR Light Studio menu set.

2. Go to Utilities > Edit Plugins > Grouping Method. Find and delete the HDRLS_for_LW.p script from

the HDR Light Studio Connection folder.
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Overview
1. Start LightWave 3D.

2. Add a model.

3. Set up your environment ready for lighting.

4. Start your HDR Light Studio lighting session.

5. Light the scene in HDR Light Studio. See render updates in LightWave 3D.

6. When the lighting design is finished, render a high resolution image to disk.

7. Stop your HDR Light Studio lighting session.

8. Point LightWave 3D at the high resolution, high dynamic range file on disk.

9. Render the model using the HDR environment map.

10.Save your LightWave 3D scene.

11.Quit LightWave 3D.
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Workflow
Start LightWave 3D.

Load a model.

Show the Render Globals dialog. Use <Ctrl>-P or click on the Render tab. In the Global Illumination

tab select Enable Radiosity.

Enable Radiosity

Click on Windows - Backdrop Options (<Ctrl>-F5). Click on Add Environment and select

HDRLS_environment. This sets up the transfer of image data enabling you to light in HDR Light

Studio and see the results in LightWave 3D.
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Add Environment

Set your render view to VPR to see the effects of your lighting in LightWave's renderer.

Select VPR

Initially this lighting will be white because HDR Light Studio isn't yet running.
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Default lighting

Select HDR Light Studio - Start.

Select Start to

start HDR Light

Studio

HDR Light Studio will start with the default gradient.
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HDR Light Studio lit with the default gradient light

Click on a Round Light in HDR Light Studio. By default this is placed in the center of the canvas and

the effect can be seen in the VPR. If you move the light on the canvas, the VPR will re-render with the

new light position.

Round Light

Rather than guess where to position the light on the canvas to get the effect you want on the car, use

LightPaint to position the lights by clicking on the model. Press LightPaint - Enable and select

LightPaint Mode - Reflection. 
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Select LightPaint -

Reflection

Now click near the headlamp. You will see the new position of the round light on the canvas and see

that light reflecting in the side of the car where you clicked. 

Using LightPaint to position the lights

Use LightPaint Mode - Illumination to position the light 'normal' to the surface to illuminate the area

selected, this is ideal for matte objects. Use LightPaint Mode - Rim mode to position the light directly

on the HDRI map that is visible in the background of your shot - this creates a rim lighting effect or

can be used to place lights in the background to create a nice background effect. If LightPaint is

active, 'Right Clicking' on your 3D model will select the light sources used. So right click on a reflection

to select the light that is creating that reflection.
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A more complex lighting design

The image data passed to LightWave 3D is at a proxy resolution to give an interactive lighting

experience. Once you are happy with your lighting, you need to render a high resolution, high quality

.hdr or .exr file on disk. Click on Tools - Render HDRI (or use the render button in HDR Light Studio),

enter a file name and press Render.

Final render

The final step is to replace the reference to the temporary proxy file with the high resolution file

we've just rendered to disk. Go back to Windows - Backdrop Options (<Ctrl>-F5). Select Add

Environment - Textured Environment.
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Replace low-res proxy with high-res final render

Double click (or right mouse click) to show its properties and click on Texture.

Properties
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Set the Projection to Spherical, make sure the Texture Axis = Y, click on Image and select Load Image

and pick the high resolution file you rendered.

Edit the properties

Close the texture properties and switch off the visibility of the HDRLS_environment.
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Switch off HDRLS_environment

You should now see the lighting update in the VPR. It will be using the high resolution HDRI map on

disk. Lights that appeared pixelated before, should now be smooth. You can now use this lighting to

render your final image in LightWave 3D. You can also share this scene with another LightWave 3D

user. They will not need HDR Light Studio to render it.

If you save your LightWave 3D scene, the HDR Light Studio lighting design will be embedded in the

file. So the next time you load that LightWave scene, you can start HDR Light Studio and the lighting

design is automatically loaded and ready to adjust. You can also save the lighting design from within

the HDR Light Studio app, using the Project > Save Project. Lighting designs can be re-loaded using

Project - Open Project.

If you Stop HDR Light Studio, this will close the HDR Light Studio app and will purge the HDR Light

Studio data. Use the Show/Hide Interface buttons to toggle between it being shown/hidden.

Presets

Over time you will build up a collection of favorite lighting designs which can be reused between

LightWave 3D projects. However, there is another way to access projects using the Presets Shelf. The

Preset shelf can be used to store, retrieve, and hot swap HDR Light Studio lighting designs. It's really

cool! Simply press the Presets Shelf button to show the current presets. Ensure you use the top left

drop down within the shelf to select (This User) WorkSpace. Press Add Preset to store your current

HDR Light Studio state as a Preset. Double click on any preset thumbnail on the shelf to load it into

HDR Light Studio and to replace your current lighting design. You will be required to confirm the
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loading of the new lighting design unless you have disabled this in the Plug-in Options - by disabling

the 'Enable presets load confirmation'. With this disabled you can very quickly try out different

lighting designs by double clicking its thumbnail.

Presets

Note: Big thanks to www.lewis.tomsoft.hr for the use of his Pontiac LightWave 3D scene file in this

tutorial.
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Release Notes

Release Notes

Build 2022.0513

New build fixes bad memory access in LW2020 that causes a crash

Build 2021.0520

LightWave - plug-in updated. On macOS, if the environment variable is not working to tell LightWave

the location of the HDR Light Studio application, the Connection will then look in the default install

location. This fixes an issue where macOS users report LightWave not able to start HDR Light Studio

from Cinema 4D on macOS.

14th May 2020

Added support for LightWave 2020

Build 2019.0123

Added support for LightWave 2019

Build 2018.0207

Added support for LightWave 2018

Minor bug fixes

Build 2016.0106

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Bug 1008 - Show and Hide button UI state now displaying properly.

Build 2015.0707

LightWave 3D 2015, 11.6, 11.5 supported in this release.

Arnold, LightWave3D and Octane v2 supported in this release.
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Known Issues

None reported
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Maxwell Studio Connection

HDR Light Studio is designed to generate a high resolution, high dynamic range image used for

image based lighting. As you shape the lighting, the Maxwel Studio connection seamlessly pulls HDR

Light Studio's environment map back into Maxwell without having to import/export via the file

system.

· Installation

· Connection Workflow

· Release Notes
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Installation

Simply install the main HDR Light Studio software. The connection between HDR Light Studio and

Maxwell Studio is built into Maxwell Studio 3.2 and above, so no additional plug-in installation is

required.
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Workflow

Start Maxwell Studio

Select the Environment from the scene tree. Choose Image Based as the Environment Type.

Scroll down the Attributes panel to the IBL Settings section
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Maxwell Studio supports the creation and embedding of one HDR Light Studio lighting design.

Therefore, we should leave the Reflection, Refraction, Illumination slots using the Background HDRI

map, so their settings should stay at 'Same as Background'. So all slots will use the same HDRI map

we create in HDR Light Studio.

Use the Type drop down to select HDR Light Studio
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Now the image based lighting will use the live HDRI map shared by HDR Light Studio. We should

press the Launch HDR Light Studio button to begin lighting our shot.

It is best to use the FIRE preview at the same time, to judge the lighting effect.

When HDR Light Studio opens, it will display our own Render View with a default teapot model

loaded. You can close this Render View panel as we do not need to use it when working with Maxwell

Studio. You can also adjust the layout of the HDR Light Studio interface to be more compact if you

are using it on the same display as Maxwell Studio.

Make a few lights in HDR Light Studio and see the lighting update instantly in Maxwell Studio.
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Once you are happy with the lighting, we need to produce a high quality, high resolution final HDRI

map on disc. This will be used when rendering your scene with Maxwell Render.

If you do not do this, Maxwell Render will not be able to render the scene, as only Maxwell Studio

and FIRE are able to use the temp HDR file shared from HDR Light Studio.

Press the Render Production HDRI button on the HDR Light Studio interface. The Production

Render setting panel will appear. Choose the resolution of file and type of file you want to make.

Then browse to select a file location and file name for the file. Press Render to generate the HDRI file.
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Maxwell Studio will now automatically update to use the file on disc for its IBL. You will see the

Background Type change from HDR Light Studio to HDR Image, and will see a file name has been

added in the Map slot.
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Now when this scene is rendered in Maxwell Render it will be lit using this file on disc.

If you save your Maxwell Studio scene, the next time this is opened and HDR Light Studio is started,

your lighting design will load into HDR Light Studio. The HDR Light Studio project is embedded in the

Maxwell Scene file when using this integration. This means you can make adjustments to your

lighting designs if you are not happy with them. But remember to always complete your lighting

session by rendering a file to disc, so Maxwell Render can use it.
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Release Notes

Release Notes

Maxwell Studio v3.2 and higher supports HDR Light Studio.

Known Issues

None reported
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Maya Connection

The Maya Connection is a plug-in that creates a bridge between HDR Light Studio and Maya.

As the HDRI map and Area Lights are created in HDR Light Studio, Maya is kept in sync.

Start an ActiveShade session to see the lighting evolve on your final shot as you light in HDR Light

Studio.

Supported Renderers: V-Ray, RenderMan, Redshift, Octane, Arnold 5.2.0+

· Installation

· Interface Overview

· Workflow

· Managing Performance/Resources

· Renderer Specific Notes

· Release Notes

Legacy Maya Connection Documentation
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Installation

Important Note:

You should install the main HDR Light Studio application first, prior to installing our Maya

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both Maya and HDR Light Studio app are not running prior to installing our Maya

Connection plug-in.

The Maya Connection installation performs two actions. It puts a mod file in Maya's search path. And

it copies the plug-in and related files to our Lightmap directory. The mod file points to the plug-in.

Installation - Windows

Installation - MacOS

Installation - Linux

Plug-in Interface in Maya

Uninstalling

Common Problems
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Installation - Windows

1. Download the Maya Connection for HDR Light Studio from our web site.

2. Run the installer. It is recommended that you use the default installation directory so that the

plug-in will be available in the Plug-in Manager for enabling. If you decide to change the default

installation directory you will need to edit the contents of the installed HDRLightStudio.mod file to

point to your alternative directory. This file must also be present in your Maya module search

path. You can run the MEL command getenv MAYA_MODULE_PATH in Maya's script editor to see

the standard and custom locations that Maya checks for modules.

This is where we install the module file: <user>/Documents/maya/modules

If you have a previous installation you will need to remove the old mod file from your machine, for

example:

Maya 2021: C:/Program Files/Common Files/Autodesk Shared/Modules/Maya/2021/HDRLightStudio.mod

3. Run Maya.

4. Bring up the Plug-in Manager dialog. From the top menu select Window - Settings/Preferences -

Plug-in Manager

5. Find the HDRLS5Connection and select Loaded and Auto Load. Close the dialog.

Plug-in Manager
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7. That's it. A new shelf for HDR Light Studio will appear in the Maya interface. This plug-in

connection will need a license key to work. You should now proceed to Licensing. For information

on using the connection see Maya Connection.
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Installation - MacOS

1. Download the Maya Connection for HDR Light Studio from our web site.

2. Run the installer. It is recommended that you use the default installation directory so that the

plug-in will be available in the Plug-in Manager for enabling. If you decide to change the default

installation directory you will need to edit the contents of the installed HDRLightStudio.mod file to

point to your alternative directory. This file must also be present in your Maya module search

path. You can run the MEL command getenv MAYA_MODULE_PATH in Maya's script editor to see

the standard and custom locations that Maya checks for modules.

This is where we install the module file: <user>/Documents/maya/modules

If you have a previous installation you will need to remove the old mod file from your machine, for

example:

Maya 2021: ~/Library/Preferences/Autodesk/maya/2021/modules/HDRLightStudio.mod

3. Run Maya.

4. Bring up the Plug-in Manager dialog. From the top menu select Window - Settings/Preferences -

Plug-in Manager

5. Find the HDRLS5Connection and select Loaded and Auto Load. Close the dialog.

Plug-in Manager
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7. That's it. A new shelf for HDR Light Studio will appear in the Maya interface. This plug-in

connection will need a license key to work. You should now proceed to Licensing. For information

on using the connection see Maya Connection.
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Installation - Linux

1. Download the HDR Light Studio Connection for Maya tar gzip archive from our web site.

2. Extract the files from the archive file, example.

gunzip maya2015_linux_2015.0331.tar.gz

tar xvf maya2015_linux_2015.0331.tar

3. Move the root directory to a directory of your choosing,

e.g. /disk1/lightmap/HDRLightStudioConnectionMaya

4. Edit the HDRLightStudio.mod file to point to the new location. Here's an example of the contents

of this file:

+ HDRLS5Connection any /disk1/lightmap/HDRLightStudioConnectionMaya

5. Put HDRLightStudio.mod into your users maya module folder (~/maya/modules) or any directory

that is referenced by your MAYA_MODULE_PATH. In Maya run the MEL command "getenv

MAYA_MODULE_PATH" to see the directories which are searched then copy HDRLightStudio.mod

into one of those directories. The HDRLightStudio connection for Maya will then be available in

Maya's Plug-in Manager.

6. Run Maya.

7. Bring up the Plug-in Manager dialog. From the top menu select Window - Settings/Preferences -

Plug-in Manager

8. Find the HDRLS5Connection and select Loaded and Auto Load. Close the dialog.

That's it. A new shelf for HDR Light Studio will appear in the Maya interface. This plug-in connection

will need a license key to work. You should now proceed to Licensing. For information on using the

connection see Maya Connection.



910

910Connections (Plug-Ins)

Plug-in Interface in Maya

After you have installed the Maya connection and loaded the HDRLS5Connection.py plug-in (1) using

Maya's Plug-in Manager, you will see that a new shelf has been created (2). You can start HDR Light

Studio by selecting that shelf and clicking on the HDR Light Studio icon (3).

The HDR Light Studio connection appears docked on the left (4). It can be dragged off as a floating

panel using the top bar (or using the small undock button). It can be dragged towards the right and

will dock with the Attribute Editor and Channel Box / Layer Editor.
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Uninstalling

To remove the HDR Light Studio plug-in connection to Maya, run the uninstaller in the following

directory, if you're on windows.

C:\Program Files\Lightmap\HDRLightStudioConnectionMaya\
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Common Problems

If something goes wrong with the installation, there may be a simple fix. Here's an example fix for

Windows. The installation performs two simple actions. 

1. It puts a mod file in Maya's search path. The contents of this text file, HDRLightStudio.mod, point

to the location of the HDR Light Studio plug-in files.

2. It copies the HDR Light Studio plug-in files to a sub-directory of C:\Program

Files\Lightmap\HDRLightStudioConnectionMaya\

Plug-in directory for Maya 2014

To fix the problem you should check that our HDRLightStudio.mod file is in your

MAYA_MODULE_PATH. To do this run Maya and from the Script Editor, type the MEL command:

getenv MAYA_MODULE_PATH

This will list all the directories searched for modules. You'll need to check that HDRLightStudio.mod is

in one of them. If it's missing, try and find it in C:\Program

Files\Lightmap\HDRLightStudioConnectionMaya\ and copy it into one of the directories in your

MAYA_MODULE_PATH. If it's not missing, the check the contents of the HDRLightStudio.mod file

point to the plug-in files. For example, for Maya 2014:

+ HDRLS5Connection any C:\Program Files\Lightmap\HDRLightStudioConnectionMaya\2014\

If you still can't get it to work, contact support@lightmap.co.uk

mailto:support@lightmap.co.uk
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Interface Overview

The new updated Maya Connection is now based on shelf buttons. These replace the panel that

needed to be open when previously using the connection.

WIth the updated workflow that was released in Carbon (Drop 1), getting started is as easy as

pressing Play.
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Workflow

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to Maya provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in Maya,

where you can see the lighting interact with your 3D scene. You can also create and control Area

Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between Maya and HDR Light

Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial
Requirements: Maya 2022 / 2023 / 2024 with V-Ray, RenderMan, Redshift, Octane or Arnold 5.2.0+.

Not your Maya version or renderer? Click here to see Workflow - Method 2

STEP 1: Start Maya and load the Maya project you want to light (see Figure 1).

Make sure a camera is set up for your scene and your correct renderer is set. In this example

V-Ray is used.

Figure 1: Loaded scene in Maya

STEP 2: Open the HDRLightStudio Connection shelf

If you do not see the HDRLightStudio shelf, click here to see installation instructions.

https://www.lightmap.co.uk/learning/category/get-started/
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The HDRLightStudio shelf opens (see Figure 2)

Figure 2: HDR Light Studio connection tab

STEP 3: In the HDRLIghtStudio connection shelf, click on the 'Start' button (see Figure 3)

In order for HDR Light Studio to be started in a connection with Maya and your Renderer, an

IBL Hook is required to connect with.

An IBL Hook is simply a valid Image Based Lighting setup (Dome Light / Environment Light),

whose HDRI map file can be replaced and updated by HDR Light Studio.

Figure 3: Starting the HDR Light Studio connection by clicking on the 'Start' button

STEP 4:  Create a new IBL Hook by providing a name for the hook in the 'Create New Hook

for VRay' panel and press the OK button (see Figure 4).

During the start process, our plug-in detects if there are valid IBL Hooks, if not then we create

one for you.

Figure 4: Creating a new IBL hook

HDR Light Studio will now start, controlling the HDRI image file used on the new IBL Hook,

unless there are already valid IBL Hooks in your Maya scene, a dialog will appear where you

will be asked to choose a Hook from the drop down, or there is an option to create a New

Hook (see Figure 5).
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Figure 5: Selecting an existing hook before HDR Light Studio

connection starts

HDR Light Studio will then start connected to the hook selected or the new one created (see

Figure 6).

The HDR Light Studio interface should look like in Figure 6.

If not in HDR Light Studio you can reset it by going to the menu: Window > Layout > Load >

Default > Maya

Figure 6: HDR Light Studio on start up

When the HDR Light Studio Connection starts, a HdrlsProjectData node is added to the Maya

scene and can be seen in the Outliner (see Figure 7).

This node stores the HDR Light Studio lighting project within the Maya scene so that the

lighting design can be restored in HDR Light Studio in future sessions.

This stores the last state of the project before the HDR Light Studio connection is closed, and

of course is only saved when the Maya scene itself is saved.

 

Please note: Using Maya's 'File > Optomize Scene Size' feature will remove the HdrlsProjectData node

from your scene. Be sure not to accidentally remove it.



918

918Connections (Plug-Ins)

Figure 7: HdrlsProjectData node shown in the outliner

The current HDRI map design in HDR Light Studio is shared with Maya as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for Maya to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this

image is updated in Maya to use a new temp with a new file name, to ensure the renderer

uses the new image even when caching images.

The temporary file name and location will look something like in Figure 8 on your IBL

dome/sphere. 
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Figure 8: Location of the temp proxy (lo-res) image

STEP 5: In HDR Light Studio, press Play on Render View [Maya|VRay] (see Figure 9)

Figure 9: Starting the V-Ray Render View withing HDR Light Studio

HDR Light Studio now instructs Maya to start a new session of the Maya Preview Render.

The interactive Preview Render image is now displayed in this Render View (see Figure 10).

To understand all of the features/controls for this view, see here.

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_host.html
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It is possible that there will be delay in seeing the render appear, we can only show it once the

renderer in Maya has started, parsed the scene and has begun the render process. This can take a

long time with a very large scene, or even because the renderer it trying to get hold of a license. You

can check in Maya to see the status of the renderer and see if it has begun

Figure 10: V-Ray render view working within HDR Light Studio

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the

chosen location on the 3D model when using LightPaint (see Figure 11).

Learn about LightPaint here.

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 11: LightPaint mode set to Reflection

STEP 6: Click on the Presets tab next to the Light List tab, to show the Preset Lights (see Figure

12).

Figure 12: Opening the presets tab to see a list of presets

STEP 7: Drag and drop a Preset Light onto the 3D model in the Render View [Maya|VRay]

(see Figure 13).
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Figure 13: Placing a preset light onto the model

The Preset Light has been added to the lighting design in a location that is reflecting where the

light was dropped on the 3D model.

•  A new light in the Light List in HDR Light Studio (see Figure 14).

•  You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see

Figure 14).

•  The Maya environment has been updated to use the new live HDRI map from HDR Light

Studio, and the Maya|VRay Preview Render updated using the new lighting (see Figure 14).
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Figure 14: HDR Light Studio interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [Maya|

VRay] (see Figure 15).

STEP 8: Click on the 3D model to reposition the selected light from the Light List (see Figure

15).

The light is moved on the HDRI map, the new HDRI map is sent to Maya and the Preview

Render updates.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where

you want them.
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Figure 15: Using LightPaint to paint lights on the model

If there is a delay of more than a second, or so, after clicking to move a light and see the

updated rendered result - the process will be slow and tedious.

In this situation we can use HDR Light Studio's built in renderer to speed up the lighting

process.

STEP 9: Press the play button on Render View [HDR Light Studio] (see Figure 16)



925

925Connections (Plug-Ins)

Figure 16: Starting up HDR Light Studio Render View

The Import Scene Geometry panel will pop up

STEP 10: Press Import (see Figure 17)

Figure 17: Importing the scene from Maya to

HDR Light Studio render view

You may need to use the Camera Drop Down in Render View [HDR Light Studio] to match the

camera view you are seeing from Maya (see Figure 18).
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Figure 18: Maya|VRay render view (left) and HDR Light Studio render view (right) side

by side

The Render View [HDR Light Studio] renders the loaded scene lit with the current lighting

design. A simple shader is used on the whole scene to preview the light and reflections.

If you needed to open Render View [HDR Light Studio] to get a more interactive lighting

experience. Use this view for LightPaint, where clicking and dragging to position lights is

supported - it's fast and interactive.

The Render View [Maya|VRay] rendering will catch up eventually as you work, and will display

an image using the latest lighting.

If the Render View [Maya|VRay] is still so slow that it is of little benefit during the

interactive lighting process, and maybe it is also slowing down HDR Light Studio a lot,

then use the Pause/Play button to stop and resume rendering in Render View [Maya|

VRay], in order to do test renders from time to time (see Figure 19).

Figure 19: Pause / Play button for the render view

We have documented in more detail the process of using 2 render views together in HDR Light Studio

here.

http://help.lightmap.co.uk/hdrlightstudio5/render-views-useage.html
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So far the light we created is on the HDRI map. With a single setting, this light can be removed

from the HDRI map, and created as an Area Light in 3D space in Maya, mapped with the HDR

content from HDR Light Studio.

STEP 11: Enable the Area Light check box in the Light Properties panel for the selected light

(see Figure 20).

Figure 20: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

•   The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly

showing which lights are Area Lights (see Figure 21).

•   The light is removed from the HDRI map lighting the Render Views (but is still represented

and shown on the Canvas) (see Figure 21).

•   A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio

with a Smart Dolly distance of 1,000 (see Figure 21).

•   A 3D plane with emitter shader is created in Maya, mapped with the HDR light content

(RGBA), this can be seen lighting the shot in Render View [Maya|VRay] (see Figure 21).
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Figure 21: Light converted into an area light

STEP 12: Reduce the Smart Dolly slider value to move the light closer to the 3D model (see

Figure 22).

Figure 22: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in Maya. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

If we switch to the Maya user interface, we can see:



929

929Connections (Plug-Ins)

•   The Area Light geometry in the viewport (see Figure 23) (If not, the area light is most likely

too far away from your scene. To learn more about Smart Dolly - click here)  

•   A folder containing the area lights made with HDR Light Studio in the Outliner (see Figure

23)

•   Area Light setup in the Attributes panel for the created area lights - mapped with HDR

(RGBA) content (see Figure 23)

Figure 23: Maya interface after creating an area light

STEP 13: Use LightPaint in the Render Views to move the Area Lights, just like moving a light

on the HDRI map (see Figure 24).

In fact, area lights are controlled just like any other light in HDR Light Studio, with the addition

of distance settings.

Figure 24: Using LightPaint to position the area light

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in Maya (or any part of their associated shader

network/file nodes) will cause problems!

http://help.lightmap.co.uk/hdrlightstudio5/reference-area-lights.html
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STEP 14: Enable Fast Area Light setting in the Render View panel  (25) for fast noise removal

on very big scenes (see Figure 26). 

Figure 25: Fast Area Light checkbox

Figure 26: Painting area lights with Area Light Setting On (left) and Off (right)

STEP 15: Once you are happy with your lighting, press the 'Production Render' button in HDR Light

Studio (see Figure 27).
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Figure 27: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the

'Orientation' is already set to 'Maya/VRay', this ensures that the rendered HDRI map is mapped

correctly in the host, i.e. Maya (see Figure 28). For more information see: Production Render

Dialog

Figure 28: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update Maya to use these final area lights and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be

updated to use the updated proxy versions again.

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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So please ensure you 'Stop' the HDR Light Studio connection after you have produced

your production lighting, by Pressing the Stop button (see Figure 29).

Figure 29: Stopping the HDR Light Studio connection

STEP 16: Save Maya scene.

If you would like the HDR Light Studio project to be saved in your Maya scene, you should

save your Maya scene now. This way the scene state matches the HDRI map and area lights

that are currently in the project.

STEP 17: The below explains how to save and load HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during

the lighting process as a HDi file (native HDR Light Studio project file), even when using HDR

Light Studio via a connection. If you were to open HDR Light Studio in a connection with Maya,

this project can be loaded into HDR Light Studio using Project > Open Project. The lighting

design would load into HDR Light Studio replacing its current design, and would then be

synced back into Maya. This is how you can move lighting designs between Maya projects or

between other supported 3D software / renderers.

Legacy (Workflow for Maya with Maxwell)

HDR Light Studio is a standalone lighting application providing a set of tools and content

dedicated to lighting 3D scenes. Using HDR Light Studio connected to Maya provides the

ability to create custom HDRI maps to light your scenes, with lights chosen and positioned to

provide the perfect effect on your model. As you work with HDR Light Studio, the lighting is

updated in real-time in Maya, where you can see the lighting interact with your 3D scene. You

can also create and control Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between Maya and

HDR Light Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content

here to learn the HDR Light Studio interface and the basic features.

https://www.lightmap.co.uk/learning/category/get-started/
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Workflow Tutorial

Requirements: Maya 2022 / 2023 / 2024 with Maxwell. Not your Maya version or renderer? Click

here to see Workflow - Method 1

STEP 1: Start Maya and load the Maya project you want to light (see Figure 1).

Make sure a camera is set up for your scene and your correct renderer is set. In this example

Maxwell Render is used.

Figure 1: Loaded scene in Maya

STEP 2: When using Maxwell Render, the image based lighting needs to be manually set. If you

are not using Maxwell Render, you can skip this step and continue to Step 3.

Go to Windows > Rendering Editors > Render Settings, while the Maxwell Render tab is

open, in the Maxwell Render Environment section, ensure 'Use Image Based Environment'

tick box is on. Load any HDRI map (hdr or exr) into the Background Texture slot and ensure

'Spherical Mapping' tick box is on (see Figure 2).
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Figure 2: setting up image based lighting

An IBL Hook is now created. Close Render Settings Panel. 

STEP 3: Open the HDRLightStudio Connection shelf.

If you do not see the HDRLightStudio shelf, click here to see installation instructions.

The HDRLightStudio shelf opens (see Figure 3)
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Figure 3: HDR Light Studio connection tab

STEP 4: In the HDRLIghtStudio connection shelf, click on the 'Start' button (see Figure 4)

Figure 4: Starting the HDR Light Studio connection by clicking on the

'Start' button

STEP 5: In order for HDR Light Studio to be started in a connection with Maya and your

renderer, an IBL Hook is required to connect with.

An IBL Hook is simply a valid Image Based Lighting setup (Dome Light / Environment Light),

whose HDRI map file can be replaced and updated by HDR Light Studio.

If using Maxwell Render, 'Select Hook for Maxwell' panel opens, click 'Ok' while Background

is selected as the hook (see Figure 5). This selects the IBL Hook that was created in Step 2. For

any other renderers with no existing hooks, you will be required to create a new IBL Hook by

providing a name for the hook in the 'Create New Hook for x' panel and press the OK button

(see Figure 6).

Figure 5: Selecting an existing IBL hook for Maxwell

Render

Figure 6: Creating a new IBL hook
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HDR Light Studio will then start connected to the hook selected (see Figure 7).

The HDR Light Studio interface will look like in Figure 7.

Using our latest version of HDR Light Studio and the Maya connection - the HDR Light Studio

interface will now show 2 Render Views. On the left is Render View [Maya|Maxwell] (see

Figure 7)

Currently this view is not compatible with Maya Maxwell and can be closed!

Figure 7: HDR Light Studio on start up

We recommend changing the layout using the top menu: Window > Layout > Load > Default >

Standalone

The HDR Light Studio interface will then contain the features you need to use HDR Light Studio

with Maya and Maxwell (see Figure 8).
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Figure 8: HDR Light Studio Standalone interface layout

When the HDR Light Studio Connection starts, a HdrlsProjectData node is added to the Maya

scene and can be seen in the Outliner (see Figure 9).

This node stores the HDR Light Studio lighting project within the Maya scene so that the

lighting design can be restored in HDR Light Studio in future sessions.

This stores the last state of the project before the HDR Light Studio connection is closed, and

of course is only saved when the Maya scene itself is saved.

 

Please note: Using Maya's 'File > Optomize Scene Size' feature will remove the

HdrlsProjectData node from your scene. Be sure not to accidentally remove it.
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Figure 9: HdrlsProjectData node shown in

the outliner

The current HDRI map design in HDR Light Studio is shared with Maya as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for Maya to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this

image is updated in Maya to use a new temp with a new file name, to ensure the renderer

uses the new image even when caching images.

The temporary file name and location will look something like in Figure 10. 
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Figure 10: Location of the temp proxy (lo-res) image

STEP 6: Using 2 displays provides the best work flow, with HDR Light Studio on one display,

and Maya on the other (see Figure 11). Press the play button on Render View [HDR Light

Studio] (see Figure 12).
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Figure 11: Maya (left) and HDR Light Studio (right) running on 2

displays

Figure 12: Starting HDR Light Studio Render View

The Import Scene Geometry panel will pop up.

STEP 7: Press Import (see Figure 13)
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Figure 13: Importing the scene from

Maya to HDR Light Studio render

view

We will use this Render View in HDR Light Studio as the interface for positioning lights on the

model, with real time feedback (see Figure 14).

Figure 14: HDR Light Studio render view with imported scene from

Maya

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the

chosen location on the 3D model when using LightPaint (see Figure 15).

Learn about LightPaint here.

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 15: LightPaint mode set to Reflection

STEP 8: Drag and drop a Preset Light onto the 3D model in the Render View (see Figure 16)

Figure 16: Placing a preset light onto the model

The Preset Light has been added to the lighting design in a location that is reflecting where the

light was dropped on the 3D model.

You will see:

· A new light in the Light List in HDR Light Studio (see Figure 17).

· You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see

Figure 17).
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· The Render View has been updated to show the lighting effect on the loaded 3D model (see

Figure 17).

Figure 17: HDR Light Sutido interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [HDR Light

Studio] (see Figure 18).

STEP 9: Click on the 3D model to reposition the selected light from the Light List.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where

you want them (see Figure 18).
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Figure 18: Using LightPaint to paint light on the model

STEP 10: Let's start Maxwell interactive rendering in Maya to see what the lighting looks like

(see Figure 19).

Figure 19: Starting Maxwell interactive

rendering in Maya

Maxwell Frame Buffer opens and Maxwell starts rendering the view (see Figure 20).

Figure 20: Maxwell frame buffer inside Maya (left) running with HDR

Light Studio (right) 

We can leave Maxwell rendering as we work in HDR Light Studio. When lighting changes in

HDR Light Studio, it will update Maya > Maxwell to use the new lighting.

If the scene is large and rendering in Maxwell is updating slowly, you can produce test renders
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from time to time instead of leaving Maxwelll interactive rendering running. It is up to the user

to judge this performance and decide what to do.

So far the light we created is on the HDRI map. With a single setting, this light can be removed

from the HDRI map, and created as an Area Light in 3D space in Maya, mapped with the HDR

content from HDR Light Studio.

STEP 11: Enable the Area Light check box in the Light Properties panel for the selected light

(see Figure 21).

Figure 21: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

•   The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly

showing which lights are Area Lights (see Figure 22).

•   The light is removed from the HDRI map lighting the Render Views (but is still represented

and shown on the Canvas) (see Figure 22).

•   A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio

with a Smart Dolly distance of 1,000 (see Figure 22).

•   A 3D plane with emitter shader is created in Maya, mapped with the HDR light content

(RGBA), this can be seen lighting the shot in Render View [HDR Light Studio] (see Figure 22).
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Figure 22: Light converted into an area light

STEP 12: Reduce the Smart Dolly slider value to move the light closer to the 3D model (see

Figure 23).

Figure 23: Moving the area light closer to the model (LightPaint

position)
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HDR Light Studio has a scene scale setting that is useful when working with Area Lights in

Maya. If the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar

value in Preferences. This value scales all area lights in HDR Light Studio.

If we switch to the Maya user interface, we can see:

•   The Area Light geometry in the viewport (see Figure 24) (If not, the area light is most likely

too far away from your scene. To learn more about Smart Dolly - click here)  

•   A folder containing the area lights made with HDR Light Studio in the Outliner panel (see

Figure 24)

•   Area Light setup in the Attributes panel for the created area lights - mapped with HDR

(RGBA) content (see Figure 24)

Figure 24: Maya interface after creating an area light

STEP 13: Use LightPaint in the Render View [HDR Light Sutdio] to move the Area Lights, just

like moving a light on the HDRI map (see Figure 25).

In fact, area lights are controlled just like any other light in HDR Light Studio, with the addition

of distance settings.

Figure 25: Using LightPaint to position the area light

Rather than guessing where to put the lights in HDR Light Studio to achieve your desired

effect, a selected light in HDR Light Studio can be moved using the LightPaint tools in the HDR

http://help.lightmap.co.uk/hdrlightstudio5/reference-area-lights.html
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Light Studio Connection shelf. Press one of the LightPaint mode names to enable the tool.

Then click on the 3D model in the Maya viewport to position the light via that LightPaint mode.

Press the Off button to stop the LightPaint tool.

For more information about the LightPaint modes see: LightPaint

Figure 25: LightPaint tools in the HDR Light Studio Connection shelf

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in Maya (or any part of their associated

shader network/file nodes) will cause problems!

STEP 14: Enable Fast Area Light setting in the Render View panel  (26) for fast noise removal

on very big scenes (see Figure 27). 

Figure 26: Fast Area Light checkbox

http://help.lightmap.co.uk/hdrlightstudio5/reference_render_view_lightpaint.html
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Figure 27: Painting area lights with Area Light Setting On (left) and Off

(right)

STEP 15: Once you are happy with your lighting, press the 'Production Render' button in HDR

Light Studio (see Figure 28).

Figure 28: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the

'Orientation' is already set to 'Maya/Maxwell', this ensures that the rendered HDRI map is

mapped correctly in the host, i.e. Maya (see Figure 29). For more information see: Production

Render Dialog

http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
http://help.lightmap.co.uk/hdrlightstudio5/reference_final_render.html
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Figure 29: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update Maya to use these final area lights and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be

updated to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced

your production lighting, by Pressing the Stop button (see Figure 30).

Figure 30: Stopping the HDR Light Studio connection

STEP 16: Save Maya scene.

If you would like the HDR Light Studio project to be saved in your Maya scene, you should

save your Maya scene now. This way the scene state matches the HDRI map and area lights

that are currently in the project.

STEP 17: The below explains how to save and load HDR Light Studio projects
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HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during

the lighting process as a HDi file (native HDR Light Studio project file), even when using HDR

Light Studio via a connection. If you were to open HDR Light Studio in a connection with Maya,

this project can be loaded into HDR Light Studio using Project > Open Project. The lighting

design would load into HDR Light Studio replacing its current design, and would then be

synced back into Maya. This is how you can move lighting designs between Maya projects or

between other supported 3D software / renderers.

Managing Performance/Resources

HDR Light Studio includes its own CPU powered Render View. Import a Maya scene and quickly

create perfect lighting by clicking and dragging light positions on the 3D model geometry with

realtime feedback. Use Maya's own interactive rendering at the same time to see the updated

lighting interacting with the final shaders. In this scenario, 2 renderers are running at the same time

and will be competing for your computer's resources. The competing renderers can slow down each

other's performance and the responsiveness of the computer. Here is some advice on how to better

manage this situation by managing the resources better.

Recommendations for Managing Performance/Resources:

GPU Rendering in Maya

When using a GPU based renderer in Maya (when HDR Light Studio's renderer is running), it should

not compete with HDR Light Studio. So both renderers should be nice and fast when used at the

same time.
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CPU Rendering or CPU/GPU (Combined) Rendering in Maya

If using CPU or CPU/GPU (Combined) renderering in Maya when HDR Light Studio's CPU renderer is

running, please consider making the following adjustments to improve performance:

1. In HDR Light Studio's Render View Settings for HDR Light Studio, reduce the Max Samples to a

low number like 5.

HDR Light Studio's renderer will now stop renderering much sooner after each lighting change,

leaving more resources for Maya's renderer.

HDR Light Studio's Render View really does not need to resolve to a high quality image, just a few

samples is enough to get a good impression of the lighting. See here:
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Please note

One thing to bear in mind is that when using HDR Light Studio using only the HDRI map (i.e. no 3D

area lights). Once HDR Light Studio has collected the render samples, it does not need to re-sample

when the HDRI map changes, i.e. a light is edited on the HDRI map. Therefore, once the progress bar

is fully green, the renderer has essentially stopped 'rendering'. There is a small set of calculations to

update the image when the HDRI map is changed. But these happen fast. So please understand that

you can leave the Max Samples setting at 80 if you are using only HDRI map based lighting and HDR

Light Studio's own Render View has already completed sample collection.

2. If you still feel the renderers are competing and performance is poor, if possible reduce the

number of threads used by your renderer in Maya when rendering. Many renderers default to using

all threads. This can reduce Maya's ability to process messages and images from HDR Light Studio.

For example, if you have a computer with 8 CPU cores, reducing your renderer to use 6 cores will

leave 2 more cores for HDR Light Studio and for handling communications between HDR Light Studio

and Maya. Additionally reducing thread priority to low can also help. Availability of these settings

varies from renderer to renderer, please consult your renderer's documentation to see how to

change these settings.
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Renderer Specific Notes

Here are specific notes relating to using HDR Light Studio in Connection with Maya using the

following renderers:

V-Ray

Arnold

Octane

Maxwell

Redshift

RenderMan

Support has been removed for Mental Ray and Iray in this release of HDR Light Studio
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V-Ray

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Issues relating to the new V-Ray Render View inside HDR Light Studio

Maya 2020 issue: Pausing/restarting/resizing IPR frame buffer views of V-Ray under OSX can cause a

crash. This is most likely a V-Ray issue seen when using HDR Light Studio.

When the user stops HDR Light Studio from the Connection panel in Maya, we shut down the

VFB/IPR window. This doesn't work for VRay and the window will be left open, although it will stop

rendering.

Solution, manually close the VRay VFB window in Maya.

If the user pauses the Maya/VRay Render View in HDR Light Studio , we shut down the VFB/IPR

window for the renderer while paused, it stops rendering but doesn't close. So the Maya/VRay

Render View won't start back up when play is pressed. Solution, the user then needs to either go to

the VRay VFB and click start, or clicking the ReSync button in HDR Light Studio on the view  will

restart the render.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.
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Create a V-Ray Light Dome

In the Attribute Editor for the VRayLightDome

Ensure Dome Spherical tick box is enabled

Ensure Use Dome Tex tick box is enabled



957

957Connections (Plug-Ins)

Click the checker board button to the right of the Dome Tex slider to add a texture to the light.

From the resulting Create Render Node panel, select 2D Textures > File
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In the Attributes Editor, click the folder icon to select a HDR or EXR file to load into the Image Name

slot

The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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Arnold

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

The Cam Visibility 'on' state in HDR Light Studio is not honored by the area light in Arnold.

Alpha is not supported on Arnold aiAreaLights, an RGB image (pre-multiplied by the Alpha) is used as

the light content.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

Arnold - aiSky (option 1)

Open the Render Settings panel

Go to the Arnold Renderer tab

In the Environment section, left click on the check box next to the Background slot

Select Create Sky Shader
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A new material is created called aiSky

In the Attribute Editor for aiSky

Ensure Format is set to latlong
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Enable Visible in Reflections and Visible is Refractions

Press the checker board button next to the Color slot to add a HDR file to the aiSky



962

962Connections (Plug-Ins)

In the resulting Create Render Node panel, select 2D Textures > File
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Press the folder icon next to the Image Name slot to load a standin HDR or EXR file.

The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.

Arnold - Sky Dome Light (option 2)
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From the Arnold shelf, press the Create SkyDome Light button to create a Sky Dome Light

In the Attribute Editor for the light, click the checker board button next to the Color slot.
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In the resulting Create Render Node panel, select 2D Textures > File
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Press the folder icon next to the Image Name slot to load a standin HDR or EXR file.

The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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Octane

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Constant Falloff is not supported on Area Lights, only Quadratic Falloff is supported which is

physically correct.

When exporting your Maya scene into HDR Light Studio, be sure not to export the polygon geometry

for the area lights.

If Importance Sampling is 'On' and HDR Light Studio shares a black HDRI map with Octane, the

render in Octane becomes incorrect, as if light is being removed from the scene. A black HDRI map is

shared for example when an Area Light is solo, thereby turning off all other lights that are on the

HDRI map. Here is an example.

To fix this issue, turn off Importance on the Environment. But remember to turn this back on again

for your final render produced in Octane.

IBL Hook Setup

Older versions of Octane plug-in for Maya - Pre 3.08.3

These are the manual steps needed to create an image based lighting setup that is compatible with
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HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

From the Octane shelf, press the Create Octane Sun/Sky environment node button

In the Attribute Editor

Ensure Type is set to Texture Environment

In the Texture Environment section change Texture value  to 1.000

In the Texture Environment section change Power value  to 1.000
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Press the checker board button next to the Texture slot
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Select Octane Textures > Octane Image Texture

Use the folder icon to select a HDR or EXR file as a standin for the File slot

Ensure Power and Gamma are both set to values 1.000
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We also advise for accurate render results to change some settings for the camera, to remove the

color cast from the imager settings, and get the correct gamma for the most realistic output.

Select your camera and navigate to the Octane camera properties in the Attribute Editor.

In the Octane imager section

Change the Response to Linear/Off

Change the Gamma value to 2.2
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The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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Maxwell

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Sometimes, if you have a window docked over the top of the Attribute Editor before an area light is

created, then texture updates on the area light will not be seen by the Fire window. The workaround

is simply open the Attribute Editor and make another change to the light in HDRLS (which will cause

a texture update), all updates will then be applied to the light regardless of whether the Attribute

Editor stays open or not.

When exporting your Maya scene into HDR Light Studio, be sure not to export the polygon geometry

for the area lights.

The HDR Light Studio connection treats the Background, Reflection, Refraction and Illumination

environment slots in Maxwell each as valid IBL Hooks. However in order for the HDR Light Studio

connection to find the Reflection, Refraction and Illumination hooks, the user first needs to open the

Render Settings UI and expand the Environment > Image Based section in the Maxwell Settings in

order for the HDR Light Studio connection to be able to find them (Use the Refresh List button in

order to to this). This is an edge case, as most of the time the user will create a single HDR Light

Studio lighting design that is connected to the Background Environment in Maxwell, and the other

slots will be set to use the same background.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

Open the Render Settings panel

Go to the Maxwell Render Environment section

Ensure Use Image Based Environment tick box is on
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Load any standin HDRI map (hdr or exr) into the Background Texture slot

Ensure Spherical Mapping tick box is on
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The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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Redshift

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

Alpha is not supported on the area light, an RGB image (pre-multiplied by the Alpha) is used as the

light content.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Create a RedshiftDomeLight in the Hypershade window
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In the Attribute Editor use the Folder icon to select a standin HDR or EXR file for the Dome Map

Ensure Map Type is set to Spherical

The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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RenderMan

KNOWN ISSUES

IBL HOOK SETUP

Known Issues

RenderMan 23.1

There is an issue where RenderMan 23.1 is not currently sharing the IPR render image with the HDR

Light Studio interface. You can still use the connection with RenderMan 23.1, looking at the IPR in

Maya. Pixar know about the issue and are looking into it.

RenderMan 22 / Mac OS Issue

On Mac OS, if the user imports the scene across to HDRLS after they have started the HDRLS frame

buffer, the 'please wait' message will appear on the render view but it will not load, and Maya will

hang in the background. This only occurs on Mac OS, and does not occur if the scene is imported

first, and then the HDRLS frame buffer is started; nor when starting the IPR inside Maya first and

then importing the scene to HDRLS. It also does not occur when exporting the scene, or when using

another renderer (tested with Arnold), so it seems to be RenderMan 22 only.

Other Issues

· HDR Light Studio will default to using the EXR file format for its content when used with

RenderMan. It is possible to override this in HDR Light Studio and set it to use HDR, but this will

cause Maya on MacOS to crash when used with RenderMan.

· It is best to set RenderMan IPR to leave some CPU cores free for Maya and HDR Light Studio to use.

Otherwise RenderMan can compromise Maya's ability to correctly receive HDR Light Studio lighting

updates.

· Start RenderMan IPR only after HDR Light Studio connection has been launched.

· Some changes to the area lights get missed by the RenderMan IPR, refreshing the IPR view will re-

sync to the up to date lighting.

· RenderMan IPR can miss some lighting updates if many changes are sent at once from HDR Light

Studio, for example if you have 10 area lights in your scene and solo one, this hides the other 9

lights in sequence and some of these updates can be missed by the IPR. Refreshing the IPR view

will re-sync to the up to date lighting.

· RenderMan Maya Area Light Textures are set to resolution 1,024. This needs manually updating to

a higher value if resolutions higher than this are required.
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· Alpha is not supported on the area light, an RGB image (pre-multiplied by the Alpha) is used as the

light content.

· When camera visibility is turned on/off in HDR Light Studio, this isn't detected in the RenderMan

IPR session. An IPR restart is required to correctly honor this setting.

· When soloing an Area Light, the HDRI map will use the colour setting from the PxrDomeLight so

the HDRI will now be white instead of black.

· RenderMan 21: Area Lights are not named to match the HDR Light Studio name, they stay as their

default Maya names.

· RenderMan 21: When promoting/demoting an area light occasionally the dome texture will not

update leading to either a duplicate light (both the new area light and the HDR light) or no light

(area light disappears but the HDR doesn't update). This one seems fairly random and isn't very

common but is easily fixed by either manually selecting the dome light in Maya or making a change

to the main HDR image.

· RenderMan 21: When creating a new area light, it usually briefly flashes up as a white rectangle in

the IPR until the texture updates start coming through for that light. Occasionally the IPR seems to

ignore the texture update and leave the light as a white rectangle, doing any operation on the light

(moving, property, texture) will cause the light to properly update its texture.

IBL Hook Setup

These are the manual steps needed to create an image based lighting setup that is compatible with

HDR Light Studio.

When HDR Light Studio creates an IBL Hook for you, it generates this setup.

Create a Pixar Dome Light pressing the PxrDomeLight button

In the Attribute Editor, use the folder icon to select a standin HDRI map file for the Color Map

If you would like to see the HDRI environment in the background of the shot, enable the Camera
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Visibility tick box

The IBL hook is now valid. HDR Light Studio will now see and connect to this IBL setup.
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Release Notes

Release Notes | Known Issues

Release Notes

Build 2023.1115

Updated to be compatible with HDR Light Studio 8.2

Build 2023.0329

Maya 2024 support - Adding Python 3.10 into the Maya installer.

Added support for Area Light spread - Arnold, Renderman, Redshift, and V-Ray.

New unified single installer.

Performance improvements.

HDR Light Studio has moved to using a new version of QT. Plug-in updates were required as a result

of this.

HDR Light Studio API updates.

Fixed a bug related to exporting your scene without panel having focus.

Fixed Pause/Start Start/Start buttons not saving the project data.

Lots of additional small bugs fixed.

5th May 2022

Maya 2023 plug-in released - Plug-in build 2022.0404

Build 2021.1115

Support added for RenderMan 24.2

Dropped support for Maya 2018

9th June 2021

Support for Maya 2022 added

Build 2021.0504

On macOS, if HDR Light Studio environment variable is not found/work/set then default install

location used to find HDR Light Studio main app. This allows users to use HDR Light Studio with their

connection who were having technical difficulties due to macOS ignoring our environment variable.

Build 2020.1203

Fixed a big with RenderMan IPR support.
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Build 2020.0302

Support added for Maya 2020, supporting: Redshift, V-Ray, Octane, Renderman and Arnold

Tested against: Redshift 2.6.51, V-Ray 4.30.001, Octane 2019.1.5 - 15.14, RenderMan 23.1, Arnold 4.0.1

Bug fix: Maya / Octane: Area Light Alpha not appearing correctly

Build 2019.0531

Fixed LightPaint inaccurate in V-Ray Render View inside HDRLS

Build 2019.0403

Maya 2019 support added

Fixed issues with VRay VFB not hiding/reloading/restarting properly.

Fixed issues with ReSync'ing the Arnold FrameBuffer.

Fixed issue with Maya not refreshing its environment hooks before Starting the Connection.

Fixed issues with not handling switching of the Maya scene when HDRLS is running. 

Fix for RenderMan 22.3 support 

Build 2018.1206

Fixed a bug resulting in duplicated area lights caused by a change in Arnold 3.1.1

Build 2018.1023

Maya/Octane: Later release of Octane broke HDR Light Studio compatibility. This has now been fixed.

Maya/Octane: Fixed a potential crash issue when starting the Octane IPR in Maya via HDR Light

Studio.

HostPreset namings for RenderMan are changing to;

RenderMan 20 and older will be referred to as RenderMan Legacy

RenderMan 21 & 22 will both be referred to as RenderMan.

Build 2018.0725

Changes to support updated API in newer HDRLS.

Build 2018.0426

Huge interface update, replacing HDR Light Studio connection panel with shelf buttons.

Bug Fixes:

Bug 1732: Maya/Arnold - area lights are not hidden when solo'd or turned off in HDRLS

Build 2018.0202

Updated workflow - hook creation for renderers, Maya IPR image hosted in HDR Light Studio Render

View

Plus minor bug fixes
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HDR Light Studio 5.4.1 fixes a bug with Maya/Arnold. HDR Light Studio Production Render content

was output in the wrong file format. This is now fixed.

Build 2016.1122

Support added for new area light advanced rotations and light handle

Bug 1204 - Fixed bug with Octane Renderer where Show/Hide for area lights does not affect the IPR

Bug 1517 - Fixed probems due to using Multiple Environment Hooks

Bug 1424 - Fixed issue where invalid characters in Area Light name causes the IPR renderer to stop

responding

Build 2016.0804

Added support for Maya 2017

Added support for RenderMan 21

V-Ray area lights are now correctly scaled using U and V size parameters

Fixed broken Alpha on Maya V-Ray area lights

Build 2016.0512

Added support for Maya 2016.5

Build 2016.0323

A fix so that RenderMan is now supported on OSX  as well as Windows and Linux. Performance

improvements when using RenderMan.

Build 2016.0225

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Support added for iRay for Maya.

Support added for HDR Light Studio area lights. Works with MentalRay, Arnold, V-Ray, Maxwell,

Octane, Redshift, RenderMan (RIS), iRay for Maya.

Bug 996 - Fixed bug where HDRLS can not be stopped when it's hidden.

Bug 1138 - Fixed bug where Export Scene fails if path name has a space in it.

Bug 1139: Fixed bug with exporting the scene as a named file not being saved in the HDRLS project

data in Maya. 

Bug 1151 - Fixed plug-in exception bug with using Rim LightPaint mode in Maya viewport

Bug 1004 - Fixed bug where connection could not be resumed with HDRLS after a HDRLS crash.

Bug 1206: Fixed rotation for HDRI map in Maya/Redshift. 
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Build 2015.0814

The Maya Connection has been updated to be compatible with HDR Light Studio 5.2.1

HDR Light Studio 5.2.1 contains a critical stability fix relating to communications between HDR Light

Studio and host connections.

Build 2015.0630

Support for Maya Renderman 20 environment node has been added (PxrStdEnvMapLight).

Plug-in user interface has been updated to be more consistent with the plug-in connections.

Build 2015.0527

BUG 826 - if your Maya scene was exported to HDR Light Studio 5 with the "Via Temporary File"

switched off, saving and restoring the scene in Maya would not load back the model in HDR Light

Studio. This has been fixed.

BUG 829 - in the previous build using the Maya plug-in connection, there was a delay of a few

seconds before a re-render was triggered in Maya after a lighting change in HDR Light Studio. This

has been fixed in the Maya plug-in connection build 2015.0527. You will also need to install HDR Light

Studio 5.1.

Known Issues

Arnold

Whilst Maya has cameras for the front/side/top and they are listed in HDR Light Studio's Render View

that shows the Arnold IPR. But those views are not supported by Arnold. If you select front/side/top

camera views in the HDR Light Studio Render View, the view will not change and the LightPaint

feature will not function. The reason is that whilst Maya will list them as cameras, Arnold does not

recognize them as cameras.
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Legacy Maya Connection

The Maya Connection has now had a major redesign and is much improved using Maya shelf

buttons.

For users of older builds - here is the legacy documentation:

· Quick Start

· Interface Overview

· Maya Connection in Detail
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Quick Start

1. Press the HDR Light Studio button on the HDR Light Studio shelf in Maya

The HDR Light Studio Connection panel opens. You can dock this in your Maya interface.

At the top of the panel it will show Maya's current renderer (if it's supported by the HDR Light Studio

connection)

2. Press the Start button

The HDR Light Studio Connection will now create an IBL Hook (Environment Light) for you.

Please give it a name and Press OK.
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3. HDR Light Studio will now start connected with Maya

The HDR Light Studio interface will look like this when starting.

4. Press the play button on the Render View (HDR Light Studio) - the view with the HDR Light Studio

logo

Now press the Import button to load your Maya scene into HDR Light Studio. This will export a temp

Alembic file into HDR Light Studio.
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Your Maya scene is now loaded into HDR Light Studio's own renderer - providing a very fast way to

light your shot.

5. Make you first light

Press the Round Light button on the tool bar
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The light is added to the HDRI map and you can see the lighting updated in the HDR Light Studio

render view.

Click and drag on the 3D model in the Render View to reposition the active light using the LightPaint

tool (default)

The light will interactively move and the render view updates as the light is moved. Welcome to

interactive HDRI lighting!

6. Press the Play button in the Render View (Maya/VRay)

New in HDR Light Studio (Carbon) - This feature is compatible with V-Ray, Arnold, Octane,

Redshift and RenderMan
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V-Ray IPR will now be started in Maya and the IPR image will be shown in the HDR Light Studio

interface.

This is a simple example with a red shader over the whole car model.

Continue adding and adjusting lights until you are happy with the lighting design. The lighting

updates in both views as you work.

7. Let's make one of the lights a 3D Area Light

In this example the Large Rect Soft Box that is active in the Light List.
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In the Render Properties panel enable the Area Light check box.

Use the Smart Dolly slider to bring the light closer to the object in the scene.

If we look at the Maya scene, we can see the 3D Area Light has also been built correctly for this

renderer.
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HDR Light Studio created area lights are seen in the HDRLSAreaLights group. Everytime the light is

edited in HDR Light Studio, it is updated in Maya.

8. Now we will generate the HDR content as high quality files on disc.

Press the HDR button in HDR Light Studio.
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The Production Render dialog opens

In this example we have set the HDRI map resolution to 3000 x 1500, and have left the Area Light

resolution as 1000 pixels.
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Press Browse and provide a file name and location.
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Now press the Render button and HDR Light Studio will generate the HDR content for Maya.

The environment light and area lights in Maya will now use these files on disc.

9. Press the Stop button in the HDR Light Studio Connection panel in Maya.

This will close HDR Light Studio and the connection to it.
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That's it! You lit your first shot using HDR Light Studio with the Maya Connection.
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Interface Overview
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Maya Connection in Detail

Showing the  HDR Light Studio Connection panel

Press the HDR Light Studio button in Maya (by default this is found in the HDRLightStudio shelf)

The HDR Light Studio Connection panel will open in the Maya interface.

When the HDR Light Studio Connection panel opens, a HdrlsProjectData node is added to the Maya

scene and can be seen in the Outliner.

This node stores the HDR Light Studio lighting project within the Maya scene so that the lighting

design can be restored in HDR Light Studio in a future sessions.

This stores the last state of the project before the HDR LIght Studio connection is closed, and of

course in only saved when the Maya scene itself is saved.

Please note: Using Maya's 'File > Optomize Scene Size' feature will remove the HdrlsProjectData node from

your scene. Be sure not to accidentally remove it.

HDR Light Studio Connection - IBL Hook and Connection

At the top of the panel are the IBL Hook and Connection sections.
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In order for HDR Light Studio to be started in a connection with Maya and your Renderer, an IBL

Hook is required to connect with.

An IBL Hook is simply a valid Image Based Lighting setup (Dome Light / Environment Light), who's

HDRI map file can be replaced and updated by HDR Light Studio.

If the Renderer shown at the top matches your current renderer in Maya (it should do)

The fastest way to get started is to simply press the Start button.

During the start process, our plug-in detects if there are valid IBL Hooks, if not then we create one for

you.

(An exception to this is Maxwell Render - you need to set up image based lighting manually for this renderer

- see here for details on how to do this)

Simply provide a name for the Hook and press the OK button.

HDR Light Studio will now start, controlling the HDRI image file used on the new IBL Hook.
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If you press the Start button and there are already valid IBL Hooks in your Maya scene, a dialog will

appear where you will be asked to choose a Hook from the drop down, or there is an option to create

a New Hook

HDR Light Studio will then start connected to the hook selected or the new one created.

What happens when HDR Light Studio is connected to an IBL Hook?

The HDR light Studio connection now controls the image file being used in the IBL setup. The current

HDRI map design in HDR Light Studio is shared with Maya as a temp proxy (lo-res) image, and the IBL

is automatically updated to use this file.

A proxy image is used because it is faster to calculate in HDR Light Studio and faster for Maya to load

during the iterative lighting design process.

The temporary file name and location will look something like this on your IBL dome/sphere:

The file name of the proxy file shared will change with a random number at the end. This ensures

that an IPR session will update with the most up to date lighting at all times, even when renderers

cache image textures in the scene.

At the end of the lighting process in HDR Light Studio a Production quality HDRI map will be

produced at higher resolution and quality, and this map will automatically replace the proxy image.

The location and size of the proxy files can be set in the Preferences dialog in HDR Light Studio. You may

need to change this location to a network drive if you want to use an IPR session using multiple computers

for network rendering.

LightPaint in Maya Viewports

Rather than guessing where to put the lights in HDR Light Studio to achieve your desired effect, a

selected light in HDR Light Studio can be moved using the LightPaint tools in the HDR Light Studio

Connection panel. Press one of the LightPaint mode names to enable the tool. Then click on the 3D
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model in the Maya viewport to position the light via that LightPaint mode. Press the Off button to

stop the LightPaint tool.

For more information about the LightPaint modes see: LightPaint

Export Maya Scene to HDR Light Studio

An alternative to using the LightPaint tool within the Maya viewport, is to Export your Maya scene

into HDR Light Studio's Render View.

The Render View in HDR Light Studio provides a fast preview of the illumination and reflection effect

of the HDR lighting on the scene, plus acts as an interface for positioning the lights.

The image is not intended as a final render, but an aid in the lighting design process.

Benefits of exporting your scene to HDR Light Studio are:

· Work in a single application with all the lighting controls at hand within the interface to

concentrate on the lighting process.

· Click to reposition lights using LightPaint, and drag to move the light around the model with live

ray-traced feedback in the render view.

· Drag and drop from the library of Preset Lights directly onto your 3D model in the Render View,

they are positioned using the LightPaint mode.

· The Render View in HDR Light Studio is fast and highly optimized for previewing image based

lighting. It handles very large scenes.

· Often provides a more robust and faster experience than using IPR with some renderers.

Use the Render View instead of an IPR session, and produce test renders in Maya for larger scenes.
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The HDR Light Studio Connection panel has an Export section that provides a fast method to export

your scene directly into HDR Light Studio's Render View.

The default settings for this work well, Alembic is a very reliable format to move your geometry and

cameras into HDR Light Studio, even for still images.

The Alembic format also supports animation in HDR Light Studio and the frame required can be

selected.

Make sure the viewport with the camera view you want in Maya is active, and press the 'Export

Scene' button.

Maya will export the scene and HDR Light Studio will then automatically load it.

Area Lights

Lights can be promoted from the HDRI map into Area Lights (light cards/emitters) in 3D space.

For more information on creating and using area lights in HDR Light Studio see: Area Lights

The promoted area light is removed from the HDRI map shared with Maya. However a

representation of the area light will still be seen on the Canvas in HDR Light Studio (the canvas

provides a lat-long view of both area lights and the HDRI map as viewed from the world origin).

When using HDR Light Studio connected to Maya, the area lights will automatically be created with

the correct shader network for your renderer. The area lights in Maya will use proxy image files

containing the light content (RGBA data) that is mapped onto the light surface. These proxy images

will be controlled by HDR Light Studio, just like the main IBL proxy image is during the lighting

process. Please note: You can set the resolution of the proxy content in HDR Light Studio’s Preferences

panel.

In addition to the RGBA content - then the size, location, rotation of these area lights is also

controlled by HDR Light Studio through the connection. If available in your renderer, the primary
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(camera) visibility and light falloff (quadratic or constant) will also be set by HDR Light Studio. All

other settings for the area light are not controlled by HDR Light Studio and can be adjusted in Maya.

We have gone to great lengths to ensure creating and adjusting area lights will work correctly when

using a Maya IPR (or your renderer's IPR) to provide a live preview of your lighting. This makes a great

workflow - lighting in HDR Light Studio and seeing the results update in your IPR session.

When the first area light is created by HDR Light Studio in Maya, a new group caled HDRLSAreaLights is

created to contain these area lights and can be seen in the Outliner.

Control of HDR Light Studio's area lights is uni-directional from HDR Light Studio to Maya, i.e. if you

move one of these area lights in Maya, the position is not updated in HDR Light Studio. HDR Light

Studio drives their position. If you did move a light in Maya by mistake, the next time HDR Light

Studio adjusted the light it would move back to HDR Light Studio location.

As lights are created, duplicated, deleted, hidden etc within HDR Light Studio, the area lights in this

folder are updated and will be in sync with HDR Light Studio.
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If you drag the position of a light in the Render view in HDR Light Studio, the position will be updated

in Maya when releasing the mouse, keeping the communication traffic between the apps to a

sensible level. 

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in Maya (or any part of their associated shader network/file

nodes) will cause problems!

Production Render

Once you are happy with your lighting, press the 'Production Render' button in HDR Light Studio.

Set your Production Render settings and Press Render in this panel. For more information see:

Production Render Dialog

The production quality content will be calculated and saved. The connection will automatically

update Maya to use these final area light and HDRI map images.

If any changes are now made to the lighting in HDR Light Studio, all content will be updated to use

the proxy versions again. So please ensure you 'Stop' the HDR Light Studio connection after you have

produced your production lighting.
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Save Maya scene.

If you would like the HDR Light Studio project to be saved in your Maya scene, you should save your

Maya scene now. This way the scene state matches the HDRI map and area lights that are currently

in the project.

This Maya scene can be shared with another Maya user without the HDR Light Studio 5 Connection

installed, and it would open and render without problems, even the area lights. The HdrlsProjectData

node would simply be ignored.

Saving and loading HDR Light Studio projects

The HdrlsProjectData could be deleted from the scene and would not create problems, but would

remove the option of restore the HDR Light Studio project if you wanted to further edit/adjust the

lighting.

However the HDR Light Studio project can be saved from the HDR Light Studio interface at any time

during the lighting process as a HDi file (native HDR Light Studio project file), even when using HDR

Light Studio via a connection. If you were to open HDR Light Studio in a connection with Maya, this

project can be loaded into HDR Light Studio using Project > Open Project. The lighting design would

load into HDR Light Studio replacing its current design, and would then be synced back into Maya.

This is how you can move lighting between Maya projects or between renderers in Maya.
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MODO Connection

The MODO Connection is a plug-in that creates a bridge between HDR Light Studio and MODO.

As the HDRI map and Area Lights are created in HDR Light Studio, MODO is kept in sync.

Supports MODO: 14,15,16

Supported Renderers: MODO, Octane

· Installation

· Connection Interface Overview

· Workflow - MODO Renderer

· Workflow - Octane Renderer

· Workflow - V-Ray Renderer

· Managing Performance/Resources

· Release Notes
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Installation

Installing on Windows

Installing on MacOS

Uninstalling on Windows

Uninstalling on MacOS
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Installing on Windows

Important Note:

You should install the main HDR Light Studio application first, prior to installing our MODO

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both MODO and HDR Light Studio app are not running prior to installing our MODO

Connection plug-in.

1. Download the HDR Light Studio Connection for MODO installer from our web site. Pick the

appropriate installer for your version of MODO.

2. Run the installer. This copies the files from the installer to:

C:/Users/<username>/AppData/Roaming/Luxology/Configs/hdrls5_kit801

3. Run MODO.

4. Go to System > Kit Toggle Enable. If you have the HDR Light Studio 4 plug-in installed you should

disable this while using the HDR Light Studio connection. So disable hdrlightstudio and enable

HDRLightStudioConnection

5. Restart MODO.

6. That's it. The HDR Light Studio connection to MODO should be installed on your computer.  The

options for HDR Light Studio appear in MODO's Environment Properties Panel.
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MODO Environment Properties Panel

You should now proceed to Licensing. For information on using the connection see MODO

Connection.



1011

1011Connections (Plug-Ins)

Installing on MacOS

Important Note:

You should install the main HDR Light Studio application first, prior to installing our MODO

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both MODO and HDR Light Studio app are not running prior to installing our MODO

Connection plug-in.

1. Download the HDR Light Studio Connection for MODO installer from our web site. Pick the

appropriate installer for your version of MODO.

2. Run the installer. This copies the files from the installer to:

/Library/Application Support/Luxology/Content/Kits

3. Run MODO.

4. Go to System > Kit Toggle Enable. If you have the HDR Light Studio 4 plug-in installed you should

disable this while using the HDR Light Studio connection. So disable hdrlightstudio and enable

HDRLightStudioConnection

5. Restart MODO.

6. That's it. The HDR Light Studio connection to MODO should be installed on your computer. The

options for HDR Light Studio appear in MODO's Environment Properties Panel.
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MODO Environment Properties Panel

You should now proceed to Licensing. For information on using the connection see MODO

Connection.
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Uninstalling on Windows

To remove the HDR Light Studio plug-in connection to MODO, run the uninstaller in the following

directory:

C:\Program Files\Lightmap\HDRLightStudioConnectionModo\

Uninstalling on MacOS

To remove the HDR Light Studio plug-in connection to MODO, delete our kit directory (called

"hdrls_kitxx" where xx is the version) in the following directory:

/Library/Application Support/Luxology/Content/Kits 
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Interface Overview
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Workflow - MODO Renderer

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to MODO provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in

MODO, where you can see the lighting interact with your 3D scene. You can also create and control

Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between MODO and HDR Light

Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial

1. Start MODO and load the MODO project you want to light.

It makes most sense to use the 'Render' interface layout in MODO when using HDR Light Studio (see

Figure 1).

Figure 1: Setting the interface layout to 'Render'

Make sure a camera is set up and active for the specific view you want to light. By default, MODO

creates a camera for us called ‘Camera’, which can be seen in the ‘Items’ panel. For this camera to be

https://www.lightmap.co.uk/learning/category/get-started/
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the camera view that we use when lighting in HDR Light Studio, it needs to be ‘Set as Render

Camera’ by Right-Clicking on the camera in the ‘Items’ panel and selecting that option (see Figure

2). A ‘blue ball’ icon next to the camera name in the Items panel will appear to indicate that this is the

current Render Camera. 

Figure 2: Setting a camera to be the Render Camera

2. Whatever interface layout you are in (MODO, Model, Animate, Render, VR), ensure the view

is set to ‘Render Camera’ (see Figure 3). 

This is to ensure your view always displays the view of your camera in HDR Light Studio. If the view in

MODO does not match the camera view in HDR Light Studio, you will notice that LightPaint will not

paint the lights where you would expect them to. 
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Figure 3: Changing the view to always show the view of the Render Camera

3. In the Shading Panel, select an Environment. The HDR Light Studio Connection 'controls' can

be seen at the bottom of the Environment Properties (see Figure 4).

 Figure 4: Controls of the HDR Light Studio connection

4. Click within the 3D viewport in MODO to make sure the view is 'active'.

HDR Light Studio needs to know the active view when starting. (Although MODO does not highlight the

active view, so its easy to forget to do this).

5. In the HDR Light Studio Connection controls, use the drop down to choose the Renderer you

are using for this project (see Figure 5). 

This is used to determine the available features in the HDR Light Studio interface. The lighting design
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created will be the same and compatible with MODO, Octane and V-Ray renderers.

In this example we are using the MODO renderer.

Figure 5: Choosing Modo as the renderer

6. Press 'Start' to start HDR Light Studio connected with MODO (see Figure 6).

Figure 6: Starting HDR Light Studio connection

The HDR Light Studio application will now open and is connected to MODO.

The HDR Light Studio connection has added a new image on the selected Environment (see Figure 7).

Figure 7: New image is added to the environment

The current HDRI map design in HDR Light Studio is shared with MODO as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for MODO to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is
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updated in MODO to use a new temp with a new filename, to ensure the renderer uses the new

image even when caching images.

The HDR Light Studio interface should look like in Figure 8.

If not in HDR Light Studio you can reset it by going to the menu: Window > Layout > Load > Default >

MODO

Figure 8: HDR Light Studio on startup with Modo

Using our latest version of HDR Light Studio and the MODO connection - the HDR Light Studio

interface will now show 2 Render Views.

On the left is Render View [Modo|Modo] (New in Tungsten Drop 2)

7. Press Play on Render View [Modo|Modo] (see Figure 9) 
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Figure 9: Starting the Modo Render View within HDR Light Studio

HDR Light Studio now instructs MODO to start a new hidden session of the MODO Preview Render.

The interactive Preview Render image is now displayed in this Render View (see Figure 10).

To understand all of the features/controls for this view, see here.
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Figure 10: Modo render view working within HDR Light Studio

If you hide HDR Light Studio, you will not see a Preview Render running in MODO as a result of pressing this

button. HDR Light Studio has created its own hidden Preview Render session. If you were to press play in

MODO and start another Preview Render, this view will not be used by HDR Light Studio, and 2 x Preview

Renders running at the same time will slow things down.

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the chosen

location on the 3D model when using LightPaint (see Figure 11).

Learn about LightPaint here.

Figure 11: LightPaint mode set to Reflection
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8. Click on the Presets tab next to the Light List tab, to show the Preset Lights (see Figure 12).

Figure 12: Opening the presets tab to see a list of presets

9. Drag and drop a Preset Light onto the 3D model in the Render View [Modo|Modo] (see Figure

13).
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Figure 13: Placing a preset light onto the model

The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

· A new light in the Light List in HDR Light Studio (see Figure 14).
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· You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure

14).

· The MODO environment has been updated to use the new live HDRI map from HDR Light Studio,

and the MODO Preview Render updated using the new lighting (see Figure 14).

Figure 14: HDR Light Studio interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [Modo|Modo] (see

Figure 15).

10. Click on the 3D model to reposition the selected light from the Light List (see Figure 15).

The light is moved on the HDRI map, the new HDRI map is sent to MODO and the Preview Render

updates.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where you

want them.
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Figure 15: Using LightPaint to paint lights on the model

If there is a delay of more than a second, or so, after clicking to move a light and see the updated

rendered result - the process will be slow and tedious.

In this situation we can use HDR Light Studio's built in renderer to speed up the lighting process.

11. Press the play button on Render View [HDR Light Studio] (see Figure 16)

Figure 16: Starting up HDR Light Studio Render View

The Import Scene Geometry panel will pop up

12. Press Import (see Figure 17)
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Figure 17: Importing the scene from Modo to

HDR Light Studio render view

By default the whole MODO scene is exported as a temporary alembic file and loaded into the

Render View [HDR Light Studio].

To export only selected geometry into HDR Light Studio - see here

You may need to use the Camera Drop Down in Render View [HDR Light Studio] to match the camera

view you are seeing from MODO (see Figure 18).

Figure 18: Modo render view (left) and HDR Light Studio render view (right) side by side

The Render View [HDR Light Studio] renders the loaded scene lit with the current lighting design. A

simple shader is used on the whole scene to preview the light and reflections.

If you needed to open Render View [HDR Light Studio] to get a more interactive lighting

experience. Use this view for LightPaint, where clicking and dragging to position lights is

supported - it's fast and interactive.

The Render View [Modo|Modo] rendering will catch up eventually as you work, and will display an

image using the latest lighting.
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If the Render View [Modo|Modo] is still so slow that it is of little benefit during the interactive

lighting process, and maybe it is also slowing down HDR Light Studio a lot, then use the

Pause/Play button to stop and resume rendering in Render View [Modo|Modo], in order to do

test renders from time to time (see Figure 19).

Figure 19: Pause/Play button for the render view

We have documented in more detail the process of using 2 render views together in HDR Light Studio here.

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area Light in 3D space in MODO, mapped with the HDR content

from HDR Light Studio.

13. Enable the Area Light check box in the Light Properties panel for the selected light (see

Figure 20).

Figure 20: Converting a light into an area light
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As a result of enabling the Area Light setting, these things instantly happen:

· The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 21).

· The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 21).

· A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio with a

Smart Dolly distance of 1,000 (see Figure 21).

· A 3D plane with emitter shader is created in MODO, mapped with the HDR light content (RGBA),

this can be seen lighting the shot in Render View [Modo|Modo] (see Figure 21).

Figure 21: Light converted into an area light

14. Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure 22).
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Figure 22: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in MODO. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

If we switch to the MODO user interface, we can see:

· The Area Light geometry in the viewport (see Figure 23) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here)  

· A folder containing the area lights made with HDR Light Studio in the Items panel (see Figure 23)

· Shaders setup in the Shading panel for the created area lights - mapped with HDR (RGBA) content

(see Figure 23)
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Figure 23: MODO interface after creating an area light

15. Use LightPaint in the Render Views to move the Area Lights, just like moving a light on the

HDRI map (see Figure 24).

In fact area lights are controlled just like any other light in HDR Light Studio, with the addition of

distance settings.

Figure 24: Using LightPaint to position the area light

When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in MODO (or any part of their associated shader

network/file nodes) will cause problems!

16. Production Render

Once you are happy with your lighting, press the 'Production Render' button in HDR Light Studio (see Figure

25).
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Figure 25: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to 'Modo/Modo', this ensures that the rendered HDRI map is mapped correctly in the

host, i.e. MODO (see Figure 26). For more information see: Production Render Dialog

Figure 26: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update MODO to use these final area light and HDRI map images.
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If any further changes are now made to the lighting in HDR Light Studio, all content will be updated

to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced your

production lighting, by Pressing the Stop button (see Figure 27).

Figure 27: Stopping the HDR Light Studio connection

17. Save MODO scene.

If you would like the HDR Light Studio project to be saved in your MODO scene, you should save your

MODO scene now. This way the scene state matches the HDRI map and area lights that are currently

in the project.

18. Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as a HDi file (native HDR Light Studio project file), even when using HDR Light Studio

via a connection. If you were to open HDR Light Studio in a connection with MODO, this project can

be loaded into HDR Light Studio using Project > Open Project. The lighting design would load into

HDR Light Studio replacing its current design, and would then be synced back into MODO. This is

how you can move lighting between MODO projects or between other supported 3D software.
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Workflow - Octane Renderer

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to MODO provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in

MODO, where you can see the lighting interact with your 3D scene. You can also create and control

Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between MODO/Octane

Render and HDR Light Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial

For compatibility ensure you are running 'at least' Octane Version: 2018.1.3.145

1. Start MODO and load the MODO project you want to light.

It makes most sense to use the 'Render' interface layout in MODO when using HDR Light Studio (see

Figure 1).

Figure 1: Setting the interface layout to 'Render'

https://www.lightmap.co.uk/learning/category/get-started/
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Make sure a camera is set up and active for the specific view you want to light. By default, MODO

creates a camera for us called ‘Camera’, which can be seen in the ‘Items’ panel. For this camera to be

the camera view that we use when lighting in HDR Light Studio, it needs to be ‘Set as Render

Camera’ by Right-Clicking on the camera in the ‘Items’ panel and selecting that option (see Figure

2). A ‘blue ball’ icon next to the camera name in the Items panel will appear to indicate that this is the

current Render Camera.

Figure 2: Setting a camera to be the Render Camera

2. Whatever interface layout you are in (MODO, Model, Animate, Render, VR), ensure the view

is set to ‘Render Camera’ (see Figure 3).

This is to ensure your view always displays the view of your camera in HDR Light Studio. If the view in

MODO does not match the camera view in HDR Light Studio, you will notice that LightPaint will not

paint the lights where you would expect them to.
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Figure 3: Changing the view to always show the view of the Render Camera

3. In the Shading Panel, select an Environment. The HDR Light Studio Connection 'controls' can

be seen at the bottom of the Environment Properties (see Figure 4).

 Figure 4: Controls of the HDR Light Studio connection

4. Click within the 3D viewport in Modo to make sure the view is 'active'.

HDR Light Studio needs to know the active view when starting. (Although Modo does not highlight the

active view, so its easy to forget to do this).

5. In the HDR Light Studio Connection controls, use the drop down to choose the Renderer you

are using for this project (see Figure 5). 

This is to used determine the available features in the HDR Light Studio interface. The lighting design
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created will be the same and compatible with MODO, Octane and V-Ray renderers.

In this example we are using the Octane renderer.

Figure 5: Choosing Octane as the renderer

6. Press 'Start' to start HDR Light Studio connected with MODO (see Figure 6).

Figure 6: Starting HDR Light Studio connection

The HDR Light Studio application will now open and is connected to MODO.

The HDR Light Studio connection has added a new image on the selected Environment (see Figure 7).

Figure 7: New image is added to the environment

The current HDRI map design in HDR Light Studio is shared with MODO as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for MODO to load during the
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iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is

updated in MODO to use a new temp with a new filename, to ensure the renderer uses the new

image even when caching images.

The HDR Light Studio interface should look like this (see Figure 8).

If not in HDR Light Studio you can reset it by going to the menu: Window > Layout > Load > Default >

MODO

Figure 8: HDR Light Studio on startup with MODO

Using our latest version of HDR Light Studio and the MODO connection - the HDR Light Studio

interface will now show 2 Render Views.

On the left is Render View [Modo|Octane] (New in Tungsten Drop 2)

7. Press Play on Render View [Modo|Octane] (see Figure 9)
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Figure 9: Starting the Octane Render View within HDR Light Studio

HDR Light Studio now instructs MODO to start Octane Render interactive rendering in an

OctaneRender Viewport.

This interactive Preview Render image is now displayed in this Render View (see Figure 10).

To understand all of the features/controls for this view, see here.
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Figure 10: Octane render view working within HDR Light Studio 

By default this view will be set to have a display LUT, in this case sRGB. But the image being shared

with HDR Light Studio already has a display LUT applied.

To display this image correctly, to match what we see in MODO. Use the drop down to change

the LUT to None (see Figure 11).
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Figure 11: Removing LUT

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the chosen

location on the 3D model when using LightPaint (see Figure 12).

Learn about LightPaint here.

Figure 12: LightPaint mode set to Reflection

8. Click on the Presets tab next to the Light List tab, to show the Preset Lights (see Figure 13).
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Figure 13: Opening the presets tab to see a list of presets

9. Drag and drop a Preset Light onto the 3D model in the Render View [Modo|Octane] (see

Figure 14).
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Figure 14: Placing a preset light on the model

The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

· A new light in the Light List in HDR Light Studio (see Figure 15).
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· You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure

15).

· The MODO environment has been updated to use the new live HDRI map from HDR Light Studio,

and the Octane render updated using the new lighting (see Figure 15).

Figure 15: HDR Light Studio interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [Modo|Octane]

(see Figure 16).

10. Click on the 3D model to reposition the selected light from the Light List (see Figure 16).

The light is moved on the HDRI map, the new HDRI map is sent to MODO and Octane Render

updates.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where you

want them.

Figure 16: Using LightPaint to paint lights on the model
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If there is a delay of more than a second, or so, after clicking to move a light and see the updated

rendered result - the process will be slow and tedious. This is unlikely when using Octane as its fast.

But, if Octane updates are slow for some reason, we could use HDR Light Studio's built in renderer to

speed up the lighting process.

11. Press the play button on Render View [HDR Light Studio] (see Figure 17)

Figure 17: Starting up HDR Light Studio Render View

The Import Scene Geometry panel will pop up

12. Press Import (see Figure 18)

Figure 18: Importing the scene from MODO

to HDR Light Studio render view
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By default the whole MODO scene is exported as a temporary alembic file and loaded into the

Render View [HDR Light Studio].

To export only selected geometry into HDR Light Studio - see here

You may need to use the Camera Drop Down in Render View [HDR Light Studio] to match the camera

view you are seeing from MODO (see Figure 19).

Figure 19: Octane render view (left) and HDR Light Studio

render view (right) side by side

The Render View [HDR Light Studio] renders the loaded scene lit with the current lighting design. A

simple shader is used on the whole scene to preview the light and reflections.

If you needed to open Render View [HDR Light Studio] to get a more interactive lighting

experience. Use this view for LightPaint, where clicking and dragging to position lights is

supported - it's fast and interactive.

The Render View [Modo|Octane] rendering will catch up eventually as you work, and will display an

image using the latest lighting.

If the Render View [Modo|Octane] is so slow that it is of little benefit during the interactive

lighting process, then use the Pause/Play button to stop and resume rendering in Render View

[Modo|Octane], in order to do test renders from time to time (see Figure 20).

Figure 20: Pause/Play button for the render view

We have documented in more detail the process of using 2 render views together in HDR Light Studio here.

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area Light in 3D space in MODO, mapped with the HDR content

from HDR Light Studio.
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13. Enable the Area Light check box in the Light Properties panel for the selected light (see

Figure 21).

Figure 21: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

· The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 22).

· The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 22).

· A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio with a

Smart Dolly distance of 1,000 (see Figure 22).

· A 3D plane with emitter shader is created in MODO, mapped with the HDR light content (RGBA),

this can be seen lighting the shot in Render View [Modo|Octane] (see Figure 22).
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Figure 22: Light converted into an area light

14. Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure 23).

Figure 23: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in MODO. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

If we switch to the MODO user interface, we can see:
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· The Area Light geometry in the viewport (see Figure 24) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here)  

· A folder containing the area lights made with HDR Light Studio in the Items panel (see Figure 24)

· Shaders setup in the Shading panel for the created area lights - mapped with HDR (RGBA) content

(see Figure 24)

Figure 24: MODO interface after creating an area light

15. Use LightPaint in the Render Views to move the Area Lights, just like moving a light on the

HDRI map (see Figure 25).

In fact area lights are controlled just like any other light in HDR Light Studio, with the addition of

distance settings.

Figure 25: Using LightPaint to position the area light
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When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in MODO (or any part of their associated shader

network/file nodes) will cause problems!

16. Production Render

Once you are happy with your lighting, press the 'Production Render' button in HDR Light Studio (see Figure

26).

Figure 26: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to 'Modo/Octane', this ensures that the rendered HDRI map is mapped correctly in the

host, i.e. MODO (see Figure 27). For more information see: Production Render Dialog

Figure 27: Production Render panel

The production quality content will be calculated and saved. The connection will automatically

update MODO to use these final area light and HDRI map images.
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If any further changes are now made to the lighting in HDR Light Studio, all content will be updated

to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced your

production lighting, by Pressing the Stop button (see Figure 28).

The OctaneRender Viewport will be stopped but will remain open in MODO when stopping HDR Light

Studio. This view will need to be closed manually.

Figure 28: Stopping the HDR Light Studio connection

17. Save MODO scene.

If you would like the HDR Light Studio project to be saved in your MODO scene, you should save your

MODO scene now. This way the scene state matches the HDRI map and area lights that are currently

in the project.

18. Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as a HDi file (native HDR Light Studio project file), even when using HDR Light Studio

via a connection. If you were to open HDR Light Studio in a connection with MODO, this project can

be loaded into HDR Light Studio using Project > Open Project. The lighting design would load into

HDR Light Studio replacing its current design, and would then be synced back into MODO. This is

how you can move lighting between MODO projects or between other supported 3D software.



1051

1051Connections (Plug-Ins)

Workflow - V-Ray Renderer

HDR Light Studio is a standalone lighting application providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to MODO provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in

MODO, where you can see the lighting interact with your 3D scene. You can also create and control

Area Lights using HDR Light Studio.

This workflow tutorial will teach you how to use the connection between MODO and HDR Light

Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

Workflow Tutorial

1. Start MODO and load the MODO project you want to light.

It makes most sense to use the 'Render' interface layout in MODO when using HDR Light Studio (see

Figure 1).

Figure 1: Setting the interface layout to 'Render'

Make sure a camera is set up and active for the specific view you want to light. By default, MODO

creates a camera for us called ‘Camera’, which can be seen in the ‘Items’ panel. For this camera to be

https://www.lightmap.co.uk/learning/category/get-started/
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the camera view that we use when lighting in HDR Light Studio, it needs to be ‘Set as Render

Camera’ by Right-Clicking on the camera in the ‘Items’ panel and selecting that option (see Figure

2). A ‘blue ball’ icon next to the camera name in the Items panel will appear to indicate that this is the

current Render Camera.

Figure 2: Setting a camera to be the Render Camera

2. In the Shading Panel, select an Environment. The HDR Light Studio Connection 'controls' can

be seen at the bottom of the Environment Properties (see Figure 3).

 Figure 3: Controls of the HDR Light Studio connection

3. Click within the 3D viewport in Modo to make sure the view is 'active'.

HDR Light Studio needs to know the active view when starting. (Although Modo does not highlight the

active view, so its easy to forget to do this).
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4. In the HDR Light Studio Connection controls, use the drop down to choose the Renderer you

are using for this project (see Figure 4). 

This is used to determine the available features in the HDR Light Studio interface. The lighting design

created will be the same and compatible with MODO, Octane and V-Ray renderers.

In this example we are using the V-Ray renderer.

Figure 4: Choosing V-Ray as the renderer

5. Press 'Start' to start HDR Light Studio connected with MODO (see Figure 5).

Figure 5: Starting HDR Light Studio connection

The HDR Light Studio application will now open and is connected to MODO.

The HDR Light Studio connection has added a new image on the selected Environment (see Figure 6).

Figure 6: New image is added to the environment
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The current HDRI map design in HDR Light Studio is shared with MODO as a temp proxy (lo-res)

image. A proxy is used because it's faster to calculate and faster for MODO to load during the

iterative lighting design process. When the lighting design changes in HDR Light Studio, this image is

updated in MODO to use a new temp with a new filename, to ensure the renderer uses the new

image even when caching images.

Using our latest version of HDR Light Studio and the MODO connection - the HDR Light Studio

interface will now show 2 Render Views. On the left is Render View [Modo|Vray] (see Figure 7)

Currently this view is not compatible with MODO V-Ray and can be closed!

Figure 7: HDR Light Studio on startup with MODO and V-Ray

We recommend changing the layout using the top menu: Window > Layout > Load > Default >

Standalone

The HDR Light Studio interface will then contain the features you need to use HDR Light Studio with

MODO and V-Ray (see Figure 8).
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Figure 8: HDR Light Studio Standalone interface layout  

Using 2 displays provides the best work flow, with HDR Light Studio on one display, and MODO on

the other (see Figure 9).

Figure 9: Modo (left) and HDR Light Studio (right) running on 2 displays

6. Press the play button on Render View [HDR Light Studio] (see Figure 10).
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Figure 10: Starting HDR Light Studio Render View

The Import Scene Geometry panel will pop up

7. Press Import (see Figure 11) 

Figure 11: Importing the scene from Modo to

HDR Light Studio render view

By default the whole MODO scene is exported as a temporary alembic file and loaded into the

Render View [HDR Light Studio].

To export only selected geometry into HDR Light Studio - see here

We will use this Render View in HDR Light Studio as the interface for positioning lights on the model,

with real time feedback (see Figure 12).
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Figure 12: HDR Light Studio render view with imported scene from MODO

Let's make our first light in HDR Light Studio ...

By default, LightPaint is set to Reflection in this view. So lights are positioned to reflect in the chosen

location on the 3D model when using LightPaint (see Figure 13).

Learn about LightPaint here.

Figure 13: LightPaint mode set to Reflection

8. Drag and drop a Preset Light onto the 3D model in the Render View (see Figure 14).
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Figure 14: Placing a preset light onto the model 

The Preset Light has been added to the lighting design in a location that is reflecting where the light

was dropped on the 3D model.

You will see:

· A new light in the Light List in HDR Light Studio (see Figure 15).

· You can see the new light added on the Canvas (HDRI Map View) in HDR Light Studio (see Figure

15).

· The Render View has been updated to show the lighting effect on the loaded 3D model (see Figure

15).
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Figure 15: HDR Light Studio interface after creating a light

You can see that the LightPaint tool is active in the toolbar within the Render View [HDR Light Studio]

(see Figure 16).

9. Click on the 3D model to reposition the selected light from the Light List.

This is a very interactive way to light your shot. Placing lights directly on the 3D model where you

want them (see Figure 16).

Figure 16: Using LightPaint to paint light on the model

10. Let's start V-Ray interactive rendering in MODO to see what the lighting looks like (see

Figure 17).



1060

1060Connections (Plug-Ins)

Figure 17: Starting V-Ray interactive rendering in MODO  

V-Ray Frame Buffer opens and V-Ray starts rendering the view (see Figure 18).

Figure 18: V-Ray Frame Buffer inside MODO (left) running with HDR Light Studio (right) 

We can leave V-Ray rendering as we work in HDR Light Studio. When lighting changes in HDR Light

Studio, it will update MODO > V-Ray to use the new lighting.

If the scene is large and rendering in V-Ray is updating slowly, you can produce test renders from

time to time instead of leaving V-Ray interactive rendering running. It is up to the user to judge this

performance and decide what to do.

So far the light we created is on the HDRI map. With a single setting, this light can be removed from

the HDRI map, and created as an Area Light in 3D space in MODO, mapped with the HDR content

from HDR Light Studio.

11. Enable the Area Light check box in the Light Properties panel for the selected light (see

Figure 19).
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Figure 19: Converting a light into an area light

As a result of enabling the Area Light setting, these things instantly happen:

· The Light in the Light List gets the suffix [AreaLight] and the text is now yellow - clearly showing

which lights are Area Lights (see Figure 20).

· The light is removed from the HDRI map lighting the Render Views (but is still represented and

shown on the Canvas) (see Figure 20).

· A 3D Area Light mapped with the HDR light content (RGBA) is created in HDR Light Studio with a

Smart Dolly distance of 1,000 (see Figure 20).

· A 3D plane with emitter shader is created in MODO, mapped with the HDR light content (RGBA),

this can be seen lighting the shot in V-Ray (see Figure 20).
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Figure 20: Light convered into an area light

12. Reduce the Smart Dolly slider value to move the light closer to the 3D model (see Figure 21).

Figure 21: Moving the area light closer to the model (LightPaint position)

HDR Light Studio has a scene scale setting that is useful when working with Area Lights in MODO. If

the area lights are too close or too far away by default. Adjust the Smart Dolly Scalar value in

Preferences. This value scales all area lights in HDR Light Studio.

On the MODO user interface, we can see:
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· The Area Light geometry in the viewport (see Figure 22) (If not, the area light is most likely too far

away from your scene. To learn more about Smart Dolly - click here)  

· A folder containing the area lights made with HDR Light Studio in the Items panel (see Figure 22)

· Shaders setup in the Shading panel for the created area lights - mapped with HDR (RGBA) content

(see Figure 22)

Figure 22: MODO interface after creating an area light

13. In HDR Light Studio, use LightPaint in the Render View [HDR Light Studio] to move the Area

Lights, just like moving a light on the HDRI map (see Figure 23).

In fact area lights are controlled just like any other light in HDR Light Studio, with the addition of

distance settings.

Figure 23: Using LightPaint to position the area light
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When using the HDR Light Studio area lights, please note:

Renaming/deleting/duplicating these area lights in MODO (or any part of their associated shader

network/file nodes) will cause problems!

14. Production Render

Once you are happy with your lighting, press the 'Production Render' button in HDR Light Studio (see Figure

24).

Figure 24: Production Render buttons

Set your Production Render settings and Press Render in this panel. Notice how the 'Orientation' is

already set to 'Modo/Vray', this ensures that the rendered HDRI map is mapped correctly in the host,

i.e. MODO (see Figure 25). For more information see: Production Render Dialog
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Figure 25: Production Render Panel

The production quality content will be calculated and saved. The connection will automatically

update MODO to use these final area light and HDRI map images.

If any further changes are now made to the lighting in HDR Light Studio, all content will be updated

to use the updated proxy versions again.

So please ensure you 'Stop' the HDR Light Studio connection after you have produced your

production lighting, by Pressing the Stop button (see Figure 26).

Figure 26: Stopping the HDR Light Studio connection
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15. Save MODO scene.

If you would like the HDR Light Studio project to be saved in your MODO scene, you should save your

MODO scene now. This way the scene state matches the HDRI map and area lights that are currently

in the project.

16. Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as a HDi file (native HDR Light Studio project file), even when using HDR Light Studio

via a connection. If you were to open HDR Light Studio in a connection with MODO, this project can

be loaded into HDR Light Studio using Project > Open Project. The lighting design would load into

HDR Light Studio replacing its current design, and would then be synced back into MODO. This is

how you can move lighting between MODO projects or between other supported 3D software.
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Exporting Selected

Sometimes you don't want to export the whole scene from MODO into HDR Light Studio. Especially if

you have hidden geometry that you don't want to export. For example earlier version of the model.

The standard export process into HDR Light Studio will export the whole scene.

Here is the workflow to export only Selected items into Render View [HDR Light Studio]

In this example we are going to export only the mixer bowl into HDR Light Studio.

1. Go to the MODO interface.

2. Select items in this specific order and then Press the Selected Via File button.

A. Camera

B. Parts to Export

C. Environment in Shading panel (in order to show Environment properties for next step)

D. Press 'Selected Via File' button
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You will be promoted for a file name and location for the exported Alembic file.

Press Save.
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HDR Light Studio will open and display the exported scene in the Render VIew [HDR Light Studio].

You may need to change the camera using the drop down in the view.
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Managing Performance/Resources

HDR Light Studio includes its own CPU powered Render View. Import a MODO scene and quickly

create perfect lighting by clicking and dragging light positions on the 3D model geometry with

realtime feedback. Use MODO's own interactive rendering at the same time to see the updated

lighting interacting with the final shaders. In this scenario, 2 renderers are running at the same time

and will be competing for your computer's resources. The competing renderers can slow down each

other's performance and the responsiveness of the computer. Here is some advice on how to better

manage this situation by managing the resources better.

Recommendations for Managing Performance/Resources:

GPU Rendering in MODO

When using a GPU based renderer in MODO (when HDR Light Studio's renderer is running), it should

not compete with HDR Light Studio. So both renderers should be nice and fast when used at the

same time.

CPU Rendering or CPU/GPU (Combined) Rendering in MODO

If using CPU or CPU/GPU (Combined) renderering in MODO when HDR Light Studio's CPU renderer is

running, please consider making the following adjustments to improve performance:

1. In HDR Light Studio's Render View Settings for HDR Light Studio, reduce the Max Samples to a

low number like 5.
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HDR Light Studio's renderer will now stop renderering much sooner after each lighting change,

leaving more resources for MODO's renderer.

HDR Light Studio's Render View really does not need to resolve to a high quality image, just a few

samples is enough to get a good impression of the lighting. See here:

Please note

One thing to bear in mind is that when using HDR Light Studio using only the HDRI map (i.e. no 3D

area lights). Once HDR Light Studio has collected the render samples, it does not need to re-sample

when the HDRI map changes, i.e. a light is edited on the HDRI map. Therefore, once the progress bar

is fully green, the renderer has essentially stopped 'rendering'. There is a small set of calculations to
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update the image when the HDRI map is changed. But these happen fast. So please understand that

you can leave the Max Samples setting at 80 if you are using only HDRI map based lighting and HDR

Light Studio's own Render View has already completed sample collection.

2. If you still feel the renderers are competing and performance is poor, if possible reduce the

number of threads used by your renderer in MODO when rendering. Many renderers default to

using all threads. This can reduce MODO's ability to process messages and images from HDR Light

Studio. For example, if you have a computer with 8 CPU cores, reducing your renderer to use 6 cores

will leave 2 more cores for HDR Light Studio and for handling communications between HDR Light

Studio and MODO. Additionally reducing thread priority to low can also help. Availability of these

settings varies from renderer to renderer, please consult your renderer's documentation to see how

to change these settings.
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Release Notes

Release Notes | Known Issues

Release Notes

Build 2024.0222

Updated to be compatible with HDR Light Studio 8.2

Fixed an error when making Area Lights in MODO 16.1 and above

Build 2023.0330

Fixed conflicts with other plug-ins.

HDR Light Studio has moved to using a new version of QT. Plug-in updates were required as a result

of this.

5th May 2022

MODO 16 plug-in released - Plug-in build 2022.0420

Build 2021.0504

On macOS, if HDR Light Studio environment variable is not found/work/set then default install

location used to find HDR Light Studio main app. This allows users to use HDR Light Studio with their

connection who were having technical difficulties due to macOS ignoring our environment variable.

MODO 15 support added 6th April 2021

MODO 15 itself has fixed a licensing bug where a floating license of MODO was preventing a floating

license of HDR Light Studio working.

Tungsten Drop 4

Support added for MODO 14.

There is a bug with Area Lights textures in MODO 14 first release. The RGB texture is not being

applied correctly to the light. We are working with Foundry on this, as the issue is in MODO.

Using HDR Light Studio for HDRI map creation is working as expected.

There is an interface bug when the connection panel is narrow, the Stop button is not showing up in

the pop up containing the missing buttons. To work around this make the panel wider.



1074

1074Connections (Plug-Ins)

Build 2019.0710

See your MODO Interactive Render inside the HDR Light Studio interface

Supported in MODO 11,12,13, with MODO Renderer and Octane Render.

Octane Render View in HDR Light Studio interface

For compatibility ensure you are running 'at least' Octane Version: 2018.1.3.145

Bug Fix: MODO Connection - Export Selected Via File with Collada not working.

Build 2019.0403

Adds MODO 13 support

Fixed Deletes environment textures on load complete notification (no env texture on re-starting

session)

Build 2018.1204

Fixed bug where initial state of lighting shared with Modo was black until one lighting change was

made.

Build 2018.0424

Adds MODO 12 support

Build 2018.0129

Press Play button in HDR Light Studio to automatically import the scene from Modo

Plus minor bug fixes

Build 2017.0706

Support for MODO 11 added.

LightPaint in MODO viewports does not work in MODO version 11.1.

We are working with Foundry on this issue.

There are no issues when using LightPaint in MODO version 11.0

Build 2016.1102

Support added for new area light advanced rotations and light handle

Build 2016.0621
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Added support for Modo version 10

HDR Light Studio Area Light support added - supports renderers: MODO, Octane and V-Ray

Build 2016.0225

Added support for Modo 902

Updated for compatibility with HDR Light Studio 5.3

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Bug 1005 - Fixed HDRLS crash on exit when referencing Alembic file

Bug 1126 - Fixed bug where Modo thinks its connected to HDRLS when it isn't, after an initial failed

attempt.

Fixed bug where HDRLS can not be stopped when it's hidden.

Build 2015.0625

Support for Alembic scene export has been added.

Plug-in user interface has been updated to be more consistent with the plug-in connections.

Build 2015.0527

Support has been added for MODO 901

BUG 826 - if your MODO scene was exported to HDR Light Studio 5 using the persistent option,

saving and restoring the scene in MODO would not load back the model in HDR Light Studio. This

has been fixed.

BUG 827 - the Pause button has been replaced with Show and Hide buttons to improve consistency

across plug-in connections. Also undocked panels would not hide in the previous build. This has

been fixed.

BUG 829 - in the previous build using the MODO plug-in connection (particularly on Mac OS X and

Linux), there was a delay of a few seconds before a re-render was triggered in MODO after a lighting

change in HDR Light Studio. This has been fixed in the MODO plug-in connection build 2015.0527.

You will also need to install HDR Light Studio 5.1.

Known Issues

Modo 16.0v4+ with Octane Crash

Modo 16.0v4 and later release, when used with OctaneRender_for_Modo15-16: 2023_1_2_196 can
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cause a crash when you switch to the Octane Layout, Start HDR Light Studio, and press the play

button on the Render View (Modo/Octane). The workaround is to start the Octane render in the

viewport first in Modo before pressing play in HDR Light Studio.

No Render Camera found bug

Start up Modo, delete the default camera and then create a new one. If you try and export the scene

to HDR Light Studio at this point it will error with "No Render Camera found".

To fix, go to the Render section in the Shading view, on the Render Camera drop down, reselect the

newly created camera. HDR Light Studio will now sync the scene correctly.
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Octane Standalone

The Octane Render Standalone Connection is a plug-in that creates a bridge between HDR Light

Studio and Octane Render Standalone.

Start HDR Light Studio and paint the Octane Render View with lights inside HDR Light Studio.

· Installation

· HDRI Map Workflow

· Area Lights Workflow

· Release Notes

HDR Light Studio Connection is compatible with Octane Standalone on Windows only, version

2021.1.7 minimum.
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Installation

HDR Light Studio Connection for Octane Standalone is available for Windows operating system only.

Important Note:

You should install the main HDR Light Studio application first, prior to installing our Octane

Connection plug-in. See installation instructions for HDR Light Studio here.

Make sure both Octane and HDR Light Studio app are not running prior to installing our Octane

Connection plug-in.

Make sure Octane Standalone and HDR Light Studio is closed.

Run the HDR Light Studio Connection installer exe, for example: OctaneRender_Win_2018.0619.exe

Once installed, the HDR Light Studio Connection panel is available to open from the 'Windows' drop

down menu in Octane Standalone.
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HDRI Map Workflow

Let's light an Octane Standalone scene using only a single HDRI map containing all of your light

sources.

In Octane Standalone, use the Windows drop down menu, to choose HDR Light Studio Connection

The HDR Light Studio Connection panel will open.

Click hold and drag the small square to the left on the panel title 'HDR Light Studio Connection' in

order to dock this new panel in your Octane Standalone interface layout. Here we have docked it

above the Node Inspector.

If you do not dock the panel, this panel can end up behind the main Octane interface, it is therefore always

best to dock the panel.
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The connection requires a Render Target node to be selected in Octane before starting. Selecting the

Render Target starts the rendering in Octane which is a pre-requisite for the connection to start. 

Press the Start button to start HDR Light Studio in a connection with Octane Standalone. HDR Light

Studio will open and replace your environment texture with a live HDRI map.

Maximize the HDR Light Studio interface, as we do not need to see the Octane layout when using

HDR Light Studio.
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Press the large play button on the Render View (Octane|Octane) Panel. This will display the

rendered image from Octane Standalone within the HDR Light Studio interface.

Please note, our Render View allows you to choose the display LUT for the incoming image. You may need to

set the LUT to 'None' if the image has already got a LUTs or Gamma applied in Octane Standalone, becuase

otherwise the sRGB LUT we apply by default will make the image look washed out and not match the

Octane view.
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Now we can start to light the shot. Let's drag and drop a Preset Light from the preset panel and

onto the Render View (Octane|Octane).
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Once the light is dropped, it is added to the HDRI map in HDR Light Studio, which is instantly

updated and shared with Octane Standalone. So you can see the new light is added to the view, and

added to the Light List. The last light created is selected and highlighted in the Light List.

Because the 'LightPaint' mode of the RenderView is set to the default 'Reflection' setting - the preset

light was added to the HDRI map in a location that reflects in the location where it was dropped onto

the 3D model.

To reposition the light we can click on the 3D model again to move it - we call this 'LightPaint'.

Let's click in another location on the model.
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The selected light is moved to a new location on the HDRI map to reflect in the new position clicked

on the 3D model. This allows you to place lighting effects exactly where they are needed on your

model. When a light is selected, its properties are displayed in the Light Properties panel. You can

adjust the size, rotation, brightness and much more for any light in here.

In this example, we have now skipped ahead after adding and adjusting more lights.

To complete the lighting process we need to save a high resolution, sub-sampled (smoother and

higher quality) HDRI map, as a file on disc for Octane Standalone to use.

We do this by pressing the HDR button on the tool bar in HDR Light Studio.

The Production Render panel is displayed.
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Choose a Resolution for the Map, then use the Browse button to select a location and create a

filename for the final map. Then press the Render button to generate the final HDRI map on disc.

Once this is completed, Octane Standalone will be updated to use this new file.

In Octane Standalone, press the Stop button to close HDR Light Studio.

If we examine the Octane scene, we can see that the Environment is now using the HDRI map we just

created.
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This Octane scene is lit and is ready to render at high resolution for the final image. Make sure you

save the Octane scene now too.

If you decided that you wanted to edit the lighting further, the HDR Light Studio project is embedded

within the Octane scene you saved. If you press the Start button on the HDR Light Studio Connection

panel again. HDR Light Studio would start, load the embedded lighting project, and replace the high

resolution file on disc with the live lo-res HDRI map that is generated quickly as you design the

lighting. So remember always to use the HDR button to render the final HDRI map at the end of

every lighting session.
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Area Lights Workflow

By default new lights created in HDR Light Studio are added to the HDRI Map.

Lights on the HDRI map affect the whole scene, as they mimic lights positioned a long distance away

from the model.

So for example in this scene, you can see the single light is illuminating the entire model. You can see

the strap behind the watch face is receiving light too.

Lights in HDR Light Studio with '3D mapping' display the Area Light check box.

Enable this setting to remove the light from the HDRI map used in Octane, and instead create a 3D

emitter with the HDR content from HDR Light Studio mapped onto it.
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In the example below we have enabled the Area Light check box (1)

You can see the light in the Light List now has yellow text and [Area Light] at the end of its name (2)

Lower the Smart Dolly slider value (3) to move the light towards the 3D model. If you move the light

close enough it will become visible in the camera view.

Area Lights are controlled exactly the same as lights on the HDRI map, clicking on the 3D model to

position them using LightPaint, with the addition of the distance control.

You can see in the example below how the light is now locally lighting the 3D model, the strap behind

the watch face is no longer receiving light.

Please note: There is a scale setting for area lights. If the 3D scene is very small you will find it hard to

position the lights close to the model with any precision using the slider. Or if the scene is very big, you may

find it impossible to position the lights far enough away. This can be rectified by changing the Smart Dolly

Scalar value in Edit > Preferences. This allows the slider to control the lights over varying distances.
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In the example below we have duplicated the Area Light and positioned four of them around the 3D

model. 
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It is often desirable to see the reflection and illumination effect of an area light, but not to see this

light source directly in the camera view.

Disable the Cam Visibility check box and the light will no longer be seen directly by the camera.

Please note: The back side of an area light seen in Octane will appear black. If the light is not in focus, it can

be hard to see this effect. If the light gets between the camera and the subject, it can cast a dark smudge

over part of the image. Watch out for this and disable the visibility of the light to make sure this

undesirable effect does not happen.

See below, the visibility of the same area lights has been turned off. But they still light and reflect in

the 3D scene.

If you switch to Octane Render and look at the Scene outliner, you can see where the HDR Light

Studio Area Lights have been created. This is all controlled automatically via the HDR Light Studio

Connection. As new area lights are created or deleted, they are added and removed from this group.
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If you wish to return a light back to the HDRI map, simply uncheck the Area Light check box. We have

done this with the four area lights in the example below.

Now their lighting and reflections affect the whole scene, they appear in white text again in the Light

List, and the distance controls are no longer available.
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If we look in Scene outliner in Octane, we can see the Area Lights have been deleted that existed

before, because the Area Light check box was disabled for them all.
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When you have finished lighting a scene containing Area Lights, they need rendering at high quality

at the same time as the HDRI map. When you press the HDR button to open the Production Render

panel, there is a resolution setting specifically for the Area Lights. They will generated to the chosen

resolution. Each area light will inherit the name of the main HDRI map, with the addition of a unique

number on the end of the file name to identify it.
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Release Notes

Build 2023.1115

Updated to be compatible with HDR Light Studio 8.2

Build 2023.0505

Works with 2022.1 and 2022.1.1

Small bug fixes and added support for 2022.1.1

Build 2023.0203

Works with 2021.1 and 2022.1

Fixed a compatibility issue - we now work with 2021.1.7 as a minimum version.

Removed support for 2019 and 2020

HDR Light Studio API updates.

14 Jan 2022

Connection Released for Octane Standalone 2021.1

Build 2021.0512

Bug fixes

Build 2020.1208

Support added for Octane Standalone 2020.2

Build 2020.0805

Connection updated to use the new TCP/IP API in HDR Light Studio.

This provides a more responsive communication and lighting experience between HDR Light Studio

and Octane Standalone.

Build 2020.0511

New build for Octane Standalone 2020 release version, built against release SDK. Previous build

stopped working with final release.

Build 2019.1211

Small bug fixes

Build 2019.1203

Octane Standalone 2019 and 2020 support added
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Build 2019.0716

Octane 2018 support added

Octane 3 supported retired

Bug fix: Lightpaint sometimes inaccurate.

Bug fix: Area lights not correctly synced back up causing scene geometry to be hidden when area

lights toggled on/off 

Bug fix: Renaming area lights correctly handled 

Build 2019.0304

Fixed issue with area lights not turning off/on

Fixed memory leak

Build 2018.0717

HDR Light Studio Connection is compatible with Octane Standalone on Windows only version 3.08.1

and higher.

Notes:

Known Issue:

If ‘Enable denoising’ is set and ‘DeMain' is selected, Render View [Octane|Octane] will fail to

start

Any scene that has 'Enable Denoising' set in Render target node > Imaging Settings > Imager > Spectral

AI Denoiser, and when 'DeMain' is selected and HDR Light Studio is started, the Octane interactive

rendering inside HDR Light Studio interface will not start. The following error message will be

displayed in the render view: Octane Not Responding. Setups appears to be incorrect. 

Error Message when LightPainting on Octane Standalone Render View - says Connection Error.

ORBX scenes exported from Maya with some versions of Octane 2019 and 2020, are not have all the

cameras setup correctly with their film settings node linked up. Only the render camera at the time

of export appears to have this correctly setup. This can be fixed manually in Octane standalone. It

affects our LightPaint system and creates an error message if this is not correctly setup.

Don't touch/move/manipulate the "HDR Light Studio Area Lights" node

If the user creates area lights whilst using Octane, a "HDR Light Studio Area Lights" node is created

and placed in the geometry "pipe/pin" of the node graph.

This node is a "container" for all of our area light nodes, effectively containing/hiding them away

from the user.

By default it's created as the "first" thing in the geometry pipeline, first step from the render target,

whilst the user could manually move this around and reconnect it anywhere in the geometry

pipeline, or even disconnect it completely. This could break the area lights, they may not render or
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start rendering behind things (effectively hiding them) etc. It's strongly recommended that the user

doesn't touch/move/manipulate the "HDR Light Studio Area Lights" node at all.

Don't rename area lights inside Octane Standalone

Area lights in Octane cannot be manually renamed (inside Octane), it will break our connection to the

area light.

Any renaming of the area light must be done inside HDRLS, the light node name itself also contains

our light ID (which we use to link the area lights), if that ID were removed/changed it will break the

connection we have to the light.

Don’t select other nodes in Octane when interactive rendering inside HDR Light Studio is

running

If other nodes in Octane are clicked or moved, e.g. moving off the initial Render Node, then the

interactive rendering inside HDR Light Studio interface may stop receiving updates from Octane. To

get it updating again, users will be required to click on the Resync (Restart) button inside the Render

View [Octane|Octane].
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Omniverse

The NVIDIA Omniverse™ Connection is an extension that creates a bridge between HDR Light

Studio and NVIDIA Omniverse™ USD Composer.

As the HDRI map and Area Lights are created in HDR Light Studio, Omniverse is kept in sync.

Requires Omniverse USD Composer 2021.3.2 and higher (Windows OS)

 

Requires HDR Light Studio - Xenon Drop 4 or higher

Supported Renderers: RTX

· Installation

· Interface Overview

· Workflow

· Quick Start Video

· Release Notes
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Installation

 Important: Before installing our Omniverse Connection, you will need to install:

•   A local Nucleus Service

•   Omniverse USD Composer

•   HDR Light Studio (main application/standalone)

Installing For All Users - Windows

Installing For a Single User - Windows

Uninstalling - Windows

 Please Note: If you're looking to update the Omniverse Connection, please first uninstall your

current Omniverse Connection build and then follow the installation instructions below.

Installing For All Users - Windows

STEP 1: Download the Omniverse Connection file from our web site.

STEP 2: Save the zip file downloaded from our website at a location of your choice. Do not unzip this

file. 

STEP 3: Start up Omniverse USD Composer and go to Window > Extensions

https://docs.omniverse.nvidia.com/nucleus/latest/workstation/installation.html
https://docs.omniverse.nvidia.com/app_create/app_create/overview.html
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STEP 4: Go to Hamburger Menu and click on Import Extension
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STEP 5: Go to the directory where you have stored the Omniverse Connection zip file. Select it and

click on Import.
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The HDR Light Studio Connection for Omniverse USD Composer is now installed.

You no longer need the .zip file used to install the connection, it can now be deleted (in this example it was

stored on the desktop).

STEP 6: Search for HDR Light Studio and enable the HDR Light Studio Connection by toggling the

toggle switch.

 If you click on the HDR Light Studio Connection, on the right will see details about the connection

and you can check the Autoload checkbox for the HDR Light Studio Connection to load on start-up.

STEP 7: Access the HDR Light Studio Connection by going to Window > HDR Light Studio. 
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The installation process is complete and you are now ready to use HDR Light Studio using this

Workflow.

 Important: When updating the HDR Light Studio extension to a new version, please uninstall the

current extension before installing the newer one. At the moment, Omniverse will allow users to

install multiple versions of the HDR Light Studio extension, however, this can cause conflicts.

Installing For a Single User - Windows

STEP 1: Download the Omniverse Connection file from our web site.

STEP 2: Go to C:\Users\<user>\Documents\Kit\shared\exts and create a hdrlightstudio folder
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STEP 3: Save the zip file downloaded from our website in C:

\Users\<user>\Documents\Kit\shared\exts\hdrlightstudio

STEP 4: Extract/Unzip the Omniverse Connection file. You will no longer need the .zip file used to

install the Connection, it can now be deleted.

STEP 5: Start up Omniverse USD Composer and go to Window > Extensions
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STEP 6: Search for HDR Light Studio and enable the HDR Light Studio Connection by toggling the

toggle switch. You will notice the Connection gets a USER tag, which means that the extension has

been installed for the chosen user.

 If you click on the HDR Light Studio Connection, on the right will see details about the connection

and you can check the Autoload checkbox for the HDR Light Studio Connection to load on start-up.
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STEP 7: Access the HDR Light Studio Connection by going to Window > HDR Light Studio. 
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The installation process is complete and you are now ready to use HDR Light Studio using this

Workflow.

 Important: When updating the HDR Light Studio extension to a new version, please uninstall the

current extension before installing the newer one. At the moment, Omniverse will allow users to

install multiple versions of the HDR Light Studio extension, however, this can cause conflicts.

Uninstalling - Windows

STEP 1:  Search for HDR Light Studio Connection in the Omniverse USD Composer Extension

Manager (Go to the Omniverse USD Composer menu, Window > Extensions), then click on the

extension to show more details.
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STEP 2: Disable the HDR Light Studio Connection and make sure the Autoload setting is unchecked
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STEP 3: Click on the folder icon to open up the location of where the HDR Light Studio Connection is

installed. You can minimize it for now, you will need it soon.
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STEP 4: Close Omniverse USD Composer but do not close the file path pointing to the location of

where the HDR Light Studio Connection is installed.

STEP 5: You can now maximize the file path to the installed HDR Light Studio Connection.

STEP 6: Go down one level in the file path and delete the folder containing the extension files.
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The HDR Light Studio Connection for Omniverse USD Composer is now uninstalled.
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Interface Overview
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Workflow

This workflow tutorial teaches how to use HDR Light Studio with

Omniverse USD Composer via the Connection.

Watch the HDR Light Studio - Quick Start video first to learn the key

concepts of using HDR Light Studio.

Ensure you have installed both the HDR Light Studio main application and the HDR Light Studio

Connection for Omniverse.

Start Omniverse USD Composer and Load your 3D Scene

Before we start to use HDR Light Studio to light this scene.... let's make sure the scene is ready

to light first.

Camera View

Make sure you have a camera setup with the final composition for the shot that you want to light. If

you move the camera during the lighting process, the reflections of the lights will move and this will

ruin your lighting.

Existing Lights

Your scene should not contain any lighting before using HDR Light Studio. You may have set up some

environment/dome lighting during the look development for the scene, so now is a good time to hide

or delete this lighting. If you have an LED light that's part of a product for example, then this is a part

of your scene and should be kept. We simply want to avoid confusion by mixing lights created with

HDR Light Studio and those not created with HDR Light Studio. A blank lighting canvas is the best

place to start.

Tip: If you have an HDRI map you want to edit that's already lighting the scene, hide or delete this

light and load the HDRI map into HDR Light Studio once it's open.

Open the 'HDR Light Studio Connection' panel

Go to the menu: Window > HDR Light Studio
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The HDR Light Studio Connection panel opens.
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Ideally, you should now drag the panel and dock it into the Omniverse USD Composer

interface.
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Create A New Sublayer And Store Your Lighting On A Separate USD

File

Go to Layer panel. Then, while the Root Layer is the authoring layer, click on Create Sublayer

button.

 If the Root Layer isn't the authoring layer, simply double click on the Root Layer.

Give your sublayer a name and save. In this example we'll call it Porsche_Lighting.usd.
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Double click on the sublayer you have just created to change it to the Authoring Layer. The sublayer

will turn green,
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Now, any lighting we create in HDR Light Studio will be made and stored in this sublayer. This is a

good way to keep your lighting separate to your geometry, animation etc.

Create A Dome Light

Go to menu: Create > Light > Dome Light
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If we look in the Layer panel, we can see that this dome light has been created and is contained

within the created lighting layer. This dome light is now detected by the HDR Light Studio connection

and can be seen listed in HDR Light Studio panel.

When started, HDR Light Studio will connect to the chosen dome light and take control of its

environment image.
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If your dome light isn't being detected by the HDR Light Studio connection and it isn't listed in the

Dome Lights list, then click on Refresh (in the HDR Light Studio connection panel) to re-scan the

Omniverse stage and re-populate the Dome Lights list.

Start RTX Path-Traced Rendering

If you haven't already, switch from RTX Real-Time to RTX Path-Traced as it's the most accurate

render mode for lighting.
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Start HDR Light Studio

Press 'Start' to start HDR Light Studio in a connection with Omniverse USD Composer.

Please Note: If HDR Light Studio is already open running standalone, connected with another 3D

app, or connected to another session of Omniverse USD Composer - the connection will not function

correctly. So please ensure HDR Light Studio is not already open before starting it from Omniverse

USD Composer.

HDR Light Studio expects the dome light to have orientation set to 270, 0, 0.  This is important for the

LightPaint feature in HDR Light Studio to work as expected. So, if you see the HDR Light Studio -

Warning dialogue below, it means the dome light you have created has its orientation set to a value

that's different to what HDR Light Studio expects and is compatible with. Therefore, it is highly

recommended to always press Yes to allow HDR Light Studio to automatically fix the orientation and

set it to a value it expects, i.e. 270, 0, 0.
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The HDR Light Studio application now opens connected with Omniverse USD Composer. Behind the

scenes, the HDR Light Studio connection has taken control of the environment image on the chosen

dome light.

The HDRI map from HDR Light Studio is now shared with Omniverse as a temporary low-res image (a

proxy). This image is fast to calculate and fast for Omniverse USD Composer to load and use during

the interactive lighting design process.
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When the lighting design changes in HDR Light Studio, the environment in Omniverse USD

Composer is updated to use a new temp file with a new file name with a random number on the end

(see image above). This ensures the renderer uses the new image and not a cached old image.

Default HDR Light Studio Interface Layout with Omniverse
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By default, the HDR Light Studio interface should look something like this. (below)

If not, you can reset the HDR Light Studio interface layout by going to the menu: Window >

Layout > Load > Default > Omniverse

Show the interactive render inside the HDR Light Studio interface

In HDR Light Studio, press Play on Render View [Omniverse|RTX]

The Omniverse rendered image will now stream into HDR Light Studio's interface, so we can now

paint it with lighting.

To understand all of the features/controls for this view, see here.
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The rendered image will look too bright. This is because we need to change a setting in the Render

View [Omniverse|RTX]. Use the dropdown to change the LUT from sRGB to None. This will ensure

the image looks the same in HDR Light Studio as it does in Omniverse USD Composer.

Let's make our first Light

By default, LightPaint is set to Reflection in this view. So lights are moved to reflect in the clicked

location on the 3D model.

Learn about LightPaint here.

Drag and drop a Preset Light onto the 3D model in the Render View.
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A new light is added to the lighting design - it's reflecting where the light was dropped on the 3D

model.

As a result, you can now see in HDR Light Studio:

· 1. New light added in the Light List

· 2. New light can be seen on the Canvas

· 3. Render View has updated to show the new light on the model

Just the same as when we used HDR Light Studio standalone, but we have the scene from Omniverse

USD Composer in our Render View.
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Move the Light

You can see that the LightPaint tool is active in the toolbar in the Render View [Omniverse|RTX].

Click on the 3D model to reposition the selected light, (highlighted on the Light List)
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Please Note: If you are lighting in RTX Real-Time render mode, you will need to disable DLSS for

LightPaint to work properly. DLSS can be disabled in RTX Real-Time Render Settings > Anti-

Aliasing.

LightPainting on Transparent/Translucent Materials - e.g. Glass

At the moment, materials like glass may not be present in the depth pass inside Omniverse. Depth

pass allows our LightPaint feature to hook onto the surface and reposition your lights by clicking on

your model. In the future, Omniverse may change this. However, right now, for LightPaint to work as

expected on materials like glass, users will be required to set the "captureShadowCasters" setting in

the synthetic data module.

1. Close Omniverse USD Composer and HDR Light Studio, then find a file called omni.create.bat for

your build of Omniverse USD Composer. By default, it can usually be found in C:

\Users\myself\AppData\Local\ov\pkg\[Omniverse USD Composer Version]

2. Right click on omni.create.bat and click Edit
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3. The file will open in notepad

Replace call "%~dp0kit\kit.exe" "%%~dp0apps/omni.create.kit"  %*

with call "%~dp0kit\kit.exe" "%%~dp0apps/omni.create.kit" --ext-folder "%~dp0/apps"

--/syntheticdata/sensors/captureShadowCasters=true %*

4. Save omni.create.bat file and open your scene in Omniverse USD Composer.

5. In the Layer panel, set the authoring layer to be the Root Layer in your project and not your

Lighting layer (.usd file). When you set your Root Layer as the authoring layer, it will turn green.

6. Turn on the flag for Cast Shadows for all of the geometry in your scene that has

transparent/translucent materials applied to it, e.g. glass.
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Now, when start re-start HDR Light Studio and start LightPainting on transparent/translucent

materials, like glass, you will see it behaves as expected. However, this does result in some darkening

in your scene as that geometry will now cast shadows like solid objects. 

Making Area Lights - A 3D light mapped with an HDR texture

So far the lighting we created is on the HDRI map shared with Omniverse. This is about to change!

Enable the Area Light check box in the Light Properties panel for the selected light.

Please Note: Only Lights with 3D mapping show the option to be converted into area lights, as

these are the only lights that make sense to become area lights.
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Please Note: Alpha is not supported on area lights in Omniverse at the time of releasing this

connection. HDR Light Studio shares RGB texture files to the area lights with RGB values multiplied

by the alpha channel. So lights will have a black surround where the alpha should be.

As a result of enabling this Area Light setting, the lighting looks very similar to before, but lots of

things just happened with that single setting:

· 1. The Light in the Light List gets the suffix [AreaLight] and its text is now yellow.

· 2. The light has been removed from the HDRI map but is still represented on the Canvas as a view

of the light as seen from the center of the world. Don't be confused, it's really no longer on the

HDRI map lighting the shot!

· 3. Additional Area Light properties have been added to the Light Properties for this light, with a

default Smart Dolly distance of 1,000 units.

· 4. An Area Light has been created in Omniverse for the selected renderer - mapped with the HDR

texture from HDR Light Studio, and matching the size and position of the area light in HDR Light

Studio.

· 5. An area light has been created in Omniverse - mapped with the HDR texture from HDR Light

Studio, and matching the size and position of the area light in HDR Light Studio.
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Please Note: USD Composer 2023.1+ now conforms to the latest naming conventions for paths.

This includes not allowing asset names to begin with a numeric. As a result, the name of any area

light created by HDR Light Studio will now begin with 'hdrls_'. Omniverse users can use the new Asset

Validator to fix all of their assets and bring them up to the current standards. 

In Omniverse. temporarily switch to Render Mode: RTX Real-Time to see what the area lights look

like in this render mode. You will notice that the HDR textures are ignored in this render more. HDR

textures will be visible on the area light's geometry but not visible in the scene's reflections. Before

continue, ensure to switch back to  Render Mode: RTX Path-traced.

https://docs.omniverse.nvidia.com/composer/latest/release_notes.html
https://docs.omniverse.nvidia.com/composer/latest/release_notes.html


1132

1132Connections (Plug-Ins)

Change the Area Light Distance

Initially, the Area Light will be far away from your model providing a similar lighting effect to when it

was on the HDRI environment. We need to move it closer to the model so you can see it.

Reduce the Smart Dolly slider value to move the light closer to the 3D model.

HDR Light Studio has a scene scale setting that is useful when working with Area Lights. If the

area lights are too close or too far away by default, adjust the Smart Dolly Scalar value in Preferences.

This value scales all area light distances in HDR Light Studio.
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Let's take a look at the Omniverse interface now. You can see:

· 1. The Area Light that HDR Light Studio created can be seen in the Omniverse viewport.

· 2. Area Lights made with HDR Light Studio can be seen in the list of object in the Stage panel in

Omniverse.

· 3. The Area Light has been set up for your renderer. You can see the texture from HDR Light Studio

mapped to the light properties. This texture is updated when the light's appearance is changed in

HDR Light Studio.

 Please Note: Renaming/deleting/duplicating HDR Light Studio area lights in Omniverse can

cause issues. Area Lights created by HDR Light Studio should be managed using HDR Light Studio's

interface.

Moving Area Lights

Let's go back to the HDR Light Studio interface.

In HDR Light Studio, use LightPaint in the Render View [Omniverse|RTX] to move the Area

Light.

Area lights are controlled just like any other light in HDR Light Studio with the addition of the

distance controls.

Click on the 3D model to move the selected light.
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Area Light Spread

We can use the spread setting in HDR Light Studio to change how the light emits from the area light.

This is how the spread setting changes the light emitting from the area light.
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The effect of changing this setting varies between render mode RTX Real-Time and RTX Path-Traced.

Below can see the effect of changing this setting in two different render modes and how the light

becomes more focused on the scene with lower settings.

Area Light Spread in RTX Path-Traced

Default Spread = 1
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Spread = 0.50

Spread = 0.20

Area Light Spread in RTX Real-Time
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Default Spread = 1

Spread = 0.50



1138

1138Connections (Plug-Ins)

Spread = 0.20

Finalizing the Lighting Design

Rendering the Final HDRI Lighting Textures

So far we have been sharing lo-res temporary textures with Omniverse for your lighting - to keep things fast

during the lighting design process.

Now let's complete the lighting process by producing higher resolution and higher quality sub-sampled HDR

textures on disk.

Press the 'Production Render' button in HDR Light Studio.

The top HDR button on the toolbar

Set your Production Render settings
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Notice how the 'Orientation' is already set for Omniverse and your set renderer. This ensures that

the rendered HDRI map is orientated correctly when rendered.

For more information on these settings see: Production Render Dialog

Press the Browse button to choose a file location and give the lighting file a name.

Press the Render button in this panel.

The production quality HDR textures will now be calculated and saved as permanent files on disk.

Once complete, the connection automatically updates Omniverse to use these new textures.

Stopping HDR Light Studio

If any further changes are now made to the lighting in HDR Light Studio, all lighting textures will be

updated to use new proxy images, and the link to the rendered files is broken.

Please ensure you 'Stop' the HDR Light Studio connection after you have rendered your final

lighting files.

Press the Stop button.
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HDR Light Studio now closes and leaves your Omniverse scene with an awesome lighting setup for

your renderer. This scene uses standard lights and can be rendered anywhere, even on computers

without HDR Light Studio licenses.

 Please Note: If you want to edit the lighting design, press the Start button and HDR Light Studio

will open and load the lighting design project data which is embedded in the Omniverse project. You

can now edit the lighting, but make sure to render the final HDR textures at the end of the process.

Save the Omniverse project

The current state of the HDR Light Studio project is embedded in the Omniverse project. You should

save your Omniverse scene now.

 Saving and loading HDR Light Studio projects

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as an HDi file (native HDR Light Studio project file), even when using HDR Light

Studio via a connection. If you were to open HDR Light Studio in a connection with Omniverse, this

project can be loaded into HDR Light Studio using Project > Open Project. The lighting design would

load into HDR Light Studio replacing its current design, and would then be synced back into

Omniverse. This is how you can move lighting between Omniverse projects or between other

supported 3D software.
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Quick Start Video

Make sure you have watched the HDR Light Studio - Quick Start video

first to learn the key concepts of using HDR Light Studio.

NVIDIA Omniverse™ Connection - Quick Start Video
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Release Notes

Build 2023.1115

Updated to be compatible with HDR Light Studio 8.2

Build 2023.0715

Support added for Support for USD Composer 2023.1+

'Refresh' button has been added to the HDR Light Studio Connection panel. The button re-scans the

Omniverse stage and re-populates available dome lights in the Dome Lights list.

The name structure of the area lights created by HDR Light Studio now adheres to the latest naming

conventions for paths. The name of any area light created by HDR Light Studio will now begin with

'hdrls_'. 

Build 2023.0217

HDR Light Studio API updates.

Support added for USD Composer 2022.3+

30th September 2022

Updated plug-in released - Plug-in build 2022.0920

Updated to maintain compatibility with newer Omniverse USD Composer builds.

13th June 2022

Updated plug-in released - Plug-in build 2022.0610

In USD Composer 2022.1.3, the DX12 implementation corrupts the Beauty Pass of the interactive

rendering inside HDR Light Studio. As a result, the interactive rendering inside HDR Light Studio

interface will appear black. NVIDIA is aware of this issue and will fix it in the next release of USD

Composer.

At the moment, there are 2 options to use HDR Light Studio with Omniverse USD Composer:

1) Use HDR Light Studio with Omniverse USD Composer 2022.1.2

2) Use the new Omniverse USD Composer Connection build 2022.0610 and run Vulkan rather than

default DX12 rendering engine:

From your USD Composer root folder, example: C:\Users\user\AppData\Local\ov\pkg\create-2022.1.3
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You can run .\kit\kit.exe .\apps\omni.create.kit --vulkan

This will use the Vulkan engine rather than DX12. It may take some time to start the first time as it

will be compiling the shaders. Users can then use HDR Light Studio and Omniverse USD Composer

2022.1.3.

5th May 2022

Updated plug-in released - Plug-in build 2022.0414

We now auto enable 'sampled direct lighting' so that area lights can be seen in reflections using the

RTX Real-time renderer.

HDR Light Studio - Xenon (Drop 4.2)

HDR Light Studio Indie and Pro licenses will now support the NVIDIA Omniverse™ Connection

in this HDR Light Studio release.

Previously the NVIDIA Omniverse™ Connection was only available for Automotive licenses.

Existing customers with active licenses of Indie and Pro will be able to start using the NVIDIA

Omniverse™ Connection right away with existing licenses using this new build of HDR Light Studio.

Build 2022.0404

The Omniverse Connection has been updated to support the latest build of Omniverse, where

Omniverse changes had broken our previous build.

Fixed bug that caused LightPaint to not work with RTX Real-Time. Now, for LightPaint to work with

RTX Real-Time, DLSS needs to be disabled in RTX Real-Time Render Settings > Anti-Aliasing.

Build 2022.0330

The Omniverse Connection has been updated to support the latest build of Omniverse, where

Omniverse changes had broken our previous build.

Build 2021.0914

NVIDIA Omniverse™ extension for the 'USD Composer' app 2021.3.2 versions and higher is released.

(Windows only)
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Patchwork3D Connection

The Patchwork3D Connection is a plug-in that creates a bridge between HDR Light Studio and

Patchwork3D.

As the HDRI map and Area Lights are created in HDR Light Studio, Patchwork3D is kept in sync.

· Installation

· Interface Overview

· Workflow

· Editing Existing HDRI Maps

Installation

Simply install the HDR Light Studio main application and ensure that HDR Light Studio is licensed.

The connectivity to HDR Light Studio is already included within Patchwork3D.

You are now ready to use HDR Light Studio with Patchwork3D!

Next steps: Connection Interface Overview or follow the Workflow Tutorial
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Interface Overview

Workflow

HDR Light Studio is a standalone lighting application, providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to Patchwork3D, provides the ability to

create custom HDRI maps to light your scenes, with lights chosen and positioned to provide the

perfect effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time

in Patchwork3D, where you can see the lighting interact with your 3D scene.

This workflow tutorial will teach you how to use the connection between Patchwork3D and

HDR Light Studio.

It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started' content here

to learn the HDR Light Studio interface and the basic features.

When using HDR Light Studio connected to Patchwork3D and a change to the HDRI map design is

made in HDR Light Studio, Patchwork3D is instantly updated with this new lighting. HDR Light Studio

shares a low resolution HDRI of the lighting design (proxy) during the lighting design process. At the

end of this process, the HDRI map is rendered by HDR Light Studio as a high quality and high-

resolution file on disk that is then used by the Patchwork3D environment.

https://www.lightmap.co.uk/learning/category/get-started/
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HDR Light Studio can be used to create:

• Studio Lighting from scratch

• Edit/Enhance/Augment existing HDRI environments by loading them into HDR Light Studio

• Create convincing lighting for a back-plate image without an associated HDRI map

1. Starting HDR Light Studio in Patchwork3D

If you already have a scene loaded in Patchwork3D, please skip to Step 5.

For those less familiar with Patchwork3D, you can start here.

STEP 1: Start Patchwork3D. Figure 1 shows what your screen may look like. 

Figure 1: Patchwork3D on startup

STEP 2: To load a Patchwork3D scene, go to File > Open (see Figure 2) in the top toolbar or hit Ctrl +

O on the keyboard. Then, find your scene and click on ‘Open’. The scene will now load in

Patchwork3D (see Figure 3). 
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Figure 2: Loading a scene

Figure 3: Loaded scene

STEP 3: Double-Click on your scene in the ‘Product’ panel to make it visible in the Patchwork3D

Matter viewport (see Figure 4). 
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Figure 4: Active scene in Patchwork3D viewport

STEP 4: Adjust your camera view using the ‘Orbit’ tool from the top toolbar (see Figure 5) or activate

it by hitting C on your keyboard. 

Figure 5: Scene with an adjusted camera view

STEP 5: On the right of the Patchwork3d interface, click on the ‘Internal Libraries’ icon to open the

‘Internal Libraries’ tab (see Figure 6).
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Figure 6: Internal Libraries tab opened  

STEP 6: Inside the ‘Internal Libraries’ click on the ‘Environment Library’ icon to access HDR Light

Studio connection (see Figure 7). Alternatively, hit 4 on the keyboard. 

Figure 7: Accessing HDR Light Studio connection through the Environment Library

You may not have an environment set up for your scene yet. In this case, your Environment Library

will be empty (see Figure 8). Either way, we will create a new environment to start lighting our scene

with HDR Light Studio. 
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Figure 8: Empty

Environment

Library

STEP 7: Create a new environment to light with HDR Light Studio by clicking on the ‘Create

Environment with HDR Light Studio Live’ icon at the bottom of the ‘Environments’ section in the

‘Environment Library’ (see Figure 9). 

Figure 9: Creating a new environment and starting HDR Light Studio connection 

A new environment called ‘HDRLS Environment’ by default is created (see Figure 10) and HDR Light

Studio connection will launch (see Figure 11).



1151

1151Connections (Plug-Ins)

 Figure 10: HDR Light Studio environment is created

Figure 11: HDR Light Studio on startup

STEP 8: Place the HDR Light Studio interface onto your second display, if you have one (see Figure

12). Otherwise, you will need to rearrange the HDR Light Studio interface to see both HDR Light

Studio and VRED on the same display, which is not ideal and can get crowded.
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Figure 12: Patchwork3D (left) running with HDR Light Studio connection (right) 

Notice how the scene is not lit by the environment we have just created with HDR Light Studio, i.e.

‘HDRLS Environment’ (see Figure 12). This is because the environment is not yet assigned to the

scene. 

STEP 9: Drag and drop the ‘HDRLS Environment’ onto the scene (see Figure 13). This assigns the

environment to the scene. As a result, the scene will now be lit by ‘HDRLS Environment’ (see Figure

14).

Figure 13: Assigning HDRLS Environment to the scene

Figure 14: Environment created with HDR Light Studio assigned to the scene
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2. Painting Lights on HDRI Map using LightPaint

STEP 1: In HDR Light Studio add a ‘Rect Light’ from the toolbar on the left (see Figure 15). Then in

Patchwork, from the toolbar at the top, click on the ‘HDR Light Studio LightPaint Reflection’ icon.

You can now Left-Click to position your light on your model. In this example, we have left-clicked on

the car’s hood/bonnet (see Figure 16). 

Figure 15:  Selecting a Rect Light from the toolbar on the left in HDR Light Studio 

Figure 16: Rect Light painted on the car model 

The selected light has moved to a position on the HDRI map that will 'reflect' in the 3D model where

clicked. This is because the LightPaint mode in Patchwork3D is set to 'Reflection'. 

STEP 2: Create another ‘Rect Light’ in HDR Light Studio, just like in STEP 1. In the ‘Light Properties’

panel, the brightness of the light has been changed to 800 so that its effect on the scene will be more

visible. In Patchwork3D, from the toolbar at the top, change LightPaint mode from Reflection to

Illumination by clicking on the ‘HDR Light Studio LightPaint Illumination’ icon. You can Left-Click

on the model to paint the light using Illumination mode. In this example, we have Left-Clicked on the

driver’s rear alloy wheel (see Figure 17). 
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Figure 17: Rect Light painted on the model using illumination mode 

The selected light has moved to a position on the HDRI map that will 'illuminate' in the 3D model

where clicked. This is because the LightPaint mode in Patchwork3D is set to 'Illumination'. 

STEP 3: In Patchwork3D you can click on the ‘Raytrace Active Viewport’ icon in the left toolbar to

see a more accurate preview of your lighting (see Figure 18). This may take a while to complete. Paint

more lights until you are happy with the lighting design (see Figure 19).

Figure 18: The scene after being raytraced

Figure 19: Lighting design made in HDR Light Studio
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3. Producing the Final HDR Content

HDR Light Studio can render higher resolution, high quality sub-sampled HDR images on disk for

Patchwork3D to use instead of the proxy content used during the lighting design process.

STEP 1: In Patchwork3D, click on ‘HDR Live HQ’ button (see Figure 20). This opens the 'Production

Render' panel in HDR Light Studio.

Figure 20: Render button for the HDR Light Studio connection

STEP 2: In HDR Light Studio Ensure the ‘Orientation’ for the map is set to

'Patchwork3D/Patchwork3D' (see Figure 21)

Figure 21: Setting the map orientation to match with Pathwork3D 

STEP 3: Adjust the rest of the settings according to your needs. Set the Resolutions for the HDRI map.

Choose a file name and location for the HDRI content using the 'Browse' button. Click ‘Render’ and

HDR Light Studio will calculate the final content, save it on the disk and automatically update

Patchwork3D to use that content (see Figure 22).
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Figure 22: Rendering the final HDRI map file

STEP 4: HDR Light Studio projects can be saved from the HDR Light Studio interface (CTRL + S or

Project > Save Project, see Figure 23) at any time during the lighting process as a HDi file (native

HDR Light Studio project file), even when using HDR Light Studio via a connection. If you were to

open HDR Light Studio in a connection with Patchwork3D, this project can be loaded into HDR Light

Studio using Project > Open Project. The lighting design would load into HDR Light Studio replacing

its current design, and would then be synced back into Patchwork3D. This is how you can move

lighting between Patchwork3D projects or between other supported 3D software. 

Figure 23: Saving

HDR Light Studio

project

STEP 5: Close HDR Light Studio connection from the HDR Light Studio interface, Project > Exit (see

Figure 24). If any further changes are now made to the lighting in HDR Light Studio, all content will be

updated to use the updated proxy versions again. So, please ensure you ‘stop’ the HDR Light Studio

connection after you have produced your production lighting.
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Figure 24:

Stopping the

HDR Light Studio

connection

Editing Existing HDRI Maps

Figure 1 shows a car scene, lit by a HDRI map that was loaded in Patchwork3D.

Figure 1: Car scene lit by an existing HDRI map

You can edit existing HDRI maps using HDR Light Studio in conjunction with Patchwork3D to

enhance the lighting in your scene.

Ensure you already have a scene loaded and a new HDR Light Studio environment created with HDR

Light Studio running. To learn how, please see Workflow Tutorial before you begin.

STEP 1: Once your HDR Light Studio connection with Patchwork3D starts, delete the ‘Default
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Gradient Background’ by selecting the light in the 'Light List', Right-Clicking on it and selecting

‘Delete’ (Figure 2).

Figure 2: Deleting the default gradient background in HDR Light Studio

STEP 2: Add a picture background light in HDR Light Studio by clicking on the ‘Picture Background’

icon from the toolbar on the left (Figure 3). The light will appear in the 'Light List' (Figure 4).

Figure 4: Picture background button

Figure 4: Picture background is created
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STEP 3: While the ‘Picture Background’ light is selected, in the ‘Light Properties’ under the ‘Content’

section, click on the ‘Load’ icon next to the ‘Image’ field to load a HDRI map of your choice (Figure 5)

Figure 5: Loading a HDRI map image

STEP 4: Find your HDRI Map, select it and click ‘Open’ (Figure 6). If asked, convert the file into a mip-

mapped and tiled image for better performance.

Figure 6: Choosing the HDRI map to load

STEP 5: By default, the HDRI map’s rotation does not match with VRED (compare Figure 1 and 7). To

prevent this, in HDR Light Studio in the ‘Light Properties’ panel, under the ‘Transform (Core)’

section, change the ‘Longitude’ to 0 (Figure 8).
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Figure 8: By default, the HDRI map's rotation in HDR Light Studio is not matching the rotation in Patchwork3D

Figure 8:  Changing the Longitude from 180 to 0 adjusts the roation of the HDRI map for it to match with

Patchwork3D

STEP 6: You can now start editing the existing HDRI map (Figure 9)

Figure 9: Edited HDRI map
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Rhino Connection

HDR Light Studio supports:

Rhino 6, 7

Rhino 5
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Rhino 6,7

Currently compatible with Rhino 6, 7 using:

Cycles

V-Ray (version 3.60.03 or higher)

Octane (version 4_00_0_103 or higher)

and other renderers able to use the native Rhino environments

· Installation

· General Workflow

· Video Demonstrations

· Error Messages

· Release Notes
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Installation

To add support in Rhino for a connection to HDR Light Studio, we have implemented a new HDR

Light Studio Environment texture type that is added to Rhino.

Installing on Windows

Uninstalling
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Installing on Windows

1. Uninstall any old plug-ins. See Uninstalling.

2. Download the HDR Light Studio Connection for Rhino from our web site.

3. Unzip the file. Here's the structure:

Rhino\2015.1028\5\HDRLightStudioTexture.rhp

4. Put the HDRLightStudioTexture.rhp file in a folder on your computer where you wish it to be

permanently located. Once the plug-in has been installed in the following step, it will reference

the file in its current location.

5. Drag and drop the .rhp file onto a running session of Rhino 5. The HDR Light Studio Environment

type will be installed.

6. That's it! You should now be able to create a HDR Light Studio Environment type in Rhino.

You should now proceed to Licensing. For information on using the connection see Rhino

connection.
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Uninstalling

To uninstall the HDR Light Studio connection from Rhino, go to Tools > Options in the Rhino menu.

Go to the Plug-ins section and find the HDRLightStudio Texture entry in the list, and uncheck the

tick box.

You will be told the plug-in is already loaded and to restart Rhino for this change to take effect.

Press OK on the Rhino Options panel.

Close Rhino
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Delete the HDRLightStudio Texture.rhp file from it's location. This plug-in has now been uninstalled

from Rhino.
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Connection_Workflow

HDR Light Studio let's you create a custom HDRI map to light your render in Rhino.

HDR Light Studio connects with Rhino, so as lights are added and moved in HDR Light Studio's HDRI

map, you can see the lighting change in real-time in your rendering software in Rhino. Welcome to

interactive lighting using HDRI maps!

HDR Light Studio's connectivity with Rhino works via Rhino's Environments. Once the HDR Light

Studio plug-in has been installed in Rhino, you can Add an additional Environment type called 'HDR

Light Studio Environment', in the Environments panel. This environment type is used to store HDR

Light Studio's lighting project, a temporary low res HDRI map, and contains buttons  to start and stop

HDR Light Studio.

For Rhino 6 we have simplified the connection experience and added some exciting new features too.

The updated HDR Light Studio Environment has just 2 buttons - Start and Stop. You can now do

more from within HDR Light Studio, we will come to that soon.
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OK, let's Light a Shot

Prior to starting your lighting, please turn off Autosave in Rhino.

Currently Rhino files take significantly longer to save when they contain a HDR Light Studio

Environment. We are working to solve this issue in a future build.

In this example we are using V-Ray for Rhino 3.6, but the process is similar for any renderer that

supports Rhino Environments.
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Open the Environments panel using the menu Render > Environment Editor

The Environments panel opens.

By default with a new scene in Rhino 6, you are given the option to set the background mode to

Environment. Select this option if you would like to see the HDRI environment map in the

background of your render.

You will also see a default studio lighting environment already listed and active.
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So here is the scene we are going to light. It already has the V-Ray materials applied. But no lighting

has been created yet. We have docked the Environment panel on the right side of the Rhino

interface.
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Please note, the following steps are V-Ray for Rhino specific, please skip to the next section if you

are using another renderer.

Create a Rhino Dome Light (using menu or tool bar)

You may need to click in a Rhino view to create the Dome Light. If you are then prompted to choose

an image for the dome light, you can cancel this, you do not need an image on the dome light. This

will come from the Rhino environment.
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Now select the Dome light created and view its Properties, switching to the light properties section.

Enable the Sync. Env check box. This setting tells the V-Ray dome light to use Rhino's environment.

Now return to the Environments panel.

We are now going to add a HDR Light Studio Environment.

Click the + button and select HDR Light Studio Environment from the list

 

Double click on the new HDR Light Studio Environment in the environment list to make it 'active'. You

can see it is active because its highlighted and has triangles in each corner.
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Before we start HDR Light Studio, let's start interactive rendering in the viewport, in this example V-

Ray Interactive.

At this point there we have not created any lighting, so the view will be black.

We are now ready to press the Start button on the HDR Light Studio Environment, this will open

HDR Light Studio in a live connection with the HDR Light Studio Environment.
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The HDR Light Studio interface opens. There is a big play button on the Render View with a Rhino

logo above.
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Press the Play button and you will then see the Rhino viewport inside the HDR Light Studio. You are

now able to fully concentrate on lighting the shot within HDR Light Studio.
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The rendered image will look washed out, too bright. This is because we need to change a setting in

the Render View. Use the dropdown to change the view LUT from sRGB to None. This will ensure the

image looks the same in HDR Light Studio as it does in Rhino.

You are now ready to light the shot.

You can drag and drop lights from the presets panel onto the Render View, and they will be added to

the HDRI map, they will be positioned to reflect where they are dropped on the 3D model.

You can reposition an active light by clicking on the model in the Render View, or moving it on the

Canvas.

You can make new lights using the tool bar buttons, and move them by clicking on the Render View

and Canvas too.

In this example below we are now happy with the lighting design. So we now need to complete the

lighting process, close HDR Light Studio and return to Rhino.
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Every time a lighting change was made in HDR Light Studio, 2 things happen in Rhino.

1. Updated lo res HDRI data was sent to Rhino and stored against the HDR Light Studio Environment

- this is why the renderer kept updating to use the new lighting.

2. The HDR Light Studio project file was stored against the HDR Light Studio Environment - this

means next time you open this Rhino file, you can open HDR Light Studio and edit the lighting.

To complete the lighting process we need to output the HDRI map at a higher quality and higher

resolution. We use only a low resolution for the live HDRI maps to make them update as fast as

possible when using interactive rendering.

Press the HDR button on the tool bar

The Production Render panel will open. There are only a few settings that we need to concern our

selves with.
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Map Settings

Resolution - Use the drop-down to choose the resolution you want for the final HDRI map file.

Format - Choose from EXR or HDR file formats

Output

Use the Browse button to chose a location and give the file a name.

Then press the Render button to generate the final HDRI map file on disc.

Once the HDRI map has been generated you can now close HDR Light Studio.

When returning to Rhino you will notice there is now an additional environment called HDR Light

Studio Environment (Render)



1179

1179Connections (Plug-Ins)

The low resolution HDRI map and HDR Light Studio project is still stored on the original HDR Light

Studio Environment which is still active.

The HDR Light Studio Environment (Render) environment is a Basic Environment created using the

new high resolution HDRI map file. Switch to using this environment to take advantage of the higher

quality HDRI map.
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You are now ready to produce your final render in Rhino using the high quality lighting created in

HDR Light Studio.

If you want to edit the lighting, simply choose the HDR Light Studio Environment and press the start

button again. HDR Light Studio will start and the stored lighting project will be loaded.
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Video Demonstrations

Workflow Demo with V-Ray

https://vimeo.com/307665641

Workflow Demo with Octane

https://vimeo.com/307680082

Workflow Demo with Cycles

https://vimeo.com/307665641
https://vimeo.com/307680082
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https://vimeo.com/307665391

https://vimeo.com/307665391
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Error Messages

Rhino 6 can give the following errors in our connection panel:

Failed to initialise HDR Light Studio

Will be shown if the initialisation call to HDR Light Studio fails.

This is most likely due to unsupported version mismatches. i.e. the Rhino connection and version of

HDR Light Studio are not compatible.

To check which versions to use together - see our PDF compatability chart here.

Cannot locate HDR Light Studio installation directory

Will be shown if connection cannot find the HDR Light Studio environment variable or the dll.

A reinstall of the main HDR Light Studio application is needed (and a restart of the computer to be

sure).

https://s3-eu-west-1.amazonaws.com/lightmap/docs/CompatibilityChart.pdf
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Release Notes

Release Notes

Build 2023.1218

Updated to be compatible with HDR Light Studio 8.2

Build 2023.0417

Fixed a bug with V-Ray not showing in the HDR Light Studio interface.

Performance improvements.

Rhino 7 support added 6th April 2021

Build 2018.1130

We currently advise when using HDR Light Studio to have autosave turned off.

The HDRI map data stored against the HDR Light Studio Environment makes your Rhino files take

longer to save. We are working at speeding this up. The data is not large, it is due to some processing

it needs in order to be saved.
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Rhino 5

This is currently compatible with Rhino V5 using: V-Ray for Rhino 2, V-Ray for Rhino 3, Rhino

Render, Brazil, Neon, Octane.

Please note: V-Ray for Rhino 2 is not dependent on installing the Lightmap ‘Rhino Connection’. It

includes its own code to talk with HDR Light Studio.

But it will still require a Rhino Connection license from Lightmap in order to connect with Rhino.

· Installation

· General Workflow

· Notes for Octane for Rhino

· V-Ray for Rhino version 2 Workflow

· V-Ray for Rhino version 3.6 Workflow

· Release Notes
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Installation

To add support in Rhino for a connection to HDR Light Studio, we have implemented a new HDR

Light Studio Environment texture type that is added to Rhino.

This is currently compatible with Rhino V5 using: V-Ray for Rhino 3, Rhino Render, Brazil, Neon and

Octane for Rhino.

Please note: V-Ray for Rhino 2 has its own independent direct connection to HDR Light Studio, and

is not dependent on installing the Lightmap provided ‘Rhino Connection’. But will still require

purchasing a license for the Rhino connection.

Installing on Windows

Uninstalling
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Installing on Windows

1. Uninstall any old plug-ins. See Uninstalling.

2. Download the HDR Light Studio Connection for Rhino from our web site.

3. Unzip the file. Here's the structure:

Rhino\2015.1028\5\HDRLightStudioTexture.rhp

4. Put the HDRLightStudioTexture.rhp file in a folder on your computer where you wish it to be

permanently located. Once the plug-in has been installed in the following step, it will reference

the file in its current location.

5. Drag and drop the .rhp file onto a running session of Rhino 5. The HDR Light Studio Environment

type will be installed.

6. That's it! You should now be able to create a HDR Light Studio Environment type in Rhino.

You should now proceed to Licensing. For information on using the connection see Rhino

connection.
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Uninstalling

To uninstall the HDR Light Studio connection from Rhino, go to Tools > Options in the Rhino menu.

Go to the Plug-ins section and find the HDRLightStudio Texture entry in the list, and uncheck the

tick box.

You will be told the plug-in is already loaded and to restart Rhino for this change to take effect.

Press OK on the Rhino Options panel.

Close Rhino
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Delete the HDRLightStudio Texture.rhp file from it's location. This plug-in has now been uninstalled

from Rhino.
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General Workflow

Open the Rhino scene that you want to light using HDR Light Studio.

Go to, or open, the Environment Editor Panel.

Press the + button to add a new environment to your Rhino scene.

The Open Window appears differently depending on which renderer is active. In this case it’s the

Rhino Renderer and looks like this.

Press the ‘More Types…’ button
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Select HDR Light Studio Environment from the list and press OK

A HDR Light Studio Environment 001 has been added to the Environments Editor Panel, and is active.

When a HDR Light Studio environment is active, below it you can see the controls for the HDR Light

Studio connection.

Press ‘Show Light Studio’ to start HDR Light Studio. HDR Light Studio is now opened and connected

to this environment texture in Rhino. You may want to place the HDR Light Studio interface on a

second monitor, or adjust its size so you can also see Rhino.

As you create lighting in HDR Light Studio, the HDRI map is shared with Rhino and updates with each

change. Welcome to HDRI lighting in Rhino!
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By default HDR Light Studio displays a rendered view with a default Kettle model, but this view can

be closed when using Rhino, as you will make your lighting decisions in the Rhino viewport.

LightPaint

To quickly and easily position a light on your 3D model in Rhino, create a new light in HDR Light

Studio and then press the LightPaint button in Rhino. Now click on your 3D model in the Rhino

viewport (ensure the view is shaded), and the light will move in HDR Light Studio to reflect in that

location on your model. The LightPaint mode can be changed to alternatively ‘illuminate’ or ‘rim light’

the location selected. To drop the LightPaint tool in Rhino press the ‘Escape’ button on the keyboard.

If you were to save your Rhino scene now, it would have the HDR Light Studio project embedded and

also the lo-res HDRI map shared from HDR Light Studio. To render a higher quality, high resolution

version of the HDRI map, press the ‘Render’ button in the HDR Light Studio controls in Rhino.

Once this has been pressed, click on the HDR Light Studio app and you will see the ‘Production

Render’ Window. Choose a resolution for your HDRI map and press Render. A high resolution HDRI

map will be generated and shared with Rhino. If you saved your Rhino project now, it would have

this high quality HDRI map embedded in your scene file.
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If you wanted to render your HDRI lighting design to a HDRI map file on disc, so that another user

without HDR Light Studio could open this Rhino project, press the Bake button in the HDR Light

Studio controls in Rhino.

Click on the HDR Light Studio app and in the Production Render window, select a file location and

give the file a name, using the Browse button, and then Press Render.
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You will now see that a second environment appears in the list, this is a generic rhino environment

with the HDRI map on disc as its texture.
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The Rhino scene can contain as many HDR Light Studio Environments as you like, so you are free to try out

lots of different lighting designs for your 3D renders, or create different lighting designs for different camera

angles.
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Notes for Octane for Rhino

Open the OctaneRender Settings panel.

Set the Environment to use a Texture Environment and choose an RGB image, and select a temp

image to use. It is not important what image is used, it will be replaced by the Rhino Environment

shortly.

Ensure the Gamma for the Environment is set to 1 (not the default 2.2)

Now Right click anywhere on the Settings panel and select/enable Sync Octane Enviro to Rhino

Enviro

Now Octane Render will be using the Rhino Environment for lighting, and if this is a HDR Light Studio

Environment, it will pick up the live changes made when using HDR Light Studio.

Now you can light your shot in real time with HDR Light Studio and Octane Render.
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V-Ray for Rhino 2 Workflow

V-Ray 2.0 for Rhino can create a direct connection with HDR Light Studio without the need to use

Lightmap's HDR Light Studio environment texture.

HDR Light Studio enables the real-time creation and editing of a HDRI map for lighting your scene.

This provides a much easier and faster approach to lighting your V-Ray shots, that will render fast

too.

Workflow

Create a V-Ray Dome light in your scene

The HDR Light Studio Live controls are found on the Dome Light's 'Properties' tab, under the 'Light'

section. Scroll to the bottom of the properties panel to see the HDR Light Studio Live section (that is

displayed if HDR Light Studio is installed on your computer).

Let's turn on V-Ray RT in the view port for our scene - so we can see the dome lighting interacting

with our scene and materials with real-time feedback.



1198

1198Connections (Plug-Ins)

Now we can see the scene lit with the dome light.

Now let's light this shot using HDR Light Studio. Find the HDR Light Studio Live controls and press

the Show button to start HDR Light Studio in a live connection with this Dome Light.



1199

1199Connections (Plug-Ins)

The HDR Light Studio app is opened and the content of the HDR canvas in HDR Light Studio is now

being used to light your V-Ray RT render. Every time a change to the lighting is made in HDR Light

Studio - the V-Ray RT view will update using the new HDR lighting.

HDR Light Studio is providing V-Ray RT with small temporary HDR files that are used during the lighting

design process. These are updated automatically though the live connection.

When HDR Light Studio opens, you will see that the interface includes its own Render View with a

loaded default 'teapot' model. When using HDR Light Studio with V-Ray for Rhino, it is not necessary

to see use this Render View at all, and it can be closed. Also, if you are not using HDR Light Studio on

a second display, it is worth adjusting the layout of the HDR Light Studio interface so it fits more

comfortably onto your display with Rhino. You can save your interface layout when you are happy

with it to use next time.

Here is a nice example of a more compact interface layout to use with V-Ray for Rhino.
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Lets add a new light source to the HDR canvas in HDR Light Studio, press the Round light button on

the top bar. A light is created in the center of the canvas. You can see V-Ray RT update using the new

lighting (the light in the background may look pixelated because this is using the lo-res temp file at

the moment, at the end of the process we will render a hi-res, high quality HDR file on disc).
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So we now have a light on the HDRI map... but how do we position it in the right place to get the

desired lighting effect on our model? The answer is the LightPaint feature. Let's activate the Light

Paint check box so we can click directly onto the V-Ray RT view to position the active light in HDR

Light Studio. (You can also click on the Rhino views without using the V-Ray RT renderer, but it is far

more effective to click on the render and see the lighting update before your eyes)

Now with the light active in HDR Light Studio, left click on your 3D model in the V-Ray RT view.

Because LightPaint is in Reflection mode, the active light has moved on the HDRI map so that it

'reflects' in the region of your 3D model that was 'Clicked' on. This point and click lighting technique

is a very fast and precise way to light your shots.

Use the drop down to select Rim mode, this places the light directly on the visible HDRI map in the

background of your image and is useful for creating a background effect or rim lights to reflect in the

glancing edges of your models.
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Use the drop down to select Illumination mode, to position a light to illuminate the region clicked,

this works best for matt surfaces without reflections.

Lights can even be selected in HDR Light Studio using the LightPaint modes in Rhino using the Shift

key when clicking on the model. For example, ‘Shift Click’ on a highlight using Reflection mode to

select the light reflecting in that location. This is a great way to pick lights when editing your design

without the need to remember the light names or locations on the HDRI map.

When another tool is selected in Rhino, then the Light Paint mode is deactivated until you turn it

back on.

Create more lights and adjust their properties until you are happy with the lighting design. When you

are happy with the lighting design, Press the Render / Close button to render a hi-res HDR file on disc

and to close your HDR Light Studio session. This is what you do at the end of your lighting session.

The HDR Light Studio Production Render dialog will open where you can set a resolution for the HDRI

map, and then browse to a location on disc and name your hdr or exr file. Once you press the Render

button on this panel, the file on disc will be generated and V-Ray for Rhino will use that file for the

dome light texture. HDR Light Studio will also close after the file has been completed.
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So now you have a scene lit with a custom HDRI file on disc and you are ready to produce your final

V-Ray production rendering. This Rhino scene can be opened by other users without HDR Light

Studio, as it is lit by a standard HDRI file on disc and is therefore totally compatible.

The HDR Light Studio lighting project is actually embedded with your V-Ray Dome Light in Rhino. So

save your Rhino scene to store the lighting design, then next time you open the scene launch HDR

Light Studio from the dome light and the lighting will automatically be loaded in the state it was left

when the Rhino file was saved.

Top Tips

Multiple V-Ray Dome Lights can be created in your Rhino scene and assigned to different layers. This

way you can store many different lighting designs in the same Rhino scene. This is useful for creating

different lighting for alternative camera views.

Use the Project menu in HDR Light Studio to save and load HDR Light Studio lighting projects

independently of your Rhino scenes. You can move your favorite lighting setups between projects

this way, or to create an archive of useful lighting rigs for future. projects. Once lighting is loading

into HDR Light Studio this way, the current lighting shown in HDR Light Studio is what gets saved and

embedded within your Rhino scene.
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V-Ray for Rhino 3.6 Workflow

HDR Light Studio enables the real-time creation and editing of a HDRI map for lighting your scene.

This provides a much easier and faster approach to lighting your V-Ray shots, that will render fast

too.

Workflow

Create a V-Ray Dome Light in your scene

With the Dome Light selected, ensure the Sync Env. check box is active, this means that V-Ray will

use the active Rhino environment image on this dome light.

Go to, or open, the Environment Editor Panel.
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Press the + button to add a new environment to your Rhino scene.

Select HDR Light Studio Environment from the list and press OK

A HDR Light Studio Environment 001 has been added to the Environments Editor Panel, and is active

(if not double click the new environment to make it active, with yellow corners).

When a HDR Light Studio environment is active, below it you can see the controls for the HDR Light

Studio connection.

Press ‘Show Light Studio’ to start HDR Light Studio. HDR Light Studio is now opened and connected

to this environment texture in Rhino. You may want to place the HDR Light Studio interface on a

second monitor, or adjust its size so you can also see Rhino.
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As you create lighting in HDR Light Studio, the HDRI map is shared with Rhino and updates with each

change. You can enable V-Ray Interactive Rendering to see the lighting update as you work in HDR

Light Studio.

By default HDR Light Studio displays a rendered view with a default Kettle model, but this view can

be closed when using Rhino, as you will make your lighting decisions in the Rhino viewport.

LightPaint

To quickly and easily position a light on your 3D model in Rhino, create a new light in HDR Light

Studio and then press the LightPaint button in Rhino. Now click on your 3D model in the Rhino

viewport (ensure the view is shaded), and the light will move in HDR Light Studio to reflect in that

location on your model. The LightPaint mode can be changed to alternatively ‘illuminate’ or ‘rim light’

the location selected. To drop the LightPaint tool in Rhino press the ‘Escape’ button on the keyboard.



1207

1207Connections (Plug-Ins)

If you were to save your Rhino scene now, it would have the HDR Light Studio project embedded and

also the lo-res HDRI map shared from HDR Light Studio. To render a higher quality, high resolution

version of the HDRI map, press the ‘Render’ button in the HDR Light Studio controls in Rhino.

Once this has been pressed, click on the HDR Light Studio app and you will see the ‘Production

Render’ Window. Choose a resolution for your HDRI map and press Render. A high resolution HDRI

map will be generated and shared with Rhino. If you saved your Rhino project now, it would have

this high quality HDRI map embedded in your scene file.

If you wanted to render your HDRI lighting design to a HDRI map file on disc, so that another user

without HDR Light Studio could open this Rhino project, press the Bake button in the HDR Light

Studio controls in Rhino.
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Click on the HDR Light Studio app and in the Production Render window, select a file location and

give the file a name, using the Browse button, and then Press Render.

You will now see that a second environment appears in the list, this is a generic rhino environment

with the HDRI map on disc as its texture.
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The Rhino scene can contain as many HDR Light Studio Environments as you like, so you are free to try out

lots of different lighting designs for your 3D renders, or create different lighting designs for different camera

angles.
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Release Notes

Release Notes

Build 2018.0206

Compatibility update with newer HDR Light Studio version

Build 2015.1123

Updated for compatibility with HDR Light Studio 5.3

Fixed bug where HDRLS can not be stopped when it's hidden.

Bug 1154 - Dragging Lat / Long Sliders in HDRLS, slow HDRI map updates has been fixed.

Bug 1232 - Fixed issue when starting HDRLS with an embedded project, the initial lighting didn't

match until a change was made.

Build 2015.1103

New Rhino V5 connection with support for: Rhino Render, Brazil, Neon and Octane for Rhino.

V-Ray for Rhino has been updated to connect with HDR Light Studio 5 too.

Known Issues

None reported
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SOLIDWORKS Visualize

HDR Light Studio is designed to generate a high resolution, high dynamic range image used for

image based lighting. As you shape the lighting, the SOLIDWORKS Visualize connection seamlessly

pulls HDR Light Studio's environment map back into Visualize without having to import/export via

the file system.

· Installation

· Connection Interface

· Create New Environment

· Enhance Existing Environment

· Release Notes
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Installation

The latest SOLIDWORKS Visualize products have a built in connection to HDR Light Studio, and

automatically detect HDR Light Studio software.

There is no need for the additional installation of a plug-in, simply install and license the HDR Light

Studio main app.
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Interface

Start - Launches and un-pauses/un-hides HDR Light Studio

Pause - Pauses/Hides HDR Light Studio

Stop - Stops HDR Light Studio software

LightPaint Modes

Reflection - Positions active HDR Light Studio light to reflect in the model location clicked in

SOLIDWORKS Visualize

Illumination - Positions active HDR Light Studio light to illuminate the model location clicked in

SOLIDWORKS Visualize (normal to the model)

Environment - Positions active HDR Light Studio light on the HDRI map location clicked in the

background view (use this for rim lighting effect, to place light behind your model)

Left Click in the Visualize view to Position active light using the LightPaint mode

Right Click in the Visualize view to select lights using the LightPaint mode
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Create New Environment

To understand the range of features available in the HDR Light Studio main app, see the HDR Light

Studio Reference Pages

Here we will concentrate on looking at the workflow of using HDR Light Studio live with SOLIDWORKS

Visualize.

With the Scenes tab active, right click in the Environments area and select 'New HDR Light Studio',

or click the 'New HDR Light Studio' button if this is showing in the settings area.

Please Note: The SOLIDWORKS Visualize project can contain more than one HDR Light Studio environment

— so many lighting designs can be developed. HDR Light Studio environments can even be copied and

pasted.

A new blank HDR Light Studio environment (default name HDR Light Studio, this can be changed) is

created and HDR Light Studio is launched in a live connection.

It works best to place the HDR Light Studio app on your second display if you have one. (shown

below outlined in red on the right).
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HDR Light Studio's Render View panel (the Kettle view) is not required in this workflow, so can be

closed using the cross top right of the panel.

You are now ready to start creating your lighting.

Create a light in HDR Light Studio by dragging one of the Preset lights onto the canvas.. The light will

be added to the HDR Canvas.

Visualize will immediately updates, so you can see the lights effect on your 3D model - but the light is

not in the right location yet.
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Next we need to position the light source. By default the LightPaint mode is set to Reflection - this is

the most useful LightPaint mode as most of the time you will be placing lights to reflect in your

model.

Simply click on the 3D model in the Visualize view to position your active light in HDR Light Studio to

reflect in that position (the active light is highlighted in the Light List in HDR Light Studio).

Continue to create new lights, position them with LightPaint and adjust their properties until you get

a lighting look you are happy with.

Lights can also be selected by right clicking on the 3D model. This can be very useful to find lights you

would like to adjust once the lighting design gets more complex — especially if you are not renaming your

lights to indicate their lighting purpose.

The live HDR canvas is only low resolution, this makes it fast and responsive whilst you are designing

your lighting. If you place lights with defined hard edges you will see they look jagged in Visualize,

don't worry — the final step is to render a high resolution and high quality final HDRI map on disc to

light your final Visualize render.

To do this simply press the HDR Render button in HDR Light Studio.
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The Production Render window will be shown.

In the Map Settings section, select the Resolution you want for the HDRI map.

Press the Browse button and choose a file name and location for your HDRI map.

Press Render to make the HDRI map.

Your scene will automatically update to use this file on disc for the lighting. But if any changes are

made to the design in HDR Light Studio, the scene will revert to using the lo-res live data.

So here's the final shot lit with the new HDR file we generated:



1218

1218Connections (Plug-Ins)

To close HDR Light Studio press the Stop button or to hide HDR Light Studio press the Pause button.

Press Start to both launch or un-pause HDR Light Studio.
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Enhance Existing Environment

Please Note: This feature does not work when using HDR Light Studio in unlicensed demo

mode.

Select an existing Environment and Press the 'Edit with HDR Light Studio' button in the HDR Light

Studio section of the Environment settings.

HDR Light Studio launches and loads the environment's HDR or EXR file into the background in HDR

Light Studio. You will notice a reduction in image quality because the live HDR canvas is lo-res to

keep updates fast in both HDR Light Studio and Visualize. But the quality is good enough for

interactive lighting design.

In the Light Properties for the Background Image, you will need to turn off the Flip check box which is

on by default in HDR Light Studio. This ensures the image has the same orientation as SolidWorks

Visualize.
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Now we can add add some lights and position them using LightPaint, like we learned in the previous

section.
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Once you are happy with the lighting look, render a hi-res file to disc and Visualize will use this

instead of the lo-res canvas data. You have edited your existing environment.
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Release Notes

Release Notes

HDR Light Studio - Xenon Drop 4 fixes an issue with LightPaint positions being incorrect

There is a crash bug when using HDR Light Studio 5.4 and earlier with SOLIDWORKS Visualize 2017

This bug has been fixed in HDR Light Studio 5.4.1

HDR Light Studio is compatible with SOLIDWORKS Visualize 2016 SP1 and above

Known Issues

Issues when using HDR Light Studio in demo mode (without a license)

Edit with HDR Light Studio does not work correctly in unlicensed mode - please test HDR Light Studio

with SolidWorks Visualize using New HDR Light Studio method only.

To avoid these issues. Try HDR Light Studio for 15 days with a full license.

If you edit an existing Environment in SolidWorks Visualize it will be flipped when it is loaded by HDR

Light Studio and used in SolidWorks Visualize. As a work around just untick the flip option in HDR

Light Studio against the image node.
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VRED Connection

HDR Light Studio is designed to generate a high resolution, high dynamic range image used for

image based lighting.

As you shape the lighting, the VRED connection seamlessly pulls HDR Light Studio's environment

map back into VRED without having to import/export via the file system.

· Installation

· Interface Overview

· Workflow Tutorial

· Editing Existing HDRI Maps

· Area Light Distance in detail

· Missing Area Light Reflections

· Multiple Environments in VRED

· Release Notes and Known Issues
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Installation

Installation

Simply install the HDR Light Studio main application and ensure that HDR Light Studio is licensed.

The connectivity to HDR Light Studio is already included within VRED.

You are now ready to use HDR Light Studio with VRED!

Next steps: Connection Interface Overview or follow the Workflow Tutorial

Please Note: If you are running VRED 2016 or older, you will need to edit a Windows Environment

Variable so VRED can find HDR Light Studio.

Older versions of VRED are hard coded to look for HDR Light Studio 4, and will not see the new

installation of HDR Light Studio.

Therefore, we need to make a simple change to a Windows OS Setting that will tell VRED to start HDR

Light Studio instead.

Open the Control Panel in Windows OS
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Select System and Security

Select System

Select Advanced system settings

(You will need administrator privileges on your user account to do this, if you are unable to complete this
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step please ask your IT admin to help you)

Click the Environment Variables… button
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Scroll down the System variables list until you can see the HDRLS_HOME_V5 entry.

Click on the HDRLS_HOME_V5 entry in the list and press the Edit… button

(Important: If you already have a HDRLS_HOME_V4 entry in the list too, please consult the last page of this

document before continuing)

We are now going to copy the Variable value from HDRLS_HOME_V5

We will later paste this path into a HDRLS_HOME_V4 variable
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The whole path will look something like this:

C:\Program Files\Lightmap\HDR Light Studio

Select all of the Variable value contents and copy this path by pressing CTRL + C and then press OK

to close this window.

If you already have HDR Light Studio 4 installed, Click on the HDRLS_HOME_V4 entry in the list and

press the Edit… button.

The current value will be something like this:

C:\Program Files\Lightmap\HDR Light Studio v4.0
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If you do not have a HDRLS_HOME_V4 entry in the list, Press the New… button under the System

variables list, and type: HDRLS_HOME_V4 into the Variable name field.

(Please note, this field is case sensitive and needs to exactly match)

Now we will replace or enter the Variable value by selecting all (CTRL + A) and pasting (CTRL + V) into

the Variable value field

It should then look something like this, you will have a HDRLS_HOME_V4 variable pointing to the

location of HDR Light Studio (C:\Program Files\Lightmap\HDR Light Studio)

Press OK to close the Edit System Variable window
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Press OK to close the Environment Variables window

Press OK to close the System Properties Window
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Connection Interface Overview

The controls for the connection with HDR Light Studio are found in the Materials Editor panel when

an Environment is selected.

They appear in a section called: HDR Light Studio
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Workflow Tutorial

HDR Light Studio is a standalone lighting application, providing a set of tools and content dedicated

to lighting 3D scenes. Using HDR Light Studio connected to VRED, provides the ability to create

custom HDRI maps to light your scenes, with lights chosen and positioned to provide the perfect

effect on your model. As you work with HDR Light Studio, the lighting is updated in real-time in VRED,

where you can see the lighting interact with your 3D scene. New in VRED 2020.1, you can also create

and control Area Lights using HDR Light Studio (Tungsten Drop 1 and higher).

This workflow tutorial will teach you how to use the connection between VRED and HDR Light

Studio. It will not teach you how to use HDR Light Studio itself. Please see our 'Getting Started'

content here to learn the HDR Light Studio interface and the basic features.

1. Starting HDR Light Studio Connection in VRED

If you already have a scene loaded in VRED and lit by an existing Environment, please skip to Step 5.

For those less familiar with VRED, you can start here.

STEP 1: Start VRED. Figure 1 shows what your screen may look like.

Figure 1: VRED 2020.1 on start-up

STEP 2: In the top toolbar go to File > Open to load your scene in VRED (see Figure 2) or hit Ctrl + O

on the keyboard.

https://www.lightmap.co.uk/learning/category/get-started/
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Figure 2: Loading a scene

In this workflow example, we are using an example scene that comes with VRED,

'Automotive_Genesis.vpb', which at default is stored in C:\ProgramData\Autodesk\VREDPro-

12.1\Examples (see Figure 3). 

Figure 3: Loaded scene in VRED (Automotive Genesis)
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STEP 3: Click on the 'Materials' icon in the bottom toolbar (see Figure 4) or in the top toolbar go to

Scene > Material Editor (see Figure 5). This will open your 'Material Editor' (see Figure 6).

Figure 4: Opening Material Editor (method one)

Figure 5: Opening Material Editor (method two)
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Figure 6: Material Editor panel

STEP 4:  Move your mouse over the 'Material Editor' title bar and click/hold/drag the window to the

side of the UI (see Figure 7), this will dock the window for your convenience (see Figure 8). 

Figure 7: Moving the Material Editor window
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Figure 8: Material Editor docked to the side

STEP 5: When using HDR Light Studio connected to VRED, it will replace the HDRI file used by the

current VRED environment with the HDR canvas seen in HDR Light Studio. When a change to the

HDRI map design is made in HDR Light Studio, VRED is instantly updated with this new lighting. HDR

Light Studio shares a low resolution HDRI of the lighting design (proxy) during the lighting design

process. At the end of this process, the HDRI map is rendered by HDR Light Studio as a high quality

and high resolution file on disk that is then used by the VRED environment.

HDR Light Studio can be used to create:

· Studio Lighting from scratch

· Edit/Enhance/Augment existing HDRI environments by loading them into HDR Light Studio

· Create convincing lighting for a back-plate image without an associated HDRI map

Let's go...

In the Materials List, expand 'Environments' tab and enable 'Studio' with the tick box (see Figure 9).

The car is now lit with the Studio Environment. 

This is the environment we will edit using HDR Light Studio.
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Figure 9: Selecting Studio Environment

STEP 6: In the 'Environment Material' section, change 'Environment Geometry' property to

'Sphere' (see Figure 10a). This allows none distorted placement of lights in all directions around your

model.

If you prefer to leave this set to a 'Dome', this is fine, but lights on the floor will be distorted in their shape

on the HDRI map.

Figure 10a: Setting Environment Geometry to Sphere

Make sure the X,Y,Z Rotations in the Transformation settings for the Environment are all set to 0,0,0.

This ensures all lighting is correctly created with HDR Light Studio. (Figure 10b)
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Figure 10b: X,Y,Z Rotations in the Transformation settings for the

Environment are all set to 0,0,0

STEP 7: Click on the 'HDR Light Studio' section of the properties to expand it.

Click on ‘Edit & Load Settings’ to start HDR Light Studio connected with VRED (see Figure 11). 

Figure 11: Expanding HDR Light Studio section

then starting up HDR 

The HDR Light Studio application opens, and is now connected to VRED (see Figure 12).
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Please Note: If the HDR Light Studio interface does not look like the layout below, you can reset the interface

layout in HDR Light Studio by going to the menu: Window > Layout > Load > Default > VRED

Figure 12: HDR Light Studio on start-up (right)

STEP 8: Place the HDR Light Studio interface onto your second display, if you have one (see Figure

13).

Otherwise you will need to rearrange the HDR Light Studio interface to see both HDR Light Studio and VRED

on the same display, which is not ideal and can get crowded.

Notice how the car in VRED is now lit with the default gradient HDRI map coming from HDR Light

Studio. The studio environment image in VRED has been replaced with the HDRI output from HDR

Light Studio.

The Environment now says: 'HDRLightStudioLive Environment'

Figure 13: VRED (left) running with HDR Light Studio connection (right)

2. Painting Lights onto HDRI Map using LightPaint
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STEP 1: In VRED go to the Material Editor, and in the HDR Light Studio section tick the LightPaint

tick box to allow you to use LightPaint on the VRED viewport (see Figure 14). 

Figure 14: Enabling LightPaint within VRED

STEP 2: In HDR Light Studio add a ‘Rect Light’ from the toolbar on the left. Then inside VRED, while

holding the Shift key, left click (Shift-Click) on the car hood/bonnet to position the selected light in

HDR Light Studio (see Figure 15).

Figure 15: Painting a rectangular light onto the hood/bonnet of the car.

The selected light will move to a position on the HDRI map that will 'reflect' in the 3D model where

clicked.

This is because the LightPaint drop down in VRED is set to 'Reflection Painting'.

STEP 3: In VRED you can click on the ‘Raytracing’ and the ‘Antialias’ icons in the top toolbar to see a

more accurate preview of your lighting. But this will provide slower rendering updates and will be

less responsive.

Paint more lights until you are happy with the lighting design (see Figure 16).
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Figure 16: Raytracing enabled to preview a more accurate lighting design made in HDRI Light Studio

3. Adding Area Lights
New

You can create Area Lights in VRED using: HDR Light Studio Tungsten Drop 1 (and higher) with

VRED 2020.1 (and higher).

So far we have been creating a custom HDRI map for the selected VRED environment using HDR

Light Studio. When lights are represented on a HDRI map they provide lighting and reflections seen

by the entire 3D model with lighting coming from a distance around the entire scene. A light

positioned to reflect on the bonnet may also be seen by other areas of the model. Sometimes this is

fine, but sometimes you need lights in 3D space that can be positioned closer to your model. Lighting

only one area of the model.

Area Lights are light panels in 3D space. A flat rectangular plane emitting light from one side only.

Area Lights can be positioned anywhere you want in your scene as a light source. Allowing specific

area of your model to get illumination or reflections. The HDR Light Studio connection can create

VRED Area Lights and control their size, position and appearance with the mapped HDRI content

coming from HDR Light Studio.

STEP 1: In HDR Light Studio create or pick a light of your choice (with 3D mapping, i.e. in the 'Light

Properties' panel, 'Mapping' set to '3D') and place it anywhere on the HDR canvas in HDR Light

Studio, in this example Umbrella 1 was used (see Figure 17). 
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Figure 17: Adding a light onto canvas in HDR Light Studio

STEP 2: With the light selected, easily convert the light into an Area Light by ticking the ‘Area Light’

check box in the 'Light Properties' panel (see Figure 18). 

Please Note: A light can be returned to the HDRI map and removed as an Area Light in VRED at any time by

deactivating the Area Light check box. This change will happen instantly.

Figure 18: Light just before being converted to Area Light

Please Note: If when trying to make an area light in HDR Light Studio you see the error pop up 'VRED does

not support area lights' (see Figure 19) and you are using VRED 2020.1 or higher, this indicates the

version of HDR Light Studio you are using is lower than Tungsten. Area Light functionality with VRED 2020.1

requires HDR Light Studio 'Tungsten' release or higher.

Figure 19: Error message when creating area

lights in HDR Light Studio
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The light has now been converted into an Area Light in HDR Light Studio and has also been created

in VRED. It is likely that the viewport in VRED will not change much because the lights initial size and

position will look very similar to when the light was on the HDRI map (see Figure 20).

Figure 20: Light converted into an Area Light

Notice how the name of the light in the Light List in HDR Light Studio now has an area light tag at the

end, i.e. [AreaLight], and is color coded yellow. 

The promoted area light is now removed from the HDRI map shared with VRED and is created as an

Area Light in VRED, with the HDRI content from HDR Light Studio mapped onto its surface.

Please Note: A representation of the area light will still be seen on the Canvas in HDR Light Studio (the

canvas provides a lat-long view of both area lights and the HDRI map as viewed from the world origin).

The area lights in VRED will use low res proxy image files containing the light content (HDR RGBA

data) that is mapped onto the light surface. These proxy images will be controlled by HDR Light

Studio, just like the main HDRI map proxy image is during the lighting process. They will also be

replaced when the final rendering of the content is done by HDR Light Studio at the end of the

lighting process.

STEP 3: In VRED use Shift-Click to position the selected Area Light using LightPaint (just like

positioning lights on the HDRI map before) (see Figure 21). 
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Figure 21: Positioning area lights using LightPaint in VRED

STEP 4: In HDR Light Studio under Light Properties panel you can use ‘Smart Dolly’ and ‘Dolly

Multiplier’ to adjust the distance between the LightPaint position and the Area Light in VRED (see

Figure 22).

Smart Dolly will scale the light so it is smaller when closer to the model and larger when it is further

away. This means whatever distance away the light maintains the same illumination effect on the

model. (If you move a large light close to the model it will get very bright lighting and you would then

need to reduce its brightness or scale it to be smaller manually. Using Smart Dolly avoids these

issues). Dolly Multiplier simply multiplies with the distance value set by Smart Dolly. This however

will not change the size of the light. Dolly Multiplier is ideal as a setting to use to make small

adjustments to the distance already set using Smart Dolly, without changing the size of the light. We

recommend using Smart Dolly to set the distance to begin with, and make small changes using Dolly

Multiplier.

Figure 22: Using Smart Dolly along with Dolly Multiplier to adjust the size and the distance between the light and the

car

STEP 5: To achieve your desired effect, you can make further adjustments to the area light in HDR

Light Studio.  In this example, ‘Cam Visibility’ has been unticked (so the camera does not see the

light, but its illumination on the model and reflections can still be seen. Use this setting if the light is
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visible within the camera shot and you don't want to see it.) and the area light has been rotated

using advanced rotations (see Figure 23).

Below is a list of Area Light properties controllable using HDR Light Studio:

· Brightness (Via the brightness of the HDR RGBA content mapped onto the light)

· Size (width and height)

· Location

· Rotation

· Camera Visibility (Toggling visibility of an area light but not its effect on the scene)

· Falloff (Controls the fall off of the Area Light: Quadratic (Realistic in VRED) or Constant

(None in VRED))

Figure 23: Turning Cam Visibility off and rotating the area to achieve the desired lighting effect

STEP 6: In VRED go to Scene > Light Editor and then expand the section called ‘Studio Area Lights

[HDR Light Studio]’ to see the area lights created by HDR Light Studio (see Figure 24)

Any settings not controllable by HDR Light Studio, can be adjusted in VRED inside the Light Editor. 
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Figure 24: Area lights created by HDR Light Studio being shown in

VRED

Please be aware that adjusting settings controllable by HDR Light Studio inside VRED will not update them

in HDR Light Studio, these settings are not 'bi-directional'. Next time HDR Light Studio is connected with the

VRED scene, settings controlled by HDR Light Studio will be overwritten by HDR Light Studio in the VRED

scene.

Please Note: If the 'Type' of the light is changed in VRED from Rectangular Light to another setting, the lights

connection with HDR Light Studio is broken.

4. Producing the Final HDR Content

HDR Light Studio will now render higher resolution, high quality sub-sampled HDR images on disk for

VRED to use instead of the proxy content used during the lighting design process.

STEP 1: In HDR Light Studio, click on the 'HDR' button on the left toolbar (see Figure 25). This opens

the 'Production Render' panel.
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Figure 25: Clicking on the 'Render Production HDRI icon' to render the HDRI

map file.

STEP 2: The Orientation for the map will be set to 'VRED/VRED' (see Figure 26).

Figure 26: Setting the map orientation to VRED.

STEP 3: Adjust the rest of your settings according to your needs.

Set the Resolutions for the both HDRI map and the Area Lights.

Choose a file name and location for the HDRI content using the 'Browse' button.



1248

1248Connections (Plug-Ins)

Click ‘Render’ and HDR Light Studio will calculate the final content, save it on the disk and update

VRED to use that content (see Figure 27). 

Please Note: Users can select the Format 'Live' and the rendered images will not be saved to disk, but sent

to and stored in the VRED scene itself.

Figure 27: Rendering the final HDRI map file.

 VRED will now use the files on disk rather than the temporary low res output (see Figure 28).

Figure 28: Upon saving the HDRI map file VRED updates the environment.

STEP 4: Going back to VRED, in 'Material Editor' and under the 'HDR Light Studio section', click on

‘Save Settings’ to save the HDR Light Studio project against the VRED environment (see Figure 29).

Now when opening this VRED scene in the future and starting HDR Light Studio, the lighting design
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will be loaded by HDR Light Studio and the lo-res HDR content will be used again, allowing you to

edit the lighting design further.

You can now save your VRED scene and use the 'Quit' button in VRED to close HDR Light Studio.

Figure 29: Quitting HDR Light Studio connection
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Editing Existing HDRI Maps

Figure 1 shows a car scene, lit by a HDRI map that was loaded in VRED.

Figure 1: Car lit by an environment in VRED

You can edit existing HDRI maps using HDR Light Studio in conjunction with VRED to enhance the

lighting in your scene. 

Ensure you already have a scene loaded and HDR Light Studio running with VRED. To learn how,

please see Workflow Tutorial before you begin.

STEP 1: Once your HDR Light Studio connection with VRED starts, delete the ‘Default Gradient

Background’ by selecting the light in the 'Light List', right clicking on it and selecting ‘Delete’ (Figure

2).

Figure 2: Car scene being lit by the default gradient background in HDR Light Studio

STEP 2: Add a picture background light in HDR Light Studio by selecting the ‘Picture Background’

icon from the toolbar on the left (Figure 3). The light will appear in the 'Light List' (Figure 4). 
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Figure 3: Picture Background button in the left toolbar of HDR Light Studio

Figure 4: Picture background light is created and visible from the Light List in HDR Light Studio

STEP 3: While the ‘Picture Background’ light is selected, in the ‘Light Properties’ under the

‘Content’ section, click on the ‘Load’ icon next to the ‘Image’ field to load a HDRI map of your choice

(Figure 5)

Figure 5: Loading a HDRI map image

STEP 4: Find your HDRI Map, select it and click ‘Open’ (Figure 6)



1252

1252Connections (Plug-Ins)

Figure 6: Choosing the HDRI map to load

STEP 5: When ‘Image Conversion’ window pops up, click on ‘Convert’ to convert the HDRI Map to a

tx file so it is map-mapped to improve performance (Figure 7). Save the tx file to the location of your

choice. 

Figure 7: Image Conversion window is prompted upon trying to load a HDRI map that is not mip-mapped

STEP 6: By default, the HDRI map’s rotation does not match with VRED (compare Figure 1 and 8). To

prevent this, in HDR Light Studio in the ‘Light Properties’ panel, under the ‘Transform (Core)’

section, change the ‘Longitude’ to 0 (Figure 9). 

Figure 8: By default, the HDRI map's rotation in HDR Light Studio is not matching the rotation in VRED
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Figure 9: Changing the Longitude from 180 to 0 adjusts the roation of the HDRI map for it to match with VRED

STEP 7: You can now start editing the existing HDRI map (Figure 10)

Figure 10: The existing HDRI map is being edited
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Area Light Distance in Detail

HDR Light Studio takes an alternative approach to working with area lights. Instead of moving lights

around in 3D space with X,Y,Z controls or gizmos, as with standard 3D software, HDR Light Studio

area lights are controlled with the same LightPaint system used to position the lights on the HDRI

map. By clicking on the model in VRED using the the LightPaint modes of Reflection, Illumination or

Rim - the area light is automatically moved to a 3D location that provides the required lighting effect.

Distance

Unlike lights that are on the HDRI map, 3D Area Lights need to know how far away from the model to

be positioned. The Smart Dolly slider in HDR Light Studio is the primary control for distance. It

controls both the distance from the LightPaint position to the Area Light, and scales the Area Light

at the same time. The further away the light gets, the larger it gets. This ensures the same amount of

illumination is reaching the 3D model from the area light however far away it is. In the image above

you can see the effect of changing the Smart Dolly values on an area light.
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The Dolly Multiplier slider provides additional distance control. It will change the distance without

changing the scale of the light. Its value is multiplied with the value from the Smart Dolly distance.

Think of this slider as a fine adjustment for distance. Once you have the light in about the right

position using Smart Dolly, this slider is good for refining the distance, but without changing the size

of the light.

A Creative Approach

By clicking on the model to position the light and then using the smart dolly to change the distance

(and scale), this is a really artist friendly approach to lighting. It allows the user to focus on the

creative process of lighting the final shot, the user does not need to leave the shot being lit in order

to move and adjust lights, its all done in context with real-time feedback. The user doesn't need to

worry about the physical size of the lights, but rather on their effect on the shot. The width and

height settings for the light are used to control the size of the light as seen by the model, rather than

worry about making a light of a specific measurement.

Scene Scale and Area Lights

Please Note: In the example below, units in VRED were set to mm.
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The default Smart Dolly value for a newly created area light is 1,000. This positions the light 1m

(1,000mm) away from the LightPaint position in VRED.

This is also the highest value on the slider (although larger values can be typed, and if you drag off the

end of the slider, the value will keep increasing if you have the screen space).

For some scenes 1m is too far away. For other scenes 1m is too close. Therefore we provide an

application setting in the Preferences panel to handle different scene scales.

The Smart Dolly Scalar value chosen in Preferences is multiplied with the Smart Dolly slider values

for all area lights in HDR Light Studio. This multiplied value then determines the actual distance area

lights are placed from the LightPaint position. Making this value smaller will result in area lights being

closer (and the range of distances available on the slider smaller), making this value larger will result

in area lights being further away  (and the range of distances available on the slider larger).

Change the Smart Dolly Scalar value from the default 1 to 0.1 and instantly all HDR Light Studio area

lights will be 10 times closer in VRED. (Smart Dolly of 1,000 = 100mm)

Change the Smart Dolly Scalar value from the default 1 to 10 and instantly all HDR Light Studio area

lights will be 10 times further away in VRED. (Smart Dolly of 1,000 = 10,000mm or 10m).

A Smart Dolly Scalar value of 10 makes good sense for lighting a car. Lights will be created 10m away

initially and the Smart Dolly slider will cover lighting from 0 to 10m. However in this case the area
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lights may be created outside of the environment geometry and will not be seen in reflections - see

here how to fix this.

Please Note: Smart Dolly Scalar is an app preference, not project preference, i.e. the value of Smart Dolly

Scalar is shared across all projects opened in HDR Light Studio. This setting can be changed at any time

and all area lights in the open project will have their scale updated right away.
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Missing Area Light Reflections

When making Area Lights in VRED using HDR Light Studio, it is possible that the area light may be

missing, or partially missing, in reflections in your 3D model.

This happens when the 3D area light is positioned outside of your environment geometry in VRED

(see below). This is likely to happen if you have changed the Smart Dolly Scalar preference in HDR

Light Studio to make it a value of 10 or higher. See here for details on this setting.

In the view below we have zoomed out in VRED. You can see the area light is there, but the

environment sphere is blocking the visibility of the area light to the 3D model.

If you were viewing your scene from within the environment sphere, you would be unaware of the

area light outside.

However, the area light illumination is not blocked by the environment sphere geometry, and the

area light will illuminate your 3D model from outside the environment.

Solution 1: Move the Area Light Closer

The simple solution is to drag the Smart Dolly slider value smaller in HDR Light Studio, to bring the

area light closer to your model in VRED, and completely inside of the environment geometry.

But if you don't want the light to be closer, solution 2 is for you.
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Solution 2: Scale the VRED Environment geometry to be larger

Please Note: Changing the environment geometry size in VRED will move the reflections of lights (on

the HDRI map) on your 3D model.

STEP 1: In VRED Open up the ‘Scenegraph’ by clicking on the ‘Graph’ icon in the bottom toolbar.

Alternatively, in the top toolbar Scene > Scenegraph

STEP 2: Select your environment geometry in the scene graph, this is the environment that is

illuminating your scene.
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HDR Light Studio environment selected

STEP 3: While your environment is selected, click on the ‘Transform’ icon in the bottom toolbar to

open up the 'Transform' panel.

Opening Transform panel

STEP 4: Under the ‘Scaling’ section in the ‘Transform’ panel, you can scale your environment. As a

result of this, if the environment is scaled up enough, the area light will be inside of the environment.
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The environment's scale is now 1.6

Because the area light is now inside the environment, the area light can be seen in the reflection. 

Viewing area light from inside of the environment
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Multiple Environments in VRED

A VRED scene can have more than one Environment and easily switch between them.

HDR Light Studio can be used to create/edit lighting for these multiple environments in VRED.

You may want multiple lighting designs in the same VRED scene to:

· Try out and save different lighting styles/looks/locations

· Create a new lighting design for each camera angle

In the example VRED Scenegraph below, there are 3 environments (Env 1, Env 2, Env 3) where HDR

Light Studio has been used to edit the HDRI map and to create Area Lights too.

You can see that Env 1 is the currently active environment (those items are on). You can see in the

graph that the corresponding Area Lights are stored as part of the Environment hierarchy.

This means that when the active environment is switched, only the Area Lights belonging to that

environment are visible and lighting your shot.
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Important Notes when working with HDR Light Studio between Multiple Environments in VRED

1. Prior to switching the active environment in VRED, make sure you use the 'Save Settings' button

to store the HDR Light Studio lighting design state on the currently active environment.

If you do not do this, your current lighting design will not be saved against this environment when

switching to edit another.

2. When switching to a different active environment in VRED, remember to press the 'Edit & Load

Settings' button in order to tell VRED that you want to use HDR Light Studio to edit this

environment. This does no happen automatically when switching between environments in VRED. If

you do not press this button, HDR Light Studio will display and continue to edit the lighting design

you were last editing.
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Release Notes and Known Issues

Release Notes

VRED 2020.1

Area Light support has been added in VRED 2020.1 and higher.

Area Lights can be created using HDR Light Studio Tungsten Drop 1 and higher.

HDR Light Studio 5.3

Fixes issue where dragging Lat / Long Sliders caused slow HDRI map updates.

Known Issues

Changing VRED Project

If HDR Light Studio is connected when starting a new project or loading a saved project in VRED, HDR

Light Studio will no longer be connected, according to VRED interface and HDR Light Studio will

remain open showing the lights from the previous session. The ‘Show’ and ‘Quit’ buttons will be

enabled in VRED but do not function. To reconnect HDR Light Studio press the ‘Edit and Load

Settings’ button.

LightPaint Environment and Shadow Plane

The Environment and Shadow Plane are treated as geometry that can be LightPainted. This could

cause unexpected results when using LightPaint and the cursor clicks on these areas of the view.

Area Lights Issues

Floor Shadows
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Shadows cast by VRED area lights can cause undesirable floor shadows when using a Shadow plane

material (see image above).

The Shadow material is only dark where the light casts an actual shadow in its the light-emitting

direction. In the other direction where no light is emitted, there are no shadows cast. There are two

ways to get a different result:

1) use another material for the ground like Plastic, or 2) set the Ground Shadow Intensity of the area

light to 0 in the Light Editor to remove this shadow completely.

Area Lights Rear-side
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In the image above there are 2 area lights facing outwards to the vases on the left and right. There is

a problem that the rear-side of the area lights are also textured and can be seen in reflections in

raytracing. This is the behavior of the VRED area lights. Please be aware that the rear-side of the light

will be seen in reflections, as seen in the reflections of the red vase in the middle. But also note there

is no illumination coming from the rear-side of the area lights. In this respect this is not behaving in a

physically correct way.

Environment Rotation results in incorrect Area Light orientation

For area lights to be correctly orientated, ensure the rotation settings for the VRED environment are

set to 0,0,0
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UNREAL Connection

The Unreal Engine 5 Connection is a plug-in that creates a bridge between HDR Light Studio and

Unreal Engine 5.

As the HDRI map and Area Lights are created in HDR Light Studio, Unreal Engine 5 is kept in sync.

Compatibility: Official major & minor releases of Unreal Engine 5.2.1 & 5.3.x

• Installation

• Interface Overview

• Workflow

• Release Notes
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Installation

 Updating the Unreal Engine plugin builds

If you have an older build of the Unreal Engine plugin installed, you should uninstall it first before

installing a newer build - see Uninstalling.

 Important Note: You should install the main HDR Light Studio application first, prior to installing

our Unreal Engine 5 Connection plug-in. See installation instructions for HDR Light Studio here.

Installing on Windows

Ensure both Unreal Engine 5 (including the Epic Games Launcher) and HDR Light Studio app are not

running prior to installing our Unreal Engine 5 Connection plug-in.

1. Download the Unreal Engine 5 plug-in file from our web site. Pick the appropriate one for your

version of Unreal Engine.

2. Save the zip file downloaded from our website at a location of your choice. Then, Unzip the file.

3. Move the hdrlightstudio folder into your Unreal Engine 5 'plugins' folder. By default this will be in:

C:\Program Files\Epic Games\version\Engine\Plugins
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You no longer need the .zip file used to install the connection, it can now be deleted (in this example

it was stored on the desktop).

Please ensure the contents of your hdrlightstudio folder look like this (you should not have a

hdrlightstudio folder inside another hdrlightstudio folder):
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4. Open Epic Games Launcher and start Unreal Engine 5. Then, open your project and go to Edit >

Plugins.

5. Search for ‘HDR Light Studio’ and enable the plugin, then click ‘Restart Now’ for changes to take

effect.

Once Unreal Engine restarts, and you look in the plugins panel, you will notice the HDRIBackdrop

plugin is enabled. The HDR Light Studio plugin is utilising the HDRIBackdrop plugin to manage the

HDRI lighting. When HDR Light Studio plugin is enabled, it automatically enables the HDRIBackdrop

plugin. You will not be able to disabled the HDRIBackdrop plugin whilst the HDR Light Studio plugin

is enabled. 



1272

1272Connections (Plug-Ins)

6. Close the plugins panel and open the HDR Light Studio connection panel from the toolbar at the

top.

The installation process is complete and you are now ready to use HDR Light Studio using this

Workflow.

Uninstalling on Windows

1. Start Unreal Engine 5 and open your project, then go to Edit > Plugins
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2. Search for ‘HDR Light Studio’ and disable the plugin, then click ‘Restart Now’ for changes to take

effect.

3. Close Unreal Engine 5.

4. Delete the hdrlightstudio folder from your Unreal Engine 5 'plugins' folder.

By default this will be in: C:\Program Files\Epic Games\version\Engine\Plugins
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5. HDR Light Studio plugin for Unreal Engine 5 is now uninstalled.
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Connection Interface Overview
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Workflow Tutorial

This workflow tutorial teaches how to use HDR Light Studio with Unreal Engine 5 via the

Connection.

Watch the HDR Light Studio - Quick Start video first to learn the key concepts of using HDR

Light Studio.

 Please Note: Ensure you have installed both the HDR Light Studio main application and the HDR

Light Studio Connection for Unreal Engine 5.

Compatibility

HDR Light Studio is supported with major and minor official releases of Unreal Engine 5.2.1 & 5.3.x.

Using HDR Light Studio with preview, pre-release, or custom builds of Unreal Engine 5 may be buggy

or may not work.

Start Unreal Engine 5, Load your Project & Open the Level you want

to Light

In this workflow tutorial we will be using the Photo Studio template (available from the Automotive

Product Design & Manufacturing section in the Project Browser), and we will be lighting a Cinematic

Level Sequence (using Sequencer Editor).

Before we start to use HDR Light Studio to light our Level Sequence/Level.... let's make sure it's

ready to light first.

Camera View

Make sure you have a camera setup with the final composition for the shot/s you want to light. If

your camera composition changes during the lighting process, the reflections of the lights will move

and this will change the look of your lighting.

Existing Lights

The HDR Light Studio connection will create and set up new Sky Lights or Hdri Backdrops for you. So,

if you have any lighting that was set up during the look development for the scene, now is a good

time to disable or delete it. However, if you already have a Hdri Backdrop or a Sky Light set up in any

of your Levels and you wish to edit them in HDR Light Studio, you can leave it active. Later in the

tutorial, you will learn how to use your existing Hdri Backdrop/Sky Light for editing in HDR Light

Studio.  

https://docs.unrealengine.com/5.2/en-US/unreal-engine-templates-reference/
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Open the 'HDR Light Studio Connection' panel

From the toolbar at the top, click on the HDR Light Studio button to open up the connection panel.

The HDR Light Studio Connection panel opens.
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Ideally, you should now drag the panel and dock it into the Unreal Engine 5 interface.

Create a new Sublevel & Store your Lighting Separately

The Levels window in Unreal Engine is very useful for level management - You can learn more about

the Levels window in Unreal Engine's documentation here.

In this workflow tutorial, we will create a new Sublevel and use it to separately store our lighting. 

Go to Window > Levels to access the Levels window.

https://docs.unrealengine.com/5.2/en-US/managing-multiple-levels-in-unreal-engine/
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In this example, we only have a Persistent Level, which is the Level we currently have open.

Let's create a new Sublevel by clicking on the Levels dropdown menu and selecting Create New.
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Choose an Empty Level. 

Give the Level a name, for example: HDRLightStudioLighting. Then, choose where you want to save

it and press Save.
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We can now see that our Persistent Level contains a Sublevel, and it has automatically been set to be

the Current Level (indicated in bold blue text).

Click on the Summons level detail.
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Select your Sublevel from the Inspect level drop-down and enable the Initially Loaded & Initially

Visible settings.

This will ensure the Sublevel is loaded and made visible when we simulate it (required for streaming

interactive render in HDR Light Studio). 

We are now ready to start lighting using HDR Light Studio. The lighting created will be stored in the

Sublevel we have just created. 
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Storing your HDR Light Studio lighting in a separate Sublevel keeps your project organized, but also,

it will allow you to add this Sublevel (including lighting) to all Levels in your Unreal Engine project.

Start HDR Light Studio

Let's put our focus back on the HDR Light Studio connection panel.

Press Start to start HDR Light Studio in a connection with Unreal Engine 5.

 Please Note: If HDR Light Studio is already open running standalone, connected with another 3D

app, or connected to another session of Unreal Engine 5 - the connection will not function correctly.

So please ensure HDR Light Studio is not already open before starting it from Unreal Engine 5.

If the editor setting Use Less CPU when in Background is enabled, a performance dialogue will

appear.

When this editor setting is enabled, the CPU is throttled and it may stop HDR Light Studio from

receiving real-time updates while lighting.

So, it is advisable to Disable the editor setting Use Less CPU when in Background.
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During the start process, HDR Light Studio plug-in will detect any existing environment lights (Hdri

Backdrops/Sky Lights) in your Persistent Level and Sublevels. A dialog will appear where you will be

asked to choose an environment light from the drop-down. If no environment lights are present, we

can create a new environment light by choosing from 2 different types:

•   Hdri Backdrop

•   Sky Light

 Please Note: Hdri Backdrop offers a prepared solution for IBL lighting and it will not require any

further setting up from the user. However, Hdri Backdrop is not 100% compatible with the Path

Tracer. So, if you are planning on using the Path Tracer, it is recommended to use a Sky Light and

manually set it up for technical Path Tracing. 

You can find out more about the Hdri Backdrop blueprint and the Path Tracer in the Unreal Engine 5

documentation. 

In this example, we will create a New Sky Light. 

https://docs.unrealengine.com/5.1/en-US/hdri-backdrop-visualization-tool-in-unreal-engine/
https://docs.unrealengine.com/5.1/en-US/path-tracer-in-unreal-engine/
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 Please Note: If you ever need to delete any of your Hdri Backdrops / Sky Lights, please do so

when you are not in simulation mode or playing your Level in editor (PIE mode) and when HDR Light

Studio application is not running.

The newly created environment light will be called SkyLight_0 [HDRLightStudioLighting] because

we have created a first instance of a Sky Light in the Current Level called HDRLightStudioLighting -

this is what we have called our Sublevel.

The newly created Sky Light will now be the selected environment light in the drop down. This will be

the environment light that HDR Light Studio will connect to and take control of.

You can close the Levels window now and press OK to start launching HDR Light Studio.

 Tip: Working with Multiple Environment Lights 

You can can create multiple environment lights in your Sublevel/Level and change the active

environment light. The active environment light is the environment light that HDR Light Studio is

currently connected to and taking control of. 

This can be useful if you would like to create multiple lighting designs using different types of

environment lights. 

For example, you might have created a lighting design in HDR Light Studio using a Hdri Backdrop

but would also like to create one using a Sky Light. 

Creating new Environment Lights
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Ensure you create additional environment lights when HDR Light Studio application is not

running, if it is then Stop the connection. Please also ensure you are not simulating or playing

your Level/Level Sequence in editor (PIE mode).

New environment lights can be created by clicking Start in the HDR Light Studio connection panel

in Unreal Engine 5 and then creating a New Hdri Backdrop or New Sky Light. When a new

environment light is created, by default, it will become the selected environment light in the drop

down. 

Changing the Active Environment Light

Ensure HDR Light Studio application is not running and you are not simulating or playing your

Level/Level Sequence in editor (PIE mode). If HDR Light Studio is running, ensure to Stop the

connection from the HDR Light Studio connection panel in Unreal Engine.

To change which environment light HDR Light Studio should be connected to and take control of,

press Start in the HDR Light Studio connection panel in Unreal Engine, and select your

environment light from the drop down. Then, click OK.
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HDR Light Studio will now start connected to Unreal Engine 5 and the environment light selected.

Please Note: With more than one loaded and visible environment light in your Level, Unreal

Engine will layer the results of multiple environment lights on top of each other. If you find

yourself seeing stand-in blue HDR Light Studio logo images lighting your Level/Level Sequence, it’s

because one or some of your environment lights are not using final production files. There is more

information on this later in this workflow tutorial – learn more here.

In this workflow tutorial, we will not be working with multiple environment lights. We will continue

working with the Sky Light we have originally created called SkyLight_0 [HDRLightStudioLighting].

If a firewall permission panel pops up. Give permission for the HDR Light Studio connection to use

TCPIP. This is how HDR Light Studio communicates with Unreal Engine 5.

The HDR Light Studio application will now open connected to Unreal Engine 5 and the environment

light selected.

Let's change the the View Mode in Unreal Engine to either Lit or Path Tracing, so we can see the

lighting in our Level.
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New HDR Light Studio projects contain a default gradient background that’s now lighting our scene.

This is because the render view would be black if we didn’t have any lights. 

Tip: Importing your own HDRI Map into HDR Light Studio 
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If you would like to import and load your own HDRI map in HDR Light Studio, you can create a

Picture Background and load your own Image Content.

Tip: If your Level is dark or appears black (when in lit or path tracing mode) even after HDR Light

Studio launches, you will likely need to adjust the exposure in your Level. The exposure can also be

affected by a PostProcessVolume. 

In the Outliner panel in Unreal Engine 5 you will notice that HDRLS Objects folder has been created -

it contains a Sky Light.

Any Sky Light/Hdri Backdrop created by HDR Light Studio or opened in HDR Light Studio will be

stored inside the HDRLS Objects folder.
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Behind the scenes, the HDR Light Studio connection has taken control of the environment texture on

the Sky Light.
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The Sky Light uses a Texture Cube that gets updated when the lighting design changes in HDR Light

Studio. During the lighting process, low-res temporary textures are used as they are fast to calculate

and for Unreal Engine 5 to load.

Note for users using a Hdri Backdrop

The created Hdri Backdrop will have its projection center set to 0, and size set to 100000.
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The Hdri backdrop uses a Texture Cube that gets updated when the lighting design changes in

HDR Light Studio. During the lighting process, low-res temporary textures are used as they are

fast to calculate and for Unreal Engine 5 to load.

Default HDR Light Studio Interface Layout with Unreal Engine 5

By default, the HDR Light Studio interface should look something like this (see below).

If not, you can reset the HDR Light Studio interface layout by going to the menu: Window > Layout >

Load > Default > Unreal
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Show the interactive render inside the HDR Light Studio interface

Before we can stream the interactive render inside HDR Light Studio's interface, we need to ensure

the viewport in our Level Sequence/Level is set to Cinematic Viewport.

Now, if we go back to HDR Light Studio, we can press the Play button in Render View

[UnrealUnreal].



1294

1294Connections (Plug-Ins)

The Unreal Engine 5 rendered image will stream into HDR Light Studio's interface. In the background,

HDR Light Studio has started the simulation of your Level Sequence/Level in Unreal Engine.

Simulating your Level Sequence/Level is essential for HDR Light Studio to receive image updates.

To understand all of the features/controls for this view, see here.

Please Note: If your Hdri Backdrop / Sky Light disappears from the outliner when simulating your

Level Sequence/Level, it's likely because your Sublevel hasn't loaded and been made visible - see

here for more info.

HDR Light Studio will detect all Cinematic Cameras in our Level Sequence/Level and populate the

camera list in HDR Light Studio. By default, HDR Light Studio will either use the first instance of a

Cinematic Camera in your Level Sequence/Level or the currently selected one. If there are no

Cinematic Cameras in your Level Sequence/Level then HDR Light Studio will use the Perspective view.
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You can use the camera list dropdown in HDR Light Studio to switch your camera view.

This Level contains animation that is automatically played when we start simulation. In this example,

the CameraMotion actor is responsible for the animation.

Because we are wanting to light a Cinematic Level Sequence (using Sequencer Editor), we will disable

Auto Play and ensure the animation is set to Don't Loop on the CameraMotion actor. We will want to

control the animation playback using Sequencer Editor instead.

Please Note: If you are lighting a Level without a Sequencer Editor (non Cinematic Level

Sequence), then you will probably want your animations to Auto Play. If that's the case, you can skip

to the next section here.

Before we disable Auto Play, we need to Stop Simulation, only then we can edit the properties of the

CameraMotion actor and disable Auto Play and Loop.
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It's now important to resume the simulation of our Level Sequence/Level for HDR Light Studio to

receive image updates.

We can do this by either clicking on the Resync Render View button in HDR Light Studio or the Start

Simulate button in Unreal Engine.

Next, we can Lock Viewport to Camera Cuts, then Loop playback range and start playing your

sequence. 

We can now use the Sequencer Editor to control the playback of the animation.

Using the Path Tracer

If you want to use Path Tracing in your Level Sequence/Level, you can enable it in the console using

the command showflag.pathtracing 1 (showflag.pathtracing 0 to disable).
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Please Note: Hdri Backdrops are not 100% compatible with the Path Tracer. Therefore, we only

recommend using Sky Lights with the Path Tracer.

Pausing Animations in your Level Sequence/Level during lighting

Streaming non-static/animated scenes into Render View [Unreal|Unreal] in HDR Light Studio may

show latency and may be too slow to render.
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Because the scene used in this workflow tutorial is animated and was too slow to render smoothly

inside HDR Light Studio, we will Pause (at a point of our choice) the playback of the sequence using

Unreal Engine's Sequencer Editor - please see the note below if you are lighting a Level (non

Cinematic Level Sequence). 

While we are building the lighting in HDR Light Studio we can play and pause the sequence to test

the lighting.

 

Pausing a Level (non Cinematic Level Sequence)

If you are lighting a Level (non Level Sequence), you won't have the Sequencer Editor to control

the playback of your animations/sequence.

In this case, you can Pause the Simulation Mode at a point of your choice. 
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 Please Note: If you ever minimize the HDR Light Studio window and then you maximize it,

please be aware that this will resume/re-start the simulation mode. 

During the lighting process in HDR Light Studio you can play and pause the simulation mode to

test the lighting.

Let's make our first Light

Let's put our focus on the HDR Light Studio interface and start lighting our scene!

Please note: Ensure Unreal Engine is not minimized while you light in HDR Light Studio as this

will stop the interactive render in HDR Light Studio from receiving image updates from Unreal

Engine. 

You will notice the rendered image will look too bright in HDR Light Studio. This is because we need

to change a setting in the Render View [Unreal|Unreal].
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Use the dropdown to change the LUT from sRGB to None. This will ensure the image looks the same

in HDR Light Studio as it does in Unreal Engine 5.

By default, LightPaint is set to Reflection in this view. So lights are moved to reflect in the clicked

location on the 3D model (Learn about LightPaint here).

Drag and drop a Preset Light onto the 3D model in the Render View.
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 Auto Exposure Tip: As you are lighting in HDR Light Studio, you may notice your interactive

rendering changing its exposure level. This will happen if you have Auto Exposure enabled in Unreal

Engine 5 (Project Settings > Rendering > Default Settings). We recommend turning off Auto Exposure as

it can be quite difficult to design your lighting with exposure levels constantly changing.

A new light is added to the lighting design - it's reflecting where the light was dropped on the 3D

model.

As a result, you can now see in HDR Light Studio:

1. New light added in the Light List

2. New light can be seen on the Canvas

3. Render View has updated to show the new light on the model

Just the same as when we used HDR Light Studio standalone, but we have the scene from Unreal

Engine 5 in our Render View.
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Tip: If you have paused your animations, you can resume them at any time during the lighting

design process to test your lighting with your animated scene. You can resume and pause your

animations whenever it's needed.

Move the Light

You can see that the LightPaint tool is active in the toolbar in the Render View [Unreal|Unreal].

Click on the 3D model to reposition the selected light, (highlighted on the Light List).
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Making Area Lights - A 3D light mapped with an HDR texture

So far, the lighting we created is on the HDRI map shared with Unreal Engine 5. This is about to

change!

Enable the Area Light check box in the Light Properties panel for the selected light.

 Please Note: Only Lights with 3D mapping show the option to be converted into area lights, as

these are the only lights that make sense to become area lights.
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As a result of enabling this Area Light setting, the lighting may look similar to before, but lots of

things just happened with that single setting:

1. The light in the Light List gets the suffix [AreaLight] and its text is now yellow.

2. The light has been removed from the HDRI map but is still represented on the Canvas as a

view of the light as seen from the center of the world. Don't be confused, it's really no

longer on the HDRI map lighting the shot!

3. Additional Area Light properties have been added to the Light Properties for this light, with

a default Smart Dolly distance of 1,000 units.

4. An area light has been created in the Render View [Unreal|Unreal], mapped with the HDR

texture to control its appearance.

5. An Area Light has been created in Unreal Engine 5 - mapped with the HDR texture from HDR

Light Studio, and matching the size and position of the area light in HDR Light Studio.
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Tip: Viewing area light's geometry in the interactive render

If you want to see your area light's physical geometry in the interactive render whilst you're

editing it in HDR Light Studio, be sure to select your area light in the outliner (in Unreal Engine). 
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Change the Area Light Distance
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Initially, the Area Light will be far away from your model providing a similar lighting effect to when it

was on the HDRI environment. We need to move it closer to the model so we can see it more in the

reflections.

Reduce the Smart Dolly slider value to move the light closer to the 3D model.

Tip: HDR Light Studio has a scene scale setting that is useful when working with Area Lights. If the

area lights are too close or too far away by default, adjust the Smart Dolly Scalar value in Preferences.

This value scales all area light distances in HDR Light Studio.

Let's take a look at the Unreal Engine 5 interface now. You can see:

1. The Area Light that HDR Light Studio created can be seen lighting the scene in Unreal

Engine 5 viewport.

2. Area Lights made with HDR Light Studio can be seen inside the HDRLS Object folder in the

Outliner panel in Unreal Engine 5.

3. The Area Light has been set up for Unreal Engine 5. You can see the texture from HDR Light

Studio mapped to the light properties. This texture is updated every time the light's

appearance is changed in HDR Light Studio.

 Please Note: Renaming/deleting/duplicating HDR Light Studio area lights in Unreal Engine 5 can

cause issues. Area Lights created by HDR Light Studio should be managed using HDR Light Studio's

interface. 
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Moving Area Lights

Let's go back to the HDR Light Studio interface.

In HDR Light Studio, use LightPaint in the Render View [Unreal|Unreal] to move the Area Light.

Area lights are controlled just like any other light in HDR Light Studio with the addition of the

distance controls.

Click on the 3D model to move the selected light.
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Area Light Spread

You can use the Spread slider in the Light Properties panel to control area light spread/directionality.

The spread setting controls the Barn Door angle in Unreal Engine.

This is how the spread setting changes the light emitting from the area light.
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Here you can see the effect of changing this setting, see how the light becomes more focused on the

car with lower settings.

Default Spread = 1

Spread = 0.5
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Spread = 0.00

Finalizing the Lighting Design & Rendering the Final HDRI Lighting

Textures

So far, we have been sharing low-res temporary textures with Unreal Engine 5 for your lighting - to

keep things fast during the lighting design process.

Now let's complete the lighting process by producing higher resolution and higher quality sub-

sampled HDR textures on disk.

Press the Production Render button in HDR Light Studio.

Set your Production Render settings

Notice how the 'Orientation' is already set for Unreal Engine 5. This ensures that the rendered HDRI

map is orientated correctly when rendered. For more information on these settings see: Production

Render Dialog

Press the Browse button to choose a file location and give the lighting file a name.
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 Please note:  EXR (.exr) HDRI Maps are not supported by Unreal Engine.

Press the Render button in this panel.

The production quality HDR textures will now be calculated and saved as permanent files on disk.

Once complete, the connection automatically updates Unreal Engine 5 to use these new textures.

Stopping HDR Light Studio

 Please note: If any further changes are now made to the lighting in HDR Light Studio, all lighting

textures will be updated to once again use temporary proxy images, and the link to the rendered

production files will be broken.

Please ensure you Stop the HDR Light Studio connection after you have rendered your final lighting

files.

Press the Stop button.
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HDR Light Studio now closes and leaves your Unreal Engine 5 scene with an awesome lighting setup.

This scene uses standard lights and can be rendered anywhere, even on computers without HDR

Light Studio licenses.

What happens when you stop the HDR Light Studio connection without rendering

the final HDRI lighting textures?

If you stop HDR Light Studio and have not done a Production Render of your final HDRI lighting

textures, your Unreal Engine scene would still be using temporary low-res temporary images.

When the HDR Light Studio session is over and the connection is stopped, the temporary low-res

proxy images are deleted. Therefore, the connection detects this and updates Unreal Engine to

use the blue HDR Light Studio logo image on the Environment Light and the Area Lights. This

prevents the scene from referencing missing image textures, and also makes it obvious that the

scene is not using the final high-quality lighting, ensuring the scene is not rendered by mistake

using proxy content.

So, it’s important to always render your final HDRI lighting textures at the end of the lighting

session in HDR Light Studio, to provide the highest quality lighting images for your final renders in

Unreal Engine.
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 Please Note: If you want to edit the lighting design, press the Start button and HDR Light Studio

will open and load the lighting design project data which is embedded in the Unreal Engine 5 project.

You can now edit the lighting, but make sure to render the final HDR textures at the end of the

process.

Save the Unreal Engine 5 project

The current state of the HDR Light Studio project is embedded in the Unreal Engine 5 project. You

should save your Unreal Engine 5 scene now.

Tip: Saving and loading HDR Light Studio projects / Moving HDR Light Studio lighting to your

3D modelling software

HDR Light Studio projects can be saved from the HDR Light Studio interface at any time during the

lighting process as an HDi file (native HDR Light Studio project file), even when using HDR Light

Studio via a connection. If you were to open HDR Light Studio in a connection with Unreal Engine 5,

this project can be loaded into HDR Light Studio using Project > Open Project. The lighting design

would load into HDR Light Studio replacing its current design, and would then be synced back into

Unreal Engine 5. This is how you can move lighting between Unreal Engine 5 projects or between

other supported 3D software.
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Release Notes and Known Issues

Build 2023.1115

Updated to be compatible with HDR Light Studio 8.2

Known Issues

HDR Light Studio project data does not transfer over to duplicated levels

If you have lighting made with HDR Light Studio in your level and you duplicate or use 'Save Current

Level As...' to save your level under a different name, then the HDR Light Studio project data will not

transfer over from the original level. 

Temporary workaround:

Open your original level in Unreal Engine 5 that contains your HDR Light Studio lighting. Start HDR

Light Studio in connection with Unreal Engine 5 and save your lighting project from the HDR Light

Studio interface as an .HDi file (Project > Save Project As). Return to Unreal Engine 5 and stop HDR

Light Studio from the connection panel. Next, open your new (duplicated) level in Unreal Engine 5

and start HDR Light Studio from the connection panel. Then, load the project (.HDi file) from the HDR

Light Studio interface using Project > Open Project. The lighting design will load into HDR Light Studio

replacing its current design, and will then be synced back into your duplicated level in Unreal Engine

5. 
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KeyShot Connection

Installation on Windows

Notes for HDR Light Studio 4 users
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Installation on Windows

HDR Light Studio works with KeyShot version 3-6 on Windows only.

The connection between HDR Light Studio and KeyShot is built into KeyShot - so no additional plug-

ins are required. However, you do need to set two environment variables HDRLS_HOME_V4 and

HDRLS_HOME_V5 to point to the directory where HDR Light Studio has been installed.

Step 1: Install

Make sure KeyShot is not running.

Install HDR Light Studio main app using the installer provided

Step 2: Environment Variable

The current versions of KeyShot are hard coded to look for HDR Light Studio 4, and will not see the

new installation of HDR Light Studio.

Therefore, we need to make a simple change to a Windows OS Setting that will tell KeyShot to start

HDR Light Studio instead.

Open the Control Panel in Windows OS
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Select System and Security

Select System

Select Advanced system settings

(You will need administrator privileges on your user account to do this, if you are unable to complete this
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step please ask your IT admin to help you)

Click the Environment Variables… button
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Scroll down the System variables list until you can see the HDRLS_HOME_V5 entry.

Click on the HDRLS_HOME_V5 entry in the list and press the Edit… button

(Important: If you already have a HDRLS_HOME_V4 entry in the list too, please consult the last page of this

document before continuing)

We are now going to copy the Variable value from HDRLS_HOME_V5

We will later paste this path into a HDRLS_HOME_V4 variable
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The whole path will look something like this:

C:\Program Files\Lightmap\HDR Light Studio

Select all of the Variable value contents and copy this path by pressing CTRL + C and then press OK

to close this window.

If you already have HDR Light Studio 4 installed, Click on the HDRLS_HOME_V4 entry in the list and

press the Edit… button.

The current value will be something like this:

C:\Program Files\Lightmap\HDR Light Studio v4.0
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If you do not have a HDRLS_HOME_V4 entry in the list, Press the New… button under the System

variables list, and type: HDRLS_HOME_V4 into the Variable name field.

(Please note, this field is case sensitive and needs to exactly match)

Now we will replace or enter the Variable value by selecting all (CTRL + A) and pasting (CTRL + V) into

the Variable value field

It should then look something like this, you will have a HDRLS_HOME_V4 variable pointing to the

location of HDR Light Studio (C:\Program Files\Lightmap\HDR Light Studio)

Press OK to close the Edit System Variable window
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Press OK to close the Environment Variables window

Press OK to close the System Properties Window

You’re done!

You can now start KeyShot, go to the Preferences Panel in KeyShot and enable the HDR Light Studio

plugin. Restart KeyShot and press the ‘Edit’ button on the environment to launch HDR Light Studio.
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Notes for HDR Light Studio 4 users

Important Information if you already have a HDR Light Studio 4 installation on this computer

If there are other HDR Light Studio 4 plugins being used on this computer, as well as KeyShot, then

making the changes to the environment variable to make KeyShot connect will mean all version 4

plugins on this computer will try and load HDR Light Studio, and not version 4.

So if you are only testing HDR Light Studio, please change the HDRLS_HOME_V4 variable value back

to its original value to regain the use of your version 4 plugins after you have completed your trial. 

If you reinstall the main HDR Light Studio 4 app, this will also change the environment variable back

to its proper value. This is a simple way to reset the value.

The default value looks something like this:

HDRLS_HOME_V4  = C:\Program Files\Lightmap\HDR Light Studio v4.0

But can vary depending on your language, or if you installed in a custom location.

If you have purchased and upgraded to using HDR Light Studio on this computer, and want to use it

with KeyShot and other 3D apps on this computer, please ensure you have purchased and installed

the new connections for your other 3D software as they will no longer be able to open HDR Light

Studio 4 on this machine with the v4 connections.
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Common Connection Issues
Light positions don’t match between HDR Light Studio and my 3D software

Problems Exporting your 3D Scene into HDR Light Studio

The lighting from HDR Light Studio is not updating in my 3D software

Light positions don’t match between HDR Light Studio and my 3D

software

If you have exported your scene into HDR Light Studio’s own Render View, and have positioned lights

in there, but the light positions don’t match in your 3D software/renderer. Here are some possible

causes.

1. The dome light / environment has been rotated in your 3D software.

HDR Light Studio assumes the environment in your 3D software has been created with its default

orientation. If you rotate the dome light/environment in your 3D software, HDR Light Studio does not

take this into account, and your lighting will not match. To rectify this issue, remove any rotation you

have added to your dome light/environment and they should match.

2. HDR Light Studio is not set to match the 3D software and renderer you are using.

The title bar of HDR Light Studio displays this, in this example HDR Light Studio is connected to Maya

and V-Ray. Each combination of 3D software and renderer uses environment lighting with a different

default orientation (i.e. rotation and flip).

To change the setting if it is not matching your software/renderer, press the HDR button on the tool

bar in HDR Light Studio, and in the Production Render settings, edit the Orientation settings so

they match your 3D software and renderer. After this press Apply, then Close the panel - now the

next HDRI map update will have it's orientation updated to match the new settings.
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3. The camera you are looking through in HDR Light Studio’s Render View is not the same as

the camera you are rendering in your 3D software.

Make sure you are looking through the same camera view. A different camera view will dramatically

affect the position of reflections.

Problems Exporting your 3D Scene into HDR Light Studio

Hidden geometry is exported

When exporting your scene, if the exporter in your 3D software is also exporting hidden geometry,

you will see this in the Render View in HDR Light Studio. To fix this, use the Export section of your

HDR Light Studio connection with the ‘Export Selected’ option turned on. Making sure you have

selected the geometry and camera/s you want to send to HDR Light Studio.

Model doesn’t look right

If something looks wrong with how your model has exported. This could be down to the exporter in

your 3D software. An easy way to test this is to manually export using the same format, and load this

exported file back into your 3D software (this totally removes HDR Light Studio from the process). If

the model looks wrong importing it back into your 3D software, then then there is an issue with the

exporter, and this is why it also looks wrong inside HDR Light Studio’s Render View.

Camera view does not match

If there is no camera in your scene when exporting, HDR Light Studio will look at the scene through a

default camera (called LiveLight-Persp), and this will not match your 3D software.

If exporting ‘selected’ items only, make sure a camera is also selected.
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If your cameras have exported and the camera view in HDR Light Studio and your 3D software does

not match - use the drop down at the top of the Render View in HDR Light Studio to select which

camera to look through – so they match.

 

If your scene is an animation, maybe the frame you are looking at does not match the frame being

shown in HDR Light Studio. Adjust the ‘Scene FPS’ in the Render View Settings in HDR Light Studio,

and then set the Frame in the Render View to match the frame in your 3D software.

Crashing on Export

If your 3D software or HDR Light Studio is crashing when exporting your scene. Try exporting the

scene manually as a file on disc from your 3D software in the same file format. If this crashes, we

know it has nothing to do with HDR Light Studio and is an issue with your 3D software’s export

process.

If the manual export is successful, try loading this exported file into HDR Light Studio manually –

using the Menu item ‘Project > Load 3D Scene File’. If there is a crash on loading this model, please

contact support@lightmap.co.uk and we can see if this is an importer bug we can fix.

The lighting from HDR Light Studio is not updating in my 3D software

Make sure you only have 1 session of HDR Light Studio running at once. HDR Light Studio and the

Connections are not designed to work with multiple sessions of HDR Light Studio running with

multiple sessions of your 3D software.

Sometimes there can be a hidden session of HDR Light Studio running, and you end up starting a

second. Please check in your equivalent of the Windows ‘Task Manager’ to close all sessions of HDR

Light Studio before starting HDR Light Studio through the connection from your 3D software.
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Another example is your 3D software not shutting down correctly from the last session. Sometimes

we have seen 3ds Max not fully closing on exit. When a second session of 3ds Max is started (the user

thinks it’s the first and only session), the HDR Light Studio connection plug-in does not function

properly.
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Troubleshooting
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Troubleshooting
· HDR Light Studio failed to start

· Bonjour not found

· Concurrency check failure

· Unlicensed Help
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HDR Light Studio failed to start

If HDR Light Studio is failing to start when pressing the start button on your connection, here are

some possible solutions:

1. Make sure you have installed the HDR Light Studio main app and not just the connection.

2. If you have installed the main HDR Light Studio app already, restart your computer and install it

again with no other software running. This sets the environment variable so that your connection

knows where to find HDR Light Studio.

3. If you get the error message 'Failed to initialise HDR Light Studio' it's because the initialisation call

to HDR Light Studio fails. This is most likely due to unsupported version mismatches. i.e. the

connection and version of HDR Light Studio main app are not compatible. To check which versions to

use together - see our PDF compatability chart here. 

4. Ensure HDR Light Studio and the Connection are allowed past your firewall.

https://s3-eu-west-1.amazonaws.com/lightmap/docs/CompatibilityChart.pdf
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Bonjour not found

You will see an error message when starting HDR Light Studio if the Bonjour service is not found.

Bonjour, developed by Apple, enables automatic discovery of devices and services on a local network

using industry standard IP protocols. We use this technology to check that other users on the same

network are not using the same HDR Light Studio license. HDR Light Studio requires an active

Bonjour service and will not start without it.

To fix the 'Bonjour not found' issue, we suggest restarting your computer and running the HDR Light

Studio installer again. This will install Bonjour on Windows computers for you. MacOS computers

have it installed by default with the operating system. If you still have issues with Bonjour and it is

installed, please contact support@lightmap.co.uk to get help.

mailto:support@lightmap.co.uk
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Cannot locate HDR Light Studio installation

directory

Error Message: Cannot locate HDR Light Studio installation directory

If you see the error message 'Cannot locate HDR Light Studio installation directory' it's because the

connection cannot find the HDR Light Studio environment variable or the dll. A reinstall of the main

HDR Light Studio application is needed (and a restart of the computer to be sure).

Concurrency check failure

HDR Light Studio licenses are not online based, with activation and deactivation functionality. Once a

HDR Light Studio node-locked license has been generated, it is stored on your computer and we can

not invalidate it. The license will work on that computer until the license expiry date in the license

file. Therefore, when transferring your license to a new computer, you can use HDR Light Studio on

both your old and new computers until the licenses expire. However, if you try to use HDR Light

Studio on both computers at the same time, you will get an error message saying "The host

'Computer X' is currently using this license."

We do not allow concurrent use of the old and new license at the same time, and this is checked for

on your local network. A node-locked license is for a single user and the license transfer should not

be abused to provide a free second license for another user. If you want 2 users to use HDR Light

Studio at the same time, please purchase a second license from our store here:

www.lightmap.co.uk/hdrlightstudio/pricing

https://www.lightmap.co.uk/hdrlightstudio/pricing/
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Unlicensed Help

You are probably looking at this page because you pressed the 'Help' button on the Licensing panel

when HDR Light Studio started in an unlicensed state. There are many reasons why this could

happen but here are the most popular reasons.

1. You have not purchased a license for the software.

It is expected the software will start unlicensed if a valid license has not been installed. The licensing

panel provides you with ways to license the software or a button to Run in Unlicensed Demo Mode.

2. You have a valid license but have started a second session of HDR Light Studio. (Error -22 All

licenses in use)

Your license allows just 1 session of HDR Light Studio to be used on your computer at a time. Please

ensure all other sessions of HDR Light Studio are closed before starting a new one. You may think

you have only one HDR Light Studio session open, but it's possible you have hidden HDR Light Studio

only, and not closed it. Pressing the close button on HDR Light Studio's interface will only hide HDR

Light Studio when used via a connection. Also, if your main 3D software crashed this may leave a

hidden session of HDR Light Studio running - you can check this in your task manager on Windows,

for example, and close HDR Light Studio from there. Also, be sure to start HDR Light Studio via the

connection 'Start' button, a connection will not connect to an already open session of HDR Light

Studio.

3. The license has expired

Most licenses for HDR Light Studio that we sell last for 1 year. If HDR Light Studio starts unlicensed

and your license was working fine on that computer some time ago, then perhaps the license has

expired. Please check your HDR Light Studio order to confirm the type of license purchased - a

Subscription license lasts for 1 year, after this, you buy another one.

4. You have changed your hardware

The HDR Light Studio license is tied to the mac address of your computer. If you have changed your

motherboard, this Mac address will change and the license will no longer enable HDR Light Studio. If

this is the case, you can transfer your node-locked license to the new computer using this web page:

www.lightmap.co.uk/support/licensing/license-transfer

5. Your license is for an older version of HDR Light Studio/Connection

For customers using permanent licenses of HDR Light Studio/Connections, each license contains a

maintenance date. You can run all releases of HDR Light Studio with build dates up to your

https://www.lightmap.co.uk/support/licensing/license-transfer/
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maintenance date. If you try to install and run a newer version of HDR Light Studio than your

maintenance date, the software will not be licensed. To fix this issue, please install an older build of

HDR Light Studio, with a build date before your license's maintenance date. You can check the

history of releases and build dates on the Compatibility Chart page. Or you can check and renew

your maintenance here: www.lightmap.co.uk/account/maintenance

If the above has not solved your problem, please get in touch with support@lightmap.co.uk to help

you.

https://www.lightmap.co.uk/account/maintenance/
mailto:support@lightmap.co.uk
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Legal Information
· End User License Agreement

· Bonjour License

· OpenEXR Copyright

· OpenImageIO Copyright

· OpenColorIO Copywright

· openssl license

· tbb license

· Embree License

· zlib copyright

· zmq license

· Pystring Copyright

· TinyXML License

· yaml-cpp Copyright

· PTEX Copyright

· Little CMS Copyright

· MD5 Copyright

· argparse Copyright

· Boost License

· tiff copyright

· jpeg turbo credit

· png copyright

· Alembic License

· Intel Threading Building Blocks License

· Perlin Simplex Noise C++ Implementation

· HEIF License

· DE265 License
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End User License Agreement

END USER LICENSE AGREEMENT

IMPORTANT NOTICE: BY INSTALLING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE READ

THIS AGREEMENT, UNDERSTAND IT AND YOU AND YOUR EMPLOYEES AGREE TO BE BOUND BY ITS

TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT WE ARE

UNWILLING TO LICENSE THE SOFTWARE TO YOU AND YOU MUST NOT INSTALL, COPY OR USE THE

SOFTWARE.

This END USER LICENSE AGREEMENT (this "Agreement") is made by and between you, as either an

individual or a single entity ("Licensee" or "you") and Lightmap Limited, a company registered in

England and Wales (No. 6879016), ("Licensor" or "we"). In consideration of the mutual covenants

contained herein and for other good and valuable consideration (the receipt and sufficiency of which

is acknowledged by each party hereto) the parties agree as follows:

1. GRANT OF LICENSE

Subject to the limitations of Section 2, the Licensor hereby grants to you a limited, non-transferable

and non-exclusive license to install and use a machine readable, object code version of this software

program (the "Software"), for the period of time allowed by your License Key, and the accompanying

documentation (the "Documentation") solely for your own business purposes (collectively, the

"License"); provided, however, your right to install and use the Software and the Documentation is

limited to those rights expressly set out in this Agreement.

2. RESTRICTIONS ON USE

2.1 You undertake: (i) not to gift, share, offer for sale, sell or provide to any third party any image

outputs created using the Software (‘output’). The output is for your internal use only. (ii) not to gift,

share, offer for sale, sell or provide to any third party any services involving the provision of output

only.

2.2 You shall not share, rent, sell, lease, sublicense, assign, loan, transfer, pledge or export the

Software, the Documentation or your rights hereunder.

2.3 You shall not modify, adapt, merge, vary, translate or create derivative works based on the

Software and Documentation.
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2.4 You shall not (and shall not permit any third party to) alter or circumvent the license

protection mechanisms in the Software or reverse engineer, decompile, disassemble or otherwise

attempt to discover the source code of the Software.

2.5 You shall not make alterations to, or modifications of, the whole or any part of the Software,

nor permit the Software or any part of it to be combined with, or become incorporated in, any other

programs.

2.6 You shall not disassemble, decompile, reverse engineer or create derivative works based on,

the whole or any part of the Software nor attempt to do any such thing except to the extent that (by

virtue of section 296A of the Copyright, Designs and Patents Act 1988) such actions cannot be

prohibited because they are essential for the purpose of achieving interoperability of the Software

with another software program, and provided that the information obtained by you during such

activities: 

a. is used only for the purpose of achieving interoperability of the Software with another software

program; and

b. is not unnecessarily disclosed or communicated without the Licensor's prior written consent to

any third party; and

c. is not used to create any software that is substantially similar to the Software.

2.7 You shall not allow or permit anyone (other than you and your authorised employees) to use

or have access to the Software or Documentation.

2.8 You shall not take any action, or fail to take action, that could adversely affect the trademarks,

patents, copyrights or other intellectual property rights of the Licensor or any third party with

intellectual property rights in the Software (each, a "Third Party Licensor"). Furthermore, for

purposes of this Section 2, the term "Software" shall include any derivatives of the Software.

2.9 You shall not use the Software by means of remote terminal access over a communications

network.

2.10 You agree to supervise and control the use of the Software and where applicable ensure that

the Software is used by your employees and representatives in accordance with the terms of this

License.
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2.11 If the Software is used without a License Key, the output will be watermarked and in this

mode you may only use the Software for the purpose of evaluation and for no other purpose. In this

mode you agree not to use the Software for commercial, professional or for-profit purposes.

2.12 Expired licenses. If the Software is used with a License Key that has expired (that is to say

ceased to function after a particular date), the output will be watermarked and in this mode you may

only use the Software for the purpose of evaluation and for no other purpose. In this mode you

agree not to use the Software for commercial, professional or for-profit purposes.

2.13 Educational licenses. If the License Type is "EDU" you may only use the Software for the

purposes of learning and/or teaching and for no other purpose. In this mode you agree not to use

the Software for commercial, professional or for-profit purposes, and you agree that the number of

concurrent users of the Software does not exceed the total number of licenses granted to you.

2.14 Beta licenses. If the License Type is "beta" you may only use the Software for the purpose of

testing and for no other purpose, and you agree that the number of concurrent users of the Software

does not exceed the total number of licenses granted to you.

2.15 NFR (Not For Resale) licenses. If the License Type is "nfr" you may only use the Software for

the purposes of demonstration, learning, training and evaluation and for no other purpose. In this

mode you agree not to use the Software for commercial, professional or for-profit purposes, and you

agree that the number of concurrent users of the Software does not exceed the total number of

licenses granted to you. 

2.16 Commercial licenses. If the License Type is "commercial" you agree that the number of

concurrent users of the Software does not exceed the total number of licenses purchased by you.

2.17 Pro licenses. If the License Type is "pro" you agree that the number of concurrent users of

the Software does not exceed the total number of licenses purchased by you.

2.18 Automotive licenses. If the License Type is "automotive" you agree that the number of

concurrent users of the Software does not exceed the total number of licenses purchased by you.

2.19 Indie licenses. The pricing applicable to Indie Licenses is only available to those individuals

or organizations (the ‘Indie User’) where: (i) such Indie User and its affiliates and related individuals

collectively have revenues not exceeding US$100,000 during the prior, or current, fiscal year. (ii) in

the case of an Indie User that is sharing Software project files with a third party that will use the

project files in connection with a Commercial activity, such third party and its Affiliates and related

individuals collectively have revenues not exceeding US$100,000 during the prior, or current, fiscal

year, directly or indirectly. If the licensee is taking advantage of the pricing applicable to Indie

Licenses, the Licensee represents and warrants that they satisfy these criteria.
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Only one (concurrent) Indie license purchase is permitted per individual/organization.

If the License Type is "indie" you can use the software for Commercial purposes, subject to the

revenue limitations above, and you agree that the number of concurrent users of the Software does

not exceed the total number of licenses purchased by you.

3. BACKUP COPIES

3.1 You are permitted to make one copy of the Software in order to provide a back-up in the

event of destruction by flood, fire, acts of war, acts of nature, or other incident. In no event may the

Licensee use the backup-up copy of the Software or Documentation to circumvent the usage or other

restrictions set forth in this Agreement.

3.2 You must include the copyright notice of the Licensor on all entire or partial copies of the

Software.

3.3 You agree to keep all copies of the Software reasonably secure.

4. CONSENT TO USE OF DATA

You agree that the Licensor may collect, process and store software usage data. Data is anonymous,

unless the software is used with a License Key, whereby license key data is transmitted, which does

not contain personally identifiable information, but can be cross referenced to identify a user for

license compliance checks. As a result of collecting this data, the IP address from where data

originates is recorded as part of the communication protocol.

5. INSPECTION

You shall advise the Licensor, on demand, of all locations where the Software or Documentation is

used or stored. You shall permit the Licensor, or its authorised representatives, at all reasonable

times and on reasonable advance notice to have access to any premises at which the Software or the

Documentation is being kept or used and to inspect the computer equipment and any records kept

there pursuant to this License, for the purpose of ensuring that you are complying with the terms of

this License. If any inspection discloses a breach of this Agreement, the Licensor reserves the right to

immediately terminate this Agreement and/or recover damages, attorney's fees, and costs.

6. OWNERSHIP
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6.1 You acknowledge that all intellectual property rights in the Software and the Documentation

anywhere in the world belong to the Licensor and the Third Party Licensors, that rights in the

Software are licensed (not sold) to you, and that you have no rights in, or to, the Software or the

Documentation other than the right to use them in accordance with the terms of this License.

6.2 The Software contains technical protection measures to defend the intellectual property

rights, including copyright, and to manage the use of the Software in accordance with this License.

You agree not to circumvent or remove, or attempt in any way to circumvent or remove, the technical

protection measures in the Software.

6.3 You shall not remove, or allow the removal of, any copyright or other proprietary rights notice

included in and on the Software or Documentation or take any other action that could adversely

affect the property rights of the Licensor or any Third Party Licensor.

7. LIMITED WARRANTY

7.1 The Licensor warrants that:

a. for a period of ninety (90) days from the date of purchase ("Warranty Period") the Software will,

when properly used, perform substantially in accordance with the functions described in the

Documentation;

b. it has tested the Software for viruses using commercially available virus checking software,

consistent with current industry practice.

7.2 You acknowledge that the Software has not been developed to meet your individual

requirements, and that it is therefore your responsibility to ensure that the facilities and functions of

the Software as described in the Documentation meet your requirements.

7.3 You acknowledge that the Software may not be free of bugs or errors, and agree that the

existence of minor errors shall not constitute a breach of this License.

7.4 Except as warranted, the Software and Documentation is being provided "as is." THE

FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS

OR IMPLIED, AND THE LICENSOR DISCLAIMS ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS,

INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF TITLE, NON-INFRINGEMENT,

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, REGARDLESS OF WHETHER THE

LICENSOR KNOWS OR HAS REASON TO KNOW OF LICENSEE'S PARTICULAR NEEDS.

8. LIMITED REMEDY
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The Licensor's entire liability and your exclusive remedy during the Warranty Period as provided in

Section 7 ("Limited Warranty") will be, at the Licensor's option, to attempt to correct or work around

errors, to replace the defective media on which the Software is provided, if any, or to refund the

license fees and terminate this Agreement.

9. LIMITED LIABILITY

9.1 Nothing in this License shall exclude or in any way limit the Licensor's liability for fraud, or for

death or personal injury caused by its negligence, or any other liability to the extent that it may not

be excluded or limited as a matter of law.

9.2 The Licensor shall not be liable under, or in connection with, this License or any collateral

contract for any of the following types of losses whether caused by tort (including negligence),

breach of contract or otherwise: 

a. loss of income;

b. loss of business profits or contracts;

c. business interruption;

d. cost of procurement of substitute goods or services;

e. loss of the use of money or anticipated savings;

f. loss of information;

g. loss of opportunity, goodwill or reputation;

h. loss of, damage to or corruption of data; or

i. any indirect or consequential loss or damage of any kind howsoever.

9.3 No action arising out of or related to this Agreement, regardless of form, may be brought by

you more than one (1) year after your initial receipt of the Software; provided, however, to the extent

such one (1) year limit may not be valid under applicable law, then such period shall be limited to the

shortest period allowed by law.
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9.4 The Licensor's maximum aggregate liability under or in connection with this License, or any

collateral contract, whether in contract, tort (including negligence) or otherwise, shall not exceed the

License fee paid by you.

9.5 The Licensor's liability for infringement of third-party intellectual property rights shall be

limited to breaches of rights subsisting in the United Kingdom.

10. TERMINATION

10.1 The Licensor may terminate this License immediately if you are in breach of this Agreement.

10.2 Upon termination:

a. all rights granted to you under this License shall cease; and

b. you must cease all activities authorised by this License; and

c. you must immediately pay to the Licensor any sums due to the Licensor under this License; and

d. you must immediately delete or remove the Software from all computer equipment on which it

was installed, and immediately destroy or return to the Licensor (at the Licensor's option) all copies

of the Software and Documentation then in your possession, custody or control and, in the case of

destruction, certify to the Licensor that you have done so.

11. TRANSFER OF RIGHTS AND OBLIGATIONS

11.1 This License is binding on you and us, and on our respective successors and assigns. 

11.2 You may not transfer, assign, charge or otherwise dispose of this License, or any of your

rights or obligations arising under it, without our prior written consent.

11.3 The Licensor may transfer, assign, charge, sub-contract or otherwise dispose of this License,

or any of the Licensor's rights or obligations arising under it, at any time during the term of the

License.

12. CANCELLATION
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You have no right to cancel your order and receive a refund once the Licensor has issued a License

Key to you.

13. WAIVER

13.1 If the Licensor fails, at any time during the term of this License, to insist upon strict

performance of any of your obligations under this License, or if the Licensor fails to exercise any of

the rights or remedies to which the Licensor is entitled under this License, this shall not constitute a

waiver of such rights or remedies and shall not relieve you from compliance with such obligations.

13.2 A waiver by the Licensor of any default shall not constitute a waiver of any subsequent

default.

13.3 No waiver by the Licensor of any of these terms and conditions shall be effective unless it is

expressly stated to be a waiver and is communicated to you in writing.

14. SEVERABILITY

If any of the terms of this License are determined by any competent authority to be invalid, unlawful

or unenforceable to any extent, such term, condition or provision will to that extent be severed from

the remaining terms, conditions and provisions which will continue to be valid to the fullest extent

permitted by law.

15. CONFIDENTIALITY

You agree that the Software and Documentation are confidential and proprietary information of the

Licensor. You agree that you will respect and preserve the confidentiality of all such information and

any communications relating thereto (collectively, "Confidential Information"). You shall disclose

Confidential Information only to your employees who have a "need to know" such Confidential

Information, and shall advise any recipients of Confidential Information that it is to be used only as

authorized in this Agreement. You shall not, without the prior written consent of the Licensor,

disclose Confidential Information or otherwise make any Confidential Information available to any

other employees of the Licensee or to any third parties. You shall take reasonable security measures

to hold the Software, Documentation and Confidential Information in strict confidence and safe

custody. You acknowledge that monetary damages may not be a sufficient remedy for unauthorized

disclosure of Confidential Information, and that the Licensor shall be entitled, without waiving any

other rights or remedies, to such injunctive or equitable relief as may be deemed proper by a court

of competent jurisdiction.

16. ENTIRE AGREEMENT
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16.1 This License and any document expressly referred to in it represents the entire agreement

between us in relation to the licensing of the Software and Documentation and supersedes any prior

agreement, understanding or arrangement between us, whether oral or in writing.

16.2 We each acknowledge that, in entering into this License, neither of us has relied on any

representation, undertaking or promise given by the other or be implied from anything said or

written in negotiations between us prior to entering into this License except as expressly stated in

this License.

16.3 Neither of us shall have any remedy in respect of any untrue statement made by the other,

whether orally or in writing, prior to the date we entered into this License (unless such untrue

statement was made fraudulently) and the other party's only remedy shall be for breach of contract

as provided in these terms and conditions.

17. LAW AND JURISDICTION

This License, its subject matter or its formation (including non-contractual disputes or claims) shall

be governed by and construed in accordance with English law and submitted to the non-exclusive

jurisdiction of the English courts. 

Appendix A

DEFINITIONS

"License Key" means a human readable code that unlocks features of the Software and defines the

use by which the Licensee shall use the Software. The License Key can be stored in a license file

locally or on a remote computer.

"License Type" means the type of usage for the Licensee's licensed use of the Software (e.g. indie,

pro, automotive, commercial, educational, not for resale, etc). The License Type may be located in (a)

the Software (e.g. in a license information dialog box); or (b) the contract field of the License Key; or

(c) obtained from the Licensor on request.

EULA 1 May 2019
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Bonjour License

HDR Light Studio uses ‘Bonjour for Windows’ on Windows OS only. Bonjour for Windows is

distributed by Lightmap Ltd with the following EULA. This additional EULA section is not

applicable for MacOSX or LinuxOS installations.

APPLE INC.

SOFTWARE LICENSE AGREEMENT FOR BONJOUR FOR WINDOWS.

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE USING THE

APPLE SOFTWARE. BY USING THE APPLE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE

TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT INSTALL

AND/OR USE THE SOFTWARE. IF THE APPLE SOFTWARE WAS ACCESSED ELECTRONICALLY, CLICK

"DISAGREE/DECLINE" AND DO NOT INSTALL OR USE IT.

IMPORTANT NOTE: This software may be used to reproduce materials. It is licensed to you only for

reproduction of non-copyrighted materials, materials in which you own the copyright, or materials

you are authorized or legally permitted to reproduce. If you are uncertain about your right to copy

any material, you should contact your legal advisor.

1. General. The software, documentation and any fonts accompanying this License whether on disk,

in read only memory, on any other media or in any other form (collectively the "Apple Software") are

licensed, not sold, to you by Apple Inc. ("Apple") for use only under the terms of this License, and

Apple reserves all rights not expressly granted to you. You own the media on which the Apple

Software is recorded but Apple and/or Apple's licensor(s) retain ownership of the Apple Software

itself. The terms of this License will govern any software upgrades provided by Apple that replace

and/or supplement the original Apple Software product, unless such upgrade is accompanied by a

separate license in which case the terms of that license will govern. Title and intellectual property

rights in and to any content displayed by, or accessed through, the Apple Software belongs to the

respective content owner. Such content may be protected by copyright or other intellectual property

laws and treaties, and may be subject to terms of use of the third party providing such content. This

License does not grant you any rights to use such content.

2. Permitted License Uses and Restrictions.

(a) Subject to the terms and conditions of this License, you are granted a limited non-exclusive

license to install and use a reasonable number of copies of the Apple Software on computers that are

owned or controlled by you for use internally by your employees whose job duties require the use of
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the Apple Software or for use on your personal home computer(s). No other use and no external

redistribution of the Apple Software are permitted.

(b) Certain components of the Apple Software, and third party open source programs included with

the Apple Software, have been or may be made available by Apple on its Open Source web site

(<http://www.opensource.apple.com/>) (collectively the "Open-Sourced Components"). You may

modify or replace only these Open-Sourced Components; provided that: (i) the resultant modified

Apple Software is used, in place of the unmodified Apple Software, on a single Apple-branded

computer; and (ii) you otherwise comply with the terms of this License and any applicable licensing

terms governing use of the Open-Sourced Components. Apple is not obligated to provide any

updates, maintenance, warranty, technical or other support, or services for the resultant modified

Apple Software.

(c) You may make one copy of the Apple Software in machine-readable form for backup purposes

only; provided that the backup copy must include all copyright or other proprietary notices

contained on the original.

(d) You may not and you agree not to, or to enable others to, copy (except as expressly permitted by

this License), decompile, reverse engineer, disassemble, attempt to derive the source code of,

decrypt, modify, or create derivative works of the Apple Software or any services provided by the

Apple Software, or any part thereof (except as and only to the extent any foregoing restriction is

prohibited by applicable law or to the extent as may be permitted by licensing terms governing use

of the open-sourced components included with the Apple Software). Any attempt to do so is a

violation of the rights of Apple and its licensors of the Apple Software.
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3. Transfer. You may not rent, lease, lend, sell, redistribute or sublicense the Apple Software. Subject

to the restrictions set forth below, you may, however, make a one-time permanent transfer of all of

your license rights to the Apple Software (in its original form as provided by Apple) to another party,

provided that: (a) the transfer must include all of the Apple Software, including all its component

parts, original media, printed materials and this License; (b) you do not retain any copies of the Apple

Software, full or partial, including copies stored on a computer or other storage device; and (c) the

party receiving the Apple Software reads and agrees to accept the terms and conditions of this

License. You may not rent, lease, lend, sell, redistribute, sublicense or transfer any Apple Software

that has been modified or replaced under Section 2(b) above. All components of the Apple Software

are provided as part of a bundle and may not be separated from the bundle and distributed as

standalone applications. NFR (Not for Resale) Copies: Notwithstanding other sections of this License,

Apple Software labeled or otherwise provided to you on a promotional basis may only be used for

demonstration, testing and evaluation purposes and may not be resold or transferred.

4. Consent to Use of Data. You agree that Apple and its subsidiaries and agents may collect,

maintain, process and use diagnostic, technical and related information, including but not limited to

information about your computer, system and application software, and peripherals, that is

gathered periodically to facilitate the provision of software updates, product support and other

services to you (if any) related to the Apple Software, and to verify compliance with the terms of this

License. Apple may use this information, as long as it is in a form that does not personally identify

you, to improve our products or to provide services or technologies to you.

5. Termination. This License is effective until terminated. Your rights under this License will terminate

automatically or otherwise cease to be effective without notice from Apple if you fail to comply with

any term(s) of this License. Upon the termination of this License, you shall cease all use of the Apple

Software and destroy all copies, full or partial, of the Apple Software. Sections 6, 7, 10, and 11 of this

License shall survive any such termination.

6. Disclaimer of Warranties.

6.1 If you are a customer who is a consumer (someone who uses the Apple Software outside of your

trade, business or profession), you may have legal rights in your country of residence which would

prohibit the following limitations from applying to you, and where prohibited they will not apply to

you. To find out more about rights, you should contact a local consumer advice organization.

6.2 YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT, TO THE EXTENT PERMITTED BY APPLICABLE

LAW, USE OF THE APPLE SOFTWARE IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO

SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU.
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6.3 TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE APPLE SOFTWARE IS PROVIDED

"AS IS", WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND APPLE AND APPLE'S

LICENSORS (COLLECTIVELY REFERRED TO AS "APPLE" FOR THE PURPOSES OF SECTIONS 6 AND 7)

HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE APPLE SOFTWARE,

EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS

FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT OF

THIRD PARTY RIGHTS.

6.4 APPLE DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE APPLE

SOFTWARE, THAT THE FUNCTIONS CONTAINED IN THE APPLE SOFTWARE WILL MEET YOUR

REQUIREMENTS, THAT THE OPERATION OF THE APPLE SOFTWARE WILL BE UNINTERRUPTED OR

ERROR-FREE, OR THAT DEFECTS IN THE APPLE SOFTWARE WILL BE CORRECTED.

6.5 YOU FURTHER ACKNOWLEDGE THAT THE APPLE SOFTWARE IS NOT INTENDED OR SUITABLE FOR

USE IN SITUATIONS OR ENVIRONMENTS WHERE THE FAILURE OF, OR ERRORS OR INACCURACIES IN

THE CONTENT, DATA OR INFORMATION PROVIDED BY, THE APPLE SOFTWARE COULD LEAD TO

DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE, INCLUDING

WITHOUT LIMITATION THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR

COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, LIFE SUPPORT OR WEAPONS SYSTEMS.

6.6 NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE OR AN APPLE AUTHORIZED

REPRESENTATIVE SHALL CREATE A WARRANTY. SHOULD THE APPLE SOFTWARE PROVE DEFECTIVE,

YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME

JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON

APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS

MAY NOT APPLY TO YOU.

7. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY APPLICABLE LAW, IN NO EVENT SHALL

APPLE BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR

CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS

OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR

LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE APPLE SOFTWARE,

HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE)

AND EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME

JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF

INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In no

event shall Apple's total liability to you for all damages (other than as may be required by applicable

law in cases involving personal injury) exceed the amount of fifty dollars ($50.00). The foregoing

limitations will apply even if the above stated remedy fails of its essential purpose.
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8. Export Control. You may not use or otherwise export or re-export the Apple Software except as

authorized by United States law and the laws of the jurisdiction in which the Apple Software was

obtained. In particular, but without limitation, the Apple Software may not be exported or re-

exported (a) into any U.S. embargoed countries or (b) to anyone on the U.S. Treasury Department's

list of Specially Designated Nationals or the U.S. Department of Commerce Denied Person’s List or

Entity List. By using the Apple Software, you represent and warrant that you are not located in any

such country or on any such list. You also agree that you will not use these products for any

purposes prohibited by United States law, including, without limitation, the development, design,

manufacture or production of nuclear, chemical or biological weapons.

9. Government End Users. The Apple Software and related documentation are "Commercial Items",

as that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer Software" and

"Commercial Computer Software Documentation", as such terms are used in 48 C.F.R. §12.212 or 48

C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §227.7202-1 through

227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software

Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and

(b) with only those rights as are granted to all other end users pursuant to the terms and conditions

herein. Unpublished-rights reserved under the copyright laws of the United States.

10. Controlling Law and Severability. This License will be governed by and construed in accordance

with the laws of the State of California, excluding its conflict of law principles. This License shall not

be governed by the United Nations Convention on Contracts for the International Sale of Goods, the

application of which is expressly excluded. If you are a consumer based in the European Union, this

License will be governed by the laws of the jurisdiction of your residence and you may make a claim

in the courts of the country where you reside. If for any reason a court of competent jurisdiction

finds any provision, or portion thereof, to be unenforceable, the remainder of this License shall

continue in full force and effect.

11. Complete Agreement; Governing Language. This License constitutes the entire agreement

between you and Apple relating to the use of the Apple Software and supersedes all prior or

contemporaneous understandings regarding such subject matter. No amendment to or modification

of this License will be binding unless in writing and signed by Apple. Any translation of this License is

done for local requirements and in the event of a dispute between the English and any non-English

versions, the English version of this License shall govern to the extent not prohibited by local law in

your jurisdiction.
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OpenEXR Copyright

Copyright Contributors to the OpenEXR Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and

the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to endorse

or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OpenImageIO Copyright

Copyright (c) 2008-present by Contributors to the OpenImageIO project. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and

the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to endorse

or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OpenColorIO Copywright

Copyright Contributors to the OpenColorIO Project.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution.

* Neither the name of the copyright holder nor the names of its contributors may be used to endorse

or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



1357

1357Legal Information

openssl license

Apache License

Version 2.0, January 2004

https://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by

Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is

granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are

controlled by, or are under common control with that entity. For the purposes of this definition,

"control" means (i) the power, direct or indirect, to cause the direction or management of such entity,

whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding

shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this

License.

"Source" form shall mean the preferred form for making modifications, including but not limited to

software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a

Source form, including but not limited to compiled object code, generated documentation, and

conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under

the License, as indicated by a copyright notice that is included in or attached to the work (an example

is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or

derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
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modifications represent, as a whole, an original work of authorship. For the purposes of this License,

Derivative Works shall not include works that remain separable from, or merely link (or bind by

name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any

modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to

Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity

authorized to submit on behalf of the copyright owner. For the purposes of this definition,

"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or

its representatives, including but not limited to communication on electronic mailing lists, source

code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor

for the purpose of discussing and improving the Work, but excluding communication that is

conspicuously marked or otherwise designated in writing by the copyright owner as "Not a

Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a

Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,

sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

(except as stated in this section) patent license to make, have made, use, offer to sell, sell, import,

and otherwise transfer the Work, where such license applies only to those patent claims licensable

by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of

their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute

patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that

the Work or a Contribution incorporated within the Work constitutes direct or contributory patent

infringement, then any patent licenses granted to You under this License for that Work shall

terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof

in any medium, with or without modifications, and in Source or Object form, provided that You meet

the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
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(b) You must cause any modified files to carry prominent notices stating that You changed the files;

and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those notices

that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that

You distribute must include a readable copy of the attribution notices contained within such NOTICE

file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of

the following places: within a NOTICE text file distributed as part of the Derivative Works; within the

Source form or documentation, if provided along with the Derivative Works; or, within a display

generated by the Derivative Works, if and wherever such third-party notices normally appear. The

contents of the NOTICE file are for informational purposes only and do not modify the License. You

may add Your own attribution notices within Derivative Works that You distribute, alongside or as an

addendum to the NOTICE text from the Work, provided that such additional attribution notices

cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the

Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally

submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions

of this License, without any additional terms or conditions. Notwithstanding the above, nothing

herein shall supersede or modify the terms of any separate license agreement you may have

executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service

marks, or product names of the Licensor, except as required for reasonable and customary use in

describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor

provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT

WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,

any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A

PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or

redistributing the Work and assume any risks associated with Your exercise of permissions under

this License.
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8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),

contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent

acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,

indirect, special, incidental, or consequential damages of any character arising as a result of this

License or out of the use or inability to use the Work (including but not limited to damages for loss of

goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages

or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,

or other liability obligations and/or rights consistent with this License. However, in accepting such

obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of

any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor

harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your

accepting any such warranty or additional liability.
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tbb license

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by

Sections 1 through 9 of this document.

 "Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is

granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are

controlled by, or are under common control with that entity. For the purposes of this

definition,"control" means (i) the power, direct or indirect, to cause the direction or management of

such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the

outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this

License.

"Source" form shall mean the preferred form for making modifications, including but not limited to

software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a

Source form, including but not limited to compiled object code, generated documentation, and

conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under

the License, as indicated by a copyright notice that is included in or attached to the work (an example

is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or

derived from) the Work and for which the editorial revisions, annotations, elaborations, or other

modifications represent, as a whole, an original work of authorship. For the purposes of this License,
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Derivative Works shall not include works that remain separable from, or merely link (or bind by

name) to the interfaces of, the Work and Derivative Works thereof.

 "Contribution" shall mean any work of authorship, including the original version of the Work and any

modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to

Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity

authorized to submit on behalf of the copyright owner. For the purposes of this definition,

"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or

its representatives, including but not limited to communication on electronic mailing lists, source

code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor

for the purpose of discussing and improving the Work, but excluding communication that is

conspicuously marked or otherwise designated in writing by the copyright owner as "Not a

Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a

Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,

sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

(except as stated in this section) patent license to make, have made, use, offer to sell, sell, import,

and otherwise transfer the Work, where such license applies only to those patent claims licensable

by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of

their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute

patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that

the Work or a Contribution incorporated within the Work constitutes direct or contributory patent

infringement, then any patent licenses granted to You under this License for that Work shall

terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof

in any medium, with or without modifications, and in Source or Object form, provided that You meet

the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files;

and
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(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those notices

that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that

You distribute must include a readable copy of the attribution notices contained within such NOTICE

file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of

the following places: within a NOTICE text file distributed as part of the Derivative Works; within the

Source form or documentation, if provided along with the Derivative Works; or,  within a display

generated by the Derivative Works, if and wherever such third-party notices normally appear. The

contents of the NOTICE file are for informational purposes only and do not modify the License. You

may add Your own attribution notices within Derivative Works that You distribute, alongside or as an

addendum to the NOTICE text from the Work, provided that such additional attribution notices

cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the

Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally

submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions

of this License, without any additional terms or conditions. Notwithstanding the above, nothing

herein shall supersede or modify the terms of any separate license agreement you may have

executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service

marks, or product names of the Licensor, except as required for reasonable and customary use in

describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor

provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT

WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,

any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A

PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or

redistributing the Work and assume any risks associated with Your exercise of permissions under

this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),

contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent

acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
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indirect, special, incidental, or consequential damages of any character arising as a result of this

License or out of the use or inability to use the Work (including but not limited to damages for loss of

goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages

or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,

or other liability obligations and/or rights consistent with this License. However, in accepting such

obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of

any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor

harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your

accepting any such warranty or additional liability.
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Embree License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by

Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is

granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are

controlled by, or are under common control with that entity. For the purposes of this definition,

"control" means (i) the power, direct or indirect, to cause the direction or management of such entity,

whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding

shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this

License.

"Source" form shall mean the preferred form for making modifications, including but not limited to

software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a

Source form, including but not limited to compiled object code, generated documentation, and

conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under

the License, as indicated by a copyright notice that is included in or attached to the work (an example

is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or

derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
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modifications represent, as a whole, an original work of authorship. For the purposes of this License,

Derivative Works shall not include works that remain separable from, or merely link (or bind by

name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any

modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to

Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity

authorized to submit on behalf of the copyright owner. For the purposes of this definition,

"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or

its representatives, including but not limited to communication on electronic mailing lists, source

code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor

for the purpose of discussing and improving the Work, but excluding communication that is

conspicuously marked or otherwise designated in writing by the copyright owner as "Not a

Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a

Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,

sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

(except as stated in this section) patent license to make, have made, use, offer to sell, sell, import,

and otherwise transfer the Work, where such license applies only to those patent claims licensable

by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of

their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute

patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that

the Work or a Contribution incorporated within the Work constitutes direct or contributory patent

infringement, then any patent licenses granted to You under this License for that Work shall

terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof

in any medium, with or without modifications, and in Source or Object form, provided that You meet

the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
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(b) You must cause any modified files to carry prominent notices stating that You changed the files;

and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those notices

that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that

You distribute must include a readable copy of the attribution notices contained within such NOTICE

file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of

the following places: within a NOTICE text file distributed as part of the Derivative Works; within the

Source form or documentation, if provided along with the Derivative Works; or, within a display

generated by the Derivative Works, if and wherever such third-party notices normally appear. The

contents of the NOTICE file are for informational purposes only and do not modify the License. You

may add Your own attribution notices within Derivative Works that You distribute, alongside or as an

addendum to the NOTICE text from the Work, provided that such additional attribution notices

cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the

Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally

submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions

of this License, without any additional terms or conditions. Notwithstanding the above, nothing

herein shall supersede or modify the terms of any separate license agreement you may have

executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service

marks, or product names of the Licensor, except as required for reasonable and customary use in

describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor

provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT

WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,

any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A

PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or

redistributing the Work and assume any risks associated with Your exercise of permissions under

this License.



1368

1368Legal Information

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),

contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent

acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,

indirect, special, incidental, or consequential damages of any character arising as a result of this

License or out of the use or inability to use the Work (including but not limited to damages for loss of

goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages

or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,

or other liability obligations and/or rights consistent with this License. However, in accepting such

obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of

any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor

harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your

accepting any such warranty or additional liability.
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zlib copyright

Copyright notice:

(C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty.  In no event will the

authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the

original software. If you use this software in a product, an acknowledgment in the product

documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being

the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly        Mark Adler

jloup@gzip.org          madler@alumni.caltech.edu

mailto:madler@alumni.caltech.edu
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zmq license

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing

it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of

version 3 of the GNU General Public License, supplemented by the additional permissions listed

below.

0. Additional Definitions. 

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the

"GNU GPL" refers to version 3 of the GNU

General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a

Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not

otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a

mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library.  The

particular version of the Library with which the Combined Work was made is also called the "Linked

Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the

Combined Work, excluding any source code for portions of the Combined Work that, considered in

isolation, are based on the Application, and not on the Linked Version.
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The "Corresponding Application Code" for a Combined Work means the object code and/or source

code for the Application, including any data and utility programs needed for reproducing the

Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by

section 3 of the GNU GPL.

 2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to

be supplied by an Application that uses the facility (other than as an argument passed when the

facility is invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event an

Application does not supply the function or data, the facility still operates, and performs whatever

part of its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to that

copy.

3. Object Code Incorporating Material from Library Header Files. The object code form of an

Application may incorporate material from a header file that is part of the Library.  You may convey

such object code under terms of your choice, provided that, if the incorporated material is not

limited to numerical parameters, data structure layouts and accessors, or small macros, inline

functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the

Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

  4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not

restrict modification of the portions of the Library contained in the Combined Work and reverse

engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it and that

the Library and its use are covered by this License.
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b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

c) For a Combined Work that displays copyright notices during execution, include the copyright

notice for the Library among these notices, as well as a reference directing the user to the copies of

the GNU GPL and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding

Application Code in a form suitable for, and under terms that permit, the user to recombine or relink

the Application with a modified version of the Linked Version to produce a modified Combined Work,

in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library.  A suitable mechanism is one

that (a) uses at run time a copy of the Library already present on the user's computer system, and (b)

will operate properly with a modified version of the Library that is interface-compatible with the

Linked Version. 

e) Provide Installation Information, but only if you would otherwise be required to provide such

information under section 6 of the GNU GPL, and only to the extent that such information is

necessary to install and execute a modified version of the Combined Work produced by recombining

or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the

Installation Information must accompany the Minimal Corresponding Source and Corresponding

Application Code. If you use option 4d1, you must provide the Installation Information in the manner

specified by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library

together with other library facilities that are not Applications and are not covered by this License,

and convey such a combined library under terms of your choice, if you do both of the following:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined

with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the Library, and

explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.
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The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General

Public License from time to time. Such new versions will be similar in spirit to the present version,

but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a

certain numbered version of the GNU Lesser General Public License "or any later version" applies to

it, you have the option of following the terms and conditions either of that published version or of

any later version published by the Free Software Foundation. If the Library as you received it does

not specify a version number of the GNU Lesser General Public License, you may choose any version

of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU

Lesser General Public License shall apply, that proxy's public statement of acceptance of any version

is permanent authorization for you to choose that version for the Library.

--------------------------------------------------------------------------------

 SPECIAL EXCEPTION GRANTED BY COPYRIGHT HOLDERS

As a special exception, copyright holders give you permission to link this library with independent

modules to produce an executable, regardless of the license terms of these independent modules,

and to copy and distribute the resulting executable under terms of your choice, provided that you

also meet, for each linked independent module, the terms and conditions of the license of that

module. An independent module is a module which is not derived from or based on this library. If

you modify this library, you must extend this exception to your version of the library.

Note: this exception relieves you of any obligations under sections 4 and 5 of this license, and section

6 of the GNU General Public License.
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Pystring Copyright

Copyright (c) 2008-2010, Sony Pictures Imageworks Inc All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer. 

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution. 

· Neither the name of the organization Sony Pictures Imageworks nor the names of its contributors

may be used to endorse or promote products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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TinyXML License

TinyXML is released under the zlib license:

This software is provided ‘as-is’, without any express or implied warranty. In no event will the authors

be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the

original software. If you use this software in a product, an acknowledgment in the product

documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being

the original software.

3. This notice may not be removed or altered from any source distribution.
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yaml-cpp Copyright

Copyright (c) 2008 Jesse Beder.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and

associated documentation files (the “Software”), to deal in the Software without restriction, including

without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial

portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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PTEX Copyright

PTEX SOFTWARE Copyright 2009 Disney Enterprises, Inc. All rights reserved

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer. 

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution.

· The names “Disney”, “Walt Disney Pictures”, “Walt Disney Animation Studios” or the names of its

contributors may NOT be used to endorse or promote products derived from this software without

specific prior written permission from Walt Disney Pictures.

Disclaimer: THIS SOFTWARE IS PROVIDED BY WALT DISNEY PICTURES AND CONTRIBUTORS “AS IS”

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT AND

TITLE ARE DISCLAIMED. IN NO EVENT SHALL WALT DISNEY PICTURES, THE COPYRIGHT HOLDER OR

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE

GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER

CAUSED AND BASED ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Little CMS Copyright

Little CMS Copyright (c) 1998-2010 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and

associated documentation files (the “Software”), to deal in the Software without restriction, including

without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial

portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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MD5 Copyright

Copyright (C) 1999, 2002 Aladdin Enterprises. All rights reserved.

This software is provided ‘as-is’, without any express or implied warranty. In no event will the authors

be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

The origin of this software must not be misrepresented; you must not claim that you wrote the

original software. If you use this software in a product, an acknowledgment in the product

documentation would be appreciated but is not required. Altered source versions must be plainly

marked as such, and must not be misrepresented as being the original software. This notice may not

be removed or altered from any source distribution.

L. Peter Deutsch ghost@aladdin.com
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argparse Copyright

Copyright 2008 Larry Gritz and the other authors and contributors. All Rights Reserved. Based on

BSD-licensed software Copyright 2004 NVIDIA Corp.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met: 

· Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer.

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution.

· Neither the name of the software’s owners nor the names of its contributors may be used to

endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

(This is the Modified BSD License)
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Boost License

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the

software and accompanying documentation covered by this license (the "Software") to use,

reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works

of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to

the following:

The copyright notices in the Software and this entire statement, including the above license grant,

this restriction and the following disclaimer, must be included in all copies of the Software, in whole

or in part, and all derivative works of the Software, unless such copies or derivative works are solely

in the form of machine-executable object code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT

HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER

LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN

CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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tiff copyright

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any

purpose is hereby granted without fee, provided that (i) the above copyright notices and this

permission notice appear in all copies of the software and related documentation, and (ii) the names

of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the

software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR

OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS

FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,

INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING

FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,

AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR

PERFORMANCE OF THIS SOFTWARE.
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jpeg turbo credit

This software is based in part on the work of the Independent JPEG Group.
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png copyright

This code is released under the libpng license. libpng versions 1.0.7, July 1, 2000 through 1.6.26,

October 20, 2016 are Copyright (c) 2000-2002, 2004, 2006-2016 Glenn Randers-Pehrson, are derived

from libpng-1.0.6, and are distributed according to the same disclaimer and license as libpng-1.0.6

with the following individuals added to the list of Contributing Authors:

Simon-Pierre Cadieux

Eric S. Raymond

Mans Rullgard

Cosmin Truta

Gilles Vollant

James Yu

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the library or against infringement.

 There is no warranty that our efforts or the library will fulfill any of your particular purposes or

needs.  This library is provided with all faults, and the entire risk of satisfactory quality, performance,

accuracy, and effort is with the user.

Some files in the "contrib" directory and some configure-generated files that are distributed with

libpng have other copyright owners and are released under other open source licenses.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998-2000 Glenn

Randers-Pehrson, are derived from libpng-0.96, and are distributed according to the same disclaimer

and license as libpng-0.96, with the following individuals added to the list of Contributing Authors:

Tom Lane

Glenn Randers-Pehrson

Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996-1997 Andreas Dilger,

are derived from libpng-0.88, and are distributed according to the same disclaimer and license as

libpng-0.88, with the following individuals added to the list of Contributing Authors:

John Bowler

Kevin Bracey

Sam Bushell

Magnus Holmgren
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Greg Roelofs

Tom Tanner

Some files in the "scripts" directory have other copyright owners but are released under this license.

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995-1996 Guy Eric

Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the following set

of individuals:

Andreas Dilger

Dave Martindale

Guy Eric Schalnat

Paul Schmidt

Tim Wegner

The PNG Reference Library is supplied "AS IS".  The Contributing Authors and Group 42, Inc. disclaim

all warranties, expressed or implied, including, without limitation, the warranties of merchantability

and of fitness for any purpose.  The Contributing Authors and Group 42, Inc. assume no liability for

direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the

use of the PNG Reference Library, even if advised of the possibility of such damage. Permission is

hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any

purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the

original source.

3. This Copyright notice may not be removed or altered from any source or altered source

distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use

of this source code as a component to supporting the PNG file format in commercial products.  If you

use this source code in a product, acknowledgment is not required but would be appreciated.
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Alembic License

TM & © 2009-2015 Lucasfilm Entertainment Company Ltd. or Lucasfilm Ltd. All rights reserved.

Industrial Light & Magic, ILM and the Bulb and Gear design logo are all registered trademarks or

service marks of Lucasfilm Ltd.

© 2009-2015 Sony Pictures Imageworks Inc.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution.

* Neither the name of Industrial Light & Magic nor the names of its contributors may be used to

endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY

WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------------------------------

ALEMBIC ATTACHMENT A —

REQUIRED NOTICES FOR DISTRIBUTION

The Alembic Software is distributed along with certain third party  components licensed under
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various open source software licenses ("Open  Source Components"). In addition to the warranty

disclaimers contained  in the open source licenses found below, Industrial Light & Magic, a  division

of Lucasfilm Entertainment Company Ltd. ("ILM") makes the  following disclaimers regarding the

Open Source Components on behalf of  itself, the copyright holders, contributors, and licensors of

such Open  Source Components: 

TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW, THE OPEN SOURCE  COMPONENTS

ARE PROVIDED BY THE COPYRIGHT HOLDERS, CONTRIBUTORS,  LICENSORS, AND ILM "AS IS" AND

ANY REPRESENTATIONS OR WARRANTIES OF ANY  KIND, WHETHER ORAL OR WRITTEN, WHETHER

EXPRESS, IMPLIED, OR ARISING BY  STATUTE, CUSTOM, COURSE OF DEALING, OR TRADE USAGE,

INCLUDING WITHOUT  LIMITATION THE IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS

FOR  A PARTICULAR PURPOSE, AND NON-INFRINGEMENT, ARE DISCLAIMED. IN NO EVENT  WILL THE

COPYRIGHT OWNER, CONTRIBUTORS, LICENSORS, OR ILM AND/OR ITS  AFFILIATES BE LIABLE FOR

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,  EXEMPLARY, OR CONSEQUENTIAL DAMAGES

(INCLUDING, BUT NOT LIMITED TO,  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF

USE, DATA, OR  PROFITS; OR BUSINESS INTERRUPTION), HOWEVER CAUSED AND ON ANY THEORY OF

 LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING  NEGLIGENCE OR

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THE OPEN  SOURCE COMPONENTS, EVEN IF

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Boost C++ Libraries

------------------------------------------------------------------------

Boost Software License – Version 1.0 August 17th, 2003 Permission is  hereby granted, free of charge,

to any person or organization obtaining  a copy of the software and accompanying documentation

covered by this  license (the "Software") to use, reproduce, display, distribute,  execute, and transmit

the Software, and to prepare derivative works of  the Software, and to permit third-parties to whom

the Software is  furnished to do so, all subject to the following:   The copyright notices in the Software

and this entire statement,  including the above license grant, this restriction and the following 

disclaimer, must be included in all copies of the Software, in whole or  in part, and all derivative

works of the Software, unless such copies or  derivative works are solely in the form of machine-

executable object  code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS  OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF  MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE, TITLE AND  NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT

HOLDERS OR ANYONE  DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER

LIABILITY,  WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 

CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE  SOFTWARE. 
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Intel Threading Building Blocks License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by

Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is

granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are

controlled by, or are under common control with that entity. For the purposes of this definition,

"control" means (i) the power, direct or indirect, to cause the direction or management of such entity,

whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding

shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this

License.

"Source" form shall mean the preferred form for making modifications, including but not limited to

software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a

Source form, including but not limited to compiled object code, generated documentation, and

conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under

the License, as indicated by a copyright notice that is included in or attached to the work (an example

is provided in the Appendix below).
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"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or

derived from) the Work and for which the editorial revisions, annotations, elaborations, or other

modifications represent, as a whole, an original work of authorship. For the purposes of this License,

Derivative Works shall not include works that remain separable from, or merely link (or bind by

name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any

modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to

Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity

authorized to submit on behalf of the copyright owner. For the purposes of this definition,

"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or

its representatives, including but not limited to communication on electronic mailing lists, source

code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor

for the purpose of discussing and improving the Work, but excluding communication that is

conspicuously marked or otherwise designated in writing by the copyright owner as "Not a

Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a

Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,

sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor

hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable

(except as stated in this section) patent license to make, have made, use, offer to sell, sell, import,

and otherwise transfer the Work, where such license applies only to those patent claims licensable

by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of

their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute

patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that

the Work or a Contribution incorporated within the Work constitutes direct or contributory patent

infringement, then any patent licenses granted to You under this License for that Work shall

terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof

in any medium, with or without modifications, and in Source or Object form, provided that You meet

the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
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(b) You must cause any modified files to carry prominent notices stating that You changed the files;

and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those notices

that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that

You distribute must include a readable copy of the attribution notices contained within such NOTICE

file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of

the following places: within a NOTICE text file distributed as part of the Derivative Works; within the

Source form or documentation, if provided along with the Derivative Works; or, within a display

generated by the Derivative Works, if and wherever such third-party notices normally appear. The

contents of the NOTICE file are for informational purposes only and do not modify the License. You

may add Your own attribution notices within Derivative Works that You distribute, alongside or as an

addendum to the NOTICE text from the Work, provided that such additional attribution notices

cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications, or

for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the

Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally

submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions

of this License, without any additional terms or conditions. Notwithstanding the above, nothing

herein shall supersede or modify the terms of any separate license agreement you may have

executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service

marks, or product names of the Licensor, except as required for reasonable and customary use in

describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor

provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT

WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,

any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A

PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or

redistributing the Work and assume any risks associated with Your exercise of permissions under

this License.
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8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),

contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent

acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,

indirect, special, incidental, or consequential damages of any character arising as a result of this

License or out of the use or inability to use the Work (including but not limited to damages for loss of

goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages

or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works

thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,

or other liability obligations and/or rights consistent with this License. However, in accepting such

obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of

any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor

harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your

accepting any such warranty or additional liability.
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Perlin Simplex Noise C++ Implementation

Perlin Simplex Noise C++ Implementation

https://github.com/SRombauts/

The MIT License (MIT)

Copyright (c) 2012-2018 Sebastien Rombauts (sebastien.rombauts@gmail.com)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and

associated documentation files (the "Software"), to deal in the Software without restriction, including

without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial

portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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HEIF License

High Efficiency Image File Format (Apple use this for saving images as it’s better than JPeg for lossy

compression)

Source from: https://github.com/strukturag/libheif

                   GNU LESSER GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

  This version of the GNU Lesser General Public License incorporates

the terms and conditions of version 3 of the GNU General Public

License, supplemented by the additional permissions listed below.

  0. Additional Definitions.

  As used herein, "this License" refers to version 3 of the GNU Lesser

https://github.com/strukturag/libheif
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General Public License, and the "GNU GPL" refers to version 3 of the GNU

General Public License.

  "The Library" refers to a covered work governed by this License,

other than an Application or a Combined Work as defined below.

  An "Application" is any work that makes use of an interface provided

by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode

of using an interface provided by the Library.

  A "Combined Work" is a work produced by combining or linking an

Application with the Library.  The particular version of the Library

with which the Combined Work was made is also called the "Linked

Version".

  The "Minimal Corresponding Source" for a Combined Work means the

Corresponding Source for the Combined Work, excluding any source code

for portions of the Combined Work that, considered in isolation, are
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based on the Application, and not on the Linked Version.

  The "Corresponding Application Code" for a Combined Work means the

object code and/or source code for the Application, including any data

and utility programs needed for reproducing the Combined Work from the

Application, but excluding the System Libraries of the Combined Work.

  1. Exception to Section 3 of the GNU GPL.

  You may convey a covered work under sections 3 and 4 of this License

without being bound by section 3 of the GNU GPL.

  2. Conveying Modified Versions.

  If you modify a copy of the Library, and, in your modifications, a

facility refers to a function or data to be supplied by an Application

that uses the facility (other than as an argument passed when the

facility is invoked), then you may convey a copy of the modified

version:
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   a) under this License, provided that you make a good faith effort to

   ensure that, in the event an Application does not supply the

   function or data, the facility still operates, and performs

   whatever part of its purpose remains meaningful, or

   b) under the GNU GPL, with none of the additional permissions of

   this License applicable to that copy.

  3. Object Code Incorporating Material from Library Header Files.

  The object code form of an Application may incorporate material from

a header file that is part of the Library.  You may convey such object

code under terms of your choice, provided that, if the incorporated

material is not limited to numerical parameters, data structure

layouts and accessors, or small macros, inline functions and templates

(ten or fewer lines in length), you do both of the following:

   a) Give prominent notice with each copy of the object code that the
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   Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the object code with a copy of the GNU GPL and this license

   document.

  4. Combined Works.

  You may convey a Combined Work under terms of your choice that,

taken together, effectively do not restrict modification of the

portions of the Library contained in the Combined Work and reverse

engineering for debugging such modifications, if you also do each of

the following:

   a) Give prominent notice with each copy of the Combined Work that

   the Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the Combined Work with a copy of the GNU GPL and this license
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   document.

   c) For a Combined Work that displays copyright notices during

   execution, include the copyright notice for the Library among

   these notices, as well as a reference directing the user to the

   copies of the GNU GPL and this license document.

   d) Do one of the following:

       0) Convey the Minimal Corresponding Source under the terms of this

       License, and the Corresponding Application Code in a form

       suitable for, and under terms that permit, the user to

       recombine or relink the Application with a modified version of

       the Linked Version to produce a modified Combined Work, in the

       manner specified by section 6 of the GNU GPL for conveying

       Corresponding Source.

       1) Use a suitable shared library mechanism for linking with the

       Library.  A suitable mechanism is one that (a) uses at run time
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       a copy of the Library already present on the user's computer

       system, and (b) will operate properly with a modified version

       of the Library that is interface-compatible with the Linked

       Version.

   e) Provide Installation Information, but only if you would otherwise

   be required to provide such information under section 6 of the

   GNU GPL, and only to the extent that such information is

   necessary to install and execute a modified version of the

   Combined Work produced by recombining or relinking the

   Application with a modified version of the Linked Version. (If

   you use option 4d0, the Installation Information must accompany

   the Minimal Corresponding Source and Corresponding Application

   Code. If you use option 4d1, you must provide the Installation

   Information in the manner specified by section 6 of the GNU GPL

   for conveying Corresponding Source.)

  5. Combined Libraries.
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  You may place library facilities that are a work based on the

Library side by side in a single library together with other library

facilities that are not Applications and are not covered by this

License, and convey such a combined library under terms of your

choice, if you do both of the following:

   a) Accompany the combined library with a copy of the same work based

   on the Library, uncombined with any other library facilities,

   conveyed under the terms of this License.

   b) Give prominent notice with the combined library that part of it

   is a work based on the Library, and explaining where to find the

   accompanying uncombined form of the same work.

  6. Revised Versions of the GNU Lesser General Public License.

  The Free Software Foundation may publish revised and/or new versions

of the GNU Lesser General Public License from time to time. Such new

versions will be similar in spirit to the present version, but may
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differ in detail to address new problems or concerns.

  Each version is given a distinguishing version number. If the

Library as you received it specifies that a certain numbered version

of the GNU Lesser General Public License "or any later version"

applies to it, you have the option of following the terms and

conditions either of that published version or of any later version

published by the Free Software Foundation. If the Library as you

received it does not specify a version number of the GNU Lesser

General Public License, you may choose any version of the GNU Lesser

General Public License ever published by the Free Software Foundation.

  If the Library as you received it specifies that a proxy can decide

whether future versions of the GNU Lesser General Public License shall

apply, that proxy's public statement of acceptance of any version is

permanent authorization for you to choose that version for the

Library.

----------------------------------------------------------------------
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                    GNU GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

                            Preamble

  The GNU General Public License is a free, copyleft license for

software and other kinds of works.

  The licenses for most software and other practical works are designed

to take away your freedom to share and change the works.  By contrast,

the GNU General Public License is intended to guarantee your freedom to

share and change all versions of a program--to make sure it remains free

software for all its users.  We, the Free Software Foundation, use the

GNU General Public License for most of our software; it applies also to
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any other work released this way by its authors.  You can apply it to

your programs, too.

  When we speak of free software, we are referring to freedom, not

price.  Our General Public Licenses are designed to make sure that you

have the freedom to distribute copies of free software (and charge for

them if you wish), that you receive source code or can get it if you

want it, that you can change the software or use pieces of it in new

free programs, and that you know you can do these things.

  To protect your rights, we need to prevent others from denying you

these rights or asking you to surrender the rights.  Therefore, you have

certain responsibilities if you distribute copies of the software, or if

you modify it: responsibilities to respect the freedom of others.

  For example, if you distribute copies of such a program, whether

gratis or for a fee, you must pass on to the recipients the same

freedoms that you received.  You must make sure that they, too, receive

or can get the source code.  And you must show them these terms so they
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know their rights.

  Developers that use the GNU GPL protect your rights with two steps:

(1) assert copyright on the software, and (2) offer you this License

giving you legal permission to copy, distribute and/or modify it.

  For the developers' and authors' protection, the GPL clearly explains

that there is no warranty for this free software.  For both users' and

authors' sake, the GPL requires that modified versions be marked as

changed, so that their problems will not be attributed erroneously to

authors of previous versions.

  Some devices are designed to deny users access to install or run

modified versions of the software inside them, although the manufacturer

can do so.  This is fundamentally incompatible with the aim of

protecting users' freedom to change the software.  The systematic

pattern of such abuse occurs in the area of products for individuals to

use, which is precisely where it is most unacceptable.  Therefore, we

have designed this version of the GPL to prohibit the practice for those



1405

1405Legal Information

products.  If such problems arise substantially in other domains, we

stand ready to extend this provision to those domains in future versions

of the GPL, as needed to protect the freedom of users.

  Finally, every program is threatened constantly by software patents.

States should not allow patents to restrict development and use of

software on general-purpose computers, but in those that do, we wish to

avoid the special danger that patents applied to a free program could

make it effectively proprietary.  To prevent this, the GPL assures that

patents cannot be used to render the program non-free.

  The precise terms and conditions for copying, distribution and

modification follow.

                       TERMS AND CONDITIONS

  0. Definitions.

  "This License" refers to version 3 of the GNU General Public License.
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  "Copyright" also means copyright-like laws that apply to other kinds of

works, such as semiconductor masks.

  "The Program" refers to any copyrightable work licensed under this

License.  Each licensee is addressed as "you".  "Licensees" and

"recipients" may be individuals or organizations.

  To "modify" a work means to copy from or adapt all or part of the work

in a fashion requiring copyright permission, other than the making of an

exact copy.  The resulting work is called a "modified version" of the

earlier work or a work "based on" the earlier work.

  A "covered work" means either the unmodified Program or a work based

on the Program.

  To "propagate" a work means to do anything with it that, without

permission, would make you directly or secondarily liable for

infringement under applicable copyright law, except executing it on a
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computer or modifying a private copy.  Propagation includes copying,

distribution (with or without modification), making available to the

public, and in some countries other activities as well.

  To "convey" a work means any kind of propagation that enables other

parties to make or receive copies.  Mere interaction with a user through

a computer network, with no transfer of a copy, is not conveying.

  An interactive user interface displays "Appropriate Legal Notices"

to the extent that it includes a convenient and prominently visible

feature that (1) displays an appropriate copyright notice, and (2)

tells the user that there is no warranty for the work (except to the

extent that warranties are provided), that licensees may convey the

work under this License, and how to view a copy of this License.  If

the interface presents a list of user commands or options, such as a

menu, a prominent item in the list meets this criterion.

  1. Source Code.
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  The "source code" for a work means the preferred form of the work

for making modifications to it.  "Object code" means any non-source

form of a work.

  A "Standard Interface" means an interface that either is an official

standard defined by a recognized standards body, or, in the case of

interfaces specified for a particular programming language, one that

is widely used among developers working in that language.

  The "System Libraries" of an executable work include anything, other

than the work as a whole, that (a) is included in the normal form of

packaging a Major Component, but which is not part of that Major

Component, and (b) serves only to enable use of the work with that

Major Component, or to implement a Standard Interface for which an

implementation is available to the public in source code form.  A

"Major Component", in this context, means a major essential component

(kernel, window system, and so on) of the specific operating system

(if any) on which the executable work runs, or a compiler used to

produce the work, or an object code interpreter used to run it.
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  The "Corresponding Source" for a work in object code form means all

the source code needed to generate, install, and (for an executable

work) run the object code and to modify the work, including scripts to

control those activities.  However, it does not include the work's

System Libraries, or general-purpose tools or generally available free

programs which are used unmodified in performing those activities but

which are not part of the work.  For example, Corresponding Source

includes interface definition files associated with source files for

the work, and the source code for shared libraries and dynamically

linked subprograms that the work is specifically designed to require,

such as by intimate data communication or control flow between those

subprograms and other parts of the work.

  The Corresponding Source need not include anything that users

can regenerate automatically from other parts of the Corresponding

Source.

  The Corresponding Source for a work in source code form is that
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same work.

  2. Basic Permissions.

  All rights granted under this License are granted for the term of

copyright on the Program, and are irrevocable provided the stated

conditions are met.  This License explicitly affirms your unlimited

permission to run the unmodified Program.  The output from running a

covered work is covered by this License only if the output, given its

content, constitutes a covered work.  This License acknowledges your

rights of fair use or other equivalent, as provided by copyright law.

  You may make, run and propagate covered works that you do not

convey, without conditions so long as your license otherwise remains

in force.  You may convey covered works to others for the sole purpose

of having them make modifications exclusively for you, or provide you

with facilities for running those works, provided that you comply with

the terms of this License in conveying all material for which you do

not control copyright.  Those thus making or running the covered works
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for you must do so exclusively on your behalf, under your direction

and control, on terms that prohibit them from making any copies of

your copyrighted material outside their relationship with you.

  Conveying under any other circumstances is permitted solely under

the conditions stated below.  Sublicensing is not allowed; section 10

makes it unnecessary.

  3. Protecting Users' Legal Rights From Anti-Circumvention Law.

  No covered work shall be deemed part of an effective technological

measure under any applicable law fulfilling obligations under article

11 of the WIPO copyright treaty adopted on 20 December 1996, or

similar laws prohibiting or restricting circumvention of such

measures.

  When you convey a covered work, you waive any legal power to forbid

circumvention of technological measures to the extent such circumvention

is effected by exercising rights under this License with respect to
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the covered work, and you disclaim any intention to limit operation or

modification of the work as a means of enforcing, against the work's

users, your or third parties' legal rights to forbid circumvention of

technological measures.

  4. Conveying Verbatim Copies.

  You may convey verbatim copies of the Program's source code as you

receive it, in any medium, provided that you conspicuously and

appropriately publish on each copy an appropriate copyright notice;

keep intact all notices stating that this License and any

non-permissive terms added in accord with section 7 apply to the code;

keep intact all notices of the absence of any warranty; and give all

recipients a copy of this License along with the Program.

  You may charge any price or no price for each copy that you convey,

and you may offer support or warranty protection for a fee.

  5. Conveying Modified Source Versions.
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  You may convey a work based on the Program, or the modifications to

produce it from the Program, in the form of source code under the

terms of section 4, provided that you also meet all of these conditions:

    a) The work must carry prominent notices stating that you modified

    it, and giving a relevant date.

    b) The work must carry prominent notices stating that it is

    released under this License and any conditions added under section

    7.  This requirement modifies the requirement in section 4 to

    "keep intact all notices".

    c) You must license the entire work, as a whole, under this

    License to anyone who comes into possession of a copy.  This

    License will therefore apply, along with any applicable section 7

    additional terms, to the whole of the work, and all its parts,

    regardless of how they are packaged.  This License gives no

    permission to license the work in any other way, but it does not
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    invalidate such permission if you have separately received it.

    d) If the work has interactive user interfaces, each must display

    Appropriate Legal Notices; however, if the Program has interactive

    interfaces that do not display Appropriate Legal Notices, your

    work need not make them do so.

  A compilation of a covered work with other separate and independent

works, which are not by their nature extensions of the covered work,

and which are not combined with it such as to form a larger program,

in or on a volume of a storage or distribution medium, is called an

"aggregate" if the compilation and its resulting copyright are not

used to limit the access or legal rights of the compilation's users

beyond what the individual works permit.  Inclusion of a covered work

in an aggregate does not cause this License to apply to the other

parts of the aggregate.

  6. Conveying Non-Source Forms.
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  You may convey a covered work in object code form under the terms

of sections 4 and 5, provided that you also convey the

machine-readable Corresponding Source under the terms of this License,

in one of these ways:

    a) Convey the object code in, or embodied in, a physical product

    (including a physical distribution medium), accompanied by the

    Corresponding Source fixed on a durable physical medium

    customarily used for software interchange.

    b) Convey the object code in, or embodied in, a physical product

    (including a physical distribution medium), accompanied by a

    written offer, valid for at least three years and valid for as

    long as you offer spare parts or customer support for that product

    model, to give anyone who possesses the object code either (1) a

    copy of the Corresponding Source for all the software in the

    product that is covered by this License, on a durable physical

    medium customarily used for software interchange, for a price no

    more than your reasonable cost of physically performing this
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    conveying of source, or (2) access to copy the

    Corresponding Source from a network server at no charge.

    c) Convey individual copies of the object code with a copy of the

    written offer to provide the Corresponding Source.  This

    alternative is allowed only occasionally and noncommercially, and

    only if you received the object code with such an offer, in accord

    with subsection 6b.

    d) Convey the object code by offering access from a designated

    place (gratis or for a charge), and offer equivalent access to the

    Corresponding Source in the same way through the same place at no

    further charge.  You need not require recipients to copy the

    Corresponding Source along with the object code.  If the place to

    copy the object code is a network server, the Corresponding Source

    may be on a different server (operated by you or a third party)

    that supports equivalent copying facilities, provided you maintain

    clear directions next to the object code saying where to find the

    Corresponding Source.  Regardless of what server hosts the
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    Corresponding Source, you remain obligated to ensure that it is

    available for as long as needed to satisfy these requirements.

    e) Convey the object code using peer-to-peer transmission, provided

    you inform other peers where the object code and Corresponding

    Source of the work are being offered to the general public at no

    charge under subsection 6d.

  A separable portion of the object code, whose source code is excluded

from the Corresponding Source as a System Library, need not be

included in conveying the object code work.

  A "User Product" is either (1) a "consumer product", which means any

tangible personal property which is normally used for personal, family,

or household purposes, or (2) anything designed or sold for incorporation

into a dwelling.  In determining whether a product is a consumer product,

doubtful cases shall be resolved in favor of coverage.  For a particular

product received by a particular user, "normally used" refers to a

typical or common use of that class of product, regardless of the status
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of the particular user or of the way in which the particular user

actually uses, or expects or is expected to use, the product.  A product

is a consumer product regardless of whether the product has substantial

commercial, industrial or non-consumer uses, unless such uses represent

the only significant mode of use of the product.

  "Installation Information" for a User Product means any methods,

procedures, authorization keys, or other information required to install

and execute modified versions of a covered work in that User Product from

a modified version of its Corresponding Source.  The information must

suffice to ensure that the continued functioning of the modified object

code is in no case prevented or interfered with solely because

modification has been made.

  If you convey an object code work under this section in, or with, or

specifically for use in, a User Product, and the conveying occurs as

part of a transaction in which the right of possession and use of the

User Product is transferred to the recipient in perpetuity or for a

fixed term (regardless of how the transaction is characterized), the
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Corresponding Source conveyed under this section must be accompanied

by the Installation Information.  But this requirement does not apply

if neither you nor any third party retains the ability to install

modified object code on the User Product (for example, the work has

been installed in ROM).

  The requirement to provide Installation Information does not include a

requirement to continue to provide support service, warranty, or updates

for a work that has been modified or installed by the recipient, or for

the User Product in which it has been modified or installed.  Access to a

network may be denied when the modification itself materially and

adversely affects the operation of the network or violates the rules and

protocols for communication across the network.

  Corresponding Source conveyed, and Installation Information provided,

in accord with this section must be in a format that is publicly

documented (and with an implementation available to the public in

source code form), and must require no special password or key for

unpacking, reading or copying.
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  7. Additional Terms.

  "Additional permissions" are terms that supplement the terms of this

License by making exceptions from one or more of its conditions.

Additional permissions that are applicable to the entire Program shall

be treated as though they were included in this License, to the extent

that they are valid under applicable law.  If additional permissions

apply only to part of the Program, that part may be used separately

under those permissions, but the entire Program remains governed by

this License without regard to the additional permissions.

  When you convey a copy of a covered work, you may at your option

remove any additional permissions from that copy, or from any part of

it.  (Additional permissions may be written to require their own

removal in certain cases when you modify the work.)  You may place

additional permissions on material, added by you to a covered work,

for which you have or can give appropriate copyright permission.
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  Notwithstanding any other provision of this License, for material you

add to a covered work, you may (if authorized by the copyright holders of

that material) supplement the terms of this License with terms:

    a) Disclaiming warranty or limiting liability differently from the

    terms of sections 15 and 16 of this License; or

    b) Requiring preservation of specified reasonable legal notices or

    author attributions in that material or in the Appropriate Legal

    Notices displayed by works containing it; or

    c) Prohibiting misrepresentation of the origin of that material, or

    requiring that modified versions of such material be marked in

    reasonable ways as different from the original version; or

    d) Limiting the use for publicity purposes of names of licensors or

    authors of the material; or

    e) Declining to grant rights under trademark law for use of some
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    trade names, trademarks, or service marks; or

    f) Requiring indemnification of licensors and authors of that

    material by anyone who conveys the material (or modified versions of

    it) with contractual assumptions of liability to the recipient, for

    any liability that these contractual assumptions directly impose on

    those licensors and authors.

  All other non-permissive additional terms are considered "further

restrictions" within the meaning of section 10.  If the Program as you

received it, or any part of it, contains a notice stating that it is

governed by this License along with a term that is a further

restriction, you may remove that term.  If a license document contains

a further restriction but permits relicensing or conveying under this

License, you may add to a covered work material governed by the terms

of that license document, provided that the further restriction does

not survive such relicensing or conveying.

  If you add terms to a covered work in accord with this section, you
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must place, in the relevant source files, a statement of the

additional terms that apply to those files, or a notice indicating

where to find the applicable terms.

  Additional terms, permissive or non-permissive, may be stated in the

form of a separately written license, or stated as exceptions;

the above requirements apply either way.

  8. Termination.

  You may not propagate or modify a covered work except as expressly

provided under this License.  Any attempt otherwise to propagate or

modify it is void, and will automatically terminate your rights under

this License (including any patent licenses granted under the third

paragraph of section 11).

  However, if you cease all violation of this License, then your

license from a particular copyright holder is reinstated (a)

provisionally, unless and until the copyright holder explicitly and
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finally terminates your license, and (b) permanently, if the copyright

holder fails to notify you of the violation by some reasonable means

prior to 60 days after the cessation.

  Moreover, your license from a particular copyright holder is

reinstated permanently if the copyright holder notifies you of the

violation by some reasonable means, this is the first time you have

received notice of violation of this License (for any work) from that

copyright holder, and you cure the violation prior to 30 days after

your receipt of the notice.

  Termination of your rights under this section does not terminate the

licenses of parties who have received copies or rights from you under

this License.  If your rights have been terminated and not permanently

reinstated, you do not qualify to receive new licenses for the same

material under section 10.

  9. Acceptance Not Required for Having Copies.
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  You are not required to accept this License in order to receive or

run a copy of the Program.  Ancillary propagation of a covered work

occurring solely as a consequence of using peer-to-peer transmission

to receive a copy likewise does not require acceptance.  However,

nothing other than this License grants you permission to propagate or

modify any covered work.  These actions infringe copyright if you do

not accept this License.  Therefore, by modifying or propagating a

covered work, you indicate your acceptance of this License to do so.

  10. Automatic Licensing of Downstream Recipients.

  Each time you convey a covered work, the recipient automatically

receives a license from the original licensors, to run, modify and

propagate that work, subject to this License.  You are not responsible

for enforcing compliance by third parties with this License.

  An "entity transaction" is a transaction transferring control of an

organization, or substantially all assets of one, or subdividing an

organization, or merging organizations.  If propagation of a covered



1426

1426Legal Information

work results from an entity transaction, each party to that

transaction who receives a copy of the work also receives whatever

licenses to the work the party's predecessor in interest had or could

give under the previous paragraph, plus a right to possession of the

Corresponding Source of the work from the predecessor in interest, if

the predecessor has it or can get it with reasonable efforts.

  You may not impose any further restrictions on the exercise of the

rights granted or affirmed under this License.  For example, you may

not impose a license fee, royalty, or other charge for exercise of

rights granted under this License, and you may not initiate litigation

(including a cross-claim or counterclaim in a lawsuit) alleging that

any patent claim is infringed by making, using, selling, offering for

sale, or importing the Program or any portion of it.

  11. Patents.

  A "contributor" is a copyright holder who authorizes use under this

License of the Program or a work on which the Program is based.  The
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work thus licensed is called the contributor's "contributor version".

  A contributor's "essential patent claims" are all patent claims

owned or controlled by the contributor, whether already acquired or

hereafter acquired, that would be infringed by some manner, permitted

by this License, of making, using, or selling its contributor version,

but do not include claims that would be infringed only as a

consequence of further modification of the contributor version.  For

purposes of this definition, "control" includes the right to grant

patent sublicenses in a manner consistent with the requirements of

this License.

  Each contributor grants you a non-exclusive, worldwide, royalty-free

patent license under the contributor's essential patent claims, to

make, use, sell, offer for sale, import and otherwise run, modify and

propagate the contents of its contributor version.

  In the following three paragraphs, a "patent license" is any express

agreement or commitment, however denominated, not to enforce a patent



1428

1428Legal Information

(such as an express permission to practice a patent or covenant not to

sue for patent infringement).  To "grant" such a patent license to a

party means to make such an agreement or commitment not to enforce a

patent against the party.

  If you convey a covered work, knowingly relying on a patent license,

and the Corresponding Source of the work is not available for anyone

to copy, free of charge and under the terms of this License, through a

publicly available network server or other readily accessible means,

then you must either (1) cause the Corresponding Source to be so

available, or (2) arrange to deprive yourself of the benefit of the

patent license for this particular work, or (3) arrange, in a manner

consistent with the requirements of this License, to extend the patent

license to downstream recipients.  "Knowingly relying" means you have

actual knowledge that, but for the patent license, your conveying the

covered work in a country, or your recipient's use of the covered work

in a country, would infringe one or more identifiable patents in that

country that you have reason to believe are valid.
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  If, pursuant to or in connection with a single transaction or

arrangement, you convey, or propagate by procuring conveyance of, a

covered work, and grant a patent license to some of the parties

receiving the covered work authorizing them to use, propagate, modify

or convey a specific copy of the covered work, then the patent license

you grant is automatically extended to all recipients of the covered

work and works based on it.

  A patent license is "discriminatory" if it does not include within

the scope of its coverage, prohibits the exercise of, or is

conditioned on the non-exercise of one or more of the rights that are

specifically granted under this License.  You may not convey a covered

work if you are a party to an arrangement with a third party that is

in the business of distributing software, under which you make payment

to the third party based on the extent of your activity of conveying

the work, and under which the third party grants, to any of the

parties who would receive the covered work from you, a discriminatory

patent license (a) in connection with copies of the covered work

conveyed by you (or copies made from those copies), or (b) primarily



1430

1430Legal Information

for and in connection with specific products or compilations that

contain the covered work, unless you entered into that arrangement,

or that patent license was granted, prior to 28 March 2007.

  Nothing in this License shall be construed as excluding or limiting

any implied license or other defenses to infringement that may

otherwise be available to you under applicable patent law.

  12. No Surrender of Others' Freedom.

  If conditions are imposed on you (whether by court order, agreement or

otherwise) that contradict the conditions of this License, they do not

excuse you from the conditions of this License.  If you cannot convey a

covered work so as to satisfy simultaneously your obligations under this

License and any other pertinent obligations, then as a consequence you may

not convey it at all.  For example, if you agree to terms that obligate you

to collect a royalty for further conveying from those to whom you convey

the Program, the only way you could satisfy both those terms and this

License would be to refrain entirely from conveying the Program.
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  13. Use with the GNU Affero General Public License.

  Notwithstanding any other provision of this License, you have

permission to link or combine any covered work with a work licensed

under version 3 of the GNU Affero General Public License into a single

combined work, and to convey the resulting work.  The terms of this

License will continue to apply to the part which is the covered work,

but the special requirements of the GNU Affero General Public License,

section 13, concerning interaction through a network will apply to the

combination as such.

  14. Revised Versions of this License.

  The Free Software Foundation may publish revised and/or new versions of

the GNU General Public License from time to time.  Such new versions will

be similar in spirit to the present version, but may differ in detail to

address new problems or concerns.
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  Each version is given a distinguishing version number.  If the

Program specifies that a certain numbered version of the GNU General

Public License "or any later version" applies to it, you have the

option of following the terms and conditions either of that numbered

version or of any later version published by the Free Software

Foundation.  If the Program does not specify a version number of the

GNU General Public License, you may choose any version ever published

by the Free Software Foundation.

  If the Program specifies that a proxy can decide which future

versions of the GNU General Public License can be used, that proxy's

public statement of acceptance of a version permanently authorizes you

to choose that version for the Program.

  Later license versions may give you additional or different

permissions.  However, no additional obligations are imposed on any

author or copyright holder as a result of your choosing to follow a

later version.
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  15. Disclaimer of Warranty.

  THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY

APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT

HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY

OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM

IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF

ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. Limitation of Liability.

  IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING

WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS

THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY

GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE

USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF

DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
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PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),

EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF

SUCH DAMAGES.

  17. Interpretation of Sections 15 and 16.

  If the disclaimer of warranty and limitation of liability provided

above cannot be given local legal effect according to their terms,

reviewing courts shall apply local law that most closely approximates

an absolute waiver of all civil liability in connection with the

Program, unless a warranty or assumption of liability accompanies a

copy of the Program in return for a fee.

                     END OF TERMS AND CONDITIONS

            How to Apply These Terms to Your New Programs

  If you develop a new program, and you want it to be of the greatest

possible use to the public, the best way to achieve this is to make it
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free software which everyone can redistribute and change under these terms.

  To do so, attach the following notices to the program.  It is safest

to attach them to the start of each source file to most effectively

state the exclusion of warranty; and each file should have at least

the "copyright" line and a pointer to where the full notice is found.

    <one line to give the program's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

    This program is free software: you can redistribute it and/or modify

    it under the terms of the GNU General Public License as published by

    the Free Software Foundation, either version 3 of the License, or

    (at your option) any later version.

    This program is distributed in the hope that it will be useful,

    but WITHOUT ANY WARRANTY; without even the implied warranty of

    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the

    GNU General Public License for more details.
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    You should have received a copy of the GNU General Public License

    along with this program.  If not, see <http://www.gnu.org/licenses/>.

Also add information on how to contact you by electronic and paper mail.

  If the program does terminal interaction, make it output a short

notice like this when it starts in an interactive mode:

    <program>  Copyright (C) <year>  <name of author>

    This program comes with ABSOLUTELY NO WARRANTY; for details type `show w'.

    This is free software, and you are welcome to redistribute it

    under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate

parts of the General Public License.  Of course, your program's commands

might be different; for a GUI interface, you would use an "about box".

  You should also get your employer (if you work as a programmer) or school,
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if any, to sign a "copyright disclaimer" for the program, if necessary.

For more information on this, and how to apply and follow the GNU GPL, see

<http://www.gnu.org/licenses/>.

  The GNU General Public License does not permit incorporating your program

into proprietary programs.  If your program is a subroutine library, you

may consider it more useful to permit linking proprietary applications with

the library.  If this is what you want to do, use the GNU Lesser General

Public License instead of this License.  But first, please read

<http://www.gnu.org/philosophy/why-not-lgpl.html>.

DE265 License

Implementation of the h.265 video codec and is used by the HEIF library.

Source from: https://github.com/strukturag/libde265

                   GNU LESSER GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

https://github.com/strukturag/libde265
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 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

  This version of the GNU Lesser General Public License incorporates

the terms and conditions of version 3 of the GNU General Public

License, supplemented by the additional permissions listed below.

  0. Additional Definitions.

  As used herein, "this License" refers to version 3 of the GNU Lesser

General Public License, and the "GNU GPL" refers to version 3 of the GNU

General Public License.

  "The Library" refers to a covered work governed by this License,

other than an Application or a Combined Work as defined below.
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  An "Application" is any work that makes use of an interface provided

by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode

of using an interface provided by the Library.

  A "Combined Work" is a work produced by combining or linking an

Application with the Library.  The particular version of the Library

with which the Combined Work was made is also called the "Linked

Version".

  The "Minimal Corresponding Source" for a Combined Work means the

Corresponding Source for the Combined Work, excluding any source code

for portions of the Combined Work that, considered in isolation, are

based on the Application, and not on the Linked Version.

  The "Corresponding Application Code" for a Combined Work means the

object code and/or source code for the Application, including any data

and utility programs needed for reproducing the Combined Work from the

Application, but excluding the System Libraries of the Combined Work.



1440

1440Legal Information

  1. Exception to Section 3 of the GNU GPL.

  You may convey a covered work under sections 3 and 4 of this License

without being bound by section 3 of the GNU GPL.

  2. Conveying Modified Versions.

  If you modify a copy of the Library, and, in your modifications, a

facility refers to a function or data to be supplied by an Application

that uses the facility (other than as an argument passed when the

facility is invoked), then you may convey a copy of the modified

version:

   a) under this License, provided that you make a good faith effort to

   ensure that, in the event an Application does not supply the

   function or data, the facility still operates, and performs

   whatever part of its purpose remains meaningful, or
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   b) under the GNU GPL, with none of the additional permissions of

   this License applicable to that copy.

  3. Object Code Incorporating Material from Library Header Files.

  The object code form of an Application may incorporate material from

a header file that is part of the Library.  You may convey such object

code under terms of your choice, provided that, if the incorporated

material is not limited to numerical parameters, data structure

layouts and accessors, or small macros, inline functions and templates

(ten or fewer lines in length), you do both of the following:

   a) Give prominent notice with each copy of the object code that the

   Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the object code with a copy of the GNU GPL and this license

   document.
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  4. Combined Works.

  You may convey a Combined Work under terms of your choice that,

taken together, effectively do not restrict modification of the

portions of the Library contained in the Combined Work and reverse

engineering for debugging such modifications, if you also do each of

the following:

   a) Give prominent notice with each copy of the Combined Work that

   the Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the Combined Work with a copy of the GNU GPL and this license

   document.

   c) For a Combined Work that displays copyright notices during

   execution, include the copyright notice for the Library among

   these notices, as well as a reference directing the user to the

   copies of the GNU GPL and this license document.
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   d) Do one of the following:

       0) Convey the Minimal Corresponding Source under the terms of this

       License, and the Corresponding Application Code in a form

       suitable for, and under terms that permit, the user to

       recombine or relink the Application with a modified version of

       the Linked Version to produce a modified Combined Work, in the

       manner specified by section 6 of the GNU GPL for conveying

       Corresponding Source.

       1) Use a suitable shared library mechanism for linking with the

       Library.  A suitable mechanism is one that (a) uses at run time

       a copy of the Library already present on the user's computer

       system, and (b) will operate properly with a modified version

       of the Library that is interface-compatible with the Linked

       Version.

   e) Provide Installation Information, but only if you would otherwise
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   be required to provide such information under section 6 of the

   GNU GPL, and only to the extent that such information is

   necessary to install and execute a modified version of the

   Combined Work produced by recombining or relinking the

   Application with a modified version of the Linked Version. (If

   you use option 4d0, the Installation Information must accompany

   the Minimal Corresponding Source and Corresponding Application

   Code. If you use option 4d1, you must provide the Installation

   Information in the manner specified by section 6 of the GNU GPL

   for conveying Corresponding Source.)

  5. Combined Libraries.

  You may place library facilities that are a work based on the

Library side by side in a single library together with other library

facilities that are not Applications and are not covered by this

License, and convey such a combined library under terms of your

choice, if you do both of the following:
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   a) Accompany the combined library with a copy of the same work based

   on the Library, uncombined with any other library facilities,

   conveyed under the terms of this License.

   b) Give prominent notice with the combined library that part of it

   is a work based on the Library, and explaining where to find the

   accompanying uncombined form of the same work.

  6. Revised Versions of the GNU Lesser General Public License.

  The Free Software Foundation may publish revised and/or new versions

of the GNU Lesser General Public License from time to time. Such new

versions will be similar in spirit to the present version, but may

differ in detail to address new problems or concerns.

  Each version is given a distinguishing version number. If the

Library as you received it specifies that a certain numbered version

of the GNU Lesser General Public License "or any later version"

applies to it, you have the option of following the terms and
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conditions either of that published version or of any later version

published by the Free Software Foundation. If the Library as you

received it does not specify a version number of the GNU Lesser

General Public License, you may choose any version of the GNU Lesser

General Public License ever published by the Free Software Foundation.

  If the Library as you received it specifies that a proxy can decide

whether future versions of the GNU Lesser General Public License shall

apply, that proxy's public statement of acceptance of any version is

permanent authorization for you to choose that version for the

Library.

----------------------------------------------------------------------

                    GNU GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies
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 of this license document, but changing it is not allowed.

                            Preamble

  The GNU General Public License is a free, copyleft license for

software and other kinds of works.

  The licenses for most software and other practical works are designed

to take away your freedom to share and change the works.  By contrast,

the GNU General Public License is intended to guarantee your freedom to

share and change all versions of a program--to make sure it remains free

software for all its users.  We, the Free Software Foundation, use the

GNU General Public License for most of our software; it applies also to

any other work released this way by its authors.  You can apply it to

your programs, too.

  When we speak of free software, we are referring to freedom, not

price.  Our General Public Licenses are designed to make sure that you

have the freedom to distribute copies of free software (and charge for
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them if you wish), that you receive source code or can get it if you

want it, that you can change the software or use pieces of it in new

free programs, and that you know you can do these things.

  To protect your rights, we need to prevent others from denying you

these rights or asking you to surrender the rights.  Therefore, you have

certain responsibilities if you distribute copies of the software, or if

you modify it: responsibilities to respect the freedom of others.

  For example, if you distribute copies of such a program, whether

gratis or for a fee, you must pass on to the recipients the same

freedoms that you received.  You must make sure that they, too, receive

or can get the source code.  And you must show them these terms so they

know their rights.

  Developers that use the GNU GPL protect your rights with two steps:

(1) assert copyright on the software, and (2) offer you this License

giving you legal permission to copy, distribute and/or modify it.
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  For the developers' and authors' protection, the GPL clearly explains

that there is no warranty for this free software.  For both users' and

authors' sake, the GPL requires that modified versions be marked as

changed, so that their problems will not be attributed erroneously to

authors of previous versions.

  Some devices are designed to deny users access to install or run

modified versions of the software inside them, although the manufacturer

can do so.  This is fundamentally incompatible with the aim of

protecting users' freedom to change the software.  The systematic

pattern of such abuse occurs in the area of products for individuals to

use, which is precisely where it is most unacceptable.  Therefore, we

have designed this version of the GPL to prohibit the practice for those

products.  If such problems arise substantially in other domains, we

stand ready to extend this provision to those domains in future versions

of the GPL, as needed to protect the freedom of users.

  Finally, every program is threatened constantly by software patents.

States should not allow patents to restrict development and use of
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software on general-purpose computers, but in those that do, we wish to

avoid the special danger that patents applied to a free program could

make it effectively proprietary.  To prevent this, the GPL assures that

patents cannot be used to render the program non-free.

  The precise terms and conditions for copying, distribution and

modification follow.

                       TERMS AND CONDITIONS

  0. Definitions.

  "This License" refers to version 3 of the GNU General Public License.

  "Copyright" also means copyright-like laws that apply to other kinds of

works, such as semiconductor masks.

  "The Program" refers to any copyrightable work licensed under this

License.  Each licensee is addressed as "you".  "Licensees" and
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"recipients" may be individuals or organizations.

  To "modify" a work means to copy from or adapt all or part of the work

in a fashion requiring copyright permission, other than the making of an

exact copy.  The resulting work is called a "modified version" of the

earlier work or a work "based on" the earlier work.

  A "covered work" means either the unmodified Program or a work based

on the Program.

  To "propagate" a work means to do anything with it that, without

permission, would make you directly or secondarily liable for

infringement under applicable copyright law, except executing it on a

computer or modifying a private copy.  Propagation includes copying,

distribution (with or without modification), making available to the

public, and in some countries other activities as well.

  To "convey" a work means any kind of propagation that enables other

parties to make or receive copies.  Mere interaction with a user through
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a computer network, with no transfer of a copy, is not conveying.

  An interactive user interface displays "Appropriate Legal Notices"

to the extent that it includes a convenient and prominently visible

feature that (1) displays an appropriate copyright notice, and (2)

tells the user that there is no warranty for the work (except to the

extent that warranties are provided), that licensees may convey the

work under this License, and how to view a copy of this License.  If

the interface presents a list of user commands or options, such as a

menu, a prominent item in the list meets this criterion.

  1. Source Code.

  The "source code" for a work means the preferred form of the work

for making modifications to it.  "Object code" means any non-source

form of a work.

  A "Standard Interface" means an interface that either is an official

standard defined by a recognized standards body, or, in the case of
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interfaces specified for a particular programming language, one that

is widely used among developers working in that language.

  The "System Libraries" of an executable work include anything, other

than the work as a whole, that (a) is included in the normal form of

packaging a Major Component, but which is not part of that Major

Component, and (b) serves only to enable use of the work with that

Major Component, or to implement a Standard Interface for which an

implementation is available to the public in source code form.  A

"Major Component", in this context, means a major essential component

(kernel, window system, and so on) of the specific operating system

(if any) on which the executable work runs, or a compiler used to

produce the work, or an object code interpreter used to run it.

  The "Corresponding Source" for a work in object code form means all

the source code needed to generate, install, and (for an executable

work) run the object code and to modify the work, including scripts to

control those activities.  However, it does not include the work's

System Libraries, or general-purpose tools or generally available free
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programs which are used unmodified in performing those activities but

which are not part of the work.  For example, Corresponding Source

includes interface definition files associated with source files for

the work, and the source code for shared libraries and dynamically

linked subprograms that the work is specifically designed to require,

such as by intimate data communication or control flow between those

subprograms and other parts of the work.

  The Corresponding Source need not include anything that users

can regenerate automatically from other parts of the Corresponding

Source.

  The Corresponding Source for a work in source code form is that

same work.

  2. Basic Permissions.

  All rights granted under this License are granted for the term of

copyright on the Program, and are irrevocable provided the stated
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conditions are met.  This License explicitly affirms your unlimited

permission to run the unmodified Program.  The output from running a

covered work is covered by this License only if the output, given its

content, constitutes a covered work.  This License acknowledges your

rights of fair use or other equivalent, as provided by copyright law.

  You may make, run and propagate covered works that you do not

convey, without conditions so long as your license otherwise remains

in force.  You may convey covered works to others for the sole purpose

of having them make modifications exclusively for you, or provide you

with facilities for running those works, provided that you comply with

the terms of this License in conveying all material for which you do

not control copyright.  Those thus making or running the covered works

for you must do so exclusively on your behalf, under your direction

and control, on terms that prohibit them from making any copies of

your copyrighted material outside their relationship with you.

  Conveying under any other circumstances is permitted solely under

the conditions stated below.  Sublicensing is not allowed; section 10
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makes it unnecessary.

  3. Protecting Users' Legal Rights From Anti-Circumvention Law.

  No covered work shall be deemed part of an effective technological

measure under any applicable law fulfilling obligations under article

11 of the WIPO copyright treaty adopted on 20 December 1996, or

similar laws prohibiting or restricting circumvention of such

measures.

  When you convey a covered work, you waive any legal power to forbid

circumvention of technological measures to the extent such circumvention

is effected by exercising rights under this License with respect to

the covered work, and you disclaim any intention to limit operation or

modification of the work as a means of enforcing, against the work's

users, your or third parties' legal rights to forbid circumvention of

technological measures.

  4. Conveying Verbatim Copies.
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  You may convey verbatim copies of the Program's source code as you

receive it, in any medium, provided that you conspicuously and

appropriately publish on each copy an appropriate copyright notice;

keep intact all notices stating that this License and any

non-permissive terms added in accord with section 7 apply to the code;

keep intact all notices of the absence of any warranty; and give all

recipients a copy of this License along with the Program.

  You may charge any price or no price for each copy that you convey,

and you may offer support or warranty protection for a fee.

  5. Conveying Modified Source Versions.

  You may convey a work based on the Program, or the modifications to

produce it from the Program, in the form of source code under the

terms of section 4, provided that you also meet all of these conditions:

    a) The work must carry prominent notices stating that you modified
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    it, and giving a relevant date.

    b) The work must carry prominent notices stating that it is

    released under this License and any conditions added under section

    7.  This requirement modifies the requirement in section 4 to

    "keep intact all notices".

    c) You must license the entire work, as a whole, under this

    License to anyone who comes into possession of a copy.  This

    License will therefore apply, along with any applicable section 7

    additional terms, to the whole of the work, and all its parts,

    regardless of how they are packaged.  This License gives no

    permission to license the work in any other way, but it does not

    invalidate such permission if you have separately received it.

    d) If the work has interactive user interfaces, each must display

    Appropriate Legal Notices; however, if the Program has interactive

    interfaces that do not display Appropriate Legal Notices, your

    work need not make them do so.
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  A compilation of a covered work with other separate and independent

works, which are not by their nature extensions of the covered work,

and which are not combined with it such as to form a larger program,

in or on a volume of a storage or distribution medium, is called an

"aggregate" if the compilation and its resulting copyright are not

used to limit the access or legal rights of the compilation's users

beyond what the individual works permit.  Inclusion of a covered work

in an aggregate does not cause this License to apply to the other

parts of the aggregate.

  6. Conveying Non-Source Forms.

  You may convey a covered work in object code form under the terms

of sections 4 and 5, provided that you also convey the

machine-readable Corresponding Source under the terms of this License,

in one of these ways:

    a) Convey the object code in, or embodied in, a physical product
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    (including a physical distribution medium), accompanied by the

    Corresponding Source fixed on a durable physical medium

    customarily used for software interchange.

    b) Convey the object code in, or embodied in, a physical product

    (including a physical distribution medium), accompanied by a

    written offer, valid for at least three years and valid for as

    long as you offer spare parts or customer support for that product

    model, to give anyone who possesses the object code either (1) a

    copy of the Corresponding Source for all the software in the

    product that is covered by this License, on a durable physical

    medium customarily used for software interchange, for a price no

    more than your reasonable cost of physically performing this

    conveying of source, or (2) access to copy the

    Corresponding Source from a network server at no charge.

    c) Convey individual copies of the object code with a copy of the

    written offer to provide the Corresponding Source.  This

    alternative is allowed only occasionally and noncommercially, and
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    only if you received the object code with such an offer, in accord

    with subsection 6b.

    d) Convey the object code by offering access from a designated

    place (gratis or for a charge), and offer equivalent access to the

    Corresponding Source in the same way through the same place at no

    further charge.  You need not require recipients to copy the

    Corresponding Source along with the object code.  If the place to

    copy the object code is a network server, the Corresponding Source

    may be on a different server (operated by you or a third party)

    that supports equivalent copying facilities, provided you maintain

    clear directions next to the object code saying where to find the

    Corresponding Source.  Regardless of what server hosts the

    Corresponding Source, you remain obligated to ensure that it is

    available for as long as needed to satisfy these requirements.

    e) Convey the object code using peer-to-peer transmission, provided

    you inform other peers where the object code and Corresponding

    Source of the work are being offered to the general public at no
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    charge under subsection 6d.

  A separable portion of the object code, whose source code is excluded

from the Corresponding Source as a System Library, need not be

included in conveying the object code work.

  A "User Product" is either (1) a "consumer product", which means any

tangible personal property which is normally used for personal, family,

or household purposes, or (2) anything designed or sold for incorporation

into a dwelling.  In determining whether a product is a consumer product,

doubtful cases shall be resolved in favor of coverage.  For a particular

product received by a particular user, "normally used" refers to a

typical or common use of that class of product, regardless of the status

of the particular user or of the way in which the particular user

actually uses, or expects or is expected to use, the product.  A product

is a consumer product regardless of whether the product has substantial

commercial, industrial or non-consumer uses, unless such uses represent

the only significant mode of use of the product.
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  "Installation Information" for a User Product means any methods,

procedures, authorization keys, or other information required to install

and execute modified versions of a covered work in that User Product from

a modified version of its Corresponding Source.  The information must

suffice to ensure that the continued functioning of the modified object

code is in no case prevented or interfered with solely because

modification has been made.

  If you convey an object code work under this section in, or with, or

specifically for use in, a User Product, and the conveying occurs as

part of a transaction in which the right of possession and use of the

User Product is transferred to the recipient in perpetuity or for a

fixed term (regardless of how the transaction is characterized), the

Corresponding Source conveyed under this section must be accompanied

by the Installation Information.  But this requirement does not apply

if neither you nor any third party retains the ability to install

modified object code on the User Product (for example, the work has

been installed in ROM).
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  The requirement to provide Installation Information does not include a

requirement to continue to provide support service, warranty, or updates

for a work that has been modified or installed by the recipient, or for

the User Product in which it has been modified or installed.  Access to a

network may be denied when the modification itself materially and

adversely affects the operation of the network or violates the rules and

protocols for communication across the network.

  Corresponding Source conveyed, and Installation Information provided,

in accord with this section must be in a format that is publicly

documented (and with an implementation available to the public in

source code form), and must require no special password or key for

unpacking, reading or copying.

  7. Additional Terms.

  "Additional permissions" are terms that supplement the terms of this

License by making exceptions from one or more of its conditions.

Additional permissions that are applicable to the entire Program shall
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be treated as though they were included in this License, to the extent

that they are valid under applicable law.  If additional permissions

apply only to part of the Program, that part may be used separately

under those permissions, but the entire Program remains governed by

this License without regard to the additional permissions.

  When you convey a copy of a covered work, you may at your option

remove any additional permissions from that copy, or from any part of

it.  (Additional permissions may be written to require their own

removal in certain cases when you modify the work.)  You may place

additional permissions on material, added by you to a covered work,

for which you have or can give appropriate copyright permission.

  Notwithstanding any other provision of this License, for material you

add to a covered work, you may (if authorized by the copyright holders of

that material) supplement the terms of this License with terms:

    a) Disclaiming warranty or limiting liability differently from the

    terms of sections 15 and 16 of this License; or
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    b) Requiring preservation of specified reasonable legal notices or

    author attributions in that material or in the Appropriate Legal

    Notices displayed by works containing it; or

    c) Prohibiting misrepresentation of the origin of that material, or

    requiring that modified versions of such material be marked in

    reasonable ways as different from the original version; or

    d) Limiting the use for publicity purposes of names of licensors or

    authors of the material; or

    e) Declining to grant rights under trademark law for use of some

    trade names, trademarks, or service marks; or

    f) Requiring indemnification of licensors and authors of that

    material by anyone who conveys the material (or modified versions of

    it) with contractual assumptions of liability to the recipient, for

    any liability that these contractual assumptions directly impose on
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    those licensors and authors.

  All other non-permissive additional terms are considered "further

restrictions" within the meaning of section 10.  If the Program as you

received it, or any part of it, contains a notice stating that it is

governed by this License along with a term that is a further

restriction, you may remove that term.  If a license document contains

a further restriction but permits relicensing or conveying under this

License, you may add to a covered work material governed by the terms

of that license document, provided that the further restriction does

not survive such relicensing or conveying.

  If you add terms to a covered work in accord with this section, you

must place, in the relevant source files, a statement of the

additional terms that apply to those files, or a notice indicating

where to find the applicable terms.

  Additional terms, permissive or non-permissive, may be stated in the

form of a separately written license, or stated as exceptions;
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the above requirements apply either way.

  8. Termination.

  You may not propagate or modify a covered work except as expressly

provided under this License.  Any attempt otherwise to propagate or

modify it is void, and will automatically terminate your rights under

this License (including any patent licenses granted under the third

paragraph of section 11).

  However, if you cease all violation of this License, then your

license from a particular copyright holder is reinstated (a)

provisionally, unless and until the copyright holder explicitly and

finally terminates your license, and (b) permanently, if the copyright

holder fails to notify you of the violation by some reasonable means

prior to 60 days after the cessation.

  Moreover, your license from a particular copyright holder is

reinstated permanently if the copyright holder notifies you of the
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violation by some reasonable means, this is the first time you have

received notice of violation of this License (for any work) from that

copyright holder, and you cure the violation prior to 30 days after

your receipt of the notice.

  Termination of your rights under this section does not terminate the

licenses of parties who have received copies or rights from you under

this License.  If your rights have been terminated and not permanently

reinstated, you do not qualify to receive new licenses for the same

material under section 10.

  9. Acceptance Not Required for Having Copies.

  You are not required to accept this License in order to receive or

run a copy of the Program.  Ancillary propagation of a covered work

occurring solely as a consequence of using peer-to-peer transmission

to receive a copy likewise does not require acceptance.  However,

nothing other than this License grants you permission to propagate or

modify any covered work.  These actions infringe copyright if you do
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not accept this License.  Therefore, by modifying or propagating a

covered work, you indicate your acceptance of this License to do so.

  10. Automatic Licensing of Downstream Recipients.

  Each time you convey a covered work, the recipient automatically

receives a license from the original licensors, to run, modify and

propagate that work, subject to this License.  You are not responsible

for enforcing compliance by third parties with this License.

  An "entity transaction" is a transaction transferring control of an

organization, or substantially all assets of one, or subdividing an

organization, or merging organizations.  If propagation of a covered

work results from an entity transaction, each party to that

transaction who receives a copy of the work also receives whatever

licenses to the work the party's predecessor in interest had or could

give under the previous paragraph, plus a right to possession of the

Corresponding Source of the work from the predecessor in interest, if

the predecessor has it or can get it with reasonable efforts.
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  You may not impose any further restrictions on the exercise of the

rights granted or affirmed under this License.  For example, you may

not impose a license fee, royalty, or other charge for exercise of

rights granted under this License, and you may not initiate litigation

(including a cross-claim or counterclaim in a lawsuit) alleging that

any patent claim is infringed by making, using, selling, offering for

sale, or importing the Program or any portion of it.

  11. Patents.

  A "contributor" is a copyright holder who authorizes use under this

License of the Program or a work on which the Program is based.  The

work thus licensed is called the contributor's "contributor version".

  A contributor's "essential patent claims" are all patent claims

owned or controlled by the contributor, whether already acquired or

hereafter acquired, that would be infringed by some manner, permitted

by this License, of making, using, or selling its contributor version,
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but do not include claims that would be infringed only as a

consequence of further modification of the contributor version.  For

purposes of this definition, "control" includes the right to grant

patent sublicenses in a manner consistent with the requirements of

this License.

  Each contributor grants you a non-exclusive, worldwide, royalty-free

patent license under the contributor's essential patent claims, to

make, use, sell, offer for sale, import and otherwise run, modify and

propagate the contents of its contributor version.

  In the following three paragraphs, a "patent license" is any express

agreement or commitment, however denominated, not to enforce a patent

(such as an express permission to practice a patent or covenant not to

sue for patent infringement).  To "grant" such a patent license to a

party means to make such an agreement or commitment not to enforce a

patent against the party.

  If you convey a covered work, knowingly relying on a patent license,
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and the Corresponding Source of the work is not available for anyone

to copy, free of charge and under the terms of this License, through a

publicly available network server or other readily accessible means,

then you must either (1) cause the Corresponding Source to be so

available, or (2) arrange to deprive yourself of the benefit of the

patent license for this particular work, or (3) arrange, in a manner

consistent with the requirements of this License, to extend the patent

license to downstream recipients.  "Knowingly relying" means you have

actual knowledge that, but for the patent license, your conveying the

covered work in a country, or your recipient's use of the covered work

in a country, would infringe one or more identifiable patents in that

country that you have reason to believe are valid.

  If, pursuant to or in connection with a single transaction or

arrangement, you convey, or propagate by procuring conveyance of, a

covered work, and grant a patent license to some of the parties

receiving the covered work authorizing them to use, propagate, modify

or convey a specific copy of the covered work, then the patent license

you grant is automatically extended to all recipients of the covered



1474

1474Legal Information

work and works based on it.

  A patent license is "discriminatory" if it does not include within

the scope of its coverage, prohibits the exercise of, or is

conditioned on the non-exercise of one or more of the rights that are

specifically granted under this License.  You may not convey a covered

work if you are a party to an arrangement with a third party that is

in the business of distributing software, under which you make payment

to the third party based on the extent of your activity of conveying

the work, and under which the third party grants, to any of the

parties who would receive the covered work from you, a discriminatory

patent license (a) in connection with copies of the covered work

conveyed by you (or copies made from those copies), or (b) primarily

for and in connection with specific products or compilations that

contain the covered work, unless you entered into that arrangement,

or that patent license was granted, prior to 28 March 2007.

  Nothing in this License shall be construed as excluding or limiting

any implied license or other defenses to infringement that may
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otherwise be available to you under applicable patent law.

  12. No Surrender of Others' Freedom.

  If conditions are imposed on you (whether by court order, agreement or

otherwise) that contradict the conditions of this License, they do not

excuse you from the conditions of this License.  If you cannot convey a

covered work so as to satisfy simultaneously your obligations under this

License and any other pertinent obligations, then as a consequence you may

not convey it at all.  For example, if you agree to terms that obligate you

to collect a royalty for further conveying from those to whom you convey

the Program, the only way you could satisfy both those terms and this

License would be to refrain entirely from conveying the Program.

  13. Use with the GNU Affero General Public License.

  Notwithstanding any other provision of this License, you have

permission to link or combine any covered work with a work licensed

under version 3 of the GNU Affero General Public License into a single
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combined work, and to convey the resulting work.  The terms of this

License will continue to apply to the part which is the covered work,

but the special requirements of the GNU Affero General Public License,

section 13, concerning interaction through a network will apply to the

combination as such.

  14. Revised Versions of this License.

  The Free Software Foundation may publish revised and/or new versions of

the GNU General Public License from time to time.  Such new versions will

be similar in spirit to the present version, but may differ in detail to

address new problems or concerns.

  Each version is given a distinguishing version number.  If the

Program specifies that a certain numbered version of the GNU General

Public License "or any later version" applies to it, you have the

option of following the terms and conditions either of that numbered

version or of any later version published by the Free Software

Foundation.  If the Program does not specify a version number of the
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GNU General Public License, you may choose any version ever published

by the Free Software Foundation.

  If the Program specifies that a proxy can decide which future

versions of the GNU General Public License can be used, that proxy's

public statement of acceptance of a version permanently authorizes you

to choose that version for the Program.

  Later license versions may give you additional or different

permissions.  However, no additional obligations are imposed on any

author or copyright holder as a result of your choosing to follow a

later version.

  15. Disclaimer of Warranty.

  THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY

APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT

HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY

OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
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THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM

IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF

ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. Limitation of Liability.

  IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING

WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS

THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY

GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE

USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF

DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD

PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),

EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF

SUCH DAMAGES.

  17. Interpretation of Sections 15 and 16.
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  If the disclaimer of warranty and limitation of liability provided

above cannot be given local legal effect according to their terms,

reviewing courts shall apply local law that most closely approximates

an absolute waiver of all civil liability in connection with the

Program, unless a warranty or assumption of liability accompanies a

copy of the Program in return for a fee.

                     END OF TERMS AND CONDITIONS

            How to Apply These Terms to Your New Programs

  If you develop a new program, and you want it to be of the greatest

possible use to the public, the best way to achieve this is to make it

free software which everyone can redistribute and change under these terms.

  To do so, attach the following notices to the program.  It is safest

to attach them to the start of each source file to most effectively

state the exclusion of warranty; and each file should have at least

the "copyright" line and a pointer to where the full notice is found.
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    <one line to give the program's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

    This program is free software: you can redistribute it and/or modify

    it under the terms of the GNU General Public License as published by

    the Free Software Foundation, either version 3 of the License, or

    (at your option) any later version.

    This program is distributed in the hope that it will be useful,

    but WITHOUT ANY WARRANTY; without even the implied warranty of

    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the

    GNU General Public License for more details.

    You should have received a copy of the GNU General Public License

    along with this program.  If not, see <http://www.gnu.org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
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  If the program does terminal interaction, make it output a short

notice like this when it starts in an interactive mode:

    <program>  Copyright (C) <year>  <name of author>

    This program comes with ABSOLUTELY NO WARRANTY; for details type `show w'.

    This is free software, and you are welcome to redistribute it

    under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate

parts of the General Public License.  Of course, your program's commands

might be different; for a GUI interface, you would use an "about box".

  You should also get your employer (if you work as a programmer) or school,

if any, to sign a "copyright disclaimer" for the program, if necessary.

For more information on this, and how to apply and follow the GNU GPL, see

<http://www.gnu.org/licenses/>.

  The GNU General Public License does not permit incorporating your program

into proprietary programs.  If your program is a subroutine library, you
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may consider it more useful to permit linking proprietary applications with

the library.  If this is what you want to do, use the GNU Lesser General

Public License instead of this License.  But first, please read

<http://www.gnu.org/philosophy/why-not-lgpl.html>.
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